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About this User Guide

This document serves as a user's guide for the 64-bit versions of TerraScan. The entry-level
version, TerraScan Lite, is functionally a subset of the full version, TerraScan. TerraScan UAV is
aiming to users who process point clouds collected with UAS (Unmanned Airborne Systems,
also referred to systems carried by Drones). Tools available in TerraScan, TerraScan UAV, and/or
TerraScan Lite work identically in all versions. Tools that are not available in TerraScan Lite are
marked as "Not Lite" in the documentation. Tools that are not available in TerraScan UAV are
marked with "Not UAV" in the documentation.

The PDF version of the user guide is created in order to provide an offline version of the online
webhelp. It shall be updated together with the webhelp. Some parts of the webhelp may be
left out on purpose in the PDF document. In case of inconsistency, the online webhelp is the
primary source of information. The user is responsible for keeping his/her offline version
updated.

Document conventions

The following conventions and symbols appear in this guide:

· Data click - click on the data mouse button, usually the left button on a right-hand mouse.

· Reset click - click on the reset mouse button, usually the right button on a right-hand mouse.

· < > - angle brackets are used to refer to keyboard keys, for example, <Enter>.

· Command - type a command in the Spaccels window of Spatix or the key-in line of
MicroStation and then press <Enter>.

· OR - alternate procedures or steps in a procedure.

· C:\TERRA64 - paths to directories of files on a hard disk are written with capital letters.

· To do  - the beginning of a workflow is introduced with bold-italic letters.

· When no distinction between Spatix and MicroStation versions is necessary, this document
refers to the CAD environment simply as "CAD platform".

Notes and hints are highlighted in light blue boxes.
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Spatix documentation

The User Guide for Spatix is published by GISware Integro and delivered as PDF with the
software. It can be opened with the Manual command from the Help menu of Spatix.

Terrasolid software runs on top of Spatix. The functionality of Terrasolid software is the same in
Spatix and on top of Bentley products whenever possible. Any differences are clearly
mentioned in the User Guide.

MicroStation documentation

This user guide is written under the assumption that the reader knows how to use the basic
MicroStation features. You should refer to any documentation of MicroStation whenever you
need information about tools and functionality of the CAD platform.

Terrasolid software runs on top of the full version of Bentley MicroStation or some other CAD
products of Bentley, such as PowerDraft. Compatible Bentley products are listed on Terrasolid's
webpage. The CAD platform causes no difference in functionality of Terrasolid software.
Therefore, only the term "MicroStation" is used when referring to any Bentley product.

Terminology

Spatix and MicroStation often use different terms for referring to the same thing. Long-time
users of MicroStation are used to the terminology of the Bentley products. New Spatix users
without MicroStation knowledge only get to know the Spatix terminology.

To keep the text of the User Guide simple, only one term is used (normally the MicroStation
term) if no specific separation of MicroStation and Spatix terminology is necessary. The
following table provides an overview of the terminology of the two CAD platforms:

MICROSTATION SPATIX REMARK

Level Layer also Level list, Level manager, Active
level

Select Element Choose Element selection tool

Line string Polyline element type

Shape Polygon element type

Complex element

· Create Complex
Chain

· Create Complex
Shape

Big element

· Construct Big Element
/ Big line

· Construct Big Element
/ Big polygon

element type

· tool

· tool

Cell Symbol element type, also Cell library

https://terrasolid.com/software-downloads/
https://terrasolid.com/software-downloads/
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MICROSTATION SPATIX REMARK

Fence (= selected
shape)

= selected polygon many TerraScan functions consider a
selected polygon as fence

Key-in command Spaccel (Spatix
accelerates)

typed command to call a function, also
key-in window, key-in line
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TerraScan

Introduction

TerraScan is a dedicated software solution for processing laser scanning point clouds. It can
easily handle millions of points as all routines are tweaked for optimum performance.

Its versatile tools prove useful for a number of application fields, such as transmission lines,
flood plains, proposed highways, stock piles, forest areas, city models, road and railroad
surveying, and much more.

The application reads points from binary files or text files. It provides tools to:

· display point clouds in many different ways

· define your own point classes such as ground, vegetation, buildings or wires

· organize huge point clouds in projects

· manage trajectory information

· classify points using automatic filter routines

· classify points interactively

· digitize features by snapping to laser points

· detect and vectorize object features, such as buildings, powerline wires and towers,
overhead wires, road breaklines, rails

· analyze object conditions, such as road surfaces, lines-of-sight, clearance areas, danger
objects for roads, rails and wires, change detection

· create colored point clouds (requires also TerraPhoto)

· export colored raster images

· output classified points into text or binary files

· and much more

TerraScan is integrated with the CAD platform. This CAD environment provides a large number
of useful tools and capabilities in the areas of view manipulation, visualization, vector
placement and labeling. A basic understanding of the CAD platform usage is required in order
to be productive with TerraScan.

TerraScan Lite

TerraScan Lite is a light version of TerraScan and provides a subset of the functionality of the
full version. It can be used to view point clouds, setup projects, work on loaded points and
classify points manually. It provides all the tools for manual 3D building model editing.

TerraScan Lite does only include a very limited number of automatic classification routines; it
does not contain automatic building and powerline vectorization tools, and waveform
processing tools.
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The Function matrix provides a complete overview of tools and commands available in the
different TerraScan versions.

TerraScan UAV

TerraScan UAV is another lighter version of TerraScan dedicated for processing point clouds that
are collected by UAV-mounted scanners. It provides the full functionality of TerraScan but only
for a limited size of the point cloud. Basically, the points must fit in memory for processing
tasks as there are no tools for splitting the point cloud into smaller parts. On the other hand,
the version provides pre-defined routines for the most common processing tasks. This allows
full-automatic point cloud processing.

TerraScan UAV does not include the same project capabilities as the full version, it does not
contain waveform processing and tunnel analysis tools.

The Function matrix provides a complete overview of tools and commands available in the
different TerraScan versions.

https://terrasolid.com/guides/tscan/function-matrix.html
https://terrasolid.com/guides/tscan/function-matrix.html
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Hardware and software requirements

TerraScan is built on top of a CAD platform, such as Spatix or Bentley MicroStation. You must
have a computer system capable of running any compatible CAD platform.

Terra applications run parallel on Spatix and on MicroStation. Only one installation of Terra
applications is needed and files are shared by the CAD platforms, such as license and settings
files.

To run TerraScan, you must have the following:

· quad-core processor or better, good processor frequency

· 8 GB RAM minimum, 16 GB RAM or more recommended

· 1024*768 resolution display or better

· SSD hard disc or other storage device with fast access speed is recommended

· Windows x64 version 7 or later

· Any of the compatible CAD platforms:

GISware Integro, purchased by
Terrasolid

Bentley

· Spatix · MicroStation CONNECT Edition

· PowerDraft CONNECT Edition

· OpenCities Map PowerView
CONNECT Edition

· OpenCities Map CONNECT Edition

· OpenCities Map Enterprise
CONNECT Edition

· ContextCapture Editor CONNECT
Edition

· OpenRoads Designer

Installation of TerraScan requires about 2 MB of free hard disk space.
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Installation

Terrasolid applications may be delivered as a zip file or on a USB-Stick. The installation package
of Terrasolid applications for Spatix includes the setup for Spatix itself as well. Therefore, you
can install Spatix and Terrasolid software in one step.

A zip package contains the software - it does not include the User Guides. This is the normal
delivery method of the software if you download it from the Terrasolid webserver.

A USB-Stick may include the User Guides in PDF format in addition to the installation files. The
USB-Stick may further include versions for multiple environments. You choose the version
which corresponds to your operating system and MicroStation version. You install Terrasolid
software from an USB-Stick probably only if you participate in a training event.

Terrasolid applications for Bentley products and Spatix may be installed on the same computer
and run parallel. The applications should be installed in the same directory (e.g. c:\terra64).
This enables the use of the same configuration files, settings, etc. for both platforms.

To install TerraScan from a zip file together with or on top of Spatix:

1. Unpack the zip archive with any zip file manager.

2. Start SETUP.EXE which is part of the zip archive. You must have administrator permissions in
order to run setup successfully.

The installation program tries to determine where Spatix has been installed and opens the
Terra Setup dialog:

https://terrasolid.com/software-downloads/
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3. Check and possibly change the installation folder of Spatix. Click on the Browse button next
to the input field in order to select a new installation folder for Spatix. The folder is created
automatically, if it does not exist.

4. Define the installation folder(s) where to install TerraScan and maybe other Terra
applications.

The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.

As an alternative, if executables and settings files need to be separated, select another
Folder choice:

· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,
setting files are installed into C:\TERRA64.

· Freely selectable folders - the user defines a folder for Executables and Settings in the
corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.

5. Select all Terrasolid applications that you want to install.

Select either the full version, the UAV version or the Lite version of an application. The
versions do not run parallel on the same CAD platform.

6. Click OK to start the installation.

A message is displayed when the installation is finished.

Install all Terrasolid applications into the same folder(s) in order to ensure interaction
between the applications without trouble.

To install TerraScan from a zip file on top of any Bentley  product:

1. Unpack the zip archive with any zip file manager.

2. Start SETUP.EXE which is part of the zip archive.

This may open a dialog confirming the execution of SETUP.EXE and/or prompting for the
administrator password.

The installation program needs to know where the Bentley product (MicroStation, Map
PowerView or any other compatible product) has been installed. It automatically searches all
local hard disks to find the Bentley installation directory.

The installation dialog opens:
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The dialog is the same for all Bentley products and Terra applications. The labels in the dialog
always refer to "MicroStation", no matter what Bentley product is used.

3. Check the MicroStation directory. Replace the path if the correct location was not found
automatically.

4. Define the installation folder(s) where to install TerraScan and maybe other Terra
applications.

The default Folder choice is Default c:\terra64. This installs all executables and setting files
into the same folder C:\TERRA64. The folder is created automatically, if it does not exist.

As an alternative, if executables and settings files need to be separated, select another
Folder choice:

· Default 'Program files' - executables are installed into C:\PROGRAM FILES\TERRASOLID,
setting files are installed into C:\TERRA64.

· Freely selectable folders - the user defines a folder for Executables and Settings in the
corresponding input fields. Click on the Browse button next to each input field in order to
select a folder.

5. Click OK to start the installation.

A message is displayed when the installation is finished.

Install all Terrasolid applications into the same folder(s) in order to ensure interaction
between the applications without trouble.

The installation folder contains a README.TXT file which explains the installation of the
software in batch mode. The allows to install several Terrasolid applications in one step.

To install TerraScan from USB-Stick on top of a Bentley  product:

The process is the same for all Bentley products. The labels in all dialogs always refer to
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"MicroStation", no matter what Bentley product is used.

1. Insert the USB-Stick.

2. Locate the correct installation directory on the stick.

3. Start SETUP.EXE from that directory.

The installation program tries to determine where MicroStation has been installed and
opens the Terra Setup dialog.

4. Define the directory where to install TerraScan and maybe other Terra applications.

The default path is C:\TERRA64. You can change this to another location. The specified
directory is created automatically, if it does not exist.

5. Check the MicroStation directory. Replace the path if the correct location was not found
automatically.

You can use the Scan button to automatically search the hard disk for the MicroStation
installation. Alternatively, you can use the Browse button to locate the MicroStation
installation folder yourself.

6. Click OK to continue.

This opens another Terra Setup dialog.

7. Select the TerraScan for MicroStation item in the dialog.

You may select all applications for which you have installation files.

8. Click OK to start the installation.

A message is displayed when the installation is finished.
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Starting TerraScan

TerraScan is an application that runs on top of Spatix (Ix App) or MicroStation (MDL Application).

To start TerraScan in Spatix:

1. Select Execute command from the Ix Apps menu in Spatix.

The Choose Ix app to execute dialog opens, a standard Windows dialog to open a file.

2. Browse to the \APP folder of the Terra applications installation directory.

By default, the path is C:\TERRA64\APP.

3. Select the tscan.ix file.

You may select other applications as well.

4. Click Open in order to start all selected applications.

To start TerraScan in MicroStation:

1. Select MDL Applications command from the Utilities ribbon in MicroStation.

The MDL dialog opens:

2. In the Available Applications list, select TSCAN.

3. Click the Load button.

OR

1. Key in mdl load tscan.
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The Available Applications list shows all MDL applications that MicroStation is able to locate.
MicroStation searches for MDL applications in the directories listed in MS_MDLAPPS
configuration variable. If MicroStation can not find TSCAN.MA, you should check the variable
in the Configuration Variable dialog of MicroStation. Make sure the directory path of the
TSCAN.MA file is included in the variable values. See also Installation Directories and
Configuration Variables for more information.

When the application is loaded, it opens the TerraScan window and  TerraScan toolbox
according to the settings for loading TerraScan:

TerraScan toolbox - Full version

TerraScan toolbox - Lite version

TerraScan toolbox - UAV version

If the TerraScan window is accidentally closed, it can be re-opened with the key-in command:

scan app mainwin

If the TerraScan toolbox is accidentally closed, it can be re-opened with the Main toolbox
command from the Toolboxes submenu in the Tools pulldown menu or with the key-in
command:

scan app main

Unloading TerraScan

TerraScan is unloaded automatically when you exit Spatix or MicroStation. Sometimes you may
want to unload the application while continuing to work with the CAD platform. This frees up
the memory reserved by TerraScan.

To unload TerraScan in Spatix:

1. Select tscan.ix command from the Ix Apps menu in Spatix.

The IxApp Properties dialog opens:
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2. Click on the Stop button.

This unloads TerraScan, closes the TerraScan window and toolbox and updates the Status and
IxApp Info in the IxApp Properties dialog.

3. Close the dialog with OK or Cancel.

To unload TerraScan in MicroStation:

1. Select MDL Applications command from the Utilities ribbon in MicroStation.

The MDL dialog opens:

2. In the Loaded Applications list, select TSCAN.

3. Click on the Unload button.

OR

1. Key in mdl unload tscan.

This unloads the application and frees the memory allocated for it.
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TerraScan Settings

Settings control the way how tools and commands of TerraScan work. They are organized in
logical categories. The Settings dialog is opened by the Settings tool.

SETTINGS FOLDER / CATEGORY

Building vectorization / Editing tools

Building vectorization / Levels

Building vectorization / Model

Component fitting / Colors

Component fitting / Levels

Component fitting / Operation

Component fitting / Profile

Component fitting / Weights and styles

Coordinate transformations /
Transformations

Coordinate transformations / User projection
systems

File formats / Default storage format

File formats / File name extensions

File formats / LAS formats

File formats / LAZ formats

File formats / Leica formats

File formats / Optech formats

File formats / User point formats

File formats / User trajectory formats

Manual classification tools / Classify Above
Line

Manual classification tools / Classify Below
Line

Manual classification tools / Classify Close to
Line

Manual classification tools / Classify Fence
tool

Powerlines / Active line

SETTINGS CATEGORY

Alignment reports

Block naming formulas

City Databases

Collection shapes

Color mixures

Default coordinate setup

Default line qualities

Elevation labels

Loaded points

Object library

Operation

Point display

Rail section templates

Road section parameters

Scanner systems

Scanner waveform profiles

Section templates

Signal markers

Slave computers

Snapping

Street View images

Target objects

Trajectory accuracies

Travel View tool

Tree species

Tree visualization types

Undo and backup
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SETTINGS FOLDER / CATEGORY

Powerlines / Profile layouts

Powerlines / Tower functions

Powerlines / Tower statuses

Powerlines / Tower types

Road paint markings / Crosswalks

Road paint markings / Paint markings

SETTINGS CATEGORY

User vegetation indexes
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Alignment reports

Alignment reports category contains a list of alignment report formats. The formats are used by
the Output alignment report command. The report format defines what information is included
in the output report along an alignment element. It consists of a descriptive name and a list of
columns.

To define a new alignment report format:

1. Open the Alignments reports category.

2. Click Add in the Settings dialog.

The Alignment Report Format dialog opens:

3. Type a Name for the report format.

4. Click Add in the Alignment Report Format dialog in order to add a new column definition to
the report.

The Report Column dialog opens:
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5. Define settings and click OK.

6. Repeat steps 4 and 5 for all columns you want to add to the report format.

7. Click OK in the Alignment Report Format dialog.

8. Close the Settings dialog in order to save the alignment report settings for TerraScan.

SETTING EFFECT

Title Title of the report column.

Data Content of the report column:

· Alignment station - station value along an
alignment element.

· Alignment easting - easting coordinate at
stations along the alignment element.

· Alignment northing - northing coordinate at
stations along the alignment element.

· Alignment elevation - elevation coordinate
at stations along the alignment element.

· Interval elevation - minimum or maximum
Elevation of points in a given Class. A
rectangular search area is defined by the
offset left and right of the alignment station
given in the Within field. The interval step
size along the alignment element given at
report output time.

· Point elevation - closest, minimum,
average, or maximum Elevation value from
points in a given Class inside a circular area.
The center of the circular area is at the
given Offset from the alignment station,
the size is determined by the Radius value.

· Surface elevation - elevation value of a
surface model. This requires at least one
active surface model in TerraModeler. The
elevation value is computed from the
selected Surface type at the XY location of
the alignment station plus the given Offset
value.

· Column difference - computes the
difference between two other Columns of
the report. Select the number of the
columns in the selection lists of the dialog.

· Alert - writes an asterisk character (*) in the
report if the difference between two
columns is bigger or smaller than a given
limit. Select the number of the columns and
the comparison sign in the selection lists of
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SETTING EFFECT

the dialog. Define the limit value in the text
field.

Offset An offset value in the dialog refers to the
distance from the alignment element. The
selected Data value is determined from the
location defined by the alignment station and
the offset. A negative offset is left, a positive
offset right of the alignment element.

Alignment report formats are stored in a configuration file ALREPFMT.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make alignment
report formats available on them.
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Block naming formulas
Not UAV

Block naming formulas category shows a list of naming conventions that can be used to create
block names for TerraScan projects. The naming formulas can be utilized when adding block
boundaries to a TerraScan project.

You can Add, Edit, and Delete block naming formulas by using the corresponding buttons in the
Settings dialog.

To create a new block naming formula:

1. Open the Block naming formulas category.

2. Click Add in the Settings dialog.

The Block Naming Formula dialog opens:

3. Define settings and click OK.

4. Close the Settings dialog in order to save the block naming formula settings for TerraScan.

SETTING EFFECT

Description Description of the formula.

Format Format of the formula. This may include any
free text and variable definitions. The
resulting text string is probably used naming
files, so it should follow naming conventions
for storing files.

Append Opens the Append field dialog. The dialog
contains a list of variables which can be added
to a formula:

· minimum | maximum easting | northing -
minimum or maximum values of easting or
northing corner coordinates of a block
boundary.

· block size - block height or width value,
whatever is larger.

https://terrasolid.com/guides/tscan/prjaddbyboundaries.html
https://terrasolid.com/guides/tscan/prjaddbyboundaries.html
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SETTING EFFECT

· block number - number according to the
selection order of block boundaries.

Block naming formulas are stored in a configuration file BLOCKNAMING.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make block naming
formulas available on them.
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Building vectorization / Editing tools

Editing tools category in Buildings vectorization folder defines the default tool of the Building
Edges toolbox.

SETTING EFFECT

Start ‘Modify Edge’ as default tool If on, the Modify Edge tool is activated by
default when other building model
modification tools are reset.
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Building vectorization / Levels

Levels category in Building vectorization folder sets levels which are used for drawing building
models into the CAD file. These settings are used for automatic building vectorization and the
Check Building Models tool.

SETTING EFFECT

Models to check Levels for Roof, Walls, and Base polygons if a
model is marked for checking. This is the
status after automatic detection.

Active model Levels for Roof, Walls, and Base polygons if a
model is active. This is the case if the Check
Building Models tool is started and a model is
selected in the list of vector models.

Approved models Levels for Roof, Walls, and Base polygons if a
model has been approved. This is the status
after the model has been checked and
approved with the Check Building Models
tool.

On the Spatix platform, a whole building model is always stored on a single level. Roofs,
Walls, and Base of a single building populate the same level depending on the building
status. Thus, only single level per each setting is available in TerraScan settings.
The setting on Spatix platform corresponds to the Walls level on MicroStation platform.
Changing Models to check setting on Spatix changes Models to check: Walls setting on
MicroStation, and the other way around.
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Building vectorization / Model

Model category in Building vectorization folder defines design settings for drawing
automatically created building models in the CAD file. See Chapter 3D Building Models for a
detailed description of building vectorization options and tools in TerraScan.

SETTING EFFECT

Average elevations Vertices in a building model are set to the
same elevation if they are closer to each
other than the given tolerance value. As a
result, there is no elevation jump in a
building model even if there is no exact
intersection line but the elevation
difference of vertices is smaller than the
tolerance. In addition, roof patches may not
be exactly planar shapes.

To enforce exact planarity for roof patches,
set this value to 0.0. This may lead to
vertices that are not exactly at the same XYZ
location anymore although they are vertices
of intersection lines.

Walls start Distance between the ground level and the
start of walls below the ground. Defines the
elevation of the base polygon vertices.

Roof | Fill Default outline and fill color of roof
polygons. Click on the color button in order
to change the color in the standard Windows
Color dialog.

Walls | Fill Default outline and fill color of wall
polygons. Click on the color button in order
to change the color in the standard Windows
Color dialog.
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City databases

City databases category shows a list of database connections that can be used to write, read, or
delete 3D building models to/from 3D City Databases. The connections are available in the
dialogs of the Write Buildings to Database, Read Buildings from Database, Delete Database
Buildings tools in the Building toolbox of TerraScan.

You can Add, Edit, and Delete database connections by using the corresponding buttons in the
Settings dialog.

To create a new database connection:

1. Open the City databases category.

2. Click Add in the Settings dialog.

The City Database Source dialog opens:

3. Define settings and click OK.

4. Close the Settings dialog in order to save the database connection settings for TerraScan.

SETTING EFFECT

Database type Version of the 3D City Database: 3DCityDB 3.0
or 3DCityDB 4.0.

Name Name of the database source for internal use
in TerraScan. This name appears in the
selection list of the tool dialogs.

Connect string Name of the database to which the software
connects.

Coordinate system EPSG number of the coordinate system used
in the database. The EPSG number identifies
each coordinate system in a unique way.
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SETTING EFFECT

Building id field Name of the ID field in the database. The ID
identifies each building in the database in a
unique way.

Texture thema Appearance/Theme name for textures in the
3D City Database. This is applied when
building models with textures are written to
the database. The name also appears, for
example in selection lists, when other
software exports/imports the building
models from the database.

City database connections are stored in a configuration file CITY_DATABASES.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make
database connections available on them, provided that the same database can be connected
on another computer.
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Collection shapes

Collection shapes category shows a list of collection shape types. Collection shapes can be used
to group laser points. Typical collection shape type examples are building, road, or tree. The
actual grouping is done by placing collection shapes with the Place Collection Shape tool. The
collection shape type determines what kind of an object the polygon encloses as well as the
level and the symbology of the polygon.

Collection shapes can be further used to output laser points into separate files according to the
collection or group they belong to. See Output collections command from the Tools pulldown
menu of the TerraScan Project window.

You can Add, Edit, and Delete collection shape types by using the corresponding buttons in the
Settings dialog.

To create a new collection shape type:

1. Open the Collection shapes category.

2. Click Add in the Settings dialog.

The Collection shape dialog opens:

3. Define settings and click OK.

4. Close the Settings dialog in order to save the collection shape settings for TerraScan.

SETTING EFFECT

Name Name of the collection shape type.

Level Number of the level on which collections
shapes are placed.

Color Color of collections shapes. Uses the active
color table of the CAD file.

Weight Line weight of collection shapes. Uses
standard line weights.
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SETTING EFFECT

Style Line style of collection shapes. Uses standard
line styles.

Collection shapes are stored in a configuration file COLLECTION_SHAPES.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make collection
shape definitions available on them.
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Color mixtures

Color mixtures category shows a list of color mixtures. A color mixture can be used to assign
color values to laser points. For some object types, such as trees, color mixtures look more
naturally compared with constant colors or colors extracted from images. This is especially true
for point clouds collected by ground-based mobile mapping systems.

Color mixtures are defined by using the Hue Saturation Value (HSV) color model. Hue defines
the color value on a 360-degree color circle ranging from Red (0 deg) via Yellow (60 deg), Green
(120 deg), Cyan (180 deg), Blue (240 deg), Magenta (300 deg) back to Red. Saturation defines the
intensity or purity of the color. A smaller saturation sets the color closer to a gray shade. Value
defines the lightness or darkness of the color. A smaller value sets the color closer to black.

Color mixtures are used by the Assign color to points command for loaded points and by the
Assign color macro action.

You can Add, Edit, and Delete color mixtures by using the corresponding buttons in the Settings
dialog.

To create a new color mixture:

1. Open the Color mixtures category.

2. Click Add in the Settings dialog.

The Color Mixture dialog opens:
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3. Define settings and click OK.

4. Close the Settings dialog in order to save the color mixture settings for TerraScan.

SETTING EFFECT

Name Name of the color mixture.

Percentage Percentage value for using a color in the
mixture.

Hue Hue of a color and its variation. Values can
vary from 0 to 359, the variation can range
from 0 to 180.

Saturation Saturation range of a color. Values can vary
from 0 to 180.

Value Value range of a color. Values can vary from 0
to 180.

Color mixtures are stored in a configuration file COLOR_MIXTURES.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make color mixture
definitions available on them.
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Component fitting / Colors
Not Lite, Not UAV

Colors category in Component fitting folder defines colors for drawing the different elements
of geometry component fitting. All color values are given in RGB color space. You can define a

color by typing the RGB values in the text fields of the dialog or by clicking on the  Button
next to the text fields. The button opens the standard Color dialog of Windows and lets you
select a color.

 See Chapter Fit Geometry Components for more information about the topic.

SETTING EFFECT

Arc Color of fitted arc elements.

Clothoid Color of fitted clothoid elements.

Line Color of fitted line elements.

Hilite Color of fitted highlighted elements.

Temporary Color of fitted temporary elements.

Horizontal Color of horizontal alignment elements.

Vertical Color of vertical alignment elements.

Label Color of label elements.

3D shape Color of the final 3D shape.
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Component fitting / Levels
Not Lite, Not UAV

Levels category in Component fitting folder sets levels used for drawing geometry component
fitting elements into the CAD file. Define a level by typing the level number in the text fields of
the dialog.

See Chapter Fit Geometry Components for more information about the topic.

SETTING EFFECT

Horizontal levels

Surveyed alignment Level for drawing the surveyed horizontal
alignment elements.

Horizontal components Level for drawing the fitted horizontal
component elements.

Point weights Level for drawing the point weight values for
horizontal elements.

Vertical levels

Profile frame Level for drawing the frame of the profile
that displays the vertical geometry fitting
elements.

Surveyed alignment Level for drawing the surveyed vertical
alignment elements.

Vertical components Level for drawing the fitted vertical
component elements.

Point weights Level for drawing the point weight values for
vertical elements.

3D result

3D shape Level for drawing the final 3D shape.
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Component fitting / Operation
Not Lite, Not UAV

Operation category in Component fitting folder defines whether results of the geometry
component fitting process are saved automatically in the CAD file or not. See Chapter Fit
Geometry Components for more information about the topic.

SETTING EFFECT

Save geometry automatically If on, results of the geometry fitting process
are saved automatically.
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Component fitting / Profile
Not Lite, Not UAV

Profile category in Component fitting folder defines the layout of the profile that is used for
representing the geometry component fitting elements. See Chapter Fit Geometry
Components for more information about the topic.

SETTING EFFECT

Horizontal scale Scale factor for horizontal elements.

Vertical scale Scale factor for vertical elements.

Elevation grid Step size for elevation values.

Relative margin Size of a margin around the profile.

Station values Number of decimals for station value labels.

Component values Number of decimals for geometry
component value labels.

Text size Size of text elements. Given in millimeters
plotted on paper.

Font Font type of text elements. Uses a list of
fonts available in the CAD file.
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Component fitting / Weights and styles
Not Lite, Not UAV

Weights and styles category in Component fitting folder sets the line weights and styles for
drawing geometry component fitting elements. It uses standard line weights and styles. See
Chapter Fit Geometry Components for more information about the topic.

SETTING EFFECT

Line weight Line weight of component fitting elements.

Hilite weight Line weight of highlighted elements.

Hilite style Line style of highlighted elements.

Preview weight Line weight of preview elements.

Preview style Line style of preview elements.
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Coordinate transformations / Transformations

Transformations category in Coordinate transformations folder contains a list of coordinate
transformations which can be used to transform the position of laser data, trajectories, and
other data.

You can Add, Edit, and Delete transformation by using the corresponding buttons in the Settings
dialog. The Copy button copies the selected transformation to the clipboard. With the Paste
button you can paste a transformation from the clipboard. The Derive button can be used for
Deriving a transformation from a set of control point pairs.

Several types of coordinate transformations are supported:

· Linear transformation

· Equation transformation - discarded feature in x64 software

· Known points transformation

· Xy multiply transformation

· 3D translate & rotate transformation

· 3D Affine transformation

· Projection change transformation

· Scale from center

To define a new transformation:

1. Open the Transformations category in the Coordinate transformations folder.

2. Click Add in the Settings dialog.

This opens the Transformation dialog.

3. Type a Name for the transformation and select a transformation Type. Define the other
settings depending on the transformation type.

4. Close the Settings dialog in order to save the modified settings for TerraScan.

You can copy transformations from one Terra application to another. Select the
transformation in the Settings dialog and click on the Copy button to copy the definition to
the clipboard. Click on the Paste button in the other Terra application to paste the definition.

Linear transformation

Linear transformation scales and/or translates coordinate values. You can assign a coefficient
and a constant offset for each coordinate axis. The target coordinates are computed by
multiplying the original coordinates with the given coefficient and by adding a given constant
value.
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SETTING EFFECT

Multiply by - X Coefficient for multiplying the easting
coordinate.

Multiply by - Y Coefficient for multiplying the northing
coordinate.

Multiply by - Z Coefficient for multiplying the elevation
coordinate.

Add constant - X Value to add to the easting coordinate.

Add constant - Y Value to add to the northing coordinate.

Add constant - Z Value to add to the elevation coordinate.

Known points transformation

Known points transformation lets you specify the coordinates of two known points in the
original coordinate system (survey coordinates) and their respective coordinates in the target
system (CAD file coordinates).
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SETTING EFFECT

Survey X, Y, Z First known point in the original coordinate
system.

X, Y, Z Second known point in the original
coordinate system.

Design X, Y, Z First known point in the target coordinate
system.

X, Y, Z Second known point in the target coordinate
system.

Xy multiply transformation

Xy multiply applies a transformation using equations:

NewX = dx + a * Sx + b * Sy
NewY = dy + c * Sx + d * Sy
NewZ = dz + e * Sz

where dx, dy, dz, a, b, c, d, and e are constant parameters of the transformation and Sx, Sy, Sz
are the original (survey) coordinates. This is often used as 2D Helmert type of transformation.
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3D translate & rotate transformation

3D translate & rotate applies a three dimensional translation and rotation to coordinates.

SETTING EFFECT

Dx, Dy, Dz Values to add to X, Y, Z coordinates.

Ox, Oy, Oz X, Y, Z coordinates of the rotation center
point.

Rx, Ry, Rz Rotation angle in radians around X, Y, Z axes.

3D Affine transformation

3D Affine applies separate translation, rotation and scaling for each coordinate axis. The
transformation is defined by equations:
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NewX = dx + (1.0 + mx) * X + rz * Y - ry * Z
NewY = dy + (1.0 + my) * Y - rz * X + rx * Z
NewZ = dz + (1.0 + mz) * Z + ry * X - rx * Y

where dx, dy, dz, mx, my, mz, rz, ry, and rz are constant parameters of the transformation and X,
Y, Z are the original coordinates.

SETTING EFFECT

Dx, Dy, Dz Values to add to X, Y, Z coordinates
(translation).

Mx, My, Mz Factors to scale the data along the X, Y, Z
axes.

Rx, Ry, Rz Rotation angle in radians around X, Y, Z axes.

Projection change transformation

Projection change transforms coordinates from one projection system to another. The software
transforms the X, Y, Z coordinates from the source projection system back into WGS84
geocentric X, Y, Z and then computes the transformation into the target projection system.

Projection systems are referenced by their EPSG code (EPSG = European Petroleum Survey
Group Geodesy, worldwide unique 4- to 5-digits code numbers for coordinate systems). A list of
all available projection systems is opened by clicking the >> button next to the From/To input
fields in the dialog. This opens the Browse for Projection System dialog:
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Type parts of the projection system name or code number in the Search using line in order to
reduce the list to relevant systems. Select the system you want to use in the list. The View
Details button opens an information dialog showing the details of the selected projection
system. The Copy button copies the projection system parameters to the clipboard. Click OK in
order to use the selected projection system in the Transformations dialog.

If a projection system is not available in the EPSG code list, it can be defined in Coordinate
transformations / User projection systems. All systems activated there are also available for a
projection change transformation.

SETTING EFFECT

From Source projection system. Start typing the
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SETTING EFFECT

name or EPSG code of the system in the text
field. The software offers corresponding
systems next to the input line. When clicking
OK, the system shown next to the input field
is used no matter what is typed in the input
field. E.g., type "84 UTM 32" in the field. The
software shows "32632 WGS 84 / UTM zone
32N" next to the field which is the complete
name of the system used for the
transformation.
Alternatively, use the >> button next to the
field to open the complete list of projection
systems.

To Target projection system. The input line works
in the same way as for the From field.

Modify Coordinate values to modify:

· Xyz - modifies all coordinates.

· Xy only - no changes to elevation values.

If you already applied a geoid correction, you should run a reverse geoid correction to the
data set before using a projection change transformation. This is essential in cases where the
source and the target systems use different ellipsoids or datums. A geoid correction or a
reverse geoid correction is only applied automatically if the UK National Grid system is used
in the transformation.

Scale from center

Scale from center applies a scale factor to points relative to a given center point.
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SETTING EFFECT

Center X, Y, Z XYZ coordinates of the center point. 

Scale X, Y, Z Scale factor for the X, Y, Z axes.

Deriving a transformation

You can also derive transformation parameter values from point pairs. This requires that
identical control points (point pairs) are available in source and target coordinate values. The
points must be stored in text files. The number of required control point pairs depends on the
transformation type.

To derive a transformation, click on the Derive button in the Settings dialog. This opens the
Derive transformation from points dialog:

SETTING EFFECT

Type Type of the derived transformation:

· 2D transformation - parameter values for a
2D Helmert transformation are derived.

· 3D translate & 2D rotate - parameter values
for a 3D translation and a 2D rotation
transformation are derived.

· 3D translate & rotate - parameter values for
a 3D translation and rotation transformation
are derived.

· 7 parameter affine - parameter values for a
3D affine transformation (7 parameters) are
derived.

· 9 parameter affine - parameter values for a
3D affine transformation (9 parameters) are
derived.

Use Points used for deriving the transformation:

· All point pairs - uses all control point pairs.

· Inside source fence only - points inside a
fence in the source coordinate system are
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SETTING EFFECT

used.

· Inside target fence only - points inside a
fence in the target coordinate system are
used.

Source Text file that contains the point pair
coordinates in the source system.

Target Text file that contains the point pair
coordinates in the target system.

The transformation derivation can be tested by using the Test button. This computes the
parameter values and displays the result in a report window. The report includes residuals
which determine how accurate the transformation works.

To create the transformation, click on the Create button. This opens the Transformation dialog
that displays the derived parameter values. Type a Name for the transformation and click OK in
order to add the transformation to the list in the Settings dialog.



TerraScan User Guide  © 2023 Terrasolid Ltd

55TerraScan Settings > Coordinate transformations / User projection systems >  

Coordinate transformations / User projection systems

User projection systems category in Coordinate transformations folder contains a list of user
defined projection systems. You can define your projection system based on Transverse
Mercator / Gauss-Krueger, Lambert conic conformal or Hotine oblique mercator projection.

A projection system definition can be divided into three distinct parts:

· Ellipsoid - defined by Semi-major axis and Inverse flattening.

· Datum - defined by seven parameter Bursa/Wolfe transformation.

· Projection - defined by the projection type, true origin, false origin, scale factor at the
central meridian, and distance unit.

The list of user projection system displays a toggle box for each row. The toggle box indicates
whether a projection system is active or not. Only active projection systems can be selected
when applying a transformation. To activate or deactivate a projection system, place a data click
inside its toggle box in the list.

You can Add, Edit, and Delete user projection systems by using the corresponding buttons in
the Settings dialog. The Copy button copies the selected projections system definition to the
clipboard. With the Paste button you can paste a projection system definition from the
clipboard.

To define a new projection system:

1. Open the User projection systems category in the Coordinate transformations folder.

2. Click Add in the Settings dialog.

This opens the Projection system dialog:
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3. Define settings and click OK.

4. Activate the projection system.

5. Close the Settings dialog in order to save the modified settings for TerraScan.

SETTING EFFECT

Name Descriptive name for the projection system.

Semi-major axis Semi-major axis of the target ellipsoid.

Inverse flattening Inverse flattening of the target ellipsoid.

Shift X Datum X shift from WGS84 to the target
system in meter.

Shift Y Datum Y shift from WGS84 to the target
system in meter.

Shift Z Datum Z shift from WGS84 to the target
system in meter.

Rotation X Datum rotation around the X axis in arc
seconds.

Rotation Y Datum rotation around the Y axis in arc
seconds.
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SETTING EFFECT

Rotation Z Datum rotation around the Z axis in arc
seconds.

Scale correction Datum scale correction as parts per million.
The actual scale factor is computed as 1.0 +
(0.000001 * ScaleFactor).

Projection type Type of the projection system: Transverse
Mercator/Gauss-Kruger, Lambert conic
conformal 1SP | 2SP, Hotine oblique
mercator, Swiss conic conformal.

Origin longitude Longitude of the true origin in decimal
degrees.

Origin latitude Latitude of the true origin in decimal
degrees.

False easting Map coordinate easting of the true origin.

False northing Map coordinate northing of the true origin.

Scale factor Scale factor on the central meridian.

Unit Distance unit: Meter, International foot, US
Survey Foot, or International yard.

You can copy user projection systems from one Terra application to another. Select the
system in the Settings dialog and click on the Copy button to copy the definition to the
clipboard. Click on the Paste button in the other Terra application to paste the definition. You
can also paste the definition in a text editor in order to save it into a text file.
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Default coordinate setup

Default coordinate setup category defines the default values for the coordinate setup of Terra
applications. The default values can be changed by using the Define Coordinate Setup tool.

SETTING EFFECT

Resolution Default integer steps per master unit in a
CAD file used by Terra applications. This
effects the number of decimals stored for
coordinate values of points in TerraScan.
Example: Resolution 100 per meter stores
coordinates with 2 decimals, which is
centimeter accuracy.

Easting Default easting coordinate of the CAD file
origin.

Northing Default northing coordinate of the CAD file
origin.

Elevation Default elevation coordinate of the CAD file
origin.
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Default flightline qualities

Default flightline qualities category defines quality tags for flightlines. These quality settings
are used by Cut overlap command in case trajectories have not been imported. The flightline
numbers refer to the line number attribute that can be stored for points in TerraScan.

A value range of 0 - 65535 refers to all possible line numbers. A value of -1 refers to no line
number.

SETTING EFFECT

Bad Line number range with Bad quality tag.

Poor Line number range with Poor quality tag.

Normal Line number range with Normal quality tag.
By default, this is the quality tag for all lines.

Good Line number range with Good quality tag.

Excellent Line number range with Excellent quality
tag.



TerraScan User Guide  © 2023 Terrasolid Ltd

60TerraScan Settings > Elevation labels >  

Elevation labels

Elevation labels category defines the format of elevation values drawn as text elements. The
settings are used when points are drawn into the CAD file using the Write to design file
command and if the points are drawn as Elevation labels which is set in the Define Classes
dialog.

SETTING EFFECT

Accuracy Number of decimals to display for elevation
values.

Display plus If on, positive elevation values start with a
plus (+) sign.

Display minus If on, negative elevation values start with a
minus (-) sign.
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File formats / Default storage format

Default storage format category in File formats folder defines what binary format is the default
storage format for laser data and what GPS time format is the default format for storing time
stamps. The formats are used by default for new projects in the Project information dialog
opened by New project command.

SETTING EFFECT

Format Default format for laser data: FastBinary, LAS
1.0, LAS 1.1, LAS 1.2, LAS 1.4, Scan binary 16
bit line, or Scan binary 8 bit lines.

Time type Default format for storing time stamps of
laser points: GPS seconds-of-week or GPS
standard time
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File formats / File name extensions

File name extensions category in File formats folder defines default file extensions for various
file formats. These extensions are expected for reading files in the corresponding formats and
used as default extensions when you output points from TerraScan. However, you can also read
files with different extensions as long as the format of the file is correct. You can also define
other extensions for each output step.

SETTING EFFECT

East North Z Extension for plain XYZ text files. Default is
xyz.

Code East North Z Extension for text files containing point class
and coordinates. Default is txt.

TerraScan binary Extension for 8-bit/16-bit binary files in
TerraScan format. Default is bin.

FastBinary Extension for files in TerraScan FastBinary
format. Default is fbi.

LAS binary Extension for binary files in LAS format.
Default is las.
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File formats / LAS formats

LAS formats category in File formats folder defines the bit depth of color values in LAS files. The
setting can be used to read LAS files with incorrectly stored color values.

SETTING EFFECT

Bit depth Bit depth of color values in the LAS file:

· Correct 16 bits - color values are stored as 16
bit values. This is the correct value according
to the LAS standard format definition.

· Low 12 bits - color values are stored as 12 bit
values.

· Low 8 bits - color values are stored as 8 bit
values.

Check bit depth in 'Read points' If on, the software checks color bit depth
when reading LAS files. If all color values are
between 0-255 (8 bit values), it automatically
scales the color values to proper 16 bit values.

Set the value to Low 8 bits or Low 12 bits if your read or import LAS files with incorrect color
values. Set the value to Correct 16 bits in order to store color values correctly. Switch on the
Check bit depth in 'Read points' option in order to enable automatic scaling of color values.
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File formats / LAZ formats

LAZ formats category in File formats folder defines the bit depth of color values in LAZ files. The
setting can be used to read LAZ files with incorrectly stored color values.

SETTING EFFECT

Bit depth Bit depth of color values in the LAZ file:

· Correct 16 bits - color values are stored as 16
bit values. This is the correct value according
to the LAS standard format definition.

· Low 12 bits - color values are stored as 12 bit
values.

· Low 8 bits - color values are stored as 8 bit
values.

Check bit depth in 'Read points' If on, the software checks color bit depth
when reading LAZ files. If all color values are
between 0-255 (8 bit values), it automatically
scales the color values to proper 16 bit values.

Set the value to Low 8 bits or Low 12 bits if your read or import LAZ files with incorrect color
values. Set the value to Correct 16 bits in order to store color values correctly. Switch on the
Check bit depth in 'Read points' option in order to enable automatic scaling of color values.
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File formats / Leica formats

Leica formats category in File formats folder defines rules how to interpret intensity values
coming from specific Leica file formats.

SETTING EFFECT

Read Reading intensity of Leica LDI files: Raw
intensity or Normalized intensity.
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File formats / Optech formats

Optech formats category in File formats folder defines rules how to interpret data coming from
specific Optech file formats.

SETTING EFFECT

Scale intensity Factor for scaling intensity values.

Use as last echo Defines which value is used as last echo: First
xyz, Second xyz, or Lower xyz.

Ignore first echoes If on, TerraScan filters out first echoes from
Optech xyzxyzii type files based on the
elevation difference of the first and last
echo.

Less than First echos less than the given elevation
difference above the corresponding last echo
are ignored. This is only active if Ignore first
echoes is switched on.
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File formats / User group formats

User group formats category in File formats folder contains a list of user-defined group formats.
You can define your own formats which can be used for the output of group information. The
file format definition determines what attributes are included for each group and what is the
order of the attribute fields in the output file.

The fields in the output files are delimited by either comma, space, tabulator or semicolon.

You can Add, Edit and Delete group formats by using the corresponding buttons in the Settings
dialog. The Copy button creates an identical copy of a selected format definition. The Move up
and Move down buttons change the order of formats in the list.

The following attributes can added to a group output file:

· Group id - TerraScan group number.

· Point count - amount of points in the group.

· Average easting, northing, z - average XYZ coordinates derived from the group.

· Ground z at average xy - ground elevation at the group's average XY position.

· Trunk easting, northing, z - XYZ coordinates derived from the tree trunk.

· Trunk diameter - diameter of the tree trunk. This requires circular elements drawn in the
CAD file that represent the trunk diameter. The elements may be created by the Measure
Trunk Diameters tool.

· Canopy width - biggest width of a tree canopy derived from the group.

· Biggest distance - point with the biggest distance above ground. This is derived from the
distance computation above ground.

· Smallest distance - point with the smallest distance above ground. This is derived from the
distance computation above ground.

· Length - length of the group.

· Width - width of the group.

· Height - height of the group.

There are two example formats provided in the settings category. The examples are dedicated
to export tree information.

To define a new group format:

1. Open the User group formats category in the File formats folder.

2. Click Add in the Settings dialog.

The Group File Format dialog opens:
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3. Type a Name for the format.

4. Select a Delimiter for separating the attribute fields in the output file.

5. Click Add in order to add new attributes to the format.

This opens the Group Field dialog:

6. Select an attribute from the list of Fields and click OK.

This adds the attribute to the list in the Group File Format dialog. Repeat steps 5 and 6 for all
attributes you want to add to the group file format.

7. Click OK to the Group File Format dialog.

8. Close the Settings dialog in order to save the modified settings for TerraScan.

User group formats are stored in a configuration file GROUP_FORMATS.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make point file
formats available on them.
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File formats / User point formats

User point formats category in File formats folder contains a list of user-defined point formats.
You can define your own formats which can be used for the input or output of point data. The
software can read any text files where each row contains the information of one point and the
point attributes are organized in columns (fields). The file format definition determines what
fields are included for each point and what is the order of the fields.

The text file formats may contain delimited fields or fixed length fields. The delimiter can be
comma, space, tabulator, or semicolon. A fixed length fields is defined by constant column
widths and positions in each row.

You can Add, Edit, and Delete point formats by using the corresponding buttons in the Settings
dialog. The Copy button creates an identical copy of a selected format definition. The Move up
and Move down buttons change the order of formats in the list.

The following attributes can be imported/exported from/to text files:

· No field - no field defined in the text file.

· Ignore - the column in the text file is ignored. This applies only for importing text files into
TerraScan.

· Easting, Northing, Elevation - XYZ coordinates.

· Longitude, Latitude - position in degrees, minutes, and seconds.

· Class - class number.

· Code - class code. Can be defined in the Define classes dialog of TerraScan.

· Echo type - echo type as text string. Possible values are 'First', 'Last', 'Intermediate', and
'Only'.

· Index - unique number for each point.

· Intensity - intensity value as integer.

· Line - line number.

· Time - time stamp.

· Collection - number of collection shape. Only used with Output collections command for
projects (Not UAV).

· Group - group number. Can be assigned automatically to point groups by using the Assign
groups command or macro action, or manually by using the Create point group tool.

· Surface dz - difference between a point and a TerraModeler surface. This requires that a
surface model is loaded into TerraModeler.

· Red 8|16, Green 8|16, Blue 8|16 - RGB color values. The number determines the color depth
which can be either 8-bit or 16-bit. Color values can be assigned to points by using the
Extract color from images command, or the Assign color to points command or macro action.

· Echo number - echo number as number.

· Number of echos - total number of echos at the position of a point.

· Scan angle - scan angle in degree or integer units as defined in LAS 1.4 file format. Select the
correct format in the Scan angles selection list that appears in the dialog if the attribute is
selected for one of the fields. Degree values must range between -128 to +127.

· Scanner - scanner number.

https://terrasolid.com/guides/tscan/prjoutputcollections.html
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· Image - image number. An image number can be computed and stored for points if the
corresponding setting in the Extract color from images command is set.

· Distance - distance value computed with the Compute distance command or macro action.

· Echo length - echo length value. The value can be extracted from waveform information in
TerraScan using the Extract echo properties command. It can also be provided system-
specific, such as by Riegl Extra Bytes attribute Pulse width.

· Parameter - parameter value. The value may be set from an attribute of a system-specific
point format, such as Riegl Extra Bytes in LAS files.

· Dimension - dimension attribute computed with Compute normal vector command or macro
action.

· Normal X, Normal Y, Normal Z - XYZ normal vector components computed with Compute
normal vector command or macro action.

To define a new point format:

1. Open the User point formats category in the File formats folder.

2. Click Add in the Settings dialog.

The File Format dialog opens:

3. (Optional) Select Load example command from the File pulldown menu of the File Format
dialog. Select an example file of the format you want to define.

This reads the first lines of the text file and shows its content in the field list. The software
also tries to detect the Field type and the Delimiter.

4. If required, change the number of fields that are available in the dialog by using the
commands from View pulldown menu. You can choose between 8, 10, 15 or 20 fields.

5. Type a Format name and define the other settings.
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6. Select the correct attribute for each field you want to import.

7. Click OK to the File Format dialog.

8. Close the Settings dialog in order to save the modified settings for TerraScan.

SETTING EFFECT

Format name Descriptive name of the new format.

Use for Defines the usage of the format:

· Input only - files of this format can be
loaded into TerraScan using the Read points
command or the Load Airborne Points tool.

· Output only - files of this format can be
saved into new text files using the Save
points As command or the Output points,
Output by line macro actions.

· Input and output - files of this format can be
loaded into TerraScan and saved into new
text files.

Field type Defines fields are separated in the text file:
Delimited or Fixed length.

Delimiter Delimiter character used in text files: Space,
Tabulator, Comma, or Semicolon. This is only
active if Field type is set to Delimited.

Comment char Character that introduces comment lines in
the text file. Lines beginning with this
character are ignored when points are read
from a text file.

Prepend file Location of a text file from which the content
is added at the beginning of an output file.
This is not active if Use for is set to Input only.

Append file Location of a text file from which the content
is added at the end of an output file. This is
not active if Use for is set to Input only.

There are some text file format already implemented in TerraScan. See Supported file
formats for a list of implemented file formats. User point formats are stored in a
configuration file OUTFMT.INF in the TerraScan installation folder. You can copy this file to
other computers in order to make point file formats available on them.
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File formats / User trajectory formats

User trajectory formats category in File formats folder contains a list of user-defined trajectory
formats. You can define your own file formats which can be used when reading in trajectory
information from text files.

For the definition of trajectory formats, the same steps and settings apply as for point formats
described above in File formats / User point formats. The differences in usage and attributes
are listed in the table below.

SETTING EFFECT

Use for Defines the usage of the format:

· Input only - files of this format can be
loaded into TerraScan using the Import files
command from the Manage Trajectories
dialog.

· Output only - files of this format can be
saved into new text files using the Output
positions command from the Manage
Trajectories dialog.

· Input and output - files of this format can
be loaded into TerraScan and saved into
text files.

No field Selection of what trajectory position attribute
is stored in the field:

· No field - no field defined in the text file.

· Ignore - the column in the text file is
ignored.

· Time - time stamp.

· Easting, Northing, Elevation - XYZ
coordinates.

· Longitude, Latitude - position in degrees,
minutes, and seconds.

· Heading, Roll, Pitch - orientation angles.

· Quaternion0...3 - rotation expressed as
quaternion values.

· X|Y|Z accuracy - accuracy estimates for XYZ
position values.

· Heading|Roll|Pitch accuracy - accuracy
estimates for orientation angle values.

Trajectory formats are stored in a configuration file TRAJFMT.INF in the TerraScan installation
folder. You can copy this file to other computers in order to make trajectory formats available
on them.
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Loaded points

Loaded points category defines the symbology for highlighting selected points in TerraScan. It is
used, for example, if the location of several selected points is shown by using the Show
location button in the TerraScan window.

SETTING EFFECT

Hilite color Color for the rectangles drawn around
selected points. Uses the active color table of
the CAD file.

Hilite weight Line weight for the rectangles drawn around
selected points. Uses standard line weights.
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Manual classification tools / Classify Above Line

Classify Above Line category in Manual classification tools folder defines display settings for
the temporary help lines for the Classify Above Line tool.

SETTING EFFECT

Color Color of the help lines. Uses the standard
Windows dialog for selecting a color.

Weight Line weight of the help lines. Uses standard
line weights.

Vertical lines Line style of the vertical help lines. Uses
standard line styles.
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Manual classification tools / Classify Below Line

Classify Below Line category in Manual classification tools folder defines display settings for
the temporary help lines for the Classify Below Line tool.

SETTING EFFECT

Color Color of the help lines. Uses the standard
Windows dialog for selecting a color.

Weight Line weight of the help lines. Uses standard
line weights.

Vertical lines Line style of the vertical help lines. Uses
standard line styles.
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Manual classification tools / Classify Close to Line

Classify Close to Line category in Manual classification tools folder defines display settings for
the temporary help lines for the Classify Close to Line tool.

SETTING EFFECT

Color Color of the help lines. Uses the standard
Windows dialog for selecting a color.

Weight Line weight of the help lines. Uses standard
line weights.

Vertical lines Line style of the vertical help lines. Uses
standard line styles.
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Manual classification tools / Classify Fence tool

Classify Fence tool category in Manual classification tools folder defines settings for the
temporary display of help lines for the Classify Fence tool.

SETTING EFFECT

Color Color of the help lines. Uses the standard
Windows dialog for selecting a color.

Weight Line weight of the help lines. Uses standard
line weights.

Style Line style of the help lines. Uses standard
line styles.
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Manual classification tools / Classify Using Brush

Classify Using Brush category in Manual classification tools folder defines display settings for
the mouse pointer shape of the Classify Using Brush tool. Color and weight settings can be
defined for the inactive and active state of the tool.

SETTING EFFECT

Color Color of the mouse pointer shape
representing the brush. Uses the standard
Windows dialog for selecting a color.

Weight Line weight mouse pointer shape
representing the brush. Uses standard line
weights.
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Object library

Object library category shows a list of object definitions that can be used for automatic object
detection. Currently, poles are the objects that can be detected automatically from very dense
point clouds, such as mobile scanning point clouds. Find poles tool makes use of the object
library.

Object detection in TerraScan relies on the computation of distance from ground and groups of
points with a certain shape. Therefore, it is required to compute distance and assign groups in a
point cloud in order to define an object in the Settings and to detect objects. For object
definition, it is further required to classify the static parts of a sample object in order to
separate them from the variable parts of the object. Distance computation, group assignment,
and classification can be done using the menu commands for loaded points in the TerraScan
window, manual classification tools, or macro actions.

Sample point cloud for object definition. Classification of static (blue)/variable parts (green) shown on the left and
group shown in the center image.

 The right image shows a vertical cross section of the sample point cloud for object definition. The arm of the pole
points in the direction of the alignment, such as the trajectory line.

The object detection can be supported by an alignment element, a line element drawn in the
CAD file. A trajectory line drawn in the CAD file can be used as alignment. The object definition
defines whether an object is located left or right of the alignment or, with other words,
whether the scanner system was driven on the left side or right side of the object. It is
recommended to use an alignment in order to speed up object detection significantly.

In the object detection process, the software classifies points on objects into a given class. The
object definition determines the target class.

(MicroStation only) In addition, it may place cell elements in the CAD file. A cell element can be
created using MicroStation tools for cell management. Cells are stored in cell libraries. A cell
library must be attached to the CAD file before cells from the library can be used. The object
definition determines the name of the cell that is placed for a certain object type.

The object items of the library are stored in text files in the TerraScan installation folder, for
example C:\TERRA64\TSCAN\OBJECT_LIBRARY. The text file stores the points belonging to the
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group in the sample point cloud using object coordinates. The origin of the object group is
defined by the base point of an object and set to XYZ = 0,0,0 in the object coordinate system.
The X axis points in cross section direction of the object (to the right in a cross section view),
the Y axis is perpendicular to the X axis (away from the viewer in a cross section view), and the
Z axis points upwards (up in a cross section view).

You can Add, Edit, and Delete objects by using the corresponding buttons in the Settings dialog.
The delete action deletes the object definition from the settings but it does not delete the
object text file from the object library folder.

To add a new object item to the library:

1. Open the Object library category

2. Choose a sample object in the point cloud. You may create a separate file from the sample.

3. (Optional) Make sure that the sample represents an "ideal" object, for example, a vertical
pole. You may rotate the sample point cloud of a leaning pole by using the Rotate points
button in the Settings dialog.

4. (Optional) Create a cell element by using MicroStation tools for cell management. (Not Spatix)

If distance computation and grouping is not yet done for the point cloud, it must be done for
the sample before an object can be defined.

5. Draw an accurate vertical cross section of the sample object. If the object has a horizontal
cross arm, the centerline of the section should follow the direction of the cross arm
accurately.

6. Click Add in the Settings dialog.

The Object Item dialog opens:
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7. Define settings and click OK.

8. Define the object base point with a data click in the cross section view.

The base point defines the origin of the object in an object coordinate system. You may snap
to a point at ground level in order to define the base point.

9. Define the group which defines the object with another data click close to points of the
group.

This adds the object to the library.

10. Close the Settings dialog in order to save the object library settings for TerraScan.

SETTING EFFECT

Match class Point class used for defining the sample
object. The class should contain point from
the static parts of an object. This is only
available when a new object is added. The
setting is not available when an existing
object item is edited.

Type Type of the object:

· Pole - single vertical column - pole object
with a single column and maybe horizontal
parts.
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SETTING EFFECT

· Pole - complex - pole object of a more
complex structure.

Alignment Location of an object relative to an alignment
element:

· Not defined - no location relative to an
alignment is defined.

· On left side - the alignment is located left of
the sample object.

· On right side - the alignment is located right
of the sample object.

To class Point class into which points of groups of this
object type are classified.

Name Name of the object item. Defines the name of
the text file created for this object item.

Cell Name of the cell element that is placed for
the object item. The same name must be used
for the cell element in a MicroStation cell
library.

Clip at ground If on, the cell element is clipped at ground
level. Parts under ground are removed from
the cell element.

Height variation Maximum variation of the height of the
object.

Diameter Approximate diameter of the pole column.
This is only available if Type is set to Pole -
single vertical column.

Max lean Maximum angle by which an object may be off
from vertical.

Require match Determines how well an object must match
the sample object definition in order to be
detected as this object type.

At center The two Z tolerances values determine the
elevation variation of points on vertical parts
relative to horizontal parts of an object in the
point cloud compared to the sample object
point cloud.
In very dense MLS point clouds, points on the
edge of objects, such as vertical arms of street
lamps, railway posts, etc. vary more than
points on the central vertical part of the
object. Thus, At edge value should be larger
than At center value, for example 1.0 vs. 3.0.
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SETTING EFFECT

In less dense ALS point clouds, horizontal
parts of objects, such as powerline tower
arms, are represented more confidently and
with less variation than vertical parts. Thus, At
center value should be larger than At edge
value, for example 3.0 vs. 2.0.

At edge

Object definitions are stored in a configuration file OBJECT_LIBRARY.INF in the TerraScan
installation folder. The sample objects in the library are stored in folder \OBJECT_LIBRARY as
text files with the extension .XYZ. You can copy these files to other computers in order to
make object definitions available on them.

Rotate points

Rotate points can be used to rotate a sample point cloud in a section view. This may be
required, for example, to get a sample pole object vertical.

To rotate points:

1. Draw a vertical cross section of the object. The vertical part of the object should be clearly
visible in the section. If the object has a horizontal cross arm, the centerline of the section
should follow the direction of the arm accurately.

2. Select Rotate points button in the Object library category of the Settings.

3. Define a first base point with a data click, for example close to the lower end and on the left
side of a pole.

The software shows a horizontal line at the mouse pointer location which acts as a helping
line for defining the base of a vertical object.

4. Define a second base point with another data click on the right side of a pole.

The software shows a vertical helping line which extends dynamically with the mouse
pointer movement.

5. Define a first top point with a data click, for example close to the upper end and on the left
side of a pole.

The software shows a horizontal line at the mouse pointer location which acts as a helping
line for defining the top of a vertical object.

6. Define a second top point with another data click on the right side of a pole.

This rotates the point cloud according to the four points defined with data clicks.

7. Use the Cut section tool in order to create another vertical section of the pole that is
perpendicular to the previous section.

8. Repeat steps 2 to 6 in order to rotate the pole in the second section view.
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Create a MicroStation cell element

Not Spatix

A MicroStation cell element can be placed by TerraScan for representing an object. The cell may
be a simple 2D symbol or a more complex 3D structure. The cell origin should be the same as
the origin/base point of the TerraScan object group. For objects standing on the ground, the
origin should be on the ground.

MicroStation cell elements are stored in cell libraries. A cell library is stored in files with the
extension .CEL. In order to create, modify, or use a cell element, the cell library must be
attached to the CAD file.

Example workflow for creating a cell element:

1. Draw a vertical cross section of the object. If the object has a horizontal cross arm, the
centerline of the section should follow the direction of the arm accurately.

A line element drawn in the center of the cross arm and following its direction may be used
as helping line for creating accurate cross section views and for making the section view
creation repeatable.

2. (Optional) Draw another helping line that starts from the center base point of the object. For
a single-column pole object, the base point is the center of the column at ground elevation.
Use, for example, Mouse point adjustment tool in order to place the helping line start point
exactly at ground elevation.

3. Digitize the object using MicroStation tools. The object may be represented by lines, shapes,
or any other MicroStation element type. Several elements of different types may form a cell.
Snap to the start point of the helping line created in step 2 in order to place the base point of
the cell on the ground. You may use any drawing aids of MicroStation for digitizing the
elements of the cell.

4. Extend the base point of the object below the ground. For example, if the height of an object
may vary by around 1.5 m, extend the base point to about 2 m below ground. You may use,
for example, the Extend Line tool of MicroStation in order to extend a line element to a
specified distance below ground.

5. Select Define Cell Origin tool of MicroStation. Snap to the start point of the helping line
created in step 2 and place the origin of the cell with a data click. The cell origin should be
located on the base point of the object at ground elevation.

6. Select all elements that form the cell for the object.

OR

6. Select Place Fence tool of MicroStation. Set Fence Type to be Block or Shape, and Fence
Mode to be Inside. Place a fence that includes completely all elements that form the cell for
the object. Do not include the helping lines. 

7. Open the Cell Library window of MicroStation.
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8. Select New command from the File pulldown menu in order to create a new cell library.
Define a location and name for storing the library.

OR

8. Select Attach file command from the File pulldown menu in order to attach an existing cell
library. Browse to the storage location and select the library file.

9. Select the Create button from the Cell Library window. The button is only active if a cell
origin has been placed and if elements are selected or inside a fence (steps 5 and 6).

10. Define a name and description of the cell. The cell name is the link between the TerraScan
object item and the cell element. Select cell type Graphic and click Create.
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Operation

Operation category defines actions performed when TerraScan is loaded.

SETTING EFFECT

Open Main window If on, the TerraScan window is opened.

Open Main tool box If on, the TerraScan toolbox is opened.

Close AccuDraw If on, the MicroStation AccuDraw is closed.
This has no effect in Spatix.

Set AccuSnap off If on, the MicroStation AccuSnap is
deactivated. This has no effect in Spatix.

Maximum Maximum amount of threads used for
TerraScan processing. Normally, you should
set this to the number of processor cores of
your computer or a bit higher.
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Point display

Point display category determines how points in TerraScan are drawn on the screen relative to
other CAD file or Terra Application elements. It also defines default display settings as well as
various additional settings related to more specific point display in TerraScan.

SETTING EFFECT

Display method

Order Order of drawing points on the screen relative
to other elements, such as vector data in the
CAD file, images in TerraPhoto, surface
models in TerraModeler:

· Before vectors - point are drawn first on the
screen, before other elements. This means,
they are displayed behind other elements
in CAD file views.

· After vectors - points are drawn last on the
screen, after other elements. This means,
they are displayed in front of other
elements in CAD file views.

Ignore 'Borders' in section view If on, the setting for Borders is not applied to
any section views.

Default display mode settings - The values can be changed in the Display mode dialog.

Weight Default size of points on the screen. Can be
defined by point class or uses standard line
weights.

Speed Default speed for point display:

· Fast - sparse points - amount of displayed
points depends on the zoom factor. If you
zoom out, only a subset of points is drawn.
This is the recommended setting for
displaying a larger amount of points.

· Normal - more points are drawn. The
software decides based on the density of
the point cloud. In sparse data sets, this
already draws all points.

· Slow - all points - all points are drawn at
every zoom level. This may slow down the
display speed for a large amount of points.

Borders Default setting for enhanced depth display of
the point cloud. The setting determines how
much space on the screen is covered by black
borders that separate foreground points from
background points. An enhanced depth
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SETTING EFFECT

perception can be achieved by displaying
points with Borders > 0. See also the
description of the setting in the Display mode
dialog.

Coloring schemes - The same action can be performed for the corresponding coloring modes
in the Display mode dialog.

Fit automatically If on, color schemes for displaying points by
elevation and intensity are fitted
automatically to the corresponding values of
points when they are loaded into TerraScan.

If off, the software keeps the elevation and
intensity values of the previous data set for
the color schemes.

Background in camera views

Draw sky if ‘Use depth’ is on If on, the background of camera views is
drawn as “sky color scheme” (blue to black
color gradient). This effects views for which
the Borders setting is > 0 in the Display mode
dialog. It may result in a more realistic point
cloud visualization, especially for mobile
ground-based data sets.

Group coloring mode - Refers to the Group coloring mode in the Display mode dialog.

Display non-grouped points If on, points that are not assigned to any group
are displayed with the color selected in the
color field. Click on the color field in order to
select the display color. Uses the active color
table of the CAD file.

Vegetation index limits - Refers to the Vegetation index coloring mode in the Display mode
dialog.

Normalized difference Threshold value for displaying points by
Vegetation index / Normalized difference
method. The default value is 0.0, difference
values may range from -1 to +1.

Visual band difference Threshold value for displaying points by
Vegetation index / Visual band difference
method. The default value is 0.05, difference
values may range from -1 to +1.
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Powerlines / Active line

Active line category in Powerlines folder defines settings for the display of an active powerline
line string. The settings effect the display of a line string element after it has been selected by
the Activate Powerline tool.

SETTING EFFECT

Hilite Parts of the line string that are highlighted:
No hilite, Vertices, or Line segments.

Color Color of a highlighted line string. Uses the
active color table of the CAD file.

Weight Line weight of a highlighted line string. Uses
standard line weights.

Style Line style of a highlighted line string. Uses
standard line styles.
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Powerlines / Profile layouts

Profile layouts category in Powerlines folder contains a list of user defined profile layouts. Each
layout definition contains a list of data rows that appear below the profile. Currently, the
software doesn't use profile layouts in any tool or command.

You can Add, Edit, and Delete profile layouts by using the corresponding buttons in the Settings
dialog. The Copy button creates an identical copy of a selected layout definition. You can Add,
Edit, and Delete bottom rows to a profile layout by using the corresponding buttons in the
Profile layout dialog.

To define a new profile layout:

1. Open the Profile layouts category in the Powerlines folder.

2. Click Add in the Settings dialog.

The Profile layout dialog opens.

3. Type a Name for the profile layout.

4. Click Add in the Profiles layout dialog in order to add a new data row that is displayed below
a profile.

The Profile Bottom Row dialog opens:

5. Define Basic information settings.

6. Select an auto-text option for the Content list as well as additional settings depending on the
content selection. Choose Other as Content if nothing of the list entries fit to your data.
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7. Select settings for Draw frame lines.

8. Click OK in the Profile Bottom Row dialog.

9. Add more data rows if necessary.

10. Click OK to the Profile layout dialog.

11. Close the Settings dialog in order to save the profile layout settings for TerraScan.

SETTING EFFECT

Title 1 Text used as first line of a title in the bottom
row.

Title 2 Text used as second line of a title in the
bottom row.

Height Height of the bottom row. Given in
millimeters on paper.

Content Defines the type of information displayed in
the bottom row:

· Stationing - stations along the alignment
element of the profile.

· Surface elevations - elevations of surfaces
of the given Surface type. This refers to
surfaces loaded in TerraModeler.

· Tower base z - elevation of a tower base
point.

· Tower turn angle

· Tower span

· Crossing object stationing - station along the
alignment element where another object
crosses the powerline.

· Other - space reservation for any other
content that can be added manually.

Vertical lines on the sides If on, vertical lines are drawn on the left and
right side of the bottom row.

Horizontal line below If on, a horizontal line is drawn below the
bottom row using the selected color, line
weight and style.

https://terrasolid.com/guides/tmodel/index.html
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Powerlines / Tower functions

Tower functions category in Powerlines folder contains a list of different functions for
powerline towers. Typical function examples are suspension towers, tension towers, and dead-
end towers.

You can Add, Edit, and Delete tower functions by using the corresponding buttons in the
Settings dialog.

A tower function is defined by an Abbreviation and a Description which can be typed in the
fields of the Tower Function dialog.

The tower function is applied when the tower model is placed using the Place Tower tool. The
information can be included in a report created by the Export Powerline tool.

Tower functions are stored in a configuration file TOWER_FUNCTIONS.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make tower
functions available on them.
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Powerlines / Tower statuses

Tower statuses category in Powerlines folder contains a list of different statuses for powerline
towers. Status examples may be existing, planned, broken, etc.

You can Add, Edit, and Delete tower statuses by using the corresponding buttons in the Settings
dialog.

A tower status is defined by an Abbreviation and a Description which can be typed in the fields
of the Tower status dialog.

The tower status is applied when the tower model is placed using the Place Tower tool. The
information can be included in a report created by the Export Powerline tool.

Tower statuses are stored in a configuration file TOWER_STATUSES.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make tower statuses
available on them.
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Powerlines / Tower types

Tower types category in Powerlines folder contains a list of user-defined tower types. The
tower type determines the general design of a tower, including the number, position and
length of cross arms and attachments.

The values defined for the tower height as well as position and length of cross arms and
attachments do not have to be exact if towers are placed with the Place Tower tool using no
template. For placing towers using templates the accuracy of the values determine how well a
template fits to the real towers design.

It is recommended to enter a text in the Description fields of Tower Type and Tower Type Cross
Arm dialogs, because the editing tools for powerline processing refer to this field. The other
descriptive information is mainly used in reports. See Chapter Powerlines for more information
about powerline processing.

You can Add, Edit, and Delete tower types by using the corresponding buttons in the Settings
dialog. You can Add, Edit, and Delete cross arms and attachments for a tower type by using the
corresponding buttons in the Tower type dialog.

To add a new tower type:

1. Open the Tower types category in the Powerlines folder.

2. Click Add in the Settings dialog.

The Tower Type dialog opens:
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3. Define Abbreviation, Description and Height values.

SETTING EFFECT

Abbreviation Abbreviation of the tower type.

Description Description of the tower type.

Height Height of a tower.

Cross arms List of cross arms for this tower type. Use
buttons next to the list to Add, Edit, and
Delete cross arms.

Attachments List of attachments per cross arm. Select a
cross arm and use buttons next to the list to
Add, Edit, and Delete cross arms.

4. Click Add in the Tower Type dialog in order to add a cross arm.

This opens the Tower Type Cross Arm dialog:
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5. Define settings and click OK.

SETTING EFFECT

Number Number of the cross arm. Increases
automatically for each new arm added to the
tower type.

Description Description of the cross arm.

Position Position of the cross arm relative to the top
of the tower.

Left length Length of the cross arm to the left side of the
tower.

Right length Length of the cross arm to the right side of
the tower.

6. Repeat steps 4 and 5 for all cross arms that belong to this tower type.

7. Select a cross arm and click Add in the Tower Type dialog in order to add an attachment to the
selected cross arm.

This opens the Tower Type Attachment dialog:

8. Define settings and click OK.
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SETTING EFFECT

Number Number of the attachment. Increases
automatically for each new attachment
added to a cross arm.

Description Description of the attachment.

Offset Position of the attachment along the cross
arm relative to the tower center. A positive
offset creates an attachment right of the
tower center, a negative offset left of the
tower center.

Length Length of the attachment.

9. Repeat steps 7 and 8 for all attachments per cross arm and all cross arms of the tower type.

10. Click OK to the Tower type dialog.

11. Close the Settings dialog in order to save the tower type settings for TerraScan.

Tower types are stored in a configuration file TOWER_TYPES.INF in the TerraScan installation
folder. You can copy this file to other computers in order to make tower types available on
them.
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Rail section templates

Rail section templates category shows a list of rail section definitions that can be used for
automatic rail vectorization using the Find Rails tool.

A drawing of the rail section can be used to define the geometry of a rail section template. Both
rails of the rail section must be drawn into a CAD file using the correct measures. It is an
advantage to draw them in a way that the center point of the rail section is at the CAD file origin
(coordinates XY = 0,0). As an alternative, you can also define a rail section by typing the start
and end point coordinates of section lines in an input dialog.

You can Add, Edit, and Delete rail section templates by using the corresponding buttons in the
Settings dialog. You can Add, Edit, and Delete parts of a rail section templates by using the
corresponding buttons in the Rail section template dialog.

To add a new rail section:

1. (Optional) Draw the rail section into a CAD file and select it.

2. Open the Rail section templates category.

3. Click Add in the Settings dialog.

The Rail Section Template dialog opens:

If a section drawing has been selected, the section definition is shown in the dialog.

The dialog shows the list of rail section elements on the left side. A preview of the rail
section is shown on the right side. In the preview, horizontal elements are drawn in blue,
vertical elements in black, void elements in red. Elements of high weight are drawn with a
thicker line, medium and low weight elements with thinner lines. Alignment positions are
marked with a small red dot. An element selected in the list is highlighted in green in the
preview.

4. Type a Name for the rail section.
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5. Click Add in the Rail Section Template dialog in order to add a new element to the section.

OR

6. Select a line in the list of section elements and click Edit in the Rail Section Template dialog
in order to edit an existing element of the section.

The Rail Section Line dialog opens:

7. Define settings and click OK.

8. Add/Edit more elements of the section if necessary.

9. Click OK in the Rail Section Template dialog.

10. Close the Settings dialog in order to save the rail section template settings for TerraScan.

SETTING EFFECT

Type Type of the rail section line:

· Horizontal - horizontal line as part of the rail
section. Used to find the Z location of a rail
in automatic rail detection.

· Vertical - vertical line as part of the rail
section. Used to find the XY location of a rail
in automatic rail detection.

· Void - line that indicates a location without
laser data close to rails.

· Alignment - location of linear vector
elements that are drawn in automatic rail
vectorization.

Weight Weight of a rail section line: Low, Medium, or
High. A line with higher weight takes priority
over lines with lower weights in automatic rail
detection. This is only active if Type is not set
to Alignment.

Start X | Y
End X | Y

Start and end point coordinates of a rail
section line. Given in the rail section’s
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SETTING EFFECT

coordinate system. The origin of the system
(0,0) should be in the center of the rail
section. This is only active if Type is not set to
Alignment.

Position X | Y Location of an alignment element. Given in
rail section’s coordinates. This is only active if
Type is set to Alignment.

Rail section templates are stored in a configuration file RAIL_SECTIONS.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make rail section
templates available on them.
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Road paint markings / Crosswalks

Crosswalks category in the Road paint markings folder shows a list of templates for crosswalk
digitization using the Place Crosswalk tool.

A crosswalk template defines the width of the paint lines forming a crosswalk as well as the
approximate distance between the paint lines.

You can Add, Edit, and Delete crosswalk templates by using the corresponding buttons in the
Settings dialog.

To add a new crosswalk template:

1. Open the Road paint markings / Crosswalk category.

2. Click Add in the Settings dialog.

The Crosswalk dialog opens:

3. Type a Name for the crosswalk template.

4. Define Width and Spacing settings and click OK.

5. Close the Settings dialog in order to save the crosswalk template settings for TerraScan.

SETTING EFFECT

Name Free definition of a name for the crosswalk
template.

Width Width of the paint lines forming the
crosswalk.

Spacing Approximate spacing between the paint
lines. This is slightly adjusted when a
crosswalk is digitized.

Crosswalk section templates are stored in a configuration file CROSSWALKS.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make
crosswalk templates available on them.
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Road paint markings / Paint line report lengths

Paint line report lengths category in the Road paint markings folder defines the list of line
length categories used in Output Paint Report tool.

You can Add, Edit, and Delete line length categories by using the corresponding buttons in the
Settings dialog.

To add a new length category:

1. Open the Road paint markings / Paint line report lengths category.

2. Click Add in the Settings dialog.

The Paint Line Length dialog opens:

4. Define Line length setting and click OK.

5. Close the Settings dialog in order to save the paint line report length settings for TerraScan.

Paint line report lengths are stored in a configuration file PAINT_LINE_LENGTHS.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make same
length categories available on them.
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Road paint markings / Paint line report widths

Paint line report widths category in the Road paint markings folder defines the list of line
length categories used in Output Paint Report tool.

You can Add, Edit, and Delete line width categories by using the corresponding buttons in the
Settings dialog.

To add a new width category:

1. Open the Road paint markings / Paint line report widths category.

2. Click Add in the Settings dialog.

The Paint Line Width dialog opens:

3. Define Line width  setting and click OK.

4. Close the Settings dialog in order to save the paint line report width category settings for
TerraScan.

Paint line report widths are stored in a configuration file PAINT_LINE_WIDTHS.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make same
width categories available on them.
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Road paint markings / Paint markings

Paint markings category in the Road paint markings folder shows a list of Paint marking groups
and for each group, the list of templates of Paint markings.

A drawing of the paint marking is used to define the geometry of a paint marking template.
Technical drawings of paint markings may be provided, for example, by the road
administration.

You can Add, Edit, and Delete paint marking templates by using the corresponding buttons in
the Settings dialog.

To add a new paint marking:

1. Draw the paint marking into a CAD file and select it.

2. Open the Road paint markings / Paint markings category.

3. (Optional) Click Add next to the Paint marking groups field in the Settings dialog.

This opens the Paint Marking Group dialog:

4. Type a name for the new group and click OK.

OR

3. Select an existing Paint marking group from the list.

5. Click Add next to the Paint markings field in the Settings dialog.

6. Define the origin of the paint marking with a data click. This may be supported by snapping to
a vertex or boundary line of the drawing.

The data click opens the Paint Marking dialog:
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The paint marking drawing is shown in the dialog, the red dot indicates the origin point.

7. Type a Name and a Cell name for the paint marking.

8. Click OK in the Paint Marking dialog.

9. Close the Settings dialog in order to save the paint marking settings for TerraScan.

SETTING EFFECT

Name Free definition of a name for the paint
marking.

Cell Free definition of a cell name for the
paint marking. The cell name may be
used to identify all paint markings of
the same type in a CAD file.

Rotate the paint marking template
clockwise or counterclockwise in 90
degree steps.

Paint marking templates are stored in a configuration file PAINT_MARKINGS.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make paint
marking templates available on them.
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Road section parameters

Road section parameters category defines level, color, text size, and unit settings for drawing
road section parameter elements into the CAD file. The settings effect the display of elements
that have been detected with the macro action Compute section parameters and drawn into
the CAD file using the Read / Section parameters command. The description of the macro action
contains a detailed explanation of the different road section parameters.

SETTING EFFECT

Level CAD file level on which the different road
section parameters are drawn.

Color Color of the different road section
parameters. Users the active color table of
the CAD file.

Text size Size of text elements that are drawn for the
different road section parameters.

Unit Unit for expressing the different road section
parameter values. Slopes can be expressed in
Degree or Percentage, other parameters can
be expressed in Master units of the CAD file
or in Millimeters on paper.
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Scanner systems

Scanner systems category shows a list of scanner system configurations. A scanner system can
include several scanners where each scanner has its own lever arm definition. The system
definition also defines the misalignment between the IMU and the scanner system.

In addition, each scanner in a system can contain a link to a waveform profileNot UAV. See Scanner
waveform profile for more information.

The scanner system number must be unique. It is used to establish a link between a scanner
system and trajectory files.

You can Add, Edit, and Delete scanner systems by using the corresponding buttons in the
Settings dialog. You can Add, Edit, and Delete scanners by using the corresponding buttons in
the Scanner System dialog.

The lever arm of a scanner describes the distance between the IMU and the scanner. It is
expressed as X, Y, and Z components of a vector. The direction of the three vector components
is as follows:

· X - positive values to the right, negative to the left.

· Y - positive values forward, negative backward.

· Z - positive values up, negative down.

To add a new scanner system:

1. Open the Scanner systems category.

2. Click Add in the Settings dialog.

The Scanner System dialog opens:
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3. Type a Scanner number and a Scanner name.

4. If necessary, define values for the misalignment angles Heading, Roll, and Pitch between the
scanner system and the IMU.

5. Click Add in the Scanner System dialog in order to add a new scanner.

The Scanner dialog opens:

6. Define settings and click OK.

7. Repeat steps 5 and 6 for all scanners that belong to the system.

8. Click OK in the Scanner System dialog.

9. Close the Settings dialog in order to save the scanner system settings for TerraScan.
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SETTING EFFECT

Scanner number Number of the scanner. Must be unique
within a system.

Lever arm X | Y | Z X, Y, and Z component of the lever arm vector
between IMU and the scanner.

Waveform profile Waveform profile linked to the scanner.

Scanner systems are stored in a configuration file SCANNER_SYSTEMS.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make scanner system
definitions available on them.
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Scanner waveform profiles

Scanner waveform profiles category shows a list of scanner waveform profile definitions.
Scanner waveform profiles provide the reference or standard waveform shape that is typical for
a scanner. They are required for waveform processing tasks, such as the extraction of echo
properties or the extraction of additional points.

The waveform profile can be created from loaded laser points and trajectory information. The
trajectory must include the link to the waveform file. The waveform profile can be best
extracted from laser points on open ground, preferable hard surface, where a wider range of
intensity values are represented. The sample points should not be too close to line edges.

You can Add, Edit, and Delete waveform profiles by using the corresponding buttons in the
Settings dialog. You can also Copy a profile definition and view it in a text editor or Paste a
profile definition from a text editor in TerraScan.

To create a new scanner waveform profile:

1. Use Manage Trajectories tool and commands from the Trajectories dialog in order to import
and manage trajectories, and to link the trajectories with the waveform files.

2. Load points into TerraScan.

3. Classify points in sample areas that are suited for creating the scanner waveform profile.

4. Open the Scanner waveform profiles category.

5. Click Add in the Settings dialog.

The Scanner Waveform Profile dialog opens:

6. Define settings and click OK.

The software extracts the waveform profile.

7. Close the Settings dialog in order to save the modified settings for TerraScan.

SETTING EFFECT

Unique id Number of the waveform profile. Must be
unique in the list of scanner waveform
profiles.
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SETTING EFFECT

Name Name of the waveform profile.

Hard surface Laser point class that the software uses to
extract the waveform profile. Uses the active
class definitions in TerraScan.

Scanner waveform profiles are stored in a configuration file WAVEFORM_PROFILES.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make
scanner waveform profiles available on them.
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Section templates
Not Spatix

Section templates category shows a list of cross section templates. Section templates may
represent, for example, clearance areas or tunnel sections. They can be used for the
classification of point clouds with the By section template routine.

A section template is defined by the outline of the section and it’s origin point. The outline
must be drawn into a CAD file top view using correct measures. If the section is used in a
classification step, it is aligned to an element by using the origin point.

You can Add, Edit, and Delete section templates by using the corresponding buttons in the
Settings dialog.

To create a new section template:

1. Draw the outline of the cross section as closed shape in a CAD file top view.

2. (Optional) Draw a point at the position of the alignment element relative to the cross section
shape.

3. Open the Section templates category.

4. Select the cross section shape drawn in step 1.

5. Click Add in the Settings dialog.

6. Define the origin point of the section. If you created an element that represents the origin
point, snap to the element in order to define the correct location.

The Section Template dialog opens:
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7. Type a Name for the section template.

8. Click OK in the Tunnel Sections dialog.

9. Close the Settings dialog in order to save the modified settings for TerraScan.

Section templates are stored in a configuration file SECTION_TEMPLATES.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make section
templates available on them.
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Signal markers

Signal markers category lets you define signal markers which can be used for automatic XYZ
adjustment of a point cloud. Signal markers are bright paintings on dark ground surfaces, e.g. on
an asphalt surface, at the location of a control measurement. The signal marker must be visible
in the intensity values of a dense point cloud.

The signal marker has to be drawn into a CAD file before it can be defined in TerraScan. The
drawing must include a larger rectangle that represents the dark background and the shape of
the bright painting.

A signal marker can be modified by selecting the marker and clicking the Edit button in the
Settings dialog. It can be deleted using the Delete button.

To define a signal marker:

1. Create a drawing of the signal marker in a CAD file.

2. Select the drawing.

3. Open Signal markers category from TerraScan Settings.

4. Click Add in the Settings dialog.

5. Define the exact measurement coordinate of the signal marker by either snapping to the
drawing origin (= point of measurement on the signal marker location) or by typing the
command:

xy=0:0 (Spatix)   OR   xyz = 0,0,0 (MicroStation)

where 0,0,0 is the origin coordinate of the drawing.

This opens the Signal Marker dialog:



TerraScan User Guide  © 2023 Terrasolid Ltd

115TerraScan Settings > Signal markers >  

6. Type a Name for the marker and click OK.

This adds the new signal marker to the list.

Signal markers are stored in a configuration file SIGNAL_MARKERS.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make tower
functions available on them. It is the same file format that is used by TerraMatch for signal
markers. Therefore, exchange of signal marker definitions is also possible between
TerraScan and TerraMatch. Signal markers in TerraScan can only be used for adjusting a point
cloud to control measurements but not for matching data of flight/drive paths to each other.
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Slave computers

Slave computers category shows a list of computers that may participate in TerraSlave
computation tasks. By default, the list shows only the local computer but you can add any
network computer that you want to use for processing TerraSlave tasks.

A detailed description of TerraSlave is provided in the TerraSlave User Guide.

You can Add, Edit, and Delete computers by using the corresponding buttons in the Settings
dialog.

To add a new computer:

1. Open the Slave computers category.

2. Click Add in the Settings dialog.

The Slave Computers dialog opens:

3. Define settings and click OK.

4. Close the Settings dialog in order to save the slave computer settings for TerraScan.

SETTING EFFECT

Computer Name of the computer

Slave folder Installation directory of TerraSlave on the
Computer. The default local path is C:
\TERRA64\TSLAVE. Use UNC paths for distant
slave computers.

Max instances Maximum amount of processor cores used
for TerraSlave processing tasks.

Slave computers are stored in a configuration file SLAVE_COMPUTERS.INF in the TerraScan
installation folder. You can copy this file to other computers in order to make slave computer
definitions available on them.

https://terrasolid.com/guides/tslave/index.html
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Snapping

Snapping category determines whether the capability of snapping to loaded points is switched
on or off. If Snap to loaded points is switched on, you can snap to laser points in the same way
as to CAD elements by using the Tentative mouse button. This may be helpful, for example, for
dynamically rotating a view around a location in the point cloud or for digitizing vector data
based on the point cloud.
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Street View images

Street View images category defines display settings for Google Street View© images opened

by the Show Street View tool. In addition, the key for accessing the Street View© images is set.

SETTING EFFECT

Access key Hard-coded access key for accessing Street

View© images. The key can be changed to a
company's or person's own access key.

Image width Width of the Street View© image in the
browser window. Given in pixels.

Image height Height of the Street View© image in the
browser window. Given in pixels.

Field of view Field of view angle. Given in degree.

Pitch Angle off from horizontal viewing direction.
Given in degree.
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Target objects

Target objects category shows a list of target object definitions. Target objects are normally
used for matching point clouds of static terrestrial laser scanners. Supported shape primitives
of target objects include ball, cone and pyramid.

A target object may represent the location of a control point for which the coordinate values
are known. Target objects defined in this settings category are used by the Place target object
tool of the Measurement pulldown menu.

You can Add, Edit and Delete target objects by using the corresponding buttons in the Settings
dialog.

To add a new target object:

1. Open the Target objects category.

2. Click Add in the Settings dialog.

The Target Object dialog opens:

3. Define settings and click OK.

4. Close the Settings dialog in order to save the target object settings for TerraScan.

SETTING EFFECT

Description Description of the target object.

Type Shape primitives: Ball, Cone, or Pyramid.

Radius Radius of the ball or cone.

Depth Depth of a cone or pyramid.

Width Width of a pyramid.

Height Height of a pyramid.
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SETTING EFFECT

A distance Distance from the target object’s center point
to the known control point location along the
xy line from scanner to object.

B distance Distance from the target object’s center point
to the known control point location
perpendicular to xy line from scanner to
object.

H distance Elevation difference from the target object’s
center point to known control point location.

Target objects are stored in a configuration file TARGETS.INF in the TerraScan installation
folder. You can copy this file to other computers in order to make target object definitions
available on them.
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Trajectory accuracies

Trajectory accuracies category lets you specify minimum accuracy estimates to apply when
importing trajectories.

SETTING EFFECT

Enforce minimum accuracies during import If on, minimum accuracy estimates are
applied when trajectories are imported into
TerraScan.

Xy Minimum accuracy estimate for horizontal
coordinate values.

Z Minimum accuracy estimate for vertical
coordinate.

Heading Minimum accuracy estimate for heading
values values.

Roll/pitch Minimum accuracy estimate for roll and pitch
values.
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Travel View tool

Travel View tool category defines basic camera and view settings for the Travel View tool.

SETTING EFFECT

Camera Camera viewing angle. Given in degree.

Front clipping Distance in front of a camera view within
which content is clipped off.

Back clipping Distance after which content in a camera
view is clipped off in the background.
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Tree species

Tree species category shows a list of tree species. The tree type definitions are used in tree cell
placement with the Create Tree Cells tool.

You can Add, Edit, Sort, and Delete tree species by using the corresponding buttons in the
Settings dialog.

There are two example tree species defined in the default setup of TerraScan. They use cells of
a cell library also provided with the TerraScan installation. The library is stored in the \CELL
folder of the Terra applications installation directory, for example C:
\TERRA64\CELL\KARTTALI.CEL.

Any settings related to MicroStation cell elements do not have any effect in Spatix.

To create a new tree species:

1. Open the Tree species category.

4. Click Add in the Settings dialog.

The Tree Species dialog opens:

5. Define settings and click OK.

6. Close the Settings dialog in order to save the tree species settings for TerraScan.

SETTING EFFECT

Latin name Latin (scientific) name of the tree species.

Common name Name of the tree species as it is commonly
used.

Cell Name of the cell used for this tree species.
The name must correspond to the cell name
used in a MicroStation cell library.

Top is Distance between highest hit on the tree in
the point cloud and the top of the tree cell.
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Tree types are stored in a configuration file TREE_SPECIES.INF in the TerraScan installation
folder. You can copy this file to other computers in order to make tree type definitions
available on them.
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Tree visualization types

Tree visualization types category shows a list of tree
types. A tree type is defined by the shape of the tree
crown cross section and additional parameters. The tree
type definitions are used in automatic tree detection from
laser points with the Detect trees command.

You can Add, Edit, and Delete tree types by using the
corresponding buttons in the Settings dialog.

Any settings related to MicroStation cell elements do not
have any effect in Spatix.

To create a new tree type:

1. Draw an outline of one half of a tree crown cross section
as a line string in a CAD file front view.

You may use a cross section of a tree in laser points as
background for digitizing the tree crown shape. The image on the right shows the
approximate tree section centerline in white (used as helping line) and the outline in red.

2. Select the outline.

3. Open the Tree types category.

4. Click Add in the Settings dialog.

The Tree Type dialog opens:
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5. Define settings and click OK.

6. Close the Settings dialog in order to save the tree type settings for TerraScan.

SETTING EFFECT

Name Name of the tree type.

Cell Name of a MicroStation cell that is drawn into
the CAD file when trees are detected.

RPC cell Name and location of a RPC cell file that is
used in rendered views to replace detected
trees.

Min height Minimum height of a tree.

Max height Maximum height of a tree.
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SETTING EFFECT

Top is Distance between highest hit on the tree in
laser points and the tree top of the tree cells.

Width variation Variation of tree crown width for the tree
type. Given in percent.

Tree types are stored in a configuration file TREE_TYPES.INF in the TerraScan installation
folder. You can copy this file to other computers in order to make tree type definitions
available on them.
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Undo and backup

Undo and backup category defines how much memory the application allocates for its undo
buffer. The setting effects the amount of steps that can be undone with Undo or From list
commands. Further, the category lets you define settings for saving an automatic backup copy
of loaded points.

SETTING EFFECT

Buffer Amount of memory allocated for undo
actions. The recommended value range is 16 -
64 MB.

Save loaded points If on, TerraScan saves a backup copy of
loaded points automatically in regular time
intervals as long as the points are modified.

Every Time interval for saving loaded points
automatically.

Folder Storage directory for the backup copy of the
loaded data.
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User vegetation indexes

User vegetation indexes category shows a list of definitions for vegetation that can be
computed from color channels.

TerraScan implements the two most common vegetation index formulas: the Normalized
Difference Vegetation Index and the Visual Band Vegetation Index. These indexes assume the
channel order Red Green Blue (+ Near-Infrared). If color values are assigned to a point cloud
using this common channel order, no additional settings are required and the implemented
display option and classification tool can be used.

The User vegetation indexes category lets you define additional computation rules for
vegetation. This may be necessary, if the order of color channels is different, or if other
channels than RGB and NIR are involved. The settings dialog provides a number of pre-defined
formulas for channel computation. The user can choose from these formulas and define the
channel assignment. The user vegetation indexes are then also available for displaying points
by vegetation index and for classifying loaded points.

You can Add, Edit, and Delete vegetation indexes by using the corresponding buttons in the
Settings dialog.

To add a new target object:

1. Open the User vegetation indexes category.

2. Click Add in the Settings dialog.

The User Vegetation Index dialog opens:

3. Define settings and click OK.

4. Close the Settings dialog in order to save the vegetation index settings for TerraScan.

SETTING EFFECT

Name Name of the vegetation index.
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SETTING EFFECT

Formula List of pre-defined formulas for channel
computation.

Channel A | B | C Number of the color channel used in the
selected Formula.

Limit Threshold value for displaying points by
Vegetation index using the selected Formula.

User vegetation indexes are stored in a configuration file VEGETATION_INDEXES.INF in the
TerraScan installation folder. You can copy this file to other computers in order to make
vegetation index definitions available on them.
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TerraScan Toolbox

The TerraScan toolbox is opened when TerraScan is loaded and if the Open Main tool box
option in the Operation category in TerraScan Settings is switched on.

The toolbox can be re-sized by dragging its lower right corner with the mouse pointer
(MicroStation only). It can be docked to the edges of the CAD platform user interface.

There are 16 toolbars included in the TerraScan toolbox. A toolbar can be displayed by keeping
the data mouse button pressed for 1-2 seconds on a tool icon in the TerraScan toolbox. The
toolbar pops up and any tool can be selected with a data click. A toolbar can also be extracted
from the toolbox by selecting Open as ToolBox (MicroStation) or As Toolbar (Spatix) command
from the toolbar pop-up or by selecting the toolbar name from the Toolboxes submenu in the
Tools pulldown menu.

If the TerraScan toolbox is accidentally closed, it can be re-opened with the Main tool box
command from the Toolboxes submenu in the Tools pulldown menu or with the key-in
command:

scan app main
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3D Building Models

TerraScan provides a set of tools for building vectorization based on airborne point cloud (ALS
or photogrammetric) data. The 3D vector models are created fully-automatically but for higher
accuracy, they can be modified manually with dedicated tools. These tools ensure that the
topology of a building model is preserved and allow fast and easy editing. In addition,
TerraScan may be used for creating or updating building models stored in 3D City Databases.

According to the common way for describing building models, the models of TerraScan are at
level-of-detail (LOD) 2. In LOD 2, roof shapes and the overall structure of roofs are represented
but walls are just plain vertical polygons.

The automatic vectorization is based on classified points of the ground and on building roofs.
Building footprints can be used in the vectorization process for placing walls or roof edges.
Image data loaded in TerraPhoto supports the automatic vectorization of buildings. For manual
editing, images in camera views improve the result essentially, because edges of roofs, roof
structures, and smaller details may not be detectable accurately in the point cloud data.

The automatic building vectorization runs on loaded laser points using the Vectorize Buildings
tool or for a TerraScan project using the Vectorize buildings macro action.

The workflow for automatic building vectorization can be outlined as follows:

1. Classify ground points using the Ground classification routine.

2. Classify high points which may be hits on building roofs using the By distance classification
routine. This classification also includes points from high vegetation and other high objects.

3. Classify points on building roofs using the Buildings classification routine.

4. (Optional) If images are available, load a mission and an image list into TerraPhoto. The
camera parameters of the mission and the image list should be adjusted in order to provide
accurately positioned images.

6. Create vector models of buildings using the Vectorize Buildings tool for loaded points or run
a macro including the Vectorize buildings macro action on a TerraScan project.

7. Review and improve building models with the help of the Check Building Models tool and
tools in the Building Patches toolbox and the Building Edges toolbox.

The quality of the automatic building vectorization depends on the quality of the laser data
processing that is done in preparation of the vectorization, but also on the point density of the
data. A higher point density results in more accurate models. The following number may serve
as a guideline for estimating the possible results of the automatic vectorization:

· Low density < 2 points / m² - good models of large buildings, more problems with small
buildings, loss of small details and roof structures

· Medium density 2-10 points / m² - good models

· High density > 10 points / m² - accurate models with details and roof structures

https://terrasolid.com/guides/tphoto/index.html
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As alternative to point cloud data, TerraScan can also utilize line elements for the creation of 3D
building models. The line elements must represent different types of roof edges, such as outer
edges, internal edges along elevation jumps, and intersection lines, and they must form a
closed line work for each building. From the line network, the Construct Roof Polygons tool
tries to create closed polygons which represent roof planes. Finally, the Create Buildings from
Polygons can be used to create the 3D vector models from the roof polygons.

The major advantage of this building vectorization approach is the automatic production of 3D
building models for large areas in a comparatively short time. The process can also model
complex roofs that are non-planar and contain a lot of detailed roof patches. The tools for
improving the result of the automatic process are versatile and make the manual work fast and
simple.

A disadvantage of the vectorization process is that it fully relies on the quality of the source
data, which is either laser data or a line work for building roofs. If, for example, laser data is
missing on parts of a building roof, there is no way to create at least an approximate building
model based on the represented roof parts.

3D City Database

TerraScan also provides tools for writing, reading, updating and deleting building models stored
in 3D City Databases. The 3D City Database is a free geo database to store, represent, and
manage virtual 3D city models on top of a standard spatial relational database. The database
schema implements the CityGML standard for storing geometry and semantic information of
urban objects. More information, instructions for 3DCityDB setup and examples are available on
the official internet pages of 3D City Database.

You may update building models stored in a 3DCityDB or write new building models in a
database. A typical update workflow can be outlined as follows:

1. Read building models stored in a 3DCityDB.

2. Review and improve building models with the help of the Check Building Models tool and
tools in the Building Patches toolbox and the Building Edges toolbox.

3. If necessary, delete models of demolished buildings from the database.

4. If necessary, create models for new buildings using the Vectorize Buildings tool for loaded
points or run a macro including the Vectorize buildings macro action on a TerraScan project.

5. Write modified models to the database using the method Replace by Id or Replace by
centroid.

6. Write new models to the database using the method Add to database.

In this scenario, the CAD file acts only as temporary working environment. The building models
are only stored in the database.

https://www.3dcitydb.org/3dcitydb/
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Buildings toolbox

The tools in the Buildings toolbox are used to create 3D building models automatically from
point clouds, roof lines or roof polygons, and to check these building models.

 

 

TO USE TOOL

Vectorize buildings from point cloud Vectorize Buildings Not Lite

Construct polygons from roof lines Construct Roof Polygons Not Lite

Create building models from roof polygons Create Buildings from Polygons

Merge small polygons to larger footprint
polygons

Merge Footprint Polygons

Draw relevant roof lines into the CAD file Draw Roof Lines

Check building models one at a time Check Building Models

Write buildings to a 3D City database Write Buildings to Database

Read buildings from a 3D City database Read Buildings from Database

Delete buildings from a 3D City database Delete Database Buildings

Check Building Models

Check Building Models tool can be used to check automatically created building models in an
organized way. It is intended to be used after building vectorization by Vectorize Buildings tool,
Vectorize Buildings macro action, or Create Buildings from Polygons tool. The tool includes a
validation option for checking the planarity of roof planes and/or the match between vector
models and building footprint polygons.

The Check Building Models dialog shows a list that contains building models in the CAD file that
are drawn on the levels defined in Building vectorization / Levels category of TerraScan
Settings. If a line in the list is selected, the software updates the display in a number of CAD file
views as defined in the tool settings. The tool can update different view types, such as top,
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isometric, section, and camera views which may show the building models within a point cloud
and/or on top of images.

With the help of the list, you can start to work with tools of the Building Patches toolbox and
the Building Edges toolbox in order to improve the accuracy of the building models.

To check build ing models:

1. Select Check Building Models tool.

This opens the Check Building Models dialog:

2. Define settings and click OK.

This opens the Check Building Models dialog.

SETTING EFFECT

Search Area where the software searches for building
models:

· Whole design file - all models in the CAD
file.
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SETTING EFFECT

· Active block - all models inside the active
project block. This is defined by the
TerraScan project block that is loaded or was
last loaded into TerraScan.

· Loaded point area - all models inside an
area for which points are loaded in
TerraScan.

Show Building models shown in the list of the Check
Building Models dialog:

· All buildings - all building models on Model
to check levels defined in Building
vectorization / Levels.

· Unchecked buildings - building models on
Model to check levels defined in Building
vectorization / Levels with the status Need
to check or any "problem" status.

· Problem buildings - building models on
Model to check levels defined in Building
vectorization / Levels with any "problem"
status. See Validate models for more
information.

Footprints CAD file level on which the footprint polygons
are drawn. This is required for detecting and
highlighting Footprint problems.

Enforce footprint as edges If on, the tool clips automatically all building
model edges to the footprint polygons. You
should switch this option on if model edges
must match to footprint polygons.

Top view A top view showing the active building model
is displayed in the given view.

Displayset buffer Elevation buffer for displaying roof points of a
displayset in the Top view. This has only an
effect if Points is set to Displayset only in the
Display Mode dialog.

Isometric view An isometric view showing the active building
model. It is recommended to set the display
style for this view to Smooth rendering in CAD
file view controls.

Section view 1 A section view showing the active building
model. The section is drawn along the major
direction of the building.

Section view 2 A section view showing the active building
model. The section is drawn across the major
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SETTING EFFECT

direction of the building.

Camera view A camera view showing the active building
model is displayed in the given view. This
view works only if a mission, camera, and
image list are loaded into TerraPhoto.

Detail view A camera view showing the location of an
active building model in detail is displayed in
the given view. The zoom level is determined
by the given Zoom to value. This view works
only if a mission, camera, and image list are
loaded into TerraPhoto and if you select a
building edge or corner for modification.

Arrange views If on, the CAD file views are arranged on the
screen according to the given view settings.
The software opens the views and places
them within the CAD platform interface
without overlap.

Level CAD file level on which the colored edges of
an active model are drawn. The level should
be switched on in the views that display the
active model.

Outer edges Display color, line weight and line style of
outer edges of the active model. Uses the
active color table and standard line weights
and styles of the CAD file.

Internal edges Display color, line weight and line style of
internal edges of the active model. Uses the
active color table and standard line weights
and styles of the CAD file.

Intersection lines Display color, line weight and line style of
intersection lines of the active model. Uses
the active color table and standard line
weights and styles of the CAD file. The
Tolerance value determines up to which
maximum positional difference vertices of
intersecting planes are considered to be at
exactly the same location.

Footprint Display color, line weight and line style of
lines of the footprint polygon. Uses the active
color table and standard line weights and
styles of the CAD file.

Footprint problems Display color, line weight and line style of
lines of the active model that do not match to

https://terrasolid.com/guides/tphoto/index.html
https://terrasolid.com/guides/tphoto/index.html
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SETTING EFFECT

footprint polygons. This highlights problems if
a vector model edge is inside the footprint
polygon drawn on the Footprints level. Uses
the active color table and standard line
weights and styles of the CAD file.

Water problems Display color, line weight and line style of
lines of the active model that is not "water
tight". The Tolerance value determines the
size of allowed gaps that are ignored.

Crossing edges Display color, line weight and line style of
edge lines that cross each other and result in
roof polygons intersecting each other. The
Tolerance value determines up to which
maximum distance crossings of edge lines is
ignored.

Check Building Models

The Check Building Models dialog shows a list that contains all building models drawn on the
CAD file levels that are defined in Building vectorization / Levels category of TerraScan Settings.
The status of each model after automatic creation is Need to check by default. In addition, the
status of a model can indicate a problem. Then, the status is shown in red color. A "problem"
status can be related to footprints, such as mismatch between model edges and footprint
boundaries, or to non-planar roof patches.

Further, the dialog contains buttons that can be used to change the status of a model to
Approved, to recompute or delete a model, to fix footprint or planarity issues, to display a
certain model, and to select another image that is displayed in the background of the active
model. Menu commands can be used to display the Vectorize Buildings dialog, to validate
models, and to change the status of all models to Approved.
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To show the location of a building model, select a line in the Check Building Models dialog. This
updates the display in all views that are set up for checking building models.

COMMAND/BUTTON EFFECT

Approve After checking a building model and possibly
modifying it, click on the Approve button.
This changes the status of the selected model
to Approved. It moves the model to the
Approved models levels defined in Building
vectorization / Levels category of TerraScan
Settings.

Recompute Recomputes a building model based on
loaded points and tailored settings. This
might be necessary, if the settings of the
automatic vectorization process did not
provide a reasonable model for this building.

Fix footprint Fix small mismatch between roof edges and a
footprint polygon. This is only available if
models have been validated using the
Footprint mismatch option.

Fix planarity Fixes planarity issues of roof patches. Exactly
planar roof patches are enforced. This also
requires that Average elevations is set to 0.0
in Building vectorization / Models category of
TerraScan Settings. Exact planarity may lead
to small differences between vertices of
intersection lines. This is only available if
models have been validated using the Non-
planar roof option.
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COMMAND/BUTTON EFFECT

Delete Deletes a model from the CAD file and from
the list. If you undo the delete action by
using the Undo command of the CAD
platform, the model is returned into the CAD
file but not into the list of the dialog. You
need to re-open the dialog in order to see
the model again in the list.

Identify To identify a building model, click on the
Identify button and place a data click close to
a model in a view. This selects the
corresponding model in the Check Building
Models dialog.

You can use the buttons in the lower right
corner in order to select images from the
TerraPhoto image list. The image is displayed
in the camera views used for checking
building models. By default, the software
selects the image for display that sees the
building (detail) location best.
Click on the camera button in the middle of
the button group in order to identify an
image for display. Move the mouse pointer
into a view. The image footprint closest to
the mouse pointer is dynamically displayed.
Select an image for display with a data click.
Click on the arrow buttons left and right in
the button group in order to select the
previous or next image from the currently
displayed image in the images list.

Tools / Computation settings Opens the Vectorize Buildings dialog with
the settings used in the automatic
vectorization process. This might be useful to
check before recomputing a model for which
the settings do not apply sufficiently.

Tools / Validate models Checks building models for footprint or
planarity problems.

Tools / Sort Options for sorting the models in the list:

· By area - by roof area. Smaller models are
in the beginning of the list, larger models
in the end.

· By number - by model number. This is the
default order of models when the Check
building models tool is started.

· By status - by model status. Approved
models are in the end of the list.
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COMMAND/BUTTON EFFECT

Tools / View fields Define attribute fields that are visible in the
Check Building Models dialog.

Tools / Approve all Changes the status of all models in the list to
Approved. It moves the models to the
Approved models levels defined in Building
vectorization / Levels category of TerraScan
Settings.

To recompute a build ing model:

1. Load laser data into TerraScan for the location of the building model.

2. Click on the  button in order to open the Vectorize Buildings dialog.

The settings of the dialog are described for the Vectorize Buildings tool.

3. Change settings in the dialog and click OK.

4. Click on the Recompute button.

This recomputes the selected building model by using the tailored settings.

Validate models

Validate models command checks the vector models in the list for footprint, topology and/or
planarity issues. The check is useful to find models that do not match to footprint polygons or
that contain non-planar building patches.

The validation process may change the status of vector models to a "problem" status:

· Footprint - the model edges do not match to the footprint boundaries.

· No footprint - no footprint is available for validation.

· Non-planar - one or more patches of the model are not planar. Exactly planar roof patches
can only be created if Average elevations is set to 0.0 in Building vectorization / Models
category of TerraScan Settings. Otherwise, patches are non-planar which is fine for most of
the building model applications.

· Not watertight - the model is not closed, i.e. water can flow out of the model.

· Intersecting - roof polygons intersect each other.

A "problem" status is displayed in red in the list of building models.

To validate models:

1. Select Validate models command from the Tools pulldown menu.

This opens the Validate Settings dialog:



TerraScan User Guide  © 2023 Terrasolid Ltd

142TerraScan Toolbox > 3D Building Models > Buildings toolbox

2. Select settings and click OK.

This starts the validation process. An information dialog shows the amount of detected
problems. The status for models is changed in the list if a problem is detected.

SETTING EFFECT

Non-planar roof If on, the process checks the planarity of roof
patches. A problem is detected if the patch
planarity differs more than the given
Tolerance value from a perfect plane.

Non-watertight model If on, the process checks for gaps in building
models that allow water to flow out of the
model. A problem is detected if the gap size
is larger than the given Tolerance value.

Intersecting polygon If on, the process checks for roof polygons
intersecting each other by more than the
given Tolerance value.

Footprint mismatch If on, the process checks mismatch between
footprint polygons and vector model edges.
A problem is detected if the model vertex
differs more than the given Tolerance value
from the footprint vertex.

It is virtually impossible to create roof patches with exact planarity, perfect geometry and
even shapes. Therefore, enforce exact planarity for roof patches only if it is explicitly
required. Otherwise, it may be more convenient to create building models with correct outer
boundaries and intersection lines for roof patches and at the same time, accepting non-
planar patches.

View fields

View fields command lets you select which attributes are displayed in the Check Building
Models dialog.



TerraScan User Guide  © 2023 Terrasolid Ltd

143TerraScan Toolbox > 3D Building Models > Buildings toolbox

ATTRIBUTE DESCRIPTION

Number Internal building number.

Database ID Building ID stored in a 3D City Database.

ID string Text string stored for a building in a 3D City
Database.

Status Modification status.

Area Size of the area covered by the roof.

Construct Roof Polygons
Not Lite

Construct Roof Polygons tool creates 3D roof polygons from selected 3D roof lines. It tries to
determine closed polygons for each roof plane from the line work. The resulting polygons can
then be used by Create Buildings from Polygons tool in order to create 3D building models.

The line elements must represent different types of roof edges, such as outer edges, internal
edges along elevation jumps, and intersection lines, and they must form a closed line work for
each building. The tool does not rely on lines being drawn on different levels or using different
symbology. It tries to determine which elevations to keep and which to ignore in the polygon-
building process only from the geometrical configuration of the line work.

The following figure illustrates the result of the roof polygon construction. Lines are roughly
colored according to their roof edge type: outer edges = red, elevation jumps = yellow,
intersection lines = blue. The resulting roof polygons are displayed in gray.
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To construct roof polygons from lines:

1. Select the lines that represent roof edges.

2. Select Construct Roof Polygons tool.

This creates the polygons. The polygons are drawn on the active level using the active
symbology settings of the CAD file. An information dialog shows the number of created
polygons.

It is recommended to check the polygons, for example, by using Smooth rendering display of
the CAD platform. This shows gaps or other issues in the roof polygons which may be caused
by flaws in the line work. In this case, correct the line work and run the roof polygon
construction again.

You can undo the creation of roof polygons by using the Undo command of the CAD platform.

Create Buildings from Polygons

Create Buildings from Polygons tool creates 3D building models from selected 3D roof
polygons. The polygons are usually a result of the Construct Roof Polygons tool.

The tools uses laser points to get the base elevation for walls. The building models are created
as MicroStation cell elements that contain shapes for each roof plane, possibly roof sides which
determine the roof’s thickness according to settings in Building vectorization / Model, and wall
shapes for each outer roof edge.

The following figure illustrates the result of the building model creation using the same
example as shown for the Construct Roof Polygons tool.
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To construct build ing models from polygons:

1. Select the polygons that represent roof planes.

2. Select Create Buildings from Polygons tool.

This opens the Create Building from Polygons dialog:

3. Define settings and click OK.

This creates the building models. The building models are drawn into the CAD file according
to the settings in Building vectorization / Levels category of TerraScan Settings.

SETTING EFFECT

Lower classes Point class(es) consisting points next to
buildings, for example, ground or low
vegetation. The points are used to get the
base elevation of the building walls.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Lower classes field.

Random wall color If on, wall shapes are colored randomly by
using a selection of colors from the active
color table of the CAD file. If off, the color
defined in Building vectorization / Model
category of TerraScan Settings is used for
all wall shapes.
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You can undo the creation of building models by using the Undo command of the CAD
platform.

Delete Database Buildings
Not Spatix

Delete Database Buildings tool deletes building models from a 3D City Database (3DCityDB).
This requires the connection of TerraScan with the 3DCityDB. The connection parameters are
defined in the City databases category of TerraScan Settings.

You may use the tool for deleting demolished buildings from a 3DCityDB. The building models
must be read from the database using the Read Buildings from Database tool. This ensures that
the software identifies a building model by its unique ID stored in the database.

To delete build ings from a 3DCityDB:

1. Select the building models you want to delete.

2. Select Delete Database Buildings tool.

This opens the Delete Database Buildings dialog:

3. Select the Database from the selection list.

4. Confirm the process with another data click inside a CAD view.

This deletes the selected building models from the database based on the model ID. It also
removes the models from the CAD file.

Draw Roof Lines

Draw Roof Lines tool draws relevant roof lines of selected building models as permanent
elements in the CAD file. This might be useful for checking the quality of building vector
models without modifying the models at the same time.

To draw roof lines in  the CAD file:

1. Select the building models for which to draw the roof lines.

2. Select Draw Roof Lines tool.

This opens the Draw Roof Lines dialog:
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3. Define settings and click OK.

This draws the line elements on the active level of the CAD file.

SETTING EFFECT

Footprints CAD file level on which the footprint
polygons are drawn. This is required for
detecting and drawing Footprint problems.

Outer edges Display color, line weight, and line style of
outer edges of the model. Uses the active
color table and standard line weights and
styles of the CAD file.

Internal edges Display color, line weight, and line style of
internal edges of the model. Uses the active
color table and standard line weights and
styles of the CAD file.

Intersection lines Display color, line weight, and line style of
intersection lines of the model. Uses the
active color table and standard line weights
and styles of the CAD file. The Tolerance
value determines up to which maximum
positional difference vertices of intersecting
planes are considered to be at exactly the
same location.

Footprint problems Display color, line weight, and line style of
roof lines of the model that do not match to
footprint polygons. This highlights problems
if a vector model edge is inside the footprint
polygon drawn on the Footprints level. Uses
the active color table and standard line
weights and styles of the CAD file.

You can undo the drawing of roof lines by using the Undo command of the CAD platform.
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Merge Footprint Polygons

Merge Footprint Polygons tool can be used to merge several polygons that form a single
building footprint into one polygon. A typical example is that the main building and balconies
or other small building extensions are outlined by separate polygons. In order to create a 3D
vector model of the building including these extensions, there must be one single footprint
polygon.

The polygons to be merged must share at least one edge. The larger polygon is considered as
the 'main footprint'. Smaller polygons are merged to the main footprint. The polygons may be
drawn on different CAD file levels but the main footprints for all buildings should be on one
level.

To merge footprint polygons:

1. Select the footprint polygons. Polygons of several buildings may be selected.

2. Select Merge Footprint Polygons tool.

This opens the Merge Footprint Polygons dialog:

3. Define settings and click OK.

This creates a new polygon for each building footprint by merging smaller polygons to the
main footprint. The polygon is drawn on the active level using the active symbology settings
of the CAD file.

SETTING EFFECT

Select main footprint levels Determines the CAD file level on which the
main footprint polygons are drawn.

Tolerance Maximum distance limit by which the shared
edge(s) of the main footprint polygon and
the extension polygons may differ in
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SETTING EFFECT

location. If the distance is smaller, the edge
is still considered as shared and polygons are
merged.

You can undo the merging of footprint polygons by using the Undo command of the CAD
platform.

Read Buildings from Database
Not Spatix

Read Buildings from Database tool reads building models from a 3D City Database (3DCityDB).
This requires the connection of TerraScan with the 3DCityDB. The connection parameters are
defined in the City databases category of TerraScan Settings.

The 3D City Database is a free geo database to store, represent, and manage virtual 3D city
models on top of a standard spatial relational database. The database schema implements the
CityGML standard for storing geometry and semantic information of urban objects. More
information, instructions for 3DCityDB setup and examples are available on the official internet
pages of 3D City Database.

You may update building models stored in a 3DCityDB by reading the models, modify them
based on a newer point cloud/image data set, and write them back to the database. In this
scenario, the CAD file acts only as temporary working environment. The building models are
only stored in the database.

To read build ings from a 3DCityDB:

1. (Optional) Define the area for reading building models by drawing a fence.

2. Select Read Buildings from Database tool.

This opens the Read Buildings from Database dialog:

3. Define settings and click OK.

This reads the building models from the database and draws them into the CAD file. The
building models are drawn according to the settings for Models to check in Building
vectorization / Levels category of TerraScan Settings. 

https://www.3dcitydb.org/3dcitydb/
https://www.3dcitydb.org/3dcitydb/
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SETTING EFFECT

Database Name of the 3DCityDB as defined in the City
databases category of TerraScan Settings.

Import textures If on, texture images are imported as well.
If off, only the geometry of the models is
imported.

Inside fence only If on, only building models located inside a
fence are imported. This is only active if a
fence has been defined before the tool is
started.

Vectorize Buildings
Not Lite

Vectorize Buildings tool creates 3D building models based on loaded point cloud data. The
point cloud has to be classified into:

· ground points using the Ground classification routine.

· above-ground points which may be hits on building roofs using Compute distance followed
by the By distance classification routine. This classification also includes points from high
vegetation and other high objects.

· points on building roofs using the Buildings classification routine.

The tool creates MicroStation cell elements that contain shapes for each roof plane, possibly
roof sides which determine the roof’s thickness according to settings in Building vectorization /
Model, and wall shapes for each outer roof edge.

Building vectorization can be also performed on project level by using the Vectorize buildings
macro action.

To vectorize build ings based on loaded points:

1. Load point cloud data into TerraScan.

2. Select the Vectorize Buildings tool.

This opens the Vectorize Buildings dialog:
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3. Define settings and click OK.

This starts the vectorization process. It may take a while until the first models are created
because the routine creates models for large buildings first. The building models are drawn
into the CAD file according to the settings in Building vectorization / Levels category of
TerraScan Settings.

SETTING EFFECT

Roof class Point class consisting points on building
roofs.

User roof class Point class consisting points on building
roof details. The details are vectorized even
if the area is smaller than the Minimum
detail value.

Lower classes Point class(es) consisting points next to
building roof edges, for example, ground or
low vegetation. The points are used to
determine the base elevation of building
walls and help to place outer roof edges
more accurately.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Lower classes field.
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SETTING EFFECT

Process Area to be processed:

· All points - all loaded points are
processed. This may include points from
neighbour blocks.

· Active block - points of the active block
are processed.

· Inside fence - points inside a fence or
selected polygon are processed. This is
only active if a MicroStation fence is
drawn or a polygon is selected.

Use polygons Defines how polygons are used in addition
to point cloud data:

· Do not use - no polygons are used.

· As bounding polygons - polygons define
boundaries that divide large building
blocks into separate models. Example:
land property polygons.

· As roof edges - polygons define the XY
shape of outer edges of buildings.
Example: footprint polygons.

Level CAD file level on which the polygons are
located that are used in the vectorization
process. This is only active if Use polygons is
set to As bounding polygons or As roof
edges.

Maximum gap Maximum distance between building parts
belonging to the same model. If the
distance is larger, separate building models
are created.

Planarity tolerance Defines how closely a point must match a
plane equation to belong to that roof plane.

Increase tolerance Additional tolerance for merging close to
horizontal planes together.

Minimum area Minimum size of a building footprint.

Minimum detail Minimum size of a building part footprint.

Max roof slope Maximum gradient of a roof plane.

Point spacing Spacing between points on building roofs in
the point cloud:

· From data - the software derives the
spacing from the data. This is the normal
setting for randomly distributed point
clouds.
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SETTING EFFECT

· Fixed - the spacing is given by the value in
the text field.

Adjust edges using active images If on, building edges are adjusted based on
images. The images must be referenced by
an image list loaded into TerraPhoto.

Random wall color If on, wall shapes are colored randomly by
using a selection of colors from the active
color table of the CAD file.
If off, the color defined in Building
vectorization / Model category of TerraScan
Settings is used for all wall shapes.

Write Buildings to Database
Not Spatix

Write Buildings to Database tool writes building models to a 3D City Database (3DCityDB). This
requires the connection of TerraScan with the 3DCityDB. The connection parameters are
defined in the City databases category of TerraScan Settings.

The 3D City Database is a free geo database to store, represent, and manage virtual 3D city
models on top of a standard spatial relational database. The database schema implements the
CityGML standard for storing geometry and semantic information of urban objects. More
information, instructions for 3DCityDB setup and examples are available on the official internet
pages of 3D City Database.

You may update building models stored in a 3DCityDB by reading the models, modify them
based on a newer point cloud/image data set, and write them back to the database. In this
scenario, the CAD file acts only as temporary working environment. The building models are
only stored in the database.

To write build ings to a 3DCityDB:

1. (Optional) Define building models you want to write to the database either by selecting the
models or by drawing a fence around the models.

2. Select Write Buildings to Database tool.

This opens the Write Buildings to Database dialog:

https://terrasolid.com/guides/tphoto/index.html
https://www.3dcitydb.org/3dcitydb/
https://www.3dcitydb.org/3dcitydb/
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3. Define settings and click OK.

This writes the building models to the database.

SETTING EFFECT

Database Name of the 3DCityDB as defined in the City
databases category of TerraScan Settings.

Write Determines what building models are written
to the database:

· All buildings - all building models in the CAD
file.

· Selected buildings - building models that
have been selected before starting the tool.

· Inside fence - buildings models that are
inside a fence drawn before starting the
tool.

Level Level-of-detail of the building models. Refers
to the LOD definition of the CityGML standard:

· LOD1 - building models without roof
structure and plane walls.

· LOD2 - building models with roof structure
and plane walls. This is the LOD of building
models produced by TerraScan vectorization
tools from aerial point cloud data.

Write method Method of writing building models to the
database:

· Add to database - new models are written
to the database. Use this if models do not
yet exist in the database.

· Replace by Id - a model replaces an existing
model with identical ID. This can be used if
existing models in the database are
updated. The ID identifies each model in a
unique way.
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SETTING EFFECT

· Replace by centroid -  a model replaces an
existing model with the same centroid
coordinate. This may be used if the model
ID is not usable for an update case.

Write textures If on, texture images are stored in the
database as well.
If off, only the geometry of the models is
stored.

Building Patches toolbox

The tools in the Building Patches toolbox are used to modify roof patches of 3D building
models. The term “patch” is used for the single roof planes that form a roof.

 

 

TO USE TOOL

Split building into two separate models Split Building

Split patch into two separate patches Split Patch

Merge two patches into one Merge Patches

Enforce symmetry for planar roof patches Apply Plane Symmetry

Enforce the same elevation for vertices of
adjacent patches

Match Roof Elevations

Remove a patch by mouse click Remove Patch

Remove small patches Remove Details

Display a building cross section Draw Building Section

Extrude a building model from a cross
section

Extrude Building
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Building Patches tools work only when the Check Building Models dialog is open. You can
undo the actions of the tools by using the Undo command of the CAD platform.

Apply Plane Symmetry

Apply Plane Symmetry tool forces plane equations, normal directions and/or slope gradients of
planar roof patches to match. The symmetry adjustment requires that at least two patches are
selected. However, the tool is also applicable to more than two patches in one step.

To apply  plane symmetry:

1. Select Apply Plane Symmetry tool.

The Apply Plane Symmetry dialog opens:

2. Select settings.

3. Move the mouse pointer inside a view.

A patch is highlighted if the mouse pointer is inside.

4. Define the first roof patch with a data click.

If Values from is set to First patch, this patch determines the symmetry change for the other
patches.

5. Define the next roof patch with a data click.

Repeat step 5 for all patches that you want to include in the symmetry adjustment.

6. Confirm the patch selection with another data click inside one of the selected patches.

This applies the symmetry to all selected patches.

SETTING EFFECT

Symmetry Determines the symmetry value that is
enforced for all selected roof patches:

· Whole equation - the plane equation is
recomputed and selected patches are
adjusted accordingly. Symmetric planes
have the same plane equation.
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SETTING EFFECT

· Direction & Slope - normal direction and
slope gradient are adjusted.

· Direction - the normal direction of a plane is
adjusted. Symmetric planes have normal
directions that differ by 90 degree.

· Slope - the slope of a plane is adjusted.
Symmetric planes have mirrored slope
gradients.

Values from Defines how the new values for roof patches
are derived:

· Average - the values of all selected patches
are averaged.

· First patch - the value of the first selected
patch is used for all selected patches.

Draw Building Section

Draw Building Section tool displays a cross section of a building. The tool is intended to be
used, for example, before Extrude Building tool. It provides a cross section view of the laser
data that is suited for drawing a building roof profile line. In addition, the tool can be helpful in
cases there are no image available for modifying vector models manually. Then, it speeds up
the drawing of sections for single building planes.

To draw a build ing section:

1. Load point cloud data into TerraScan.

2. (Optional) Open one or two additional CAD file view(s) that can be used for the section
display.

3. (Optional) Draw a fence around the area from which you want to create a cross section.

4. Select Draw Building Section tool.

The Draw Building Section dialog opens:

5. Select an option for the tool setting.

6. If Fit to show is set to Single patch, move the mouse pointer in the top view. If the mouse
point is inside a patch, it is highlighted. Define the patch with a data click in the top view.

7. Define a view with a data click.
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This displays the building or patch section in the selected view.

8. If Fit to show is set to Single patch, define the second view with a data click.

This displays the second patch section in the selected view.

SETTING EFFECT

Fit to show Defines the area that is used to select a
location for the cross section:

· Active building points - area covered by all
points that are inside the active building.

· Inside fence - area covered by a
MicroStation fence. This requires a fence
element drawn into the CAD file.

· Single patch - area covered by a selected
patch. The patch is selected with a separate
data click. The tool draws one along-patch
section and one across-patch section.

Extrude Building

Extrude Building tool creates a building model by extruding a cross section line. The tool is
especially useful for modeling buildings with round roofs. For such roof shapes, the automatic
vectorization process usually does not provide a good result. The tool can also be used for
adding or replacing planar roof patches of an existing model. This may be useful if a part of a
roof can not be modeled from the point cloud due to the lack of points.

The cross section line of the building roof needs to be digitized manually based on a vertical
section view of the laser data. The line string element should be placed on a CAD file level that
is not used for building models. It can also be deleted after the building model has been
created.

To create a build ing model from a cross section line:

1. Remove all patches that you want to replace from the existing model by using Remove Patch
or Remove Details tools.

2. Create a cross section view of the building by using the Draw Building Section tool.

It is recommended to display the section in an additional CAD file view.

3. Digitize the shape of the cross section based on the laser data that is displayed in the section
view. You can use any CAD tool for line string placement.

4. Select Extrude Building tool.

This opens the Extrude Building dialog:
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5. Select an option for handling overlap areas.

6. Select the cross section line with a data click.

7. Define the first edge of the building with a data click, preferable in a top view.

8. Define the second edge of the building with a data click, preferable in a top view.

This creates a building model between the two edges defined by the data clicks. For each
intermediate vertex of the cross section line, an intersection line is created in the building
model. The outer boundaries of the new model are defined by the first and last vertex of the
cross section line.

SETTING EFFECT

Overlap Defines which roof patch is used in
overlapping roof patch areas:

· Keep new - replaces old patches with new
ones.

· Keep old - keeps the old patches and adds
new patches only in areas outside the old
ones.

Match Roof Elevations

Match Roof Elevations tool modifies the plane equation in order to set the elevation of roof
plane vertices to the elevation of a neighbouring patch.

To match roof elevations:

1. Select Match Roof Elevations tool.

2. Move the mouse pointer inside a view.

A patch is highlighted if the mouse pointer is inside.

3. Define the roof patch to modify with a data click.

The vertex closest to the mouse pointer is highlighted if the tool is applicable.

4. Define the first vertex to adjust with a data click.

Repeat step 4 for all vertices that you want to adjust in elevation.

5. Confirm the vertex selection with another data click on the last selected vertex.

This applies the elevation of all selected vertices to the elevation of the neighbouring patch.
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Merge Patches

Merge Patches tool combines two neighbouring patches into one patch. The process
recomputes the plane equation for the new patch as average of the two original planes.

To merge two patches:

1. Select Merge Patches tool.

This opens the Merge Patches dialog:

2. Define settings.

3. Move the mouse pointer inside a view.

Potential patches for merging are dynamically highlighted if the mouse pointer is inside a
patch.

4. Select the first patch with a data click.

If you move the mouse pointer, the possible patches for merging are dynamically displayed.

5. Select the second patch with a data click.

This merges the two patches into one patch and recomputes the plane equation of the new
patch. You can continue with step 3.

SETTING EFFECT

Equation from Method of how the plane equation for the
merged patch is defined:

· First patch - the equation of the first
selected patch is used.

· Average - the average of the two patches is
computed.

Remove Details

Remove Details tool removes all patches of a building roof which are of the same size or
smaller than a patch identified by a data click or a specified value. This can be used, for
example, for removing patches of unnecessary structures on a roof, such as roof windows.

To remove a build ing patch:

1. Select Remove Details tool.
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The Remove Details dialog opens:

2. Define settings.

3. Move the mouse pointer inside a view.

The patches effected by the removal action are dynamically highlighted if the mouse pointer
is inside a patch (Limit by = Identify patch) or inside the view (Limit by = Keyin value).

4. Confirm the selection of patches with a data click.

This removes all patches from the building model that are defined by the tool’s setting. You
can continue with step 4.

SETTING EFFECT

Remove Defines what patches are effected by the
removal action:

· All small patches - all patches that are of the
same size or smaller than the patch selected
by the data click.

· Internal patches - only patches that are
completely inside a building roof are
effected. The same size rules as for All small
patches apply.

· Outer patches - only patches that share an
outer boundary of the building roof are
effected. The same size rules as for All small
patches apply.

Limit by Method of how the maximum size of a patch
to be deleted is determined:

· Identify patch - identified with a data click
inside the patch.

· Keyin value - the size is determined by the
given Area value.

You can remove all patches of an active building model. Nevertheless, the model still exists
in the list and stays active. You can apply additional processing steps, such as recomputing
the model using the Recompute button of the Check Building Models dialog or creating a
new model with the help of the Extrude Building tool. If you want to delete a model
completely, use the Delete button of the Check Building Models dialog.
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Remove Patch

Remove Patch tool removes a single building patch.

To remove a build ing patch:

1. Select Remove Patch tool.

2. Move the mouse pointer inside a view.

A patch is dynamically highlighted if the mouse pointer is inside a patch.

3. Select a patch with a data click.

This removes the patch from the building model. You can continue with step 3.

You can remove all patches of an active building model. Nevertheless, the model still exists
in the list and stays active. You can apply additional processing steps, such as recomputing
the model using the Recompute button of the Check Building Models dialog or creating a
new model with the help of the Extrude Building tool. If you want to delete a model
completely, use the Delete button of the Check Building Models dialog.

Split Building

Split Building tool cuts out a part of a building complex. This part is then treated as own
separate building model.

To split a  build ing into two build ing models:

1. Draw a fence around the building part that you want to cut out.

2. Select Split Building tool.

OR

1. Select Split Building tool.

2. Draw a line by placing the two end points with data clicks. The line represents the splitting
line for the building model.

3. Move the mouse pointer inside a CAD file view.

The two building parts are highlighted with blue and red coloring.

4. Accept the two building parts with a data click inside a view.

This splits the building. The area outside the fence or on one side of the line stays as active
building. The area completely inside the fence or on the other side of the line becomes a
new building model that is put at the end of the list in the Check Building Models dialog.
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Split Patch

Split Patch tool splits a patch at edge vertices into two separate patches. The process can
recompute the plane equations for the two patches if laser points of the roof class are loaded in
TerraScan.

To split a  patch:

1. (Optional) Load laser data into TerraScan. Only points in the building roof class are required.

2. Select Split Patch tool.

The Split Patch dialog opens:

3. Define, whether the process should Recompute plane equations using points or not. The
setting is only available if points are loaded in TerraScan.

4. Move the mouse pointer inside a view.

A potential vertex for splitting is dynamically highlighted if the mouse pointer comes close
to it.

5. Select the first edge vertex with a data click.

If you move the mouse pointer, the possible split lines are dynamically displayed.

6. Select the second edge vertex with a data click.

This splits the patch into two patches and recomputes the plane equation of the patches, if
applicable. You can continue with step 5.

Building Edges toolbox

The tools in the Building Edges toolbox are used to modify roof edges and corners of 3D
building models.
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TO USE TOOL

Set all edges of a building model to
rectangular

Set All Edges

Apply a straight line between two vertices Apply Straight Line

Apply an intersection line of two patches Apply Intersection Line

Move an edge of a building Modify Edge

Move an edge vertex Move Edge Vertex

Align an edge segment perpendicular or
parallel to another edge

Align Edge Segment

Create a step corner Build Step Corner

Cut an edge corner Cut Edge Corner

Cut an edge segment Cut Edge Segment

Delete a vertex from an edge Delete Edge Vertex

Add a new vertex to an edge Insert Edge Vertex

Building Edges tools work only when the Check Building Models dialog is open. You can undo
the actions of the tools by using the Undo command of the CAD platform.

Align Edge Segment

Align Edge Segment tool moves an edge segment. At the same time, it aligns the edge segment
according to a base direction defined by a reference edge segment. The alignment is either
parallel or perpendicular to the reference edge segment.

To align an edge segment:

1. Select Align Edge Segment tool.

2. Move the mouse pointer inside a view.

The edge segment closest to the mouse pointer is dynamically highlighted.

3. Define the reference edge segment with a data click. This defines the base direction.

4. Define the edge segment to align with a data click.
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This updates the Detail view and displays the image that sees the selected edge segment
location best. If you move the mouse pointer, the new edge location is dynamically
displayed.

5. Define the new location of the edge segment with a data click.

This aligns and places the edge segment at the new location. You can continue with step 4.
After placing a reset click, you continue with step 3.

Apply Intersection Line

Apply Intersection Line tool replaces edge segment(s) between two planar patches with an
intersection line of two planes. This may move the original edge segment(s) and vertices to
another location in order to match the exact intersection of the planes. Unnecessary
intermediate vertices are removed from the resulting intersection line.

To apply  an intersection line:

1. Select Apply Intersection Line tool.

The Apply Intersection Line dialog opens:

2. Define whether all segments or only one segment is effected by the tool.

3. Move the mouse pointer inside a view.

The location of the intersection line between two patches closest to the mouse pointer is
dynamically highlighted.

4. Accept the intersection line with a data click.

This sets the intersection line, adjusts vertices if necessary, and deletes unnecessary
intermediate vertices along the intersection line. You can continue with step 2 or 4.

SETTING EFFECT

Apply to Defines the edge segments effected by the
tool:

· All segments - all edge segments are
replaced by the intersection line.

· One segment - only one edge segment is
replaced by the intersection line.
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The tool adjusts vertices in order to apply an intersection line between two patches. If
several intersection lines are connected in one vertex, it might be necessary to apply the
tool several times to the edges. Then, the location of the vertices is more and more refined
until intersection lines can be applied to all edges.

Apply Straight Line

Apply Straight Line tool moves all close by vertices to match a straight line between two
selected vertices. Unnecessary vertices are removed from the resulting edge.

To apply  a straight line:

1. Select Apply Straight Line tool.

The Apply Straight Line dialog opens:

2. Define an offset within which the vertices are moved to match the straight line.

3. Move the mouse pointer inside a view.

The vertex closest to the mouse pointer is dynamically highlighted.

4. Define the first vertex of the straight connection line with a data click.

If you move the mouse pointer, the area within which vertices are effected is dynamically
displayed.

5. Define the second vertex of the straight connection line with a data click.

This moves all vertices within the given offset to the straight line and deletes unnecessary
intermediate vertices along the edge. You can continue with steps 2 or 4.

SETTING EFFECT

Within Offset within which vertices are effected.
Half of the given offset value applies to the
left side and half to the right side of the
straight line.
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Build Step Corner

Build Step Corner tool detaches a vertex and moves it along an incoming/outgoing edge
segment. Only the vertex is moved, the effected segment should be aligned in a separate step
using the Align Edge Segment tool.

To build a step corner:

1. Select Build Step Corner tool.

2. Move the mouse pointer inside a view.

The edge segment and vertex to be detached closest to the mouse pointer is dynamically
highlighted.

3. Define the vertex to detach and move with a data click.

This updates the Detail view and displays the image that sees the selected vertex location
best. If you move the mouse pointer, the new vertex location is dynamically displayed.

4. Define the new location of the vertex with a data click.

This places the vertex at the new location. You can continue with step 3.

Cut Edge Corner

Cut Edge Corner tool can modify a patch corner in two ways. It cuts off a piece from a corner or it
adds a piece to a corner. In any case, the new edges are aligned perpendicular to the edges the
form the original corner.

To add/cut off a  piece to/from an edge corner:

1. Select Cut Edge Corner tool.

2. Move the mouse pointer inside a view.

The edge corner closest to the mouse pointer is dynamically highlighted.

3. Define the edge corner to modify with a data click.

This updates the Detail view and displays the image that sees the selected corner location
best. If you move the mouse pointer, the new edge of the corner is dynamically displayed.

4. Define the location of one edge segment with a data click.

5. Define the location of the other edge segment with a data click.

This places the new corner at the defined location. You can continue with step 3. You can go
back from steps 5 to 4 and 4 to 3 by placing a reset click.
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Cut Edge Segment

Cut Edge Segment tool can modify an edge segment in two ways. It cuts off a piece from a
segment or it adds a piece to a segment. The cut off or added part is formed by three new edge
segments of which two are perpendicular and one is parallel to the original edge segment.

To add/cut off a  piece to/from an edge segment:

1. Select Cut Edge Segment tool.

2. Move the mouse pointer inside a view.

The edge closest to the mouse pointer is dynamically highlighted.

3. Define the edge to modify with a data click.

This updates the Detail view and displays the image that sees the selected edge location
best. If you move the mouse pointer, the new edge is dynamically displayed.

4. Define the location of one perpendicular edge segment with a data click.

5. Define the location of the other perpendicular edge segment with a data click.

6. Define the location of the parallel edge segment with a data click.

This places the new edge segments at the defined locations. You can continue with step 3.
You can go back from steps 6 to 5, 5 to 4, and 4 to 3 by placing a reset click.

Delete Edge Vertex

Delete Edge Vertex tool removes a vertex from an edge. Only vertices that connect two edge
segments can be removed.

To delete an edge vertex:

1. Select Delete Edge Vertex tool.

2. Move the mouse pointer inside a view.

The vertex closest to the mouse pointer is dynamically highlighted.

3. Define the vertex to delete with a data click.

This removes the vertex. You can continue with steps 3.
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Insert Edge Vertex

Insert Edge Vertex tool adds a new vertex to an edge segment. It also defines the location of
the new vertex.

To add an edge vertex:

1. Select Insert Edge Vertex tool.

The Insert Edge Vertex dialog opens:

2. Define setting.

3. Move the mouse pointer inside a view.

The edge segment closest to the mouse pointer is dynamically highlighted.

4. Define the edge segment to which to add a vertex with a data click.

This updates the Detail view and displays the image that sees the selected edge location
best. If you move the mouse pointer, the new vertex location is dynamically displayed.

5. Define the location of the new vertex with a data click.

This adds the vertex and places the edge segments according to the location of the new
vertex. You can continue with step 3.

SETTING EFFECT

Insert at Determines a rule for inserting an edge
vertex:

· Free position - the vertex can be inserted
freely without limitations.

· 90 degree angle - the vertex can be inserted
only at a place where it creates a 90 degree
corner.

· To base 90 degree angle - the vertex can be
inserted only at a place where it creates a 90
degree corner of the base polygon.

· To intersection - the vertex can be inserted
only at a place where it creates an edge
segment following the direction of an
intersection line. This applies only if a
vertex is inserted to an edge that shares an
end point with an intersection line.
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Modify Edge

Modify Edge tool moves an edge vertex or segment. The modification effects all parallel
segments of the same edge.

To modify  an edge vertex or segment:

1. Select Modify Edge tool.

The Modify Edge dialog opens:

2. Define settings.

3. Move the mouse pointer inside a view.

The edge segment or vertex closest to the mouse pointer is dynamically highlighted.

4. Define the edge segment or vertex to move with a data click.

This updates the Detail view and displays the image that sees the selected edge/vertex
location best. If you move the mouse pointer, the new edge segment or vertex location is
dynamically displayed.

5. Define the new location of the edge segment or vertex with a data click.

This places the edge segment or vertex at the new location and adjusts all other parallel
segments along the same edge accordingly. You can continue with steps 2 or 4.

SETTING EFFECT

Move Determines a rule for moving an edge vertex:

· Freely - the vertex can be moved freely
without limitations.

· Along closest line - the vertex can be moved
only in the direction of the closest line. This
is basically the incoming and outgoing edge
segment.

· Along incoming line - the vertex can be
moved only in the direction of the incoming
edge segment.

· Along outgoing line - the vertex can be
moved only in the direction of the outgoing
edge segment.
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SETTING EFFECT

· To 90 degree angle - the vertex can be
moved only to a place where it creates a 90
degree corner.

· To base 90 degree angle - the vertex can be
moved only to a place where it creates a 90
degree corner of the base polygon.

· To intersection - the vertex can be moved
only in the direction of an intersection line.
This applies only to vertices that are end
points of intersection lines.

Vertex Status of the vertex for tools that
automatically adjust edges and vertices, such
as the Set All Edges tool:

· Free - sets a vertex to be freely movable for
automatic edge and vertex adjustment.

· Fixed - sets a vertex to be fixed in automatic
edge and vertex adjustment.

Move Edge Vertex

Move Edge Vertex tool moves a vertex. The modification only effects the edge segments that
are connected at the vertex but does not move other parallel edge segments.

To modify  an edge vertex or segment:

1. Select Move Edge Vertex tool.

The Move Edge Vertex dialog opens:

2. Define settings.

3. Move the mouse pointer inside a view.

The vertex closest to the mouse pointer is dynamically highlighted.

4. Define the vertex to move with a data click.

This updates the Detail view and displays the image that sees the selected vertex location
best. If you move the mouse pointer, the new vertex location is dynamically displayed.

5. Define the new location of the vertex with a data click.
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This places the vertex at the new location. You can continue with steps 2 or 4.

SETTING EFFECT

Move Determines a rule for moving an edge vertex:

· Freely - the vertex can be moved freely
without limitations.

· Along closest line - the vertex can be moved
only in the direction of the closest line. This
is basically the incoming and outgoing edge
segment.

· Along incoming line - the vertex can be
moved only in the direction of the incoming
edge segment.

· Along outgoing line - the vertex can be
moved only in the direction of the outgoing
edge segment.

· To 90 degree angle - the vertex can be
moved only to a place where it creates a 90
degree corner.

· To base 90 degree angle - the vertex can be
moved only to a place where it creates a 90
degree corner of the base polygon.

· To intersection - the vertex can be moved
only in the direction of an intersection line.
This applies only to vertices that are end
points of intersection lines.

Vertex Status of the vertex for tools that
automatically adjust edges and vertices, such
as the Set All Edges tool:

· Free - sets a vertex to be freely movable for
automatic edge and vertex adjustment.

· Fixed - sets a vertex to be fixed in automatic
edge and vertex adjustment.

Set All Edges

Set all edges tool adjusts the edges of roof patches. As a result, all patches are set to a rectangle
or rectangular shape. The tool can adjust all patches of a roof or only a single patch. Vertices
that have been set by the Modify Edge or Move Edge Vertex tools to status Fixed are not
changed. The other edges/vertices are adjusted to the fixed vertices.

To set all edges:

1. Select Set All Edges tool.

The Set All Edges dialog opens:
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2. Select settings.

3. Move the mouse pointer into a view.

This displays the adjusted shape of one or more patches as preview.

4. Apply the edge adjustment with a data click inside the patch or roof area.

This sets the edges and thus, the shape of the patch(es).

SETTING EFFECT

Modify Determines the patches to modify: All patches
or One patch.

Set to Defines the shape of the patch(es):

· Rectangle - all patches are set to rectangles.

· Rectangular - all patches are set to
rectangular shapes.

Walls toolbox

The tools in the Walls toolbox are used to vectorize walls classified in point cloud data and
modify the vectorized elements. Tools generate wall line and polygon elements to zero
elevation. Tools could be used to produce building footprint polygons to use as input for
building vectorization, or to efficiently digitize building plans from indoor scans.

 

 

TO USE TOOL

Define levels and appearance for wall
elements

Define Wall Settings

Extract wall line segments from point cloud
automatically

Vectorize Wall Lines

Place wall lines manually Place Wall Line
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TO USE TOOL

Place wall line by key point and parallel
alignment

Place Wall Thru Point

Connect two parallel wall line segments to
make a corner

Place Wall Corner

Connect wall line segments to a continuous
wall line

Connect Wall Lines

Place closed wall polygon from scratch Place Wall Polygon

Build closed wall polygon from separate
wall line segments

Build Wall Polygon

Clear wall line segments from the CAD file Delete Wall Lines

Define Wall Settings

Define wall settings specifies CAD levels and element appearance for tools in the Wall toolbox
when new elements are created with the tools.

To define wall settings:

1. Select the Define Wall Settings  tool.

The Define Wall Settings  dialog opens:

2. Define settings and click OK.

This writes settings to the TerraScan setting file.

SETTING EFFECT

Wall lines Level, color, and line weight for wall lines

Wall polygons Level, color, and line weight for wall
polygons
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Vectorize Wall Lines

Vectorize wall lines creates wall line segments to CAD from input wall points. The tool searches
for continuous linear chains of points and places line element to the CAD file when detects
one. Line elements are always placed to the zero elevation.

The tool expects as input a point class representing vertical walls. Input points can be classified,
for example, using By best match group classification routine. The input may represent either
interior or exterior walls.

To vectorize wall lines:

1. Select the Vectorize Wall Lines tool.

The Vectorize Wall Lines dialog opens:

2. Define settings and click OK.

This starts the vectorization process. Wall lines are produced on the level specified in wall
settings.

SETTING EFFECT

Class Source class(es) representing vertical
walls.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Tolerance The width of the corridor considered in
extraction of continuous linear chain of
points. The value should correspond to the
horizontal spread in the point cloud.

Inside fence only If on, only points inside the active fence
are used in vectorization.
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Place Wall Line

Place wall line tool is used to manually digitize wall lines. The tool may be used to digitize parts
of walls missing after detection with Vectorize Wall Lines, or to digitize entire sets of lines
manually.

The tool produces line elements with properties specified in wall settings. The tool is designed
to be used in a top view.

To place a wall line:

1. Select the Place Wall Line tool.

The Place Wall Line dialog opens:

2. Define settings.

SETTING EFFECT

Detail view The number of the detail view. If None, no
detail view is used but elements are digitized
in any view.

Fix to 90 degree turns If on, vertices of the finished wall line are
shifted to create right angles when possible.

Simplify geometry If on, unnecessary vertices of the finished
wall line are removed.

Max movement Limit for changes when finished wall line is
adjusted.

Undo last Click on the button in order to delete the last
vertex that was placed while digitizing the
wall line.

Close Finish the wall line connecting the last vertex
with the first one.

3. Place a vertex at a wall corner.

4. Pan to the next building corner.
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OR if detail view is defined

3. Locate approximate position of a wall corner in some other than detail view.

This focuses the detail view to show the position picked.

4. Place a vertex to the wall corner.

5. Repeat steps 3 and 4 until the wall line is done.

You can click on the Undo last button in order to delete the last vertex that was placed. The
undo action can be applied several times.

6. Press the reset button to finish the wall line.

OR

6. Press the Close button to connect the first and the last wall line vertex.

OR

6. Place data click to the first vertex of the wall line.

This finishes the wall line. The geometry is adjusted and simplified according to settings.

Place Wall Thru Point

Place wall thru point tool is used to manually digitize wall lines.

With this tool a line is defined with three data clicks. The tool can be useful to place wall lines
when corresponding walls are not properly present in point cloud data. Another example use
case is placement of wall line perfectly parallel to another.

The tool produces line elements with properties specified in wall settings. The tool is designed
to be used in a top view.

To place a wall thru point:

1. Select the Place Wall Thru Point tool.
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2. Enter the key point the final wall line should intersect (1).

This temporarily shows the key point as a small circle in CAD views.

3. Enter the start point of an alignment line (2) defining the direction of the wall line.

This shows the preview of the wall line and temporarily the alignment line.

4. Enter the end point of the alignment line (3) defining the direction of the wall line.

This finishes the wall line and removes preview elements.

Place Wall Corner

Place wall corner tool is used to form a corner connecting two roughly parallel wall lines. The
idea is to complete drawing by placing missing elements and connecting separated ones.

The tool interacts with line elements on wall line level specified in wall settings. The tool is
designed to be used in a top view.

To place a wall corner:

1. Select the Place Wall Corner tool.

The tool starts to highlight open wall line ends.

2. Select the first wall line end with a data click.

The defined end point remains highlighted.

3. Select the other wall line end with a data click.

The tool starts to show a preview of the connecting wall line edge.

4. Adjust the position of the corner and accept with a data click.

This finishes the corner and updates drawing in the CAD file.
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During the process, a reset click revokes the previous step in the drawing process.

Connect Wall Lines

Connect wall lines tool is used to join two separate wall line segments. It can connect line
endpoints with a straight line, or trim lines to their intersection.

The tool interacts with line elements on wall line level specified in wall settings. The tool is
designed to be used in a top view.

To connect wall lines:

1. Select the Connect Wall Lines tool.

The tool begins to highlight suitable wall line end points.

2. Define the first wall line end point with a data click.

The defined end point remains highlighted.

3. Define the second wall line end point with a data click.

Preview of the line connection is displayed. Yellow preview color indicates direct
connection, magenta color indicates trimmed connection.

4. Select the type of line connection by positioning mouse cursor inside or outside the sharp
corner between selected two lines. Accept the selection with a data click.

This finishes the corner and updates drawing in the CAD file.

During the process, a reset click revokes the previous step in the drawing process.

Place Wall Polygon

Place wall polygon tool is used to manually digitize closed wall polygons.

The tool produces line elements with properties specified in wall settings. The tool is designed
to be used in a top view.

To place a wall polygon:

1. Select the Place Wall Polygon tool.

The Place Wall Polygon dialog opens:
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2. Define settings.

SETTING EFFECT

Detail view The number of the detail view. If None, no
detail view is used but elements are digitized
in any view.

Fix to 90 degree turns If on, vertices of the finished wall polygon
are shifted to create right angles when
possible.

Simplify geometry If on, unnecessary vertices of the finished
wall polygon are removed.

Max movement Limit for changes when finished wall polygon
is adjusted.

Undo last Click on the button in order to delete the last
vertex that was placed while digitizing the
wall polygon.

3. Place a vertex at a wall corner.

4. Pan to the next building corner.

OR if detail view is defined

3. Locate approximate position of a wall corner in some other than detail view.

This focuses the detail view to show the position picked.

4. Place a vertex to the wall corner.

5. Repeat steps 3 and 4 until the wall polygon is done.

You can click on the Undo last button in order to delete the last vertex that was placed. The
undo action can be applied several times.

6. Press the reset button to finish the wall polygon.



TerraScan User Guide  © 2023 Terrasolid Ltd

181TerraScan Toolbox > 3D Building Models > Walls toolbox

Build Wall Polygon

Build wall polygon tool is used to systematically construct wall polygons from wall lines. The
tool can connect separated wall lines to a closed polygon or create a polygon from selected
closed line elements.

The tool interacts with line elements on wall line level and produces polygons with properties
specified in wall settings.

To build a wall polygon from a closed line:

1. Select the closed line segment(s).

2. Select the Build Wall Polygon tool.

The tool begins to preview the wall polygon.

3. Accept the preview with a data click.

This finishes the wall polygon and updates drawing in the CAD file. Selected wall lines are
replaced with the polygon.

To build a wall polygon from separated wall line segments:

1. Select the Build Wall Polygon tool.

The Build Wall Polygon dialog opens and the tool starts to highlight open wall line ends on
mouse hover:

2. Define settings.

SETTING EFFECT

Fix to 90 degree turns If on, vertices of the finished wall polygon
are shifted to create right angles when
possible.

Simplify geometry If on, unnecessary vertices of the finished
wall polygon are removed.

Max movement Limit for changes when finished wall polygon
is adjusted.

3. Select the first open wall line end with a data click.

The tool starts to highlight possible connections between other open wall line ends.
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4. Select the wall line end to connect with a data click.

Repeat the step 4 until you reach the other end of the first wall line.

5. Accept the polygon with a data click.

This finishes the wall polygon and updates drawing in the CAD file. Selected wall lines are
replaced with the polygon.

During the process, a reset click revokes the previous step in the drawing process.

Delete Wall Lines

Delete wall lines tool is used to remove wall lines from the CAD file. It clears any CAD file
elements  placed on the wall line level. Wall line level can be specified in wall settings.

To delete wall lines:

1. Select the Delete Wall Lines tool.

This removes all elements from the wall line level.
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Displayset toolbox

Tools in the Displayset toolbox are used to add points to, remove points from, and clear
displaysets. Displaysets can be used to display only a subset of points from a larger point cloud.
This may be helpful to focus on a specific area by only displaying the points of this area in a
view. Classification tools with setting Any visible point as source class classify only points that
are included in the displayset.

 

 

TO USE TOOL

Add points to a displayset Add Points To Displayset

Remove points from a displayset Remove Points From Displayset

Clear a displayset Clear Displayset

Add Points To Displayset

Add Points To Displayset tool adds points to a displayset. If there is not yet a displayset, the
tool creates one. You can add all points of all or selected classes to a displayset, or a specific
group, or points inside a fence.

To add points to a displayset:

1. Select Add Points To Displayset tool.

This opens the Add Points to Displayset dialog:

3. Define settings.

4. If Use is set to All points, place a data click inside a view.

If Use is set to Group, place a data click on the group to add to the displayset.
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If Use is set to Fence, draw a fence by placing data clicks inside a view. The last data click
must close the fence. Confirm the fence content with an additional data click.

This adds the points to the displayset. If Points is set to Displayset only for a view in the
Display mode dialog, only points of the displayset are visible in this view.

SETTING EFFECT

Class Point class(es) added to the displayset.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Use Determines which points are added to the
displayset:

· All points - all points in the given source
class(es).

· Group - points of one group in the given
source class(es). This requires that groups
are assigned to the points.

· Fence - points inside a fence in the given
source class(es).

Clear Displayset

Clear Displayset tool removes all points from a displayset.

To clear a displayset:

1. Select Clear Displayset tool.

This removes all points from the displayset. The point display changes to all points, even if
Points is set to Displayset only in the Display mode dialog.

Remove Points From Displayset

Remove Points From Displayset tool removes points from a displayset. This requires that there
is already a displayset created with the Add Points To Displayset tool. You can remove all points
of all or selected classes from a displayset, or a specific group, or points inside a fence.

To remove points from a displayset:

1. Select Remove Points From Displayset tool.

This opens the Remove Points from Displayset dialog:
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3. Define settings.

4. If Use is set to All points, place a data click inside a view.

If Use is set to Group, place a data click on the group to add to the displayset.

If Use is set to Fence, draw a fence by placing data clicks inside a few. Confirm the fence
content with an additional data click.

This removes the points from the displayset. If all points are removed from the displayset,
the displayset is cleared. The point display changes to all points, even if Points is set to
Displayset only in the Display mode dialog.

SETTING EFFECT

Class Point class(es) removed from the
displayset.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Use Determines which points are removed from
the displayset:

· All points - all points in the given source
class(es).

· Group - points of one group in the given
source class(es). This requires that groups
are assigned to the points.

· Fence - points inside a fence in the given
source class(es). This requires that a fence
is drawn in the CAD file before starting
the tool
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Draw toolbox

The tools in the Draw toolbox are used to fit or adjust vector elements to point cloud data. In
addition, there are tools for validating vector elements.

 

 

TO USE TOOL

Adjust mouse clicks to laser point
coordinates

Mouse Point Adjustment

Fit linear element by laser points Fit Linear Element

Drape linear element to laser surface Drape Linear Element

Find breakline running parallel to an
element

Find Breakline Along Element

Find curb stone running along a 2D element Find Curb Along Element

Cut linear element with other features
close-by

Cut Linear Element

Compare footprint polygons and classified
roof hits

Check Footprint Polygons

Adjust shape element to laser elevation Set Polygon Elevation

Identify polygons that are inside a selected
bounding polygon

Mark Polygons by Centroid

Place shape around a group of laser points Place Collection Shape

Find and classify pipes Find Pipes

Draw tunnel sections into the CAD file Vectorize Tunnel Sections Not UAV

Check tunnel cross sections one at a time Check Tunnel Sections Not UAV

Inspect elements one at a time Inspect Elements
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Check Footprint Polygons

Check Footprint Polygons tool compares building footprint polygons with point cloud data,
usually with points classified into building class. The software computes the percentage of each
polygon covered by point cloud data and the optimal rotation of a polygon in order to match the
point cloud data best. The rotation computation considers the roof structure where the normal
vector of the roof planes effect the footprint polygon rotation. There are two methods
implemented in the tool:

· Check as list - the software offers a list of footprint polygons and the results of the
comparison with point cloud data. The user can check the footprints by going through the
list. The list dialog also offers modification tools for improving the footprint polygons.

· Mark mismatches - the software marks areas with problems between footprint polygon and
point cloud data. It may create polygons that mark areas of low point density (footprint is
not covered with points) and areas of missing footprints (no footprint for points classified as
building).

The tool is useful for finding flaws in the building classification, places with no or very sparse
laser points on building roofs, and flaws in building footprint vector data. It's recommended to
be used before the footprint polygons are used in automatic building vectorization.

To compare footprint polygons and laser data:

1. Load laser data into TerraScan. Only points in class(es) for the comparison with footprint
polygons are required.

2. Select the footprint polygons that you want to include in the comparison.

3. Select the Check Footprint Polygons tool.

This opens the Check Footprint Polygons dialog:
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4. Define settings and click OK.

The comparison starts and the software creates either a list of comparison results for each
footprint or polygons that mark problematic areas.

SETTING EFFECT

Source classes Point class(es) used for the comparison. The
list contains the active classes in TerraScan.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Source classes field.

Method Method for handling comparison results:

· Check as list - list dialog shows footprint
polygons and offers tools for interactive
modification of the polygons.

· Mark mismatches - polygons drawn in the
CAD file mark areas with problems.

This determines the availability of further
settings in the dialog.

Search data Distance from the footprint boundary
within which the software searches for
point cloud data.

Radius Circular area covered by a point. The value
depends on the point density.

Pixel size Size of a pixel for analyzing point coverage
inside a polygon area.

Solve shift Automatic footprint shift toggle. If on,
solves automatic shift but processing time is
longer.

Top view Number of a CAD file view that is used to
display the footprint area as top view.

Rotate to match footprint If on, the top view is rotated horizontally in
order to follow the base direction of the
footprint.

Section view Number of a CAD file view that is used to
display the footprint area as section view.

Oblique view Number of a CAD file view that is used to
display a footprint on top of oblique
images. This requires image data loaded in
TerraPhoto.

Ground Class used to turn a 2D footprint polygon
into a 3D polygon. This is required for the
display on top of oblique images in order to
enable the comparison in 3D. Usually,
points on the ground should be used.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in
the Ground field.

Corner lines Length, color and line weight of temporary
vertical line elements that are drawn for
building corners in oblique views. Click on
the color field in order to select another
color from the Windows Color dialog.
Change the line weight by selecting another
weight from the list. The list contains the
standard line weights of the CAD file.

Create polygons for low density If on, polygons are created on places where
there is a selected polygon but no or only
sparse laser points in the given Source
class(es).

Covered Defines the minimum point density inside a
footprint polygon. If the density is lower, a
polygon is created.

Area Defines the minimum area of a building.
Only areas larger than the given value are
considered in the comparison.

Level Polygons marking low density places are
drawn on the given level using the active
symbology settings of the CAD file.

Create polygons for missing footprint If on, polygons are created on places where
there are laser points in the given Source
class(es) but no selected polygon.

Points Defines the minimum distance between a
laser point and a selected polygon. If the
distance is larger, a polygon is created.

Area Defines the minimum area of a building.
Only areas larger than the given value are
considered in the comparison.

Level Polygons marking missing footprint places
are drawn on the given level using the
active symbology settings of the CAD file.

Check Footprint Polygons results

If method Check as list is used for footprint polygon vs. point cloud data comparison, another
Check Footprint Polygons dialog is opened to show the results:
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The dialog offers various options to modify and improve the footprint polygons.

MENU COMMAND/BUTTON EFFECT

Auto rotate Derives a rotation for the polygon in order to
fit it to the point cloud data. After clicking
the button, move the mouse close to the
footprint in the top view. The new position
is shown. Place a data click in order to
confirm the new position.

Auto shift Derives a shift for the polygon in order to fit
it to the point cloud data. After clicking the
button, move the mouse close to the
footprint in the top view. The new position
is shown. Place a data click in order to
confirm the new position.

Rotate Lets you interactively rotate a polygon. Place
a data click in the top view to determine the
rotation center point. Move the mouse
pointer to rotate the polygon. Confirm the
new position with another data click.
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MENU COMMAND/BUTTON EFFECT

Shift Lets you interactively shift a polygon. Place a
data click in the top view to determine the
shift origin. Move the mouse pointer to shift
the polygon. Confirm the new position with
another data click.

Fix corners Sets polygon corners to 90 degree angles. In
the Fix Corners dialog, the user can define
whether the edge positions are derived from
the existing polygon or from the point cloud
data.

Reject Moves a polygon to another CAD file level.
This button is defined in the Check Footprint
Buttons dialog.

Show Select a footprint polygon in the list and click
on the Show button. Move the mouse
pointer inside the top view. This highlights
the corners of the selected polygon. Place a
data click in order to center the polygon in
the view.

Identify Click on the Identify button and move the
mouse pointer close to a footprint polygon
in the top view. This highlights the polygon.
Place a data click in order to center the
polygon in the view and to select the
corresponding row in the list of footprint
polygons.

Change between oblique images by clicking
on one of the four buttons around the
building icon. An oblique image that sees
the building from the selected direction is
displayed in the Oblique view. This requires
image data loaded in TerraPhoto.

File / Save list as Saves the list of footprint polygons into a
text file.

View / Fields Set the display of fields in the Check
Footprint Polygons dialog.

View / Sort by Sort the list of footprint polygons in the
Check Footprint Polygons dialog:

· Area - size of the footprint area.

· Corners - Number of non-90-degree
corners.

· Coverage - percentage of area covered
with point cloud data.
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MENU COMMAND/BUTTON EFFECT

· Location - geographical location.

· Angle - angular mismatch.

· Shift - locational mismatch.

View / Buttons Set the display of buttons and the action of
user-defined buttons.

Edit / ... The Edit menu contains commands that
apply the same actions to polygons as the
buttons described above:
Auto rotate, Auto shift, Rotate, Shift, Fix
corners.

Tools / Mark missing data polygons Move footprint polygons without point cloud
data to another CAD file level.

Tools / Label coverage Create text elements that label footprint
polygons.

Tools / Apply fixes Apply fixes to all footprint polygons in the
list if given conditions are fulfilled.

View / Fields

Fields command from the View menu opens the View Footprint Fields dialog:

Switch on the attributes that you want to see in the list of the Check Footprint Buttons dialog.
Click OK to apply changes in the settings.

ATTRIBUTE DESCRIPTION

Area Size of a footprint polygon.

Coverage Area of the footprint polygon covered with
point cloud data. Given in percentage.

Angle correction Angular mismatch between the footprint
polygon and the building in the point cloud
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ATTRIBUTE DESCRIPTION

data.

Reliability rating Weight for computing the angle correction.
The value determines how reliable a
suggested rotation is. The higher the value,
the better the auto rotation will match the
polygon to the point cloud data.

Shift distance Horizontal locational mismatch between the
footprint polygon and the building in the
point cloud data.

Corners (non 90 deg) Number of corners that are not 90 degree.

Show overlap with red text Footprint polygons that overlap each other
are shown with red text in the list of the
Check Footprint Buttons dialog.

View / Buttons

Buttons command from the View menu opens the Check Footprint Buttons dialog:

Switch on the buttons that you want to see in the Check Footprint Buttons dialog. You may
define additional buttons for moving polygons to specific CAD file levels.

To define additional buttons:

1. Select a CAD file level from the selection list.

2. Type a name for the button in the text field.

3. Decide whether the footprint polygon is removed from the list in the Check Footprint
Buttons dialog or not when the button is pressed.
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4. Click OK in order to apply the changes to the button settings.

Tools / Mark missing data polygons

Mark missing data polygons command from Tools menu can be used to move footprint
polygons to another CAD file level if there is not enough point cloud data in the building class.
This may help to identify buildings for which the creation of 3D building models is problematic
due to the lack of data. In general, a coverage of less than 50-60% is problematic for automatic
vectorization processes.

The command opens the Mark Missing Data Polygons dialog:

SETTING EFFECT

Less than Minimal expected percentage of polygon
area covered with points. If the percentage is
lower, the polygon is identified as missing
data area.

Move to level Polygons identified as areas of missing data
are moved to the given CAD file level.

Remove from list If on, the footprint polygon is removed from
the list in the Check Footprint Buttons dialog.

Tools / Label  coverage

Label coverage command from the Tools menu creates text elements as labels for footprint
polygons. The label shows the percentage of area that is covered with point cloud data. The
text elements are drawn in the CAD file on the active level using the active text and symbology
settings.

The command opens the Label Coverage dialog:
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SETTING EFFECT

Draw labels Determines for which polygons the labels are
created:

· For all polygons - all polygons.

· For missing data polygons - only polygons
with a coverage defined by the Less than
setting.

Less than Minimal percentage of polygon area covered
with points. Only if the percentage is lower,
the polygon is labeled. This is only active if
Draw labels is set to For missing data
polygons.

Tools / Apply fixes

Apply fixes command from the Tools menu applies corrections to all footprint polygons that
fulfill given conditions. The user defines what corrections to apply (rotation, shift, fix corners)
and what conditions must be fulfilled. Only footprint polygons for which all conditions apply,
are modified.
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SETTINGS EFFECT

Auto rotate If on, an angular correction is applied.

Auto shift If on, an horizontal locational correction is
applied.

Fix corners If on, corners are fixed to 90 degree angles.

Modify color If on, the given color is applied to the
modified polygons. Select another color from
the color selection list.

Area Polygons are modified if their size is within
the given range of squared CAD file units.

Coverage Polygons are modified if they are covered by
point cloud data within the given percentage
range.

Angle reliability Polygons are modified if their reliability
value for angle correction is within the given
percentage range.

Shift magnitude Polygons are modified if the magnitude of
the shift correction is within the given range
of CAD file units.

Not touching other footprints Polygons are modified if they do not touch
another footprint polygon.

Not resulting in overlap Polygons are modified if there is no overlap
between footprint polygons caused by the
modification.

Check Tunnel Sections
Not UAV

Check Tunnel sections tool supports the systematic check of tunnel sections created by the
Vectorize Tunnel Sections tool. It provides a list of tunnel sections from which you can select
one element after the other.

The tool includes settings that define a CAD file section view displaying a selected tunnel
section. The selected section is automatically centered in this view.

To check tunnel sections:

1. Select the alignment element that has been used for vectorizing the tunnel sections.
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2. Select the Check Tunnel Sections tool.

This opens the Check Tunnel Sections dialog:

SETTING EFFECT

Section level CAD file level on which the tunnel sections
have been drawn.

View CAD file view used for displaying the
selected tunnel section in a section view.

Offset Distance to the left and right from the
alignment element that is displayed in the
section view.

Depth Distance forward and backward from the
section centerline. Defines the depth of the
section displayed in the section view.

Section step Distance between consecutive sections. This
should be the same value as used for
vectorizing the tunnel sections.

First station Location of the first section for display along
the alignment element. By default, this is the
starting point of the alignment element.

Last station Location of the last section for display along
the alignment element. By default, this is the
end point of the alignment element.

3. Define settings and click OK.

This opens another Check Tunnel Sections dialog that contains the list of all sections that
belong to the selected alignment element:
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· Station - location of a tunnel section along the alignment element.

· Open - amount of gaps along the tunnel section line string. Entries with gaps are highlighted
in red.

· Closed - amount of closed tunnel section line strings.

· Area - size of the area enclosed by the tunnel section line string. Given in CAD file units.

4. Select a row in the list of sections.

This centers the selected section in the CAD file view defined in the tool’s View setting.

SETTING EFFECT

Connect Creates a connection line between open end
points of the tunnel section line string.

Show location Select a row in the list, click on the button
and move the mouse pointer inside a CAD
file view. This highlights the selected section
location in the view.

Identify Click on the button and identify an element
with a data click in a CAD file view. This
selects the corresponding row in the list.

To close a gap in a tunnel section

1. Select the section in the Check Tunnel Sections dialog list.

2. Select the Connect button in the Check Tunnel Sections dialog.

3. Move the mouse pointer inside the CAD file section view close to the gap you want to close.

This shows a preview of the connection line.

4. Place a data click in order to confirm the connection line. Continue placing connection lines
until all gaps are closed.
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This connects the end points of the existing section line string, moves the section drawing to
the active level of the CAD file and applies the active symbology settings. The entry in the
Check Tunnel Sections dialog list is updated.

You may use other CAD tools to modify tunnel sections as well. This is not updating the list in
the Check Tunnel Sections dialog automatically.

Cut Linear Element

Cut Linear Element tool determines the distance between linear elements and laser points or
other linear elements. It removes parts of linear elements for which there are no laser points,
no other linear elements, or other linear elements within a certain 3D distance.

It may be used, for example, to mark places where there are elements close to rail tracks or
wires.

To cut linear elements:

1. (Optional) Select the element(s) that you want to cut.

2. Select the Cut Linear Element tool.

This opens the Cut Linear Element dialog:

3. Define settings.

4. If elements have been selected, start the process with a data click inside the CAD file view.

This compares the selected elements to laser points or other elements and removes parts if
applicable.

OR

4. Identify the element to cut.

This highlights the given element.

5. Accept the highlighted element with a data click.

This compares the selected element to the laser points or other elements and removes parts
if applicable. You can continue to steps 3 or 4.
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SETTING EFFECT

Cut criteria Defines which element parts are removed:

· No points closeby - no laser points are
close to the element.

· No elements closeby - no other vector
elements are close to the element.

· Another element closeby - another
element is close to the element.

Cut intervals Minimum size of a linear element part to be
removed by the tool. An element (part) is
removed if the resulting 3D gap along the
element longer than the given value.

No points within An element (part) is removed if the 3D
distance to laser points/other elements is
larger than the given value.

Class Point class(es) considered in the distance
computation. This is only active if Cut
criteria is set to No points closeby.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Level Elements of the given CAD file level are
considered for distance computation. This is
only active if Cut criteria is set to No
elements closeby or Another element
closeby.

Drape Linear Element

Drape Linear Element tool fits linear elements to the elevation of laser points. The xy position
of the elements is not effected.

The tool is typically used to drape linear elements which run on a smooth, planar ground
surface or along edges of slopes. Valid CAD element types for this tool include lines, line
strings, shapes, and complex shapes. You can fit several selected elements in a single process.

You can decide whether you want to adjust only existing vertices or add intermediate vertices
so that the resulting element follows changes of the surface more closely. The density of
automatically added vertices depends on the density of laser points. In addition, smoothing
and thinning can be applied to the adjusted element.
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To drape linear elements to laser points:

1. (Optional) Select the element(s) that you want to drape.

2. Select the Drape Linear Element tool.

This opens the Drape Linear Element dialog:

3. Define settings.

4. If elements have been selected, start the draping process with a data click inside a view.

This drapes the selected elements to the laser points.

OR

4. Identify the element to drape.

This highlights the given element.

5. Accept the highlighted element with a data click.

This drapes the linear element to the laser points. You can continue to steps 3 or 4.

SETTING EFFECT

Runs along Type of surface structure the linear element
runs along:

· Planar surface - smooth planar surface.

· Juncture of surfaces - intersection of one
planar surface on the left side of the
element and another planar surface on
the right side.

· Edge of surface - edge of a surface where
only points on the left or on the right side
of the edge are used for draping.
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SETTING EFFECT

· Fixed height curb stone - curb stone of
constant height. Two linear elements are
generated with a given elevation
difference.

· Auto height curb stone - curb stone of
varying height. The average elevation
difference is derived from the points on
the left and the right side of the curb
stone edge. Two linear elements are
generated which have the derived
elevation difference.

Vertices Determines the computation of additional
vertices:

· Compute additional - additional vertices
are computed, the draped element
follows the surface structure more
closely.

· Drape original only - no additional
vertices are added.

From class Point class(es) to drape to. Contains the list
of active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Offset Offset distance range from which to use
laser points for computing elevation values
for the linear element.

Smoothen Z If on, smoothing is applied to the elevation
of vertices of the draped element. The
elevation of vertices can change up to the
value given in the Maximum field.

Thin If on, unnecessary vertices are removed
from the draped element. The allowed
change in position caused by thinning is
defined by the value in the Accuracy field.

Create copy If on, a new element is created and draped.
If off, the original element is draped.

Set symbology If on, you can define new symbology
settings for the draped element. Click on
the Define button in order to open the
Draped element symbology dialog. You can
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SETTING EFFECT

define Level, Color, Weight, and Style
settings.

Strip attributes If on, any attribute linkages are removed
from the draped element.

Shift If on, the draped element is created at the
given xy Distance from the surface edge
location. This is only active if Runs along is
set to Edge of surface.

Curb width Width of a curb stone, xy offset between
the upper and lower linear element of a
curb stone. This is only active if Runs along
is set to Fixed height curb stone or Auto
height curb stone.

Curb height Height of a curb stone, elevation offset
between the upper and lower linear
element of a curb stone. This is only active
if Runs along is set to Fixed height curb
stone.

To drape shapes to a constant elevation derived from laser points inside the shapes, you may
also check the Set Polygon Elevation tool.

Find Breakline Along Element

Find Breakline Along Element tool creates a linear element which runs along a breakline in the
terrain. The search starts with an existing 2D linear element which runs close to the actual
breakline location.

Valid CAD element types for this tool include lines, line strings, shapes, and complex shapes.
You can fit several selected elements in a single process.

The tool finds the more accurate breakline position if there is a planar surface on both sides of
the breakline. It is most useful to create hard breakline elements such as the top of man-made
slopes.

To find a breakline feature:

1. (Optional) Select the element(s) from which you want to create breaklines.

2. Select the Find Breakline Along Element tool.

This opens the Find Breakline Along Element dialog:
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3. Define settings.

4. If elements have been selected, start the process with a data click inside a view.

This creates new 3D elements at the most probably position of terrain breaklines close to the
selected elements.

OR

4. Identify the 2D linear element running close to a terrain breakline.

This highlights the given element.

5. Accept the highlighted element with a data click.

The application determines the most probable position for a breakline using the given
parameters and creates a 3D element running along the breakline. You can continue to steps
3 or 4.

SETTING EFFECT

Fit to class Point class from which to find the breakline
in the terrain. The list contains the active
point classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Fit to class field.

Breakline type Type of the breakline:

· Hard breakline - breakline which forms a
sharp corner when viewed in a cross
section.

· Soft breakline - breakline which forms a
soft corner when viewed in a cross
section.
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· Slope change - terrain slope changes at
the breakline.

· Elevation jump top - top of a breakline
feature forming a drop in elevation.

· Elevation jump bottom - bottom of a
breakline feature forming a drop in
elevation.

Soft breaks Distance between single linear elements
that form a soft breakline. This is only active
if Breakline type is set to Soft breakline.

Geometry Geometry type of the resulting element:

· Line - feature may have sharp turns.

· Curve - feature has smooth turns only.

· From element - derived from the original
element.

Result within Determines how close the original 2D
element is to the true xy position of the
breakline.

Plane width Width of the planar surfaces on both sides
of the breakline.

Thin result If on, unnecessary vertices are removed
from the breakline element. The allowed
change in position caused by thinning out
vertices is defined by the value in the
Accuracy field.

Find Curb Along Element

Find Curb Along Element tool creates longitudinal breakline elements along sharp edges in a
point cloud. It requires a 2D line element running along the approximate location of a curb
stone.

The tool creates two 3D line elements following the lower and upper edges of curb stones in a
point cloud. It separates the lower and upper edge up to a given minimum vertical distance. If
the height of the curb stone is smaller or if there are no sharp edges in the point cloud, only
one line is drawn or the detection fails. The edge detection method is based on cross-sections
every 25 cm along the 2D line element and the elevation jump of two planes (sidewalk and road
surface). The planes must be represented by at least 40 points for a confident edge detection.

The suggested workflow for preparing the curb stone detection is as follows:

1. Classify ground and low vegetation points. The points should include the upper and lower
ground level as well as the vertical side of a curb stone.

2. Classify model keypoints from ground points.
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3. Create a TIN model and display the model as shaded surface in TerraModeler.

4. Digitize an approximate 2D line string element along the curb stone edge. You may use any
TerraScan or CAD tool for line placement, such as Place railroad string tool, Place Polyline
tool (Spatix) or Place SmartLine tool (MicroStation).

To vectorize curb stones:

1. (Optional) Select the 2D line string element(s) running along the approximate curb stone
location.

2. Select Find Curb Along Element tool.

This opens the Find Curb Along Element dialog:

3. Define settings.

4.  If elements have been selected, place a data click inside a view in order to start the process.

OR

4. Identify the 2D line element running along the approximate curb stone location with a data
click.

This highlights the given element.

5. Accept the highlighted element with another data click.

This creates new 3D line elements at the most probably position of curb stones close to the
selected element(s). The line elements are drawn on the active level using the active
symbology settings of the CAD file. You can continue to steps 3 or 4.

SETTING EFFECT

Class Point class(es) from which to find the curb
stones.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Result within Determines how close the original 2D
element is to the true xy position of the
curb stone.

https://terrasolid.com/guides/tmodel/displayshadedsurface.html
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Separation Minimum distance between lower and
upper edge of a curb stone for which two
separate lines are drawn. If the height of a
curb stone is smaller, only one line is
drawn.

Min length Minimum length of a curb stone line
element.

You can undo the curb stone drawing by using the Undo command of the CAD platform.

Find Pipes

Find Pipes tool is used for the automatic detection of circular pipes based on dense point
clouds. It may be used to detect pipes running horizontally or vertically for a longer distance
without turns, such as pipes running inside a tunnel. The tool is not suited for pipes that run
with a lot of turns such as indoor pipes of industrial sites. 

Before running the tool, normal vectors must be computed for the point cloud. This can be
done using the Compute normal vectors command for loaded points or the Compute normal
vectors macro action. The software assumes that the normal direction points towards the
outside of a pipe. In addition, some thinning may be applied to a very dense point cloud in
order to speed up the detection process.

The Find Pipes tool runs on points loaded in TerraScan. It classifies laser points on pipes into a
separate class and optionally creates line string elements that represent the centerline of a
pipe.

To detect pipes automatically :

1. Load laser points into TerraScan.

2. Select Find Pipes tool.

This opens the Find Pipes dialog:
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3. Define settings and click OK.

This starts the detection process. The software classifies the points and draws a line string in
the center of a detected pipe, if the setting is selected. The level, color, line weight, and line
style of the line string are determined by the active level and symbology settings of the CAD
file.

SETTING EFFECT

From class Point class used for detecting pipes. The
list contains the active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class into which points on detected
pipes are classified.

Diameter Minimum and maximum outer diameter of
the pipes to detect. Choose values a bit
smaller (minimum) and bigger (maximum)
than the true pipe diameter.

Min length Minimum length of pipe structure to be
detected. This avoids false findings of
other circular objects in the point cloud.

Apply automatic thinning If on, thinning is applied to the point cloud
for detecting the pipes. The thinning
distance is automatically derived from the
pipe diameter settings. The thinning is
only done internally for the pipe detection
process and has no permanent effect on
the point cloud or pipe classification result.
Thinning speeds up the process
significantly and should be switched on.

Filter bad findings If on, the software refines the pipe
detection in order to avoid false findings of
other circular objects in the point cloud.

Draw linestring If on, the software draws a line string
element at the center location of a pipe.
The element is drawn using the active
level and symbology settings of the CAD
file.

If you only want to draw a centerline for already classified pipes, select the same class for
From class and To class settings of the tool.
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Fit Linear Element

Fit Linear Element tool improves the horizontal accuracy of manually placed linear elements by
fitting the xy location of vertices to laser points. The resulting linear element follows laser
points more closely.

Valid CAD element types for this tool include lines, line strings, shapes, and complex shapes.
You can fit several selected elements in a single process.

To fit linear elements:

1. (Optional) Select the element(s) that you want to fit.

2. Select the Fit Linear Element tool.

This opens the Fit Linear Element dialog:

3. Define settings and click OK.

If elements have been selected, they are fitted to the laser points.

4. Identify the element to fit with a data click.

This highlights the given element.

5. Accept the highlighted element with another data click.

This fits the selected element to follow laser points more accurately. You can continue to
step 4.

SETTING EFFECT

Mode Defines whether vertices are added to the
fitted element or not:
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SETTING EFFECT

· Sharp vertices - no additional vertices are
added. Suitable for fitting elements with
straight line segments between sharp turns
(for example overhead wires).

· Smooth curvature - additional vertices may
be added. Suitable for fitting an element
which has smooth curvature only (for
example paint line on a road).

To class Point class to fit to. Contains the list of active
classes in TerraScan.

Within dxy Maximum horizontal offset of laser points to
be used in the fitting process.

Within dz Maximum vertical offset of laser points to be
used in the fitting process. Enter a large value
such as 999.000 if you want to use all laser
points regardless of their elevation.

Create copy If on, a copy of the original element is created
and fitted. The new element is placed on the
active level using active symbology settings of
the CAD file.
If off, the original element is fitted.

Ignore points close to vertices If on, the fitting process ignores points within
the distance to element vertices given in the
Within dxy field. This is only active if Mode is
set to Sharp vertices.

Add vertices to long segments If on, the fitting process adds intermediate
vertices along long segments. The distance
between consecutive vertices is given in the
Step field. This is only active if Mode is set to
Smooth curvature.

Smoothen curvature If on, the curvature of the fitted element is
smoothed by balancing angular direction
changes between consecutive vertices. This is
only active if Mode is set to Smooth curvature.

Inspect Elements

Inspect Elements tool supports the systematic check of vector elements in a CAD file. It
provides a list of elements from which you can select one element after the other.

The tool includes view settings that define CAD file views displaying the selected element in
different view orientations. The selected element is automatically centered in these views.
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To inspect vector elements:

1. Select the elements you want to check.

2. Select the Inspect Elements tool.

This opens the Inspect Elements dialog:

SETTING EFFECT

Top view CAD file view that displays the selected
element in a top view.

Second top view CAD file view that displays the selected
element in a top view.

Front view CAD file view that displays the selected
element in a front section view. The cross
section is 90 degree rotated compared with
the Right view.

Right view CAD file view that displays the selected
element in a right section view.  The cross
section is 90 degree rotated compared with
the Front view.

Isometric view CAD file view that displays the selected
element in an isometric view.

Camera view CAD file view that displays the selected
element in a camera view. The view can
display images that are referenced by an
active image list in TerraPhoto.

https://terrasolid.com/guides/tphoto/index.html
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SETTING EFFECT

Fit view If on, the selected element is automatically
fitted in the view.

Modifies level If on, an element removed by the Remove
button of the Inspect Elements dialog is
moved to the given CAD file level.

Modifies color If on, the selected color is applied to an
element removed by the Remove button of
the Inspect Elements dialog. The list contains
the active color table of the CAD file.

3. Define settings and click OK.

This opens another Inspect Elements dialog that contains the list of all selected elements:

4. Select a line in the list of elements.

This centers the selected element in all CAD file views defined in the tool’s View settings.
You can use the remove button of the dialog to remove an element or take any other
appropriate action.

SETTING EFFECT

Remove Removes the selected element from the
list. The element itself is not deleted but it
can be moved to another level and/or get
another color according to the tool’s
Remove action settings.

Show location Select a line in the list, click on the button
and move the mouse pointer inside a CAD
file view. This highlights the selected
element in the view.
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SETTING EFFECT

Identify Click on the button and identify an element
with a data click in a CAD file view. This
selects the corresponding line in the list.

Moves one image backward in the active
image list and displays the new image in
the camera view.

Click on the button and move the mouse
pointer inside a CAD file view. The image
closest to the mouse pointer is highlighted.
Select an image for the camera view
display with a data click.

Moves one image forward in the active
image list and displays the new image in
the camera view.

Mark Polygons by Centroid

Mark Polygons by Centroid tool identifies polygons which are inside selected bounding
polygons. A polygon is defined as inside if its centroid is within the boundaries of the bounding
polygon. The identified polygons are moved from on CAD file layer to another.

To mark polygons by  centroid:

1. Select the bounding polygon(s).

2. Select the Mark Polygons by Centroid tool.

The Mark Polygons by Centroid dialog opens:

3. Define settings.

4. Place a data click inside a view.

This moves polygons to the target level if their centroid is inside the selected bounding
polygons. An information dialog shows the number of moved polygons.

SETTING EFFECT

From level Source layer from which polygons are
checked.
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SETTING EFFECT

To level Target layer to which polygons are moved.

Mark Polygons by Points

Mark Polygons by Points tool identifies polygons bounding laser data fulfilling defined criteria.
A polygon is defined as inside if its centroid is within the boundaries of the bounding polygon.
The polygons matching the defined criteria are modified with active actions.

To mark polygons by  points:

1. Select the polygon(s).

2. Select the Mark Polygons by Points tool.

The Mark Polygons by Points dialog opens:

3. Define settings.

4. Place a data click inside a view.

This modifies the polygons if points bounded by the polygon fulfill the selected criteria.

SETTING EFFECT

Class Point class(es) used to evaluate polygons

Criteria The criteria applied to pick polygons:

· Presence of points - if any points inside
polygon.

· Point density - if point density inside
polygon within range.

· Average amplitude - average amplitude
attribute value of points..
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SETTING EFFECT

· Average brightness - average color
brightness value of points.

· Average intensity - average intensity
attribute value of points.

· Average reflectance - average reflectance
attribute value of points.

· Smallest distance - smallest distance
attribute value of points.

· Average distance - average distance
attribute value of points.

· Biggest distance - biggest distance attribute
value of points.

Range Value range required for the selected criteria

Level If on, defines the level to which selected
elements fulfilling the criteria are moved.

Color If on, defines the active color applied to
selected elements fulfilling the criteria.

Weight If on, defines the weight applied to selected
elements fulfilling the criteria.

Style If on, defines the style applied to selected
elements fulfilling the criteria.

Mouse Point Adjustment

Mouse Point Adjustment tool adjusts vector data to the location and/or the elevation of laser
points. You can use this tool with any CAD or TerraScan element placement tool. Mouse Point
Adjustment simply fixes the coordinates of data clicks, which means the vertices of vector
elements to laser data coordinates. It might be considered as a “snap to laser points” tool.

You can choose whether the elevation and/or the xy location of the vertices are adjusted. If you
want to digitize a linear object, such as a wire, you probably want to adjust both, the xy and the
elevation of the vertices to the laser points. On the other hand, if you want to place an object
on the ground, you probably want to adjust only the elevation of the vertices.

To place elements adjusted to laser points:

1. Select the Mouse Point Adjustment tool.

This opens the Mouse Point Adjustment dialog:
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2. Define setting.

3. Start the drawing tool that you want to use and digitize elements.

As long as the Mouse Point Adjustment dialog is open and any adjustment option is switched
on, all vertices of elements are adjusted according to the settings.

SETTING EFFECT

Adjust elevation If on, the elevation of data clicks ( vertices) is
adjusted.

Dz Constant offset from the laser data elevation
value that is added to the elevation
coordinate of element vertices.

Adjust xy If on, the xy location of data clicks ( vertices) is
adjusted.

Class Point class to adjust to. Contains the list of
active classes in TerraScan.

Point Points or surface model from which element
vertex coordinates are derived:

· Closest - point closest to the data click.

· Highest - highest point within a search area.

· Average - average xy and/or z of all points
within a search area.

· Percentile - average xy and/or z of a given
percentile of points within a search area.

· Lowest - lowest point within search area.

· TIN model - elevation of a triangulated
surface model and xy from the closest point.

Within Radius of the search area around the mouse
pointer location.

Be sure to always close the Mouse Point Adjustment dialog if you do not want to adjust data
clicks to laser points. As it effects all data clicks, it may interfere with your normal work if it is
active.
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Place Collection Shape

Place Collection Shape tool lets you create shape elements that are associated with certain
thematic types. Collection shapes are used to group laser points together that belong, for
example, to a topographic object, such as a building or a road.

Collection shapes can be used later to output groups of laser points.

You need to define collection shape types before you can use the tool. See Collection shapes
category of TerraScan Settings for more information.

Collection shapes can be created manually by using the digitization function of the Place
Collection Shape tool. Alternatively, they can be produced automatically from already existing
shape elements that have been created using any CAD tool for shape drawing.

Collection shapes do not store any attribute information. The application only uses element
level, color, line weight, and line style to recognize a shape as a collection shape of a specific
type.

To place a collection shape:

1. (Optional) Select shape elements that you want to turn into collection shapes.

2. Select the Place Collection Shape tool.

The Place Collection Shape dialog opens:

3. Select a collection shape type in the Type list.

4. If shape elements have been selected, apply the collection shape symbology with a data click
inside a view.

This turns all selected shapes into collection shapes. An information dialog shows the
number of effected shape elements.

OR

4. (Optional) Define additional settings in the Place Collection Shape dialog.

5. Digitize the shape boundary by placing vertices with data clicks. To close the shape, place a
data click close to the first vertex. You can undo a vertex placement with a reset click.

This creates a shape element on the level and using the symbology specified for the
collection shape type. If a Number is defined, a text element is drawn inside the shape
element using active text settings of the CAD file.



TerraScan User Guide  © 2023 Terrasolid Ltd

219TerraScan Toolbox > Draw toolbox > Place Collection Shape

SETTING EFFECT

Type Collection shape type. The list contains all
shape types that are defined in Collection
shapes category of TerraScan Settings.

Number Text string that is drawn inside the shape
element. This works only if collection shapes
are digitized manually.

Increase automatically If on, and if the text string in the Number
field ends with a number, the number
increases by 1 after a collection shape has
been created manually.

Set Polygon Elevation

Set Polygon Elevation tool sets the elevation of a closed element based on laser points inside
it.

This tool is typically used to drape a digitized 2D shape to the elevation of laser points on a
building roof or a bridge. All vertices of the shape are set to the same elevation value derived
from laser points.

Valid CAD element types include shapes, complex shapes, and ellipses. You can fit several
selected elements in a single process.

To set the elevation of a closed element:

1. (Optional) Select elements for which you want to set the elevation.

2. Select the Set Polygon Elevation tool.

This opens the Set Polygon Elevation dialog:

3. Define settings.

4. If elements have been selected, start the process with a data click inside the CAD file view.
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This computes an elevation value from laser points for each selected element and adjusts all
selected elements.

OR

4. Identify the element to adjust with a data click.

This highlights the element.

5. Accept the highlighted element with a data click inside the CAD file view.

This computes an elevation value from laser points and adjusts the element. You can
continue with steps 3 or 4.

SETTING EFFECT

Class Point class from which to derive the elevation.
Only points inside the shape element are
used.

Elevation Method of elevation computation:

· Percentile - elevations from the given
Percentile value of points. The scale shows
which percentile of points is used: Lowest,
Median, or Highest points, and can be used
to set the percentile value with a data click.

· Average - average of all laser point
elevation values inside the shape.

Turn clockwise If on, the drawing direction of the adjusted
shape is forced to run clockwise.

Adjust to orthogonal If on, the corner angles of the adjusted shape
are fixed to 90 degree turns if the angles of
the original element are within the Tolerance
value off from 90 degrees.

Create copy If on, a new element is created and adjusted
using the active level and symbology settings
of the CAD file.

If off, the original element is modified.
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Vectorize Tunnel Sections
Not UAV

Vectorize Tunnel Sections tool draws tunnel cross sections into the CAD file. The sections are
drawn as line string elements which are fitted to the cross section provided by the point cloud.
The tool requires a 3D linear element that runs along the approximate center of the tunnel. The
tool does not try to create closed line strings for the sections.

Optionally, the tool draws additional line elements as markers for the section location. These
horizontal marker lines are drawn at the alignment element elevation and extended up to the
length of the given offset from alignment setting. The line may be useful for creating a vertical
section at a tunnel cross section location.

Before vectorizing tunnel sections, it may be useful the classify the points on the tunnel floor,
roof and walls by using the Tunnel surfaces classification routine.

The Check Tunnel Sections tool may be used to check and modify the tunnel sections in an
organized and automated way.

To vectorize tunnel sections:

1. Select the 3D alignment element.

2. Select the Vectorize Tunnel Sections tool.

This opens the Vectorize Tunnel Sections dialog:
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3. Define settings and click OK.

This draws the sections and possibly the location markers into the CAD file. The sections are
created as line string elements and drawn on the active level with the active symbology
settings of the CAD file.

SETTING EFFECT

From class Point class(es) that are considered for the
section line fitting.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Within offset Maximum distance of points from the
alignment element that are considered for
the section line fitting. Determines also
the length of the section marker lines left
and right from the alignment.

Within depth Depth of a tunnel cross section within
which points are used for the  section line
fitting.
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SETTING EFFECT

Section step Distance between consecutive sections.

First station Location of the first cross section along the
alignment element.

Last station Location of the last cross section along the
alignment element. By default, the
software suggests the last possible
location at the end of the alignment
element.

Density Minimum length of a line segment along
the cross section line string. Determines
the complexity of the cross section line
string element.

Max gap Maximum length of a gap in the point
cloud cross section that is ignored for the
section drawing. A larger gap breaks the
section line string element.

Draw section markers If on, an additional line element is drawn
in the CAD file at the location of the cross
section.

Level CAD file level on which the section marker
lines are drawn. This is only active if Draw
section markers is switched on.

Color Color used for drawing the section marker
lines. Uses the active color table of the
CAD file. This is only active if Draw section
markers is switched on.
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General toolbox

The tools in the General toolbox are used to define user settings, to define point classes, to
define project blocks, to manage trajectories, to load points and to access license information
and the users’ guide document.

 

 

TO USE TOOL

Change user settings Settings

Define coordinate range and resolution Define Coordinate Setup

Define point classes and drawing
symbology

Define Classes

Design project block boundaries Design Block Boundaries Not UAV

Define project and data blocks Define Project Not UAV

Manage trajectory information Manage Trajectories

Load points from airborne / mobile
scanning

Load Airborne Points

Load points from static terrestrial scanning Load Ground Points

Show about TerraScan and license
information

About TerraScan

Open online help Help on TerraScan

About TerraScan

About TerraScan tool opens a dialog which shows information about TerraScan and about the
license.

From this dialog, you can open the License information dialog which looks the same for all Terra
Applications:
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Use the Request license button to start the online registration for node-locked licenses.

More information about license registration is available on the Terrasolid web pages.

Define Classes

Define Classes tool opens a dialog for managing point classes and related drawing rules.

A point class definition includes descriptive information for the class, such as a unique number,
code, and description, and rules for displaying the point on the screen or drawing it into the
CAD file.

TerraScan provides a default class definition file TSCAN.PTC which is stored in the TerraScan
installation folder. You can Add, Edit, and Delete point classes by using the corresponding
buttons in the Point classes dialog.

You can create a New empty class definition file, Open an existing file, Save changes to an
existing file, and Save class definitions as a new file by using the corresponding commands
from the File pulldown menu of the Point classes dialog. The class definitions are saved into
files with the default extension .PTC. Usually, there are different class definition files for
different project types. If TerraScan is loaded, the last-used class definition file is still active.

To add a new class to the active class list:

1. Select the Define Classes tool.

The Point classes dialog opens:
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The dialog contains a list of all point classes in the active class list.

2. Click the Add button.

The Point class dialog box opens:

3. Define settings and click OK.

The class is added to the active class list.

4. Select Save or Save as from the File pulldown menu in order to save the class definitions into
a file.

SETTING EFFECT

Number Unique number of the point class.
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SETTING EFFECT

Code Code of the point class. The code is a text
string which can include any kind of
characters.

Description Descriptive name of the class.

Synthetic If on, the classification bit for synthetic points
is set in LAS 1.4 files.

Keypoint If on, the classification bit for model keypoints
is set in LAS 1.4 files.

Withheld If on, the classification bit for withheld
(deleted) points is set in LAS 1.4 files.

Overlap If on, the classification bit for overlap points is
set in LAS 1.4 files.

Draw as Determines how points of a class are
displayed in rendered views:

· Not set - points are drawn normally.

· Thin object - points are drawn in a thin-
object way in rendered views.

· Surface - points are drawn in a surface-like
way in rendered views.

Color Color for displaying points of the class. Uses
the active color table of the CAD file.

Weight Size for displaying points of the class. Uses the
CAD file line weights.

Element Element type used for drawing points of the
class permanently into the CAD file.

Level Level on which point of the class are drawn
permanently into the CAD file.

Character Character used for drawing points
permanently into the CAD file. This is only
active if Element is set to Character.

Font Font type used for drawing points
permanently into the CAD file. Uses the CAD
file font types. This is only active if Element is
set to Character or Elevation text.

Size Size of the text used for drawing points
permanently into the CAD file. This is only
active if Element is set to Character or
Elevation text.

Justify Justification of the text relative to the original
point. Uses the CAD file justification options
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SETTING EFFECT

for text elements. This is only active if
Element is set to Elevation text.

Dx Offset in X direction between the original
point and the origin point of the text element.
This is only active if Element is set to Elevation
text.

Dy Offset in Y direction between the original
point and the origin point of the text element.
This is only active if Element is set to Elevation
text.

Diameter Diameter of a circle used for drawing points
permanently into the CAD file. This is only
active if Element is set to Circle.

Style Style of the outline of a circle for drawing
points permanently into the CAD file. Uses the
CAD file line styles. This is only active if
Element is set to Circle.

Since point class definitions are stored in a text file format, you can edit the file in a text
editor as well. This may be useful if you need to copy classes and drawing rules from one
class list to another.

Define Coordinate Setup

Define Coordinate Setup tool sets up coordinate system values that a Terra Application uses for
laser points and images. It determines the coordinate range inside which all data must be
located and the resolution to which coordinate values are rounded. The coordinate setup is
stored into the active CAD file and is used by all Terra Applications.

Terra Applications use signed 32 bit integer values for storing coordinates of laser points and
images. This has the advantage of using only 12 bytes of memory for the coordinate information
of each point. You can control how accurately coordinate values are stored by defining how big
each integer step is.

If, for example, one integer step is equal to one millimeter, all coordinate values are rounded
to the closest millimeter. At the same time it would impose a limitation on how far apart points
can be or how big the coordinate ranges are. Millimeter steps produce a coordinate cube which

has a size of 232 millimeters or 4294967.296 meters. If the origin of the coordinate system is at
[0.0, 0.0, 0.0], the coordinate ranges are limited to values between -2147483 and +2147483. If
necessary, you can fit the coordinate ranges to your data by modifying the Easting and Northing
coordinates of the coordinate system origin.

If one integer step is equal to one centimeter, the coordinate values can range from -21 million
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to +21 million which is large enough for most coordinate systems.

To define the coordinate setup:

1. Select the Define Coordinate Setup tool.

This opens the Define Coordinate Setup dialog:

2. Define settings and click OK.

This modifies the coordinate system values used by all Terra Applications in the active CAD
file.

Define Project
Not UAV

Define Project tool opens the TerraScan Project window. The window displays the active
project and contains menu commands for handling TerraScan projects.

The main benefits of organizing point cloud data in a project are:

· The project definition divides a large data set into smaller parts which are easy to manage.
Each part should contain an amount of points that can be loaded into memory and still allow
processing of the points.

· When points are imported into a project, the application automatically divides the large
point cloud into geographical regions (called ‘blocks’ in TerraScan’s terminology). This is
required because raw laser data is often provided in line order while some classification
routines and other processing steps rely on geographical regions.

· You can run macros that process the data of all or selected blocks of a project. You can also
start other processing routines from the Project window. This is essential for the automated
processing of large point cloud data sets.
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· TerraScan projects can be directly used in TerraStereo, Terrasolid’s software for advanced
visualization of huge point clouds in mono and stereo mode.

To view the active project:

1. Select the Define Project tool.

The Project window opens:

If there is an active project in TerraScan, the title bar of the window displays the name of the
project. Further, the window shows the list of blocks that belong to the project. For each block,
the name and the amount of points in the file are displayed.

The menu commands of the Project window are described in detail in Chapter Working with
Projects.

Design Block Boundaries
Not UAV

Design Block Boundaries tool creates shape elements that can be used as block boundaries for a
TerraScan project. The block boundary creation can start from line or shape elements. If points
are loaded in TerraScan, the tool can also compute the amount of points inside each block
boundary. Otherwise, the size of the area covered by a block can be used as support for block
design.

The line elements used as starting elements for the tool should cross each other in order to
create a closed line work for the shape creation. If shape elements are used as starting
elements, the tool does not create new shapes. It only computes the amount of points inside or
the size of the area covered by the existing shapes.

The tool may also draw labels for the block boundaries that either indicate the amount of
points or the size of the area per block. The color of the label indicates whether the amount of
points or the size of the area are within a given range. The point count is given in values
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rounded to million points. The size of the area can be shown using different units and decimal
resolutions.

The tool supports significantly the creation of block boundaries for TerraScan projects,
especially if the point density is varying in the project area. This is often the case in mobile
mapping projects if the driving speed is not constant.

To design block boundaries:

1. (Optional) Load points from the whole project area into TerraScan using Read points
command or Load Airborne Points tool. Load only a subset of points if the project area is too
big to load all points.

2. Use CAD tools or TerraScan tools to digitize line elements around your project area and to
separate the project area into smaller parts.

3. Select the Design Block Boundaries tool.

This opens the Design Block Boundaries dialog:

4. Define settings and click OK.

This creates shapes on the given Shape level. If points are loaded in TerraScan, the tool
creates text elements on the given Label level.

5. If the amount of points per block is not within the given limits, modify the line work. Run the
Design Block Boundaries tool again in order to update the shapes and labels. Continue until
the point counts are within the limits.

6. Continue with the Define Project tool in order to add the shapes as block boundaries to a
project.
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SETTING EFFECT

Start from Elements that are used to create block
boundaries:

· Bounding line work - line elements that
form closed areas.

· Shapes already drawn - already existing
shape elements.

Line level CAD file level on which the line elements are
drawn. This is only active if Start from is set to
Bounding line work.

Shape level CAD file level on which the shape elements
are drawn. The shapes are created if Start
from is set to Bounding line work.

Label Defines what is shown with the label for block
boundaries:

· None - no label is created.

· Polygon area - size of the area covered by a
block.

· Point count - amount of points falling inside
the block area. This requires points loaded
in TerraScan.

Label level CAD file level on which text elements are
drawn. The texts show the amount of points
inside a shape area if points are loaded in
TerraScan.

Unit Unit for expressing the size of the block area:
Square meter, Hectare or Square kilometer.
This is only active if Label is set to Polygon
area.

Decimals Resolution for expressing the size of the block
area. Up to 3 decimals can be displayed. This is
only active if Label is set to Polygon area.

Minimum area Minimum size of a block area. This is only
active if Label is set to Polygon area.

Maximum area Maximum size of a block area. This is only
active if Label is set to Polygon area.

Load every Indicates the subset of points that is loaded
into TerraScan. This is only active if Label is set
to Point count.

Minimum count Minimum amount of points accepted in one
project block. Rounded to million points. This
is only active if Label is set to Point count.
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SETTING EFFECT

Maximum count Maximum amount of points accepted in one
project block. Rounded to million points.This
is only active if Label is set to Point count.

Good count Display color of a label for shape areas, where
the amount of points is within the given
Minimum and Maximum count values. Uses
the active color table of the CAD file.

Bad count Display color of a label for shape areas, where
the amount of points is outside the given
Minimum and Maximum count values. Uses
the active color table of the CAD file.

Help on TerraScan

Help on TerraScan  tool opens the online help in the standard web browser.

Load Airborne Points

Load Airborne Points tool performs exactly the same action as the Read points command in the
File pulldown menu of the TerraScan window.

Load Ground Points

Load Ground Points tool is used to load laser points from a static ground-based scanner into
TerraScan. The tool works in the same way as the Load Airborne Points tool and the Read points
command.

The important difference is that the Measurement pulldown menu replaces the Line pulldown
menu in the TerraScan window. The pulldown menu contains commands tailored for processing
data of static ground-based laser scanners.

Manage Trajectories

Manage Trajectories tool opens the TerraScan Trajectories window. The window displays the
active trajectories and contains menu commands for handling trajectory information in
TerraScan.

Trajectory information is required by the following processing steps:

· Cut overlap command for identifying points from overlapping lines.
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· Adjust laser angles command for applying heading, roll, and pitch corrections to laser data.

· TerraMatch tools for fixing mismatch in laser data.

To view information about active trajectories:

1. Select the Manage Trajectories tool.

This opens the Trajectories window:

If there are active trajectories in TerraScan, the title bar of the window displays the active
trajectory folder. Further, the window shows the list of trajectory files that are stored in the
active trajectory folder.

The menu commands of the Trajectory window are described in detail in Chapter Manage
Trajectories.
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Scan Settings

Scan Settings tool lets you change a number of settings that control the way how TerraScan
works. Selecting this tool opens the TerraScan settings dialog:

The settings are grouped into logical categories. Selecting a category in the list displays the
appropriate controls next to the category list.

The different categories and related settings are described in detail in Section TerraScan
Settings.



TerraScan User Guide  © 2023 Terrasolid Ltd

236TerraScan Toolbox > Groups toolbox >  

Groups toolbox

Tools in the Groups toolbox are used to manipulate point groups manually. The tools require
that points have been assigned to groups using the Assign groups command for loaded points or
the Assign groups macro action.

 

 

TO USE TOOL

Create a new point group Create Point Group

Merge two point groups into one group Merge Point Groups

Add points to an existing group Add Points To Group

Remove a group assignment from points
inside a fence

Clear Group Fence

Add Points To Group

Add Points To Group tool adds points to an existing group. Points to be added are determined
by a fence and optionally also specified by class.

To add points to a group:

1. Select Add Points To Group tool.

This opens the Add Points To Group dialog:

2. Define settings.

3. Select the target group with a data click inside or close to the group.

4. Draw a fence around the points to add to the group by placing data clicks inside a few. The
last data click must close the fence.
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5. Confirm the fence contents with another data click inside the few.

This adds the points inside the fence to the target group.

SETTING EFFECT

From class Point class(es) added to the target group.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Use points Determines which points are added to the
target group:

· Any - all points inside the fence.

· One group - points of the one group from
which the highest amount of the points is
inside the fence.

· Non-grouped - points without a group
assignment.

In MicroStation, a fence can be drawn before the tool is started using the Place fence tool.
Then, the fence element defines the fence area for the tool.

Clear Group Fence

Clear Group Fence tool clears the group assignment from points inside a fence.

To clear groups:

1. Select Clear Group Fence tool.

This opens the Clear Group Fence dialog:

2. Define settings.

3. Draw a fence around the points to add to the group by placing data clicks inside a few. The
last data click must close the fence.

4. Confirm the fence contents with another data click inside the few.

This removes the group assignment from points inside the fence.
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SETTING EFFECT

Class Point class(es) added to the target group.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Points Determines from which points the group is
cleared:

· All - all points inside the fence.

· Dominant group - points of the one group
from which the highest amount of the
points is inside the fence.

In MicroStation, a fence can be drawn before the tool is started using the Place fence tool.
Then, the fence element defines the fence area for the tool.

Create Point Group

Create Point Group tool assigns points to a group. The assignment can be done using two
alternative methods:

· Inside fence - points inside a fence are assigned to one group.

· Tree tip point - the process starts from a user-defined tree tip point and assigns all points
belonging to the same tree to one group.

The fence is drawn manually after starting the tool and defining the settings. The fence can be
drawn in a top view or a section view.

The tool expects that a distance from ground value is computed for the points in the source
class for grouping. The value can be computed by using the Compute distance command for
loaded points or the Compute distance macro action.

It is recommended to use the tool only for cases where the automatic group assignment failed.
Points can be automatically assigned to groups by using the Assign groups command or Assign
groups macro action.

To create a new point group:

1. Select the Create Point Group tool.

This opens the Create Point Group dialog:
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2. Define settings.

3. If Create using is set to Tree tip point, identify the top of a tree with a data click.

This assigns all points found for the tree to a group

OR

3. If Create using is set to Inside fence, draw the fence around points that you want to be
assigned to one group. Close the fence by placing the last data click close to the first vertex
of the fence. Confirm the fence with another data click.

This assigns all points inside the fence to a group.

SETTING EFFECT

From class Point class(es) from which points are
assigned to a group.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Create using Method used for group assignment:

· Inside fence - points inside a fence are
assigned to a group.

· Tree tip point - a watershed algorithm is
applied in order to assign points
belonging to one tree to a group.

Use points Determines which points create the new
group:

· Any - any point in the given source
class(es).

· Current group - points that are already
assigned to a group.

· Non-grouped - points that are not
assigned to any group.

In MicroStation, a fence can be drawn before the tool is started using the Place fence tool.
Then, the fence element defines the points that are add to a group and you only need to
confirm the fence with a data click.
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Merge Point Groups

Merge Point Groups tool can be used to manually merge two point groups into one group.
Before using the tool, points must be assigned to groups by using the Assign groups command
or Assign groups macro action.

To merge two point groups:

1. Select the Merge Point Groups tool.

2. Identify the first group with a data click. This group determines the number of the merged
group.

3. Identify the second group with another data click.

This merges the two groups.
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Model toolbox

The tools in the Model toolbox are used to create an editable surface model, to classify laser
points manually, to fix the elevation of points, and to update the surface model.

The tools for manual point classification effect points loaded in TerraScan memory. You have to
save the points in order to store changes permanently into point files.

 

 

TO USE TOOL

To create an editable triangulated model Create Editable Model

Assign class to a laser point Assign Point Class

Classify points using a brush Classify Using Brush

Classify points inside fence Classify Fence

Classify points above line in section view Classify Above Line

Classify points below line in section view Classify Below Line

Classify points close to line in section view Classify Close To Line

Add a synthetic point using mouse click Add Synthetic Point

Classify vegetation points out of ground Remove Vegetation

Set elevation of points inside polygon(s) Fix elevation

Rebuild model after classification Rebuild Model

Create Editable Model and Rebuild Model tools require TerraModeler to run.
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Add Synthetic Point

Add Synthetic Point tool adds synthetic points to a point data set loaded in TerraScan. It may be
used to create single points, points along selected vector elements or inside selected polygons.

If a single point is added in a top view, its xy location is determined by the data click position
and its elevation is fixed to the active Z setting in the CAD file. If a point is added in a section
view, its xy location is fixed to the center of the section and its elevation is set by the data click
position.

Points along a vector element are created at the exact 3D position of the element and with a
given spacing between the points.

Points inside a polygon are created as grid with a given horizontal point distance. The elevation
can be determined in different ways, such as a key-in value, the mouse pointer position,
derived from other point classes or from the polygon elevation.

To add synthetic points:

1. Select vector elements or polygons if you want to add points along or inside them. 

2. Select the Add Synthetic Point tool.

The Add Synthetic Point dialog opens:

3. Define settings.

4. Place a single synthetic point with a data click in a view.

This adds a new point to the loaded point data set. You can continue with step 2 if you want
to change settings, or with step 3.

OR

4. Confirm selected vector elements or polygons with a data click inside the CAD view. If
Elevation is set to From mouse click, place a data click inside a section view in order to
determine the elevation value for the new points.

This adds the new points to the loaded point data set.
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5. Use Save points or Save points As commands in order to save added points permanently into
a laser point file.

SETTING EFFECT

Class Target class into which synthetic points are
added. The list contains the active classes in
TerraScan.

Line Line number assigned to synthetic points.

Add Method of adding new points:

· Single point - a single point is added by a
data click.

· Along selected vectors - points are added
along selected vector elements.

· Inside selected polygons - points are added
inside selected polygons.

Spacing Distance between new points along an
element or inside a polygon. This is only
active if Add is set to Along selected vectors or
Inside selected polygons.

Elevation Method of how the elevation of new points
inside a polygon is computed:

· From existing points - points in given
Existing class(es) are used. The >> button
opens the Select Classes dialog which lets
you select several classes.

· From polygons - the average elevation of a
polygon is used for the points falling inside
the polygon.

· From mouse click - a data click in a section
view determines the elevation of the new
points.

· As keyin value - the given Keyin Z value is
used.

This is only active if Add is set to Inside
selected polygons.

Assign Point Class

Assign Point Class tool classifies a single laser point or points that belong to a group of points. It
classifies either the closest point to the data click, or the highest or lowest point within a
circular search area. For group classification, the point selection method determines which
group is classified.
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Classifying points of a group requires the assignment of group numbers to laser points. This can
be done by using the Assign groups command for loaded points or the corresponding macro
action for macro processing of project blocks.

The tool works in top views as well as in section views or any rotated views.

To classify  a single point or a group of points:

1. Select the Assign Point Class tool.

The Assign Point Class dialog opens:

2. Define settings.

3. Move the mouse pointer inside a view.

In a top view, the search area is shown at the mouse pointer position.

4. Identify the single point or the group of points with a data click.

This classifies the identified point or point group. You can continue with step 2 if you want to
change settings, or with step 3.

5. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

From Source class; only points from this class are
effected. The list contains the active classes
in TerraScan. Alternatively, Any visible
point can be classified.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Classify Defines which points are classified: Single
point or Whole group. Whole group is only
active if group numbers are assigned to
laser points.
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SETTING EFFECT

Select Method how the software selects a point or
group for classification:

· Closest - the point closest to the data click
is classified.

· Highest - the highest point within the
search area is classified.

· Lowest - the lowest point within the
search area is classified.

Within Radius of the search area. Given in master
units of the CAD file.

To class Target class into which points are classified.
The list contains the active classes in
TerraScan.

Switches From and To class classes. If From
class is set to multiple classes or Any visible
point, To class is switched to the source
class with the lowest class number.

Classify Above Line

Classify Above Line tool classifies points above a line drawn in a cross section view. The
classification effects only points that are inside the extend and display depth of the cross
section view.

The tool works in section views. The user can define settings for the temporary display of the
help lines for the tool.

To classify  points above a line:

1. Select the Classify Above Line tool.

The Classify Above Line dialog opens:

2. Define settings.

3. Draw a line by placing data clicks in a section view. The line and the area effected by the
classification are temporarily displayed after placing the start point.
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This classifies points which are above the line, between the line’s start and end point, and
within the section view extend and depth. You can continue with step 2 if you want to
change settings, or with step 3.

4. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

From class Source class(es); only points from selected
class(es) are effected. The list contains the
active classes in TerraScan. Alternatively,
points from multiple classes or Any visible
point can be classified.

To class Target class into which points are
classified. The list contains the active
classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Switches From and To class classes. If From
class is set to multiple classes or Any
visible point, To class is switched to the
source class with the lowest class number.

Classify Below Line

Classify Below Line tool classifies points below a line drawn in a cross section view. The
classification effects only points that are inside the extend and display depth of the cross
section view.

The tool works in section views. The user can define settings for the temporary display of the
help lines for the tool.

To classify  points below a line:

1. Select the Classify Below Line tool.

The Classify Below Line dialog opens:
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2. Define settings.

3. Draw a line by placing data clicks in a section view. The line and the area effected by the
classification are temporarily displayed after placing the start point.

This classifies points which are below the line, between the line’s start and end point, and
within the section view extend and depth. You can continue with step 2 if you want to
change settings, or with step 3.

4. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

From class Source class(es); only points from selected
class(es) are effected. The list contains the
active classes in TerraScan. Alternatively,
points from multiple classes or Any visible
point can be classified.

To class Target class into which points are
classified. The list contains the active
classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Switches From and To class classes. If From
class is set to multiple classes or Any
visible point, To class is switched to the
source class with the lowest class number.

Classify Close To Line

Classify Close To line tool classifies points that are close to a given line in a cross section view. It
can combine up to three classification steps, above, close, and below a line. The classification
effects only points that are inside the extend and display depth of the cross section view.

The tool works in section views. The user can define settings for the temporary display of the
help lines for the tool.

To classify  points close to lines:

1. Select the Classify Close To Line tool.

The Classify Close To Line dialog opens:
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2. Define settings.

3. Draw a line by placing data clicks in a section view. The line and the area effected by the
classification are temporarily displayed after placing the start point.

This classifies points which are above the line, below the line, and/or close to the line,
between the lines’ start and end point, and within the section view extend and depth. You
can continue with step 2 if you want to change settings, or with step 3.

4. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

Above If on, above line classification is applied.
Source and target classes are selected in the
From and To lists of active classes.
Alternatively, Any visible point can be
selected in the From list.

Close If on, close to line classification is applied.
Source and target classes are selected in the
From and To lists of active classes.
Alternatively, Any visible point can be
selected in the From list.

Below If on, below line classification is applied.
Source and target classes are selected in the
From and To lists of active classes.
Alternatively, Any visible point can be
selected in the From list.

Tolerance above Distance from the drawn line to the line that
defines the above line classification limit.
Together with the Tolerance below value,
this defines the area of close to line
classification.

Tolerance below Distance from the drawn line to the line that
defines the below line classification limit.
Together with the Tolerance above value,
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SETTING EFFECT

this defines the area of close to line
classification.

Classify Fence

Classify Fence tool classifies points inside a fence area.

In MicroStation, the fence area can be defined by drawing a fence element before starting the
tool.

The tool works in top views as well as in section views. The user can define settings for the
temporary display of the help lines for the tool.

To classify  points inside a fence:

1. Select the Classify Fence tool.

The Classify Fence dialog opens:

2. Define settings.

3. If a fence has been drawn, accept the fence contents with a data click inside the view.

This classifies the points inside the fence.

OR

3. Digitize a fence around the points you want to classify by placing data clicks inside a view.
The fence is closed if you place a data click close to the first vertex of the fence.

4. Accept the fence contents with a data click.

This classifies the points inside the fence. You can continue with step 3 if you want to change
settings, or with step 4 if you digitize the fence with this tool.

5. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

From class Source class(es); only points from selected
class(es) are effected. The list contains the
active classes in TerraScan. Alternatively,
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SETTING EFFECT

points from multiple classes or Any visible
point can be classified.

To class Target class into which points are
classified. The list contains the active
classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Switches From and To class classes. If From
is set to multiple classes or Any visible
point, To class is switched to the source
class with the lowest class number.

Classify Using Brush

Classify Using Brush tool classifies points inside a circular or rectangular brush that is moved in a
CAD file view. All points that are touched by the brush are classified. The display of effect
points changes dynamically while the tool is used.

The tool can be utilized with two different kinds of mouse action. You can use it with two
separate data clicks and mouse pointer movement in between, or you can keep the data button
pressed down while moving the mouse pointer. A circle or rectangle around the mouse pointer
indicates the brush of the given size. The brush shape is displayed brighter when the tool is
active.

The tool works in top views as well as in section views.

To classify  points inside a brush using two mouse clicks:

1. Select the Classify Using Brush tool.

The Classify Using Brush dialog opens:

2. Define settings.
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3. Place a data click to start the classification.

OR

3. Press the data button down to start the classification.

This classifies points inside the brush area.

4. Move the mouse pointer to classify additional points.

5. Place another data click to stop the classification.

OR

5. Release the data button to stop the classification.

This classifies all points touched by the mouse pointer. You can continue with step 2 if you
want to change settings, or with step 3.

6. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

From Source class; only points from this class are
effected. The list contains the active
classes in TerraScan. Alternatively, Any
visible point can be classified.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From field.

Brush shape Shape of the brush: Circle or Rectangle.

Brush size Size of the brush. Given in pixels on the
screen.

To class Target class into which points are
classified. The list contains the active
classes in TerraScan.

Switches From and To class classes. If From
is set to Any visible point, To class is
switched to the source class with the
lowest class number.
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Create Editable Model

Create Editable Model tool creates a surface model from loaded laser points which can be
visualized in TerraModeler. The tool starts TerraModeler automatically if the application is not
yet running.

The surface model is actively linked to the loaded laser points, which means that all surface
model displays are updated immediately to reflect any change in point classification. The active
surface model display is particularly useful for validating ground classification. The best display
method for this purpose is a shaded surface drawn by the Display Shaded Surface tool in
TerraModeler’s Display Surface toolbox.

To create an editable model and display  a shaded surface:

1. Load laser data into TerraScan.

2. Select the Create Editable Model tool.

This opens the Create editable model dialog:

3. Select class(es) which you want to include in the surface model.

4. (Optional) Switch on Scale elevations and type a factor by which you want to scale the
elevations. A factor > 1.0 results in a model with exaggerated elevation values.

5. Click OK.

This opens the Surface settings dialog in TerraModeler.

6. Enter a descriptive name for the new surface, define other settings if required, and click OK.

TerraModeler creates the surface model.

https://terrasolid.com/guides/tmodel/displayshadedsurface.html
https://terrasolid.com/guides/tmodel/tbox_displaysurface.html
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7. Select the Display Shaded Surface tool in TerraModeler’s Display Surface toolbox.

8. Define display settings and click OK.

This displays the shaded surface using the elevation values of the laser points and given
lightning conditions.

If TerraModeler is not available, you can use the Color by Shading display method of
TerraScan to display a shaded surface visualization of the laser points based on class coloring.

Fix elevation

Fix Elevation tool fixes elevation values of points to a constant value. The tool processes data
inside limited areas that can be defined by selected polygons, polygons on a given CAD file
level, or a fence (MicroStation).

This tool may be useful, for example, to get a smooth surface from points on water.

To fix elevations of points:

1. Use CAD platform tools to draw polygons or a fence (MicroStation only) around the area(s) for
processing. Select polygons, if required.

2. Select the Fix Elevation tool.

The Fix Elevation dialog opens:

3. Define settings and click OK.

This sets the elevation values of the laser points in the selected class(es) and inside the
processing area to a constant elevation value.

https://terrasolid.com/guides/tmodel/displayshadedsurface.html
https://terrasolid.com/guides/tmodel/tbox_displaysurface.html
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4. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.

SETTING EFFECT

Class Source class(es); only points from selected
class(es) are effected. The list contains the
active classes in TerraScan. Alternatively,
points from multiple classes or Any class can
be selected.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Elevation Method of calculating the constant
elevation value:

· From points - elevation derived from the
given Percentile value of points. The scale
shows which percentile of points is used:
Lowest, Median, or Highest points, and
can be used to set the percentile value
with a data click.

· Keyin value - absolute elevation value
given in the Value field.

Process inside Determines the processing area:
· Fence - points inside a fence are effected.

(MicroStation only)

· Selected polygons - points inside selected
polygons are effected.

· Polygons by level - points inside polygons
drawn on the given CAD file Level are
effected. The polygons can be further
specified by selecting By color, By weight,
and/or By style options. The selection
lists use the active color table, line
weights and line styles of the CAD file.

Rebuild Model

Rebuild Model tool runs a complete update of an editable surface model. It effects the surface
model that has been created by the Create Editable Model tool. The process re-creates the TIN
structure from all points in the model class(es) and updates all active displays of the surface
model.
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You should use this tool if you classify points to/from the surface model class(es) using tools
other than those in the Model toolbox or if the automatic update of the editable surface model
does not work correctly.

To rebuild a model:

1. Select the Rebuild Model tool.

If an editable model is available, the re-building process starts. A progress bar shows the
progress of the process.

If no editable model is available, an information dialog is shown.

Remove Vegetation

Remove Vegetation tool removes points in vegetation from points classified as ground. It works
within a limited area defined by a selected polygon or MicroStation fence.

The can be used, for example, to smooth the ground surface after automatic ground
classification.

To remove vegetation from ground points:

1. Use CAD tools to draw a polygon or fence (MicroStation only) around the area for processing.
Select the polygon.

2. Select the Remove Vegetation tool.

The Remove Vegetation dialog opens:

3. Define settings.

4. Click on the Test button to see the result of the settings in a preview.

5. Click OK to apply the classification.

This classifies the points from the ground class to the target class.

6. Use Save points or Save points As commands in order to save changes to point classes
permanently into a laser point file.
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SETTING EFFECT

From ground Source class, usually a ground class; only
points from the selected class is effected.
The list contains the active classes in
TerraScan.

To class Target class into which points are classified.
The list contains the active classes in
TerraScan.

Only visible points If on, only points that are visible in the
marked processing area are effected.
If off, all points in the marked processing
area are effected, even if their display is
switched off.

Limit Distance up to which points above a surface
defined by the lowest ground points are
classified. Given in the master unit of the
CAD file. The amount of effected points is
shown next to the input field.
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Powerlines

TerraScan has a number of tools which are dedicated to powerline processing. These include
classification, vectorization, and reporting tools.

Tools for powerline processing are divided into three parts:

· Vectorize Wires toolbox - tools for automatic detection and manual placement of wires,
check and correction of wire attachments as well as assigning wire attributes.

· Vectorize Towers toolbox - tools for manual placement of tower models, manipulation of
towers, cross arms, and attachments.

· View Powerline toolbox - tools for labeling towers, finding danger objects, and creating
reports.

A general strategy for processing powerline data can be outlined as follows. The final workflow
depends on the project requirements.

1. Classify the point cloud in a way that points on powerline structures (towers, wires) stand
out. This may involve classification of points

· on the ground using the Ground routine

· above the ground using the By distance routine

· relative to the centerline of the powerline using the By centerline routine

· with echo type “first of many” using the By echo routine

2. Create a tower string using the Place Tower String tool or the Draw as line strings
command.

3. Detect wires automatically using the Detect Wires tool.

4. Manually place wires using the Place Catenary String tool in places where the automatic
detection does not work.

5. Validate and adjust catenary attachment points using the Check Catenary Attachments
tool.

6. Assign wire attributes using the Assign Wire Attributes tool.

7. Define tower models in the Powerlines / Tower types category of TerraScan Settings.

8. Manually place towers using the Place Tower tool.

9. Create labels with the help of labeling tools in the View Powerline toolbox.

10. Detect and analyze danger objects close to the powerline using the Find Danger Objects
tool or the Wire danger points macro action.

11. Create output reports with tools in the View Powerline toolbox.
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Vectorize Wires toolbox

The tools in the Vectorize Wires toolbox are used to place a powerline centerline, to detect
wires automatically, to manually place wire strings, to validate wire attachment points and to
assign attributes to wires.

 

 

TO USE TOOL

Detect continuous wires in the point cloud
data

Find Powerline Wires Not Lite

Place a line string from tower to tower Place Tower String Not Lite

Activate a powerline for viewing and
modification

Activate Powerline Not Lite

Detect wires along active powerline Detect Wires Not Lite

Digitize a wire line string Place Wire String Not Lite

Check wire attachment points at tower
locations

Check Wire Attachments Not Lite

Assign number and description to wire Assign Wire Attributes Not Lite

Activate Powerline

Activate Powerline tool activates a tower string element for further processing steps.

Most of the powerline processing tools, such as detection of wires, check of catenary
attachments, placement of towers as well as labeling and report tools, are applied based on the
activated tower string.

To activate a powerline:

1. Select the Activate Powerline tool.

2. Click on the tower string element that you want to activate.

OR
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1. Select the tower string element you want to activate.

2. Select the Activate Powerline tool.

This activates the selected tower string. The tower string is displayed as defined in the
Powerlines / Active line category of TerraScan Settings. An information dialog shows the
number of the activated powerline.

To deactivate a powerline:

1. Select the Activate Powerline tool.

This deactivates any activated tower string element. You can continue with activating
another tower string element or with selecting any other tool.

Assign Wire Attributes
Not Lite

Assign Wire Attributes tool lets you define attributes for wire strings. You can also change the
symbology of the line elements. Changes can be applied for the wire along the whole tower
string, within a certain span range, or for a single wire string from one tower to another. The
attributes can be included in reports created with the Output Catenary tool.

To assign attributes to catenary  strings:

1. Activate a tower string element using Activate Powerline tool.

2. Select the Assign Wire Attributes tool.

This opens the Assign Wire Attributes dialog:

3. Select, for what to assign attributes: Whole chain, Span range, or Single span.

4. If Assign to is set to Span range, select the start tower and the end tower of the span range
with data clicks.

5. Select a wire string for which to assign attributes.

This highlights the selected wire string and opens another Assign Wire Attributes dialog:
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6. Define settings and click OK.

This assigns the given attributes to the wire. You can continue with steps 3 or 5.

SETTING EFFECT

Line Number of the powerline. This is filled
automatically from the activated tower
string.

System Text field for entering a free system
identifier.

Number Text field for entering a free wire number.

Description Text field for entering a free description for
the wire.

Set level If on, the selected wire is moved to the given
CAD file level.

Set symbology If on, the given Color, Weight and line Style
is applied for the selected wire. The
selection lists include the standard colors,
line weights and styles of the CAD file.
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Check Wire Attachments
Not Lite

Check Wire Attachments tool validates and adjusts end points of wire strings. At tower
locations, the incoming and the outgoing wire strings do not meet exactly because each wire
string has been computed using laser points from one tower-to-tower span only. The
magnitude of the gap between wire strings gives some indication of how accurately the wires
have been detected or placed.

Check Wire Attachments tool produces a list of all tower locations as they are defined by the
tower string. For each tower location, the size of the gaps at the wire attachment points are
computed in XY and Z. In addition, a shift of the tower positions is computed. A shift unequal to
0 indicates a horizontal shift off from the tower center in direction of the tower string
(longitudinal shift). In this case, all incoming wire strings are lower or higher than all outgoing
wire strings.

The window displaying the list contains pulldown menus with commands for fixing the gaps
automatically or manually.

To validate wire attachment points:

1. Activate a tower string element using the Activate Powerline tool.

2. Select the Check Wire Attachments tool.

This opens the Check Wire Attachments dialog:

3. Define settings and click OK.

The application searches for wire strings on the given levels and computes gaps between the
incoming and the outgoing wires. After the process finished, it opens the Wire Attachments
window.
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SETTING EFFECT

From levels CAD file level(s) from which to search
catenaries. Define a range of level numbers
by using a minus sign, separate different
level numbers by comma.

First Number of the tower at the first vertex of the
activated tower string. The numbering is only
relevant for the list in the Wire Attachments
window.

Xy Xy gap flagging limit. Gaps exceeding this
value are displayed with red color in the list.

Z Z gap flagging limit. Gaps exceeding this
value are displayed with red color in the list.

Shift Tower shift flagging limit. Shifts exceeding
this value are displayed with red color in the
list.

Wire Attachments window

The Wire Attachment window displays the list of wire attachment points for each tower
location.

The columns in the window are: tower location number, size of XY gap, size of Z gap, horizontal
shift of the tower position. The values are given in 1/100 of the master unit of the CAD file. A -
sign for the gaps indicates an open end of a wire string. This is acceptable if a wire starts or ends
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at a tower. Otherwise, it may indicate very big gaps between incoming and outgoing wire
strings.

To show the location of an attachment point, select a line in the window. Click on the Show
location button and move the mouse pointer into a view. This highlights the selected location
with a cross. Place a data click inside a view in order to center the selected location in the view.

To identify a point, click on the Identify button and place a data click close to a point in a view.
This selects the corresponding line in the list of attachment points.

It is recommended to check at least bigger gaps and fix them manually. The commands from the
Edit pulldown menu provide tools for moving and connecting wire end points in XY and/or Z.
Small gaps can be fixed automatically with commands from the All pulldown menu. In a similar
way, shifts of tower positions can be fixed. The manual work of fixing wire attachment points
can be supported by laser data loaded in TerraScan. This helps to move wire end points to
correct locations.

You can undo actions of the tools by using the Undo command of the CAD platform.

TO USE COMMAND

Shift all tower positions All / Shift all

Adjust all attachment points to the average All / Adjust all

Recompute gaps and shifts All / Update list

View statistics about gaps All / Statistics

Draw attachment markers to the CAD file All / Draw markers

Shift a single tower position Edit / Shift tower

Set two connecting wire end points to a
given xy location

Edit / Set attachment xy

Adjust a single tower position to the average Edit / Adjust attachment

Manually enter the location of a wire end
point

Edit / Move wire end

All / Shift all

Shift all command preforms the same action as the Edit / Shift tower command but for all tower
positions of the activated tower string. The command should be used if the shift values are
small and tower position are only moved within an acceptable distance.

To shift a ll towers:

1. Select Shift all command from the All pulldown menu.

This opens the Shift All Towers dialog:
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2. Define a Maximum shift distance and click OK.

This moves the vertices of the tower string representing the tower position and the wire
attachment points for all positions for which a shift correction applies. If the computed shift
of a tower position exceeds the Maximum shift value, the additional shift remains. The gap
values in the Wire Attachments window are updated automatically.

An information dialog shows the number of shifted tower positions.

All / Adjust all

Adjust all command performs the same action as the Edit / Adjust attachment command but for
all attachment points. The command should be used if the gap values are small and the
attachment points are only moved within an acceptable distance.

To adjust all attachment points:

1. Select Adjust all command from the All pulldown menu.

This opens the Adjust All Attachments dialog:

2. Define maximum values for Xy and Z gaps to be corrected and click OK.

This adjusts all attachment points for which both, the horizontal gap and the vertical gap are
within the defined limits. The end point of the incoming wire string and the start point of the
outgoing wire string are adjusted to the average XYZ position between the two. The gap
values in the Wire Attachments window are updated automatically.

All / Update list

Update list command recomputes the gap and shift values for wire strings and updates the list.
The command should be used if

· a wire string has been deleted or added.

· an action has been undone using the Undo command of the CAD platform.
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All / Statistics

Statistics command displays statistical information about wire attachment points. This includes:

· Attachments - number of wire attachment points.

· Loose ends - number of wire end points that do not have an attachment to another wire
string. This is the case at the start and end of a tower string because there are no
incoming/outgoing wire. If there are more loose ends, it indicates missing wire strings due
to problems in wire detection, or too big gaps between incoming and outgoing wire strings
at an attachment point.

· Average xy gap - average size of horizontal gaps at attachment points.

· Average z gap - average size of elevation gaps at attachment points.

· Maximum xy gap - size of the largest horizontal gap.

· Maximum z gap - size of the largest elevation gap.

The values may be helpful to decide whether manual work for fixing gaps is required or not. In
the end, when all gaps are closed, all values should be 0.

All / Draw Markers

Draw Markers command draws specified marker to catenary attachment points.

To draw all attachment markers:

1. Select Draw Markers command from the All pulldown menu.

This opens the Draw markers dialog:
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2. Define settings and click OK.

This draws specified type of marker to all catenary attachments. An information dialog shows
the number of drawn markers.

SETTING EFFECT

Marker Marker type:

· Cell - MicroStation cell element.

· Character - text characters on horizontal
plane.

· Circle - circle on horizontal plane.

Cell Name of the cell definition. Visible only if
Marker is set to Cell.

Character Characters as text input. Visible only if Marker
is set to Character.

Size Size of the markers drawn.

Radius Circle marker radius. Visible only if Marker is
set to Circle.

Edit / Shift tower

Shift tower command shifts a tower position along tower string direction (longitudinal shift). In
can be used for places where all incoming wires are higher/lower than corresponding outgoing
wires. Shifting the tower position moves all attachment points towards the previous/next
tower and thus, lowers/raises the attachment points of incoming /outgoing wires.

To shift a  single tower position:

1. Select Shift tower command from the Edit pulldown menu.

2. Move the mouse pointer inside a view.

The tower closest to the mouse pointer is highlighted by a red or green square. The square
shows the target location of the tower position shift. The color indicates whether the shift
can be performed (green) or not (red).

3. Confirm the new position with a data click.
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This moves the vertex of the tower string representing the tower position and the wire
attachment points. The gap values in the Wire Attachments window are updated
automatically.

Edit / Set attachment xy

Set attachment xy command moves a single attachment point to a given XY location. At the
same time, it moves the end/start points of the incoming and outgoing wire strings to the same
XY location. The elevation of the wire end/start points stays unaffected.

To set xy  location of an attachment point:

1. Select Set attachment xy command from the Edit pulldown menu.

2. Move the mouse pointer inside a top view.

The attachment point closest to the mouse pointer is highlighted by a green square. The
square shows the target location of the attachment point.

3. Select the attachment point with a data click.

4. Define the XY location with a data click.

This moves the wire end points to the XY position of the data click. It does not modify the
wire constants or the elevation of the wire end points. The gap values in the Wire
Attachments window are updated automatically.

You can continue with step 3.

Edit / Adjust attachment

Adjust attachment command adjust a single attachment point to the average of the incoming
and the outgoing wires’ end/start points. It effects both, the XY and Z position of the
attachment point.

To adjust a single attachment:

1. Select Adjust attachment command from the Edit pulldown menu.

2. Move the mouse pointer inside a top or section view.

The attachment point closest to the mouse pointer is highlighted by a green square. The
square shows the target location of the attachment point. The color indicates whether the
adjustment can be performed (green) or not (red).

3. Select the attachment point with a data click.

This moves the end point of the incoming wire string and the start point of the outgoing wire
string to the new location. The gap values in the Wire Attachments window are updated
automatically.

You can continue with step 3.
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Edit / Move wire end

Move wire end command lets you move a wire start/end point to a new location. The tool
should be used if one of the wires matches laser points better than the other one. You can
either move the XY position, the Z position, or both at the same time. CAD platform snapping
functionality can be used to snap start/end points to each other.

To move a wire end or start point:

1. Choose Move wire end command from the Edit pulldown menu.

This opens the Move Wire End dialog:

2. Select the position(s) you want to modify.

3. Move the mouse pointer inside a top or section view.

The wire start/end point closest to the mouse pointer is highlighted by a green square.

4. Select the start or end point with a data click.

5. Define the new location of the start/end point with another data click.

This recomputes and redraws the wire string. The gap values in the Wire Attachments
window are updated automatically.

You can continue with step 4.

Detect Wires
Not Lite

Detect Wires tool is used to vectorize wires and classify points on wires of a powerline. It draws
line string elements in the CAD file for all detected wires. The tool runs on points loaded in
TerraScan.

The tool searches points along a catenary curve. Catenary curves are mathematical descriptions
of wires that are connected at their end points but hanging free between these end points. The
process involves least squares fitting for both, the xy line equation and the elevation curve
equation of the catenary.

The most important parameter controlling wire detection is Max gap which defines the
maximum gap between consecutive laser points on a wire. It is not advisable to run the
detection on the whole data set with a large maximum gap value because the chance of false
detections increases. It is recommended to run the detection first with a relatively small
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maximum gap value which does not necessarily detect all wires. For locations with fewer points
on the wires, the detection should be done for single segments with a smaller value.

The Detect Wires tool requires a tower string element that is has been created, for example,
with the Place Tower String tool. The tower string must be activated. The line string elements
for detected wires are drawn on the active level using the active symbology settings of the CAD
file.

To detect wires:

1. Activate a tower string element using the Activate Powerline tool.

2. Select the Detect Wires tool.

This opens the Detect Wires dialog:

3. Define settings and click OK.

If Process is set to All segments, the application starts to detect wires.

4. If Process is set to Single segment, move the mouse pointer inside a top view. The segment
closest to the mouse pointer is highlighted.

5. Select the segment to process with a data click.

This starts the detection of wires for the selected segment.
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A progress window shows the progress of the process. Depending on the data set, the
process may take some time, especially if there is vegetation close to the wires.

SETTING EFFECT

From class Point class from which wires are detected.

To class Target class into which points on wires are
classified.

Process Determines where wires are detected:

· All segments - for all segments for which
data is loaded in TerraScan.

· Single segment - only for the selected
tower-to-tower segment.

Max offset Maximum distance from the tower string
element to the left/right side to detect wires.
Defines the corridor in which the software
searches for wires.

Max gap Maximum allowed gap between consecutive
points on a wire.

Max angle Maximum allowed angle between a wire and
the  tower string element.

Linear tolerance Tolerance for XY line fitting and classification
of points on a wire.

Elevation tolerance Tolerance for elevation curve fitting and
classification of points on a wire.

Require Minimum amount of laser points on a single
wire required for detection. Values can range
from 3 to 999.

Ignore points Distance from tower within which points are
ignored for wire detection. Points close to the
tower can be from tower structures and
should be ignored when determining the
mathematical shape of the wire.

Minimum Minimum catenary constant to accept a wire.

Maximum Maximum catenary constant to accept a wire.

The vectorization of the wires can be undone by using the Undo command of the CAD
platform. The classification of the wires can be undone by using the Undo command of
TerraScan.
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Find Powerline Wires
Not Lite

Find powerline wires tool is used for the automatic detection of powerline wires based on
dense point clouds (MLS data) or on point clouds with a consistent pattern of hits from wires
(ALS data). In contrast to the Detect Wires tool, this tool does not require alignment element,
but on downside may leave gaps to the result if point cloud does not have hits from wires.

The detection process starts from classified laser points and, optionally, from an alignment
element which runs in the direction of the wires. Any overlapping strips in laser point clouds
should be matched and overlap should be cut off before running the wire extraction.

Before running the tool, points should be classified into ground and above ground points. One
of the above-ground point classes should contain the points on wires (e.g. the high vegetation
class) and is then used as source class for the wire detection.

The Find Powerline Wires tool runs on points loaded in TerraScan. It classifies points on wires
into a separate class and creates line string elements that are fitted to the points on wires. The
software stops each wire at a small distance from its end points. The wire ends can be placed
more accurately by using the Check Wire Ends tool.

The tool requires points loaded into TerraScan. However, the same process can be performed
for a TerraScan project using the Find wires macro action and then, reading the wire lines from
text files using the Read / Wires command.

To detect wires:

1. Load points into TerraScan. Only points on the wires are required.

2. (Optional) Select an alignment element with any Selection tool if you want to detect wires
running parallel or perpendicular to the alignment.

3. Select the Find Powerline Wires tool.

This opens the Find Wires dialog:
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4. Define settings and click OK.

This starts the detection process. The software draws line strings wherever it is able to fit a
line to the laser data. The level, color, line weight, and line style of the lines are determined
by the active level and symbology settings of the CAD file.

SETTING EFFECT

From class Point class that contains points on the
wires. Used for fitting the lines. The list
contains the active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class into which points on detected
wires are classified.

Wires apart Distance threshold for picking neighboring
points. Should be larger than point spacing
but smaller than distance between parallel
wires.

Tolerance from wire Distance around a wire within which the
software uses points for fitting the line
element.

Min wire length Minimum length of a line element at a wire
location.

Max angle Maximum vertical angle off from horizontal
of a line element at a wire location.
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SETTING EFFECT

Find Defines what wires the software is
searching for:

· All wires - wires in all directions.

· Parallel to alignment(s) - wires that run
parallel to the selected alignment
element(s).

· Perpendicular to alignment(s) - wires that
run perpendicular to the selected
alignment element(s).

Angle tolerance Maximum horizontal angular difference
between the alignment and a line element
at a wire location. This is only active if an
alignment element is selected and if Find is
set to Parallel to alignment(s) or
Perpendicular to alignment(s).

Within offset Maximum horizontal distance between the
alignment and a line element at a wire
location. This is only active if an alignment
element is selected and if Find is set to
Parallel to alignment(s) or Perpendicular to
alignment(s).

The vectorization of the wires can be undone by using the Undo command of the CAD
platform. The classification of the wires can be undone by using the Undo command of
TerraScan.

Place Tower String
Not Lite

Place Tower String tool is used to manually digitize a centerline of a powerline. The tool
produces a line string element. The tower string must have vertices only at tower locations. The
vertices should be located at the center point of a tower as accurate as possible. The tower
string can be digitized based on laser data and/or rectified images that show the tower
locations.

This tower string is used in later processing steps when detecting wires, validating catenary
attachment points, placing towers, and producing reports.

Place Tower String tool integrates line string placement and view panning in one tool which
speeds up the digitization process. The tower string is treated as 2D line element by other
powerline processing tools. Therefore, the elevation of tower string vertices does not play a
role.
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In general, any line string or complex line string element can be used as a tower string. If tower
positions are provided in a text file, the tower string can be generated automatically by using
the Draw as line strings command. In this case, the Place tower string tool is only used to assign
a line number to the tower string element.

To prepare for tower string placement:

1. Classify the point cloud in a way that tower locations and wires stand out. This may include
steps like

· classify by echo type, classify first of many echoes into a separate class

· classify by centerline using an approximate centerline element of the powerline

· classify ground and above-ground points

It depends on your workflow and project requirements whether the classification is applied
to project blocks or only temporarily to loaded points. For placing a tower string, you should
load a point cloud that is dense enough for visual tower detection and cover as much as
possible from the powerline.

2. Choose a view used as Top view for tower string digitization. Optionally, choose a second
view used as Profile view where a profile of the powerline is displayed while digitizing the
tower string.

3. Set up the display of laser points in the Display mode dialog. The class(es) with points on
towers/wires should be switched on, all other classes off. Set Color by to Elevation.

4. To emphasize the depth perception in the top view, set the Borders setting in the Display
mode dialog to a value > 0%. This improves the visibility of towers and wires within their
environment. You may also force the software to draw all points on the screen by setting
Speed to Normal or Slow.

5. Select CAD file symbology settings to draw the tower string. Set an empty level as active
level.

To place a tower string:

1. Select the Place Tower String tool.

This opens the Place Tower String dialog:

2. Define settings.
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SETTING EFFECT

Line number Defines a number or name for the tower
string. Each tower string should have a
unique number in order to clearly identify a
powerline.

Top view Number of the view used as top view. This
view is primarily used for digitizing the tower
string.

Profile view An optional view which displays a profile
along the powerline. This is useful to see
tower locations more clearly. The profile
view can also be used to place vertices for
the tower string.

Depth Depth of the profile view. This should
include the whole width of a powerline.

Undo last Click on the button in order to delete the last
vertex that was placed while digitizing the
tower string.

3. Enter a vertex at the center of the first tower.

This defines the location of the first tower. The dynamic rectangle is displayed whenever the
mouse pointer is inside a view. If you place a data click outside the rectangle, the application
pans the view in the direction of the click. Placing a data click inside the rectangle adds a new
vertex to the tower string.

4. Pan the view to the next tower location.

5. Place a vertex at the center of the tower.

6. Continue with steps 4 and 5 until the last tower of the powerline.

You can click on the Undo last button in order to delete the last vertex that was placed. The
undo action can be applied several times.

7. Press the reset button to finish the tower string.

It is recommended to check the tower string for missing or unnecessary vertices. It is
essential for automatic wire detection and tower model placement, that the tower string has
vertices only at tower locations and that no tower is missing a vertex.

It may happen that a tower string can not be placed along the complete powerline in one
operation. In this case, continue placing another tower string that runs in the same direction
and starts at the exact end point of the previous tower string. After placing several tower
strings along one powerline, join them with the Create Complex Chain tool (MicroStation) or
Construct Big Element tool (Spatix).

To assign a line number to an existing tower string element:

1. Select the line element that you want to use as tower string.

https://terrasolid.com/guides/spatix/big-elements.html
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2. Select the Place Tower String tool.

This opens the Assign Line Number dialog:

3. Type a number or text string in the Line number field.

4. Click OK.

This assigns the number to the tower string element.

Place Wire String
Not Lite

Place Wire String tool lets you manually place a line string for a single wire (catenary string)
between two towers. You can use this tool in places where the automatic detection of wires
fails.

You define the shape of the wire curve with three mouse clicks. Optionally, the start and end
point of the line string are defined by mouse clicks as well. Start and end points only effect the
length of the wire curve but not its shape.

The line string element for the wire is drawn on the active level using the active symbology
settings of the CAD file.

To place a wire string manually :

1. Use Draw Vertical Section tool to create a longitudinal section along the wire from tower to
tower.

2. Select the Place Wire String tool.

This opens the Place Wire String dialog:
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3. Define settings.

SETTING EFFECT

Start location separately If on, the first data click defines the start
point of the catenary string.

Snap to If on, the three curvature points are
snapped to the closest laser points in a
given class. This lock is normally on.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Snap to field.

Fit using If on, the wire string is fitted to laser points
in the given class within the given
tolerance.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Fit using field.

Classify to If on, laser points within the given radius
around the wire string are classified into
the given class.

End location separately If on, the last data click defines the end
location of the wire string.

4. (Optional) Define the start point of the wire string with a data click.

5. Define the first, second, and third curvature point with data clicks.

6. (Optional) Define the end point of the wire string with a data click.
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The application draws the wire string defined by the given points temporarily into the CAD
file.

7. Accept the wire string with another data click.

The wire string is drawn permanently into the CAD file and laser points are classified into the
given target class, if the corresponding setting is switched on.

The placement of a wire string can be undone by using the Undo command of the CAD
platform. The classification of the points along the wire string can be undone by using the
Undo command of TerraScan.

Vectorize Towers toolbox

The tools in the Vectorize Towers toolbox are used to place towers and to manipulate towers,
cross arms, and attachments.

 

 

TO USE TOOL

Place a tower Place Tower Not Lite

Edit tower attributes Edit Tower Information Not Lite

Move a tower to another location Move Tower Not Lite

Rotate a tower around its base point Rotate Tower Not Lite

Add a cross arm to a tower Add Cross Arm Not Lite

Set the height of a cross arm Set Cross Arm Elevation Not Lite

Set the length of a cross arm Extend Cross Arm Not Lite

Rotate a cross arm around the tower Rotate Cross Arm Not Lite

Modify a cross arm Modify Cross Arm Not Lite

Delete a cross arm Delete Cross Arm Not Lite

Create attachments automatically Create Attachments Not Lite
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TO USE TOOL

Add an attachment manually to a cross arm Add Attachment Not Lite

Move an attachment along the cross arm Move Attachment Not Lite

Delete an attachment Delete Attachment Not Lite

At the moment, cells and thus, the tools of the Vectorize Towers toolbox do only work in
MicroStation. There is not yet any corresponding element type in Spatix.

Add Attachment
Not Lite, Not Spatix

Add Attachment tool lets you add an attachment manually to a cross arm. Besides the options
offered for automatic creation of attachments there are two more possibilities:

· Side slope  - creates a sloped line in left or right direction relative to the tower string
element.

· Dual point - connects two wire strings that are not joined.

To add an attachment to a cross arm:

1. Select the Add Attachment tool.

This opens the Add Attachment dialog:

2. Define settings.

SETTING EFFECT

Type Direction of the attachment: Vertical, Side
slope, Slope 3D, or Dual point.

Number Number of the attachment.

Automatic If on, the number is set automatically based
on the already existing number of
attachments for the tower.
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SETTING EFFECT

Description Text field for defining a description for the
attachment.

3. Select a cross arm for which to add an attachment.

4. Identify the wire end point, connection point, or the end point of the first catenary element
with a data click.

This finishes the creation of a Vertical attachment.

5. Define the location on the cross arm where the attachment is placed with a data click.

This finishes the creation of a Side slope or a Slope 3D attachment.

6. Identify the end point of the second catenary element to connect it with the attachment.

This finishes the creation of a Dual point attachment.

Add Cross Arm
Not Lite, Not Spatix

Add Cross Arm tool lets you add a cross arm to a tower. The cross arm can be added as simple
line or as shape. This is a way to create more complex cross arms than can be defined in
Powerlines / Tower types category of TerraScan Settings.

To add a cross arm to a tower:

1. Select the Add Cross Arm tool.

This opens the Add Cross Arm dialog:

2. Define settings.

SETTING EFFECT

Type Element type of the cross arm: Line or Shape.

Center at tower If on, a cross arm is centered at the tower
center point.
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SETTING EFFECT

Force symmetry If on, a symmetric cross arm is forced. The
shape of a cross arm on the one side of the
tower is the same as the shape on the other
side of the tower.

Number Number of the cross arm.

Automatic If on, the number is set automatically based
on the already existing number of cross arms
for the tower.

Description Text field for defining a description for the
cross arm.

3. Select a tower for which to add a cross arm with a data click.

4. Define the height of the cross arm in a section view.

A line is shown dynamically at the mouse location to indicate the location of the cross arm.

5. Define the first vertex of the cross arm with a data click.

6. Define the second vertex of the cross arm with a data click.

This finishes the definition of a cross arm of the type Line.

7. Define additional vertices for a cross arm of the type Shape.

When the mouse comes close to the first vertex, it snaps to the vertex in order to close the
shape. If Force symmetry is switched on, an even amount of shape vertices is required.

8. Define the last vertex and close the shape.

 This finishes the creation of a cross arm of the type Shape.

When digitizing a cross arm, vertices can be added in a top view as well as in a section view.
If placed in a top view, the elevation of the vertex is set by the cross arm height. If entered in
a section view, the XY location of the vertex is defined by the centerline of the current
section.
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Create Attachments
Not Lite, Not Spatix

Create Attachments tool creates attachments for a tower. Attachments are line elements that
connect wires at their end or connection points with the cross arms of a tower.

Before the creation of attachments, the vectorization of wires, the tower and its cross arms
must be finished. Also, the location and rotation of towers and cross arms should be correct.

The attachment lines are created automatically if a connection from a wire end or connection
point to a cross arm can be created. The connection can be:

· Vertical - vertical line. The location of the wire end or connection point is moved to the
attachment’s end point to enforce a vertical connection line to the tower arm.

· Slope 3D -  sloped line in forward or backward direction along the tower string. Connects the
wire end or connection points on their original location with the cross arm.

The automatic creation of attachments fails if the software can not create a linear connection in
vertical or forward/backward direction between a wire end or connection point and a cross arm.

To create attachments for a tower:

1. Activate a tower string element using Activate Powerline tool.

2. Select the Create Attachments tool.

This opens the Create Attachments dialog:

3. Define settings.

SETTING EFFECT

Type Direction of the attachment: Vertical or Slope
3D.

Number Number of the first attachment for the
tower. Further attachments of the same
tower are numbered increasingly.

Description Text field for defining a description for all
attachments of the tower.

4. Select a tower for which to create attachments with a data click.
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5. Confirm the attachments with another data click.

This creates the attachment lines as part of the tower model. The creation can be rejected by
placing a reset click after step 4.

Delete Attachment
Not Lite, Not Spatix

Delete Attachment tool deletes an attachment.

The removes the connection between a wire end or connection point and a tower cross arm.

To delete an attachment:

1. Select the Delete Attachment tool.

2. Select the attachment to be deleted with a data click close to it.

3. Accept the removal with another data click.

Delete Cross Arm
Not Lite, Not Spatix

Delete Cross Arm tool deletes a cross arm.

If attachments have been created for a cross arm, they are deleted as well.

To delete a cross arm:

1. Select the Delete Cross Arm tool.

2. Select the cross arm to be deleted with a data click.

3. Accept the deleted cross arm with another data click.

Edit Tower Information
Not Lite, Not Spatix

Edit Tower Information tool lets you edit the attributes of a tower. This includes information
about tower number, description, type, status, and function as well as cross arm and
attachment attributes.

To edit tower information:

1. Select the Edit Tower Information tool.
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2. Select a tower for which to edit the attributes with a data click.

This opens the Tower information dialog:

3. Modify tower attributes.

4. To edit the attributes of cross arms, select the line of the cross arm and click the Edit button.

5. To edit the attributes for attachments, select the lines of a cross arm and of the attachment
and click the Edit button.

6. Click OK to apply the new attributes.

SETTING EFFECT

Number Tower number.

Description Text field for entering a description of the
tower.

Type Type of the tower as defined in Powerlines /
Tower types category of TerraScan Settings in
the Description field.
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SETTING EFFECT

Function Function of the tower defined in
Powerlines / Tower functions category of
TerraScan Settings.

Status Status of the tower defined in Powerlines /
Tower statuses category of TerraScan
Settings.

Cross arms Cross arms defined for the tower. Click Edit
to change cross arm Number and Description.

Attachments Attachments defined for the selected cross
arm. Click Edit to change attachment Number
and Description.

Extend Cross Arm
Not Lite, Not Spatix

Extend Cross Arm tool lets you change the length of a cross arm either on both sides
simultaneously or only on one side.

To extend a cross arm:

1. Select the Extend Cross Arm tool.

This opens the Extend Cross Arm dialog:

2. Select whether to extend Both sides or One side in the Extend field.

3. Select the cross arm to be extended with a data click near the end point.

The extend of the cross arm is dynamically displayed as the mouse pointer is moved.

4. Define a new end point for the cross arm with another data click.



TerraScan User Guide  © 2023 Terrasolid Ltd

286TerraScan Toolbox > Powerlines > Vectorize Towers toolbox

Modify Cross Arm
Not Lite, Not Spatix

Modify Cross Arm tool modifies a cross arm by moving single vertices of the line or shape.
Modification can be made to either the elevation, the XY location, or both.

To modify  a cross arm:

1. Select the Modify Cross Arm tool.

This opens the Modify Cross Arm dialog:

2. Select whether to change the Elevation, the Xy position, or the Xyz position of a vertex.

3. Select a vertex with a data click close to it.

The vertex position is dynamically displayed as the mouse pointer is moved.

4. Define the new position for the vertex with a data click.

Move Attachment
Not Lite, Not Spatix

Move Attachment tool moves an attachment along the cross arm.

The tool is not yet implemented in the software.

Move Tower
Not Lite, Not Spatix

Move Tower tool lets you change the location or the height of a tower.

The tool works with and without an active tower string element. If the tower string element is
activated, the tool moves the vertex of the tower string and the tower model if one is placed at
the location of the vertex. It also moves attached wire elements if attachments have been
placed and the tower string element has been activated. If the tower string element is not
activated, only the tower model is moved.

To move a tower:

1. (Optional) Activate a tower string element using Activate Powerline tool.
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2. Select the Move Tower tool.

3. Define what to move for the tower.

SETTING EFFECT

Move Determines what is moved for a tower:

· Xy position - horizontal position. Can be
moved in a top or section view of the tower.

· Xyz position - horizontal and vertical
position. If moved in a top view, the
elevation of the tower is set to the active
depth of the view. If moved in a section
view, the XY position is determined by the
centerline of the section.

· Base elevation - base point elevation. Move
this in a section view of the tower. Only the
height of the tower is modified, not its
location.

· Top elevation - top point elevation. Move
this in a section view of the tower. Only the
height of the tower is modified, not its
location.

4. Identify the tower with a data click.

The tower model or the tower base/top point is dynamically displayed at the mouse pointer
location.

5. Define the new location of the tower or the tower base/top point with a data click.

Place Tower
Not Lite, Not Spatix

Place Tower tool lets you place a tower model. The shape of the tower has to be defined in
Powerlines / Tower types category of TerraScan Settings. A tower model is drawn as
MicroStation cell element into the CAD file.

Towers are placed manually based on the tower type definition, an activated tower string
element, and laser points. Tower placement can be supported by view arrangement and display
options, for example by using the View Tower Spans tool. A typical setup may include views for
displaying the span and the tower in (rotated) top views, the tower and the tower tip in cross
section views.
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The placement of towers with the Place Tower tool is straightforward and includes placing the
base point, the tip point, and the end point(s) of the cross arm(s). The XY location of a tower is
defined by the vertex of the tower string element. Classified laser points loaded in TerraScan
can be used to fix the tower’s base point elevation to the ground.

In addition to the simple tower type models that are defined in the TerraScan Settings, a more
complex tower template can be created. Template creation may start from an already
vectorized, simple tower model. Then, tools from the Vectorize Towers toolbox can be used to
add, for example, more complex cross arms to the tower cell element. See Creating a tower
template for more information about how to define a tower template.

To place a tower model:

1. Activate a tower string element using Activate Powerline tool.

2. Select the Place Tower tool.

This opens the Place Tower dialog:

3. Define settings.

SETTING EFFECT

Template Use of a template for tower placement:

· None - no template is used.

· Identify - the tower model that is selected
with the next data click is set as active
template.

· Active - tower models are placed using the
active template.

Number Tower number. The number may be preceded
with alphanumerical characters. This can be
used in reports created with the Export
Powerline tool.

Auto increase If on, tower numbers increase automatically
while placing towers.
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SETTING EFFECT

Description Text field for typing a description for the
tower. This can be used in reports created
with the Export Powerline tool.

Type Type of the tower. Defined in Powerlines /
Tower types category of TerraScan Settings in
the Description field.

Function Function of the tower. Defined in
Powerlines / Tower functions category of
TerraScan Settings in the Description field.

Status Status of the tower. Defined in Powerlines /
Tower statuses category of TerraScan Settings
in the Description field.

Ground Point class used to derive the tower’s base
point elevation. This is only used if the base
point is placed in a top view.

4. Move the mouse pointer into a view.

A line is displayed at the location of the tower defined by a vertex of the tower string. In a
section view, the base point can be moved in elevation.

5. Define the base point of the tower with a data click.

If the base point is defined in the top view, the elevation is derived from the laser points
according to the Ground setting in the tool’s dialog. In a section view, the elevation is
defined by the data click.

6. Move the mouse pointer in a section view, preferable a view showing the tip of the tower.

A dynamic preview of the tower center is displayed.

7. Define the tip of the tower with a data click in the section view.

A dynamic preview of the first cross arm is displayed.

8. Place the end point of the first cross arm with a data click in the section view.

9. If the tower model defines additional cross arms, repeat step 8 for all cross arms.

After placing the end point of the last cross arm, the placement of the tower is finished. If
Auto increase is switched on in the Place Tower dialog, the number is increased.

Use the list of the View Tower Spans tool to display the next tower. You may define new
settings for the next tower in the tool’s dialog and continue with step 4.

While placing a tower model, you can undo step-by-step with reset clicks.
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Creating a tower template

A tower template can be created to place towers with a more complex shape as it can be
defined in TerraScan Settings. The template defines the position, length and shape of the cross
arms of the tower.

To create and place a tower template:

1. Place one simple tower model using Place Tower tool.

2. Modify the model using Add Cross Arm tool or other Vectorize Towers tools.

3. Select the Place Tower tool.

4. Set Template to Identify.

5. Select the tower model with a data click.

This sets the selected tower model as active template.

You can continue with placing the first tower using the template. Follow the steps 4-7
described above for placing the tower’s base point and tip.

6. The position and length of the cross arms is defined by the template. Confirm the placement
of the tower model with another data click in the section view.

Rotate Cross Arm
Not Lite, Not Spatix

Rotate Cross Arm tool rotates a cross arm around the center point of the tower.

The tool also moves attached wires if attachments have been placed and the tower string
element is activated.

To rotate a cross arm:

1. (Optional) Activate a tower string element using Activate Powerline tool.

2. Select the Rotate Cross Arm tool.

3. Select the cross arm to be rotated with a data click.

The cross arm direction is dynamically displayed as the mouse pointer is moved.

4. Define the new direction for the cross arm with a data click.

Rotate Cross Arm tool should not be used after attachments have been placed to prevent an
incorrect replacement of attachments and wires.



TerraScan User Guide  © 2023 Terrasolid Ltd

291TerraScan Toolbox > Powerlines > Vectorize Towers toolbox

Rotate Tower
Not Lite, Not Spatix

Rotate Tower tool lets you change the horizontal direction of the tower.

The tool works with and without an active tower string element. It also moves attached wire
elements if attachments have been placed and the tower string element has been activated.

To rotate a tower:

1. (Optional) Activate a tower string element using Activate Powerline tool.

2. Select the Rotate Tower tool.

3. Identify the tower to be rotated with a data click.

The tower model is dynamically displayed at the mouse pointer location.

4. Define the new direction of the tower with a data click.

Set Cross Arm Elevation
Not Lite, Not Spatix

Set Cross Arm Elevation tool lets you change the height of a cross arm.

To set the elevation for a cross arm:

1. Select the Set Cross Arm Elevation tool.

2. Select a cross arm for which to set a new height with a data click.

The cross arm location is dynamically displayed at the mouse pointer location.

3. Define the new height with a data click in a section view.

This places the cross arm at the new height.

View Powerline toolbox

The tools in View Powerline toolbox are used to view tower spans, to label towers and heights
of catenaries, to find danger objects and create reports of danger object locations, to create
span tiles and to output catenaries and towers into text or files.

 



TerraScan User Guide  © 2023 Terrasolid Ltd

292TerraScan Toolbox > Powerlines > View Powerline toolbox

 

TO USE TOOL

View tower spans as profiles and cross
sections

View Tower Spans

Label tower string with tower numbers Label Towers

Label height from ground to catenary Label Catenary Height

Find points close to the catenaries Find Danger Objects

Create tiles rectangles for powerline spans Create Span Tiles

Output catenary coordinates to text files Output Catenary

Export powerline information to text file Export Powerline

Create Span Tiles

Create Span Tiles tool creates rectangular shape elements for each span. These rectangles can
be used, for example, as tiles for creating orthophotos with TerraPhoto where each resulting
image covers one tower-to-tower distance.

There are two different types of tile elements that can be produced:

· Rotated tiles - the long rectangle sides are parallel to the tower string.

· Ortho tiles - tiles are drawn as orthogonal bounding box around a span.

The shape elements are drawn using the active line weight and style settings of the CAD file.

To create span tiles:

1. Activate the tower string element using the Activate Powerline tool.

2. Select the Create Span Tiles tool.

This opens the Create Span Tiles dialog:
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3. Define settings and click OK.

This draws the tiles as shape elements into the CAD file.

SETTING EFFECT

Draw rotated tiles If on, rotated tiles parallel to the tower string
are drawn on the defined Level using the
selected Color.

Draw ortho tiles If on, orthogonal tiles are drawn around each
span on the defined Level with the selected
Color.

Width Width of the tile measured from a tower
string vertex to the tile boundary. For
orthogonal tiles, this is the minimum
distance.

Extend Distance by which a span tile is extended
beyond the start and end tower of the span.

Pixel size Intended pixel size to be used for orthophoto
creation. See TerraPhoto User Guide for more
information.

Export Powerline

Export Powerline tool creates a report for the towers that belong to an active tower string
element. The output of the tool is a structured, delimited text file that lists all attributes of a
tower selected in the tool’s first dialog.

The tool requires that tower models have been placed using the Place Tower tool.

https://terrasolid.com/guides/tphoto/index.html
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To output towers as text file:

1. Activate the tower string element using the Activate Powerline tool.

2. Select the Export Powerline tool.

This opens the Export Powerline dialog:

3. Select a Delimiter used to separate columns in the text file.

4. Type texts in the Tower, Cross arm and Attachment fields. The texts are used in the report.

5. Select attributes to be included in the report.

6. Click OK.

This opens the Powerline export file dialog, a standard Windows dialog for saving a file.

7. Define a name and location for storing the output file. Add a suitable extension to the file
name, such as .TXT or .CSV for opening the file in a text or spreadsheet application.

8. Click Save.

This creates the report. An information dialog informs about the success of the action.

The following figure illustrates the structure of the report:
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The first row shows the tower attributes, followed by the first cross arm attributes in the next
row. Then, the attributes of the attachments belonging to the first cross arm are listed. This is
done for all cross arms of the first tower. In the same way, all other towers and tower parts are
listed in the report file.

Find Danger Objects

Find Danger Objects tool finds points which are within a given distance from vectorized wires.
In addition, it lets you create reports in order to document danger point locations.

There are three different methods how the distance between wires and the danger objects can
be defined:

· Vertical distance to wire - points within a vertical distance from the wire and within a given
offset from the tower string.

· 3D distance to wire - points within a 3D radius around a wire.

· Falling tree logic - each point in the source class is considered as the tip of a tree with its
trunk at the xy location of this point and the elevation of the base point on the ground. If the
point “falls like a tree” and falls into a 3D buffer area around a wire, it is listed as a danger
point. The method requires a ground classification.

The tool produces a list of potential danger points. The list is traversable, you can scroll through
the list and check each location.

A general workflow example for reporting danger object locations along a powerline is:

1. Detect wires by following the workflow for powerline processing as suggested, for example,
at the beginning of the Powerlines chapter.

2. Start the Find Danger Objects tool. Use any class with points on potential danger objects as
Object class. Report danger points By minimum interval to get at least one point from each
potential danger object.

3. Check the list of danger points. Use the Classify button to classify points on danger objects
into a separate class. Use the Remove button to remove points from the list if they are not
on danger objects (such as noise close to the wires).

4. Save the point cloud after classifying danger points.
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5. Close the Danger Objects dialog.

6. Start the Find Danger Objects tool again. Use the point class with points on danger objects as
Object class. Set Report to All to get a list of all danger points.

7. Setup the view display in a way that suites for creating HTML reports. For creating text
reports, no view setup is required.

8. Create a text report by using the File / Output report command or HTML reports by using the
File / Write HTML command.

To find danger points:

1. Activate the tower string element using the Activate Powerline tool.

2. Select the Find Danger Objects tool.

This opens the Find Danger Objects dialog:

SETTING EFFECT

Run on Source data used for danger object
detection:

· Loaded points - points loaded in
TerraScan.

· Active project - points in blocks of the
active project in TerraScan.
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SETTING EFFECT

Find using Method of danger object detection: Vertical
distance to wire, 3D distance to wire or
Falling tree logic.

Within distance Radius that defines a 3D buffer around a
wire. The buffer is added to a wire for
computing distances to points.

Within offset Horizontal distance from the tower string
element that defines a corridor. Danger
objects are searched within this corridor.

Object class Point class(es) from which to search danger
objects.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Object class field.

Ground class Class that contains points on the ground.
This is only active if Find using is set to
Falling tree logic.

Projection Projection system that is used for the data
set. This is required for writing
latitude/longitude values into output
reports.

First number Number of the first potential danger point
in the list.

Report Reporting frequency:

· All - each danger point is reported. This is
useful, for example, if points on danger
objects are already classified and you
want to create reports for danger objects.

· One for every span - only the danger
point with the smallest distance within a
span (distance between two towers) is
reported.

· By minimum interval - danger points are
reported every given Interval distance.
This is useful if you want to detect danger
objects and classify points on them into
another point class.

Report hits Hits on danger objects to report:

· One per point - closest wire - for each
potential danger point in the point cloud,
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SETTING EFFECT

only the distance to the closest wire is
reported.The distance to other wires is
not reported even if it is also within the
critical distance.

· Multiple - all wires - for each potential
danger point in the point cloud, distances
to all wires are reported if they are within
the critical distance.

Wire levels CAD file level(s) on which the vectorized
wire elements are placed. Separate several
level numbers by a comma or minus, for
example 1-10,13. Use 0-63 for all levels.

First tower Number of the tower at the first vertex of
the selected tower string.

3. Define settings and click OK.

The application searches for danger points. When the search is complete, the Danger Object
Display dialog opens:

SETTING EFFECT

Span top Number of CAD file view used for displaying a
span (distance between two towers) in a top
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SETTING EFFECT

view.

Span profile Number of CAD file view used for displaying a
span in a profile view. The centerline of the
profile is defined by the tower string element,
the depth by the Depth value.

Section Number of CAD file view used for displaying a
danger point location in a section view. The
centerline of the section runs perpendicular
to the tower string, the depth is defined by
the Depth value.

Profile Number of CAD file view used for displaying a
danger point location in a profile view. The
centerline of the profile is defined by the
tower string element, the width by the Width
value.

Top 1, Top 2 Number of CAD file view used for displaying a
danger point location in a top view. The width
of the area shown in the view is defined by
the Width value. The orientation of the view
is defined by the selected option:

· North up - north direction points to the top
edge of the view.

· Line up - the tower string element runs from
the bottom to the top edge of the view.

· Line right - the tower string element runs
from the left to the right edge of the view.

Draw marker for selected point If on a temporary marker is drawn for a danger
point that is selected in the list. The marker is
drawn with the given Size, on the selected
Level and using the Color and line weight
settings.

Open block automatically If on, points from the block at the danger
point location are loaded automatically.
Points from neighbouring blocks are loaded in
the given Neighbours distance.

4. Define settings and click OK.

The Danger Objects dialog is now accessible:
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The list contains all detected danger points. For each danger point, it shows the span (start
and end tower numbers), wire number, and distance between the wire and the danger
point. If you click on a row, the application automatically updates the previously defined CAD
file views to display that danger point location.

The Danger Objects dialog contains several menu and button commands for viewing,
classifying, labeling and reporting danger locations.

The list can be sorted using commands from the Sort pulldown menu.

The danger point locations can be labeled using commands from the Label pulldown menu. A
label consists of a line and a text element. The line represents the shortest distance
between the wire and the danger point. The text element shows the distance value in CAD
file units.

TO USE COMMAND

Output danger locations to a text file File / Output report

Output danger locations to an HTML file File / Write HTML

Classify all danger points into another class File / Classify all

Change the view setup for danger point
display

File / Display settings

Sort list by danger point distance Sort / By distance

Sort list by wire number and secondarily by
distance

Sort / By wire and distance

Sort list by span and secondarily by wire
number

Sort / By span and wire

Sort list by span and secondarily by distance Sort / By span and distance
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TO USE COMMAND

Label the selected danger point in 3D
position

Label / In 3d

Label the selected danger point in a profile
drawing

Label / In profile

Label all danger points in 3D Label / All in 3d

Label all danger points in a profile drawing Label / All in profile

Show the location of the selected danger
point in a view

Show location

Identify a danger point at a certain location Identify

Classify the selected danger point to the
given point class

Classify

Remove the selected row from the list Remove

File / Output report

Output report command creates a report in a text file format. You can decide what information
is included in the report. The result is a delimited text file that can be opened in text editors or
spread sheet applications.

To create a report in  text file format:

1. Select Output report command from the File pulldown menu.

This opens the Output Danger Points dialog:

2. Select fields to be included in the report.
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Longitude and latitude values can only be computed if the projection system of the data is
known. The correct projection system must be selected in the Find Danger Objects dialog.
See Find Danger Objects tool for a description of the dialog.

3. Select a Delimiter character.

4. (Optional) Switch on Write column titles in order to add the field names as column titles to
the report.

5. Click OK.

This opens the Danger point output file dialog, a standard Windows dialog for saving files.

6. Define a storage location, name, and extension for the report and click Save.

This creates the report file.

File / Write HTML

Write HTML command creates a report in HTML format. The report may contain images and
textural information of each danger point location. You can decide what information is included
in the report.

The command uses an HTML template that defines the layout of the report. The template
defines variables for the textural information and placeholders for images. The following tables
list all variables that can be included in report templates:

VARIABLE TEXT CONTENT

#dgrnumber Point number

#dgrspan Span (start-end tower)

#dgrwire Wire number

#dgrdist Distance to wire

#dgrstation Distance from start tower

#dgrclass Point class

#dgrx Easting coordinate

#dgry Northing coordinate

#dgrz Elevation

#dgrlon Longitude

#dgrlat Latitude

VARIABLE CAPTURED VIEW

#spantop Span top view as set in the Danger Object
Display dialog.
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VARIABLE CAPTURED VIEW

#spanprofile Span profile view as set in the Danger Object
Display dialog.

#section Section view as set in the Danger Object
Display dialog.

#profile Profile view as set in the Danger Object
Display dialog.

#top1 Top 1 view as set in the Danger Object
Display dialog.

#top2 Top 2 view as set in the Danger Object
Display dialog.

An example template is provided in the EXAMPLE folder of a TerraScan installation, for instance
in C:\TERRA64\EXAMPLE\DANGERPOINT_REPORT.HTML.

Longitude and latitude values can only be computed if the projection system of the data is
known. The correct projection system must be selected in the Find Danger Objects dialog. See
Find Danger Objects tool for a description of the dialog.

The view setup determines the size of the images saved for the report. The content of the
images is defined by the visibility of data in the views. Images may contain orthophotos
attached as raster reference files in TerraPhoto or MicroStation, point cloud data displayed in
TerraScan, and vector data in the CAD file.

If point cloud data from a TerraScan project is included in the images and reports are written for
all danger points, it is required to switch the Open block automatically option on in the Danger
Object Display dialog.

In the default template, there are placeholders for three images: a span top view, a section
view, and a profile view. An example view setup for producing images from these three views
is illustrated in the following figure. The views contain point cloud data colored by class, vector
data for wires, and labels for danger points. In the span top view, the visibility of some point
classes is switched off and orthophotos attached as TerraPhoto references are displayed.
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To create a report in  HTML format:

1. Arrange the views in a way that fits to your report template. Set the visibility of data.

2. Select Write HTML command from the File pulldown menu.

This opens the Write HTML Report dialog:

3. Define settings and click OK.

This creates the report file(s) and the image(s). The names of the image files are a
combination of the view type and an increasing danger object number, for example
"spantop1.jpg", "section1.jpg", "profile1.jpg" are the images for the report file
"report1.html". Images are stored as JPEG files.
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SETTING EFFECT

Write A report is written:

· All points - for all danger points in the list.

· Selected point - for the danger point
selected in the list.

Folder Location where the reports are stored.

Name prefix Defines the name prefix for the report files.
The name is a combination of the prefix and
the danger object number.

Template Storage location and name of the HTML
template file.

File / Classify all

Classify all command classifies all danger points in the list into another point class. The target
class is defined in the Classify all danger points dialog:

Another automatic way to classify more points on danger objects is provided by the Wire
danger points routine.

File / Display settings

Display setting command opens the Danger Object Display dialog described above.

Label Catenary Height

Label Catenary Height tool labels the location of the minimum elevation difference between a
catenary element and laser points loaded in TerraScan.

It finds the lowest point of a catenary element, derives an elevation value from all points
within a given radius around this XY location. Then, it computes the elevation difference
between the catenary and the derived elevation value. The tool draws a vertical line that marks
the lowest catenary point. In addition, a text element is drawn that shows the elevation
difference value. The text is drawn using the active text, level, and symbology settings of the
CAD file.



TerraScan User Guide  © 2023 Terrasolid Ltd

306TerraScan Toolbox > Powerlines > View Powerline toolbox

To label height from catenary  to ground:

1. Select the Label Catenary Height tool.

This opens the Label Catenary Height dialog:

2. Define settings.

3. Select a catenary string element with a data click.

The catenary is highlighted.

4. Accept the selected catenary element with another data click inside the view.

The location of minimum height difference is labeled. You can continue with step 3.

OR

1. Select catenary string element(s) to label

2. Select the Label Catenary Height tool.

3. Accept the selected catenary element(s) with a data click inside the view.

The location(s) of minimum height difference(s) is labeled.

SETTING EFFECT

From class Point class used for the elevation difference
computation.

Within Radius within which points are used for
computing the elevation value.

Compute Clearance computation logic:

· Vertical difference - direct vertical clearance

· 3D distance - direct distance between the
catenary and the point cloud

Draw As Height labeling method:

· Vertical line - vertical line between the
catenary and the point cloud

· 3D line - direct line between the catenary
and the closest point
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SETTING EFFECT

Accuracy Number of decimals for drawing the label.

Label Towers

Label Towers tool draws a label for each tower represented by a vertex of the active tower
string element. The label is drawn as cell element into the CAD file. The label is displayed in all
views in a way that it is readable independently of the view type and rotation.

The location of the label is determined by the vertices of the tower string element and offset
values. A positive offset value places the label elements on the right side of the tower string, a
negative value on the left side. In addition, an elevation offset can be applied. Active text size,
level, and symbology settings of the CAD file are used for drawing the labels.

To place labels for tower locations:

1. Activate a tower string element using the Activate Powerline tool.

2. Define settings for texts using the CAD platform Text tools. Set the active level and
symbology settings.

3. Select the Label Towers tool.

This opens the Label Towers dialog:

4. Define settings and click OK.

This draws the labels into the CAD file.

SETTING EFFECT

Prefix Text that is added before the tower number.

First number Number of the first tower.

Suffix Text that is added after the tower number.
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SETTING EFFECT

Numbers Method of numbering the towers along the
tower string element: Increase or Decrease.

Offset Horizontal offset of the label from the tower
location. Measured between the tower string
vertex and the center point of the text
element.

Dz Vertical offset of the label from a tower
location. Measured between the tower string
vertex and the center point of the text
element.

You can undo the placement of tower labels by using the Undo command of the CAD
platform.

Output Catenary

Output Catenary tool creates a report for the catenaries that belong to an active tower string
element. It creates a list of all wire strings, from which you can store a text file for one selected
catenary string at a time.

The output of the tool is a structured, space-delimited text file that lists all attributes of a wire
string selected in the tool’s first dialog.

To output a catenary  into a text file:

1. Activate the tower string element using the Activate Powerline tool.

2. Select the Output Catenary tool.

This opens the Output Catenary dialog:
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3. Type the number(s) of CAD file level(s) that contain catenary string elements into the From
levels field.

4. Type a number for the First tower. The numbering is applied to the list of wires displayed by
this tool and to the text reports.

5. Select attributes to be included in the report.

6. Click OK.

Another Output Catenary dialog opens:

The dialog shows a list of all wires found on the given levels, and for each wire string the
number of the start tower, the number of the wire, the offset between tower string vertex
and wire attachment, the elevation at the start tower, and the number of spans that include
this wire string.

The location of a wire can be shown by selecting a wire in the list and using the Show
location button. Move the mouse pointer into a view. The selected wire is highlighted. Place
a data click in the view in order to move the view to the start of the highlighted wire.

7. Select a wire in the list.

8. Click Output.

This opens the Output selected catenary chain dialog, a standard dialog for saving a file.

9. Define a name and location for storing the output file. Add a suitable extension to the file
name, such as .TXT or .CSV for opening the file in a text or spreadsheet application.

10. Click Save.

This creates a text file that contains a structured list with a column for each selected
attribute. An information dialog informs about the success of the action.
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View Tower Spans

View Tower Spans tool makes it easy to traverse through a powerline and display tower and
span locations in different types of views, such as top views, sections views, and profile views.

Additionally, top and oblique camera views of towers can be displayed showing aerial images.
This requires that TerraPhoto is running and the availability of images organized in a TerraPhoto
image list. Camera views might be useful in addition to other display options for towers and
spans to support classification tasks or to identify tower structures.

The tool handles the automatic update of views as you scroll through a list of towers. The
following view types can be automatically updated:

· Span top - a top view showing one tower span. The display is rotated into longitudinal
direction of the powerline.

· Span profile - a section view showing a longitudinal profile along a tower span.

· Tower top - a top view showing the tower location. The top view is rotated to north direction
pointing up.

· Tower rotated - a top view from the tower location. The view is rotated into longitudinal
direction of the powerline.

· Tower section - a cross section view of the tower location.

· Tower tip - a cross section view of the tower tip.

· Tower profile - a longitudinal section view of the tower location.

· Camera top - a top-like camera view showing the tower location in an aerial image.

· Camera oblique 1 - an oblique camera view looking in backward direction from the tower
location along the powerline.

· Camera oblique 2 - an oblique camera view looking in forward direction from the tower

location along the powerline.

The tool is useful for various processing steps, for example:

· for manually classifying laser points very close to wires or towers, such as noise points.

· for validating the automatically detected wires.

· for classifying points on towers.

· for placing tower models.

To view tower spans:

1. Activate a tower string element using the Activate Powerline tool.

2. Select the View Tower Spans tool.

This opens the View Tower Spans dialog:

https://terrasolid.com/guides/tphoto/index.html
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3. Type the number(s) of CAD file level(s) that contain catenary string elements into the From
levels field.

4. Type a number for the first tower. The numbering is only applied to the list of towers
displayed by this tool.

5. Click OK.

This opens the Tower Span Display dialog:

6. Select views that are used for the different display options.

A Depth value determines the depth of a section in section/profile views. It also defines the
area of data within which points are classified using Above curve or Below curve commands.
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A Width value determines the width of a tower profile view in longitudinal direction left and
right of the tower location.

Select None if you do not want to use a display option in any view.

7. Click OK.

This activates the Tower Spans dialog:

The dialog contains a list of all tower locations that are represented by vertices of the active
tower string. For each tower, the number of catenaries starting from this tower is shown.

8. Open the CAD file views that you want to use to display data. Arrange the views on the
screen.

9. Select a line in the list of towers.

This updates the display in the open views according to the view setup.

You can change the view setup by using the Display command from the Settings pulldown
menu. This opens the Tower Span Display dialog described above.

The commands from the Classify pulldown menu can be used to classify points in section
views.

Above curve

Above curve command classifies points above a given curve and within the section view depth.
The curve is defined by three manually placed data points.

To classify  points above a curve:

1. Select Above curve command from the Classify pulldown menu.
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This opens the Classify above curve dialog:

2. Select a point class in the From class field from which to classify points.

3. Select a point class in the To class field into which to classify points.

4. Define the first, second, and third point of the curve with data clicks in a section view. The
points are displayed temporarily as small white points and the curve is shown as a temporary
drawing after the second point has been placed.

You can undo the placement of the points step-by-step with reset clicks.

After the third point is placed, the points above the curve and within the depth of the
section are classified.

You can undo the classification by using the Undo or From list commands of TerraScan.

Below curve

Below curve command classifies points below a given curve and within the section view depth.
The curve is defined by three manually placed data points.

To classify  points below a curve:

1. Select Below curve command from the Classify pulldown menu.

This opens the Classify below curve dialog:

2. Select a point class in the From class field from which to classify points.

3. Select a point class in the To class field into which to classify points.

4. Define the first, second, and third point of the curve with data clicks in a section view. The
points are displayed temporarily as small white points and the curve is shown as a temporary
drawing after the second point has been placed.

You can undo the placement of the points step-by-step with reset clicks.

After the third point is placed, the points below the curve and within the depth of the
section are classified.
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You can undo the classification by using the Undo or From list commands of TerraScan.
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Roads and Railroads

The tools for processing data of roads and railroads have been developed a lot since more and
more data became available from Mobile Mapping System (MMS) surveys. This development is
still ongoing, so there will be additions and improvements for the tool sets in the future.

Most of the tools are intended to be used with dense point clouds of high positional accuracy.
Such point clouds are usually produced by Mobile Laser Scanning (MLS) systems. However,
some of the tool described in this Chapter are applicable to Airborne Laser Scanning (ALS) point
clouds as well. Some tools benefit from images which are collected by one or several cameras
as part of a modern MMS or ALS system.

The processing of point clouds from MLS systems is a complex task if a high accuracy and quality
for the end products shall be achieved. This includes the calibration of the scanner system, the
matching of drive paths, the classification of the points into classes that support the extraction
of the required information, and finally the extraction of the required information itself.

The general workflow for processing MLS data for road and railroad projects can be outlined as
follows:

1. System calibration: fine-tuning of the calibration values provided by system manufacturers.
This is usually done based on laser data that is collected at a specific calibration site. The
process is done with TerraScan and TerraMatch and the workflow is described in the
TerraMatch Users’ Guide.

2. Project setup: import and modify raw trajectory information, creation of a TerraScan project,
import of raw laser data. This is done with tools of TerraScan.

3. Drive path matching: improving the internal and absolute accuracy of the project data. This
involves TerraScan and (optionally) TerraPhoto, but mainly tools of TerraMatch are used and
the workflow is described in the TerraMatch Users’ Guide.

4. Laser data classification: cutting off overlap between drive paths, apply classification routines
and possibly other automatic/manual processing steps. This depends on the purpose for
which the data shall be used.

5. Extraction of information: this may include the analysis of the current situation, for example,
on a road surface or along a road/rail track; or the detection and/or vectorization of specific
features, such as paint markings, road breaklines, rails, overhead wires, or potentially
dangerous objects.

The tools described in this Chapter are related to the last point in the workflow outline above.

Road data processing

TerraScan provides three options for road breakline extraction. There is the Find Automatic
Breaklines tool for the automatic extraction of the road crown. The Find Road Breaklines tool
can be used to extract the crown of a road and road edges semi-automatically based on
approximate 2D lines. Finally, there is a special processing workflow that speeds up the

https://terrasolid.com/guides/tmatch/index.html
https://terrasolid.com/guides/tmatch/index.html
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digitization of any lines along a corridor. This workflow can be applied to MLS and high-density
ALS data, and involves the Write section points routine and the Import Road Breaklines tool.

Draw Slope Arrows tool and Color by Slope display option can be used for water flow analysis
on the road surface, for checking the superelevation of road lanes, and for detecting damage on
the road surface, such as ruts.

Write Alignment Elevations tool exports road surface elevation values along an alignment
element into text files. This may be required for further road surface analysis in other software
products, such as the computation of the International Roughness Index (IRI).

Further functionality is implemented in TerraScan as macro actions, such as Compute section
parameters and Find paint lines.

Road/Railroad data processing

There are some tools in TerraScan that are useful for both application fields, roads and
railroads.

Place Railroad String tool is a useful tool for many purposes. It allows faster digitization of
linear elements than any other CAD digitization tool.

One of them is the Draw Sight Distances tool that is applicable to ALS and MLS data. Line-of-
sight analysis based on laser point clouds has the unique advantage that all objects in the road
environment including vegetation are considered. Another tool, Draw Sign Visibility, analyzes
the visibility of signs or signals from certain viewer positions.

Find Poles is a tool for detecting and vectorizing poles along a railroad or road.

Label Alignment Curvature and Label Clearance are tools for analyzing the radius of curved
roads/rails and clearance distances below bridges or other overhead structures.

Fit Geometry Components tool derives geometry components from a surveyed centerline of
roads, railroads, and possibly other corridor projects. Geometry components are required for
design tasks, especially for the data exchange between different software products.

Railroad data processing

TerraScan has a few tools which are dedicated to railroad processing. They include classification
and vectorization tools suited for ALS and/or MLS data.

Fit Railroad String tool is intended to be used for ALS data of railroads. It fits an approximate rail
track centerline to the classified laser points on the rails. The resulting 3D line element follows
the rail track centerline more accurately.

There are two tools for the automatic detection and vectorization of rails and overhead wires
from MLS data. Find Rails tool creates vector lines along rail tracks based on classified laser
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points, a rail track cross section profile, and an alignment element. Find Wires tool is used for
the vectorization of all kinds of overhead wires along rail tracks, tram tracks, etc. It creates
vector lines and classifies laser points on wires. The automatic wire detection is usually
followed by manual improvements of the wire lines which can be done with the Check Wire
Ends tool.

Road toolbox

The tools in the Road toolbox are used to place breaklines of roads, to analyze the slopes on the
road surface and sight conditions, to place labels for curvatures, to write elevation values along
an alignment, and to start the fit geometry components module.

 

 

TO USE TOOL

Find road breaklines automatically Find Automatic Breaklines

Find multiple breaklines along a road Find Road Breaklines

Import breaklines back to world coordinate
system

Import Road Breaklines

Draw slope arrows perpendicular and along
alignment

Draw Slope Arrows

Draw sight distance values along road Draw Sight Distances

Display locations with line of sight to a sign
polygon

Draw Sign Visibility

Label smallest distance point inside
polygons

Label clearance

Label alignment curvature at regular
intervals

Label Alignment Curvature

Write alignment elevations at regular steps Write Alignment Elevations

Mark elements close to a centerline
element

Mark Elements By Centerline

Fit geometry components to match
surveyed alignment

Fit Geometry Components Not Lite, Not
UAV
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TO USE TOOL

Digitize paint lines automatically from
loaded points

Find Paint Lines

Place standard paint marking symbols
manually

Place Paint Marking

Place paint lines manually Place Paint Line

Place crosswalk paint markings manually Place Crosswalk

Place stripe paint markings manually Place Paint Stripes

Place paint marking symbol rows manually Place Paint Symbol Row

Export paint marking information to a text
file

Output Paint Report

Draw Sight Distances

Draw Sight Distances tool determines how far a viewer sees along a road, railroad, or other
corridor, and produces labels for sight distances. It’s basically a tool for line-of-sight analysis
based on point clouds.

The path of the viewer along the corridor is defined by a line element. It should run along a
lane of the road or a rail track at the elevation of the ground. It can be produced, for example,
by drawing the trajectory line into the CAD file and draping it to the ground points using the
Drape Linear Element tool. The viewer height is defined with a constant value in the tool’s
settings.

The target positions for the line-of-sight analysis are also defined by a line element draped on
the ground elevation. The target line can be the same element as the viewer line or another
line element that is a little bit longer than the viewer line. The viewing angle which determines
the area for potential obstacle search is defined as a constant value in the tool’s settings.

Potential obstacles for the viewer are represented in the point cloud. The points should be
classified into a ground class by using preferably the Hard surface and/or Ground classification
routines and above-ground classes. To get a reliable result from the line-of-sight analysis, any
points below the ground, from moving objects, and noise above the road surface should be
classified into separate classes. These classes can be excluded from the process.

The process checks if there is any point in the point cloud close to a straight line from a viewer
position to a target position. If there is a point, the closest point to the viewer position
determines the sight distance.

There are rules and regulations for required sight distances along a road. The distances mainly
depend on the speed allowance and vary from country to country. There are different sight
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distance requirements for safely stopping a car or for safely overtaking another car. Example:
For safely stopping a car, a viewer with a height of 1.10 m above lane center and a speed of 80
km/h must see a target of 0.40 m above the road surface in a distance of 120 m. For safely
overtaking a car, the same viewer must see a target of 0.60 m above the road surface in a
distance of 320 m. The viewer path needs to be cut into separate line elements according to
speed limits in order to do a precise sight distance analysis.

Draw Sight Distances tool can run on loaded points as well as on TerraScan project points. It
creates text elements as labels for sight distances. In addition, it can draw line elements for
short sight distances into the CAD file. These line element can then be used to classify points
close to them using the By centerline classification routine. The classification helps to identify
obstacles in the point cloud.

To draw sight distances:

1. Create a line element along the lane centerline as viewer traveling path and (optional)
another line element as target path.

2. Drape the line element(s) to the ground on the road surface.

3. (Optional) Load points into TerraScan if you want to run the tool on loaded points.

4. Select the line element that defines the viewer traveling path.

5. Select Draw Sight Distances tool.

This opens the Draw sight distances dialog:
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6. Define settings an click OK.

This starts the sight distance analysis process. The size of the text elements is determined by
the active text size settings in the CAD file. The color, line weight, and line style of lines for
short distances are determined by active symbology settings in the CAD file.

SETTING EFFECT

Use Laser points used for the sight distance
analysis process:

· Loaded points - points loaded into
TerraScan.

· Active project - points referenced by the
active TerraScan project. Not UAV

Class Point classes that are included in the sight
analysis. This should include all points on
potential obstacles. The list contains the
active classes in TerraScan.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Tolerance Radius around a straight line between
viewer and target position within which a
laser point may be considered a sight
obstacle.

Viewer height Height of the viewer above the viewer path
element.

Viewer step Distance between locations along the
viewer path element where the software
analyzes the sight of the viewer.

Target level CAD file level on which the line element is
drawn that defines the target path.

Target height Height of a target object above the target
path element.

Target step Distance between locations along the target
path element where the software analyzes
the sight towards a target object.

Maximum distance Maximum distances from the viewer
considered in the sight analysis.

Maximum angle Angle of sight forward from the viewer.
Defines the area that is analyzed regarding
sight obstacles.

Short distance Defines the maximum value of a critical
sight distance. Sight distances smaller or
equal to the given value can be labeled with
a different color in order to highlight the
locations.

Label sight distances If on, text elements are drawn into the CAD
file that label the sight distance at each
viewer position.

Level Level on which sight distance labels are
drawn.

Accuracy Accuracy of sight distance labels. Values are
rounded to the given accuracy, e.g. to the
closest 5 m value.
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SETTING EFFECT

Short color Color of short sight distance labels. Applied
to all distances smaller or equal to the given
Short distance value.

Long color Color of sight distance labels if the distance
is longer than the given Short distance
value.

No obstruction label Label of viewer positions for which no
obstruction is found.

Draw lines for short distances If on, lines are drawn from viewer to target
positions if the distance is smaller or equal
to the given Short distance value.

Level Level on which lines for short distances are
drawn.

You can undo the creation of sight distance labels and lines by using the Undo command of
the CAD platform.

Draw Sign Visibility

Draw Sign Visibility tool determines from what points a target object, such as a traffic sign,
traffic light, advertisement plate, etc., are visible. With other words, the tool also finds points
on objects that may obstruct the sight to a target object.

The process requires a shape, ellipse, or complex shape element that represents the target
object. The element must be drawn in a way that its front side faces towards the viewer. This
means, for example, that the element must be drawn in counterclockwise direction in
MicroStation. You can digitize the shape element in a section view created with the Draw
Vertical Section tool. The centerline of the section has to be at the target object’s location.

Further, the process requires a linear element drawn in driving direction that defines the path
of the viewer. For instance, a trajectory line draped on the ground elevation by the Drape
Linear Element tool can be used for this purpose. The viewer height is defined with a constant
value in the tool’s settings.

Potential obstacles for the visibility of a target object are represented in the point cloud. The
points should be classified into a ground class by using preferably the Hard surface and/or
Ground classification routines and above-ground classes. To get a reliable result from the
visibility analysis, any points below the ground, from moving objects, and noise in the air
should be classified into separate classes. These classes can be excluded from the process.

Draw Sign Visibility tool can run on loaded points as well as on TerraScan project points. The
process checks if there is any point in the point cloud close to a straight line from a viewer
position to the target object. It creates point elements as markers for each analyzed location.
The color of the marker indicates whether the target object is visible or not from the analyzed
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location. In addition, the process can draw line elements for locations from which the visibility
is obstructed into the CAD file. These line element can then be used to classify points close to
them using the By centerline classification routine. The classification helps to identify obstacles
in the point cloud.

To analyze sign visib ility :

1. Create a line element along the lane centerline as viewer traveling path.

2. Drape the line element(s) to the ground on the road surface.

3. Digitize a shape element that represents the target object.

4. (Optional) Load points into TerraScan if you want to run the tool on loaded points.

5. Select the line element that defines the viewer traveling path.

6. Select Draw Sign Visibility tool.

This opens the Draw Sign Visibility dialog:

7. Define settings an click OK.
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8. Identify the target object by placing a data click close to the shape element in the section
view.

9. Accept the selection with another data click.

This starts the visibility analysis process and draws the visibility markers into the CAD file. An
information dialog shows the success of the process.

SETTING EFFECT

Check Determines the area on the target object
that is checked for visibility:

· Sign center point - the center point of the
target object shape.

· All sign vertices - the vertices of the
target object shape and thus, the
complete target object area.

Use Laser points used for the visibility analysis
process:

· Loaded points - points loaded into
TerraScan.

· Active project - points referenced by the
active TerraScan project. Not UAV

Class Point classes that are included in the
visibility analysis. This should include all
points on potential obstacles. The list
contains the active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Tolerance Radius around a straight line between
viewer and target position within which a
laser point may be considered an obstacle.

Viewer height Height of the viewer above the viewer path
element.

Viewer step Distance between locations along the
viewer path element where the software
analyzes the visibility of the target object
and places a visibility marker.

Maximum distance Maximum distances from the target object
considered in the visibility analysis.

Maximum angle Angle off from the normal direction of the
target object shape. Defines the area that is
analyzed regarding visibility obstacles.
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SETTING EFFECT

Short distance Defines the maximum value of a critical
sight distance. Sight distances smaller or
equal to the given value can be labeled with
a different color in order to highlight the
locations.

Draw unobstructed spots If on, point elements are drawn into the
CAD file that mark locations of unobstructed
visibility. The markers are drawn on the
given Level and with the given Color.

Draw obstructed spots If on, point elements are drawn into the
CAD file that mark locations of obstructed
visibility. The markers are drawn on the
given Level and with the given Color.

Draw obstructed lines If on, lines are drawn from viewer position
to target object if the visibility is
obstructed. The lines are drawn on the
given Level and using the active symbology
settings of the CAD platform.

You can undo the creation of sign visibility markers and lines by using the Undo command of
the CAD platform.

Draw Slope Arrows

Draw Slope Arrows tool computes the slope along an alignment element of a road. The
computation can be done for the side slope of road lanes (representing the superelevation of
the lane) or for the longitudinal slope of the road. The tool draws arrows which show the
direction of the slope and text labels that show the gradient of the slope.

The tool requires a line string as alignment element. This is usually the approximate center line
of the road which can be derived, for example, from the trajectory lines. The alignment
element determines the longitudinal direction of the road as well as the horizontal location of
the slope arrows. The elevation of the alignment element does not effect the slope arrows.

The elevation of the slope arrows is fitted to laser points on the road surface. Thus, these laser
points should be classified into a separate class by using preferably the Hard surface
classification routine. The gradient of a slope arrow is computed from the elevation values of
the start and end points of the arrow element.

The tool requires points loaded into TerraScan. However, the same process can be performed
for a TerraScan project using the Compute slope arrows macro action and then, reading the
slope arrows from text files using the Read / Slope arrows command.
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To draw slope arrows:

1. Load laser points into TerraScan. Only points on the road surface are required.

2. Select the alignment element with any Selection tool.

3. Select Draw Slope Arrows tool.

This opens the Draw Slope Arrows dialog:

4. Define settings and click OK.

This starts the process. The software draws arrows and text elements along the alignment
element wherever it finds laser data. The level, line weight, line style, and text size of the
arrow and label elements are determined by the active symbology and text size settings in
the CAD file.

An information dialog shows the number of created slope arrows.

SETTING EFFECT

Class Point class that contains points on the road
surface. Used for fitting the elevation of
slope arrows. The list contains the active
classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
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SETTING EFFECT

TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Process Area to process:

· All locations - slope arrows are created
wherever there is point cloud data
available.

· Inside active block - slope arrows are
created only inside the active block. This
excludes areas covered by neighbour
points that are loaded in addition to the
points of an active project block.

Step Distance between locations where the
software places a slope arrow.

Direction Direction of the slope arrows relative to the
alignment element or the road direction:

· Longitudinal - in road direction.

· Perpendicular - perpendicular to the road
direction.

Offset Defines the horizontal distance of the start
and end point of an arrow relative to the
alignment element. This is only one value
for Longitudinal arrows and two values for
Perpendicular arrows. The two offset values
also determine the length of slope arrows
with Perpendicular direction. Positive
offset values create slope arrows to the
right side of the alignment element,
negative values to the left side.

Length Length of slope arrows with longitudinal
direction. This is only active if Direction is
set to Longitudinal.

Fit depth Depth of a section in the point cloud data
where the software fits the arrow to the
points on the road surface.

Fit tolerance Tolerance value for fitting the arrow to the
points. Relates to the noise in the data.

Label unit Unit for expressing the slope gradient:
Degree or Percentage.

Label decimals Number of decimals for slope labels.

Arrowhead length Length of the arrow head as part of the
slope arrow.
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SETTING EFFECT

Arrowhead width Width of the arrow head.

Flat color Color of a slope arrow if the slope gradient
is less or equal to the given value.

Normal color Color of a slope arrow if the slope gradient
is between the given flat and steep values.

Steep color Color of a slope arrow if the slope gradient
is larger than the given value.

You can undo the creation of slope arrows by using the Undo command of the CAD platform.

Find Automatic Breaklines

Find Automatic Breaklines tool is used for fully-automatic breakline detection along roads. The
tool creates 3D breaklines based on dense loaded laser points. The laser points on the road
surface should be classified into a separate class by using preferably the Hard surface
classification routine.

The detection works for breaklines along slope changes, for example along the crown of a
straight road. After automatic breakline detection, you probably need to check and manipulate
the breaklines manually.

To find road breaklines automatically :

1. Load laser points into TerraScan. Only points in the class for road breakline detection are
required.

2. Select Find Automatic Breaklines tool.

This opens the Find Automatic Breaklines dialog:
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3. Define settings and click OK.

This starts the breakline detection process. The software draws breakline elements if it finds
a slope change in the loaded laser points.

SETTING EFFECT

Ground Point class that contains points on the road
surface. Used for breakline detection. The
list contains the active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground field.

Step size Distance between locations where the
software tries to find a slope change in the
laser data in order to insert a vertex for a
breakline element.

Find slope changes If on, the software detects slope changes
in the laser data.

Min change Minimum change in slope gradient. Given
in degree.

Min length Minimum length of a breakline element.

Thin accuracy Defines the degree of thinning applied to a
breakline element. A vertex is removed, if
the location of the line does not change
more than the given value.

Level CAD file level on which the breakline
elements are drawn.

Symbology Color, line weight, and line style of the
breakline elements. Uses the active color
table and standard line weights and styles
of the CAD file.

Find Paint Lines

Find Paint Lines tool is used for automatic paint line digitization on roads. The tool creates 3D
line elements based on a loaded and pre-classified point cloud. Points on the road surface
should be classified into a separate class by using preferably the Hard surface or Ground
classification routine. In the digitization process, another macro may be included that is
executed on a temporary copy of the loaded points. It may, for example, classify points with a
bright intensity (= points on paint markings) into a separate class that is then used for paint line
digitization. This classification is not applied to the loaded points.
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The digitization process results in 3D line elements for paint markings. They may be modified
with CAD tools or convertied into polygon elements using the Place Paint Line tool.

To find paint lines automatically :

1. Load a point cloud into TerraScan.

2. (Optional) Select linear or polygon elements in order to limit the area for processing.

3. Select Find Paint Lines tool.

This opens the Find Paint Lines dialog:

3. Define settings and click OK.

This starts the paint line digitization process. The software draws the line elements on the
active layer using the active symbology settings of the CAD file.

SETTING EFFECT

Macro Macro file that is executed before the paint
line detection starts. Click on the Browse
button in order to select a macro file in a
standard dialog.

Bright class Point class(es) containing points on paint
markings and used for paint line
digitization.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Bright class field.

Approx width Approximate width of a paint line measured
in the point cloud.

Find Defines the area for searching paint lines:
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SETTING EFFECT

· Anywhere - the whole area covered by
loaded points.

· Inside fence - within a selected polygon
or fence element Microstation only

· Along selected vectors - within a given
corridor along linear elements.

Within Offset from selected linear elements that
defines the corridor for the search. This is
only active if Find is set to Along selected
vectors.

Within Maximum angular difference between a
selected linear element and the paint lines
to be detected along this element. This is
only active if Find is set to Along selected
vectors.

Min length Minimum length of a paint line element.

Find Road Breaklines

Find Road Breaklines tool is used for semi-automatic breakline detection along roads. The tool
requires 2D line elements that run approximately along road breakline locations, for example
close to the road center for crown of the road detection and close to the road edge for edge of
pavement or curb stone detection. Based on that, the software searches the best 3D breakline
close by.

The semi-automatic detection works for the following road breakline types:

· edge of pavement - runs along the edge of the road pavement.

· curb stone - runs along the curb stone edge of a road/sidewalk. A curb stone is defined as
edge with a vertical elevation jump at the same XY location.

· crown of the road - runs along the crown of the road formed by a small slope change.

· planar surface

· section centerline - runs along the center of cross sections along the road.

· section breakline - runs along the edge of cross sections along the road.

The parameters for 3D breakline creation are defined for each breakline type.

The process requires dense laser points loaded in TerraScan. The laser points on the road
surface should be classified into a separate class by using preferably the Hard surface
classification routine. Further, the breakline placement along pavement edges benefits from
color values assigned to the laser points.

After automatic breakline detection, you probably need to check and manipulate the
breaklines manually.
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To find road breaklines:

1. Load laser points into TerraScan. Only points in the class for road breakline detection are
required.

2. Select Find Road Breaklines tool.

This opens the Find Road Breaklines dialog:

3. Select Add command from the Feature pulldown menu in order to define a new feature for
road breakline detection.

You can modify an existing feature by selecting the feature and using the Edit command from
the Feature pulldown menu. To delete a feature, select the Delete command from the
Feature pulldown menu.

Add and Edit commands open the Road Feature dialog. The settings in the Road Feature
dialog partly depend on the selected breakline type.
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4. Define settings and click OK.

The feature is added to the list in the Find Road Breaklines dialog.

5. Repeat steps 3 to 4 for all road breakline features you want to detect.

6. (Optional) Save the road feature definitions into a text file using the Save as command from
the File pulldown menu. You can save changes to an existing text file by selecting the Save
command from the File pulldown menu.

7. Click Execute in order to run the breakline detection.

This starts the breakline detection process. The software draws breakline elements if it finds
the 3D location of the breakline features in the loaded laser points.

SETTING EFFECT

Description Descriptive name of the road feature.

Source level CAD file level, on which the line elements
are drawn that define the approximate
location of the breakline feature.
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SETTING EFFECT

Breakline type Type of the breakline feature:

· Crown of the road - runs along a small
slope change.

· Left curb stone - runs along a curb stone
on the left side of a road.

· Right curb stone - runs along a curb stone
on the right side of a road.

· Left edge of pavement - runs along the
edge of pavement on the left side of a
road.

· Right edge of pavement - runs along the
edge of pavement on the right side of a
road.

· Planar surface

· Section centerline - runs along the center
of cross sections along the road.

· Section breakline - runs along the edge of
cross sections along the road.

Fit to class Point class that contains points on the road
surface. Used for breakline detection. The
list contains the active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Fit to class field.

Result within Maximum horizontal offset between the
approximate line element and the true
breakline location. This is not available if
Breakline type is set to Left curb stone or
Right curb stone.

Plane width Width of a plane next to the breakline
location. One value applies for the left and
right side for Crown of the road and Planar
surface features. There are two values for
Left/Right edge of pavement features, one
for the pavement side and another for the
outside-road side. This is not available if
Breakline type is set to Section centerline or
Section breakline.

Slope change Minimum change in slope gradient. Given in
degree. This is only available if Breakline
type is set to Crown of road.
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SETTING EFFECT

Length Minimum length of a breakline element.
This is only available if Breakline type is set
to Crown of road.

Use color If on, the software uses RGB color values
assigned to laser points in order to find the
breakline location. This is only available if
Breakline type is set to Left/Right edge of
pavement.

Fit tolerance Tolerance value for fitting the breakline
element into the laser points. Relates to the
noise in the data. This is only available if
Breakline type is set to Section centerline.

Step Distance between consecutive cross
sections along the road used for fitting the
line element to the laser points. This is only
available if Breakline type is set to Section
centerline.

Percentile This is only available if Breakline type is set
to Section centerline.

Max offset Maximum horizontal offset between the
approximate line element and the true
breakline location. This is only available if
Breakline type is set to Section breakline.

Smoothing Defines the degree of smoothing applied to
a breakline element:

· None - no smoothing.

· Normal - a bit smoothing.

· Aggressive - maximum smoothing.

Thin If on, a vertex is removed, if the location of
the line does not change more than the
given value.

Result level CAD file level on which the breakline
elements are drawn.

Color Color of the breakline elements. Uses the
active color table of the CAD file.

Weight Line weight of the breakline elements. Uses
the standard line weights of the CAD file.

Style Line style of the breakline elements. Uses
the standard line styles of the CAD file.
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Fit Geometry Components
Not Lite, Not UAV

Fit Geometry Components tool starts the component fitting module of TerraScan. The module
creates design geometry built from the geometry components lines, arcs, and clothoids. The
aim is to create a geometry from these components that forms the best match to a surveyed
alignment of a road, a railroad, or a pipeline. The module finds the best fit for both horizontal
and vertical geometry.

The module and the creation of geometry components serves different purposes:

· Data exchange - view the current geometry of a road/railroad/pipeline in design software
such as Bentley InRoads, Bentley Track, etc and/or export the geometry into LandXML or
Tekla 11/12 format. Design software may only accept certain geometry components for
linear features.

· Road surface analysis - find long span deformations of road surfaces.

· Object design comparison - compare existing object geometry components with design
recommendations.

The tool starts from a 3D centerline element that can be created, for example, based on ALS or
MMS data.

To start the component fitting module of TerraScan:

1. Use the any Selection tool in order to select a centerline element that represents the
surveyed object.

2. Select the Fit Geometry Components tool.

This starts the module and opens the Components Fitting window.

The processing workflow for component fitting and the commands of the window are
explained in detail in Chapter Fit Geometry Components.

Import Road Breaklines
Not Spatix

Import Road Breaklines tool converts linear elements from an artificial coordinate system into
geographic coordinates. It is used in combination with digitized lines based on TerraScan
section points which are produced by the Write section points macro action.

The line elements are digitized in an artificial coordinate system in a separate CAD file. The
artificial coordinate system is defined by:

· X axis - scaled stations along an alignment element.

· Y axis - offset from an alignment element.

· Z axis - scaled elevation values of the original point cloud data.
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The tool converts these artificial XYZ coordinates back to Easting, Northing, Elevation
coordinates. It utilizes the same alignment element and inverse scaling factors as were used for
producing the section points.

To import road breaklines:

1. Attach the section CAD file as a reference to the normal project CAD file.

2. Open two top views, one showing the location of the road and the alignment element used
for creating section points, and the other one showing the digitized lines in the attached
reference CAD file.

3. Select the alignment element using any Selection tool.

4. Draw fence around the lines in the reference CAD file.

5. Select Import Road Breaklines tool.

This opens the Import Road Breaklines dialog:

6. Define settings. The values must be the same as used for creating the section points with the
Write section points macro action in order to compute correct coordinate values for the
breakline elements.

7. Click OK.

This converts the lines inside the fence from the artificial coordinates to the original
coordinates and draws them into the master CAD file.

SETTING EFFECT

Stations Scale factor along the alignment element.
Used for decompressing the digitized lines to
their normal length.

Elevations Scale factor for elevation values. Used for
resolve the exaggeration of elevation values
of the digitized lines.

At the moment, reference files and thus, the Import Road Breaklines tool can only be
handled in MicroStation. There is not yet a comparable concept in Spatix.
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Label Alignment Curvature

Label Alignment Curvature tool computes the radius of curves of 3D line elements. It places
text elements that show the horizontal or vertical curvature radius.

For roads, the curvature radius determines the best value for the side slope inside a curve.
Therefore, the tool supports the analysis of road surface properties.

The tool requires an alignment element, which can be the centerline of a road, railroad, etc.
derived from trajectory lines or any other representative line element.

To create labels for the radius of curves:

1. Select the alignment element with any Selection tool.

2. Select Label Alignment Curvature tool.

This opens the Label Alignment Curvature dialog:

3. Define settings.

4. Place a data click inside a CAD view.

This creates the curvature labels. The software draws text elements along the alignment
element. The level, color, and text size of the labels are determined by the active symbology
and text size settings in the CAD file.

An information dialog shows the number of created curvature labels.

SETTING EFFECT

Compute Curvature to compute: Horizontal curvature or
Vertical curvature.

Label every Distance between locations along the
alignment element where the software places
a curvature label.
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SETTING EFFECT

Fit length Length of an interval along the alignment
element from which the software computes
the curvature radius. From each labeling
point, the software uses half of the given
length forward and backward along the
element and fits a circle. The radius of the
circle determines the curvature radius at this
labeling point.

Max value Maximum curvature radius that is labeled.

Big value text Text used for radius values larger than the
given Max value.

Accuracy Accuracy of curvature labels. Values are
rounded to the given accuracy, e.g. to the
closest 10m value.

Position Determines the placement location of the
labels relative to the alignment element:

· On alignment - on the alignment element.

· Left - left of the alignment according to
digitization direction.

· Right - right of the alignment according to
digitization direction.

· Inside - on the inside of a curve.

· Outside - on the outside of a curve.

Rotation Determines the placement rotation of the
labels relative to the alignment element:

· Along alignment - reading direction is
parallel to the alignment.

· Across alignment - reading direction is
perpendicular to the alignment.

Sign Sign added in front of the curvature radius
value:

· No sign - no sign is added.

· Left negative - a minus sign is added to left-
hand curves.

· Right negative - a minus sign is added to
right-hand curves.

You can undo the creation of curvature labels by using the Undo command of the CAD
platform.
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Label Clearance

Label Clearance tool labels the smallest distance between two point classes within a given
area. The area is defined by one or more selected polygons.

The tool expects that a distance from ground value is computed for the points in the source
class for clearance analysis. The value can be computed by using the Compute distance
command for loaded points or the Compute distance macro action. Within each polygon, the
tool finds the point with the smallest distance value in the source class. It classifies the point,
and draws a line marker and a text element into the CAD file. The vertical line marker marks the
location of the smallest distance. The text element shows the corresponding distance value.

The readability of the text element is determined by a given rotation setting. It is either
readable in top views or in section views. If trajectory information is loaded into TerraScan, the
text is automatically rotated in the direction of the system movement. If no trajectory
information is available, the text can be rotated according to the drawing direction of the
polygon that defines the area for clearance analysis. For example, if the first edge of the
polygon is drawn in East-West direction, the text element is rotated to be readable in East-
West direction.

The Label Clearance tool runs on points loaded into TerraScan.

To label the clearance:

1. Draw a polygon around each location for which to label the clearance.

2. Select all polygons for which to label the clearance.

3. Select the Label Clearance tool.

This opens the Label Clearance dialog:

4. Define settings.

5. Confirm the polygon selection with a data click inside a view.

This classifies the point with the smallest distance value inside each polygon. In addition, it
creates a text element showing the distance value and a vertical line element showing the
location of the smallest distance. The text and line elements are drawn on the active level
using active symbology settings of the CAD file.
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SETTING EFFECT

From class Point class(es) from which to detect the
smallest distance value.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class into which the point with the
smallest distance value is classified. The list
contains the active classes in TerraScan.

Decimals Amount of decimals shown in the label of
the smallest distance. Zero to three
decimals are available.

Rotation Determines the readability of the label:

· Top - the text element is readable in a top
view with north direction being up.

· Rotated top - the text element is readable
in a top view. It is rotated horizontally in
drive/flight direction (if trajectory
information is loaded into TerraScan) or in
the direction of the first edge drawn for
the polygon.

· Cross section - the text element is
readable in a cross section view. The
viewing direction is in drive/flight
direction (if trajectory information is
loaded into TerraScan) or in the direction
of the first edge drawn for the polygon.

You can undo the labelling of clearance by using the Undo command of the CAD platform
(text and line placement) and the Undo command from the Point pulldown menu of
TerraScan (point classification).

Mark Elements By Centerline

Mark Elements By Centerline tool can be used for detecting linear elements close enough or
closest to selected centerline elements. Detected elements are moved to another CAD file
layer.

To mark elements close to a centerline:

1. Select the centerline element(s).

2. Select the Mark Elements By Centerline tool.
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The Mark Elements By Centerline dialog opens:

3. Select settings.

4. Confirm the process with a data click inside a CAD view.

This detects the elements that fulfill the conditions and moves or copies them to the given
CAD file layer.

SETTING EFFECT

Mode Action performed for detected elements:

· Move to another level - elements are
moved to the given target level. The original
elements are removed.

· Copy to another level - elements are copied
to the given target level. The original
elements are kept.

From level Source level on which the elements are
drawn.

To level Target level to which the detected elements
are moved or copied.

Mark elements Determines which elements are marked:

· All - all elements that fulfill the conditions.

· Closest - 

· Closest two - 

Left offset Distance to the left of the centerline element
within which elements are detected.

Right offset Distance to the right of the centerline
element within which elements are detected.

Step Distance interval along the centerline
element at which the software checks for
elements to detect.



TerraScan User Guide  © 2023 Terrasolid Ltd

343TerraScan Toolbox > Roads and Railroads > Road toolbox

Output Paint Report

Output Paint Report tool writes statistics of selected paint marking elements to text format.
Statistics include the count of markings, and total area of markings. Statistics are reported
separately per each marking type and CAD level.

To report paint markings:

1. Select paint marking vector elements with any Selection tool

2. Select Output Paint Report tool.

This opens the Paint report.

3. Click File / Save as text or File / Print to store the report

Place Crosswalk

Place Crosswalk tool can be used for the digitization of crosswalk paintings on a road. The tool
supports the placement of shapes for the paint lines that form a crosswalk. It relies on
crosswalk templates that are defined in the Road paint markings / Crosswalks category of
TerraScan Settings.

When a crosswalk is digitized, the user defines the 4 outer corners of the crosswalk drawing.
Then, the software derives the number of paint lines and adjusts them evenly between the
outer boundaries. The width of the paint lines is defined in the template. The spacing between
the paint lines is slightly adjusted, so it may differ a bit from the template definition. The
length of the paint lines is defined by the first two data clicks and equal for all shapes.
Therefore, if a crosswalk drawing includes paint lines of different length, you may use the tool
several times to place the shapes. The lines of crosswalk paintings may also be transversely
displaced. Then, the tool derives the displacement from the 4 data clicks defining the corners.

To place a crosswalk drawing:

1. Select the Place Crosswalk tool.

The Place Crosswalk dialog opens:
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2. Select a Crosswalk template and define settings.

3. Define the 4 outer corner points of a crosswalk with data clicks as shown in the sketch above
(red circles and number 1-4 indicate the data clicks).

The shape of the crosswalk is displayed at the given location.

4. Place another data click inside the CAD view in order to confirm the crosswalk drawing.

This creates individual shape elements for each paint line of the crosswalk. You can modify
the shapes using CAD tools.

SETTING EFFECT

Crosswalk Name of the crosswalk template.
Alternatively, Free definition can be
selected in order to define the crosswalk
shape individually.

Width Width of the paint lines forming the
crosswalk. This is only active if Crosswalk is
set to Free definition.

Spacing Distance between the paint lines of the
crosswalk. This is only active if Crosswalk is
set to Free definition.

Elevation Determines how the Z value for the
crosswalk drawing is defined:
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SETTING EFFECT

· Mouse click - the current mouse pointer
elevation is used. This results in a 2D-like
drawing.

· Fit using point cloud - a single plane
equation is used to fit the crosswalk
drawing to the point cloud. This results in
a 3D-like drawing.

· <surface model> - a single plane equation
is used to fit the crosswalk drawing to a
surface model loaded in TerraModeler.
This results in a 3D-like drawing.

Class Point class(es) from which to derive the
elevation of the drawing. This is only active
if Elevation is set to Fit using point cloud.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Place Paint Line

Place Paint Line tool can be used for the digitization of paint lines along a road. The tool
supports the manual placement of shapes for dashed or continues paint lines in the center or
along edges of roads. It can be used to place straight lines but also to digitize line strings similar
to the Place railroad string tool.

Alternatively, the tool can also be used to convert selected line elements into polygon
elements.

To place a paint line drawing manually :

1. Select the Place Paint Line tool.

The Place Paint Line dialog opens:
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2. Define settings.

3. Start the digitization at one end point of a paint line with a data click.

The shape of the paint line is displayed dynamically from the given location to the mouse
pointer position.

If Create is set to Long chain, the application draws a dynamic rectangle whenever you start
the digitization of a line string. If you place a data click outside the rectangle, the application
pans the view in the direction of the data click. If Rotate view when panning is switched on,
the view is also rotated in the direction of the data click. If you place a data click inside the
rectangle, you add a new vertex to the line string.

4. Place another data click to define the next point of the paint line.

If Create is set to Short line, this finishes the paint line drawing.

If Create is set to Long chain, this defines an intermediate vertex of a line string. You can
continue with step 4. Place a reset click in order to end a paint line drawing.

This creates individual shape elements for each paint line (dash). You can modify the shapes
using CAD tools.

SETTING EFFECT

Line type Defines the type of a paint line drawing:

· Centerline - line or line string element.

· Continuous polygon - one polygon
element.

· Dashed polygons - one or more polygons
forming a dashed line.

Width Width of the paint line. This is only active if
Line Type is set to Continuous polygon or
Dashed polygons.

Length Length of a paint line dash. This is only
active if Line Type is set to Dashed
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SETTING EFFECT

polygons.

Gap Distance between paint line dashes. This is
only active if Line Type is set to Dashed
polygons.

Elevation Determines how the Z value for the
crosswalk drawing is defined:

· Mouse click - the current mouse pointer
elevation is used. This results in a 2D-like
drawing.

· Fit using point cloud - a single plane
equation is used to fit the crosswalk
drawing to the point cloud. This results in
a 3D-like drawing.

· <surface model> - a single plane equation
is used to fit the crosswalk drawing to a
surface model loaded in TerraModeler.
This results in a 3D-like drawing.

Class Point class(es) from which to derive the
elevation of the drawing. This is only active
if Elevation is set to Fit using point cloud.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Create Line type to create:

· Short line - a straight line defined by two
end points.

· Long chain - a line string that may contain
intermediate vertices.

Detail view An optional view which is synchronized
with the view used for placing the mouse
clicks. This is only active if Create is set to
Long chain.

Rotate view when panning If on, the view is rotated in the direction of
the data click. This is only active if Create is
set to Long chain.

Undo last Deletes the last vertex that was placed. The
undo action can be applied several times.
This is only active if Create is set to Long
chain.
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To convert a line string into a polygon drawing:

1. Select line string element(s). 

2. Select the Place Paint Line tool.

The Place Paint Line dialog opens:

3. Define settings.

4. Place a data click inside a CAD view in order to confirm the conversion.

This creates polygon elements from all selected line elements. The original line elements
are kept in the CAD file.

Place Paint Marking

Place Paint Maring tool can be used for the digitization of paint markings, such as arrows or
parking lot drawings on a road. The tool supports the placement of standard shapes for the
paint markings. It relies on paint marking templates that are defined in the Road paint markings
/ Paint markings category of TerraScan Settings.

When a paint marking is digitized, the user defines the origin point and rotation of the marking.
Then, the software places the drawing as defined in the template.

To place a paint marking drawing:

1. Select the Place Paint Marking tool.

The Place Paint Marking dialog opens:

2. Select the Group of the paint marking and define settings.
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3. Place the origin point of the paint marking with a data click.

The shape the selected Marking or of the first paint marking in the Group as defined in the
Settings is displayed at the given location.

4. If Marking is set to Choose with mouse click, move the mouse pointer. The shapes of the
different marking templates of the group are shown at the origin location as you move the
mouse. When the correct template is shown, place a data click in order to confirm the
template.

5. Move the mouse pointer in order to rotate the template.

6. Place another data click in order to confirm the paint marking drawing.

This draws the paint marking as cellMicrostation/symbolSpatix element in the CAD file. You can drop
and modify the element using CAD tools.

SETTING EFFECT

Group Name of the paint marking group. The list
includes all groups defined in the Paint
markings category of TerraScan Settings.

Marking Name of the paint marking template to
draw:

· Choose with mouse click - the paint
marking is defined by moving the mouse
after placing the origin point. This makes
the template selection flexible if you do
not know the exact name of a paint
marking.

· <name> - name of a paint marking
template as defined in the Paint markings
category of TerraScan Settings.

Elevation Determines how the Z value for the
crosswalk drawing is defined:

· Mouse click - the current mouse pointer
elevation is used. This results in a 2D-like
drawing.

· Fit using point cloud - a single plane
equation is used to fit the crosswalk
drawing to the point cloud. This results in
a 3D-like drawing.

· <surface model> - a single plane equation
is used to fit the crosswalk drawing to a
surface model loaded in TerraModeler.
This results in a 3D-like drawing.

Class Point class(es) from which to derive the
elevation of the drawing. This is only active
if Elevation is set to Fit using point cloud.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Place Paint Stripes

Place Paint Stripes tool can be used for the digitization of crosswalk paintings on a road. The
tool supports the placement of shapes for the paint lines that form a regular stripe pattern.

When a stripe pattern is digitized, the user defines the 4 outer corners of the pattern drawing.
Then, the software derives the number of paint lines and adjusts them evenly between the
outer boundaries. The width of the paint lines is defined in the tool settings. The spacing
between the paint lines is slightly adjusted, so it may differ a bit from the definition. The
length of the paint lines is defined by the first two data clicks and equal for all shapes.
Therefore, if a stripe pattern includes paint lines of different length, you may use the tool
several times to place the shapes. The lines of a stripe pattern may also be transversely
displaced. Then, the tool derives the displacement from the 4 data clicks defining the corners.

To place a paint stripe drawing:

1. Select the Place Paint Stripes tool.

The Place Paint Stripes dialog opens:
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2. Define settings.

3. Define the 4 outer corner points of a paint stripe pattern with data clicks as shown in the
sketch above (red circles and number 1-4 indicate the data clicks).

The shape of the paint stripe pattern is displayed at the given location.

4. Place another data click inside the CAD view in order to confirm the paint stripe drawing.

This creates individual shape elements for each paint line of the paint stripe pattern. You can
modify the shapes using CAD tools.

SETTING EFFECT

Width Width of the paint lines forming the stripe
pattern.

Spacing Distance between the paint lines of the
stripe pattern.

Elevation Determines how the Z value for the
crosswalk drawing is defined:

· Mouse click - the current mouse pointer
elevation is used. This results in a 2D-like
drawing.

· Fit using point cloud - a single plane
equation is used to fit the crosswalk
drawing to the point cloud. This results in
a 3D-like drawing.

· <surface model> - a single plane equation
is used to fit the crosswalk drawing to a
surface model loaded in TerraModeler.
This results in a 3D-like drawing.

Class Point class(es) from which to derive the
elevation of the drawing. This is only active
if Elevation is set to Fit using point cloud.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Place Paint Symbol Row

Place Paint Symbol Row tool can be used for the digitization of paint markings on a road, such as
symbols arranged in rows. The tool supports the manual placement of shapes for symbol rows.
All symbols of one paint marking drawing have the same shape size and spacing.
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To place a paint symbol row:

1. Select the Place Paint Symbol Row tool.

The Place Paint Symbol Row dialog opens:

2. Define settings.

3. Start the digitization at one corner point of a symbol row with a data click.

The shape of the symbol row is displayed dynamically from the given location to the mouse
pointer position. You may adjust the Width, Height and Spacing settings, if necessary.

4. Place another data click to define the end point of the symbol row.

This creates individual shape elements for each symbol in the row. You can modify the
shapes using CAD tools.

SETTING EFFECT

Symbol Defines the type of a paint marking symbol:
Triangle or Rectangle.

Width Width of the symbol.

Height Height of the symbol.

Spacing Distance between the symbols.

Elevation Determines how the Z value for the
crosswalk drawing is defined:

· Mouse click - the current mouse pointer
elevation is used. This results in a 2D-like
drawing.

· Fit using point cloud - a single plane
equation is used to fit the crosswalk
drawing to the point cloud. This results in
a 3D-like drawing.

· <surface model> - a single plane equation
is used to fit the crosswalk drawing to a
surface model loaded in TerraModeler.
This results in a 3D-like drawing.
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SETTING EFFECT

Class Point class(es) from which to derive the
elevation of the drawing. This is only active
if Elevation is set to Fit using point cloud.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Write Alignment Elevations

Write Alignment Elevations tool writes elevation values derived from point cloud data along an
alignment. The process is based on the selection of two alignments, one defines the alignment
for which to write elevation values, the other provides the stationing. The first alignment
element can be, for example, a line that runs along a part of a road and is located on a lane, the
second alignment element could be the centerline of the whole road. However, both
alignments can also be derived from the same vector element.

The software fits a plane equation to the laser points at regular steps along the alignment and
derives an elevation value. The values are written into a report. Supported report formats are S
X Y Z (Station, Easting, Northing, Elevation) and ERD. The ERD file format can be read into
ProVAL, a software for road profile analysis.

To write elevations along an alignment:

1. Select Write Alignment Elevations tool.

This opens the Write Alignment Elevations dialog:

2. Define settings.

3. Select the first alignment element for which you want to write elevation values. You can
select the element by placing a data click close to it.

4. Select the second alignment element from which you want to derive the stationing. You can
select the element by placing a data click close to it.
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This derives the elevation values and opens the Alignment elevations window, a TerraScan
report window.

You can save the report as text file or send it directly to a printer by using corresponding
commands from the File pulldown menu of the report window. The size of the report
window can be adjusted by commands from the View pulldown menu.

SETTING EFFECT

Class Point class(es) from which the elevation
values are derived.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Format Report format:

· S X Y Z - Station Easting Northing Elevation

· ERD - ERD file format including a header
and the elevation values.

Title Text used as title in an ERD file. This is only
active if Format is set to ERD.

Start station Station value of the first station along the
alignment.

Station step Interval size for deriving elevation values.

Fit radius Radius around each station within which the
points are used to compute the elevation
value.

Railroad toolbox

The tools in the Railroad toolbox are used to place lines, to fit lines to classified points along
rails, to find rails and overhead wires automatically, and to check end points of overhead wires.
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TO USE TOOL

Place approximate railroad centerline Place Railroad String

Fit railroad centerline to laser points Fit Railroad String

Find rails using a rail section template Find Rails

Find overhead wires Find Wires

Check end points of overhead wires Check Wire Ends

Find poles Find Poles

Output pole information to a text file Output Poles

Check Wire Ends

Check Wire Ends tool can be used to check automatically detected wires in an organized way.
The tool opens the Check wire ends dialog which contains user controls for manipulating wires
and wire end points. It is intended to be used after automatic wire detection by Find Wires or
Find Powerline Wires tool.

The dialog shows a list that contains all wires and their end points. If a line in the list is
selected, the software updates the display in a number of CAD file views. The views must be
open and defined in the tools settings. The tool can update different view types, such as top,
section, and camera views which show either a wire completely or the end point of a wire.

To check wire end points:

1. Select Check Wire Ends tool.

This opens the Check Wire End Settings dialog:
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2. Define settings and click OK.

This opens the Check wire ends dialog.

SETTING EFFECT

Wire level CAD file level on which the lines for wires
have been drawn. All lines on this level are
added to the check list.

End top view A top view showing the end of a wire is
displayed in the given view.

End camera view A camera view showing the end of a wire in
displayed in the given view. This view can be
used to display images if a mission, camera,
and image list are loaded in TerraPhoto.

End profile view A longitudinal section of the end of a wire is
displayed in the given view.

Span top view A rotated top view showing a wire
completely in a horizontal section is
displayed in the given view.

Span profile view A longitudinal section showing a wire
completely is displayed in the given view.

Approve moves If on, the line of an approved wire is moved
to the level defined in the To level list.
If off, the level of approved wires remains
unchanged.

https://terrasolid.com/guides/tphoto/index.html
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SETTING EFFECT

Approve modifies If on, the line color of an approved wire is
modified to the given Color. The list contains
the active color table of the CAD file.
If off, the color of approved wires remains
unchanged.

Remove moves If on, the line of a removed wire is moved to
the level defined in the To level list.
If off, the level of removed wires remains
unchanged.

Remove modifies If on, the line color of an removed wire is
modified to the given Color. The list contains
the active color table of the CAD file.
If off, the color of removed wires remains
unchanged.

Check Wire Ends

The Check Wire Ends dialog shows a list that contains all wires and their end points. For each
wire, there is a number and two end points. The status of each wire end point is Need to check
by default.

Further, the dialog contains buttons that can be used to manipulate wire lines, to change the
status of a wire in the list, and to display wire end locations. You can add intermediate vertices
to wire lines, move the end points of wire lines, delete points from wire lines, and join wire
lines in order to bridge gaps in the automatically detected wires.

If an end point of a wire is moved close to an end point of another wire which is an potential
end point for a join, the horizontal and vertical distances between the end points are shown in
the dialog.
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To show the location of a wire end point, select a line in the Check Wire Ends dialog. Click on
the Show location button and move the mouse pointer into a view. This highlights the selected
wire end point with a cross.

To identify a wire end point, click on the Identify button and place a data click close to a wire
end point in a view. This selects the corresponding line in the Check Wire Ends dialog.

After checking a wire end point and possibly improving its location, click on the Approve
button. This changes the status of the selected end point to Approved. If both end points of a
wire are approved, the wire line is moved to another level and/or the color is changed, if the
settings in the Check Wire End Settings dialog are defined accordingly.

If you want to delete a wire, you click on the Remove button. This removes the selected wire
from the list and the wire line is moved to another level and/or the color is changed, if the
settings in the Check Wire End Settings dialog are defined accordingly. The Remove button
does not delete the wire line from the CAD file.

To modify wire lines and their end points, you can use the other buttons of the dialog as
described below. You can undo the modification of wires by using the Undo command of the
CAD platform.

To add a vertex to a wire:

1. Select the wire in the list.

2. Click on the Add point button and move the mouse pointer into a view, preferably a section
view.

This dynamically displays the new vertex and wire line at the mouse pointer location.
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3. Define the location of the new vertex by a data click.

You can continue with step 3. The software lets you place only intermediate vertices for the
selected wire.

To move an end point of a wire:

1. Select the wire end point in the list.

2. Click on the Move point button and move the mouse pointer into a view.

This dynamically displays the new end point and the wire line at the mouse pointer location.

3. Define the location of the new end point by a data click.

You can continue with step 3. The software lets you move only the selected wire end point.

To delete a point of a wire:

1. Select the wire in the list.

2. Click on the Delete point button and move the mouse pointer into a view.

This dynamically highlights the point on the wire closest to the mouse pointer location.

3. Delete the point by a data click.

You can continue with step 3. The software lets you delete end points and intermediate
vertices of the selected wire.

To jo in wires:

1. Select a wire in the list.

2. Click on the Join button and move the mouse pointer into a view.

This dynamically displays possible connection lines for the selected wire at the mouse
pointer location.

3. Move the mouse pointer close to the end point of the wire to which you want to join the
selected wire.

4. Confirm a connection line by a data click.

This joins two wire lines. If the status of the effected wires was already Approved, it is set
back to Need to check.

Manual changes of the wire lines do not effect the classification of laser points. If you want
to refine the classification of laser points on wires, you can run a By centerline classification
using the wire lines as centerlines with offset and elevation difference settings of ± a few
centimeters.
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Find Poles
Limited in Spatix

Find Poles tool is used for the automatic detection of pole objects based on point clouds. This
makes sense if you need to detect and possibly vectorize a large amount of identical poles or
other objects from a point cloud. It requires a few preparation steps, such as pre-classification
of the point cloud and the definition of a sample object for each pole type to detect. Therefore,
it is probably not the fastest solution for detecting and vectorizing just a few poles.

The steps for defining a sample object are described in the Object library category of TerraScan
Settings.

Any overlapping strips in the laser data must be matched and overlap should be cut off before
running the object detection. It is required to do a  classification of the point cloud in order to
separate points on potential objects from other points. This includes ground classification,
computation of distance from ground, and above-ground classification by distance.
Furthermore, it is required to assign groups in order to detect objects.

The object detection can be supported by an alignment element. A trajectory line drawn in the
CAD file can be used as alignment. The object definition defines whether an object is located
left or right of the alignment or, with other words, whether the scanner system was driven on
the left side or right side of the object. It is recommended to use an alignment in order to
speed up object detection significantly. In addition, the alignment element can be used to
classify point groups by centerline. This classifies potential objects within an offset from the
alignment into a separate class and thus, reduces the amount of data for the object detection.

In the object detection process, the software compares point groups in the project data set to
point groups in the object library by testing different 3D rotations. If a match is found, it
classifies the point group into the target class specified in the object definition. In addition, it
can place cell elements in the CAD file. An example workflow for creating a cell element is
provided in Object library category of TerraScan Settings. Cells are stored in cell libraries. A cell
library must be attached to the CAD file before cells from the library can be used. The tool
creates a copy of the orginal cell element for each detected object. The cell is shifted to the
correct object location and rotated according to the object rotation. The cell is further clipped at
ground elevation, if the corresponding setting for the object item is switched on. The extent of
the cell is not adjusted to the point cloud. If no cell library is attached or if the cell for an object
is not available, the process only classifies points.

The tool is most confident in detecting poles along roads or rail tracks that have been driven
during the data collection. All scanners of a system should see a pole from the same side. Thus,
most of the points are on the sides of the pole facing towards the road. Poles on side roads/rail
tracks or on bridges away from the data collection path are not detected automatically.

The tool requires laser points loaded into TerraScan. However, the same process can be
performed for a TerraScan project using the Find poles macro action and then, reading the pole
cells from text files using the Read / Poles command.
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To detect poles automatically :

1. Load points into TerraScan.

2. Select Scan Settings tool and open Object library category.

3. Click inside the rectangle field next to an object item in order to activate/deactivate object
items for detection. Activate object items to detect in the point cloud. Deactivate all other
object items.

4. Close the TerraScan settings dialog.

5. Draw a vertical section in one of the CAD file views.

6. (Optional, to place cells for poles) Open the Cell Library window of MicroStation and attach
the cell library that contains the cell element(s) for the objects in the point cloud. (Not Spatix)

7. (Optional, but highly recommended) Select the alignment element.

8. Select Find Poles tool.

This opens the Find Poles dialog:

9. Define settings and click OK.

This starts the detection process. The software classifies point groups into the target class
specified in the object definition and (optionally) places cell elements in the CAD file. The
cells are only placed if a cell library is attached to the CAD file and if a cell with the name
specified in the object definition is available. The cell is placed on the active level in the CAD
file.

SETTING EFFECT

Groups with Determines which groups are used for
detection:
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SETTING EFFECT

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with more
than 50 % of points in the source class.

· All points - groups with all points in the
source class.

From class Point class that contains points on static
parts of objects. These points of a group are
compared to the sample object in the object
library.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Ground class Point class that represents the ground. Used
for clipping a cell at ground elevation in the
Clip view.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground class field.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
more than 50 % of points are inside.

· All points - groups are classified if all
points are inside.

Tolerance Maximum distance between a point in the
sample object and a point from the object
to be detected in a project point cloud. The
elevation tolerance is further determined
by multiplying this value with the At center
and At edge factors given in the object item
definition.
For dense MLS point clouds, 0.1 m is the
recommended setting. A smaller value may
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SETTING EFFECT

improve the result but slow down the
process significantly. A larger value should
be used for point clouds with a lower
density. For low-altitude dense ALS point
clouds of powerlines, 0.25 m may be a good
estimate for detecting powerline towers.
The larger the value, the higher the
probability that objects are detected even
though the point group differs from the
sample object group.

Rotation Horizontal rotation of an object relative to
the alignment:

· Free - any rotation of the object is
possible. This slows down the detection
process significantly.

· From selected vectors - the object is
rotated only within the given Angle
tolerance relative to the alignment. This
is only active if an alignment element has
been selected before the tool was
started.

Angle tolerance Maximum allowed angular difference
between an object and the alignment. The
larger the angle, the slower the process.
Use a smaller value (e.g. around 3.0 deg) for
objects that have the same rotation angle
relative to the alignment, such as towers
along a straight powerline. This is only
active if Rotation is set to From selected
vectors.

Clip view CAD file view used for applying a clip mask
to the object's cell element. The view must
be a vertical section view. If Clip to ground
setting is switched on for an object in the
object item definition, the cell elements
are clipped at the elevation of the Ground
class.

You can undo the placement of cell elements for objects by using the Undo command of the
CAD platform. You can undo the classification of points for objects by using the undo
command of TerraScan.

At the moment, cells and thus, the cell placement capability of the Find Poles tool does only
work in MicroStation. There is not yet any corresponding element type in Spatix.
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Find Rails

Find rails tool is used for the automatic vectorization of rails. In ALS data, the method requires
the classification of the points on top of the rails. Then, the tool tries to find parallel linear
structures in the point cloud with a given distance (track width). In very dense MLS data, the
method is based on a track cross section definition. The tool looks at consecutive cross sections
of laser data along an alignment element. For each cross section, it tries to find the position
where a user-defined cross section profile of the track matches the best number of laser points.

The vectorization process starts from an alignment element which represents the approximate
direction (ALS) or centerline (MLS) of a rail track. Any digitized line element can be used as
alignment. You can use, for example, Draw into design command for trajectories and apply a
lever arm correction in order to derive a centerline from the trajectory. The lever arms are the
three components of the vector between the IMU and the center of the rail track.

Alternatively, for MLS data the trajectories can be used directly for the rail detection. They must
be imported with the correct system definition values for IMU misalignment. See Scanner
systems category of TerraScan Settings for more information. In addition, they must be
projected on the ground and to the center of the rail track. This can be established by applying a
lever arm correction to the original trajectories by using the Add lever arm command. In the
vectorization process based on trajectories, the software uses the roll angle of the trajectory
positions as cant (superelevation) angle of the rail track.

For MLS data, the tool further requires a cross section profile defined in TerraScan Settings. The
profile includes the two rails of a track, possibly places where there are no laser point (shadow
parts of rails), and the location of lines that the software creates in the vectorization process.
The creation of a rail track cross section is described in Rail section templates category of
TerraScan Settings.

Any overlapping strips in the laser data should be matched and overlap should be cut off before
running the rail vectorization. The By centerline classification routine should be used for an
approximate classification of the points in the track area (ALS) or on rails (MLS). You can use, for
example, the alignment element drawn in the CAD file for the classification by centerline.

The Find Rails tool runs on points loaded into TerraScan. It creates line string elements at the
location(s) defined in the cross section profile. Rail lines detected from ALS data contain a hugh
number of very dense vertices. The location of close-by vertices may vary at very short
distances. It is recommended to apply smoothing to the line elements in order to remove
locational variation. In addition, thinning should be applied in order to remove unnecessary
vertex density along the smoothed line elements.

To vectorize rails automatically :

1. Load points into TerraScan. Only points within the track area (ALS) or on and close to the rails
(MLS) are required.

2. (Obligatory for MLS, recommended for ALS) Select the alignment element with the Selection
tool of your CAD platform.

OR

https://terrasolid.com/guides/tmodel/smoothen-linear-element.html
https://terrasolid.com/guides/tmodel/thinlinearelement.html
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2. (MLS only) Load trajectories into TerraScan using the Manage Trajectories tool.

3. Select Find Rails tool.

This opens the Find Rails dialog:

4. Define settings and click OK.

This starts the vectorization process. The level, color, line weight, and line style of the lines
are determined by the active level and symbology settings of the CAD file.

Depending on the amount of laser data, the accuracy of the alignment element, and how
well the software can fit the rail track cross section to MLS data, the process may take some
time. It is recommended to test the settings for the tool with small data samples.

SETTING EFFECT

From class Point class that contains points on and close
to the rails or within the track area. Used for
fitting the rail lines. The list contains the
active classes in TerraScan.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Find using Method how rails are detected:

· Rail section - based on a cross section
definition of the track. This is
recommended for very dense point
clouds, such as MLS data, where the rail
profile is visible.

· Rail top hits - based on pre-classified
points on rail heads. This can be used with
sparse point clouds, such as ALS data,
where the rail profile is not visible.

Rail section Name of the rail track cross section. The list
contains all sections that are defined in Rail
section templates category of TerraScan
Settings. This is only active if Find using is
set to Rail section.

Find along Defines the alignment element used for the
vectorization:

· Trajectories - active trajectories in
TerraScan.

· Selected vectors - a selected line string
element.

This is only active if Find using is set to Rail
section.

Trajectories Trajectory numbers that are used for the
vectorization. Separate several numbers by
comma. Type 0-65535 for using all
trajectories. This is only active if Find along
is set to Trajectories.

Max roll Maximum value of the cant angle (= rail
track superelevation). This is only active if
Find along is set to Selected vectors. This is
only active if Find using is set to Rail
section.

Step Distance between locations along the
alignment where the software tries to fit
the rail track cross section to the loaded
points. This is only active if Find using is set
to Rail section.



TerraScan User Guide  © 2023 Terrasolid Ltd

367TerraScan Toolbox > Roads and Railroads > Railroad toolbox

SETTING EFFECT

Section depth Depth of a section in the point cloud data
where the software fits the rail track cross
section to the laser points. This is only
active if Find using is set to Rail section.

Max offset Maximum horizontal distance between the
alignment and a line element that the
software should draw as result of the
vectorization process (usually a line on the
rails or the track centerline). This is only
active if Find using is set to Rail section.

Max dz Maximum vertical distance between the
alignment and a line element that the
software should draw as result of the
vectorization process (usually a line on the
rails or the track centerline). This is only
active if Find using is set to Rail section.

Track width Distance between the two parallel rails of a
track. This is only active if Find using is set
to Rail top hits.

Min length Minimum length of a line element that is
drawn for a rail. This is only active if Find
using is set to Rail top hits.

Dz Elevation correction that is applied to
detected rail lines. This may correct a
systematic elevation bias due to noise or
mismatch in the data. This is only active if
Find using is set to Rail top hits.

Remove single rail vectors If on, lines are removed if there is no
corresponding parallel line within the track
width. This is only active if Find using is set
to Rail top hits.

Find Determines how rails are detected relative
to selected alignment element(s):

· All rails - all potential rail lines are drawn
independently of the direction.

· Parallel to alignment(s) - only rail lines
with a direction within the given Angle
tolerance to the alignment element are
drawn.

This is only active if Find using is set to Rail
top hits.

You can undo the vectorization of rails by using the Undo command of the CAD platform.
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Find Wires

Find wires tool is used for the automatic detection of overhead wires based on dense point
clouds (MLS data) or on point clouds with a consistent pattern of hits from wires (ALS data). The
tool can be used for any kind of overhead wires, such as rail or tram wires, in contrast to the
Detect Wires tools which is exclusively for the detection of powerline wires.

The detection process starts from classified laser points and, optionally, from an alignment
element which runs in the direction of the wires. Any overlapping strips in laser point clouds
should be matched and overlap should be cut off before running the wire extraction.

If data was captured by an MLS system mounted on a survey train, the overlap of parallel strips
should be cut off in a way that points from a more distant drive path can be used for the wire
detection. This leads to a more reliable result since wires are raised by the survey train in the
closest drive path. As an alternative to cutting off overlap, the By section template classification
routine can be used for classification of points from the closest drive path into a separate class.

Further, points should be classified into ground and above ground points. One of the above-
ground point classes should contain the points on wires (e.g. the high vegetation class) and is
then used as source class for the wire detection.

The Find Wires tool runs on points loaded in TerraScan. It classifies points on wires into a
separate class and creates line string elements that are fitted to the points on wires. The
software stops each wire at a small distance from its end points. The wire ends can be placed
more accurately by using the Check Wire Ends tool.

The tool requires points loaded into TerraScan. However, the same process can be performed
for a TerraScan project using the Find wires macro action and then, reading the wire lines from
text files using the Read / Wires command.

To detect wires automatically :

1. Load points into TerraScan. Only points on the wires are required.

2. (Optional) Select an alignment element with any Selection tool if you want to detect wires
running parallel or perpendicular to the alignment.

3. Select Find Wires tool.

This opens the Find Wires dialog:
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4. Define settings and click OK.

This starts the detection process. The software draws line strings wherever it is able to fit a
line to the laser data. The level, color, line weight, and line style of the lines are determined
by the active level and symbology settings of the CAD file.

SETTING EFFECT

From class Point class that contains points on the
wires. Used for fitting the lines. The list
contains the active classes in TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class into which points on detected
wires are classified.

Use points every Distance between locations along a wire
where the software tries to fit the line
element to the laser points.

Tolerance from wire Distance around a wire within which the
software uses points for fitting the line
element.

Min wire length Minimum length of a line element at a wire
location.

Max angle Maximum vertical angle off from horizontal
of a line element at a wire location.
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SETTING EFFECT

Find Defines what wires the software is
searching for:

· All wires - wires in all directions.

· Parallel to alignment(s) - wires that run
parallel to the selected alignment
element(s).

· Perpendicular to alignment(s) - wires that
run perpendicular to the selected
alignment element(s).

Angle tolerance Maximum horizontal angular difference
between the alignment and a line element
at a wire location. This is only active if an
alignment element is selected and if Find is
set to Parallel to alignment(s) or
Perpendicular to alignment(s).

Within offset Maximum horizontal distance between the
alignment and a line element at a wire
location. This is only active if an alignment
element is selected and if Find is set to
Parallel to alignment(s) or Perpendicular to
alignment(s).

You can undo the detection of wires by using the Undo command of the CAD platform
(vectorization) and the Undo command from the Point pulldown menu of TerraScan
(classification).

Fit Railroad String

Fit Railroad String tool can be used to fit a manually placed railroad centerline to classified laser
points. It is intended to be used after an approximate railroad centerline has been placed by
using, for example, the Place Railroad String tool.

After placing an approximate track centerline, you can continue as follows:

1. Classify points on rails more accurately by using Railroad classification routine with the
approximate centerline as alignment element.

This classifies points with a specific elevation pattern and within a given offset (half of the
rail width) from the alignment.

2. Use Fit Railroad String tool in order to fit the centerline to the classified points on the rails.

OR

1. Classify ground using the Ground classification routine and drape the centerline to the
ground elevation using the Drape Linear Element tool.
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2. Classify points on the rails more accurately by using the By centerline classification routine
with appropriate offset and elevation difference values.

3. Use Fit Railroad String tool in order to fit the centerline to the classified points on the rails.

The tool uses points on rails within an offset distance in order to find the best location for
the centerline. The offset depends on the width of the rail track and the initial accuracy of
the centerline elements. The offset is defined in the tool’s dialog as (0.5 * Rail width) ±
Tolerance. The elevation of the fitted centerline is derived from the elevation values of the
laser points.

To fit railroad centerlines:

1. Select the centerline element(s) using any Selection tool.

2. Select the Fit Railroad String tool.

This opens the Fit Railroad String dialog:

3. Define settings and click OK.

The application compares each selected line element with points in the given Rail class
within the given offset from the centerline. It creates a new line string element for the fitted
centerline which is drawn on the active level using the active symbology settings of the CAD
file.

SETTING EFFECT

Rail class Point class that contains points on rails.

Rail width Rail track width, distance from the center of
one rail to the center of the other rail.

Tolerance Tolerance value for the offset between
centerline and rails. This should be big
enough to compensate some locational
inaccuracy in the initial centerline and in
laser points. However, it should be less than
half of Rail width.
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SETTING EFFECT

Vertex interval Maximum distance between vertices of the
fitted centerline. Normally between 5.0 and
25.0 meters.

Smoothen curvature If on, the fitted centerline is smoothed by
balancing angular direction changes between
consecutive vertices. Normally, this should
be switched on.

Output Poles
Not Spatix

Output Poles tool creates a tabulator-delimited text file for selected pole cells. The cells must
have been placed by the Find Poles tool. The text file contains the attributes of the pole cell,
such as the name of the pole cell, XY coordinates of the pole, elevation coordinate of the pole
base point, angle off from the alignment element, and lean off from vertical.

To output pole cells:

1. Select pole cells with any Selection tool.

2. Select Output Poles tool.

This opens the Pole output file dialog, a standard Windows dialog for saving files.

3. Define a location and name for the output file. You may add an extension to the file name,
such as .CSV or .TXT. 

4. Click Save in order to save the text file.

Place Railroad String

Place Railroad String tool can be used for the digitization of line strings. The tool integrates
three types of functionality: it draws a line element and allows view panning and rotation.
Thus, it enables faster digitization compared with other CAD platform tools.

Initially, the tool was implemented for the manual placement of an approximate centerline
between two rails based on ALS data or aerial images. The centerline can be used to classify
points on rails more accurately. However, the tool is very useful for digitizing any kind of line
string.

The Tentative mouse button can be used to snap to a point loaded into TerraScan while drawing
a line string with the tool. This may be useful for digitizing a 3D line element directly. However,
in many cases it is more convenient to digitize a 2D line first and then, adjust it to the point
cloud elevation by using the Drape linear element tool.
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To place a line string:

1. Select the Place Railroad String tool.

The Place Railroad String dialog opens:

2. Define the location of the first point on the line string with a data click.

The application draws a dynamic rectangle whenever you move the mouse pointer inside the
view. If you place a data click outside the rectangle, the application pans the view in the
direction of the data click. If Rotate view when panning is switched on in the tool’s dialog,
the view is also rotated in the direction of the data click. If you place a point inside the
rectangle, you add a new vertex to the line string.

3. Digitize the complete line string.

You can click on the Undo last button in order to delete the last vertex that was placed. The
undo action can be applied several times.

4. After placing the last vertex, click on the reset button in order to finish the line string.

The lines string is drawn on the active level and using the active symbology settings of the
CAD file.

To prepare for railroad line string placement:

1. Classify potential points on rail into a separate point class using By intensity or Railroad
classification routines.

This initial classification probably includes a number of points which are not points on rails.
However, the should provide a visual impression of the railroad track location.

2. Switch on the display of the points on rails and switch off the display of all other point classes
in a top view.

3. (Optional) Define a custom line style in your CAD platform.

A recommended line style consists of two lines which are the railroad width apart from each
other. This supports the placement of parallel lines for the rails and allows viewing the
railroad string as a centerline of the track or as a pair of lines for the rails simply by switching
line styles on or off in a view.

4. Select level, color, and the custom line style as the active symbology in the CAD file.

5. Select the Place Railroad String tool and digitize the railroad string according to the
instructions above.
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Trees toolbox

Tools in the Trees toolbox are used to place, modify, and output tree cells. Tree cells can be
used to map trees of different species based on point clouds and (optional) images.

 

 

TO USE TOOL

Create tree cells from point groups Create Tree Cells

Place a single tree cell manually Place Tree Cell

Modify tree cell information Modify Tree Cells

Output tree cell information Output Tree Cells

Measure tree trunk diameters Measure Trunk Diameters

At the moment, cells and thus, the tools of the Tree toolbox do only work in MicroStation.
There is not yet any corresponding element type in Spatix.

Create Tree Cells
Not Spatix

Create Tree Cells tool places cells for trees into the CAD file. It fits the cell element to the point
cloud following two alternative methods. One method uses the points on the tree crown for
fitting, the other method points from the tree trunk. The tool requires some preparation steps:

· (For Highest point method only) Creation of 3D cell elements in a MicroStation cell library. A
tree cell should represent the stem and the crown of a tree. An example library is provided
with the TerraScan installation. The library is stored in the \CELL folder of the Terra
applications installation directory, for example C:\TERRA64\CELL\KARTTALI.CEL. It can be
used, for example, to test the tools of the Trees toolbox.

· Definition of tree species and usage of cells in Tree species category of TerraScan Settings.

· Classification of ground in the point cloud.

· Grouping and tree classification based on groups of the point cloud. Trees may be classified
using By parameters routine, By best match routine, or Trees routine. Any other way of
classifying point groups into separate tree species classes is valid.
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Create Tree Cells tool fits the cell elements to the points in a corresponding point class.
Therefore, there should be a cell element, a species definition, and a separate point class for
each tree species that you want to map.

The tool lets you define rules for mapping trees. The rules rely on the tree species definitions
in the Settings. Each rule defines the point class for tree detection and the common and
scientific names of a tree species. You can Add, Edit, and Delete rules by using the
corresponding buttons in the tool dialog.

To create tree cells:

1. (Optional) Draw a fence around the area in which you want to create tree cells.

2. Select Create Tree Cells tool.

This opens the Create Tree Cells dialog:

SETTING EFFECT

Add Add a new rule for mapping a tree species.

Edit Modify the selected rule for mapping a tree
species.

Delete Delete the selected rule.

Ground class Point class(es) that define the base point of
trees.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in the
Ground class field.
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SETTING EFFECT

Method Method of cell placement:

· Highest point - tree cell is matched to the
tree crown. The cell defined in the Tree
species category of TerraScan Settings is
used. The cell provides the XY location of
the tree crown center.

· Trunk - tree cell is matched to the tree
trunk. The cell is created automatically
from the points in the point class that is
used for mapping the tree. The cell
provides the exact XY location of the tree
trunk on the ground.

Inside fence Determines how a fence or selected
polygon(s) effect the cell placement:

· Not used - fence or selected polygons are
ignored.

· One or more points - a cell is placed if one
or more points of the tree group are inside.

· Average xy - a cell is placed if the average
xy point of the tree group is inside.

· Majority of points - a cell is placed if the
majority of points of the tree group is
inside.

· All points - a cell is placed if all points of
the tree group are inside.

3. Click on the Add button.

This opens the Class to species mapping dialog:

SETTING EFFECT

Class Point class containing points of one tree
species.

Tree Tree species. Start typing the common or
Latin (scientific) name of a tree species. If
the name is found in Tree species category
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SETTING EFFECT

of TerraScan Settings, the Latin and Common
names are displayed after you typed a few
characters.

4. Define settings and click OK.

5. Repeat steps 3 and 4 for all tree species that you want to map.

6. Define additional settings in the Create Tree Cells dialog.

7. Click OK in order to start the placement of cells.

The software places the cell elements according to the species mapping and the settings for
tree cells.

Single tree cells can be placed manually by using the Place Tree Cell tool. Use the Modify
Tree Cells tool to check and approve automatically created tree cells.

Measure Trunk Diameters

Measure Trunk Diameters tool supports the measurement of tree trunk diameters. It creates
circular elements at the location of tree trunks detected in the point cloud. The elements
represent the diameter of the trunk at the given height above the ground.

Trunk diameter measurement is most reliable done in very dense point clouds collected with a
tripod-mounted scanner or a mobile scanner system. Then, the point cloud may be thinned
during the processing workflow in order to reduce the amount of points. 

The tool requires the computation of distance above ground values as well as group assignment
(with Group by tree logic - Trunk method) for the point cloud data. The measurement may be
further supported by the computation of normal vectors.

To measure trunk diameters:

1. Select Measure Trunk Diameters tool.

This opens the Measure Trunk Diameters dialog:
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2. Define settings and click OK.

This creates circular elements at the location of the tree trunk measurement. The elements
are placed on the active level using the active symbology of the CAD file. They may be
modified using CAD tools.

SETTING EFFECT

Groups with Determines which groups are considered:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

Class Point class(es) that include the tree trunks.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in the
Class field.

Inside fence Determines how a fence or selected
polygon(s) effect the trunk measurement:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.
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SETTING EFFECT

At height Height from ground at which the trunk
diameter is measured.

Diameter Formula for computing the tree diameter.

Tolerance Determines how much the trunk diameter
may differ from a circular shape.

Use dimension to filter points If on, the dimension attribute is used to
improve the trunk diameter measurement.
This requires the computation of normal
vectors for the point.

Modify Tree Cells
Not Spatix

Modify Tree Cells tool lets you check and modify tree cell elements that have been placed with
the Create Tree Cells tool. The tool opens a list of selected tree cells. Based on the list, you can
display the tree cells, check their attributes and size, and possibly modify the tree species
name and the cell's height, width, and trunk width. You can also move the cell completely to
another location.

The work can be supported by images. This requires a mission and image list in TerraPhoto.
More information can be found in the TerraPhoto User Guide.

For displaying a selected tree, the tool supports automatic display update in three CAD file
views, one top view, one section view, and one camera view. Images can be displayed in the
camera view.

The list shows a flag for each tree. By default, the flag is set to Check. After you checked a tree,
you may change it to Approved.

To merge two point groups:

1. Select tree cells with any Selection tool.

2. Select Modify Tree Cells tool.

This opens the Tree View Settings dialog:

https://terrasolid.com/guides/tphoto/index.html
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3. Select CAD file views in which you want to display the tree cells and click OK.

This opens the Modify Trees dialog:

The dialog contains a list of all selected tree cells. For a selected tree in the list, the attributes
are shown on the right side of the dialog.

SETTING EFFECT

Tree Tree species. Start typing the common or
Latin (scientific) name of a tree species. If
the name is found in Tree species category of
TerraScan Settings, the Latin and Common
names are displayed after you typed a few
characters.

Note Free text field for adding a note to a tree.

Height Height of the tree represented by the cell
height. You can change the height by typing a
new value or using the button right of the
field.

Width Width of the tree crown represented by the
cell width. You can change the width by
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SETTING EFFECT

typing a new value or using the button right
of the field.

Trunk Width of the tree trunk at its base point. You
can change the width of the trunk by typing a
new value or using the button right of the
field.

Activates the manual modification of the
cell. After clicking the button, move the
mouse pointer into a top or section view. The
extend of the tree is dynamically displayed.
Define the new height, width, or trunk width
with a data click.

Click on the camera button in the middle of
the button group in order to identify an
image for display. Move the mouse pointer
into a view. The image footprint closest to
the mouse pointer is dynamically displayed.
Select an image for display with a data click.
Click on the arrow buttons left and right in
the button group in order to select the
previous or next image from the currently
displayed image in the images list.

Move tree Moves the tree cell to another location. After
clicking the button, move the mouse pointer
into a top or section view. The cell of the tree
is dynamically displayed at the mouse
pointer location. Define the new location
with a data click.

Approve | Set to check After checking a tree cell and possibly
modifying it, click on the Approve button.
This changes the status of the selected
model to Approved.
If an approved tree is selected in the list, the
button changes to Set to check. Click on the
button in order to change the status of the
selected model to Check.
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Output Tree Cells
Not Spatix

Output Tree Cells tool creates a tabulator-delimited text file for selected tree cells. The text
file contains the attributes of the tree cell, such as the scientific name of the tree species, XY
coordinates of the tree depending on the cell placement method (Highest point - center of the
tree crown or Trunk - trunk base point on the ground), elevation coordinate of the tree XY point
on the ground, height, crown width, and trunk base width.

The text file is suited for importing tree information into a database. Tree cells can also be
drawn into a CAD file by reading the file with the Read / Tree cells command from the TerraScan
window.

To output tree cells:

1. Select tree cells with any Selection tool.

2. Select Output Tree Cells tool.

This opens the Tree output file dialog, a standard Windows dialog for saving files.

3. Define a location and name for the output file. You may add an extension to the file name,
such as .CSV or .TXT. 

4. Click Save in order to save the text file.

Place Tree Cell
Not Spatix

Place Tree Cell tool lets you place a tree cell manually. The cell placement requires the
following preparation steps:

· Creation of 3D cell elements in a MicroStation cell library. A tree cell should represent the
stem and the crown of a tree. An example library is provided with the TerraScan installation.
The library is stored in the \CELL folder of the Terra applications installation directory, for
example C:\TERRA64\CELL\KARTTALI.CEL. It can be used, for example, to test the tools of the
Trees toolbox.

· Definition of tree species and usage of cells in Tree species category of TerraScan Settings.

· (Optional) Classification of ground in the point cloud.

A tree cell can be placed, for example, based on a vertical section view of a tree in a point
cloud. The base point of the tree can be fixed to the ground elevation if the ground is classified
in the point cloud.

To place a tree cell manually :

1. Select Place Tree Cell tool.
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This opens the Place Tree Cell dialog:

2. (Optional) Select a Ground class.

3. Start typing the common or Latin name of a tree species in the Tree field.

4. Define additional settings in the Create Tree Cell dialog, if necessary.

5. Define the base point of the tree cell with a data click in a top or section view.

If the data click is placed in a another view than a section view (typically in a top view), the
base point elevation is fitted to the given Ground class(es) and the XY location is defined by
the data click. If the data click is placed in a section view, the base point elevation is
determined by the data click and the XY location by the center of the vertical section.

6. Move the mouse pointer inside a section view.

The height of the tree cell is dynamically displayed.

7. Define the highest point of the tree cell with a data click in a section view.

The width of the tree cell is dynamically displayed.

8. Define the width of the tree cell with a data click in a top or section view.

The trunk width of the tree cell is dynamically displayed.

9. Define the trunk width of the tree cell with a data click in a section view.

The software places the cell element according to the settings for tree species.

SETTING EFFECT

Ground class Point class(es) that may define the base
point of a tree.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in the
Ground class field.

Tree Tree species. Start typing the common or
Latin (scientific) name of a tree species. If
the name is found in Tree species category
of TerraScan Settings, the Latin and Common
names are displayed after you typed a few
characters.

Status Sets the status of the tree cell: Check or
Approved. The status flag is used by the
Modify Tree Cells tool.

Height If on, the height of the tree cell is fixed to
the given value and can not be changed
dynamically anymore.

Width If on, the width of the tree cell is fixed to the
given value and can not be changed
dynamically anymore.

Trunk If on, the trunk width of the tree cell is fixed
to the given value and can not be changed
dynamically anymore.

Tree cells can be placed in a more automatic way by using the Create Tree Cells tool.
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View Laser toolbox

The tools in the View Laser toolbox are used to create and modify section views, create views

along a path, create and move in perspective views, open Street View© images, measure point
density, and to update distance coloring.

 

 

TO USE TOOL

Rotate view to show vertical cross section Draw Vertical Section

Rotate view to show horizontal cross
section

Draw Horizontal Section

Show points on a plane in a section view Draw Plane Section

Move forward or backward in section view Move Section

Rotate a section view around its center Rotate Section

Cut perpendicular section from section
view

Cut Section

Travel along path and display views Travel Path

Setup and move in perspective view Travel View

Define automatic synchronization of views Synchronize Views

Open a Street View© image in a browser Show Street View

Measure point density Measure Point Density

Measure point-to-point noise Measure Point Noise

Measure coverage Measure Coverage

Recompute distance colors and update
views

Update Distance Coloring
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Cut Section

Cut Section tool creates a vertical section view which is perpendicular to another vertical
section view. In addition to just rotating the section by 90 degree, the cut section tool allows
you to define another depth for the new section view.

To cut a perpendicular section view:

1. Create a vertical section view using the Draw Vertical Section tool.

2. Select the Cut Section tool.

This opens the Cut Section dialog:

3. Define the position of the new section’s center line with a data click in the section view.

The center line of the new section is defined by the given position perpendicular to the
center line direction of the source section.

4. Define the section view depth by placing a data click or by typing a value in the Depth field of
the Cut Section dialog.

5. Identify a view for displaying the new section with a data click inside the view.

The selected view is rotated to show the new section.

SETTING EFFECT

Depth Display depth of a section on both sides of
the center line. If on, the depth is fixed to
the given value.

Draw Horizontal Section

Draw Horizontal Section tool creates a top view which shows laser data and vector elements in
a limited elevation range (display or viewing depth).

Horizontal sections are useful, for example, to display the exact XY location of vertical objects,
such as building walls or poles in MLS data sets. You should open at least one top view and one
(vertical) section view before starting to create horizontal sections.

To create a horizontal section view:

1. In the top view, zoom to the area of interest that you want to display in the horizontal
section.
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2. Use the Draw Vertical Section tool in order to create a vertical section view of the area of
interest.

3. Select the Draw Horizontal Section tool.

The Draw Horizontal Section dialog opens:

4. Define the center elevation of the horizontal section with a data click in the vertical section
view.

5. Define the horizontal section display depth (= visible elevation range) with a data click in the
vertical section view or by typing a value in the Depth field of the Draw Horizontal Section
dialog.

6. If Apply to is not switched on in the Draw Horizontal Section dialog, identify the view for
displaying the horizontal section with a data click.

The selected view is rotated to a top view and displays the defined elevation range.

SETTING EFFECT

Depth Display depth or visible elevation range of a
horizontal section view up and down from
the center elevation. If on, the display depth
is fixed to the given value.

Apply to If on, the horizontal section is automatically
displayed in the selected view.

The tool does not apply any XY adjustment to the horizontal section view based on the
vertical section location.

Draw Plane Section

Draw Plane Section tool lets you set up a section that contains points on a plane. The user
defines one or several circular sample locations in the point cloud from which the software
derives a plane equation. Then, the software checks which points fit to the same plane and
draws them into a section view. The tool can be used for drawing a section of any 3D plane.

The tool may be useful, for example, for manual 3D digitization work in a point cloud. In order
to digitize the planar part of traffic signs, you can draw a plane section of the sign plate and
digitize its boundary in the section view.
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To draw a plane section:

1. Start Draw Plane Section tool.

This opens the Draw Plane Section dialog:

2. Define settings.

3. Place a data click in a view that displays the point cloud. This can be a top or section view.

This computes the plane equation from the points inside the sample radius and highlights
the are in which the points fit to this plane.

4. (Optional) Place more data clicks in the same view in order to refine the plane selection.

5.  Place a data click into another view in order to draw the plane section.

This displays the points that fit to the plane in the section view.

SETTING EFFECT

Use classes Point class(es) that must fit to the plane.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Use classes field.

Sampling radius Radial distance from a data click. The plane
equation is derived from the points that
are inside the sample radius.

Tolerance Distance by which points are allowed to
differ from a perfect plane. Points that are
within the tolerance distance are consider
as points belonging to the plane.

Depth Display depth of the plane section on both
sides of the section's center line. 
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SETTING EFFECT

Fix to vertical/horizontal If on, the software forces the plane to be
exactly vertical or horizontal if all points of
the plane are within two degree from
vertical/horizontal.

Filter using normal vector If on, only points of planar dimension are
used for drawing the plane section. This
requires the computation of normal
vectors for the points.

Create image view If on, an image is displayed in the
background of the plane section view. This
requires that TerraPhoto is available, and
that a mission and image list are loaded.
See TerraPhoto User Guide for more
information.

Draw Vertical Section

Draw Vertical Section tool creates a 3D section view from a location defined by a center line of
the section and its depth.

A vertical section view is simply a rotated CAD file view which displays all visible CAD file
elements and laser points inside the given slice of space. This makes it well-suited for viewing
laser points and for placing 3D vector elements.

To create a vertical section view:

1. Select the Draw Vertical Section tool.

The Draw Vertical Section dialog opens:

2. Define the start or left point of the section center line with a data click in a top view.

3. Define the end or right point of the section center line with a data click in a top view.

4. Define the section view depth with a data click in a top view or by typing a value in the Depth
field of the Draw Vertical Section dialog.

5. If Apply to is not switched on in the Draw Vertical Section dialog, select the view for
displaying the section with a data click inside this view.

https://terrasolid.com/guides/tphoto/index.html
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The selected view is rotated to show the vertical section. The application automatically
computes the required elevation range so that all laser points inside the given section space
are displayed.

SETTING EFFECT

Depth Display depth of a section on both sides of
the center line. If on, the depth is fixed to
the given value.

Apply to If on, the section is automatically displayed
in the selected view.

Measure Coverage

Measure Point Density tool computes the area of selected polygons that is covered by the point
cloud. This may include only selected point classes which represent certain feature types, such
as trees, buildings, etc.. The tool generates a report that shows for each polygon the size of the
whole area and the covered area as percentage value. 

In addition, the tool places a text element inside each polygon. The text element shows the
percentage of covered area. It is drawn with the active symbology and text settings of the CAD
file.

To measure the coverage:

1. Select one or more polygons for which you want to measure the point cloud coverage.

2. Select the Measure Coverage tool.

This opens the Measure Coverage dialog:

3. Define settings and click OK.

This computes the coverage, displays the report window and draws the text element(s) into
the CAD file. You can save the report as text file or print it directly by using the commands
from the File menu of the report window.
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SETTING EFFECT

Class The point coverage is computed for points
of any class or of a specific class. The list
contains the active class definitions in
TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Use Defines which points are used for the
coverage measurement:

· Loaded points - coverage is computed
from points loaded in TerraScan.

· Project points - coverage is computed
from binary files referenced by the active
project in TerraScan. Not UAV

Footprint Diameter of a circular area that is covered
by each point. Basis for computing the
coverage. The value should be big enough
that gaps caused by normal scan pattern are
closed.

Decimals Number of decimals for labeling the point
coverage inside polygons. Up to 2 decimals
can be used.

Measure Point Density

Measure Point Density tool displays the average number points per squared master unit. You
can measure the point density in a rectangular or circular area, inside selected polygons, or
from the whole data set. The measurement can be based on points loaded into TerraScan or
points residing in the active project.

The point density values are displayed in the information bar at the bottom of the CAD platform
interface. The values include the amount of points per sample area and the average point
density.

If the point density is measured in selected polygons, the tool places a text element inside
each polygon. The text element shows the point density. It is drawn with the active symbology
and text settings of the CAD file.

To measure the point density  from all loaded points:

1. Select the Measure Point Density tool.

This opens the Measure Point Density dialog:
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2. Define settings.

3. If Sample is set to All points or Selected polygons, place a data click anywhere in a CAD file
view (Loaded points) or inside the project area (Project points).

This displays the average point density of loaded points or points in the project.

OR

4. If Sample is set to Rectangle or Circle, define the center point of the sample area with a data
click.

This displays the average point density inside the sample area.

SETTING EFFECT

Class The point density is computed for points of
any class or of a specific class. The list
contains the active class definitions in
TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Use Defines which points are used for the
density measurement:

· Loaded points - density is measured from
points loaded in TerraScan.

· Project points - density is measured from
binary files referenced by the active
project in TerraScan. Not UAV

Sample Sample area for the density measurement:

· All points - area covered by all points.

· Rectangle - rectangular area.

· Circle - circular area.

· Selected polygons - one or more selected
shape elements.

Width Defines the width of a Rectangle or the
diameter of a Circle depending on the
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SETTING EFFECT

setting in the Sample field. Given in master
units of the CAD file.

Decimals Number of decimals for labeling the point
density inside polygons. This is only active if
Sample is set to Selected polygons.

Measure Point Noise

Measure Point Noise tool measures the point-to-point noise in a point cloud. The tool reports
the average distance from a point to a plane fitted to its closest neighbors. The tool may use all
points of a point cloud or only points in selected classes. The noise of a point cloud is best
assessed from points on hard, open, close-to-horizontal surfaces.

Point-to-point noise is closely related to the elevation spread of points on a hard surface. The
value provided by the tool multiplied by 3 indicates the radius of a circle that includes all points
in a section of hard surface.

To measure the point-to-point noise:

1. Select the Measure Point Noise tool.

This opens the Measure Point Noise dialog:

2. Define settings.

3. Place a data click anywhere in a CAD file view.

This displays the average point noise of loaded points.

SETTING EFFECT

Class The point-to-point noise is computed for
points of any class or of a specific class. The
list contains the active class definitions in
TerraScan.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Observe every Defines a subset of points that is included
in the noise computation. The more points
are used, the longer the process.

Radius Circular area around a point within which
the points are considered for fitting a
plane.

Time tolerance Only points within the given time
difference are considered in the noise
computation. A small time tolerance
ensures that only points from the same
path are used. Thus, any mismatch
between paths does not influence the
result.

Max slope Maximum slope gradient of points
considered in the computation.

Ignore limit Points that do not fit to the plane within
the given distance are ignored.

Move Section

Move Section tool lets you move stepwise forward or backward in section views. The tool is
most useful in views created by Draw Vertical Section and Draw Horizontal Section tools.

To move sections forward or backward:

1. Start Move Section tool.

This opens the Move Section dialog:

2. Move the mouse pointer into a section view.

The area covered by a vertical section is highlighted by a rectangle in all top views.

3. Place a data click in order to move the section forward.

OR
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4. Place a reset click in order to move the section backward.

SETTING EFFECT

Move by Step size:

· Half of view depth - the section is moved by
half of the section’s depth. If the section
depth is 1 m, the section is moved 0.5 m
with each mouse click.

· Almost full depth - the section is moved by
almost its full depth. This is the
recommended setting if you zoom in/out in
section views using the mouse wheel. Zoom
by mouse wheel can lead to little
inaccuracies between consecutive sections,
so that points may be missed by
classification tools when moving with full
view depth.

· Full view depth - the section is moved by its
full depth. If the section depth is 1 m, the
section is moved 1 m with each mouse click.

Rotate Section

Rotate Section tool rotates a vertical section view stepwise around its center point.

The direction and angle of rotation can be determined by data clicks inside the section view or
by a fixed value in the tool’s dialog.

To rotate a section view:

1. Select the Rotate Section tool.

This opens the Rotate Section dialog:

2. Move the mouse pointer into a section view.

The area covered by a vertical section is highlighted by a rectangle in all top views.

3. Place a data click inside a vertical section view.

If the data click is placed on the right side of the section view’s center, the section is rotated
counterclockwise. If the data click is placed on the left side, the rotation direction is
clockwise.
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The angle of rotation is determined by the distance of a data click from the center of the
section view or by a fixed value in the Angle field of the Rotate Section dialog.

SETTING EFFECT

Angle Rotation angle applied to a view with each
data click. If on, the rotation is fixed to the
given value. Positive values rotate in
counterclockwise direction, negative values
in clockwise direction.

Show Street View

Show Street View tool opens a Google Street View© image in a browser. The Street View©

image is determined by a mouse click. This requires that the projection system of the data set is
selected in the tool's dialog.

The Street View images category of TerraScan Settings defines display settings for the images in

the browser, as well as a key for accessing Street View© images. The access key can be changed
to a company's own key, if necessary.

To show a Street View image:

1. Select the Show Street View tool.

This opens the Show Street View dialog:

2. Select the correct projection system.

3. Place a data click inside a top view in order to determine the viewer location.

4. Place another data click inside the top view in order to determine the viewing direction and
the target location.

The standard browser opens the Google Street View© image that is closest to the viewer
location and looks in the direction of the target location.

SETTING EFFECT

Projection Projection system of the data set. Click on
the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
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SETTING EFFECT

addition, any user-defined projection
systems are included in the list.

Synchronize Views

Synchronize Views tool defines dependencies between CAD file views. The display in a
dependent view is automatically updated, if the master view display changes. This is useful if
you want to view the same location using two different types of content. For example, you may
want to see an orthophoto and laser points side by side in two different top views.

Synchronize Views tool can define the following dependencies:

· No synch - view works normally and does not depend on other views. This is the default
setting.

· Match - dependent view shows the same area using the same rotation or perspective as the
master view.

· X section - dependent view shows a cross section along the screen X axis of the master view.

· Y section - dependent view shows a cross section along the screen Y axis of the master view.

· Front 3D - dependent view is a 45 degree oblique view looking forward and down to the area
displayed by the master view.

· Side 3D - dependent view is a 45 degree oblique view looking right and down to the area
displayed by the master view.

· Camera - dependent view displays a camera view. This is useful to display images that are
referenced by a TerraPhoto image list. See TerraPhoto User Guide for more information. The
software chooses the image for display which best matches the viewing direction (for
example: top view - nadir images, section view - oblique images) and sees the four corner
points of the view. A camera view works best if there is one image covering the whole view.

To set up synchronized views:

1. Select the Synchronize Views tool.

This opens the Synchronize Views dialog:
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2. Define the dependencies by selecting a dependency type from the lists.

3. Define the master view for each dependency.

4. If required, define additional settings.

Whenever you move, pan, zoom, or redraw a master view, the dependent views are updated
automatically.

SETTING EFFECT

Depth Depth of a dependent section view.

Camera Name of a camera in a TerraPhoto Mission.
Only images captured by this camera are
displayed. This is only available for
dependency type Camera and if a Mission is
loaded in TerraPhoto.

Synchronization stays active if the Synchronize Views dialog is closed. If you want to release
the view dependencies and stop synchronization, reopen the dialog and set all views to No
synch.

Travel Path

Travel Path tool lets you view an animation along an alignment element. The tool provides an
excellent way for traversing along the survey path and checking the data visually.

The alignment element can be any linear element. In most cases you create the element
manually or draw, for example, a trajectory line into the CAD file by using the Draw into design
command. Alternatively, you can use TerraScan’s Draw from points command which draws an
approximate flight path deduced from the order of loaded laser points.

You can define what kind of views you want to see while traveling along the alignment.
Supported view types include top, cross section, longitudinal section, isometric and camera
views.

To create an animation along an alignment:

1. Draw and select the alignment element.

2. Select the Travel Path tool.

This opens the Travel Path dialog:
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3. Define settings and click OK.

The application constructs internal tables for the animation and then opens the Travel Player
dialog.

SETTING EFFECT

Step Step along alignment between consecutive
cross sections.

Depth Full depth of each cross section. Each cross
section covers a rectangular area defined by
the Depth and Width values.

Width Full width of each cross section. Each cross
section covers a rectangular area defined by
the Depth and Width values.

Speed Speed for automatic animation display.

Start station Defines the point on the alignment element
from which the animation starts.
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SETTING EFFECT

Views CAD file views that are used for displaying the
animation:

· Top view - displays data from the top.

· Second top view - displays data from the
top.

· Cross section 3D - displays data in a cross
section.

· Longitudinal section 3D - displays data in a
longitudinal section.

· Isometric view 3D - displays data in an
isometric view.

· Camera - display data in a camera view. Click
on the >> button in order to open the Travel
Path Camera Settings dialog and define
settings for the camera view.

Elevations Method of elevation range computation which
defines how the animation follows elevation
changes in the data:

· Follow all points - all points determine the
visible elevation range.

· Follow selected classes - points from
selected classes determine the visible
elevation range. Select a single class from
the Class list. Click on the >> button in order
to open the list of active classes and select
several classes.

· Follow 3D alignment - the alignment
element determines the center elevation
and the visible elevation range is
determined by the Minimum dz and
Maximum dz values given relative to the
alignment element.

· Fixed - a fixed elevation range defined by
Minimum z and Maximum z values is used
for the whole animation.

The Travel Player dialog contains the following commands and tools for traveling along the
alignment element:

MENU/TOOL COMMAND/TOOL NAME EFFECT

File Using mouse Update a cross section view
dynamically as you move
the mouse pointer along
the alignment. If you place
a data click, the tool
updates all views.
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MENU/TOOL COMMAND/TOOL NAME EFFECT

File To start Move to the start of the
alignment and update all
views.

File To end Move to the end of the
alignment and update all
views.

Play backward Start automatic animation
display backward along the
alignment.

Step backward Move stepwise backward
along the alignment.

Stop Stop automatic animation
display.

Step forward Move stepwise forward
along the alignment.

Play forward Start automatic animation
display forward along the
alignment.

Travel Path Camera Settings

The Travel Path Camera Settings dialog lets you define settings for a camera view.

SETTING EFFECT

Camera angle Field-of-view angle of the camera.

Camera dz Altitude of the camera position. Defined as
elevation difference from the section center
(= alignment element).
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SETTING EFFECT

Target dz Altitude of the target position. Defined as
elevation difference from the section center
(= alignment element).

Front clipping Distance up to which the content of the view
is clipped in the foreground. Data is
displayed in the range between Front and
Back clipping.

Back clipping Distance after which the content of the view
is clipped in the background. Data is
displayed in the range between Front and
Back clipping.

Travel View

Travel View tool lets you setup perspective views by defining a viewer position, viewer height
above a reference surface, and vertical viewing angle. Further, the tool provides user controls
for navigating in the perspective view.

To setup and travel in  a perspective view:

1. Open and setup a CAD file view that you want to use as perspective view.

The setup may include display settings for the point cloud, vector data and imagery, if
available. 

2. Select the Travel View tool.

This opens the Travel View dialog:

3. Define settings.

SETTING EFFECT

Surface Point class that defines the reference
surface for the viewer. Used as the base
elevation level for calculating the viewer
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SETTING EFFECT

position. Alternatively, select Fixed
elevation and define the viewer's base
point elevation in the Base Z field.

Opens the Select Classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Surface field.

Base Z Reference elevation for computing the
viewer position. This is only active if Surface
is set to Fixed elevation.

Viewer height Height of the viewer above the reference
elevation.

Viewing angle Defines the vertical viewing angle:

· Horizontal - the viewer looks horizontally
forward.

· Terrain slope - the viewer looks according
to the terrain slope in view direction.

· Angle down - the viewer looks down by
the given Angle.

· Angle up - the viewer looks up by the
given Angle.

Target Maximum distance to define a target
position.

4. Define the viewer position by placing a data click inside a CAD file top view.

This displays the viewer position and the viewing angle dynamically if the mouse pointer is
moved.

5. Define the target position by placing another data click inside the CAD file top view.

6. Select another CAD file view as target view.

This displays the point cloud in the target view which is changed into a perspective view. The
software opens the Travel View dialog for navigating in the perspective view:
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Move the viewer forward/backward, left/right by using the blue arrow buttons on the left
side of the dialog. Adjust the moving distance per button click with the slider on the left
side. The distance can be adjusted to fixed values between 0.1 and 100 meters.

Turn the viewing direction up/down, left/right by using the yellow arrow buttons on the
right side of the dialog. Adjust the turning angle per button click with the slider on the right
side. The angle can be adjusted to fixed values between 0.5 and 90 degree.

Define a new perspective view by activating the perspective view tool again pressing the
button in the middle. It is not necessary to activate perspective view tool again every time
defining a new view, but only when the tool was deactivated in between. The tool is
deactivated when some other tool is activated.

After at least one data click on the buttons of the Travel View dialog, you can also use the
<Arrow-up> and <Arrow-down> keys to move forward/backward, and the <Arrow-left> and
<Arrow-right> keys to turn the viewing direction to the left/right.

The other Travel View dialog is still available and settings can be adjusted. The new settings
are applied when the next navigation step is done. Even if the Travel View dialogs are
closed, the tool is still active and you can setup new perspective views by starting from step
4.

Define field of view and view clipping options for this tool in Travel View tool settings.

Update Distance Coloring

Update Distance Coloring tool recomputes distances of laser points to other laser points,
surfaces or vector elements, and updates views in which distance coloring is active. A distance
for each point must be computed first by using the Compute distance command.

You need to use this tool only if:

· you have classified points to or from classes involved in distance computation.

· you have transformed point XY coordinates or elevations.

· you have modified CAD file elements involved in distance computation.

For more information about distance coloring, see Color by Distance.
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Waveform Processing
Not Lite, Not UAV

TerraScan is able to read waveform information from LAS 1.3 and 1.4 files, WDP files (external
waveform data storage for LAS files) and from TopEye.TEW 1.15 (MarkII) files. It uses the
waveform information for processing tasks. It is not possible to write out files that include
waveform information.

TerraScan UAV does not include any waveform capabilities.

Waveform capabilities

If waveform data is available, you can perform the following processing steps:

· View Waveform for a point in a graph and export waveform information of a point into a text
file.

· Extract echo properties for laser points:
§ Echo length - relative length (millimeter) of a return signal compared to a typical

return from a hard surface.

§ Echo normality - difference in shape of a return signal compared to a typical return
from a hard surface.

§ Echo position - difference in position of a peak of a return signal compared to a typical
return from a hard surface.

· Classify laser points By echo length.

· Extract Echoes in problem areas using a specific echo extraction logic:
§ Last possible - for example in areas with dense low vegetation where the default

extraction logic did not provide ground points.

§ All possible or All distinct - for example in places where points on some feature are
missing, such as powerline wires.

§ First possible.

Waveform processing principles

In a TerraScan project, the block binary files must be saved as LAS or FastBinary files in order to
enable the use of waveform data for processing. Waveform-related attributes, such as echo
length, echo normality, and echo position can only be stored in FastBinary format.

The waveform files are linked to laser points via the trajectory files. The Trajectory information
dialog contains an input field Waveform which defines the file(s) used for reading waveform
information. Once a laser point is assigned to a trajectory (by the line number) and the
trajectory is linked to a waveform file, the software is able to find the waveform information
for any laser point using the time stamp and the echo number stored for the laser point.

For the extraction of echo properties and of additional points, the software also needs a
scanner waveform profile. The profile stores properties of typical returns from a single hard
surface. These properties include:
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· the background noise level

· the pulse length at 50% of peak strength

· the pulse length at 35% of peak strength

· the shape of the return pulse

· the system-derived point position relative to the return pulse

The scanner waveform profile can be extracted from laser point samples on hard, flat, open
ground surfaces. There should be only-echo returns and some intensity variation within the
sample area. The sample areas must not be located at the edges of scan lines. The scanner
waveform profile is then automatically computed from the sample laser points.

Finally, the scanner waveform profile must be referenced by a scanner system definition which
in turn must be linked to the trajectory files.

The following figure illustrates the method how TerraScan finds waveform information for a
laser point.

TerraScan expects waveform data stored as 16-bit unsigned integer values. Some software for
generating waveform data uses signed integer values which leads to problems when TerraScan
reads the waveform data. Depending on the software information provided in the header of an
LAS file, TerraScan excludes values > 32767 in order to avoid errors caused by signed integer
values in the waveform files.

Workflow summary

1. Load trajectories into TerraScan using the Manage Trajectories tool.
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2. Link trajectories with waveform files using the Edit information or Link to waveform files
commands of the Trajectories dialog.

3. Create a TerraScan project using the Define Project tool, storage format must be FastBinary
for storing echo properties, or LAS.

4. Import points into the project using the Import points into project command of the Project
dialog, deduce line numbers from trajectories.

This enables the display of waveform information using the View Waveform tool.

5. Draw polygons around sample areas of single, open, hard surfaces that contain only-echo
returns and some variation in intensity values. Sample areas should not be too close to scan
corridor edges.

6. Classify points inside the polygons into a separate class using Inside fence command or By
polygons classification routine.

7. Create a scanner waveform profile using the user controls in Scanner waveform profiles
category of TerraScan Settings.

You have to repeat steps 5 to 7 for all scanners or lines collected with different pulse rates.

8. Link the scanner waveform profiles with scanner system definitions using the user controls in
Scanner systems category of TerraScan Settings.

9. Link the trajectories with scanner system definitions using the Edit information command of
the Trajectories dialog.

This enables the extraction of echo properties using the Extract echo properties command of
the Project dialog or the Extract echo properties command for loaded points, and the
extraction of additional points using the Extract Echoes tool.

Waveform toolbox

Tools in the Waveform toolbox are used to view waveform information and to extract
additional echoes from the waveform information.

 

 

TO USE TOOL

View waveform data View Waveform Not Lite, Not UAV

Extract echos from waveform Extract Echoes Not Lite, Not UAV
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Extract Echoes
Not Lite, Not UAV

Extract Echoes tool extracts additional points from a return signal.

When scanner system software is generating laser points, it follows a certain logic. It may
generate a point from the strongest, first, or last return but usually, it extracts one point from a
multiple-return signal. In general, the extraction method of system software works well for
laser point clouds.

However, in some places, the generated points might not be optimal. Examples are missing
returns from wires or from ground below dense vegetation. In both cases, the system software
might extract a point from the return signal, but possibly not the point of biggest interest for
certain applications. The Extract Echoes tool can be used at such places in order to extract
additional points from return signals.

There are several extraction methods available:

· First possible - looks only at rising start of the return signal.

· Last possible - looks only at trailing end of the return signal. This should be used, for
example, to extract additional ground points.

· All distinct - constant fraction discriminator, more reliable result than All possible method.

· All possible - Gaussian decomposition, can generate multiple points from overlapping
signals. This should be used, for example, to extract additional points on wires.

The extraction of additional points should only be performed in limited areas where the
extraction method of the system software did not provide optimal results. The following
methods can be used to limit the processing area for point extraction:

· Place a fence in a section view in order to specify a 3D slice of space where to generate new
points. The section depth defines the XY area and the fence the elevation range for point
extraction.

· Draw a fence or select polygon(s) to specify a 2D area where to generate points. In this case,
the new points can be located at any elevation, only the XY area is defined.

The process creates new points only if it finds returns in the waveform that match the settings
for the extraction. For example, if there is no part of the laser beam that penetrated to the
ground because of dense vegetation, the Last possible method will probably not generate a
point on the ground level.

The extraction of additional points requires that trajectories are active and laser points are
loaded in TerraScan. The points must be linked to the trajectories and the trajectories must
reference the waveform files and the scanner systems. The scanner waveform profile must be
available and linked to the scanner system. See Waveform processing principles and Workflow
summary for more information.
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To extract additional points:

1. Draw a fence or polygon(s) around the area(s) for which you want to extract points as
described above. Select the polygon(s).

2. Select Extract Echoes tool.

The Extract Echoes dialog opens:

3. Define settings and click OK.

This generates new points if the software finds return signals in the waveforms that match
the settings. The points are added to the laser points in TerraScan memory.

4. Use Save points as commands in order to save the laser points into a file.

The new points are created as inactive points. You must save the points with setting Points
set to All points in the Save points dialog. Otherwise, the additional points extracted by
Extract Echoes tool are not stored.

SETTING EFFECT

To class Target class for extracted points. The list
contains the active classes in TerraScan.

Method Method of point extraction. See explanations
above.

Strength Required number of photons in addition to
the background noise. Only if the return
signal is stronger than the background noise
plus the given value, a points is extracted.

Separation Minimum distance along the waveform
between an existing point and a new point.
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View Waveform
Not Lite, Not UAV

View Waveform tool opens the Waveform dialog that displays the waveform shape of single
laser points. The dialog contains commands for identifying a point, showing a point’s location,
drawing the waveform vector into the CAD file, saving the waveform as text file, and changing
the display settings of the waveform graph.
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The waveform graph represents the waveform
of a return signal by bars of constant height and
varying length. The height of a bar corresponds
to a 30 centimeters distance of light travel. The
length of a bar indicates how many photons
returned to the scanner from an object. Short
bars of approximately the same length (= small
waveform sample values) represent the
background noise, longer bars more or less
strong returns from objects. A red line in the
graph indicates the location of the selected
laser point.

Viewing the waveform requires that
trajectories are active and laser points are
loaded in TerraScan. The points must be linked
to the trajectories and the trajectories must
reference the waveform files. See Waveform
processing principles and Workflow summary
for more information.

To view the waveform of a laser point:

1. Select View Waveform tool.

The Waveform dialog opens.

2. Click on the Identify button of the dialog.

3. Define a laser point with a data click inside a
view.

This displays the waveform graph for the
laser point closest to the data click.

Click on the Show location button and move
the mouse pointer inside a CAD file view in
order to highlight the point for which the
waveform is show. A data click inside a view
centers the highlighted point in the view.

To draw the waveform vector into the CAD
file:

1. Identify a laser point for waveform graph display.

2. (Optional) Center the point in a cross section view. This may be best for viewing the
waveform vector.

3. Click on the Draw in 3d button.

This draws the waveform vector into the CAD file. The vector is represented by a cell
element that contains lines of different colors. Red color is used for the strongest return,
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yellow, green, cyan, blue for other returns of decreasing strength, and gray for background
noise.

To save the waveform of a point into a text file:

1. Identify a laser point for waveform graph display.

2. Select Save As text command from the File pulldown menu.

This opens the Save waveform as text dialog, a standard dialog for saving files.

3. Define a location and file name for saving the text file and click Save.

This saves the text file.

To save the waveform of multip le points into a text files:

1. Draw a fence or polygon around the points for which you want to export the waveform.
Select the polygon.

2. Select Save inside fence command from the File pulldown menu.

This opens the Browse For Folder dialog, a standard dialog for selecting a storage folder.

3. Select a folder for saving the text files and click OK.

This saves a text file for each point inside the fence/selected polygon. An information dialog
shows the number of saved text files out of the number of points. The text files are named
automatically as WAVEFORM_<timestamp>_<echo type>.TXT.

To change the settings for waveform display:

1. Select Display settings command from the Settings pulldown menu.

This opens the Waveform Display Settings dialog:

2. Define settings and click OK.

This applies the new settings for the display.
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SETTING EFFECT

Sample height Height of a bar in the waveform graph. Given
in screen pixels.

Maximum value Defines the maximum length of a bar that can
be displayed in the graph. The value effects
the scale of the length of the bars.

Ambient noise Limit value for background noise. If a
waveform sample value is smaller than or
equal to the given value, a 3d vector line is
drawn in gray.
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TerraScan Window

The TerraScan window is opened when TerraScan is loaded and if the Open main window
option in the Operation category in TerraScan Settings is switched on.

The TerraScan window contains pulldown menu commands that are used to process point cloud
data loaded into RAM. If data is loaded by any tool or command for loading points, the software
reads the points into RAM. As long as the TerraScan window is open, the points remain in
memory and can be displayed and processed.

If set to Small dialog size, the TerraScan window is minimized to the menu. If set to a larger size
by commands from the View pulldown menu, the window shows the list of loaded points. The
list contains attributes of each point that are set to be visible in the Fields dialog. Besides the
menu commands for changing the size, the window can be resized dynamically using the
mouse.

To show the location of a point, select a line in the TerraScan window’s list of points. Click on
the Show location button and move the mouse pointer into a view. This highlights the selected
point with a square. You can show the location of several points by pressing the <Shift> or <Ctrl>
keys while selecting lines in the list.

To identify a point, click on the Identify button and place a data click close to a point in a view.
This selects the corresponding line in the Main window’s list of points.

If the TerraScan window is accidentally closed, it can be re-opened with the key-in command:

scan app mainwin

However, points are unloaded from memory if the TerraScan window is closed.

The mouse button(s) defined in the CAD platform can be used to snap to a point. This may be
helpful, for example, for dynamically rotating a view around a location in the point cloud or for
digitizing vector data based on the point cloud. Snapping to points can be disabled in the
Snapping category of TerraScan Settings.
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Classify pulldown menu

Commands from the Classify pulldown menu are used to classify laser points and to detect
planes or trees from laser points.

TO USE COMMAND

Start an automatic classification routine for
points

Routine

Classify points inside a fence Inside fence

Classify points inside a 3D fence 3D fence

Classify points captured along a trajectory
interval

Trajectory interval Not Lite

Detect plane areas from laser points Detect plane Not Lite

Detect trees from laser points Detect trees Not Lite

Add points within a specific area to ground
class

Add point to ground Not Lite

3D fence
Not Spatix

3D fence command lets you classify points inside a 3D fence from one class into another class.
Only points that are displayed on screen are effected by the classification. The 3D fence is
defined in two steps. Usually, a fence or selected polygon is drawn in a top view first. Then the
tool waits for the selection of a second view, which is automatically turned into a front view
covering the same area as defined by the fence. In this front view a second fence can be drawn
to define the final 3D fence content.

To classify  points inside a 3D fence:

1. Draw a fence or select a polygon around points to classify in a top view.

2. Select 3D fence command from the Classify pulldown menu.

3. Select a second view by placing a data click inside the view.

This turns the second view into a section view, displays the points that are located in the
fence, and opens the Classify Fence 3D dialog:
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4. Select classes in the From and To fields.

5. Draw a fence in the section view. The fence tool is already started by the command.

6. When at least 3 vertices for the fence are defined by data clicks, the Apply button in the
Classify Fence 3D dialog becomes active. Click Apply to finish the fence.

This classifies the points that are displayed in the top view and located inside the 3D fence.

Add point to ground

Add point to ground command lets you classify points inside a certain area to the ground class.
This may be useful to correct classification errors effectively in areas where the automatic
ground classification does not provide a good result.

The command is used most likely after an automatic Ground classification has been performed.
It classifies additional points to the ground class based on an initial point and additional
settings defined in the command’s settings dialog. The source class from which the points are
added to ground has to be visible in the view in which the classification is started.

To add points to the ground:

1. Select Add point to ground command from the Classify pulldown menu.

This opens the Add Point to Ground dialog:

2. Define settings for the search for additional ground points.
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SETTING EFFECT

Select Defines which point is selected as initial point
for the ground classification:

· Closest - the point closest to the data click
within the search radius.

· Highest - the highest point within the search
radius.

· Lowest - the lowest point within the search
radius.

Within Search radius around the mouse click to find
the initial point for starting the ground
classification.

From class Source class from which points are classified
into ground.

To class Target class for classified ground points.

Reprocess Area within which points are classified. The
value defines the radius of a circular area
around the initial point.

Single line If on, only points from one line at a time are
classified. This may result in ground levels per
line.

3. (Optional) Click on the Settings button in order to change settings for the ground detection
parameters.

This opens the Ground Processing Settings dialog:

The settings are the same as for the automatic ground classification. See Ground
classification routine for a detailed description of the settings.
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Apply the settings by clicking OK.

4. Click inside a view to define the initial location for adding ground points.

This classifies visible points from the source class to the ground class according to the given
settings and within the defined reprocessing area.

Detect plane
Not Lite

Detect plane command detects points on a plane inside a fence or selected polygon from one
point class. It classifies the points into another class and optionally draws a 3D rectangle around
the points on the plane.

The tool works only in top views. It does not detect close-to-vertical or vertical planes.

To detect a plane from laser points:

1. Draw a fence or select a polygon around the area where the plane(s) are located.

2. Select Detect plane command from the Classify pulldown menu.

This opens the Detect Plane dialog:

3. Define settings.

4. Click inside the fence to define a start point for the plane detection.

The software highlights points that are found on a plane. In addition, the angle of the plane
and the time spent for plane detection is shown in the message center at the bottom of the
CAD platform interface.

5. Accept the points with another data click.

This classifies the points on the plane and (optionally) draws a rectangle around the plane.
The rectangle element is drawn on the active level using the active symbology settings of the
CAD file.
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SETTING EFFECT

Initial radius Start radius for plane detection.

Plane tolerance Defines the distance how close points must
match a fitted plane equation.

Expansion step Maximum gap between points belonging to
the same plane.

Draw plane shape If on, a 3D rectangle is drawn around the
points on the detected plane.

From class Source class from which points are used for
plane detection.

Classify to Target class for points on the detected plane.

Detect trees
Not Lite, Limited in Spatix

Detect trees command detects trees from the laser point cloud automatically based on tree
shape definitions. This requires the classification of the laser points into ground, vegetation
and optionally building points as well as the definition of tree types in TerraScan Settings. See
Tree types category for information on how to define tree types.

For detected trees, either MicroStation cells or RPC cells can be placed to represent trees in 3D
visualizations. MicroStation cells must be defined in the MicroStation Cell Library to be placed
correctly. RPC cells are replaced by RPC files when a view is rendered and if the software finds
the RPC file at the given location. Settings for cell names and RPC files can be found in the Tree
types category of TerraScan Settings as well.
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RPC files are purchased by Archvision (www.archvision.com). For more information about RPC
cells and visualization options, see TerraPhoto User Guide or the MicroStation Online Help.

The automatic tree detection is based on tree crown
shapes that it tries to detect in the point cloud. It is
possible to distinguish trees with clearly different
crown shapes, such as very slim shapes of many
coniferous trees from very round shapes of some
deciduous trees. The tool is not able to detect
different tree types or the true amount of trees in
tree groups or a dense forest. Thus, the aim of the
tree detection is mainly visualization for which the
real amount of trees in tree groups or forests does
not play a role.

To detect trees from laser points:

1. Select Detect trees command from the Classify
pulldown menu.

This opens the Detect trees dialog.

2. Select one or more tree types listed in the upper
part of the dialog.

3. Define settings for tree detection.

4. Click OK.

The software starts the detection process. It
classifies points from detected trees into the given target class and (optionally) places cells
and/or RPC cells on each tree location. A process window shows the progress of the
detection. Depending on the amount of ground and vegetation points loaded into TerraScan
and given settings, the process might take some time.

SETTING EFFECT

Ground class Point class representing the ground level.

From class Source point class from which trees are
detected.

To class Target point class for points from detected
trees.

Find Determines how many trees are detected:

· More trees - higher amount of trees is
detected.

· Normal level - normal amount of trees is
detected.

· Fewer trees - lower amount of trees is
detected.

https://terrasolid.com/guides/tphoto/visuterraphotorendering.html
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SETTING EFFECT

Tolerance Positional accuracy tolerance for laser points.

Use echo information If on, echo information is used for
determining what is likely to be a tree.

Inside fence only If on, the detection area is limited to a fence
area. Requires that a fence is drawn or a
polygon is selected in the CAD file.

Place cell If on, MicroStation cells are places at detected
tree locations.

Place RPC cells If on, RPC cells are placed at detected tree
locations.

RPC cells can be also placed manually based on laser points and aerial images using the Place
Rpc Tree tool in TerraPhoto.

At the moment, cells and thus, the cell placement options of the Detect trees tool only works
in MicroStation. There is not yet any corresponding element type in Spatix.

Inside fence

Inside fence command classifies points inside a fence or selected polygon from one class into
another class. Only points that are displayed on screen are effected by the classification.

To classify  points inside a fence:

1. Draw a fence or select a polygon around points to classify.

2. Select Inside fence command from the Classify pulldown menu.

This opens the Classify Points Inside Shapes dialog:

3. Select classes in the From class and To class fields and click OK.

This classifies the points that are displayed and located inside the fence.

https://terrasolid.com/guides/tphoto/toolplacerpctree.html
https://terrasolid.com/guides/tphoto/toolplacerpctree.html
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Routine

Routine sub-menu contains commands for calling automatic classification routines. They can be
used to classify points loaded in TerraScan. Most of the classification routines are also available
as macro actions in order to use them in batch processing.

The different routines are explained in detail in Chapter Classification Routines.

Trajectory interval
Not Lite

Trajectory interval command classifies points that were captured within a given interval along a
trajectory. The interval can be defined by start and end position on a trajectory or by start
position and duration in seconds.

The command relies on trajectories stored in the active trajectory folder of TerraScan. In
addition, the trajectory number must be assigned to the loaded points.

To classify  points of trajectory  intervals:

1. Select Trajectory interval command from the Classify pulldown menu.

This opens the Classify Trajectory Interval dialog:

3. Define settings.

4. Move the mouse pointer inside a view.

The trajectory closest to the mouse pointer is dynamically displayed.

5. Identify the trajectory to classify with a data click.

6. Move the mouse pointer to the start position of the interval to classify.

The trajectory position closest to the mouse pointer is dynamically displayed.

7. Identify the start position with a data click.

If Interval is set to Fixed step slice, the software classifies the points captured within the
given Step time interval to the target class. The data click defines the center point of the
interval.
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8. If Interval is set to Free, move the mouse pointer to the end position of the interval to
classify.

The trajectory position closest to the mouse pointer is dynamically displayed.

9. Identify the end position with a data click.

This classifies the points captured during the time interval defined by the start and end
position to the target class.

SETTING EFFECT

From Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From field.

To Target class.

Interval Determines how the trajectory interval is
defined:

· Free - by two data clicks along a trajectory
line.

· Fixed step slice - by the given interval
duration.

Step Duration of the interval to classify. This is
only active if Interval is set to Fixed step
slice.

Inside fence only If on, the classification is limited to a fence
area. Requires that a fence is drawn
(Microstation only) or a polygon is selected in
the CAD file.
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Group pulldown menu

Commands from the Group pulldown menu are used to assign groups to laser points and to
classify points based on the grouping.

TO USE COMMAND

Assign a group number to points Assign groups Not Lite

Test parameters for separating point groups
into different classes

Test parameters Not Lite

Start an automatic classification routine for
point groups

Classify

Clear group numbers from selected classes Clear by class

Copy the group attribute from closest
neighbour point

Copy from closest

Split groups based on classification Split groups by class

Check groups in a systematic way Inspect groups

Any functionality related to grouping is still under development and commands/tool may
change in future versions of TerraScan.

Assign groups
Not Lite

Assign groups command assigns a group number to points of one or more classes. The grouping
is done based on different methods, such as plane fitting, watershed algorithm, or 3D spacing
between points.

The group assignment relies on a distance from ground value and normal vector information.
Both must be computed for the points before the command is started. Use Compute distance
command for loaded points or Compute distance macro action with setting Compare to =
Ground in order to compute the distance value. Use Compute normal vectors command for
loaded points or Compute normal vectors macro action in order to compute normal vector
directions.

The group number can be used for the visualization of points and for classifying points. There
are various automatic classification routines that rely on grouping. The tools from the Groups
toolbox can be used to manipulate the groups manually.

The group number can be stored in TerraScan FastBinary files. Switch on the Group attribute in
the Save points as dialog or in the Attributes to store dialog of a TerraScan project in order to
store the group number for project block files. 



TerraScan User Guide  © 2023 Terrasolid Ltd

425TerraScan Window > Group pulldown menu > Assign groups

To assign a group number to points:

1. Compute the distance from ground using the Compute distance command or corresponding
macro action.

2. Select Assign groups command from the Group pulldown menu.

This opens the Assign Groups dialog:

2. Define settings and click OK.

This assigns a group number to points in the selected class(es) that fit the requirements. All
other points get group number 0.

SETTING EFFECT

Class Point class(es) included in the search for
groups.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Current groups Determines how current group numbers of
points are handled:
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SETTING EFFECT

· Clear - existing group numbers are
deleted before assigning new numbers.

· Keep - existing group numbers are kept.

Use color If on, color values assigned to the points are
used for grouping. The Weight of color
values is determined by the given
percentage value.

Group by selected polygons If on, group numbers are assigned based on
selected polygons. Points inside a polygon
get the same group number. This is only
active if one or more shape elements are
selected in the CAD file.

Group planar surfaces If on, points that fit to planes are grouped.
Points fitting to the same plane get the
same group number.

Tolerance Determines how much points may differ
from a plane. Point that are within the given
vertical distance from a plane are grouped.
This is only active if Group planar surfaces is
switched on.

Min area Minimum area of a planar surface for
grouping points. This is only active if Group
planar surfaces is switched on.

Min height Minimum height above ground of a planar
surface for grouping points. This is only
active if Group planar surfaces is switched
on.

Group by tree logic If on, points on trees are grouped. Points
that belong to the same tree get the same
group number.

Method Method of grouping trees:

· Highest point - based on a watershed
algorithm starting from the locally highest
point. This is suitable for airborne point
clouds.

· Trunk - based on approximately circular
tree trunks visible in the point cloud. This
requires a high amount of points from
trunks and is suitable for very high-
density airborne point clouds, for mobile
data and point clouds from static
scanners.
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SETTING EFFECT

Require Minimum number of points that form a
single tree group. This is only active if
Group by tree logic is switched on and
Method is set to Highest point.

Min height Minimum height above ground of a group.
This is only active if Group by tree logic is
switched on.

Max diameter Maximum diameter of a tree trunk as an
approximate estimate. This is only active if
Group by tree logic is switched on and
Method is set to Trunk.

Min trunk Minimum length of the tree trunk. This is
only active if Group by tree logic is switched
on and Method is set to Trunk.

Group by density If on, points are grouped based on their
distance to each other. Close-by points get
the same group number.

Gap Distance between consecutive groups:

· Automatic: the software decides what
points belong to one group or to another.
This is recommended for objects with
variable gaps, such as moving objects on a
road.

· User fixed: the user can define a fixed
distance value in the text field. This is
suited for fixed objects with large
distances in between, such as powerline
towers.

Require Minimum amount of points that form a
single group. This is only active if Group by
density is switched on.

Classify

Classify sub-menu contains commands for calling automatic classification routines for groups of
points. They can be used to classify points loaded in TerraScan. Most of the classification
routines are also available as macro actions in order to use them in batch processing.

Classifying groups requires that a group number is assigned to the points. See Assign groups
command for more information.

The different routines are explained in detail in Chapter Classification Routines.



TerraScan User Guide  © 2023 Terrasolid Ltd

428TerraScan Window > Group pulldown menu > Clear by class

Clear by class

Clear by class command clears the group number from points in selected classes. The group
number is set to 0.

To clear group numbers:

1. Select Clear by class command from the Group pulldown menu.

This opens the Clear Group by Class dialog:

2. Define settings and click OK.

This sets the group number of points in the selected class(es) to 0.

SETTING EFFECT

From class Point class(es) included in the search for
groups.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Inside fence only If on, only loaded points that are located
inside a fence or selected polygon are
effected. Requires a fence or selected
polygon in the CAD file.

Group numbers can also be cleared when assigning new group numbers.

Copy from closest

Copy from closest command assigns a group number to points that do not yet have a group
assignment (non-grouped points). It copies the group number from the closest grouped point in
given classes.



TerraScan User Guide  © 2023 Terrasolid Ltd

429TerraScan Window > Group pulldown menu > Copy from closest

Copying the group number may be useful for group assignment and classification of very dense
point clouds. The grouping and classification of groups processes can be speed up by the
following workflow:

· Thin points and move some of the points to an 'Unnecessary density' class.

· Run Assign groups and classification processes, exclude 'Unnecessary density' class.

· Copy class to 'Unnecessary density' points from closest classified point.

· Copy group to 'Unnecessary density' points from closest grouped point.

To copy the group number from closest points:

1. Select Copy from closest command from the Group pulldown menu.

This opens the Copy Group from Closest dialog:

2. Define settings and click OK.

This assigns the number of the closest group to non-grouped points.

SETTING EFFECT

Class Point class(es) effected by the process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Search radius Distance around a point within which the
software checks for points with a group
assignment.

Inside fence only If on, only loaded points that are located
inside a fence or selected polygon are
effected. Requires a fence or selected
polygon in the CAD file.

Inspect groups

Inspect groups command supports the systematic check of groups. It provides a list of groups
from which you can select one group after the other.
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The tool includes view settings that define CAD file views displaying the selected group in
different view orientations. The selected element is automatically centered in these views. It
becomes the active displayset and thus, it is displayed in views for which Points is set to
Displayset only in the Display mode dialog. In addition, the tool allows the definition of up to
four classification buttons for modifying the class of a group.

To inspect groups:

1. Select the Inspect groups command from the Groups pulldown menu.

This opens the Inspect Groups dialog:

SETTING EFFECT

Groups with Determines which groups are inspected:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Point class(es) that are included in the
group inspection.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Top view View window that displays the point cloud
in a top view.

Second top view View window that displays the point cloud
in a top view.

Front view View window that displays the point cloud
in a front section view. The cross section is
90 degree rotated compared with the Right
view.

Right view View window that displays the point cloud
in a right section view. The cross section is
90 degree rotated compared with the Front
view.

Section view View window that displays the point cloud
in a section. The section is aligned to the
shape of the group. The depth of the
section either includes all points of a group
or is defined by switching on the Depth
option and typing a depth value in the text
field.

Isometric view View window that displays the point cloud
in an isometric view.

Camera view View window that displays the point cloud
in a camera view. The view can display
images that are referenced by an active
image list in TerraPhoto.
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SETTING EFFECT

Fit view If on, the selected group is automatically
fitted and centered in the view.

Button 1...4 If on, a target class can be selected for
classifying the group into another class after
inspection.

Remove If on, the selected group is removed from
the list in the Inspect Groups list dialog.

3. Define settings and click OK.

This opens another Inspect Groups dialog that contains the list of groups:

4. Select a line in the list of elements.

This centers the selected group in all view windows defined in the tool’s View settings. You
can click on the classification buttons of the dialog to classify a group into another target
class.

SETTING EFFECT

Remove Removes the selected group from the list.
The group itself is not deleted. The button
is inactive if Remove is switched on in the
tool's Classification action settings.

<Class> Up to four classification buttons defined in
the tool's Classification action settings. The
button shows the name of the target class.
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SETTING EFFECT

Show location Select a line in the list, click on the button
and move the mouse pointer inside a view
window. This highlights the selected group
in the view.

Identify Click on the button and identify a group
with a data click in a view window. This
selects the corresponding line in the list.

Moves one image backward in the active
image list and displays the new image in
the camera view. This is only visible if a
Camera view is set in the tool's View
settings.

Click on the button and move the mouse
pointer inside a view window. The image
closest to the mouse pointer is highlighted.
Select an image for the camera view
display with a data click. This is only visible
if a Camera view is set in the tool's View
settings.

Moves one image forward in the active
image list and displays the new image in
the camera view. This is only visible if a
Camera view is set in the tool's View
settings.

Split by class

Split by class command can be used to split groups if points in the group belong to different
classes. This may happen, for example, if different objects are close to each other, such as poles
and vegetation. Grouping may result in one group for a pole and close-by vegetation.

To split groups by  class:

1. Select Split groups by class command from the Group pulldown menu.

This opens the Split Groups by Class dialog:
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2. Define settings and click OK.

This assigns a new group number to points in the selected class(es), if points from another
class are in the same group.

SETTING EFFECT

Class Point class(es) that are split from groups
containing points of several classes and
become an own group.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Test parameters
Not Lite

Test parameters command can be used to test parameters for the differentiation of point
groups. The testing is done based on sample groups which need to be defined before running
the command. As a result of the testing, a parameter file can be saved. This is then used to
classify points with the By parameters routine for point groups.

There are several parameters which may be used to distinguish groups:

· Transparency - number of returns or density of points.

· Intensity - intensity values. Requires intensity values stored for points.

· Scanner 1|2|3 intensity - intensity values of different scanners/wavelengths. Requires data
from a multiple-wavelength scanner.

· Color brightness  - brightness values.

· Color red|green|blue - color values in red, green, blue channel. Requires color values stored
for points.

· Color N - near-infrared value. Requires a near-infrared value stored for points.
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· Complex|Planar|Linear ratio - dimension ratio. Requires normal vector and dimension
computed for the points.

· Crown sharpness - shape of a tree crown.

· Height - height from ground.

· Width to height - width to height ratio of a group.

· NDVI - normalized differential vegetation index.

A typical use case for Test parameters is the recognition of tree types from multi-spectral point
clouds. The point cloud may be produced by a multi-wavelength scanner, from near-infrared
stereo image pairs or by assigning color values from near-infrared images to a LiDAR point
cloud. The workflow for classifying points of trees of different types into separate classes can
be outlined as follows:

1. Classify the ground.

2. Compute distance from ground for above ground points.

3. Classify by distance from ground. Points on trees are classified into High vegetation class.

4. Assign groups to points in High vegetation class.

5. Classify trees using the Best match routine.

6. Classify sample trees into separate classes. There should be a few sample groups for each
tree type.

7. Test parameters based on the sample groups. Depending on the source data, there may be a
combination of 2-4 parameters that give the best probability of separating the tree types.

8. Save a parameter file.

9. Classify the data set using the parameter file.

To test parameters and save a parameter file:

1. Compute the distance from ground using the Compute distance command or corresponding
macro action.

2. Assign groups using the Assign groups command or corresponding macro action.

3. Define sample objects by classifying groups manually or automatically into separate classes.

4. Select Test parameters command from the Group pulldown menu.

This opens the Select Test Classes dialog:
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The upper part of the dialog shows a list with all classes for which groups are assigned and
the amount of sample groups for each class.

5. Select classes you want to use for testing. Define additional settings.

SETTING EFFECT

Use Determines which points from the selected
classes are used for deriving parameters:

· All points - all points.

· Only | First | Last echoes - only points of the
given echo type.

· Highest points - the highest points are used.
The value given in the Top field determines
the percentage of highest points measured
from the ground to the top point.
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6. Click OK.

This opens the Test Group Parameters
dialog.

The upper part of the dialog shows a list
of parameters and their certainty of
distinguishing the sample classes from
each other. The parameter with the
highest certainty percentage is selected
automatically. The combined
percentage value below the list shows
the final certainty of differentiation if
several parameters are selected.

The central part of the dialog illustrates
how good the sample classes can be
distinguished by a selected parameter.
The black field represents a statistical
value from 0.0 to 1.0. The colored bars in
the field show where the sample groups
are located within the range of 0.0 to
1.0. If the sample groups overlap, the
differentiation is less certain as if
groups are clearly separated. The color
of the bars is determined by the class
color settings in TerraScan. The field
below also shows for each sample group
where it is located in the range
between 0.0 and 1.0. In addition, a
weight factor is displayed.

The lower part of the dialog contains a
list of all sample groups and their
statistical value of a selected
parameter. Critical sample groups that overlap with groups from other classes are displayed
in red. A selected sample group can be centered in a view by using the Show location button
and placing a data click inside the view.

7. Select different parameters and check how well they distinguish the sample classes. Switch
on all parameters that you want to use in the final parameter set.

8. Click on the Save settings button.

This opens the Group parameter file dialog, a standard dialog for saving files.

9. Define a location and name for storing the parameter file and click Save.

This saves the parameters into a text file.
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Write group info

Write group info command can be used to export information about groups into a text file. This
requires that groups are assigned to points.

The format of the output file is defined in the File formats / User group formats category of the
TerraScan Settings. Depending on the object type that is represented by the groups, the output
file may include different information derived from the groups. The settings category includes
two example definitions dedicated for exporting tree information.

To output group information:

1. Select Write group info command.

This opens the Write Group Info dialog:

2. Define settings and click OK.

This opens the Group output file dialog, a standard dialog for saving files.

3. Define a storage directory and name for the output file and click Save.

This creates the output text file.

SETTING EFFECT

Groups with Determines which groups are considered:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

Class Point class(es) that are included in the
output.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in the
Class field.

Ground Point class(es) that represent the ground.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in the
Ground field.

Inside fence Determines how a fence or selected
polygon(s) effect the trunk measurement:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Format Pre-defined format of the output file. The
list contains all formats that are defined in
the File formats / User group formats
category of the TerraScan Settings.

Diameter CAD file level that contains circular elements
representing tree trunks. The elements may
be created by using the Measure Trunk
Diameters tool. This is only active if a Format
is chosen that includes the Trunk diameter
attribute.

Write column titles If on, header row with column titles is
written to the output file.

Write group points

Write group points command can be used to write a separate point cloud file for each group.
This requires that groups are assigned to points.
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To write group points:

1. Select Write group points command from the Group pulldown menu.

This opens the Write Group Points dialog:

2. Define settings and click OK.

This creates point cloud files in the given directory where each file represents one group.

SETTING EFFECT

Groups with Determines which groups are written:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

Class Point class(es) that are written into the
output files.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Format File format of the output files. The list
contains all binary formats for point clouds
that are implemented in TerraScan.

Folder Output directory for the new files. Use the
Browse button in order to open the
standard dialog for selecting a folder.

Name prefix Text string that is added in the beginning of
the name of the output files. This is
followed by the TerraScan group number.
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File pulldown menu

Commands from the File pulldown menu are used to open, save and close points.

TO USE COMMAND

Read points of a project block Open block Not UAV

Read points of a project block inside a fence Open inside fence Not UAV

Read points from a file Read points

Read points from files in a directory Read directory

Read points as read-only reference Read reference points

Save modified points Save points

Save or export points to a file Save points As

Change the cloud type setting for loaded
points

Cloud type

Close loaded points Close points

Close points

Close points command removes loaded points from memory.

If points have been modified, a dialog opens to ask if you want to save changes before closing
the points.

· Click Yes to save points. If points can not be saved into the original file, the Save points
dialog opens. See Save points As command for a description of the dialog’s settings.

· Click No to unload points without saving changes.

· Click Cancel to close the dialog without removing the points from memory.

Cloud type

Cloud type sub-pulldown menu lets you select the type of the point cloud loaded in TerraScan.
Selecting the correct type is recommended in order to optimize the processing speed for many
automatic routines. The command can be used to change the cloud type if it has not been
selected correctly when reading points.

The following point cloud types are available:

· Airborne lidar - point cloud captured by an airborne laser scanner system. The system is
carried by flying vehicle.

· Mobile lidar - point cloud captured by a mobile laser scanner system. The system is carried
by a ground-based vehicle.
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· Stationary lidar - point cloud captured by a static terrestrial laser scanner system. The
scanner is mounted on a static device such as a tripod.

· Airborne photo - photogrammetric point cloud generated from airborne images. The images
are captured from a flying vehicle.

· Mobile photo - photogrammetric point cloud generated from mobile images. The images are
captured from a ground-based vehicle.

· Stationary photo - photogrammetric point cloud generated from static terrestrial images.
The images are captured by a static camera mounted on a tripod.

· Boat sonar - point cloud captured by a sonar mounted on a boat.

· Mixed - point cloud produced by different devices.

Open block
Not UAV

Open block command loads points linked to a TerraScan project block into memory. You select
the project block geographically by clicking inside the boundary of the block. The software
reads the binary file that is linked to the selected project block.

You can open a block for modification or for viewing only. This setting has an effect if you use
project file locking. See File locking for more information. The work with projects in TerraScan
is described in detail in Chapter Working with Projects.

To open points of a project block:

1. Select Open block command from the File pulldown menu.

This opens the Open Block dialog:

2. Define settings.

3. Move the mouse pointer into the project block you want to open.

A block boundary is highlighted dynamically if the mouse pointer is inside the block area.

4. Place a data click inside the block.

This reads the binary file linked to the selected block.

SETTING EFFECT

Neighbours Width of an overlap area around the active
block for which the application loads points
from neighbouring blocks.



TerraScan User Guide  © 2023 Terrasolid Ltd

443TerraScan Window > File pulldown menu > Open block

SETTING EFFECT

Open for Block opening mode: Viewing only or
Modification.

Fit view View(s) to fit in order to display the area of
all loaded points.

Load reference points If on, points from a reference project are
loaded. This is only active if a reference
project is set in the Project information
dialog. See Edit project information and
Compare with reference commands for more
information.

The points in a block may include classes that are not defined in the active class definition in
TerraScan. In this case, a temporary class is added to the active class definition for any
missing class. The temporary class gets a default description according to its class number, for
example “class 0” for a temporary class number 0. Any temporary class is deleted if the
points are unloaded. You can store a temporary class permanently by using the Define
Classes tool.

Open inside fence
Not UAV

Open inside fence command loads laser points from TerraScan project blocks inside a fence or
selected polygon(s). The points are opened for read-only access. After modifications, the
points can be saved into a new file using Save points As command.

To open points inside fence:

1. Draw a fence (MicroStation only) or polygon(s) around area(s) for which to load the points. Select
the polygon(s).

2. Select Open inside fence command from the File pulldown menu.

This opens the Open Inside Fence dialog:
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3. Define settings.

4. Move the mouse pointer into the view.

The fenced area is highlighted dynamically if the mouse pointer is inside the view.

5. Place a data click inside the view.

This reads the points from the binary files which fall inside the fenced area.

SETTING EFFECT

Class Class(es) that are loaded for the fenced
areas.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Only every If on, only every n th point is loaded where
n is the given number.

Conserve memory If on, the software first determines how
many points will be loaded and thus, how
much memory needs to be allocated for
the exact number of points. This slows
down the loading process but it is less
likely to run out of memory.

Attributes Attributes that are loaded for laser points.
Switch on attributes that you want to read
in. Only attributes that are stored in the
point file(s) are available for loading. Point
coordinates and the class number are
always required.
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Read collection

Read collection command loads points from all files in one or more given directories into
TerraScan. Basically, it performs the same action as the Read points command but for several
files at the same time.

To load points from files in  several source folders into memory:

1. Select Read collection command from the File pulldown menu.

This opens the Read Collection dialog:

2. Click the Add files button in order to select files for import in a standard dialog. Continue
with steps 3 or 5.

OR

3. Click Add folder button in order to select a directory from which to import files. This opens
the Read Directory dialog:

4. Define settings and click OK.

This adds all files of the given format to the list in the Read Collection dialog. You may
remove files from the list by selecting the corresponding line(s) and clicking the Remove
button.

5. If the collection of files for import is ready, click OK in the Read Collection dialog.
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This opens the Read Points dialog. Follow the steps of Read points procedure in order to load
the files.

SETTING EFFECT

Directory Path to the folder from which files are loaded.

Browse Opens a standard dialog for selecting a folder.
Select the folder from which to read files and
click OK. The path to the folder is written to
the Directory field.

Read all subfolders If on, files from subfolders are loaded as well.

Files Determines which files are loaded from the
directory:

· *.* - all files.

· *.fbi - all FastBinary files. Type the
extension of files you want to load after the
point character.

· pt*.fbi - all FastBinary files whose name
start with "pt". Use the * character to
replace a free number of characters in the
file name or extension.

· name.las - only the LAS file with the given
"name".

Read points
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More information about file formats that can be read into TerraScan can be found in Section
Supported file formats and File formats / User point formats category of TerraScan Settings.

You can load several files of the same file format together in one reading process. The file
format is automatically recognized if it is known by the software. The points of the selected
file(s) are loaded into TerraScan memory. You can add more points by loading additional files. If
the memory is full, the software shows an error message and the reading process stops.

To load points from files into memory:

1. Select Read points command from the File pulldown menu.

This opens the Read points dialog, a standard dialog for selecting files.

2. Select files and click Open.

This opens the Load points dialog.

3. Select the correct Cloud type. This is recommended in order to optimize the processing
speed for many automatic routines.

4. Define other settings and click OK.

This loads the points into the memory and displays them on the screen.

SETTING EFFECT

Cloud type Type of the point cloud related to the way
of how the point cloud is produced:

· Airborne lidar - point cloud captured by
an airborne laser scanner system. The
system is carried by flying vehicle.

· Mobile lidar - point cloud captured by a
mobile laser scanner system. The system
is carried by a ground-based vehicle.
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SETTING EFFECT

· Stationary lidar - point cloud captured by
a static terrestrial laser scanner system.
The scanner is mounted on a static device
such as a tripod.

· Airborne photo - photogrammetric point
cloud generated from airborne images.
The images are captured from a flying
vehicle.

· Mobile photo - photogrammetric point
cloud generated from mobile images. The
images are captured from a ground-based
vehicle.

· Stationary photo - photogrammetric point
cloud generated from static terrestrial
images. The images are captured by a
static camera mounted on a tripod.

· Boat sonar - point cloud captured by a
sonar mounted on a boat.

· Mixed - point cloud produced by different
devices.

The cloud type can be changed for loaded
points by using the Cloud type command.

Format Format of the point file. This is
automatically recognized by the software.
For user-defined text file formats, it might
be necessary to select the correct format.

Points Amount of points in all selected files.

Fit view Defines which CAD file view is fitted to the
extent of the loaded points:

· None - no view is fitted.

· All - all open views are fitted.

· 1...8 - the selected view is fitted. Only
numbers of open views are available.

Input projection Projection system of the input data. Click on
the >> Button to open the Browse for
Projection System dialog. The dialog
provides a search option for projection
systems as well as a list of all implemented
systems. In addition, any user-defined
projection systems are included in the list.

Active projection Projection system of the data for
processing. Click on the >> Button to open
the Browse for Projection System dialog.
The dialog provides a search option for
projection systems as well as a list of all
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SETTING EFFECT

implemented systems. In addition, any
user-defined projection systems are
included in the list.

Transform Additional transformation applied to
points during the reading process.

The list contains transformations that are
defined in Coordinate transformations /
Transformations category of TerraScan
Settings.

Coordinates Easting and Northing coordinate values of
the first point found in the point cloud. The
first values are coordinates in the Input
projection system, the second values in the
Active projection system or after an
additional transformation has been applied.
If the values are the same, no
transformation is applied. 

Only every If on, only a selection of points is loaded.
The software reads every n th point from
the file(s), where n is the given number.

Only class If on, only points from the selected class(es)
are loaded.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Only class field.

Inside fence only If on, only points inside a fence or selected
polygon are loaded.

Attributes Attributes that are loaded for laser points.
Switch on attributes that you want to read
in. Only attributes that are stored in the
point file(s) are available for loading. All on
and All off buttons switch the selection of
all attributes on or off. Point coordinates
and the class number are always required.

Line numbers Defines, how line numbers are assigned to
the points during the loading process:

· Use from file - line numbers from source
files are used.

· Assign constant - the number given in the
First number field is assigned to all
points.
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SETTING EFFECT

· First number in name - the first numerical
sequence in a file name is used as line
number.

· Last number in name - the last numerical
sequence in a file name is used as line
number.

· First number in folder - the first numerical
sequence in the name of the folder
containing the input files is used as line
number.

· Last number in folder - the last numerical
sequence in the name of the folder
containing the input files is used as line
number.

· Deduce using time - numbers are
assigned based on trajectories loaded
into TerraScan. The same process can be
performed for by the Deduce using time
command or the corresponding macro
action.

· Increase by xy jump - the line numbers
increase from the given First number if
the xy distance is bigger than the value
given in the By distance field.

· Increase by time jump - the line numbers
increase from the given First number if a
jump in time stamps occurs. This requires
that trajectory information is available in
TerraScan.

· Increase by file - the line numbers
increase from the given First number for
each separate file.

· Increase by file name - the line numbers
increase from the given First number for
each file with another file name. Files
with the same name get the same
number.

· Increase by directory - the line numbers
increase from the given First number for
each file stored in another source folder.
Files from the same source folder get the
same number.

The Line numbers settings are only
available if the Line attribute is switched on
for loading.

Scanner number Defines, how scanner numbers are assigned
to the points during the loading process:
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SETTING EFFECT

· File -- scanner byte - scanner number
stored in the 8-bit user data field is used.
This is the normal way of storing a scanner
number.

· File -- scanner channel - scanner number
stored in 2-bit scanner channel field of
LAS/LAZ 1.4 files is used. This may be
relevant for LAS/LAZ 1.4 files only.

· Assign constant - the number given in the
First number field is assigned to all
loaded files.

· Increase by file - the scanner numbers
increase from the given First number for
each separate file.

· First number in name - the first numerical
sequence in a file name is used as scanner
number.

· Last number in name - the last numerical
sequence in a file name is used as scanner
number.

· First number in folder name - the first
numerical sequence in the name of the
folder containing the point files is used as
scanner number.

· Last number in folder name - the last
numerical sequence in the name of the
folder containing the point files is used as
scanner number.

· Deduce using time - numbers are
assigned based on trajectories loaded
into TerraScan.

· From line number - the line number is
used as scanner number.

The Scanner number settings are only
available if the Scanner attribute is
available and switched on for loading.

Default Point that is assigned to all points if no class
attribute is stored in the point file. This is
only active if text file formats are selected
for loading.

The point file(s) may include classes that are not defined in the active class definition in
TerraScan. In this case, a temporary class is added to the active class definition for any
missing class. The temporary class gets a default description according to its class number, for
example “class 0” for a temporary class number 0. Any temporary class is deleted if the
points are unloaded. You can store a temporary class permanently by using the Define
Classes tool.
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Read reference points

Read reference points command loads points from files into TerraScan. Basically, it performs
the same action as the Read points command but the loaded reference points are read-only. By
default, the highest possible line number 65535 is assigned to reference points.

The reference points can be used for a direct comparison of old and new data sets. They are
required for the Fit to reference command which can be used, for example, to fit two
photogrammetric point clouds to each other.

To load reference points from files into memory:

1. Select Read reference points command from the File pulldown menu.

This opens the Read reference points dialog, a standard dialog for opening files.

2. Select files and click Open.

This opens the Load reference dialog, basically the same dialog as described for the Read
points command. The line number is fixed to 65535 in this dialog.

3. Define settings and click OK.

This loads the points into the memory and displays them on the screen.

Save points

Save points command saves all loaded points to the same binary file from which they were read
in or into which they were saved earlier.

To prevent an original file being overwritten by a file which does not include all original
information, the Save points command is disabled if points have been loaded incompletely.
This includes the following cases:

· any attribute was switched off.

· only points of selected classes were loaded.

· only points inside a fenced area were loaded.

· only every n th point was loaded.

Save points As

Save points As command writes points into a new file. The output file format can be any of the
Supported file formats implemented in TerraScan or a user-defined point file format. See File
formats / User point formats for more information.

To write points into a file:

1. Select Save points As command from the File pulldown menu.
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This opens the Save points dialog:

2. Define settings for the output file.

3. Click OK.

This opens the Save points dialog, a standard dialog for saving files.

4. Define a location and name for the output file and click Save.

This creates the output file.

SETTING EFFECT

Classes Selection of classes that are written into the
output file. Contains the list of active
classes in TerraScan. Use the <Shift> or
<Ctrl> keys to select several classes.

Select all Selects all classes in the list.

Deselect all Deselects all classes in the list.

Points Defines what points are written into the
new file:

· All points - all loaded points. This may
include inactive points, for example from
neighbour blocks or points extracted from
waveform information.

· Active block - points inside the active
block area. This is only active if there are
inactive points in memory.

Line Line(s) that are written into the new file:
points of All lines or points of the selected
line number.
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SETTING EFFECT

Format Format of the output file. The list of formats
includes all implemented file formats as
well as any user-defined formats.

Attributes Opens the Attributes to save dialog. Switch
on attributes that you want to write into the
output file. Only attributes that can be
stored in the selected format are available.
If specific attributes are required for the
selected output format they are switched
on by default.
If color values are stored for the points, an
additional selection of the amount of color
channels is required. See more information
here.

Delimiter Defines the delimiter for text files: Space,
Tabulator, or Comma. This is only active if
some of the implemented text file formats
are selected as Format.

Surface Class(es) from which a surface is computed.
This is only active if Format is set to E N Z dZ 
or if a user-defined format includes dZ,
where dZ is the elevation difference
between a point and the surface.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Surface field.

Xyz decimals Defines the number of decimals for
coordinate values. This is only active if an
implemented text file format is selected as
Format.

Transform Transformation applied to points during the
writing process.
The list contains transformations that are
defined in Coordinate transformations /
Transformations category of TerraScan
Settings.

Inside fence only Only points that are inside a fence or a
selected polygon are written into the
output file.

https://terrasolid.com/guides/tscan/prjnewproject.html#ats
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Line pulldown menu

Commands from the Line pulldown menu are used to manipulate laser points based on line
information or to create and modify lines.

TO USE COMMAND

Assign line number to laser points from
trajectory information

Deduce using time

Assign line number to laser points from scan
pattern

Deduce from order

Start a new line from a selected laser point Start new at selection

Modify the numbering of lines Modify numbering

Draw approximate flight path Draw from points

Apply a boresight angle correction Adjust laser angles Not Lite

Remove points from long range
measurements

Cut long range Not Lite

Remove points with low reliability values Cut low reliability Not Lite

Remove points from overlapping lines Cut overlap Not Lite

Fit a point cloud to control measurements or
to a reference point cloud

Fit using targets

Shift a point cloud interactively Translate

Rotate a point cloud interactively Rotate

The Line pulldown menu is not available if laser data is loaded into TerraScan using the Load
Ground Points tool or if the point cloud type is set to Stationary lidar when points are loaded
with the Read points command. In this case it is replaced by the Measurement pulldown menu
which offers special commands for laser data from static terrestrial scanners.

Adjust laser angles
Not Lite

Adjust laser angles command applies a positional correction to laser points. The command is
normally used to fix misalignment of lines in the laser data. The software computes an XYZ
correction for a point as true angular rotation of the vector from the scanner to the point. The
user can then decide, whether the full correction is applied or only a partial horizontal/vertical
correction along the XY or Z axis.

Adjust laser angles requires trajectory information in order to determine the scanner position
of each laser point. Therefore, trajectories must be imported into TerraScan and the line
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numbers of laser points must match the numbers of trajectories. See Deduce using time
command for more information about matching line numbers of points and trajectories easily.

Time stamps for laser points are not mandatory. If time stamps are present, the application can
derive the laser scanner position for each laser point more accurately. If time stamps are
missing, the application uses a perpendicular projection from a laser point to the trajectory in
order to determine the scanner position.

To adjust laser angles:

1. Select Adjust laser angles command from the Line pulldown menu.

This opens the Adjust Laser Angles dialog:

2. Define settings and click OK.

The application derives the laser scanner position for each point and applies a positional
correction according to the settings.

SETTING EFFECT

Flight line Line to which the correction is applied. Select
Any in order to apply the correction to all
loaded points.

Scanner Scanner to which the correction is applied.
This can be used for data from multi-scanner
systems. Select Any in order to apply the
correction to all loaded points.

Modify Coordinate axis to modify:

· Xyz - applies a full 3D correction.

· Xy - applies a horizontal shift relative to
trajectory and movement direction.

· Z - applies a vertical shift relative to
trajectory and movement direction.
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SETTING EFFECT

Input as Unit of misalignment correction values:

· Degrees - angles given in decimal degrees.

· Radians - angles given in radians.

· Ratio - angles given as a ratio over a value
corresponding to a full circle.

Heading Heading angle correction, positive values
increase in clockwise direction.

Roll Roll angle correction, positive values increase
in left wing up direction.

Pitch Pitch angle correction, positive values
increase in nose up direction.

Cut long range
Not Lite

Cut long range command cuts off long range measurements if there are shorter measurements
from the same line closeby. This is suited for point clouds from mobile/backpack/handheld
scanners which may see the same location multiple times in a single line. The main purpose of
the process is to reduces the noise level in the data set as longer measurements may be less
accurate.

To cut long range points:

1. Select Cut long range command from the Line pulldown menu.

This opens the Cut Long dialog:

2. Define settings and click OK.

This starts the process.
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SETTING EFFECT

Use classes Point class(es) that are considered in the
process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Use classes field.

Action Action to perform on points that are cut off:

· Classify - classify points into one target
class.

· Delete - remove points from the data set.

· Set overlap bit - sets the overlap bit for
points in LAS 1.4 files.

To class Target class for points that are cut off. This is
only active if Action is set to Classify.

Mode Determines how long measurements are
defined:

· Absolute limits - fixed Search radius and
Range difference settings are used.

· Relative limits - the Search radius
depends on the range from the scanner
and the point density is taken into
account.

Search radius Radius from a point within which the
software searches for shorter range points.
A point is cut off if another point with a
shorter range is found within the given
radius. Fixed value for Absolute limits and
factor of the range from scanner for Relative
limits.

Range difference Maximum allowed range difference of two
points. Only if the range difference is
smaller, the longer range point is cut off.
Expressed in CAD file units for Absolute
limits and percentage for Relative limits.

Favor Points may be favored to keep depending
on the scan direction: Forward points or
Backward points. If all points should be
treated the same, select Nothing. This is
only active if Mode is set to Relative limits.
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Cut low reliability
Not Lite

Cut low reliability command removes points with a low reliability value if there are points with
a higher average reliability in the closer neighborhood. This may be useful for point clouds
generated by photogrammetric methods that store a confidence value for each point (e.g.
Agisoft Confidence values stored as Reliability values in TerraScan). The value indicates from
how many images a point is generated. The more images are involved, the more confident a
point is generated. Therefore, it is recommended to use points with a higher reliability value, if
available.

To cut low reliability :

1. Select Cut low reliability command from the Line pulldown menu.

This opens the Cut Low Reliability dialog:

2. Define settings and click OK.

This starts the process.

SETTING EFFECT

Use classes Point class(es) that are considered in the
process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Use classes field.

Action Action to perform on points that are cut off:

· Classify - classify points into one target
class.

· Delete - remove points from the data set.
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SETTING EFFECT

· Set overlap bit - sets the overlap bit for
points in LAS 1.4 files.

To class Target class for points that are cut off. This is
only active if Action is set to Classify.

Keep Points are not cut off if the reliability value
is equal or higher than the given value.

Search radius Defines the circular sample area around a
point within which the software computes
the average reliability.

Limit A point is cut off if its reliability value is
worse than the given percent of the average
reliability computed for the sample area.

Cut overlap
Not Lite

Cut overlap command removes laser points from locations where laser data from multiple lines
overlap. The points of overlapping areas can be classified to a specific class or classes, or they
can be deleted from the data set. In LAS 1.4 files, the overlap bit can be set instead of
classifying or deleting points.

There are several methods for cutting off overlap. If you want to apply several methods to a
data set, run the one method after another in separate processing steps in order to avoid
incorrect results.

General procedure to cut overlap:

1. Select Cut overlap command from the Line pulldown menu.

This opens the Cut Overlap Points dialog:
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2. Define settings and click OK.

This classifies/removes points from overlapping areas.

SETTING EFFECT

Coverage classes List of point classes to consider when
determining if a line covers an area. Use 0-255
to cover all classes.

Select Opens the Select classes dialog which contains
the list of active classes in TerraScan. You can
select multiple source classes from the list
that are then used in the Coverage classes
field.

Action Action to perform on points in overlapping
areas:
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SETTING EFFECT

· Add constant to class - add a given value to
the class number.

· Classify to single class - classify points into
one target class.

· Delete - remove points from the data set.

· Set overlap bit - sets the overlap bit for
points in LAS 1.4 files.

Add Value to add to class numbers if Action is set
to Add constant to class.

To class Target class if Action is set to Classify to single
class.

Cut by quality

Cut by quality method removes lower quality laser points from locations where there is laser
data from a higher quality line. The method is suited if:

· there is laser data from two different flying altitudes. Data of a lower flight line is normally
more accurate than data of a higher line.

· the hardware was not working at the best level for some lines.

· the GPS trajectory is weak for some lines.

· there is laser data from single crossing lines while the majority of lines follows another
direction.

You can define the quality of lines as an attribute of imported trajectories. See Manage
Trajectories tool and Edit information command from the Trajectory window for more
information. If you do not have imported trajectories, you can assign quality values to different
line number sequences in the Default flightline qualities category of TerraScan Settings.

Before cut After cut by quality

Point color: red points are from a lower quality line, blue points from a higher quality line

SETTING EFFECT

Cut by quality If on, cut by quality method is applied.
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SETTING EFFECT

Hole size Approximate maximum diameter of hole. If a
larger area is not covered by points of a
higher quality line, points from the lower
quality line are kept.

Cut single scanner edges

Cut single scanner edges method is designed for removing overlap in data sets collect by
airborne dual-scanner systems. It removes edges of lines that are captured by one scanner only.

SETTING EFFECT

Cut single scanner edges If on, cut single scanner edges method is
applied.

Keep minimum Minimum central part of a line and scanner to
keep. A value of 20 would keep a +10.. -10
degree corridor of each line and scanner.

Cut by offset

Cut by offset method removes laser points from the edges of lines if the same location is
covered more vertically from another line. This method serves two purposes:

· Removing edges of lines produces a more uniform point density and point pattern.

· The magnitude of error sources grows with increasing scan angle. Removing edges of lines
removes less accurate points and keeps the more accurate central part of a line.

The method is suited for cutting off overlap between parallel lines in an airborne data set. It
requires trajectory information and matching line numbers of points and trajectories. See
Deduce using time command for more information about matching line numbers of points and
trajectories easily. If time stamps are not available for laser points, the application uses a
perpendicular projection from a laser point to the trajectory.

Before cut After cut by offset

Point color: different colors represent points of different lines
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SETTING EFFECT

Cut by offset If on, cut by offset method is applied.

Scan lines Scan line pattern of the data set:

· Perpendicular to flight - parallel or zigzag
scan lines.

· Elliptical - elliptical scan lines.

Keep minimum Minimum central part of a line to keep. A
value of 20 would keep a +10.. -10 degree
corridor of each line.

Cut by scan angle

Cut by scan angle method removes points with a scan angle that is larger than a given value. It
removes the edges of lines similar to the Cut by offset method but does not rely on trajectory
information.

SETTING EFFECT

Cut by scan angle If on, cut by scan angle is applied.

Keep angles <= Points with scan anlges smaller or equal to
the given value are kept.

Cut by range

Cut by range method removes laser points from the edges of a line if the same location is
covered by points from a shorter measurement distance. This method is designed for laser data
from mobile ground-based systems.

The software searches for points inside a sphere and cuts off points resulting from long
measurements if points from a shorter range within the search radius are present. The range
can be defined as 3D range or offset range. In addition, the method can favor points from first-
or last-in-time passes. This simplifies the removal of data from duplicated passes, e.g. when a
mobile system collected data in a city driving streets several times.

The method requires trajectory information and matching line numbers of points and
trajectories. See Deduce using time command for more information about matching line
numbers of points and trajectories easily.
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Before cut After cut by 3D range After cut by offset
range

Point color: different colors represent points of different lines

SETTING EFFECT

Cut by range If on, cut by range method is applied.

Use Method to use for cut by range: 3D range, 3D
range - favor first, 3D range - favor last, Offset
range, Offset range - favor first or Offset
range - favor last.

Search radius Radius of a sphere within which the software
searches for closer range points from another
line. The radius can be automatically
increased as a factor of the range. By
increasing the radius at longer ranges, the
method is more eager to keep points from
more distant lines.

Keep range Range from scanner within which all points
are kept.

Cut by density

Cut by density method is developed for removing overlap in merged point clouds from
different sensors. The merged point cloud is a result of several point clouds with significantly
different point densities. Examples are point clouds from mobile and airborne laser scanners,
or photogrammetric airborne and terrestrial laser point clouds. Some areas may be covered by
both sensors but other areas just by one sensor. In overlap areas, the method keeps the data
from the sensor with the higher point density and removes more sparse data from the other
sensor.

The cut overlap method requires scanner numbers assigned to the points. The data from
different sensors is identified by a unique scanner number.
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SETTING EFFECT

Cut by density If on, cut by density method is applied.

Search radius Determines the area in which the local
density is computed.

Keep classes Point class(es) from which all points are kept
even if the density is lower than in data from
another sensor. Examples: roofs from
airborne laser data, hard surface areas from
mobile laser data.

Scanner groups If a range of scanner numbers is given, the
corresponding sensors are treated as a group.
For example, if there is data from two mobile
laser scanners with numbers 1 and 2, and the
scanners are calibrated, use 1-2 in order to
define a group for these 2 scanners. Separate
different groups by semicolon, for example
1-2;3-4.
If the field is empty, each sensor is treated
individually.

Deduce from order

Deduce from order command assigns a line number to the laser points according to the scan
pattern of the scanner system. There are two scan pattern supported:

· Rotating - the scanner system produces points in a circular pattern for each line.

· Zigzag - the scanner system produces points in a linear zigzag pattern for each line.

To deduce line numbers from the scan pattern:

1. Select Deduce from order command from the Line pulldown menu.

This opens the Deduce line numbering dialog:

2. Type a number for the first line in the First line field.

3. Select the Scan pattern type.

4. Click OK.



TerraScan User Guide  © 2023 Terrasolid Ltd

467TerraScan Window > Line pulldown menu > Deduce from order

This assigns line numbers to the laser points according to the scan pattern. An information
dialog shows the resulting line numbers.

Deduce using time

Deduce using time command assigns line numbers to laser points based on time stamps and
imported trajectory information. The process looks at the time stamp of each laser point, finds
a trajectory which covers that time and assigns that trajectory number to the laser point.

The command is the easiest way to make sure that the line numbers of laser points match the
trajectory numbering.

The process of deducing line numbers works only correct if the time stamps of laser points and
trajectories are unique. This may cause a problem, for example, if time stamps are stored in
GPS second-of-week format and if you have loaded multiple flight sessions from the same
week day but different weeks. If both, laser points and trajectories store time stamps in GPS
standard time format, the time information is unique and there are no roll-over problems
between different weeks.

Matching time stamps of laser data and trajectories are required for a number of processing
steps, especially in TerraMatch but also in TerraScan.

The same process can be done during the import of points into a TerraScan project or as a macro
step. See Import points into project command and Deduce line numbers macro action for more
information.

To deduce line numbers from trajectories:

1. Load trajectories into TerraScan.

2. Select Deduce using time command from the Line pulldown menu.

This assigns the trajectory numbers as line number attributes to laser points. An information
dialog shows the number of points that were effected by the process.

Draw from points

Draw from points command draws an approximate survey path as a linear element into the CAD
file. This works if the laser points are in the original scan order as the command deduces the
path from laser points only.

To draw an approximate flight path:

1. Choose Draw from points command from the Line menu.

This opens the Draw Flight Lines dialog:
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2. Define a Maximum gap value and click OK.

This computes the approximate survey path(s) and draws one or several linear elements into
the CAD file. The line elements are drawn on the active level using the active symbology
settings of the CAD file.

SETTING EFFECT

Maximum gap A new line element starts if the distance
between two consecutive laser points
exceeds this value.

Fit using targets

Fit using targets command can be used to georeference point clouds based on control
measurements. The process derives a transformation from source and target points. In the
point cloud, the following source objects are applicable:

· ball targets - ball objects with a constant and known diameter, requires empty space above
the ball object, ball must be located lower than the
scanner.

· square signals - four black and white squares in
chessboard pattern, visible in the RGB colors of a point
cloud and placed on vertical surfaces, such as walls.

· manual entry - interactive definition of source points.

The target points can be defined as follows:

· control points - coordinates of control points in a text file, format of the text file is PointID X
Y Z.

· manual entry - interactive definition of target points.

The transformation for fitting the source points to the target points may include:

· an XYZ shift and a 2D rotation.

· a rubbersheet correction that forces the point cloud to match the control point locations
with residuals to be 0. Warps the data to match the control points. The correction values are
computed based on a TIN model where the modification for places outside the TIN area
approach 0.

The georeferencing method is best suited for point clouds that are produced by handheld
devices, static scanners or cameras (photogrammetric point clouds), SLAM data sets, also from
indoor facilities.
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The transformation can also be applied to trajectories that are loaded in TerraScan and linked to
the point cloud loaded in TerraScan. This may be useful for SLAM data sets that include a
trajectory solution in a local coordinate system. As a result, the trajectory positions are
georeferenced as well.

If the difference between the original coordinate values of the point cloud and the target
coordinates is very large, it may be useful to shift the point cloud to the approximate location
of the geographic coordinate system before applying the Fit using targets command. This can be
done by defining a linear transformation in the TerraScan Settings and applying this
transformation when reading the point cloud into TerraScan. The same must be applied to
trajectories, if available.

To fit a  point cloud to targets:

1. Select Fit using targets command from the Line pulldown menu.

This opens the Fit Using Targets dialog:

2. Define settings and click OK.

If the Method is set to an automatic target detection method, the software searches for the
targets in the point cloud. It opens the Fit targets window. The window contains commands
for completing the fitting task.

SETTING EFFECT

Method Fitting method:

· Manual entry - source and target points for
computing the transformation are defined
manually. No additional settings are
required for this method and the Fit targets
window is opened without any entries.

· Automatic ball targets - ball objects are
available in the point cloud and represent
control point locations.

· Automatic square signals - square signal
marker objects are available in the point
cloud and represent control point locations.
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SETTING EFFECT

The signals must be located on vertical
surfaces and visible in RGB colors stored for
the point cloud.

From class Point class in which the software searches for
the target objects, such as balls or signal
markers.

To class Point class into which points from the target
objects are classified.

Diameter Diameter length of a ball target object. This is
only active if Method is set to Automatic ball
targets.

One square Size of one square in a square signal marker.
Typically, a chess-board pattern of four black
and white squares forms a signal. This is the
size of one black or white square. This is only
active if Method is set to Automatic square
signals.

Tolerance For ball targets, maximum distance of points
from the target objects to be considered as
returns from the target object.
For square signals, maximum angle off from
vertical surfaces.

Require Minimum amount of points that are returns
from a target. Only targets with at least this
amount of points are considered. This is only
active if Method is set to Automatic ball
targets.

Match limit Defines how easily the software finds a
square signal based on color values. This
needs to be changed if the software finds too
many wrong targets or not enough correct
targets in the point cloud. This is only active if
Method is set to Automatic square signals.
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Fit targets

COMMAND/BUTTON EFFECT

Show location Shows the location of a selected target
object. Select an entry in the targets list and
click Show location. Move the mouse pointer
inside a view. The target location is
highlighted by a small square and a cross. You
can center the target object in the view by
placing a data click inside the view.

Add source Add a new target object manually. Required,
if Manual entry was selected as Method in
the Fit Using Targets dialog or if the
automatic detection of target objects fails.

Enter target Define target coordinates for a target object
manually. Required, if Manual entry was
selected as Method in the Fit Using Targets
dialog or if there are no target coordinates
provided in the control point text file.

Remove Delete a selected target object from the list
and thus, from the transformation
computation. Should be done for false
findings of the automatic target object search
before reading a control point text file.

Apply Apply a transformation to loaded data.

File / Read targets xyz Read control point coordinates from a text
file and link them with the source
coordinates.

File / Save source xyz Write a text file with source point
coordinates.

File / Save transformation Write the transformation parameters into the
Transformation category of TerraScan
Settings. A transformation of Type 3D
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COMMAND/BUTTON EFFECT

translate & rotate and with the given Name is
created.

File / Save rubbersheet Write the rubbersheet correction values into
a text file.

Sort Sort the target object list by Increasing |
Decreasing X | Y.

To add a new target object manually :

1. Create a narrow cross section of the target object in the point cloud by using the Draw vertical
section tool.

2. Click Add source button in the Fit Targets window.

3. Place a data click in the cross section where you see the center point of the target object.

This adds the source coordinates of the new target object to the list in the Fit Targets
window.

To enter target coordinates for a target object manually :

1. Select the target object in the list in the Fit Targets window.

2. Click Enter target button in the Fit Targets window.

3. Place a data click in any view at the target location. You may use a snapping methods to snap,
for example, to the drawing of a control point in the CAD file in order to get exact XYZ
coordinates.

This adds the target coordinates to the target object selected in the list.

To continue with fitting a point cloud to target objects:

3. Check the targets that are listed in the Fit Targets window. If necessary, add additional target
objects or remove false findings by using the corresponding buttons of the window.

4. Select Read targets xyz command from the File pulldown menu.

This opens the Target coordinates file dialog, a standard dialog for selecting a file.

5. Select the control points text file and click Open.

The software links the control point coordinates stored in the text file with the source
coordinates. Coordinates that produce the smallest residuals are linked to each other.

6. Click Apply button in the Fit Targets window.

This opens the Apply Transformation dialog:
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7. Define settings and click OK.

This transforms the loaded point cloud and possibly also the active trajectory files.

SETTING EFFECT

Use Transformation type:

· Translate & rotate - applies a translation and
then a 2D rotation to the point cloud.

· Translate & rotate + rubbersheet -
additional rubbersheet correction.

Apply to Determines which data is modified:

· Loaded points - point cloud loaded in
TerraScan.

· Loaded points + trajectories - point cloud
loaded in TerraScan, and trajectories that
are in the active trajectory folder and linked
with the loaded points.

Modify numbering

Modify numbering command modifies the line number of points in a single or all lines. The
modification can be done for all points or a selection of point classes. Additionally, points of
the renumbered line(s) can be classified to another class at the same time.

To modify  line numbering:

1. Select Modify numbering command from the Line pulldown menu.

This opens the Modify Line Numbering dialog:
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2. Define settings and click OK.

This modifies the numbering for the laser points in the selected classes.

SETTING EFFECT

From class Point class(es) for which the new line
number is assigned.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

From line Line number to be changed. This can be a
specific line number between 0 and 65535,
or Any line.

To class Target class for laser points of the
renumbered line(s). Select Keep same if
you do not want to classify the points.

To line New line number assigned to the points.
This can be a specific line number between
0 and 65535.

The command can be used to classify points of a specific line into another class. If the line
numbers are the same in the From line and To line fields, the line attribute of points is not
effected.

Rotate

Rotate command lets you rotate a point cloud interactively. The point cloud is rotated around a
center point defined by a data click. In a top view, the point cloud is rotated in horizontal
direction, in a section view in vertical direction.
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To rotate a point cloud:

1. Select Rotate command from the Line pulldown menu.

This opens the Rotate measurement dialog:

2. Define settings.

If using Rotate: by mouse clicks:

3. Place a data click inside a view in order to define the center point of the rotation.

If the mouse pointer is moved, a temporary line illustrates the base line for the rotation.

4. Place another data click inside the view in order to define the origin point of the rotation (=
end point of the base line).

If the mouse pointer is moved, a temporary line illustrates the direction and angle of the
rotation.

5. Place another data click inside the view in order to define the destination point of the
rotation (= rotation direction and angle).

This rotates the point cloud to the new position.

OR if using some other Rotate setting:

3. Place a data click inside the view in order to accept the rotation.

This rotates the point cloud to the new position.

SETTING EFFECT

Measurement Points that are effected by the rotation: points
from all lines or only from one specific line.
The list contains all line numbers that are
available in the loaded point cloud.

Rotate Rotation method:

· By mouse clicks - source and target points
for computing the transformation are
defined manually. No additional settings
are required for this method and the Fit
targets window is opened without any
entries.

· By normal vectors - rotate the cloud to make
the dominant normal vector direction point
up.
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SETTING EFFECT

· 90 deg clockwise - 90 degrees around
vertical axis in clockwise direction. Sample
center defines the rotation center point.

· 180 deg  - 180 degrees around vertical axis.
Sample center defines the rotation center
point.

· 90 deg counter clockwise - 90 degrees
around vertical axis in counter clockwise
direction. Sample center defines the
rotation center point.

Start new at selection

Start new at selection command starts a new line numbering at the location of a selected laser
point. A new line number is assigned to all laser points that are recorded after the selected
point. The line number of all following points is increased by 1.

To start a new line numbering at a selection:

1. Select a laser point in TerraScan window using the Identify button or by selecting a row in the
point list.

2. Select Start new at selection command from the Line pulldown menu.

This assigns a new line number to all laser points recorded later than the selected point.

Translate

Translate command lets you shift a point cloud interactively. The shift can be horizontally,
vertically, or both.

To translate a point cloud:

1. Select Translate command from the Line pulldown menu.

This opens the Translate measurement dialog:

2. Define settings.

3. Place a data click inside a view in order to define the origin point of the translation.
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If the mouse pointer is moved, a temporary line illustrates the translation line.

4. Place another data click inside the view in order to define the target point of the translation.

This shifts the point cloud to the new position.

SETTING EFFECT

Measurement Points that are effected by the translation:
points from all lines or only from one specific
line. The list contains all line numbers that are
available in the loaded point cloud.

Move Dimension of the translation:

· Xyz - 3D shift.

· Xy only -  horizontal shift.

· Z only - vertical shift.
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Measurement pulldown menu

Commands from the Measurement pulldown menu are used to manipulate point clouds from
static terrestrial scanners. The Measurement pulldown menu becomes available, if point cloud
data is loaded into TerraScan using the Load Ground Points tool or if the Cloud type is set to
Stationary lidar when points are loaded with the Read points command.

The term "measurement" refers to a point cloud collected from one scanner position. "Scan" is
used as alternative term in the user guide. The number of a scan is stored as line attribute for
each point. In some tools, the term "line" is not replaced by "measurement" for static
terrestrial point clouds.

TO USE COMMAND

Shift a point cloud interactively Translate

Rotate a point cloud interactively Rotate

Place a target object in the CAD file Place target object

Transform a point cloud interactively Transform

Fit one scan to another Fit point clouds

Modify the numbering of scans Modify numbering

The Measurement pulldown menu is not available if point cloud data is loaded into TerraScan
using the Load Airborne Points tool or if the point cloud type is set to any other option than
Stationary lidar when points are loaded with the Read points command. In this case it is
replaced by the Line pulldown menu which offers commands for laser data from airborne or
mobile scanners, or for photogrammetric and other types of point clouds.

Translate

Translate command lets you shift a point cloud interactively. The shift can be horizontally,
vertically, or both. It may effect all scans or only one single scan.

To translate a point cloud:

1. Select Translate command from the Measurement pulldown menu.

This opens the Translate measurement dialog:

2. Define settings.
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3. Place a data click inside a view in order to define the origin point of the translation.

If the mouse pointer is moved, a temporary line illustrates the translation line.

4. Place another data click inside the view in order to define the target point of the translation.

This shifts the point cloud to the new position.

SETTING EFFECT

Measurement Points that are effected by the translation:
points from all scans or only from one specific
scan. The list contains all scan numbers that
are available in the loaded point cloud.

Move Dimension of the translation:

· Xyz - 3D shift.

· Xy only -  horizontal shift.

· Z only - vertical shift.

Rotate

Rotate command lets you rotate a point cloud interactively. The point cloud is rotated around a
center point and only in horizontal direction.

To rotate a point cloud:

1. Select Rotate command from the Measurement pulldown menu.

This opens the Rotate measurement dialog:

2. Define settings.

3. Place a data click inside a view in order to define the center point of the rotation.

If the mouse pointer is moved, a temporary line illustrates the base line for the rotation.

4. Place another data click inside the view in order to define the origin point of the rotation (=
end point of the base line).

If the mouse pointer is moved, a temporary line illustrates the direction and angle of the
rotation.

5. Place another data click inside the view in order to define the destination point of the
rotation (= rotation direction and angle).

This rotates the point cloud to the new position.
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SETTING EFFECT

Measurement Points that are effected by the rotation:
points from all scans or only from one
specific scan. The list contains all scan
numbers that are available in the loaded
point cloud.

Place target object

Place target object command lets you define the location of a target object in the point cloud.
The type of the target object can be defined in the Target objects category of TerraScan
Settings. Support types are ball, cone and pyramid. Point on the target object may be classified
into a separate class and used for placing the target object more accurately.

Target objects drawn in the CAD file may support the adjustment of several scans to each other
and to control points. You can snap to the target object's measurement point as well as to
control points drawn in the CAD file. This helps to define translation and rotation source and
target points for tools such as Translate, Rotate or Transform.

To place a target object:

1. Select Place target object command from the Measurement pulldown menu.

This opens the Place Target Object dialog:

2. Define settings.

3. Place a data click inside a view in order to define the center point of the target object.

If Fit to points is switched on, the software fits the target object to the points of the selected
point class.

The target object is drawn as cell elementMicroStation or symbolSpatix in the CAD file where the
center (measurement) point is marked with point. The elements are drawn on the active
level using the active symbology settings of the CAD file.

SETTING EFFECT

Object Type of the target object. The list contains all
target object types that are defined in the
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SETTING EFFECT

Target objects category of TerraScan Settings.

Fit to points If on, the target object is fitted automatically
to the points of the given point class.

Class Point class to which the target object is
fitted. The list contains all classes of the
active class file in TerraScan.

Within Maximum distance for fitting the target
object to points. The data click for placing the
target object must be within this distance
from the exact center point of the target
object in order to make the fitting work.

Transform

Transform command lets you interactively transform a point cloud. The transformation may
include a translation and/or a 2D rotation. It may effect all scans or only one single scan.

To transform a point cloud:

1. Select Transform command from the Measurement pulldown menu.

This opens the Transform Measurement dialog:
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2. Define settings.

3. Click on the Transform button.

This transforms the point cloud to the new position.

SETTING EFFECT

Apply to Points that are effected by the
transformation: points from all scans or only
from one specific scan. The list contains all
scan numbers that are available in the loaded
point cloud.

Original point E|N|Z XYZ coordinates of the origin point for the
translation. Click on the Enter button in order
to define the coordinate values with a data
click inside a CAD file view. Alternatively, type
the values in the fields.

Transform to E|N|Z XYZ coordinates of the target point for the
translation. Click on the Enter button in order
to define the coordinate values with a data
click inside a CAD file view. Alternatively, type
the values in the fields.

Define Determines how the rotation is defined:

· No rotation - no rotation is applied.

· Easting axis - the direction of the easting (X)
axis is defined.

· Northing axis - the direction of the northing
(Y) axis is defined.

· Direction point - two points define the
rotation direction.

E|N If the rotation is defined by Easting or
Northing axis, XY coordinates of the rotation
target point.
If Define is set to Direction point, the
coordinates on the left side determine the
origin point for the rotation and the
coordinates on the right side the target point.

The common transformation options of TerraScan can also be applied to the point cloud, for
example, by using the Transform loaded points command.

Fit point clouds

Fit point clouds command provides an option for automatically fitting one scan to another. The
scans should already be close to each other.
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To fit point clouds:

1. Select Fit point clouds command from the Measurement pulldown menu.

This opens the Fit Point Clouds dialog:

2. Define settings and click OK.

This fits the scans to each other if possible.

SETTING EFFECT

Move Number of the scan that is moved to the
other scan. The list contains all scan numbers
that are available in the loaded point cloud.

Fixed Number of the scan that is fixed and acts as
reference. The list contains all scan numbers
that are available in the loaded point cloud.

Use class Point class that is used to fit the scans.

Plane normals Maximum distance by which plane normals
differ from each other in the two scans. The
normals are derived from locally planar areas
in the point cloud.

Fit comparison

Modify numbering

Modify numbering command modifies the scan number of points for a single or all scans. The
modification can be done for all points or a selection of point classes. Additionally, points of
the renumbered scan(s) can be classified to another class at the same time.
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To modify  scan numbering:

1. Select Modify numbering command from the Measurement pulldown menu.

This opens the Modify Numbering dialog:

2. Define settings and click OK.

This modifies the scan number for the laser points in the selected classes.

SETTING EFFECT

From class Point class(es) for which the new line
number is assigned.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

From measurement Scan number to be changed. This can be a
specific scan number from the list or Any.
The list contains all scan numbers that are
available in the loaded point cloud.

To class Target class for laser points of the
renumbered scan(s). Select Keep same if
you do not want to change the class of the
points.

To measurement New scan number assigned to the points.
This can be a specific number between 0
and 65535.

The command can be used to classify points of a specific scab into another class. If the scan
numbers are the same in the From measurement and To measurement fields, the line
attribute of points is not effected.
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Output pulldown menu

Commands from the Output pulldown menu are used to create output alignment reports, to
create surface models, to export points as lattice or raster files, and to draw points into the CAD
file.

TO USE COMMAND

Output report from alignment Output alignment report

Create a surface model Create surface model

Export laser data into a lattice file Export lattice model

Export laser data into a colored image Export raster image

Draw points into the CAD file Write to design file

Draw points as line strings into the CAD file Draw as line strings

Export vertex coordinates of vector elements
into a text file

Write element vertices

Create surface model

Create surface model command passes points in a selected class to TerraModeler.
TerraModeler creates a triangulated surface model from the points.

The command requires TerraModeler running on the same computer. It starts the application if
it is not yet running.

To create a triangulated surface model:

1. Select Create surface model command from the Output pulldown menu.

This starts TerraModeler if it is not yet running and opens the Create Surface Model dialog:

2. Select a Point class to use for surface creation and click OK.

TerraModeler opens the Triangulate surface dialog.

3. Define settings and click OK.

This opens the TerraModeler Surface settings dialog.

4. Enter a descriptive name for the new surface, define other settings if required, and click OK.
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TerraModeler creates the surface model.

For more detailed information about surface creation and display in TerraModeler, see the
TerraModeler User Guide.

The command performs a similar action as the Create Editable Model tool. However, the
surface model created by the command is not editable, which means that the surface model
is not updated if the points in the source class are modified.

Draw as line strings

Draw as line strings command draws points loaded in TerraScan as line string element(s) into
the CAD file. The points are connected in the order they appear in the file or in the point list in
the TerraScan window.

The line strings may be separated by a line number assigned to the points. The command
connects only points of the same line number with a single line string.

To write points as line strings into the CAD file:

1. Select Draw as line strings command from the Output pulldown menu.

This opens the Draw as Lines Strings dialog:

2. Select a point class and click OK.

This draws the line strings into the CAD file using active symbology settings of the CAD file.

SETTING EFFECT

Class Point class(es) to draw into the CAD file.
The list includes the active classes in
TerraScan.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

https://terrasolid.com/guides/tmodel/triangulatesurvey.html
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Export lattice model

Export lattice model command creates a grid file with uniform distances between points from
one or more selected point classes. For each grid point, the lattice model file stores XY
coordinates and one of the following value types:

· elevation values

· point count/density values

· analytical values, such as average intensity, horizontal or vertical distance, surface
roughness

There are several formats supported to store lattice models as raster or text files. The command
requires the selection of at least one polygon that defines the lattice model boundary. If
several polygons are selected, the software creates a separate lattice model file for each
polygon. Text elements placed inside the polygon(s) can be used as file names for the lattice
model files. A polygonal area is always expanded to a rectangular area of a lattice model. The
cells outside the polygon are filled with a defined “outside” value or can be skipped from
output in XYZ text files.

To export a lattice model:

1. (Optional) Draw rectangle(s) around areas from which you want to create lattice model(s).
Place text elements inside the rectangles. Select rectangle(s) and text(s).

2. Select Export lattice model command from the Output pulldown menu.

This opens the Export Lattice Model dialog:
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3. Select settings and click OK.

This starts the lattice model file creation.

If File naming is set to Enter name for each, the Export lattice model dialog opens, a standard
dialog for saving files.

4. Define a location and name for the lattice file and click Save.

Repeat step 4 for each lattice model.

SETTING EFFECT

Class Source class(es) for lattice model creation.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Value Value stored for each grid point of a lattice
model:

· Triangulated model z - elevation value
calculated from a TIN model of the points
in the source class(es).

· Highest hit z - elevation value determined
by the highest point in the source
class(es).

· Average hit z - elevation value calculated
as average of points in the source
class(es) falling inside the grid cell.

· Lowest hit z - elevation value determined
by the lowest point in the source
class(es).

· Closest hit z - elevation value determined
by the point closest to the grid cell center
in the source class(es).

· Point count - amount of points falling
inside the cell.

· Point density - amount of points per
squared master unit.

· Average intensity - average intensity
value of points in the source class(es)
falling inside the grid cell.

· Distance to point - average horizontal
distance between a grid point and the
two closest points in the source class(es).

· Dz from ground - vertical distance
between a grid point and a surface model
created from the Ground class(es).
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SETTING EFFECT

· Surface roughness - difference of a grid
point from a plane fitted to the closest
points in the source class(es). Represents
the local elevation variation of points in
the source class(es).

· Biggest distance - biggest distance value
inside the grid cell. Requires that a
distance value is computed for each point
using the command for loaded points or
corresponding macro action.

· Average distance - average distance value
of points inside the grid cell. Requires
that a distance value is computed for each
point using the command for loaded
points or corresponding macro action.

· Smallest distance - smallest distance
value inside the grid cell. Requires that a
distance value is computed for each point
using the command for loaded points or
corresponding macro action.

Ground Source class(es) for creating a surface
model. This is only active if Value is set to
Dz from ground.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground field.

Export Area to be exported into lattice model
file(s):

· Whole area - the area covered by the
loaded points is exported into a single
lattice model file.

· Selected rectangle(s) - the area inside
selected polygon(s) is exported into
separate files.

Expand by Distance by which a selected polygon is
expanded for the model export. The area
covered by the expanded polygon is
included in a lattice model file. This is only
active if Export is set to Selected
rectangle(s).

Grid spacing Defines the distance between grid points
and thus, the resolution of the lattice
model.
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SETTING EFFECT

Max triangle Maximum length of a triangle edge for TIN
creation. Effects how big gaps are filled in
the lattice model by interpolating grid point
values from the TIN. This is only active if
Value is set to Triangulated model z, or
Distance to point.

Model buffer Width of a buffer area around the actual
model area that is considered for calculating
grid point values. This is only active if Value
is set to Triangulated model z, Distance to
point, Dz from ground, or Surface
roughness.

Fill gaps up to Defines the size of gaps that are filled in the
lattice model by deriving grid point values
from closest points in the source class(es).
This is only active if Value is set to Highest,
Average, Lowest hit z, Average intensity, or
Surface roughness.

File format Format of the lattice model file: ArcInfo,
GeoTIFF, Intergraph GRD, Raw, Surfer ASCII
or binary, Xyz text.

Z unit Unit of grid point values. Relevant for
formats storing elevations as integers. This
is only active if File format is set to GeoTIFF,
Intergraph GRD, or Raw.

Outside points Defines how the software handles grid cells
that are not covered by points in the source
class(es): Skip or Output. This is only active
if File format is set to Xyz text.

Outside Z Defines the value for grid cells that are
inside the rectangular lattice model area
but not covered by points in the source
class(es). This is only active if File format is
set to ArcInfo, GeoTIFF, Surfer ASCII and
binary, Xyz text.

Z decimals Determines the number of decimals stored
for the grid point value. This is only active if
File format is set to ArcInfo, Surfer ASCII, or
Xyz text.

Create TFW files If on, the software creates external
georeference files for GeoTIFFs. This is only
active if File format is set to GeoTIFF.

File naming Defines how lattice model files are named:
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SETTING EFFECT

· Enter name for each - a name for each
lattice model file has to be defined
manually.

· Selected text elements - selected text
elements inside the lattice model area
are used as file names.

This is only active if Export is set to Selected
rectangle(s).

Directory Directory for storing lattice model files.
Click on the Browse button in order to
select a folder in the Browse For Folder
dialog. This is only active if File naming is
set to Selected text elements.

Extension Extension of lattice model files. There may
be a specific extension required for a
certain file format, such as .GRD for ArcInfo
or .TIF for GeoTIFF. This is only active if File
naming is set to Selected text elements.

Lattice models can be produced in batch mode by using

· Export lattice models command for project blocks.

· Export lattice macro action.

· Produce lattice models command in TerraModeler.

Export raster image

Export raster image command generates a raster image where pixel values are derived from
laser point attributes. The source data is points loaded in TerraScan.

The raster image can be created as Windows bitmap (.BMP) or GeoTIFF (.TIF). The color of a
pixel is determined using laser points whose coordinate values fall inside the pixel. The
coloring attribute can be chosen as:

· Distance - distance value based on the distance computation. The Colors button opens the
Distance Color Scheme dialog which lets you define a coloring scheme for the distance
values. From this dialog, you may save the coloring scheme into a .DCS file for later reuse or
exchange between different PCs. The file can also be utilized as scheme definition in the
Export raster images command for projects.

· Elevation - laser point elevation.

· Elevation difference - elevation difference between laser points of two different classes.

· Intensity hits - laser point intensity.

· Intensity footprint - average intensity of points within a footprint area overlapping the pixel.

· Normal - direction of the normal vector relative to horizontal plane.

https://terrasolid.com/guides/tmodel/sw_producelatticemodels.html
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· Point color - color values stored for laser points.

· Point class - laser point class.

· Road intensity - intensity of laser points computed by directional sampling along road
alignment vectors.

· Slope - slope gradient based on normal vector computation.

To create a colored raster image:

1. Select Export raster image command from the Output pulldown menu.

This opens the Export Raster Image dialog:

2. Define settings. You may define your own coloring scheme by using the Define button.

3. Click OK.

This starts the generation of the raster file and opens the Export raster image dialog, a
standard dialog for saving files.

4. Define a location and name for the output file and click Save.

This creates the raster image.

SETTING EFFECT

Color by Coloring attribute. See description above.
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SETTING EFFECT

Class Point class(es) to use for creating the raster
file. If Color by is set to Elevation
difference, two classes have to be selected.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Alignments Level on which the road alignment vectors
are located. This is only active if Color by is
set to Road intensity.

Value Determines the value for each pixel:

· Lowest - smallest value of points inside
the pixel area.

· Average - average value of points inside
the pixel area.

· Highest - highest value of points inside
the pixel area.

This is only active if Color by is set to
Elevation, Elevation difference, or Intensity
hits.

Sampling Computation of raster values based on
directional sampling:

· Road intensity - distance along the road
alignment element(s).

· Slope - radius around a point.

Format Format of the output file: Windows BMP,
GeoTIFF, or GeoTIFF + TFW.

Background RGB values for pixels that do not have an
attribute value.

Colors Color depth of the output file for elevation
or intensity coloring:

· 24 Bit Color - true color image.

· 256 Colors - 256 color image.

· Grey Scale - 8 bit gray scale image.

Pixel size Size of each pixel in the output file.

Fill gaps If on, gaps up to the given number of pixels
are filled in places where there are no laser
points inside a pixel area.

Attach as reference If on, the output image is attached as a
raster reference. This requires TerraPhoto
to run.
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SETTING EFFECT

Draw placement rectangle If on, the output image boundary is drawn
as a shape into the CAD file. The shape is
drawn on the active level using the active
symbology settings of the CAD file.

Range Defines the value range that is covered by
the color scheme for Elevation and Intensity
coloring. Should be set to the general
elevation or intensity range covered in the
laser data to ensure that all values are
represented by the complete color scheme.

Unit Defines the unit for Slope coloring: Degree
or Percentage.

Scheme Type of coloring scheme for elevation or
intensity coloring:

· Cold to hot - varies from blue for low
pixel values via cyan, green, and yellow to
red for high pixel values. This is a
common coloring scheme for elevation
coloring.

· Hot to cold - varies from red for low pixel
values via cyan, green, and yellow to blue
for high pixel values.

· Selected colors - a user-defined coloring
scheme can be created by clicking on the
Define button. The dialog for color
scheme definition depends on the
selection of the color depth in the Colors
field, 24-Bit Color or 256 Colors.

· Black to white - varies from black for low
pixel values to white for high pixel
values. This is only active if Colors is set to
Grey scale. This is the common coloring
scheme for intensity coloring.

· White to black - varies from white for low
pixel values to black for high pixel values.
This is only active if Colors is set to Grey
scale.

Degree Determines how the color changes in color
schemes are computed. Warm and Hot
move a coloring scheme towards the red-
yellow color range, Cool and Cold towards
the blue-cyan color range. For gray scale
images, Light moves the gray scale towards
white and light gray, Dark towards black and
dark gray. Linear defines a linear
distribution of colors.
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Raster images can be produced in batch mode by using the Export raster images command for
project blocks.

Output alignment report

Output alignment report command generates a report with information at given intervals along
an alignment element. The command requires the definition of an alignment report format in
Alignment reports category of TerraScan Settings.

Alignment elements can be any linear element type such as line strings, shapes, circles, etc..
The report can be seen as a table where each row corresponds to an alignment station and each
column contains a specific type of information.

To create an alignment report:

1. Select an alignment element.

2. Select Output alignment report command from the Output pulldown menu.

This opens the Output Alignment Report dialog:

3. Define settings and click OK.

This opens the Alignment report dialog. The dialog contains the list of stations along the
alignment element and the information for each station according to the alignment report
definition.
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You can save the report as space-delimited text file by using the Text file command, or as
tabulator-delimited text file by using the Table file command from the Output pulldown
menu of the dialog.

To show the location of a station, select a line in the Alignment report dialog. Click on the
Show location button and move the mouse pointer into a view. This highlights the selected
station with a cross.

To identify a station, click on the Identify button and place a data click close to a station in a
view. This selects the corresponding line in the Alignment report dialog.

SETTING EFFECT

Format Alignment report format to use. Defines the
report content.

Transform Transformation applied to coordinates in the
report. The list contains transformations that
are defined in Coordinate transformations /
Transformations category of TerraScan
Settings. This is only active if coordinates are
included in the report.

Interval Distance between two consecutive stations
along the alignment element:

· Fixed step - fixed distance along the whole
alignment element.

· Triangle edges - distance is defined by
intersection points between surface
triangle edges and the alignment element.
This requires a surface model loaded in
TerraModeler.

Surface Name of the surface model. This is only active
if Interval is set to Triangle edges.

Step Distance between consecutive stations along
the alignment element. Given in CAD file
master units. This is only active if Interval is
set to Fixed step.

Min step Minimum distance between consecutive
stations along the alignment element. Given
in CAD file master units. This is only active if
Interval is set to Triangle edges.

Output vertices If on, the report includes the information from
each location of a vertex of the alignment
element in addition to the station locations.

Restart stationing at each vertex If on, station values restart from Start station
at each vertex location.
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SETTING EFFECT

Start station Station value at the start vertex of the
alignment element.

Output string Text string written into the report if a column
has no valid value.

Write element vertices

Write element vertices command writes vertices of selected vector elements to a text file. The
tool supports linear elements (lines, polygons, complex lines/polygons), ellipses and cells.

· Line elements - consecutive vertices are written in line direction.

· Polygon elements - boundary vertices are written in line direction. The first and last entry
for a polygon element are the same.

· Ellipses, cells - the center point of an element is written.

To write element vertices into a text file:

1. Select the element(s) to export.

2. Select Write element vertices command from the Output pulldown menu.

This opens the Write Element Vertices dialog:

3. Define settings and click OK.

This opens the Write Element Vertices Output File dialog, a standard dialog for saving a file.

4. Select a storage location and type a file name including the extension for the text file. Click
Save.

This creates the text file.

SETTING EFFECT

Format Format of the output text file. There are two
implemented formats: E N Z and Class E N Z,
where E N Z are the XYZ coordinates of the
vertices and Class is a code for the vector
element(s). Other formats can be defined in
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SETTING EFFECT

the File formats / User point formats category
of TerraScan Settings. Allowed attributes
include Easting, Northing, Elevation, Line,
Code, Class. Line is used as a counter for the
selected element, class is the same as code.

Add empty row after each element If on, an empty line is added to the text file
between the last vertex entry of one
element and the first vertex entry of another
element.

Code Code for the elements. This may include
alphanumerical, numerical or special
characters. This is only active if the Format
definition includes the Class or Code
attribute.

First line Number of the first vector element written
to the file. This is only active if the Format
definition includes the Line attribute.

Write to design file

Write to design file command draws points loaded in TerraScan permanently into the CAD file.
The command uses drawing rules assigned to point classes. See Define Classes tool for
information about class definitions.

The points drawn into the CAD file can be colored by the following methods:

· Active symbology - the active color of the CAD file is used for all points.

· Class - colors are defined in the active class file of TerraScan. See also Color by Class display
mode for points.

· Elevation - colors are determined by the elevation values of points. The coloring scheme can
be changed by clicking on the Colors button. See also Color by Elevation display mode for
points.

· Line - colors are determined by the line numbers of points. The colors can be changed by
clicking on the Colors button. See also Color by Line display mode for points.

· Intensity - colors are determined by the intensity values of points. The coloring scheme can
be changed by clicking on the Colors button. See also Color by Intensity display mode for
points.

· Point color - colors are determined by color values assigned to points.

To write points to the CAD file:

1. Select Write to design file command from the Output pulldown menu.

This opens the Write to Design dialog:
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2. Define settings and click OK.

This draws the points into the CAD file.

SETTING EFFECT

Color by Coloring method.

Color Opens the dialog for selecting colors or a
coloring scheme. This is only active if Color
by is set to Elevation, Line or Intensity.

Classes Point class(es) to draw into the CAD file. The
list includes the active classes in TerraScan.
You can switch all classes on or off by using
the All On and All Off buttons.

Only every If on, only every n th point is drawn into the
CAD file where n is the given number of
points.

Inside fence only If on, only points inside a MicroStation fence
or selected polygon are drawn into the CAD
file.

You can undo the drawing of points by using the Undo command of the CAD platform.
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Point pulldown menu

Commands from the Point pulldown menu are used to undo processing steps performed on
loaded points, to manipulate point attributes, to select points and to delete points.

TO USE COMMAND

Undo a classification action Undo

Undo classification actions from a list From list

Edit attributes of one or more laser points Edit selected

Select laser points of a specific class Select by class

Select laser points with specific attribute
values

Find

Delete points Delete

Delete

Delete commands can be used for deleting points from memory:

· Selected points - deletes the point(s) selected in the list of points.

· By point class - deletes all points in given class(es).

· By line - deletes all points of selected line(s).

· Inside fence - deletes all visible points inside a fence or selected polygon.

· Outside fence - deletes all visible points outside a fence or selected polygon.

· Using centerline - deletes all points which are more than a given distance away from a
selected centerline element. Any linear CAD element type can serve as a centerline
element.

If you delete points with the commands from the TerraScan window, the points are only
deleted from memory. You need to save the points in order to remove points permanently
from a file on a hard disk.

For LAS 1.4 files, you can decide whether to remove points or set the withheld bit. If Action is
set to Set withheld bit in any dialog for deleting points, the point is kept and only the withheld
bit is set. 

To delete selected points:

1. Select points in the list of points of TerraScan window. You need to switch the display size of
the TerraScan window to Medium dialog, Large dialog, or Wide dialog in order to see the list
of loaded points and the selected points.

2. Select Delete / Selected points from the Point pulldown menu.

This opens a dialog which asks for confirmation of the delete action. Click Yes in order to
delete the points and No in order to cancel the process.
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To delete points by  point class:

1. Select Delete / By point class from the Point pulldown menu.

This opens the Delete Points by Class dialog:

2. Select one or more class(es) of which you want to delete the points.

3. Click OK.

This opens a dialog which informs about the number of deleted points.

SETTING EFFECT

Action Defines what to do with the points:

· Delete - points are removed from the point
cloud. This is the normal action.

· Set withheld bit - the classification bit for
withheld (deleted) points is set. This
applies only to points stored in LAS 1.4 files.

To delete points by  line:

1. Select Delete / By line from the Point pulldown menu.

This opens the Delete by Line dialog:
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2. Select one or more line(s) from which you want to delete the points.

3. Click OK.

This opens a dialog which informs about the number of deleted points.

SETTING EFFECT

Action Defines what to do with the points:

· Delete - points are removed from the point
cloud. This is the normal action.

· Set withheld bit - the classification bit for
withheld (deleted) points is set. This
applies only to points stored in LAS 1.4 files.

All on Selects all lines in the list for deleting points.

All off Deselects all lines in the list for deleting
points.

To delete points inside or outside a fence:

1. Draw a fence or a polygon around the area for which you want to delete points. Select the
polygon.

2. Select Delete / Inside fence or Delete / Outside fence from the Point pulldown menu.

This opens the Delete Inside/Outside Fence dialog:

3. Select an Action.
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4. Click inside the view where the fence is defined.

This deletes points inside or outside the fence. It effects only points that are visible in the
view where the fence is defined. See Display mode for more information about point display
settings.

SETTING EFFECT

Action Defines what to do with the points:

· Delete - points are removed from the point
cloud. This is the normal action.

· Set withheld bit - the classification bit for
withheld (deleted) points is set. This
applies only to points stored in LAS 1.4 files.

To delete points using a centerline:

1. Select a centerline element.

2. Select Delete/ Using centerline from the Point pulldown menu.

This opens the Delete Using Centerline dialog:

3. Define settings.

4. (Optional) Show the distance by clicking on the Show boundary button. The boundary up to
which points are deleted is displayed if the mouse pointer is moved inside a view.

5. Click Apply.

This opens a dialog which asks for confirmation of the delete action. Click Yes in order to
delete the points and No in order to cancel the process. Another dialog shows the number of
deleted points.

SETTING EFFECT

Action Defines what to do with the points:

· Delete - points are removed from the point
cloud. This is the normal action.

· Set withheld bit - the classification bit for
withheld (deleted) points is set. This
applies only to points stored in LAS 1.4 files.
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SETTING EFFECT

From class Point class from which to delete points.

Further than Defines an offset distance from the centerline
within which points are kept. Points outside
the distance are deleted.

You can delete points of a given class or line in batch mode by using the Delete by class or
Delete by line macro actions.

Edit selected

Edit selected command lets you modify attributes for one or more points selected in the list of
the TerraScan window. You need to switch the display size of the TerraScan window to Medium
dialog, Large dialog, or Wide dialog in  order to see the list of loaded points and to select points
for editing.

For a single point, you can modify the class, line number, coordinate values, and the intensity
value. For several points, you can edit the class (code), line number, elevation value, and apply
an elevation change (dz).

To edit attributes of one point:

1. Select a point in the list of TerraScan window.

2. Select Edit selected command from the Point pulldown menu.

This opens the Edit Point dialog:

3. Define new values for attributes that you want to change.

4. Click OK.

This changes the attribute values for the selected point.
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To edit attributes of several points:

1. Select several points in the list TerraScan window.

2. Select Edit selected command from the Point pulldown menu.

This opens the Edit Several Points dialog:

3. Switch on the attribute new values for attributes that you want to change.

4. Click OK.

This changes the attribute values for all selected points.

Edit selected actions can not be undone.

Find

Find command selects points with specific attribute values. The attributes including class,
elevation range, and time range. In addition, the selection of points can be limited to a fence or
selected polygon area. The command selects either all points with the given attribute values, or
only the first and next point in the list of points.

You need to switch the display size of the TerraScan window to Medium dialog, Large dialog, or
Wide dialog in order to see the list of loaded points and the selected points.

To select points with given attribute values:

1. Select Find command from the Point pulldown menu.

This opens the Find point dialog:
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2. Switch on the attribute(s) and define values for points to be selected.

3. (Optional) Switch on Fence contents to limit the search to an area defined by a fence or
selected polygon.

4. If you want to select the first point in the point list for which the given values apply, click Find
first. The next point in the list with corresponding values can be selected by clicking Find
next.

OR

5. If you want to select all points for which the given values apply, click Find all.

This selects the points in the list of points in TerraScan window. The number of points is
displayed in the Find point dialog.

From list

From list command lets you undo one or several processing steps. This is the preferred way to
undo more than one step. The number of actions for undo is determined in Undo and backup
category of TerraScan Settings.

The command opens the dialog which shows a list of all processing steps that fit into the
memory reserved for the undo buffer. For each step, the action, time, and possibly additional
information is displayed. You can undo a number of steps by selecting the earliest step.

To undo several actions:

1. Select From list command from the Point pulldown menu.

This opens the Undo List dialog:



TerraScan User Guide  © 2023 Terrasolid Ltd

507TerraScan Window > Point pulldown menu > From list

2. Select the step up to which you want to make an undo.

3. Click Undo.

This makes all selected steps undone.

Select by class

Select by class command selects points of the same class. It requires the selection of one
sample point in the TerraScan window. You need to switch the display size of the TerraScan
window to Medium dialog, Large dialog, or Wide dialog in order to see the list of loaded points
and to select a sample point.

To select points by  class:

1. Select one point of the class to be selected in TerraScan window.

2. Select Select by class command from the Point pulldown menu.

This selects all points of the same class as defined by the sample point.

Undo

Undo command lets you undo modifications of points. Processing steps that can be undone
include:

· Manual classification steps

· Automatic classification steps

· Macro actions applied to loaded points

· Smoothen points and thin points commands

· Adjust to geoid command

· Changes to line numbering

· Automatic detection of wires
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More than one action can be undone by using the command several times or by using the From
list command. The number of actions for undo is determined in Undo and backup category of
TerraScan Settings.
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Tools pulldown menu

Commands from the Tools pulldown menu are used to process loaded laser points or to
perform actions based on laser points. There are also commands for opening the macro
window, starting addon tools, converting a geoid model, reading in text files for drawing
certain types of vector data into the CAD file.

TO USE COMMAND

Open toolbars of the TerraScan toolbox Toolboxes

View statistics about points Show statistics

Open the Macro window Macro Not Lite

Start an addon tool Addon

Draw bounding box for fitting views Draw bounding box

Draw points into a profile drawing Draw into profile

Draw points into alignment cross sections Draw into sections

Draw polygons around groups of points Draw polygons

Smooth points Smoothen points

Remove unnecessary point density Thin points

Adjust the elevations of points to a geoid
model

Adjust to geoid

Extract a local geoid model from a geoid file Convert geoid model

Transform loaded points into a new
projection system

Transform loaded points

Transform a known points file into a new
projection system

Transform known points

Check the z accuracy of the point cloud data Output control report

Assign color values to points Assign color to points

Assign a distance value to points Compute distance

Assign a normal vector value to points Compute normal vectors

Assign color values from images to points Extract color from images

Assign echo properties to laser points Extract echo properties

Compare laser points with points from a
reference project

Compare with reference

Sort points Sort

Draw building models from text files Read / Building models
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TO USE COMMAND

Draw paint markings from text files Read / Paint lines

Draw poles from text files Read / Poles

Draw polygons from text files Read / Polygons

Draw section parameter values from text
files

Read / Section parameters

Draw slope arrows from text files Read / Slope arrows

Draw trees from text files Read / Tree cells

Draw wires from text files Read / Wires

Addon

Addon sub-menu consists of commands that call custom functions in TerraScan. New commands
and functions can be added to TerraScan using a custom DLL.

An example is provided by the View histogram function which opens the Laser intensity
histogram window. It displays the distribution of intensity values of all loaded points or of
selected classes or scanners. The window also shows the average, median, and spread values of
the points that are in the selected class and captured by the selected scanner.

See Chapter DLL Interface for more information about custom DLLs in TerraScan.

Adjust to geoid

Adjust to geoid command adjusts the elevation values of a point cloud to a local elevation
model. The elevation model can be defined by an implemented geoid model, a text file, a
TerraModeler surface or a selected linear chain.

The theory of geoid adjustment and the use of the command in TerraScan are explained in
detail in section Geoid adjustment.

To run elevation adjustment on loaded points:

1. Choose Adjust to geoid command from the Tools pulldown menu.

This opens the Adjust to Geoid dialog:
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2. Define settings and click OK.

This starts the geoid adjustment for the loaded points. When the process has finished, an
information dialog shows the number of adjusted points and the variation of adjustment
values.

SETTING EFFECT

Adjustment Direction of the elevation adjustment:

· Ellipsoidal to orthometric - adjustment from
ellipsoidal to orthometric height values.
This is the normal way of an geoid
adjustment.

· Orthometric to ellipsoidal - adjustment
from orthometric to ellipsoidal height
values. This is the reverse way of an geoid
adjustment.

Dz model Source file that provides the geoid correction
model:

· Points from file - text file.

· Selected linear chain - linear element
selected in the CAD file.

· <name> - name of a geoid model loaded as
surface in TerraModeler.

· <implemented model> - name of an
implemented geoid model.
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SETTING EFFECT

File name Name of the geoid text file. This is only active
if Dz model is set to Points from file.

Extend Distance from a selected linear element by
which the linear chain is extended for
elevation value corrections. This is only active
if Dz model is set to Selected linear chain.

Inside fence only If on, geoid adjustment effects only loaded
points that are located inside a fence or
selected polygon. Requires a fence or
selected polygon in the CAD file.

Projection Projection system of the geoid model. This is
only active if Dz model is set to any
implemented geoid model.

Assign color to points

Assign color to points command assigns a color value to laser points of one or more classes. This
might be useful for laser point classes where color extraction from images results in poor
coloring (e.g. thin features like wires) or to emphasize certain classes.

The color assigned to a point can be defined in different ways:

· Constant color - a constant RGB color is assigned to each point.

· Intensity auto - automatically-fitted intensity values. This corresponds to the same display
mode option. 

· Intensity custom - a text file storing intensity values is used to assign an RGB color value to
points. The text file can be created in the Coloring Scheme dialog, opened from the  Display
mode dialog.

· Color mixture - a mixture of up to three colors is randomly assigned to laser points. A color
mixture can be defined in Color mixtures category of TerraScan Settings.

· Group color - points assigned to a group get a color value. The color per group is selected
randomly, as for the Color by Group display mode for points. Non-grouped points do not get
a color value.

· Multi scanner intensity - intensity values of three laser channels are assigned as RGB colors
to points. This requires data of a scanner that records three intensity channels for each
point. The RGB values then represent the strength of a return signal in each intensity
channel. It might be necessary to optimize the intensity values in order to get better results
from the color assignment.

Color values can be stored in TerraScan FastBinary and Binary files, and in LAS 1.2+ files.

To attach a color value to laser points:

1. Select Assign color to points from the Tools pulldown menu.
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This opens the Assign Color to Points dialog:

2. Define settings and click OK.

This assigns the color to the loaded points in the selected class(es).

SETTING EFFECT

Class Point class(es) effected by the color
assignment.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Assign to Points to which color is assigned:

· All points - all points get a new color
value.

· Non-colored points only - points which do
not yet have a color value.

Lines Determines which lines are effect by color
assignment. Several line numbers can be
separated by comma, line number ranges
can be defined by minus, e.g. 1,4-6,29-59.
Use 0-65535 to refer to all possible line
numbers.

Inside fence only If on, only points inside a fenceMicroStation only

or selected polygon(s) are effected by color
assignment.

Assign Color source: Constant color, Color mixture,
Group color, Intensity auto, Intensity
custom or Multi scanner intensity.
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SETTING EFFECT

Red | Green | Blue RGB color values for a constant color
definition. The color is defined with 16-bit
values which can range from 0 to 65535. This
is only active if Assign is set to Constant
color.

Color scheme Location and name of a color scheme file
storing intensity values. This is only active if
Assign is set to From intensity.

Mixture Name of the color mixture. The list contains
all mixtures defined in Color mixtures
category of TerraScan Settings. This is only
active if Assign is set to Color mixture.

Red scanner | Green scanner | Blue scanner Number of laser scanner channels. This is
only active if Assign is set to Multiple
scanner intensity.

Max distance Maximum search radius around a point for
the two closest neighbouring points from
the other two scanners. This is only active if
Assign is set to Multiple scanner intensity.

Default value Determines the values for the two missing
color channels for a point for which not
enough neighbouring points from other
scanners are found within the Max distance:

· Minimal value - the value of 1 is used for
the missing color channels. This results in
a more colorful display and makes it
easier to recognize features in the
colored point cloud. This is recommended
if colors are assigned for classification
purposes.

· Grey color value - the value of the single
scanner is used for all channels which
results in a grey color value.

Clear distance

Clear distance command removes computed distance attribute value from points. It can be
used to ensure data integrity when computing new distance values for a subset of points.

To clear distance from point cloud attributes:

1. Choose Clear distance command from the Tools pulldown menu.

This opens the Clear Distance dialog:
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2. Select class(es) and click OK.

This clears the distance attribute from points in selected class(es).

Compare with reference

Compare with reference command compares two laser data sets from the same location. It
classifies locations where the two data sets differ from each other. This is useful to locate
places where buildings or other objects have been built or destroyed, trees have grown or
ground has changed.

The command can be used for simple change detection analysis based in loaded points. The
newer data set is loaded as active point cloud. The older data set is loaded as reference points.
Alternatively, the newer data set is stored in the active project, the older data set has to be
defined as a reference project. See New project for information about defining a reference
project.

The process can distinguish between ground and object comparison. Ground comparison is
based on a triangulated ground surface calculated from the given classes in the active and the
reference laser points. For object comparison, a search radius is defined around each active
point within which the software expects a corresponding reference point on the same object.

It is required that different classes are set for ground and object comparison, even if no
classification is applied for one or the other comparison. However, the same class numbers can
be used in active and reference projects.

To compare laser points with a reference project:

1. Select Read point command from the File pulldown menu in order to load the active point
cloud. Select Read reference points from File pulldown menu in order to load the reference
point cloud.

OR

1. Select Open block command from the File pulldown menu. In the Open Block dialog, switch
on the Load reference points option.

2. Select Compare with reference command from the Tools pulldown menu.

This opens the Compare with Reference dialog:
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3. Define settings and click OK.

This classifies points for which there are no corresponding points in the other project.

SETTING EFFECT

Active classes List of classes for ground comparison in
active laser points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Active classes field.

Reference classes List of classes for ground comparison in
reference laser points.

Dz tolerance Elevation tolerance for ground comparison.
Points within this tolerance are considered
as corresponding points.

Active above to Points in the active file that are below the
ground surface in the reference file are
classified into this class.
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SETTING EFFECT

Active below to Points in the active file that are above the
ground surface in the reference file are
classified into this class.

Active classes List of classes for object comparison in
active laser points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Active classes field.

Reference classes List of classes for object comparison in
reference laser points.

Search radius Xy radius around each active point to
search for corresponding reference points.

Dz tolerance Elevation tolerance for object comparison.
Points within this tolerance are considered
as corresponding points.

Active to class Active points for which there are no
corresponding reference points are
classified into this class.

Ref to classes Reference points for which there are no
active points are classified into this class.

Ignore objects close to ground If on, points with a distance above the
ground smaller than the given Height value
are ignored for object comparison.

Ignore outside polygons If on, points outside polygons on the given
Level are ignored for comparison.

Compute distance

Compute distance command computes a distance value for points. The distance can be
computed based on several references:

· 3D vector elements in the CAD file, such as planar shapes, linear elements or surface
elements.

· the closest overlapping line in a point cloud.

· the average between overlapping lines.

· ground class(es) or other class(es).

· any surface model loaded in TerraModeler.

· powerline wires that have been produced with the Detect wires tool.
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· range which is the distance to the scanner position at the moment of time when a point was
captured. This requires trajectory information available in TerraScan.

· built-in vegetation indexes Normalized and Visual band differences. This requires true-color
(Visual band difference) and additionally infra-red color information (Normalized
difference) stored for the points. The distance value expresses how likely a point belongs to
vegetation (larger positive value) or not (larger negative value). Distance values range
between -1 and +1. The vegetation index distance values may support the ground
classification of photogrammetric point clouds.

· Riegl Extra Byte attributes such as Echo length (= Pulse width) and Deviation (= Pulse shape
deviation). The attribute values are translated into a distance value which indicates how
likely a point belongs to a hard surface (ground) or not. The distance values range between -
1 and +1, values between -1 and 0 are considered to represent ground. The higher the value,
the less likely a point represents ground. The distance values may support the ground
classification of LiDAR point clouds captured with Riegl scanners.

· curvature of a surface defined by local neighborhood of points. Computes the radius of the
surface fit to the points within the neighborhood. If the neighborhood does not represent
suitable curved surface, no value is extracted for the point.

· a longitudinal section line in order to detect road bumps and potholes. The trajectories of an
MLS survey or any other road center line element may be drawn in the CAD file in order to
be used as reference element. The laser data should be classified into hard surface and
noise on asphalt up to maximum 1 cm above/below hard surface. The reference element
provides the direction of the road. In the computation process, a line equation is fitted to a
longitudinal slice of data with a given length and depth. Points above the fitted line get a
positive distance value and represent bumps, points below the fitted line get a negative
distance value and represent potholes. Use distance coloring with e.g. +-15 cm distance
values in order to illustrate road damage.

· surface thickness difference between points inside polygons and neighborhood outside
polygon in order to detect paint thickness. Paint thickness could measure thickness of paint
layer on road markings. Paint thickness computation requires bounding polygons around
objects of interest. Source class points within the defined margin from bounding polygons
must be suitable for plane fitting to provide a reliable thickness result.

The distance value can be used for visualization of points and for further processing steps. The
following processing commands rely on a distance computed from ground:

· Classify by distance / Classify groups by distance

· Assign groups and corresponding macro action

· Classify groups by best match

The distance value can be stored in TerraScan FastBinary files. In addition, image files can be
created from loaded points or project block files by using the distance attribute of points in
order to display the information in other software products.

To compute distance values:

1. If you want to compute distance values for road bumps and potholes, select the vector
elements that represent these road damages.

2. Select Compute distance command from the Tools pulldown menu.

This opens the Compute Distance dialog:
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The Distance setting determines which additional settings are available in the dialog.

2. Define settings and click OK.

This computes the distance values. An information dialog shows the number of effected
points when the process is finished.

SETTING EFFECT

Class Point class(es) for which dimensions and
normal vectors are computed.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Distance Method for computing the distance:

· To elements - distance between a point
and vector elements drawn in the CAD
file.

· To closest line 3D - 3D distance between a
point and its closest neighbour point. The
computation takes the normal vector
direction of points into account.
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SETTING EFFECT

· To closest line dz - vertical distance
between a point and its closest neighbour
point in XY of another line.

· To line average Z - vertical distance from a
point to the average elevation between
overlapping lines. The computation is
based on TINs created from points of one
line.

· To ground class - vertical distance from a
point to the ground class(es). A temporary
TIN is created from points in the ground
class(es) in order to compute the
distance.

· To another class - 3D distance from a point
to points in the given Other class.

· To wires - distance from a point to the
closest powerline wire. Line strings for
wires must be produced with the Detect
wires tool.

· Range 3D - 3D distance from the scanner
position to a point.

· Range xy - horizontal distance from the
scanner position to a point.

· Range offset - left/right distance from the
scanner position to a point.

· Range forward - forward/backward
distance from the scanner position to a
point.

· Range dz - vertical distance from the
scanner position to a point.

· Normalized difference - built-in
vegetation index.

· Visual band difference - built-in
vegetation index.

· Echo Length - Riegl Extra Byte attribute
Pulse width.

· Deviation - Riegl Extra Byte attribute Pulse
shape deviation.

· Curvature - curvature radius of the points
inside local neighborhood.

· Road bumps & potholes - distance to
longitudinal section line.

· Paint thickness - distance to local plane fit
to neighbor points outside polygon
margin. 

· <TIN> - distance from a point to a surface
model loaded in TerraModeler.
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SETTING EFFECT

Levels Number(s) of CAD file level(s) on which the
elements are drawn. Level ranges and
several levels can be define with minus and
comma, for example: 1-5,10,22. This is only
active if Distance is set to Elements.

Max distance Maximum distance of points from elements
for which a distance value is computed. This
is only active if Distance is set to Elements.

Planar shapes If on, planar shapes are considered as
reference elements. This is only active if
Distance is set to Elements.

Tolerance Defines a stroking tolerance for curved
element types. This determines what
shapes are considered as planar. This is only
active if Distance is set to Elements and
Planar shapes is switched on.

Above is Defines which direction is considered as
positive distance from planar shapes:

· Upwards - points above a shape.

· Clockwise side - points in clockwise
direction of a shape.

This is only active if Distance is set to
Elements and Planar shapes is switched on.

Linear elements If on, linear elements are used for
computing a distance. This is only active if
Distance is set to Elements.

Surface elements If on, surface elements are used for
computing a distance. This is only active if
Distance is set to Elements.

Max distance Maximum distance between overlapping
lines for which a distance value is
computed. This is only active if Distance is
set to Closest line 3D or Closest line dz.

Ground Point class(es) used as reference ground
level. This is only active if Distance is set to
Ground class.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground field. This is only active if
Distance is set to Ground class.
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SETTING EFFECT

Other class Point class(es) used as reference class(es).
This is only active if Distance is set to
Another class.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Other class field. This is only active if
Distance is set to Another class.

Max distance Maximum distance between a point and
reference points in another class. The
distance value is not stored for a point if it is
larger than the given maximum value. This
is only active if Distance is set to Another
class.

Wire levels Number(s) of CAD file level(s) on which
powerline wires are drawn. Several level
number can be separated by comma, a
range of level numbers can be defined by a
minus sign, for example 10,14,22 or 3-5. This
is only active if Distance is set to Wires.

Find using Distance definition:

· Vertical distance to wire - vertical
distance from a wire.

· 3D distance to wire - 3D distance from a
wire.

· Falling tree logic - each point is
considered as the tip of a tree with its
trunk at the xy location of the point and
the elevation of the base point on the
ground. The shortest distance of the point
“falling like a tree” to a wire is computed.

This is only active if Distance is set to Wires.

Within offset Maximum horizontal distance from a wire
within which a distance value is computed.
Basically, this value defines the corridor left
and right of the wires for computing
distance values. This is only active if
Distance is set to Wires.

Ground Point class(es) used as ground level. This is
only active if Distance is set to Wires and
Find using to Fallen tree logic.

Limit Threshold value that separates vegetation
from non-vegetation by using a vegetation



TerraScan User Guide  © 2023 Terrasolid Ltd

523TerraScan Window > Tools pulldown menu > Compute distance

SETTING EFFECT

index. This is only active if Distance is set to
Normalized difference or Visual band
difference.

Neutral length Echo length/Deviation value that is
translated into a distance value of 0. This is
only active if Distance is set to Echo length
or Deviation.

Spread Echo length/Deviation value that is
translated into the minimum and maximum
distance value of ±1.  This is only active if
Distance is set to Echo length or Deviation.

Max offset Maximum horizontal distance of a point
from the longitudinal section line. Only
point within the given offset are considered
in the distance computation. This is only
active if Distance is set to Road bumps &
potholes.

Fit length Length of a longitudinal slice of data used
for fitting a line equation for each point.
Together with the Fit depth value it
determines, how big damages can be
detected. This should be bigger than the
largest bump/pothole to find. If the value is
too small, bigger damages may be missed. If
the value is too big, smaller details of
damages may be missed. This is only active
if Distance is set to Road bumps & potholes.

Fit depth Depth of a longitudinal slice of data used for
fitting a line equation for each point.
Together with the Fit length value it
determines, how big damages can be
detected. This is only active if Distance is
set to Road bumps & potholes.

Polygon levels Number(s) of CAD file level(s) on which
paint marking polygons are drawn. Several
level number can be separated by comma, a
range of level numbers can be defined by a
minus sign, for example 10,14,22 or 3-5. This
is only active if Distance is set to Paint
thickness.

Surface Type of surface equation to fit to points
outside Polygon margin of paint marking
polygon and within Max distance radius
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SETTING EFFECT

from the point. This is only active if Distance
is set to Paint thickness.

Polygon margin Additional margin outside polygon to filter
paint points from plane fitting in case
marking polygon is slightly misplaced. This
is only active if Distance is set to Paint
thickness.

Max distance Maximum radius around point for selecting
points used to extract the local plane. This is
only active if Distance is set to Paint
thickness.

Compute normal vectors

Compute normal vectors command can be used to compute and store two additional attributes
for laser points, a dimension and a normal vector.

The software determines the dimension of each point by analyzing the point and its closest
neighbour points. There are three types of dimensions:

· Linear - points form a linear feature.

· Planar - points form a planar surface.

· Complex - random group of points.

The normal vector is computed for points of planar dimension. It is strongly recommended to
have trajectory information available for computing normal vectors for mobile ground-based
laser data. However, the process also runs without trajectory information which may give good
results for airborne data sets.

The attributes can be used for the visualization of points and for classifying points. For instance,
points on a road surface in an MLS data set can be classified By normal vector in order to detect
locally flat places. In ALS data, the normal vector can be utilized to analyze roof structures.

The dimension and the three components (XYZ) of the normal vector can be stored in TerraScan
FastBinary files.

To compute normal vectors:

1. Select Compute normal vectors command from the Tools pulldown menu.

This opens the Compute Normal Vectors dialog:
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2. Define settings and click OK.

This starts the computation process. It assigns a dimension value to all laser points and a
normal vector to all points of planar dimension. An information dialog shows the number of
points for which a normal vector has been computed.

SETTING EFFECT

Class Point class(es) for which dimensions and
normal vectors are computed.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Turn normals Defines a target point for the normal vector
direction:

· Towards trajectory - turned towards the
trajectory position. This requires
trajectory information available in
TerraScan. This is the preferred method
for airborne and mobile point clouds.

· Towards center point - turned towards
the center point of the point cloud. This is
suitable for static terrestrial point clouds.

· Upwards - turned to upward direction.
Suited for airborne point clouds if no
trajectory is available.

· Towards vectors - turned towards a
selected vector element. This is suitable
for mobile point clouds of tunnels or
other inside scans if no trajectory is
available. It requires that a 3D line string
is drawn inside along the tunnel center
and selected before the tool is started.

Time difference Maximum difference in time stamps of
points that are considered for calculating
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SETTING EFFECT

the normal vector.

Process lines separately If on, the dimension and normal vector
computation is done for each line
separately. This is recommended if the data
of different lines do not match to each
other.

Process scanners separately If on, the dimension and normal vector
computation is done for each scanner
separately. This is recommended if the data
of different scanners do not match to each
other.

Convert geoid model

Convert geoid model command converts a source geoid model into a geoid text file that can be
used by Terra application tools. Supported source geoid models are:

· Denker - European geoid model

· EGM96, EGM2008 - global geoid models

· GSIGEOME - Japanese geoid model

· HBG03, HBG18 - Belgian geoid models

· Norway - Norwegian geoid model file format (such as "href2016b_nn2000_euref89.txt")

· RAF98, RAF18 - French geoid models

· SA2010 - South African geoid model

The process can include a coordinate conversion from the source geoid model's coordinates
into a projection system, another transformation as well as the addition of an elevation
difference.

To convert a geoid model:

1. Select Convert geoid model command from the Tools pulldown menu.

This opens the Convert Geoid Model dialog:
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2. Define settings and click OK.

This converts the source geoid model into the output text file.

SETTING EFFECT

Source Source geoid model.

Input Storage location and name of the source
geoid model file.

Projection Target projection system of the geoid text
file. Click on the >> Button to open the
Browse for Projection System dialog. The
dialog provides a search option for projection
systems as well as a list of all implemented
systems. In addition, any user-defined
projection systems are included in the list.

Transform Transformation applied to the geoid model
coordinates. The list contains all
transformation defined in the Coordinate
transformations / Transformations category
of TerraScan Settings.

Add dz Defines a value that is added to the elevation
difference values of the geoid model.

Inside fence only If on, the output file is written only for geoid
model points inside a fence or selected
polygon. Requires a fence or selected
polygon in the CAD file. This is recommended
if you convert a global or country-wide geoid
model for a smaller project area.

Output Storage location and name of the output text
file.
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Draw bounding box

Draw bounding box command draws a bounding box around points loaded in TerraScan. The
command draws a graphical group of twelve 3D line elements which enclose all laser points.
The line element are drawn on the active level using the active symbology settings of the CAD
file.

The bounding box may be useful, for example, if you want to use the Fit View tool of the CAD
platform to fit rotated views to the extend of the laser data. As an alternative, the TerraScan
command Fit view or the Fit button in the Display mode dialog can be used to fit views to the
extend of loaded laser points.

You can undo the drawing of a bounding box by using the Undo command of the CAD
platform.

Draw into profile

Draw into profile command draws laser points into a profile as permanent elements. This
command draws all points from one or more given classes into the profile which are within the
given depth from the profile alignment.

You have to create the profile using Draw Profile tool of TerraModeler before this tool can be
used.

To draw laser points into a profile:

1. Select Draw into profile command from the Tools pulldown menu.

This opens the Draw into profile dialog:

2. Define settings and click OK.

3. Identify the profile cell element with a data click.

This draws the points as permanent CAD file elements into the profile.

https://terrasolid.com/guides/tmodel/drawprofile.html
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SETTING EFFECT

Class Source class(es) from which points are
drawn into the profile.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Within Depth distance from the alignment element
of the profile.

Thin Determines how points are thinned for
being drawn into the profile:

· No thinning - points are not thinned.

· As point cloud - appropriate thinning
when drawing 3D objects such as trees or
powerline towers.

· As terrain surface - appropriate thinning
when drawing a ground surface.

Within Determines how close a point must be to
the alignment in order to be drawn into the
profile. This is only active if Thin is set to As
point cloud or As terrain surface.

Draw into sections

Draw into sections command draws laser points into a cross section as permanent elements.
This command draws all points from one or more given classes into the cross section which are
within the given depth from the cross section center line.

You have to create the cross section(s) using Draw Alignment Sections tool of TerraModeler
before this tool can be used.

To draw laser points into cross sections:

1. Select Draw into sections command from the Tools pulldown menu.

This opens the Draw into sections dialog:

https://terrasolid.com/guides/tmodel/drawalignmentsections.html
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2. Define settings and click OK.

3. Identify the cross section cell element with a data click.

This draws the points as permanent CAD file elements into the cross section.

SETTING EFFECT

Class Source class(es) from which points are
drawn into the cross section.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Within Depth distance from the center line of the
cross section.

Thin Determines how points are thinned for
being drawn into the cross section:

· No thinning - points are not thinned.

· As point cloud - appropriate thinning
when drawing 3D objects such as trees or
powerline towers.

· As terrain surface - appropriate thinning
when drawing a ground surface.

Within Determines how close a point must be to
the alignment in order to be drawn into the
cross section. This is only active if Thin is set
to As point cloud or As terrain surface.

Draw polygons

Draw polygons command draws 3D shapes or line strings around groups of points within one or
more point classes. The elevation of the vertices for the elements is derived from the elevation
values of the laser points.
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Optionally, grouping of points can be taken into account for drawing polygons. The requires the
assignment of group numbers to points by using the Assign groups menu command or macro
action.

To draw polygons around groups of points:

1. Select Draw polygons command from the Tools pulldown menu.

This opens the Draw Polygons dialog:

2. Define settings and click OK.

This draws the shape or line string elements around point groups into the CAD file. The
elements are drawn on the active level using the active symbology of the CAD file.

SETTING EFFECT

Class Source class(es) of laser points. Shapes or
line strings are drawn around point groups
of the given class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Separate groups If on, a separate polygon is drawn around
points belonging to one group.

Inside fence only If on, only the area inside a fence or
selected polygon is considered for
processing. Requires that a fence is drawn
or a polygon is selected in the CAD file.
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SETTING EFFECT

Draw as Definition of the element type that is
created: Shapes, Line strings, Circles or
Bounding boxes (for Separate groups only).

Gap distance Maximum gap between points. Points
which are less than the given distance away
from each other are considered to belong to
the same group.

Min size Minimum size of a polygon to be drawn.

Simplify polygons If on, unnecessary vertices of the polygons
are removed. This is only active if Draw as is
set to Shapes or Line strings.

Favor 90 degree angles If on, 90 degree angles are enforced for
close-to 90 degree angles. This is only active
if Draw as is set to Shapes or Line strings.

Label Text element written for each polygon:

· No label - no text element is created.

· Polygon number - unique number.

· Group id - the unique group number
created during the the grouping process.

Extract color from images

Extract color from images command extracts color values from raster images and assigns the
values to laser points. The color sources can be orthophotos attached as TerraPhoto raster
references or raw images in an active TerraPhoto image list. In addition, a color point file can be
used to balance colors of the raw images before the color values are assigned to the laser
points. The command requires TerraPhoto or TerraPhoto Lite running on the same computer.

TerraScan can extract up to 10 color channels for each point. The maximum amount of color
channels can only be stored in the TerraScan FastBinary format. LAS 1.4 format and later can
store up to 4 color channels, LAS 1.2 format and later and TerraScan Binary files up to 3.

The color for a laser point is derived by resampling the color values of all the pixels inside a
circular area around the point. There are different methods of color value extraction from raw
images which are either suitable for airborne or mobile data sets.

The process can involve the computation and storage of image numbers. The number of the
image used for extracting the color can be stored for each laser point. This requires the storage
of points in TerraScan FastBinary format. The image number stored as laser point attribute is
required for advanced coloring methods for mobile point clouds.

Extract color from images command is also available for TerraScan projects and thus, can be
performed for all or selected blocks of a project.
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To extract color from attached orthophotos or raw images:

1. Attach reference images in TerraPhoto’s Manage Raster References tool.

OR

1. Load an image list into TerraPhoto.

2. Select Extract color from images command from the Tools pulldown menu.

This opens the Extract Color from Images dialog:

3. Define settings and click OK.

This derives color values for the laser points from the defined source images.

SETTING EFFECT

For class Laser point class(es) for which colors are
extracted.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the For class field.

Inside fence only If on, color values are extracted for laser
points inside a fence or selected polygon.

Color source Source files for color extraction:

· Ortho images - colors are extracted from
attached TerraPhoto raster references.

https://terrasolid.com/guides/tphoto/rrefpmfile.html
https://terrasolid.com/guides/tphoto/mwloadlist.html
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SETTING EFFECT

· Raw images - colors are extracted from
raw images in an active image list in
TerraPhoto.

· Raw images & color points - colors are
extracted from raw images and from a
color point file.

Source channels Amount of color channels to be extracted.
Click on the Mapping button in order to set
the channel numbers for color extraction in
the Extract Color Channel Mapping dialog.
This makes it possible extract RGB channels
from one set of images and NIR channel
from another set of images (other channels
can be skipped).

Cpt file Location and name of a color point file. This
is only active if Color source is set to Raw
images & color points.

Image numbers Method how the software handles the
computation and storage of image numbers
from raw images:

· Compute -- do not store - image numbers
are computed but not stored for laser
points.

· Compute and store - image numbers are
computed and each laser point stores the
number of the image from which it gets
the color.

· Use stored - stored image numbers of
laser points are used for color extraction.

Use image Method how the software determines the
raw image for extracting a color for a laser
point:

· Closest in 3d - closest camera XYZ
position. Optimized for airborne data
sets.

· Closest in xy - closest camera XY position.
Optimized for airborne data sets.

· Closest in time - closest time stamp.
Optimized for airborne data sets.

· Mobile -- closest in time - closest time
stamp. Optimized for mobile data sets.

· Mobile -- ground surface - best ground
surface visibility. Optimized for mobile
data sets.
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SETTING EFFECT

· Mobile -- closest in 3d - closest camera
XYZ position. Optimized for mobile data
sets.

Footprint Radius of a circular area around each laser
point within which pixel color values are
resampled. Given in meters for a method
optimized for airborne data sets and in
pixels for mobile data sets. This is the only
setting that is active if Color source is set to
Ortho images.

Max distance Maximum distance between a raw image
and a laser point. Images outside that
distance are not considered for color
extraction. This is only active if Use image is
set to any method optimized for mobile
data sets.

Max time diff Maximum time difference between a raw
image and a laser point. Images outside that
difference are not considered for color
extraction. This is only active if Use image is
set to Mobile -- closest in time.

Use depth maps If on, depth maps files are included in the
color extraction process. This enables color
extraction from raw images as if true
orthophotos are used which means that
pixels on top of high objects are referenced
at their correct XY location. See TerraPhoto
User Guide for more information about
depth maps.

Radius Radius checked in image depth maps to find
out if the point is visible in the image or
occluded. This is only active if Use depth
maps is switched on.

Tolerance Allowed depth difference between a point
and depth map before the point is
considered occluded. If the depth of a point
is bigger than depth map value and
tolerance together, point in that image is
considered occluded and some other image
is used in color extraction. This is only active
if Use depth maps is switched on.

Favor better quality images If on, the quality attribute stored for raw
images in an image list is considered in the
color extraction process.

https://terrasolid.com/guides/tphoto/mwcomputedepthmaps.html
https://terrasolid.com/guides/tphoto/mwedit.html
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SETTING EFFECT

Favor cameras by class If on, the settings in the TerraPhoto mission
file related to favoring cameras for coloring
points are considered in the color extraction
process.

Extract echo properties
Not UAV

Extract echo properties command extracts information from waveform data and assigns it as
attributes to the laser points. The command requires that waveform data and a scanner
waveform profile are available. The processing steps for preparing the extraction of waveform-
related information are described in detail in Chapter Waveform processing.

The command can extract the following attributes:

· Echo length - relative length (millimeter) of a return signal compared to a typical return from
a hard surface.

· Echo normality - difference in shape of a return signal compared to a typical return from a
hard surface.

· Echo position - difference in position of a peak of a return signal compared to a typical return
from a hard surface.

The echo length can be used for the visualization of points and for classifying points. For
instance, a classification By echo length prior to ground classification can improve the result of
the Ground routine especially in areas of low vegetation.

The echo properties can be stored in TerraScan FastBinary files.

Extract echo properties command is also available for TerraScan projects and thus, can be
performed for all or selected blocks of a project.

To extract echo properties:

1. Select Extract echo properties command from the Tools pulldown menu.

This opens the Extract Echo Properties dialog:

https://terrasolid.com/guides/tphoto/mwnewmission.html
https://terrasolid.com/guides/tphoto/mwnewmission.html
https://terrasolid.com/guides/tscan/introwaveformprocessing.html
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2. Select what properties you want to extract by switching the corresponding options on.

3. Click OK.

This starts the extraction process. It assigns the extracted attributes to all laser points for
which waveform information is available. Depending on the amount of points, the process
may take some time. An information dialog shows the number of effected points.

Fit to reference

Fit to reference command applies a systematic correction to a data set. The correction may
include translation in XYZ direction and rotation around XYZ axes. Alternatively, a rubbersheet
correction (correction that changes over time) can be computed to fit data in elevation. 

The correction is computed based on reference points loaded into TerraScan. See Read
reference points command for more information. The correction is applied to the active points
loaded in TerraScan.

The command is primarily developed for change detection of volumes in mines based on
photogrammetric point clouds. The detection and computation of volume changes requires that
the point clouds of, for example, two days match where there was no change. Thus, the
command can be used to fit two photogrammetric point clouds in preparation of volume
computation. While a systematic shift can be done with all (ground) points of the point cloud, it
is recommended to exclude areas that have changed for the rubbersheet fit. This can be done
by drawing polygons around such areas and classify points inside the polygons into a separate
class.

To fit points to reference points:

1. Load points and reference points into TerraScan.

2. Select Fit to reference command from the Tools pulldown menu.

This opens the Fit to Reference dialog:
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3. Define settings and click OK.

This fits the active points to the reference points.

SETTING EFFECT

Fit class Class(es) used for computing the fit.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Fit class field.

Shift X If on, a translation in X direction is
computed and applied up to the given
Maximum value.

Shift Y If on, a translation in Y direction is
computed and applied up to the given
Maximum value.

Shift Z If on, a translation in Z direction is
computed and applied up to the given
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SETTING EFFECT

Maximum value.

Rotate around X If on, a rotation around the X axis is
computed and applied up to the given
Maximum value.

Rotate around Y If on, a rotation around the Y axis is
computed and applied up to the given
Maximum value.

Rotate around Z If on, a rotation around the Z axis is
computed and applied up to the given
Maximum value.

Observe every Determines how many points are used for
computing the translation and rotation
correction.

Solution level Level of accuracy for the correction values.
The selection list provides some accuracy
levels depending on the CAD file master
and secondary units.

Center of rotation Defines the center point for rotating the
point cloud:

· Center point - center point of the active
point cloud.

· User point - user-defined point.

X | Y | Z XYZ coordinate values of the center of
rotation. Define the point by typing values
in the text fields or by using the >> button
next to the coordinate fields. This is only
active if Center of rotation is set to User
point.

Lets you define the point of rotation with a
data click inside a CAD file view. You may
use the snapping functionality of the CAD
platform to define the point exactly based
on an element drawn in the CAD file. This is
only active if Center of rotation is set to
User point.

Fit Z If on, a rubbersheet correction in Z direction
is computed.

Method Method of computing rubbersheet
correction values:

· Dense data - grid-based suited for dense
point clouds.
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SETTING EFFECT

· Sparse data - based on point-to-point
spacing suited for sparse point clouds.

Max Maximum rubbersheet correction value
applied to the active point cloud.

Grid step Defines the grid step size for computing
correction values. This is only active if
Method is set to Dense data.

Spacing Defines the maximum space between
correction values. This is only active it
Method is set to Sparse data.

Macro
Not Lite

Macro command opens the Macro window which lets you create a macro for automated batch
processing. The creation and use of macros in TerraScan is described in detail in Chapter
Macros.

Modify color

Modify color command adjusts the color values of loaded points. The components to adjust are
brightness, saturation and gray balance. The process requires that color values are stored for
the points. It is normally used after extracting color values from images, for example with
Extract color from images command for projects or Extract color from images command for
loaded points.

The process supports 3-10 channels were channels 0-2 are the Red Green Blue channels of true-
color images.

To modify  the color of loaded points:

1. Select Modify color command from the Tools pulldown menu.

This opens the Modify Color dialog:
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2. Define settings.

The changes in coloring are dynamically displayed after typing a value in a settings field. If
the dialog is closed with Cancel, the original color values are restored.

3. Click OK.

This applies the color modification to the loaded points. Use Save or Save as commands for
loaded points in order to save the changes permanently to a file.

SETTING EFFECT

Class Point class(es) that are effected by the
process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Brightness Percentage value by which the current
brightness of color values are modified.

Saturation Percentage value by which the current
saturation of color values are modified.

Red Percentage value by which the red values
are modified.

Green Percentage value by which the current
blue values are modified.

Blue Percentage value by which the current
green values are modified.

Channel x Percentage value by which the current
value in additional color channels are
modified. X stands for the number of
additional channels. This is only active if
more than 3 channels are stored for the
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SETTING EFFECT

points, each additional channel gets its
own input field.

Output control report

Output control report command creates a report of elevation differences and horizontal shift
between a point cloud and ground control points or a surface model. This can be used, for
example, to check the positional accuracy of a point cloud and to calculate a correction value for
improving the positional accuracy of the point cloud.

The ground control points have to be stored in a space-delimited text file in which each row has
three or four fields: (optionally) identifier, easting, northing and elevation. The identifier field
is usually a number but it may include non-numeric characters as well.

The surface model has to be an active model in TerraModeler. The output report shows
statistical information about the elevation difference between points and surface model, such
as points used for computing the values, average difference and magnitude, standard
deviation, and RMS value. It does not show elevation difference values for single point
locations.

For loaded points, an XYZ correction can be derived from ground control points. This requires
that a signal marker is used to identify the control point location. The signal marker must be
visible in the intensity display of the point cloud. The shape of the signal marker is defined in
the Signal markers category of TerraScan Settings. The XY accuracy check requires a relatively
dense point cloud and is best suited for data collected by a UAV-carried system.

To create a control report:

1. Select Output control report command from the Tools pulldown menu.

This opens the Output Control Report dialog:
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2. Define settings and click OK.

This calculates the elevation differences and opens the Control report window. The content
of the report depends on the source file used for the comparison and on the dimension that
has been checked. The results and the further usage of a comparison with ground control
points is described in detail in Section Systematic elevation or XY(Z) correction.

SETTING EFFECT

Class Point class(es) used for the elevation value
comparison.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Check Dimension to check:

· Elevation - the elevation accuracy is
checked.

· Xyz - the full 3D accuracy is checked. This
works only for loaded points and based
on signal markers.

Compare against Source file for elevation value comparison:

· Known points - text file that contains
coordinates of ground control points.
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SETTING EFFECT

· <surface model> - name of a specific
surface model active in TerraModeler.

This is only active if Check is set to
Elevation.

Known points Location and name of the file that stores the
coordinates of the ground control points.
This is not active if  Compare against is set
to a surface model.

Max triangle Maximum length of a triangle edge. The
software creates a triangle from the closest
3 laser points around a ground control point
location. If the triangle edge length exceeds
the given value, the control point is not
used for the report. This is only active if
Check is set to Elevation.

Max slope Maximum terrain slope for which an
elevation difference is computed. This is
only active if Check is set to Elevation.

Z tolerance Normal elevation variation (noise level) of
laser points. This value is used only when
computing the terrain slope so that small
triangles do not exceed the Max slope
value. This is only active if Check is set to
Elevation.

Signal Signal marker definition used for
identifying ground control points. The list
contains all signal markers that are defined
in the Signal markers category of TerraScan
Settings. This is only active if Check is set to
Xyz.

Read / Building models

Read / Building models command reads text files that have been created in an automatic
building vectorization process. It is used to draw the buildings as 3D vector models into the CAD
file. See Vectorize buildings macro action for more information about the creation of building
text files.

The complete building models are drawn as  cell elementsMicroStation or symbolsSpatix into the CAD
file. If only selected components of a model are drawn, the software creates single polygon
elements. The settings in Building vectorization / Levels and Building vectorization / Model
categories of TerraScan Settings determine level, color, and layout definition of the models.
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After drawing the building models into the CAD file, they can be checked and modified using
dedicated tools of TerraScan. They are described in detail in Chapter 3D Building Models.

To read build ing models into the CAD file:

1. Select Read / Building models command from the Tools pulldown menu.

This opens the Read building models dialog, a standard dialog for opening files.

2. Select building text files and click Open.

This opens the Read Building Models dialog:

3. Select settings and click OK.

This reads the text files and draws the building models into the CAD file.

SETTING EFFECT

Draw Determines what components of a building
model are drawn:

· Complete model - all parts are drawn which
includes polygons for roof planes, walls, and
a base polygon.

· Selected components - only selected parts
of a model are drawn.

Roof If on, polygons for roof planes are drawn.

Wall If on, polygons for walls are drawn. 

Random color If on, walls are drawn by using colors chosen
randomly from the active color table of the
CAD file.
If off, the color defined in Building
vectorization / Model category of TerraScan
Settings is used for all walls.
This is only active if Wall is switched on.

Base If on, the base polygon is drawn.

You can undo the action by using the Undo command of the CAD platform.
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At the moment, cells and thus, the Read / Building models command only works in
MicroStation. There is not yet any corresponding element type in Spatix.

Read / Paint lines

Read / Paint lines command reads text files that have been created in an automatic
vectorization process for linear paint markings on a road surface. It is used to draw the paint
markings as 3D line string elements into the CAD file. See Find paint lines macro action for more
information about the creation of paint line text files.

The line string elements are drawn on the active level using the active symbology settings of
the CAD file.

After drawing the paint lines into the CAD file, they should be checked with the help of, for
example, the Inspect Elements tool of TerraScan or the Validate linear elements tool of
TerraModeler.

To read lines for paint markings into the CAD file:

1. Select Read / Paint lines command from the Tools pulldown menu.

This opens the Paint line files dialog, a standard dialog for opening files.

2. Select paint line text files and click Open.

This opens the Read Paint Lines dialog:

3. Define a minimum length value and click OK.

This reads the text files and draws the paint lines into the CAD file.

SETTING EFFECT

Min length Minimum length of a paint line that is drawn
into the CAD file. Any shorter line elements
are ignored.

You can undo the action by using the Undo command of the CAD platform.
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Read / Poles

Read / Poles command reads text files that have been created in an automatic process for
extracting pole objects. See Find poles macro action for more information about automatic
object extraction in batch mode.

The poles are drawn as cell elementsMicroStation or symbolsSpatix into the CAD file. The cells must be
defined in a MicroStation cell library and the cell library must be attached to the CAD file. The
cells are drawn on the active level using the active color of the CAD file.

To read poles into the CAD file:

1. Select Read / Poles command from the Tools pulldown menu.

This opens the Read poles dialog, a standard dialog for opening files.

2. Select pole text files and click Open.

This reads the text files and draws the cells into the CAD file.

You can undo the action by using the Undo command of the CAD platform.

At the moment, cells and thus, the Read / Poles command only works in MicroStation. There
is not yet any corresponding element type in Spatix.

Read / Polygons

Read / Tree cells command reads text files that have been created in an automatic process for
creating polygons. See Draw polygons macro action for more information about creating
polygons in batch mode.

The polygons are drawn as 3D shape elements into the CAD file. The shape elements are drawn
on the active level using the active color, line width, and line style settings of the CAD file.

To read tree cells into the CAD file:

1. Select Read / Polygons command from the Tools pulldown menu.

This opens the Polygon files dialog, a standard dialog for opening files.

2. Select polygon text files and click Open.

This reads the text files and draws the polygons into the CAD file.

You can undo the action by using the Undo command of the CAD platform.
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Read / Section parameters

Read / Section parameters command reads text files that have been created in an automatic
process for extracting road section parameters. It is used to draw the section parameter values
into the CAD file. See Compute section parameters macro action for more information about
section parameters and the creation of section parameter text files.

The section parameter values are drawn as text and linear elements into the CAD file. The
settings in Road section parameters category of TerraScan Settings determine level, color, text
size and unit definitions of the parameters.

To read section parameters into the CAD file:

1. Select Read / Section parameters command from the Tools pulldown menu.

This opens the Section parameter files dialog, a standard dialog for opening files.

2. Select section parameters text files and click Open.

This opens the Read Section Parameters dialog:

3. Define parameters that you want to draw and click OK.

This reads the text files and draws the section parameter values into the CAD file.

SETTING EFFECT

Fitted slope If on, the fitted slope value of a section is
drawn as text element.

Edge to edge slope If on, the edge-to-edge slope value of a
section is drawn as text element.

Cross section roughness If on, the roughness value of a section is
drawn as text element.
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SETTING EFFECT

Maximum deviation If on, the maximum deviation value of a
section is drawn as text element.

Maximum rut depth If on, the maximum depth value of ruts at a
section location is drawn as text element.

Left rut depth If on, the depth value of the left rut at a
section location is drawn as text element.

Right rut depth If on, the depth value of the right rut at a
section location is drawn as text element.

Left water depth If on, the water depth value of the left rut at
a section location is drawn as text element.

Right water depth If on, the water depth value of the right rut at
a section location is drawn as text element.

Draw fitted line If on, the line of the fitted slope of a section
is drawn as line element.

Draw section elevation line string If on, the line following the elevation
variation of a section is drawn as line string
element.

You can undo the action by using the Undo command of the CAD platform.

Read / Slope arrows

Read / Slope arrows command reads text files that have been created in an automatic process
for extracting the superelevation of road lanes. It is used to draw arrows and labels into the
CAD file. The arrows point into the direction of the slope and the labels show the gradient of
the slope. See Compute slope arrows macro action for more information about slope arrows
and the creation of slope arrow text files.

The slope arrows are drawn as 3D line string elements and the gradient values as text elements
into the CAD file. The elements are drawn on the active level using the active line width, line
style, and text size settings of the CAD file. The color is determined by settings in the Read
slope arrows dialog.

To read slope arrows into the CAD file:

1. Select Read / Slope arrows command from the Tools pulldown menu.

This opens the Slope arrow files dialog, a standard dialog for opening files.

2. Select slope arrow text files and click Open.

This opens the Read Slope Arrows dialog:
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3. Define settings and click OK.

This reads the text files and draws the slope arrows and values into the CAD file.

SETTING EFFECT

Label unit Unit for expressing the slope gradient:
Degree or Percentage.

Label decimals Number of decimals used in slope gradient
text elements.

Arrowhead length Length of the arrowhead in the arrow
drawing. Given in CAD file units.

Arrowhead width Width of the arrowhead in the arrow
drawing. Given in CAD file units.

Flat color Color of slope arrows and labels if the
gradient is smaller than or equal to the given
value.

Normal color Color of slope arrows and labels if the
gradient value is larger than the value
defined for Flat color and smaller than or
equal to the value defined for Steep color.

Steep color Color of slope arrows and labels if the
gradient is larger than the given value.

You can undo the action by using the Undo command of the CAD platform.
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Read / Tree cells
Not Spatix

Read / Tree cells command reads text files that have been created by the Output Tree Cells
tool. It draws the tree cells on the active level into the CAD file. The cells must be defined in a
cell library attached to the CAD file. See Create Tree Cells for more information about tree cell
definition and an example cell library.

To read tree cells into the CAD file:

1. Select Read / Tree cells command from the Tools pulldown menu.

This opens the Read tree cells dialog, a standard dialog for opening files.

2. Select tree cells text files and click Open.

This reads the text files and draws the tree cells into the CAD file.

You can undo the action by using the Undo command of the CAD platform.

At the moment, cells and thus, the Read / Tree cells command only works in MicroStation.
There is not yet any corresponding element type in Spatix.

Read / Wires

Read / Wires command reads text files that have been created in an automatic process for
extracting overhead wires. See Find wires macro action for more information about automatic
wire extraction in batch mode.

The wires are drawn as 3D line string elements into the CAD file. The line string elements are
drawn on the active level using the active color, line width, and line style settings of the CAD
file.

To read wires into the CAD file:

1. Select Read / Wires command from the Tools pulldown menu.

This opens the Read wires dialog, a standard dialog for opening files.

2. Select wire text files and click Open.

This reads the text files and draws the wires into the CAD file.

You can undo the action by using the Undo command of the CAD platform.
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Show statistics

Show statistics command displays basic statistics information about laser points. In the upper
part of the Statistics window, the amount of all points, active points and neighbour points are
listed, as well as the elevation range for all points. In the lower part, the separate classes are
listed with the point count, minimum elevation and maximum elevation values for each class.

Smoothen points

Smoothen points command can be used to smooth attributes of laser points. The points are
modified according to their closest neighbours. This results in a more homogeneous
appearance of the point cloud. The following methods can be applied:

· Xyz surface - 3D smoothing process, 25-30 neighboring points are used to fit a 2nd degree
surface, points are moved in XYZ closer to this fitted surface, points on vertical surfaces are
smoothed in XY direction, point on horizontal surfaces in Z direction.

· Xyz wires - smoothing process dedicated to linear features, points are moved closer to a
locally fitted line.

· Elevation - adjusts elevation values of laser points iteratively. A best fit plane equation is
derived for this group of points and the elevation of the center point is adjusted to better
match the plane equation. Then, the application tries to decide what areas became smooth
and what areas did not result in a smooth surface. Only the smooth areas are finally
adjusted. Areas which still have significant elevation variation are restored to the original
state.

· Intensity - averages intensity values of each point with its closest neighbors.

· Color - averages color values of each point with its closest neighbors.
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· Distance - averages distance value of each point with a given amount of neighbor points.
This may be useful to reduce the noise of vegetation index values derived from color
information. Thus, the result represents more the real vegetation pattern of an area with
less noise. This may also improve the classification of ground in photogrammetric point
clouds, as it can be supported by the distance value.

You would normally run elevation smoothing on ground point class in order to:

· remove random variation in laser point elevations and produce a more accurate model.

· produce a smoother surface so that contours look nicer.

· produce a smoother surface so that profile drawings look nicer.

You should not use elevation smoothing if:

· the terrain is covered with low vegetation and there are no smooth surfaces.

· you intend to extract features which have only a small elevation change such as road curb
stone lines. Those would be completely smoothed out.

You can include a point class into the smoothing process which is used in the smoothing process
but not modified. You can use this capability, for example, if you have classified points close to
breakline features into a separate class (elevation smoothing) or if points on paint markings are
classified into a separate class (intensity smoothing for points on road surfaces).

To smoothen points:

1. Select Smoothen points command from the Tools pulldown menu.

This opens the Smoothen Points dialog:

2. Define values and click OK.

This starts smoothing process.

SETTING EFFECT

Smoothen Smoothing method: Xyz - surface, Xyz -
wires, Elevation, Intensity or Color values.

Modify class Point class(es) included in and modified by
the smoothing process.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Modify class field.

Fixed class Point class(es) included in the smoothing
process but points in these classes are not
modified.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Fixed class field.

Max fix | up | down Maximum horizontal/vertical up/down
change to apply to a point. A point is not
modified if it is more than the given value
away form a locally fitted plane or line.
This is only active if Smoothen is set to Xyz
- surface, Xyz - wires or Elevation.

Use reliability as weight factor If on, the reliability value stored for points
is considered when smoothing points. This
is only active if Smoothen is set to Xyz.

Radius 3D distance from a point which defines the
sample area for line fitting or from which
the average color, intensity or distance
value is derived. This is only active if
Smoothen is set to Xyz - wires, Intensity,
Color or Distance.

Limit Defines the maximum intensity value of
points that are effected by the smoothing
process. Given as factor of the standard
deviation of intensity values in the sample
area defined by the Radius. If a point
differs more in intensity from its
neighbours than the computed limit, it is
not effected by the smoothing process.This
is only active if Smoothen is set to
Intensity.

Average max Maximum amount of points that are
included in the average distance
computation. This is only active if
Smoothen is set to Distance.

Modify hue If on, the hue component of the HSV value
of a point is modified. This is only active if
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SETTING EFFECT

Smoothen is set to Color.

Modify saturation If on, the saturation component of the HSV
value of a point is modified. This is only
active if Smoothen is set to Color.

Modify value If on, the value component of the HSV
value of a point is modified. This is only
active if Smoothen is set to Color.

Inside fence only If on, only points inside a fence or selected
polygon are effected by the process.
Requires a fence or a selected polygon in
the CAD file.

Sort

Sort command sorts loaded laser points according to the selected attribute. The sub-menu
includes the following options for sorting points:

· By time stamp - points are sorted by increasing time stamps. This is the recommmended
order for processes that rely on trajectory positions, such as cut overlap, classify by range,
and most of the TerraMatch processes.

· By line and time - points are sorted by increasing line numbers and time stamps.

· By line, scanner and time - points are sorted by increasing line numbers, scanner numbers
and time stamps.

· By xy location - points are sorted geographically by increasing xy location. This is the
recommended order for processes that rely on geometrical conditions between points in
the point cloud. Especially for photogrammetric point clouds, this order is strongly
recommended in order to speed up many automatic processes.

· By increasing X - points are sorted by increasing easting coordinate values.

· By decreasing X - points are sorted by decreasing easting coordinate values.

· By increasing Y - points are sorted by increasing northing coordinate values.

· By decreasing Y - points are sorted by decreasing northing coordinate values.

· By increasing Z - points are sorted by increasing elevation coordinate values.

· By decreasing Z - points are sorted by decreasing elevation coordinate values.

To sort laser points:

1. Select an option from the Sort sub-menu from the Tools pulldown menu.

This sort the points according to the selected attribute.

If points from neighboring blocks are loaded in addition to the active block, the points of
both are sorted independently.
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Thin points

Thin points command reduces unnecessary point density by removing some of the points which
are close to each other or within a grid cell of a given size.

The thinning method which relies on point density tries to find groups of points where all the
points are within the given horizontal distance and elevation difference from a central point in
the group. Alternatively, the thinning can be done based on a 2D or 3D grid. Then, one point per
grid cell is kept. This may be useful to thin a point cloud to a specific density, for example, to 1
point per square meter in selected areas. The 2D grid method is optimized for airborne data.
The 3D grid method is developed for mobile data but not yet optimized for achieving a
homogeneous point density.

Another setting of the command determines which point in each group or grid cell is kept. The
Keep methods for groups that rely on the point cloud geometry are illustrated in the following
figures:

Groups of points

Highest point in each group

Lowest point in each group

Central point in each group

Created average for each group



TerraScan User Guide  © 2023 Terrasolid Ltd

557TerraScan Window > Tools pulldown menu > Thin points

Additional options are to keep points with the highest or lowest intensity value, points with
the earliest or latest time stamp, points with the smallest or biggest distance value or points
from a given class.

The removed points can be either deleted or classified into another point class.

To thin points:

1. Select Thin points command from the Tools pulldown menu.

This opens the Thin Points dialog:

2. Define settings and click OK.

This thins the point cloud.

SETTING EFFECT

From class Point class(es) from which to thin out
unnecessary points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Class into which removed points are
classified. Alternatively, you can select the
Delete option in order to delete the points
completely from the point cloud.

Method Thinning method:

· By density - thinning based on distance
and elevation difference between points.
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SETTING EFFECT

· 2D Grid - thinning based on a 2D grid. One
point per grid cell is kept.

· 3D Grid - thinning based on a 3D grid. One
point per grid cell is kept. Developed for
mobile point clouds.

· By order - thinning based on point order.
The common order of LiDAR point clouds
is by time stamp, but any other order, for
instance created by the Sort command, is
possible.

· Average density - thinning based on
distance and elevation difference
between points. Chooses suitable
thresholds based on the  average spacing
within the point cloud.

Keep Defines which point to keep in each group
of points:

· Highest point - point with highest
elevation.

· Median Z point - point with median
elevation value.

· Lowest point - point with lowest
elevation.

· Central point - point closest to the center
of the group. If Method is set to 2D Grid,
the point closest to the central XYZ
location of points in a grid cell is kept.

· Create average - substitute group by
creating an average point.

· Biggest distance - point with biggest
distance value. This requires the
computation of distance values.

· Smallest distance - point with smallest
distance value. This requires the
computation of distance values.

· Highest intensity - point with highest
intensity value.

· Lowest intensity - point with lowest
intensity value.

· First in time - point with earliest time
stamp.

· Last in time - point with latest time
stamp.

· First echo - point with the lowest return
number.

· Last echo - point with the highest return
number.
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SETTING EFFECT

· Random - random selection of a point to
keep.

· points of a specific point class.

Keep full pulse If on, all points of the same pulse are kept if
the software decides to keep one point of a
pulse.

Inside fence only If on, only points inside a fence or selected
polygon are effected by the process.
Requires a fence or a selected polygon in
the CAD file.

Distance Horizontal distance limit between two
points. This is only active if Method is set to
By density.

Dz Elevation difference limit between two
points. This is only active if Method is set to
By density.

Grid step Size of a grid cell. This is only active if
Method is set to 2D Grid or 3D Grid.

Toolboxes

The commands from the Toolboxes submenu open the TerraScan toolbars. The toolbars are part
of the TerraScan toolbox. Alternatively, a toolbar can be opened by selecting As Toolbar
command from the toolbox pop-up which is displayed after keeping the data button pressed
for 1-2 seconds on a tool icon in the TerraScan toolbox.

The submenu contains only toolbars that are available for the installed TerraScan version. Some
toolbars are only available in the full version of TerraScan.

Transform known points

Transform known points command transforms coordinate values of points in a text file. This can
be used, for example, to transform known ground control points from one projection system
into another.

To transform a known points file:

1. Select Transform known points command from the Tools pulldown menu.

This opens the Source point file dialog, a standard dialog for selecting a file.

2. Select the file that stores the known points’ coordinates and click Open.
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This opens the Transform File dialog:

3. Define transformation settings and click OK.

This opens the Save transformed points dialog, a standard dialog for saving a file.

4. Define a storage location and name for the output file and click Save.

This saves the transformed known points into a new text file.

SETTING EFFECT

From projection Projection system of the original points. Click
on the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

To projection Target projection system. Click on the >>
Button to open the Browse for Projection
System dialog. The dialog provides a search
option for projection systems as well as a list
of all implemented systems. In addition, any
user-defined projection systems are included
in the list.

Transform Additional transformation applied to the
points’ coordinates. The list contains all
transformation defined in the Coordinate
transformations / Transformations category
of TerraScan Settings.

Transform loaded points

Transform loaded points command applies a transformation to points loaded in TerraScan. The
transformation can be applied to all points or to points of selected class(es), selected lines,
and/or inside a fence or selected polygon.

The transformation can be defined in different ways:
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· Dz - fixed elevation difference value in order to apply a systematic elevation shift.

· Dxyz - text file storing difference values for easting, northing and elevation. The format of
the text file is X Y dX dY dZ.

· Projection change - a source and a target projection system are selected from a list of
implemented projection systems.

· Height from ground - elevation of each point is replaced by its height above ground. Ground
is defined by points in one or more point classes.

· Height from TIN - elevation of each point is replaced by its height above a TIN model. The
TIN model is defined by an active surface model in TerraModeler.

· Add TIN - elevation values of a TIN are added to the original elevation values of loaded
points. The corresponds to an Adjust to geoid action which uses a TIN as geoid model. The
TIN is defined by an active surface model in TerraModeler.

· Scale dZ from TIN - scaled elevation difference values between the loaded points and a TIN
are added to the original elevation values of loaded points. The TIN is defined by an active
surface model in TerraModeler.

· A specific transformation defined in Coordinate transformations / Transformations category
of TerraScan Settings.

To transform loaded points:

1. Select Transform loaded points command from the Tools pulldown menu.

This opens the Transform Points dialog:
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2. Define settings and click OK.

This modifies the coordinates of loaded laser points according to the selected
transformation.

SETTING EFFECT

Class Point class(es) for which the
transformation is applied.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Line Line number(s) for which the
transformation is applied. Use a comma or
minus to separate several line numbers,
for example 2-5,10.

Transform Type of transformation.
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SETTING EFFECT

Dz Fixed value added to the original elevation
values of loaded points. This is only active
if Transform is set to Dz.

File Text file that stores the XYZ correction
values. This is only active if Transform is
set to Dxyz.

From system Source projection system. Click on the
Browse button to open the Browse for
Projection System dialog. The dialog
provides a search option for projection
systems as well as a list of all implemented
systems. In addition, any user-defined
projection systems are included in the list.

To system Target projection system. Click on the
Browse button to open the Browse for
Projection System dialog. The dialog
provides a search option for projection
systems as well as a list of all implemented
systems. In addition, any user-defined
projection systems are included in the list.

Ground Point class(es) defining the ground surface
from which height values are derived. This
is only active if Transform is set to Height
from ground.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground field. This is only active if
Transform is set to Height from ground.

Surface Surface model name that defines the TIN
surface from which height values are
derived. Requires an active surface model
in TerraModeler. This is only active if
Transform is set to Height from TIN, Add
TIN, or Scale dZ from TIN.

Scale Scale factor for exaggerating elevation
differences between loaded points and a
TIN model. This is only active if Transform
is set to Scale dZ from TIN.

Both, the original and the final coordinates must fit inside the coordinate value ranges
defined in Define Coordinate Setup tool.
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View pulldown menu

Commands from the View pulldown menu are used to change the appearance of the TerraScan
window as well as the display settings for laser points.

TO USE COMMAND

Switch TerraScan window to small size Small dialog

Switch TerraScan window to medium size Medium dialog

Switch TerraScan window to large size Large dialog

Switch TerraScan window to wide size Wide dialog

Display column titles in the main window Column titles

Change the display of fields in TerraScan
window

Fields

View header records of an LAS file Header records

View histograms of color channels Color histograms

Fit a view to display all loaded points Fit view

View points using elevation or intensity
coloring

Display mode

Small dialog

Small dialog command changes the TerraScan window to a minimal size which consists of a title
bar and pulldown menus only.

Medium dialog

Medium dialog command changes the TerraScan window to a medium size which consists of a
title bar, the pulldown menus, and a medium size list displaying the attributes of loaded points.

Large dialog

Large dialog command changes the TerraScan window to a large size which consist of a title bar,
the pulldown menus, and a large size list displaying the attributes of loaded points.

Wide dialog

Wide dialog command changes the TerraScan window to a wide size which consist of a title bar,
the pulldown menus, and a wide size list displaying the attributes of loaded points.
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Column titles

Column titles command displays field names in the TerraScan window. If the command is
ticked, the field names are displayed.

Color histograms

Color histograms command opens a window that shows histograms of color channels for loaded
points.

Display mode

Display mode command opens the Display mode
dialog which contents settings for controlling the
display of points loaded in TerraScan. See also Point
display category of TerraScan Settings for setting
default values and the general drawing method for
points.

To set up the display  of points:

1. Select Display mode command from the View
pulldown menu.

This opens the Display mode dialog.

2. Select a View for which you want to modify the
point display.

3. Define display settings.
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4. Click Apply in order to update the display settings
to the selected view.

SETTING EFFECT

View View for which display settings
are modified and applied.

Fit Fit the display in the selected
View to the extend of the visible
points.

Color by Attribute of points used for
coloring:

· Amplitude

· Class

· Class +
image

· Class +
intensity

· Color

· Color +
intensity

· Density

· Depth

· Deviation

· Dimension

· Distance

· Distance +
intensity

· Echo

· Echo length

· Elevation

· Group

· Group +
Intensity

· Image
assignment

· Image color

· Intensity
custom/auto

· Line

· Line + Intensity

· Normal

· Normal +
intensity

· Reflectance

· Reliability

· Scanner

· Scan direction

· Shading

· Slope

· Time

· Time +
Intensity

· Vegetation
index

Coloring options are only
available for display if the
corresponding attribute is
assigned to the loaded points.

Colors Opens a specific dialog depending on the selected coloring attribute. See more
information for each coloring attribute below.

Weight Determines the point size:

· By class - class-specific size settings. See Define Classes command for information
about class definitions.

· 0 ... 7 - eight standard line weights of the CAD file.
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· Relative - point size varies depending on the zoom level. The factor next to the
Weight field determines the point size based on the point-to-point spacing.

· Smooth fill - smoothed point display effect. Good for viewing surfaces with
intensity or point color display. The factor next to the Weight field determines
the amount of smoothing based on the point-to-point spacing.

Points Visibility of points based on a Displayset:

· Draw all - all points.

· Displayset only - points of a defined display set. This requires that a displayset
has been defined by the Add Points To Displayset tool.

Lines Visibility of points based on the line number: Draw all or Selected.
The Select button opens the Display lines dialog where you can select the visibility
of specific lines.
The > button lets you select a line for display interactively. The line closest to a data
click inside a view is displayed, all other lines are switched off.

Dims Visibility of points based on the dimension attribute:

· Draw all - all points.

· Unknown only - points of unknown dimension.

· Linear only - points of linear dimension.

· Planar only - points of planar dimension.

· Complex only - points of complex dimension.
This is only active if dimensions and normal vectors are computed for the points.
See Compute normal vectors command for more information.

Speed Method of drawing points:

· Fast - sparse points - amount of displayed points depends on the zoom factor. If
you zoom out, only a subset of points is drawn. This is the recommended setting
for displaying a larger amount of points.

· Normal - more points are drawn. The software decides based on the density of
the point cloud. In sparse data sets, this already draws all points.

· Slow - all points - all points are drawn at every zoom level. This is recommend, for
example, for displaying sparse points spread over a larger area. It may slow down
the display speed for a large amount of points.

Border
s

The setting enhances
the depth perception of
the point cloud by
drawing black borders
around point groups that
are in front of other
points from the viewer's
perspective. If set to a
value > 0, the display of
the point cloud includes
the given percentage of
black space on the
screen. The larger the
value, the more black
borders are drawn and



TerraScan User Guide  © 2023 Terrasolid Ltd

568TerraScan Window > View pulldown menu > Display mode

the more detailed the
point cloud appears.
10% is a good value for
many data sets and
viewing directions. The
maximum value is 50.
The setting enforces the
Raster display method.
See also Point display
category of TerraScan
Settings.

Use
normal

If on, normal vectors are
used for drawing points.
The brightness of the
points is detemined by
the normal direction
where 'foreside' points
are drawn brighter and
'backside' points are
drawn darker. The
setting works only for
points of planar
dimension and in
combination with
constant coloring types
for points, such as Color
by = Class, Dimension,
Echo, Line, etc. This is
only active if normal
vectors are computed
for the points.

List of
classes

Switch the visibility of single classes on or off by clicking in the field next to the
class name. The list contains the active classes of TerraScan.

All On Switch on the visibility of all classes.

Invert Invert the visibility of classes.

All Off Switch off the visibility of all classes.

Apply Apply current settings to the selected View.

All
views

Apply current settings to all views.

Undo the last change to display settings. This sets back the display to the previous
state. The undo button works only for one last modification of display settings.

Extend the length and/or width of the Display mode dialog. If the dialog is
extended to a wide dialog, the class numbers are displayed in addition to the class
names.
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Color by Amplitude

Color by Amplitude setting displays points according to the Riegl Extra Byte attribute Amplitude.

Color by Class

Color by Class setting displays the points according to their class attribute. To change the colors
for classes, click the Colors button next to the Class by field. This opens the Point classes dialog
which is described in detail for the Define Classes tool.

Color by Class + image

Color by Class + image setting displays the points according to their class attribute and uses
active image list to enhance visibility of details. This option renders points as small discs with
image information rectified on it. Color of each point is specified by the class, whereas local
brightness values are rectified from images. To change the colors for classes, use Define Classes
tool.

This display option requires point cloud with image numbers stored, and respective image list
to be loaded in TerraPhoto. This mode also benefits from normal vector computation.

A new input Color pts is added to the display mode dialog. This refers to TerraPhoto color point
file for balancing brightness differences between images.

Color by Class + intensity

Color by Class + intensity setting combines class and intensity coloring. The color value is
determined by the class while the brightness of the color indicates the intensity value.

The Colors button opens the Point classes dialog, the same dialog as for Color by Class. The
brightness values for intensity cannot be changed.

Color by Color

Color by Color setting displays the points according to their color values. This requires that color
values are assigned to the points. TerraScan can assign up to 10 color channels for each point.
The maximum amount of color channels can only be stored in the TerraScan FastBinary format.
LAS 1.4 format and later can store up to 4 color channels, LAS 1.2 format and later up to 3.

There are three channels available for displaying points by color. The color channel number can
be selected from the list. Only channel with values <> 0 are selectable in the list. If colors have
been extracted from 4-channel images, where the channels are 0=red (R), 1=green (G), 2=blue
(B), and 3=near-infrared (NIR), the typical channel combinations for display are:

· R: 0, G: 1, B: 2 - true-color display, typical RGB color point display

· R: 3, G:1, B: 2 - infrared-color display

https://terrasolid.com/guides/tphoto/cp.html#cp
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· same value for all channels - one-channel display

Color values for laser points can be extracted from raw images or raster attachments loaded
into TerraPhoto, or assigned per class by setting values for red, green, and blue channels. See
Extract color from images and Assign color to points for corresponding commands in TerraScan.

Color by Color + intensity

Color by Color + intensity setting combines color and intensity coloring. The color value is
determined by the color values assigned to points while the brightness of the color indicates
the intensity value.

Color by Density

Color by Density setting displays points according to the local point density. The density is
defined as sphere radius of 5 times the average spacing of points using a local 3D neighborhood
around each point. The denser the point cloud, the brighter the gray-scale value of the density
coloring scheme. A new adjustment bar is added to the Display mode dialog which lets you
adjust the coloring scheme more to the dark or bright side of the gray values.

The display option provides an understanding of density differences in point clouds, especially
in MLS data  or point clouds from static terrestrial scanners (TLS data). It also helps to identify
the scanner position in TLS point clouds.

Color by Depth

Color by Depth setting displays points based on the distance from the CAD view to the point. An
automatically fitted gray scale scheme is used to represent the depth, making close by points
light and distant points dark.

The display option is useful in interpretation of complex three dimensional environments, for
example indoor data captures. It can highlight objects and distances already in the beginning of
the work flow, before data is processed, colorized, or classified.

Color by Deviation

Color by Deviation setting displays points according to the Riegl Extra Byte attribute Pulse
deviation. A user-defined coloring scheme is used to represent the deviation values. The color
definition works in the same way as for distance coloring.

A small deviation value indicates a normal shape return pulse. A big deviation value indicates
an abnormal shape return pulse.
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Color by Dimension

Color by Dimension setting displays points according to their
dimension attribute. The dimension of a point is computed
together with its normal vector. See Compute normal vectors
command for more information.

The Colors button opens the Dimension colors dialog.

The dialog lets you choose colors for displaying points with
No dimension and for the three possible dimension types:
Linear, Planar, and Complex. Click on the color field in order
to select a color from the standard Windows dialog for color selection.

Color by Distance

Color by Distance setting displays points based on the distance value. This requires that a
distance value has been computed for points using the Compute distance command or macro
action.

To color points by  distance

1. Click on the Colors button next to the Class by field.

This opens the Distance Coloring Scheme dialog:

 

2. Define settings.
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A distance color scheme can be saved into a file by using the File / Save as command of the
dialog. This creates a text file with the extension .DCL. You can open a distance color scheme
file by using the File / Open command of the dialog.

SETTING EFFECT

Add Add a new distance value and color to the
scheme. The button opens the Distance
Color dialog. Type a Distance value in the
text field. Click on the Color field in order to
open the standard Windows dialog for
selecting a color.

Edit Modify a distance value and color. Select a
value-color pair in the list of the dialog. Click
the button which opens the Distance Color
dialog. Type a Distance value in the text
field. Click on the Color field in order to open
the standard Windows dialog for selecting a
color.

Delete Delete a distance value-color pair from the
scheme. Select the value-color pair and click
the button.

No distance Display color for points without a distance
value: 

· Fixed color - click on the color button next
to the selection list in order to open the
standard Windows dialog for selecting a
color.

· Color by intensity - intensity gray-scale
values are used.

Color by intensity If on, points outside the distance range
defined in the color scheme are displayed
with intensity gray-scale values.

Minimum Minimum distance value for intensity
display. This is only active if Color by
intensity is switched on.

Maximum Minimum distance value for intensity
display. This is only active if Color by
intensity is switched on.

Brightness Determines the amount of white added to
the intensity gray-scale scheme. A lower
value makes the display darker, a higher
value brighter. This is only active if Color by
intensity is switched on.

3. Click OK in the Distance Coloring Scheme dialog.

The software computes the distances.
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4. Click Apply in the Display mode dialog in order to update the point display for the selected
view.

After changes in distance values of points, the distance coloring can be updated in a fast way
by using the Update Distance Coloring tool.

To create exact step-wise color-value pairs, add every color twice to the list and fix the
lowest and highest value for the color. E.g., define yellow for value 20.000 and again for
29.999, followed by red for value 30.000. As a result, there is a clean change in color between
value range 20 - <30 and 30+ instead of smooth transitions between the colors.

Color by Distance + intensity

Color by Distance + intensity setting combines distance and intensity coloring. The color value is
determined by the distance values assigned to points while the brightness of the color
indicates the intensity value.

Color by Echo

Color by Echo setting displays the points according to their
return type.

The Colors button opens the Echo Colors dialog.

The dialog lets you choose colors for displaying points of
different echo types: Only, First of many, Intermediate, and
Last of many. Click on the color field in order to select a color
from the standard Windows dialog for color selection.

Color by Echo length

Color by Echo length setting displays points according to the length of the return pulse. The
value is relative to a typical return pulse length on a hard surface. The echo length has to be
extracted from waveform information. Alternatively, the Riegl Extra Byte attribute Pulse width
is used in TerraScan as Echo length attribute, if available.

The Colors button opens the Coloring Scheme dialog, the TerraScan dialog for 256 Colors.

Color by Elevation

Color by Elevation setting displays the points according to their elevation value. A color scheme
is applied where each color represents a range of elevation values. The default color scheme of
TerraScan consists blue colors for low elevation values, green and yellow colors for
intermediate values, and red colors for high elevation values with smooth transitions between
the colors.

https://terrasolid.com/guides/tscan/introwaveformprocessing.html
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A new setting Fit to view is added to the Display mode dialog. If on, the colors are adjusted
dynamically to the elevation range of points that are currently visible in a view extend. This
leads to a better visualization of points when views are zoomed or panned.

The Colors button opens the Elevation Coloring Scheme dialog:

A distance color scheme can be saved into a file by using the File / Save as command of the
dialog. This creates a text file with the extension .ECL. You can open an elevation color
scheme file by using the File / Open command of the dialog.

The square toggle button next to an elevation value can be used to fix a value. If on, the
elevation value does not change when moving value-color pairs up/down in the color
scheme.

SETTING EFFECT

Add Add a new elevation value and color to the
scheme. The button opens the Elevation
Color dialog. Switch on Fix elevation and
type an Elevation value in the text field.
Click on the Color field in order to open the
standard Windows dialog for selecting a
color.

Edit Modify an elevation value and color. Select
a value-color pair in the list of the dialog.
Click the button which opens the Elevation
Color dialog. Switch on Fix elevation and
type an Elevation value in the text field.
Click on the Color field in order to open the
standard Windows dialog for selecting a
color.
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SETTING EFFECT

Move up Moves an elevation value-color pair up in
the scheme. The elevation value is adjusted
automatically.

Move down Moves an elevation value-color pair down
in the scheme. The elevation value is
adjusted automatically.

Delete Delete an elevation value-color pair from
the scheme. Select the value-color pair and
click the button.

Range By default, the range for the color ramp
includes the elevation values of all loaded
points. This can be changed by selecting a
class in the Range from list. The list contains
the active classes in TerraScan. Then, only
the elevation values of the selected class
are applied to the color scheme.

Auto fit Removes outliers from the color scheme by
fixing the lowest and highest elevation
values. This results in a color scheme where
outliers do not affect the color distribution
in the coloring scheme. In addition, all other
elevation values are equally distributed
within the scheme and intermediate fixed
values are switched off to be flexible.
The auto fit action can be performed
automatically whenever points are loaded
into TerraScan if the corresponding setting
in Point display category of TerraScan
Settings is switched on.

To create exact step-wise color-value pairs, add every color twice to the list and fix the
lowest and highest value for the color. E.g., define yellow for value 20.000 and again for
29.999, followed by red for value 30.000. As a result, there is a clean change in color between
value range 20 - <30 and 30+ instead of smooth transitions between the colors.

Color by Group

Color by Group setting displays points according to their group number. This requires that a

group number has been assigned to points. See Assign groups command for more information.
The coloring mode uses colors of the active color table of the CAD file.

You can use the Shuffle button in order to change the color values for the groups.
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Color by Group + Intensity

Color by Group & Intensity setting combines group and intensity coloring. The color value is
determined by the group while the brightness of the color indicates the intensity value.

You can use the Shuffle button in order to change the color values for the groups.

Color by Image assignment

Color by Image assignment setting displays points according to their image number. This

requires that an image number has been assigned to points. This can be achieved by extracting
color from images for loaded points or project block binary files. The coloring mode uses colors
of the active color table of the CAD file.

A new setting Draw seamlines is added to the Display mode dialog. If on, image seamlines are
displayed temporarily.

Color by Image color

Color by Image + color renders a point as a small disc with image information rectified on it. This
display mode combines good parts of images and point cloud. It includes all the details
captured in image data while showing the captured three dimensional geometry.

This display option requires point cloud with image numbers stored, and respective image list
to be loaded in TerraPhoto. This mode also benefits from normal vector computation.

A new input Color pts is added to the display mode dialog. This refers to TerraPhoto color point
file for balancing brightness differences between images.

Color by Intensity auto/custom

Color by Intensity custom/auto settings display the points according to their intensity value.
The default gray scale of TerraScan stretches from dark gray for low intensity values to white for
high intensity values.

Intensity auto uses a more homogeneous gray-scale coloring scheme. The intensity values are
fitted to the gray values of the coloring scheme  in a way that each gray value gets a similar
amount of points. This results in a smoother intensity display, especially if intensity values are
not normal-distributed. The Save As button opens the Save intensity auto scheme dialog, a
standard dialog for saving files. You can save the gray value scheme to a text file with the
extension .CLR.

Intensity custom uses the CAD file color table and fits the intensity values to the gray-scale
color values. The Colors button opens the Coloring Scheme dialog, the TerraScan dialog for 256
Colors.

https://terrasolid.com/guides/tphoto/cp.html#cp
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Color by Line

Color by Line setting displays the points according to their line
number. By default, the soft ware uses the first seven colors
from the active color table of the CAD file for coloring points.

The Colors button opens the Line coloring dialog.

The dialog lets you choose colors for displaying points of
different line numbers. Select a line from the list. Click on the
color field in order to select a color from the standard Windows
dialog for color selection.

Color by Line & Intensity

Color by Line & Intensity setting combines line and intensity
coloring. The color value is determined by the line while the brightness of the color indicates
the intensity value. This can be used, for example, to check the horizontal accuracy of
overlapping line.

The Colors button opens the Line coloring dialog, the same dialog as for Color by Line. The
brightness values for intensity can not be changed.

Color by Normal

Color by Normal setting displays points according to the direction of a slope. This requires the
computation of normal vectors. The colors of a color circle are used for the possible slope
directions, starting from red for slopes facing to North-East via blue and green in clockwise
direction.

A new setting Color limit is added to the Display mode dialog. The percentage refers to the
gradient of a slope where 0 corresponds to a horizontal surface. If the gradient of a surface is
smaller than the given percentage value, the saturation of the colors decreases. Horizontal
surfaces are displayed in gray. The value may vary from 0 to 179 degree.

Color by Normal + intensity

Color by Normal & Intensity setting combines slope and intensity coloring. The color value is
determined by the normal vector computed for a point while the brightness of the color
indicates the intensity value.

A new setting Bright display is added to the Display mode dialog. If on, the brightness of
intensity values is increased. This makes the slope colors better visible in point clouds with
rather dark intensity values.



TerraScan User Guide  © 2023 Terrasolid Ltd

578TerraScan Window > View pulldown menu > Display mode

Color by Reflectance

Color by Reflectance setting displays points according to the Riegl Extra Byte attribute
Reflectance. An automatically fitted gray scale scheme is used to represent the attribute. The
display is very similar to intensity coloring for ALS data.

Color by Reliability

Color by Reliability setting displays points according to the
Agisoft attribute Confidence. The value indicates from how
many images a point is generated. The more images are
involved, the more confident a point is generated.

The Colors button opens the Reliability Colors dialog.

The dialog lets you choose colors for displaying points of
low reliability. Click on the color field in order to select a
color from the standard Windows dialog for color selection.

Color by Scanner

Color by Scanner setting displays the points according to their scanner number. This is useful to
distinguish points collected by different scanners of a multi-scanner system.

The Colors button opens the Scanner coloring dialog, the same dialog as for Color by Line.

Color by Scan direction

Color by Scan direction setting displays the points according to the scan direction. A point may
be recorded in negative or positive scan direction, or as edge point. This requires that laser
points are stored in LAS files. The display is based on the scan direction and edge of flight line bit
fields present in LAS files.

Color by Shading

Color by Shading setting displays a triangulated surface of the points colored by class and
shaded by triangle slope. This is useful, for example, to check ground classification results
because error ground points show up clearly in the shaded surface display.

If Color by Shading is selected, three more settings are added to the Display mode dialog:

· Azimuth - direction of the light source. Zero is north and positive values increase clockwise.

· Angle - height above horizon of the light source.
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· Display dynamics - if on, the point cloud is displayed in dynamic views, for example if the
view is moved or rotated with CAD tools. This slows down the movement speed. If off, the
point cloud is only drawn in static views.

Color by Slope

Color by Slope settings
displays points according to
the gradient of a slope. This
requires the computation of
normal vectors.

The Colors button opens the
Color Scheme dialog.

To define a new color scheme
or modify  a color scheme:

1. Select a Unit for expressing
slope gradients: Degree or
Percentage.

2. Follow the steps for color
scheme definition.

3. Click OK.

Color by Time

Color by Time setting displays the points according to time stamp intervals. A new setting
Separation is added to the Display mode dialog. It determines how long a time interval is for
drawing points in one color. A time interval can be defined in seconds, minutes, hours, days,
weeks or years.

The display option provides an understanding of the scan pattern, for example for data
captured with a hand-held scanner. For ALS data, by using a large time interval, the display is
approximately the same as color by line.

The display option requires that times stamps are stored for the points.

Color by Time + Intensity

Color by Time + Intensity setting combines time and intensity coloring. The color value is
determined by the time stamp interval while the brightness of the color indicates the intensity
value.
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Color by Vegetation index

Color by Vegetation index setting displays points according to a color channel computation. The
display method is available if colors of multiple channels are extracted for the point cloud. The
display mode provides two implemented methods for computing the vegetation index.

Normalized difference

The method assumes that channel 0 stores red (R) and channel 3 near-infrared (NIR) color
values. The normalized difference value is computed with the following equation:

ND = (NIR - R) / (NIR + R) -1 <= ND <= +1

Visual band difference

The method assumes that channel 0 stores red (R), channel 1 green (G), and channel 2 blue (B)
color values. The visual band difference value is computed with the following equation:

VBD = (2*G - R - B) / (2*G + R + B) -1 <= VBD <= +1

In the Point display category of TerraScan Settings, a threshold value is defined for each
vegetation index computation method. If the  difference value of a point is smaller than the
threshold, the point is displayed with intensity coloring (non-vegetation). If the difference
value of a point is larger than the threshold, the point is displayed with a green coloring (=
vegetation). The higher the vegetation index, the brighter the green.

In addition to the implemented methods, the list may include any User vegetation indexes
defined in the corresponding category of TerraScan Settings.

Fields

Fields command lets you select which attributes are displayed in the TerraScan window if point
are loaded in TerraScan. The list of loaded points is only visible if the window is displayed as
Medium dialog, Large dialog, or Wide dialog.

To select visib le fields:

1. Select Fields command from the View pulldown menu.

This opens the View Fields dialog:
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2. Select fields you want to see in the list of loaded points and click OK.

FIELD NAME DESCRIPTION

Class Number of the point class. Mandatory
attribute in TerraScan, must be unique.

Description Description or name of the point class.
Defined in the Point classes dialog.

Line Line number. May refer to the flight line,
drive path or scan number in ALS, MLS or
static TLS point clouds. 

Time stamp Point of time when a laser point was
captured. Expressed in seconds.

Date Date of data capture. This is derived from the
time stamp of a point, if the time stamp
format is GPS standard time or GPS time.

Echo Return signal type. TerraScan distinguishes
four return types: Only, First (of many),
Intermediate, Last (of many).

Easting | Northing | Elevation XYZ coordinates of points. Mandatory
attribute in TerraScan.

Amplitude Riegl Extra Bytes attribute: Amplitude.

Intensity Reflectance value or strength of the return
signal. Represents the reflectivity of the
surface that was scanned.

Reflectance Riegl Extra Bytes attribute: Reflectance.

Deviation Riegl Extra Bytes attribute: Pulse shape
deviation.

Reliability Agisoft value: Confidence.
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FIELD NAME DESCRIPTION

Point color RGB Color of a point expressed in channels of the
Red Green Blue color model. Uses 24-bit
color values ranging from 0 to 65535. Color
can be extracted from images or assigned
using different methods.

Point color HSV Color of a point expressed in values of the
Hue Saturation Value color model.

Scan angle Angle of a scan signal off from vertical.

Echo number Number of return out of all returns from a
scanner signal.

Scanner Number of a scanner. Essential for
differentiating data of different scanners in
multiple-scanner systems. Assigned when a
point cloud is loaded or imported into
TerraScan.

Echo length Relative length of a return signal compared
to a typical return from a hard surface. Can be
derived from waveform information in
TerraScan (full version) or from Riegl Extra Byte
attribute Pulse width.

Echo position Difference in position of a peak of a return
signal compared to a typical return from a
hard surface. Can be derived from waveform
information in TerraScan (full version).

Distance Distance value of a point. Different
computation methods.

Group Group number assigned to a point. 

Image number Image number assigned to a point when color
values are extracted from raw images.

Fit view

Fit view command fits a CAD view window to an area covered by points loaded in TerraScan.
The command fits the XY range as well as the display depth of a view to the points. It can fit to
the extend of all loaded point or of visible point only.

To fit a  view to the extend of loaded points:

1. Select Fit view command from the View pulldown menu.

The Fit View dialog opens:

https://terrasolid.com/guides/tscan/introwaveformprocessing.html
https://terrasolid.com/guides/tscan/introwaveformprocessing.html
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2. Select a method in the Fit using field: All points or Visible points.

3. Place a data click inside the view which you want to fit.

This fits the view to the area covered by points and redraws the view.

Header records

Header records command opens a window that shows Variable Length Record Header
information of LAS files. The window lists User ID, Record ID, Description and, if available,
additional information for each Variable Length Record stored in an LAS file. The window is
empty if no Variable Length Records are available.

More information about the LAS format definition can be found on the webpages of the ASPRS.
External  l ink Terrasolid is not responsable for the content of webpages of other organizations.

https://www.asprs.org/divisions-committees/lidar-division/laser-las-file-format-exchange-activities
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Wizard pulldown menu

Commands from the Wizard pulldown menu are used to create a project for UAV-based
datasets and to process UAV point clouds in a very automated way.

TO USE COMMAND

Create a project for UAV LiDAR point clouds New Drone Project Not Lite

Process data of a UAV LiDAR point cloud Process Drone Data Not Lite

Publish Wizard steps as a macro Create Drone Macro Not Lite

New Drone Project
Not Lite

New Drone Project command imports data that has been collected with UAV-mounted systems
and pre-processed with system-specific software. The input data includes the LiDAR point cloud
in LAS format and trajectory information. The import wizard performs the following steps:

· Creates a CAD file if not open already

· Fixes coordinate setup to match incoming points

· Reads laser points into memory applying a coordinate transformation

· (Optional) Sort points by xy location for speed improvement

· Classifies all points to class 1 – Default

· (Optional) Adjusts elevation values from ellipsoidal to orthometric

· (Optional) Creates a default list of point classes

· Fixes the scan direction bit

· Creates a folder and reads a trajectory solutions applying a coordinate transformation

· (Optional) Adjusts trajectory elevation values from ellipsoidal to orthometric

· Deduces line numbers for laser points

The import of input data may be system-specific. System selection optimizes certain
parameters, such as level of smoothing, in processing phase according to system
characteristics. 

To create a new project for UAV point clouds:

1. Select New Drone Project command from the Wizard menu.

This opens the New Drone Project dialog:
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2. Define settings and click OK.

SETTING EFFECT

Scanner system Scanner system used to capture the data:

· DJI L1 - DJI ZENMUSETM L1 system.

· YellowScan Explorer

· YellowScan Mapper

· YellowScan Mapper+

· YellowScan Surveyor Ultra

· YellowScan Voyager

· YellowScan Vx15

· YellowScan Vx20

· Rock R360 - Rock Robotic R360 system

· AlphaAir 450 - CHCNAV AlphaAir 450 system

· Other - any other UAV scanner system.

Project name Name of the new project.

Create default point classes If on, the default class file is copied from the
TerraScan installation folder to the project
directory.

Laser input Raw point cloud data provided by the system-
specific software. Click on the Add button in
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SETTING EFFECT

order to select the input file(s) in a standard
dialog. The expected format of the point cloud
file is LAS.

Input system Projection system of the input point cloud
data. Click on the >> Button to open the
Browse for Projection System dialog. The
dialog provides a search option for projection
systems as well as a list of all implemented
systems. In addition, any user-defined
projection systems are included in the list.

Input elevations Elevation values of the input point cloud data:
Ellipsoidal or Orthometric. Data collect with
measurement systems is usually provided
with ellipsoidal height values.

Remove duplicate points If on, point duplicates are removed.

Assign color to black points  If on, color of fully black points is replaced
with intensity based greyscale color.

Sort points for speed If on, points are sorted by XY coordinates. This
speeds up processes that rely on
neighborhood relationships between points.

Trajectory input Raw trajectory data provided by the system-
specific software. Click on the Add button in
order to select the input files in a standard
dialog. The expected format of the trajectory
information is SBET.OUT for the DJI L1 system.
If a related accuracy file SMRMSG.OUT  is
available, TerraScan reads the information
from both files.

Input system Projection system of the input trajectory data.
Click on the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection systems
are included in the list.

Input elevations Elevation values of the input trajectory data:
Ellipsoidal or Orthometric. Data collect with
measurement systems is usually provided
with ellipsoidal height values.

Target system Projection system of the data for processing.
Click on the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well



TerraScan User Guide  © 2023 Terrasolid Ltd

587TerraScan Window > Wizard pulldown menu > New drone project

SETTING EFFECT

as a list of all implemented systems. In
addition, any user-defined projection systems
are included in the list.

Target elevations Elevation values of the data for processing:
Ellipsoidal or Orthometric. Data for delivery is
usually provided with orthometric values of
some local height model.

Geoid model Model that provides the geoid correction.
Transforms the elevation values of the input
data from input to target elevation values.
This is only active if any Input elevations
setting differs from the Target elevations
setting.

Survey date Date when the data was captured. The format
is day/month/year (dd/mm/yyyy). This is
relevant for the conversion of time stamps
when importing point cloud and trajectory
data.

Storage folder Location for storing the data related to the
project. Click on the Browse button in order to
select a folder in a standard dialog.

Process Drone Data
Not Lite

Process Drone Data command provides a wizard for processing point clouds collected with UAV-
mounted scanners. The wizard performs processing steps that are common for many different
end products produced from point clouds. Basically, it combines automatic processing routines
of TerraScan with pre-defined settings. The settings are optimized based on example data sets
and can be adjusted, if necessary. The user may run all steps of the wizard or only selected
steps at once. Manual processing tasks, such as checks, additional classification or other
manipulation of the point cloud can be done at any point between the steps of the wizard.

Before running the wizard, a new UAV project must be created or points must be loaded into
TerraScan. The wizard steps expect that the default point classes of TerraScan are available. The
corresponding class file can be copied for a UAV project as part of the new project data import.
From this class file, do not change classes with numbers 1-8 because they are considered as
industry standard. Classes with class number 9 or higher may be modified according to project
requirements. Some wizard steps require trajectory information. The trajectory files are
created and provided automatically as part of the new project data import. Alternatively, they
can be imported or loaded into TerraScan manually.
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To create a process UAV point clouds automatically :

1. Select Process Drone Data command from the Wizard menu.

This opens the Process Drone Data dialog:

2. Switch on the processing steps you want to apply.

3. For each processing step, click on the Settings button in order to check and possibly adjust
the settings.

4. Click OK.

Split trajectory

Split trajectory step cuts the trajectory covering the data collection area into separate flight
paths. As a result, data from the different flight paths can be easily compared and overlap
between data collected in different flight paths can be removed. in addition, trajectory parts
from turn-arounds (transition segments between flight paths over the data collection area) are
cut off and the point cloud data from these parts is deleted.
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This step is only active if trajectory data is available in TerraScan. The step includes and may
combine the TerraScan actions Cut turnarounds and Split at laser gaps.

SETTING EFFECT

Break at trajectory gaps If on, trajectory is split when there is a time
gap between consecutive trajectory
observations.

Delete parts with no laser points If on, trajectory parts are deleted where no
point cloud data has been collected.

Split at turns If on, the trajectory is split when the system
flew a turn:

· Sharp turn - the trajectory is cut exactly at
the turn-around point. This may end up with
short flight paths (transition segments) from
which data should not be used.

· Smooth curve - the trajectory is cut in the
center of the curve.

Delete short passes If on, trajectory parts and point cloud data
collected for those parts are deleted if the
length of the flight path is below the given
Limit. Use this to remove data from transition
segments between flight paths over the area
of interest.

Match passes

Match passes step mitigates mismatches between overlapping flight paths, improving internal
accuracy of the point cloud. The step applies feature-to-feature matching -approach, searching
for tie lines, correspondence observations between strips and minimizing the mismatch
between observations. In addition to adjusting the point cloud, the tool stores used tie lines
and reports from the process to the storage folder of the drone project.

This step is only active if trajectory data is available in TerraScan.
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The step combines TerraMatch actions Search tie lines, Find Tie Line Match, Find Tie Line
Fluctuations, Find Mirror Angle Correction and Apply Correction. Use of this step requires
TerraMatch to be installed, and licensed properly.

SETTING EFFECT

Max xy mismatch Estimation of the maximum difference
between lines in horizontal positioning. Only
tie lines up to this distance are accepted in
automatic tie line search.

Max z mismatch Estimation of the maximum difference
between lines in elevation positioning. Only
tie lines up to this distance are accepted in
automatic tie line search.

Classify ground for matching If on, extracts ground points and uses them
to extract tie lines. May help reducing outlier
observations in matching.

Per session correction parameters If on, applies systematic correction for
selected parameters. Systematic correction is
optimized separately for each session.

Per line correction parameters If on, applies systematic correction for
selected parameters. Systematic correction is

https://terrasolid.com/guides/tmatch/search-tie-lines.html
https://terrasolid.com/guides/tmatch/find-tie-line-match.html
https://terrasolid.com/guides/tmatch/find-tie-line-fluctuations.html
https://terrasolid.com/guides/tmatch/find-tie-line-fluctuations.html
https://terrasolid.com/guides/tmatch/find-mirror-angle-correction.html
https://terrasolid.com/guides/tmatch/apply-correction.html
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SETTING EFFECT

optimized separately for each line.

Fluctuating correction If on, applies correction changing over time
for selected parameters.

Solve mirror angle correction If on, solve scanner mirror angle dependent
adjustment for data as with TerraMatch Find
mirror angle correction -tool.

Correction for If set to Skip central part, any adjustment
does not apply to points within specified
scan angle range.

Skip from Lower and upper limit for angle range not
adjusted. This is only available if Correction
for is set to Skip central part.

Cut overlap

Cut overlap step removes point cloud data from overlapping flight paths. As a result, there is
data from only one flight path at each XY location. The process removes points that are closer to
flight path edges (more distant from the scanner, larger scan angle) and tries to keep the data
of the most central parts of flight paths (closer to the scanner, scan angle is closer to vertical).
Thus, the data with the potentially biggest locational inaccuracy is removed. In addition, the
data volume is reduced for further processing steps.

This step is only active if trajectory data is available in TerraScan. The step combines the
TerraScan actions Deduce line numbers and Cut overlap.

https://terrasolid.com/guides/tmatch/fluctuating-corrections-tie-lines.html
https://terrasolid.com/guides/tmatch/find-mirror-angle-correction.html
https://terrasolid.com/guides/tmatch/find-mirror-angle-correction.html
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SETTING EFFECT

No trajectory Determines the action for points that can not
be assigned to any trajectory:

· Keep - nothing is done, points are kept as
they are.

· Delete - points are removed from the file.
This is the default setting.

· Classify - points are classified into a
separate class.

To class Target class for points that are not assigned to
any trajectory. This is only active if No
trajectory is set to Classify.

Overlap Determines the action for points that are
identified as overlapping points:

· Keep - nothing is done, points are kept as
they are.

· Delete - points are removed from the file.
This is the default setting.

· Classify - points are classified into a
separate class.

To class Target class for points that are identified as
overlapping points. This is only active if
Overlap is set to Classify.

Hole size Maximum size of an area without points that
may be created by the cut overlap action. This
refers to, for example, shadow areas that are
not seen by the scanner in the closest flight
path. If the area is larger, points from a more
distant flight path are kept to fill an area.

Thin points to average density If on, points on high density areas are deleted
to balance point density throughout the data
collection area applying Thin points Method:
Average density.

Smoothen and remove noise

Smoothen and remove noise step smoothens surfaces and classifies outliers above and below
surfaces as noise. Thus, it eliminates noise from the point cloud data and makes surfaces more
pretty. The process uses RGB color information assigned to laser points to recognize vegetation.
It may apply smoothing only to non-vegetated areas identified by the Visual-band difference
vegetation index computation. If no RGB color values are usable, the points that are classified
as noise close to vegetation may be later added to vegetation classes by copying the class
attribute from the actively classified points.

The step combines the TerraScan actions Smoothen points and Thin points.
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SETTING EFFECT

Smoothen surfaces If on, a smoothing process is applied to points
on surfaces.

Remove noise around surface If on, outliers are removed from surfaces in
order to reduce noise in the point cloud.

Apply to Determines the points that are effected by
the process:

· All points - all points on surfaces.

· Non-vegetation only - only surface points in
non-vegetated areas. This requires that RGB
values are assigned to the points.

Vegetation limit Threshold value for separating points in non-
vegetated areas from points in vegetated
areas by using the Vegetation index / Visual
band difference method. The default value is
0.05, values may range from -1 to +1. This is
only active if Apply to is set to Non-vegetation
only.

Temporary 1 First point class that is used for points
temporarily during the process.

Temporary 2 Second point class that is used for points
temporarily during the process.

Noise Target class for points identified as outliers.
This is only active if Remove noise around
surface is switched on.
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Thin points to inactive

Thin points to inactive step reduces the point density by classifying many points as inactive.
This is mainly done to increase the speed of further processing steps for large point clouds.
Later classification steps will only consider the active points. The result of the classification in a
thinned point cloud is not exactly as good as if all points are used. Therefore, this step is an
option to get a classification result for large point clouds in a shorter processing time. As a last
step, the above-ground object classification may be applied to inactive points by copying the
class attribute from the closest active point.

The step includes the TerraScan action Thin points.

SETTING EFFECT

Inactive class Target class for points that are thinned out. 

Spacing Distance between points that are kept as
active points.

Classify ground

Classify ground step removes some additional outliers (such as low error points in the point
cloud) and classifies the ground. The lowest (active) points are classified as ground. The process
aims for a smooth ground surface represented by not too many points. Some typical flaws of
the automatic ground classification are low points that become ground points and disturb the
further ground classification in this area, and bridges that are often classified as ground but do
not belong to the natural ground surface.

The step includes the TerraScan classification routine Ground.
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SETTING EFFECT

Spacing Distance between initial ground points.
Basically, the setting determines the size of
an area within which the lowest point is
classified as ground point. From these initial
points, a temporary TIN is created. Then, the
ground classification process iteratively
densifies the TIN by adding more and more
points to the ground class.

Check ground

Check ground step is more or less a stop criteria for the processing wizard. It is a manual step
where an operator checks the result of the automatic ground classification This can be
supported, for example, by visualizing the ground as shaded surface, either by using the
Shaded surface display mode of TerraScan (UAV) or the  Display Shaded Surface tool of
TerraModeler (UAV). The display tool of TerraModeler is more capable and should be
preferred, if TerraModeler is available. The shaded surface display shows flaws in the ground
classification quite clearly as pits (low ground points) or peaks (high ground points). Also
bridges or areas of missing ground points are well visible.

Manual classification tools of TerraScan (UAV) can be used to improve the ground classification.
Any change in the ground class updates the surface display automatically. The extend of the
manual work is project-dependent and should include at least the removal of gross errors.

If the terrain structure is simple, the ground check may be done after all steps of the data
processing wizard have been finished. If the terrain structure is complex, it is strongly
recommended to do the ground check before above-ground objects are classified. Any gross
errors in the ground classification effect further classification steps in a negative way.

If the Check ground step is switched on in the wizard, all following steps are deactivated.

Classify height from ground

Classify height from ground step classifies points above the ground into three "vegetation"
classes:

· Class 3 Low vegetation - points < 0.3 m above ground

· Class 4 Medium vegetation - points 0.3 - 2.0 m above ground

· Class 5 High vegetation - points > 2.0 m above ground

The height limits can be changed in the settings for the step. The step has an active use only if
above-ground objects are further classified. Points in classes 4 and 5 are considered for the
object classification.

The step combines the TerraScan actions Compute distance and Classify by distance.

https://terrasolid.com/guides/tmodel/displayshadedsurface.html
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SETTING EFFECT

Low vegetation Limit for points in class 3 Low vegetation.
Points with a smaller height above ground
are classified as low vegetation.

High vegetation Limit for points in class 5 High vegetation.
Points with a larger height above ground are
classified as high vegetation.

Classify above ground features

Classify above ground features step classifies points in classes 4 and 5 into up to 8 object
classes. The processing step includes point cloud segmentation (grouping in TerraScan) and a
group classification based on best match principle. The user may decide which object types are
of interest for a project. It is recommended to switch on a few object types for the classification
as the routine is based on probability comparison.

The step relies on the Classify height from ground step and is only available, if this step is active
or has been performed. The classification may benefit from vegetation index computation if
color values are available for the laser points.

The step combines the TerraScan actions Assign groups and Classify groups by best match.
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SETTING EFFECT

Roof If on, groups of points that represent
horizontal or sloped planar surfaces without
ground points underneath are classified to
the given class. Typical objects are building
roof planes.

Roof structure If on, groups of points that represent small
structures on roofs are classified to the given
class. Typical objects are chimneys, antennas,
air condition constructions, etc.. 

Wall If on, groups of points that represent close to
vertical planar surfaces are classified to the
given class. Typical objects are building walls
or any other type of wall.

Wall structure If on, groups of points that represent small
structures on walls are classified to the given
class. Typical objects are balconies or other
constructions on (building) walls. 

Tree If on, complex groups of points with a bigger
height above ground and a wider horizontal
extend are classified to the given class.
Typical objects include trees.
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SETTING EFFECT

Vegetation If on, groups of points that do not fit to any
other object type are classified to the given
class. This often includes lower vegetation or
other structures.

Pole If on, groups of points that represent narrow
high structures are classified to the given
class. Typical objects are street lamps and
poles of overhead traffic lights, street signs
or wires (not power line towers).

Car If on, small compact groups of points with a
lower height above ground are classified to
the given class. Typical objects include cars.

Use vegetation index If on, the process uses the vegetation index
computed from color values of points for
separating vegetation from non-vegetation
objects.

Limit Threshold value for separating vegetation
from non-vegetation. The default value is
0.05, the values may range from -1 to +1. A
good value for a point cloud can be found by
using the display mode option and testing
different limit values in the Point display
category of TerraScan Settings.

Temporary Point class that is temporarily used for
vegetation/non-vegetation points during the
process.

Copy result to inactive points

Copy result to inactive points step copies the class attribute from the closest active point to
points previously thinned out as inactive. This is only required if the Thin points to inactive step
has been performed in order to speed up the classification processes. It should be applied to
points of above-ground objects.

The step includes the TerraScan classification routine Closeby points.
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SETTING EFFECT

Inactive class Class the contains the previously thinned
out points and is now effected by the
process.

Thin spacing Distance used for thinning out points.

From class Source class(es) to copy the class attribute
from.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Classify to Secondary classification method if no From
class point nearby:

· Leave as inactive - keep points in the
Inactive class.

· Low vegetation - classify points to class 3,
often referred as low vegetation class.

· Low/medium/high vegetation - classify
points to classes 3, 4, and 5 according to
the distance values.

Low Limit for points in class 3 Low vegetation.
Points with a smaller height above ground
are classified as low vegetation.  This is only
active if Classify to is set to
Low/medium/high vegetation.

High Limit for points in class 5 High vegetation.
Points with a larger height above ground are
classified as high vegetation. This is only
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SETTING EFFECT

active if Classify to is set to
Low/medium/high vegetation.

Copy result to noise points

Copy result to noise points step copies the class attribute from the closest active point to points
previously classified as noise. This is only required if noise was classified in the Smoothen and
remove noise step. It should be applied to points of above-ground vegetation objects, such as
trees or other vegetation. Noise points close to surfaces should remain in the noise class.

The step includes the TerraScan classification routine Closeby points.

SETTING EFFECT

Noise class Class the contains the previously classified
noise points and is now effected by the
process.

From class Source class(es) to copy the class attribute
from.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Create Drone Macro
Not Lite

Create Drone Macro command creates a macro respective to selected process steps. Available
process steps are identical to steps provided in Process Drone Data tool.

To create a new macro from Process drone data steps:

1. Select Create Drone Macro command from the Wizard menu.
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This opens the Create Drone Macro dialog:

2. Define settings and click OK.

This opens the Macro dialog:

3. Edit, save, or use the result like a conventional macro described in Macros.
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Working with Projects
Not UAV

A project definition in TerraScan helps to organize the work with a huge point cloud and to
automate processing tasks. Basically, it is a method of dividing the whole point cloud data set
into smaller, better manageable parts. These smaller geographical regions or blocks should be
sized so that the laser data referenced by one block fits into the computer’s RAM. There must
be some space left in RAM for processing routines. See Memory usage of loaded points for
more information.

TerraScan UAV does not include any project functionality.

A project definition is saved in a TerraScan project file with the extension *.PRJ. It is an ASCII
file including:

· header - project settings.

· block names - laser file name and extension as link between the project and the referenced
binary files storing the points.

· block boundaries - coordinates of the vertices of each block boundary.

Typical steps for creating a project are:

1. Use Load Airborne Points tool or Read points command to load a subset of points (every 10th,
50th, 100th,...) from all input files that belong to a project. This shows the geographical
coverage and location of laser points without providing the full point density.

2. Create block boundaries. There are several tools and methods that support the creation of
block boundaries:

· Measure Point Density tool - estimate the amount of points inside a certain area by
using a rectangle as sample area.

· Any CAD tool for placing closed elements - place boundary shapes for the blocks. Each
block should enclose an area with a manageable number of points. You should use
snapping tools to avoid gaps and overlap between neighbouring block boundaries.

· Design Block Boundaries tool - create shapes from a closed line work and get an
approximate number how many points are inside each shape.

· Create along centerline command - create blocks along a linear element.

· Create along tower string command - create blocks along a tower string element for a
powerline corridor.

· Create along trajectories command - create blocks along trajectories loaded in
TerraScan.

· Create grid block boundaries automatically during the import of point files. See Import
points into project command.

The result of block boundary creation is always a set of shape elements which include the
project area for processing. Each shape should enclose a part of the project area with a number
of points that easily fit into the computer’s memory.

3. Close the points loaded in step 1 using Close points command.

4. Select Define Project tool. This opens the TerraScan Project window.

5. Define a new project using New project command.
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6. Select all block boundary shapes created in step 3.

7. Add blocks to the project using Add by boundaries command.

8. Save the project definition using Save project as command.

9. Import points from all input files into the project using Import points into project or Import
directory commands.

Once the points are imported into the project, you can process the data of the referenced files
in batch mode. You can run macros on the project which may include several processing steps.
Macros can run in TerraScan but most of the macro actions can also be performed in TerraSlave.
See Chapter Macros for detailed information.

Before you process project data in batch mode, you would test the settings of macro actions
based on loaded points in order to find the optimal parameter values for the project area. It is
also recommended to test a macro on several blocks before you run it on the whole project.

Besides running macros on a project, there are several processing tasks that can be performed
on project level. The corresponding commands are included in the pulldown menus of the
TerraScan Project window and described in the following sections.

TerraScan Project window

The Project window contains all menu commands for creating and modifying project
definitions, managing block definitions, and for running processing steps on project level.

Select the Define Project tool to open the Project window:

In the file list of the project window, all blocks are listed that belong to the project with the
amount of points in the referenced laser binary file. If File locking is active for a project, or if a
block binary file is set to be read only, the list also includes information about file locking.

To select a block, click on the name in the list. Press < Ctrl> to select several blocks.
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To show the location of a block, select a line in the Project window. Click on the Show location
button and move the mouse pointer into a view. This highlights the boundary of the selected
block.

To identify a block, click on the Identify button and place a data click inside a block boundary in
a view. This selects the corresponding line in the Project window. Several blocks can be
identified if <Ctrl> is pressed while selecting block locations in the view.

You can use the Select all and Deselect all buttons in order to select and deselect all blocks. The
Invert button selects all blocks that are previously not selected and deselects previously
selected blocks.
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Block pulldown menu

Commands from the Block pulldown menu are used to create and edit block boundaries.

TO USE COMMAND

Add block definitions to a project Add by boundaries Not UAV

Add block definitions deduced from block
binary files

Add using files Not UAV

Edit a block definition Edit definition Not UAV

Delete a block definition Delete definition Not UAV

Merge selected blocks into one block Merge blocks Not UAV

Lock selected block files Lock selected Not UAV

Release the lock of a block file Release lock Not UAV

Draw block boundaries into the CAD file Draw boundaries Not UAV

Create block boundaries along a centerline Create along centerline Not UAV

Create block boundaries along a tower string Create along tower string Not UAV

Create block boundaries based on trajectory
information only

Create along trajectories Not UAV

Clip block boundaries by a bounding polygon Clip boundaries Not UAV

Transform block boundaries Transform boundaries Not UAV

Add by boundaries
Not UAV

Add by boundaries command adds block boundaries to a project definition. This is usually the
second step of the project creation after defining settings of the project itself.

Block boundaries can be created using CAD drawing tools for closed elements, or using one of
the tools provided by TerraScan, such as Design Block Boundaries,  Create along centerline, or
Create along tower string.

The command lets you define names for the blocks. The same names are used for the block
binary files which are created by importing points into the project. The names can contain a
prefix and a unique, automatically derived number for each block. CAD text elements drawn
inside the boundaries of each block can be used as names as well. Alternatively, a naming
method can be defined in the Block naming formulas category of TerraScan Settings.
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To add block boundaries to the project definition:

1. Select shape elements and (optional) text elements inside the shapes using the Selection
tool.

2. Select Add by boundaries command from the Block pulldown menu.

This opens the Add Blocks by Boundaries dialog:

3. Define settings and click OK.

This adds the blocks to the project definition. Use Save project or Save project as commands
in order to save the block boundaries in a project file.

SETTING EFFECT

File prefix Prefix for the names of project blocks and
related block binary files.

Numbering Method of assigning names or name parts to
blocks:

· Selection order - automatic numbering
increases in the same order as boundary
shapes have been selected.

· North to south - automatic numbering
increases geographically from north to
south and secondarily west to east.

· South to north - automatic numbering
increases geographically from south to
north and secondarily west to east.

· West to East - automatic numbering
increases geographically from west to east
and secondarily south to north.

· East to West - automatic numbering
increases geographically from east to west
and secondarily south to north.

· Trajectory order - automatic numbering
increases according to the order of data
capturing. The time of data capturing is
derived from the active trajectories in
TerraScan.
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SETTING EFFECT

· Selected numbers - the name is defined by
a unique numerical text element that is
placed inside each block boundary.

· Selected strings - the name is defined by a
text element that is placed inside each
block boundary.

The list may further include Block naming
formulas that are defined in TerraScan
Settings.

First number Number of the first block to add. This is only
considered if a method of automatic block
numbering is selected in the Numbering list.

Add using files
Not UAV

Add using files command creates a list of block definitions from a collection of FastBinary, LAS
or GeoTIFF files. It can be used to create a TerraScan project for files that have been delivered
as tiled point cloud but without project definition.

The process deduces the bounding box for each file from the file header and uses that as block
boundary. Optionally, the block boundary can be adjusted to even coordinate values. The block
boundary may be a bit inaccurate if the position of the point cloud has been modified, for
example by TerraMatch processing. However, this is not critical for further processing steps.

To create block definitions from files:

1. Create a project definition. Use the format of the block binary files you want to use for block
creation.

2. Save the project file in the same folder where the block binary files are stored.

3. Select Add using files command from the Block pulldown menu.

This opens the Add files to project dialog, a standard dialog for opening files.

4. Select all files you want to use for creating block definitions and click Open.

This opens the Adjust Block Borders dialog:
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The dialog shows the average size of blocks that will be created.

5. (Optionally) Switch on the Adjust border to even coordinate values option and define a Step
size for block corners. The Step value determines to which closest even coordinate values
the block boundary is adjusted.

6. Click OK.

This adds the blocks to the project definition. Use Save project command in order to save the
block definitions in a project file.

Clip boundaries
Not UAV

Clip boundaries  command modifies block boundaries based on a clipping boundary. The
clipping boundary can be defined by any shape element drawn in the CAD file. The tool clips off
parts of project blocks that are either inside or outside the clipping shape.

The tool does not effect the content or extend of block binary files, if points have been already
imported into a project. In addition, the modification effects the project definition loaded in
memory. Thus, the project must be saved before the changes are written permanently to the
project file. On the other hand, if the result of the clipping action is not satisfactory, the original
and unchanged project file can be reloaded.

To clip  block boundaries:

1. Select the clipping shape to which block boundaries are clipped.

2. Select Clip boundaries command from the Block pulldown menu.

If blocks contain already points, a message is displayed and informs about the clip action.
Close the message with OK.

This opens the Clip Boundaries dialog:
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4. Define settings and click OK.

This modifies the block boundaries. An information dialog shows how many blocks have
been effect and how many new blocks have been created.

5. Use Save project or Save project as commands in order to save the modification in a project
file.

SETTING EFFECT

Keep Defines which parts are kept and which ones
are clipped off:

· Inside parts - block areas inside the clipping
boundary are kept.

· Outside parts - block areas outside the
clipping boundary are kept.

File prefix Prefix for the names of newly created blocks.

Numbering Method of assigning names or name parts to
new blocks:

· Creation order - automatic numbering
increases in the same order as block
boundaries have been created.

· North to south - automatic numbering
increases geographically from north to
south and secondarily west to east.

· South to north - automatic numbering
increases geographically from south to
north and secondarily west to east.

· West to East - automatic numbering
increases geographically from west to east
and secondarily south to north.

· East to West - automatic numbering
increases geographically from east to west
and secondarily south to north.
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SETTING EFFECT

The list may further include Block naming
formulas that are defined in TerraScan
Settings.

First number Number of the first new block to add. This is
only considered if a method of automatic
block numbering is selected in the Numbering
list.

Create along centerline
Not UAV

Create along centerline command creates block boundaries along a centerline element. The
block length is measured along the centerline element and each block has exactly the same
width and length as defined. Only the last block along the centerline element may be shorter.

Optionally, the command creates text elements that are placed inside each block boundary.
The resulting block boundaries and text elements can then be used to define blocks for a
project with Add by boundaries command.

To create blocks along a centerline element:

1. Create a centerline element using CAD or TerraScan tools.

2. Select the centerline element.

3. Select Create along centerline command from the Block pulldown menu.

This opens the Create Blocks Along Centerline dialog:

4. Define settings and click OK.
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This draws the block boundaries as shapes and, if defined, the text elements into the CAD
file. The elements are drawn on the active level using the active symbology settings of the
CAD platform.

SETTING EFFECT

Centerline The length of the selected centerline
element is displayed.

Block length Length of the blocks measured along the
centerline element.

Block width Width of the blocks.

Numbering Defines labeling of the blocks: None or Draw
texts.

Prefix Prefix for the text element drawn as label for
each block. This is followed by an
automatically increasing number.

First number Number of the first block.

Digits Defines the amount of digits for block
numbering.

Create along tower string
Not UAV

Create along tower string command creates block boundaries along a tower string element. Any
linear element can serve as a tower string for this command. The block length is measured
along the tower string but a block boundary is drawn at the location of the vertex that is closest
within the given block length. The last block ends at the last vertex of the tower string element.
The width of the blocks is constant.

Optionally, the command creates text elements that are placed inside each block boundary.
The resulting block boundaries and text elements can then be used to define blocks for a
project with Add by boundaries command.

The command is most useful for creating blocks for a powerline project. See Chapter
Powerlines for more information.

To create blocks along a tower string:

1. Draw a tower string using TerraScan Place Tower String tool or CAD drawing tools.

2. Select the tower string element.

3. Select Create along tower string command from the Block pulldown menu.

This opens the Create Blocks Along Tower String dialog:
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4. Define settings and click OK.

This draws the block boundaries as shapes and, if defined, the text elements into the CAD
file. The elements are drawn on the active level using the active symbology settings of the
CAD platform.

SETTING EFFECT

Centerline The length of the selected tower string is
displayed.

Block max length Maximum length of a block.

Block width Width of the blocks.

Numbering Defines labeling of the blocks: None or Draw
texts.

Prefix Prefix for text string drawn as label for each
block. This is followed by an automatically
increasing number.

First number Number of the first block.

Digits Defines the amount of digits for block
numbering.

Create along trajectories
Not UAV

Create along trajectories command creates block boundaries along trajectories. The trajectories
must be active in TerraScan. The block length is measured along the trajectories and
automatically adjusted according to the number of trajectories at one location. The block width
is calculated from each trajectory line. If trajectories are closer to each other than half of the
given block width, the width is computed from the outermost trajectories.
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The method does not rely on laser data or data imported into a TerraScan project. It is best
suited for MLS projects.

The resulting block boundaries can then be used to define blocks for a project with Add by
boundaries command.

If the laser scanner has been switched off for some parts of the survey, the method may
produce unnecessary blocks. This can be avoided by cutting off parts from the trajectories for
which no laser data is available.

To create blocks along trajectories:

1. Load trajectories into TerraScan.

2.  Select Create along trajectories command from the Block pulldown menu.

This opens the Create Blocks Along Trajectories dialog:

4. Define settings and click OK.

This draws the block boundaries as shapes into the CAD file. The elements are drawn on the
active level using the active symbology settings of the CAD platform.

SETTING EFFECT

Trajectories The length of the trajectories is displayed.

Block length Maximum length of the blocks measured
along the trajectories. If a place is captured
multiple times, the block length becomes
shorter automatically.

Block width Width of the blocks.

Delete definition
Not UAV

Delete definition command deletes one or more block definitions from a project definition.
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To delete a block definition:

1. Select one or more blocks in the Project window.

2. Select Delete definition command from the Block pulldown menu.

This deletes the selected blocks. If more than one block is selected, a message appears that
asks you to confirm the removal.

3. Use Save project or Save project as commands in order to save the modification in a project
file.

Draw boundaries
Not UAV

Draw boundaries command draws the boundaries and (optional) names of block definitions
into the CAD file. This can be used, for example, to draw boundaries if points have been
imported into the project without defining block boundaries beforehand or after blocks have
been transformed.

The command can also be used to draw the outer boundary of a project area into the CAD file.

To draw block boundaries into the CAD file:

1. (Optional) Select block definitions in the Project window to be drawn into the CAD file.

2. Select Draw boundaries command from the Block pulldown menu.

This opens the Draw Block Boundaries dialog:

3. Select settings and click OK.

The boundaries and, if selected, block labels are drawn as shape and text elements into the
CAD file. The elements are drawn on the active level using the active symbology settings of
the CAD platform.

SETTING EFFECT

Draw Boundaries to be drawn: All blocks, Selected
blocks, or Project outer boundaries.

Label Defines the way of labeling the blocks:
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SETTING EFFECT

· None - no text elements are created.

· Block number - the complete block number
is drawn.

· Full file name - the complete file name
without extension is drawn.

· Unique end of name - only the last unique
number or text string of the block names is
drawn. This works only if more than one
block is drawn into the CAD file.

This is only active is Draw is set to All blocks or
Selected.

Edit definition
Not UAV

Edit definition command lets you edit a block name and lock a block binary file to be read only.
If several blocks are selected in the Project window, the command lets you edit the source
folder, prefix, and file name extension of the selected blocks.

To edit a  single block definition:

1. Select a block definition in the Project window.

2. Select Edit definition command from the Block pulldown menu.

This opens the Block Information dialog:

3. Define settings and click OK.

This applies the modification to the block definition.

4. Use Save project or Save project as commands in order to save modification in a project file.

SETTING EFFECT

File Block name and file extension.
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SETTING EFFECT

First group Lowest possible group number in the block.
Effects the Assign groups command or
corresponding macro step.

Group count Amount of group numbers for the block.
Effects the Assign groups command or
corresponding macro step.

Read only If on, the block file can be opened only for
reading and permanent modifications are not
allowed.

To edit several b lock definitions:

1. Select several block definitions in the Project window.

2. Select Edit definition command from the Block pulldown menu.

This opens the Edit Several Blocks dialog:

3. Switch on the attributes that you want to modify.

4. Define new attribute values and click OK.

This applies the modification to the block definitions.

5. Use Save project or Save project as commands in order to save modification in a project file.

SETTING EFFECT

Folder Path to the source folder of the block binary
files. Use the Browse button in order to open
a standard dialog for selecting a folder.

Prefix Text string that replaces the current prefix in
the beginning the block names. All non-
numeric characters in the beginning of a
block name are considered the prefix.



TerraScan User Guide  © 2023 Terrasolid Ltd

617Working with Projects > Block pulldown menu > Edit definition

SETTING EFFECT

Extension File extension that replaces the current
extension in the end of the block names.

Group The First field defines the lowest group
number for the project. The Count field
defines the amount of group numbers for
each block. Effects the Assign groups
command or corresponding macro step.

If the block file name in the project definition is changed after points have been imported
into the project, the link between the project definition and the block binary file is lost
unless the block binary file is renamed accordingly.

Lock selected
Not UAV

Lock selected command locks the selected block binary files and thus, disables processing of
the files on any other computer than the locking computer. See File locking for more
information about the file locking concept of TerraScan.

The command is only available if Require file locking is active in the Project Information dialog.
See New project for a description of the dialog settings.

To lock selected block binary  files:

1. Select one or more block names in the Project window.

2. Select Lock selected command from the Block pulldown menu.

This locks the selected block. The name of the locking computer and the time when the lock
was established are displayed in the Project window.

Merge blocks
Not UAV

Merge blocks command merges selected project blocks. It combines the block definitions and
the binary files into one definition/file. The name of the block with the lowest number is used
for the merged block.

The command is only available if at least two block definitions are selected in the Projects
window. The process works only if there are block binary files available.

To merge blocks interactively :

1. Select two or more block definitions in the Project window.
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2. Select Merge blocks command from the Block pulldown menu.

An Alert dialog asks for confirmation of the selection.

3. Click OK.

This creates a new block definition and binary file. The original binary files are not kept. An
information dialog shows the number of merged blocks after the process is finished.

4. Use Save project or Save project as commands in order to save the modification in a project
file.

Blocks can be merged automatically by using the Merge small blocks from the Tools pulldown
menu. However, the result of the automatic process may not be optimal and can be refined
by the manual command.

Release lock
Not UAV

Release lock command releases the lock for block binary files. The lock can be released only on
the same workstation that locked the file or if the file is already locked for more than 24 hours.
See File locking for more information about the file locking concept of TerraScan.

The command is only available if Require file locking is active in the Project Information dialog.
See New project for a description of the dialog settings.

To release a lock for a block binary  file:

1. Select one or more locked blocks in the Project window.

2. Select Release lock command from the Block pulldown menu.

This releases the locking of the selected block. A message appears that informs about the
success of the release.
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File pulldown menu

Commands from the File pulldown menu are used to create a project, edit project information
and to import points into a project.

TO USE COMMAND

Create a new project definition New project Not UAV

Open an existing project definition Open project Not UAV

Save changes to an existing project definition Save project Not UAV

Save a new project definition Save project as Not UAV

Edit project information and settings Edit project information Not UAV

Import laser files into the project Import points into project Not UAV

Import all laser files from a directory Import directory Not UAV

Edit project information
Not UAV

Edit project information command lets you edit the settings of a loaded project definition.

To edit a  project:

1. Select Edit project information command from the File pulldown menu.

This opens the Project Information dialog which is described for the New project command.

2. Edit the settings for the project definition and click OK.

3. Use Save project or Save project as commands in order to save the modifications of the
project definition in a project file.

The Default block values in the Project information dialog do not effect existing blocks. Any
changes of these values effect only new blocks that are added to the project. You can use the
Edit definition command to change settings for existing blocks.

Import collection
Not UAV

Import collection command imports point files into the project. All files of the same format
from one or more source folders can be imported. The import process itself works in the same
way as described for the Import points into project command.
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To import files from several fo lders into a project:

1. Select Import collection command from the File pulldown menu.

This opens the Import Collection dialog:

2. Click the Add files button in order to select files for import in a standard dialog. Continue
with steps 3 or 5.

OR

3. Click Add folder button in order to select a directory from which to import all files. This opens
the Read Directory dialog:

4. Define settings and click OK.

This adds all files of the given format to the list in the Import Collection dialog. You may
remove files from the list by selecting the corresponding line(s) and clicking the Remove
button.

5. If the collection of files for import is ready, click OK in the Import Collection dialog.

This opens the Import Points into Project dialog. Follow the steps of Import points into
project procedure in order to import the files.

SETTING EFFECT

Directory Folder from which to import files. Click on
the Browse button in order to select a folder
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SETTING EFFECT

in the Browse for Folder dialog, a standard
dialog for selecting folders.

Import all subfolders If on, files from subfolders are imported as
well.

Files Defines the files that are imported. You can
use the * character as placeholder for any
number of characters in a file name or
extension. For example, *.las imports all LAS
files from a folder, *.* imports all files from a
folder.

Import points into project
Not UAV

Import points into
project command
imports point files into a
project. The process
reads the points from
the input files and
stores them into new
files according to the
block definitions. As a
result, there is a new
point file for each block
of the project.

The file names and the
format are derived from
the block names which
contain the name itself
and the extension
depending to the
selected storage format.
Thus, a file that is
created in the import
process is linked to a
project by its name and
extension.

To import points into a
project:

1. Select Import points
into project
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command from the
File pulldown menu.

This opens the Import points into project dialog, a standard dialog for open files.

2. Select input files and click Open.

This opens the Import Points into Project dialog.

3. Define settings and click OK.

This starts the import of the input files. A progress bar shows the progress of the process.

After all files are imported, TerraScan shows a report. The report lists the imported files, the
amounts of imported and ignored points for each file, and the overall amounts of imported
and ignored points. It can be saved as a text file or sent to a printer by using commands from
the File pulldown menu of the report window. If the import is done by TerraSlave, the report
file is stored in the TerraSlave reports folder, such as C:\TERRA64\TSLAVE\REPORTS.

SETTING EFFECT

Format Format of the input files. This is
automatically recognized by the software.
For ASCII files, there might be more than
one option.

Input projection Projection system of the input point cloud
data. The software shows the system
information if it is stored in the input file
header. To change the projection system,
click on the Browse button. This opens the
Browse for Projection System dialog. The
dialog provides a search option for
projection systems as well as a list of all
implemented systems. In addition, any
user-defined projection systems are
included in the list.
If another projection system is defined in
the project definition, a projection change
transformation will be applied during the
import process.

Transform Additional transformation applied to the
points during the import process. The list
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SETTING EFFECT

contains transformation that are defined in
Coordinate transformations /
Transformations category of TerraScan
Settings.

Coordinates Display of the Easting and Northing
coordinates of the first point in the data set
before and after importing the points. If the
values are the same, no transformation is
applied during the import. 

Input times GPS time format of the time stamps in the
input files.

Survey date Date when the data was captured. The
format is day/month/year (dd/mm/yyyy).
This is only active if Input time is set to GPS
seconds-of-week and the time stamp
format for the project is set to GPS standard
time or GPS time.

Outside blocks Defines how points outside the block
boundaries are handled:

· Ignore outside blocks - points outside
boundaries are ignored.

· Ignore outside selected - points outside
selected block boundaries are ignored.
This is only active if blocks are selected in
the list of blocks in the Project window.

· Create grid blocks - the software creates
new blocks for the points outside
boundaries. The size and names of the
new blocks are defined by the setting in
the Project information dialog.

Outside blocks Defines how points outside the block
boundaries are handled:

· Ignore outside blocks - points outside
boundaries are ignored.

· Ignore outside selected - points outside
selected block boundaries are ignored.
This is only active if blocks are selected in
the list of blocks in the Project window.

· Create grid blocks - the software creates
new blocks for the points outside
boundaries. The size and names of the
new blocks are defined by the setting in
the Project information dialog.
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SETTING EFFECT

Only every If on, only every n th point of the input files
is imported where n is the given value.

Only class If on, only points from the selected point
classes are imported. Click on the >> button
in order to open the Select Classes dialog. It
provides a list from which you can select
several classes.

Thin by order If on, points are thinned out during the
import process if consecutive points are
within the given Dxy and Dz limits. This may
ignore points in the import process and
result in a lower point density than
provided by the original point cloud.

Inside fence only If on, only points that are located inside a
MicroStation fence or selected shape
element are imported.

Delete empty blocks If on, blocks without points located inside
the block area are deleted from the project
definition.

Merge small blocks If on, blocks with a small amount of points
inside the block area are merged with
neighboring blocks. The Min and Max
values define the minimum and maximum
amount of points per block. Blocks are only
merged if the amount of points is smaller
than the given minimum and if the merged
block does not exceed the given maximum.

Autosave project after import If on, the project file is saved automatically
to the hard disc when the import process is
finished.

Default Point class that is assigned to all imported
points if no class attribute is stored in the
input files. This is only active if Format is set
to any text file format that does not include
the class attribute.

Line numbers Defines, how line numbers are assigned to
the points during the import process:

· Use from file - line numbers from source
files are used.

· Assign constant - the number given in the
First number field is assigned to all
points.
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SETTING EFFECT

· First number in name - the first numerical
sequence in a file name is used as line
number.

· Last number in name - the last numerical
sequence in a file name is used as line
number.

· First number in folder - the first numerical
sequence in the name of the folder
containing the input files is used as line
number.

· Last number in folder - the last numerical
sequence in the name of the folder
containing the input files is used as line
number.

· Deduce using time - numbers are
assigned based on trajectories loaded
into TerraScan. The same process can be
performed for by the Deduce using time
command or the corresponding macro
action.

· Increase by xy jump - the line numbers
increase from the given First number if
the xy distance is bigger than the value
given in the By distance field.

· Increase by time jump - the line numbers
increase from the given First number if a
jump in time stamps occurs. This requires
that trajectory information is available in
TerraScan.

· Increase by file - the line numbers
increase from the given First number for
each separate file.

· Increase by file name - the line numbers
increase from the given First number for
each file with another file name. Files
with the same name get the same
number.

· Increase by directory - the line numbers
increase from the given First number for
each file stored in another source folder.
Files from the same source folder get the
same number.

The availability of options depends on the
number of input files and the attributes
stored for points in the input files.

Scanner number Defines, how scanner numbers are assigned
to the points during the loading process:
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SETTING EFFECT

· File -- scanner byte - scanner number
stored in the 8-bit user data field is used.
This is the normal way of storing a scanner
number.

· File -- scanner channel - scanner number
stored in 2-bit scanner channel field of
LAS/LAZ 1.4 files is used. This may be
relevant for LAS/LAZ 1.4 files only.

· Assign constant - the number given in the
First number field is assigned to all
points.

· Increase by file - the scanner numbers
increase from the given First number for
each separate input file.

· First number in name - the first numerical
sequence in a file name is used as scanner
number.

· Last number in name - the last numerical
sequence in a file name is used as scanner
number.

· First number in folder - the first numerical
sequence in the name of the folder
containing the input files is used as
scanner number.

· Last number in folder - the last numerical
sequence in the name of the folder
containing the input files is used as
scanner number.

· From line number - the line number is
used as scanner number.

The availability of options depends on the
number of input files and the attributes
stored for points in the input files.

TerraSlave If on, the import process starts in
TerraSlave. TerraScan can be used for other
tasks while the import runs in TerraSlave.

Opens the TerraSlave Task Settings dialog.
You can select or deselect computers that
will participate in the import task. See
TerraSlave User Guide for more
information.

If you import new points into a block that already contains points, the additional points are
added to the existing block binary file. Therefore, if the import of raw data needs to be
repeated, you must delete the existing block binary files before starting the next import
process.

https://terrasolid.com/guides/tslave/index.html
https://terrasolid.com/guides/tslave/terradispatcher.html
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New project
Not UAV

New project command creates a new project definition. The complete project definition
includes some descriptive information and a list of block boundaries. For the definition of block
boundaries see Add by boundaries.

To create a project definition:

1. Select New project command from the File pulldown menu.

This opens the Project Information dialog:

2. Define settings and click OK.
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SETTING EFFECT

Scanner Scanner type: Airborne, Mobile, Ground
based, or Mixed.

Description Descriptive text for the project.

First point id Start ID number for the laser data file.

Storage Block binary file format: FastBinary, Scan
binary 8 bit, Scan binary 16 bit, LAS 1.x, LAZ 1.x,
GeoTIFF. For more information see Choosing a
project storage format.

Attributes Opens the Attributes to store dialog. Only
active attributes are stored in project block
laser point files that belong to the project.

Require file locking If on, a project block file is marked as locked
when a user opens it for modification with the
Open block command. For more information
see File locking.

Projection Projection system of the point cloud data for
processing. To change the projection system,
click on the Browse button. This opens the
Browse for Projection System dialog. The
dialog provides a search option for projection
systems as well as a list of all implemented
systems. In addition, any user-defined
projection systems are included in the list.
If another projection system is used for the
data to import into the project, a projection
change transformation will be applied during
the import process.

Data in Defines how the directory for the referenced
laser data files is determined:

· Project file directory - laser files are stored
in the same directory as the project file. This
is independent of the absolute path of the
data and is therefore good in a network
environment or when moving the data set
from one computer to another.

· Separate directory - laser files are stored at
the location given in the Directory field.

Load classes automatically If on, the defined Class file is automatically
loaded with the project.

Load line colors automatically If on, the defined Color file for line colors is
automatically loaded with the project.
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SETTING EFFECT

Load trajectories automatically If on, trajectories from the given Directory are
loaded automatically with the project.

Reference project exists If on, the given Project file is defined as
reference project to be used in corresponding
tools, such as Compare with reference
command.

Default Size of rectangular, automatically created
blocks. These blocks are created if points are
imported from areas which are outside the
pre-defined block boundaries.

Group count Amount of group numbers available for one
block in the project. Determines also the first
group number of the first block (= lowest
group number in a project).  Effects the Assign
groups command or corresponding macro
step.

Block prefix Prefix of block names that is used for
automatically created block boundaries.

Block naming Block name definition for automatically
created block boundaries. The list contains
Number as automatic numbering option and
any user defined Block naming formulas
defined in TerraScan Settings.

Choosing a project storage format

TerraScan supports multiple file formats from which you need to select one to be used for the
block binary files. The best choice depends on a few factors:

· FastBinary is the best format for processing data in TerraScan.

· If your project is static ground-based, you must choose FastBinary.

· If you need to transfer the laser files to other applications, the best choice is LAS 1.x which is
an open industry standard format and usually used for laser data exchange. The version of
the LAS format mainly depends on the attributes you want to store for each point.

· If your raw data is LAS 1.4 and you need to deliver in LAS 1.4, use LAS 1.4. Otherwise, it's
recommended to use FastBinary for processing and export into LAS 1.4 for data delivery.

· If you want to store the data in compressed files, use an LAZ 1.x format. This reduces storage
space requirements significantly and thus, is a good option for data delivery and archiving.

· Coordinate system information is read from and written into Fast Binary and LAS/LAZ files.

· Scan binary 8 bit and Scan binary 16 bit are outdated formats of TerraScan and no longer
recommended to use. They are still available in the software to ensure compatibility with
old data sets.
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Attributes to store

The dialog defines what attributes are stored for each laser point that belongs to the project.
Only active attributes are stored. It depends on the selected storage format which attributes
are available. Only the FastBinary format of TerraScan allows the storage of all available
attributes.

When a new project is created, you normally activate attributes that are stored in the raw laser
files and which you want to keep in the block binary files. You may also activate additional
attributes if you already know that you need them later. However, the selection of active
attributes can be modified later by using the Edit project information command.

In addition to the attributes, the dialog defines the format of Time stamps for the block binary
files. If the selected format differs from the time stamp format of the raw laser files, the time
stamps are converted into the format defined in the project definition. The conversion is done
during the import of the raw laser files into the project.

If Color values are stored for the block binary files, another selection is required for the amount
of color channels. TerraScan can extract up to 10 color channels for each point. The maximum
amount of color channels can only be stored in the TerraScan FastBinary format. LAS 1.4 format
and later can store up to 4 color channels, LAS 1.2 format and later up to 3. If more than 3
channels are extracted, color values are stored as 16-bit values.

In addition to the standard attributes defined for LAS formats, you can store Distance, Group
and Normal vector attributes in LAS 1.2+ and LAZ 1.2+ file formats.

You can store Riegl Extra Bytes, such as Pulse width and Amplitude attributes, in FastBinary, LAS
1.2+, or LAZ 1.2+ formats. The formats store the Riegl Pulse width as Echo length attribute and
the Riegl Amplitude as Amplitude attribute.

You can store  Riegl Extra Bytes, such as Reflectance, Amplitude and Pulse shape deviation
attributes, in FastBinary, LAS 1.4, or LAZ 1.4 formats. The formats store the Riegl Reflectance as
Reflectance attribute, the Riegl Amplitude as Amplitude attribute and the Riegl Pulse shape
deviation as Deviation attribute.

You can store Agisoft Confidence values in FastBinary, LAS or LAZ file formats. TerraScan stores
the value as Reliability attribute. 
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File locking

TerraScan supports a simple way of file locking for block binary files. The file locking should
prevent two people from modifying the same data at the same time in a work group
environment.

The file locking is active if Require file locking is switched on in the project definition. This is
only needed if you have multiple people working on the same data set in a network.

TerraScan implements file locking in a simple manner. It does not lock the laser file itself. It
creates a temporary file which shows that the laser file is undergoing modification. The
temporary file has the same name and storage location as the block binary file and has the
extension .LCK. This temporary file contains the name of the computer which has opened the
laser file for modification. The creation time of the temporary file shows when the laser file
was opened.

This relaxed locking method does not completely prevent modification of a laser file that has
been locked. Only most of the TerraScan tools refuse to modify the data. Other applications do
probably not recognize that the laser file is locked by TerraScan.

Example case

When file locking is active, the project storage directory might contain the following files:

BLOCK BINARY FILE TEMPORARY LOCK FILE

h:\otaniemi\ota000317.fbi h:\otaniemi\ota000317.lck

h:\otaniemi\ota000318.fbi  

h:\otaniemi\ota000319.fbi h:\otaniemi\ota000319.lck
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BLOCK BINARY FILE TEMPORARY LOCK FILE

h:\otaniemi\ota000320.fbi  

The above files would indicate that blocks 000317 and 000319 are modified and locked.

Operations supporting file locking

The following actions lock a block binary file:

· Open block command if Open for is set to Modification.

· Read points command when opening a single block binary file.

· Load Airborne Points tool when opening a single block binary file.

· Load Ground Points tool when opening a single block binary file.

· Executing Adjust to geoid from the Project window.

· Executing Run macro from the Project window with a Save points setting on.

The same actions also check whether a laser file is locked or not.

Releasing a lock

The Project window has a Release lock command in the Block pulldown menu for releasing a
locked block. The command releases a lock only if a file has been locked on the same
workstation or if the locking was done more than 24 hours ago.

As a last precaution, the lock can be released by deleting the .LCK file.

Open project
Not UAV

Open project command opens an existing project definition.

To open a project:

1. Select Open project command from the File pulldown menu.

This opens the Open project dialog, a standard dialog for selecting files.

2. Select a project file and click Open.

This loads the selected project into TerraScan.
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Save project
Not UAV

Save project command saves changes of the project definition to an existing project file. This
can be used after changing project settings or block definitions.

To save changes to a project:

1. Select Save project command from the File pulldown menu.

This saves the project.

Save project as
Not UAV

Save project as command saves a project definition by creating a new project file. The project
file is an ASCII file with the extension .PRJ. This can be used after creating a new project
definition.

To save a project into a new project file:

1. Select Save project as command from the File pulldown menu.

This opens the Save project dialog, a standard dialog for saving files.

2. Select a storage location and type a name for the project file

3. Click Save.

This saves the project file.
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Tools pulldown menu

Commands from the Tools pulldown menu in the Project window are used to perform different
actions on block binary files or based on block binary files on project level.

TO USE COMMAND

Run a macro on a project Run macro Not UAV

Adjust the elevation of block files to a geoid
model

Adjust to geoid Not UAV

Adjust XYZ coordinates of block files Adjust xyz Not UAV

Convert project block binary files into
another format

Convert storage format Not UAV

Check the z accuracy of block files Output control report Not UAV

View statistics about points in block files Show statistics Not UAV

Check the coverage of block files Check coverage Not UAV

Validate block boundaries Validate blocks Not UAV

Merge small blocks automatically into one
block

Merge small blocks Not UAV

Copy points into block files from a reference
project

Copy from reference Not UAV

Assign color values from images to laser
points in block files

Extract color from images Not UAV

Assign echo properties to laser points Extract echo properties Not UAV

Export block boundaries and links to binary
files into KML file

Export to Google Maps Not UAV

Export laser data from block files into lattice
files

Export lattice models Not UAV

Export laser data from block files into raster
images

Export raster images Not UAV

Export a 3D point cloud from ortho images Export 3D ortho Not UAV

Write out project data by line Write by Line Not UAV

Output collections from block files Output collections Not UAV

Draw shape elements for the point cloud or
single lines

Draw cloud boundaries Not UAV
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Adjust to geoid
Not UAV

Adjust to geoid command adjusts the elevation values of the block binary files to a local
elevation model. The geoid model can be defined by an implemented geoid model, a text file,
a TerraModeler surface, or a selected linear chain.

The theory of geoid adjustment and the use of the command in TerraScan are explained in
detail in section Geoid adjustment.

The command performs the same action on block binary files as the Adjust to geoid command
on loaded points.

To run elevation adjustment on project blocks:

1. (Optional) Select block definitions in the Project window to be adjusted.

2. Choose Adjust to geoid command from the Tools pulldown menu.

This opens the Adjust Blocks to Geoid dialog:

3. Define settings and click OK.

This starts the adjustment process. The process effects the block binary files directly on the
hard disc. It might be advisable to create a backup copy of the block binary files before
starting the process.

SETTING EFFECT

Process Blocks to adjust:

· All blocks - all blocks in the list.

· Selected blocks - selected blocks only.

Adjustment Direction of the elevation adjustment:

· Ellipsoidal to orthometric - adjustment from
ellipsoidal to orthometric height values.
This is the normal way of an geoid
adjustment.
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SETTING EFFECT

· Orthometric to ellipsoidal - adjustment
from orthometric to ellipsoidal height
values. This is the reverse way of an geoid
adjustment.

Dz model Source file that provides the geoid correction
model:

· Points from file - text file.

· Selected linear chain - linear element
selected in the CAD file.

· <name> - name of a geoid model loaded as
surface in TerraModeler.

· <implemented model> - name of an
implemented geoid model.

File name Name of the geoid text file. This is only active
if Dz model is set to Points from file.

Extend Distance from a selected linear element by
which the linear chain is extended for
elevation value corrections. This is only active
if Dz model is set to Selected linear chain.

Projection Projection system of the geoid model. This is
only active if Dz model is set to any
implemented geoid model.

Adjust xyz
Not UAV

Adjust xyz command applies a varying XYZ correction to the block binary files. The correction
model is defined by a text file containing rows with five fields: X Y dX dY dZ where X and Y
define a fixed coordinate location and dX dY dZ define the change of XYZ coordinates at this
fixed XY location.

The command performs the same action on block binary files as the Transform loaded points
command with setting Transform = Dxyz on loaded points.

To adjust block binary  file coordinates to a vary ing XYZ correction model:

1. (Optional) Select block definitions in the Project window to be adjusted.

2. Choose Adjust xyz command from the Tools pulldown menu.

This opens the Adjust Xyz dialog:
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3. Define settings and click OK.

This starts the adjustment process. The process effects the block binary files directly on the
hard disc. It might be advisable to create a backup copy of the block binary files before
starting the process.

SETTING EFFECT

Process Blocks to adjust: All blocks or Selected blocks.

File Text file that stores the correction values.

Check coverage
Not UAV

Check coverage command finds holes and areas of low point density in the project binary files.
The area to be covered can be either defined by one or more selected polygons or by all block
boundaries of the project. The application calculates the point density within sample areas and
decides to which coverage level an area belongs.

The point coverage is defined in four levels: Covered, Almost covered, Almost hole and Hole.
User settings define the point densities which are interpreted as being holes or as being fully
covered. The command can create different output products in order to illustrate the point
coverage. The options include:

· the creation of a density raster image showing the point coverage in a TIFF file. The raster
images get the same name as the original block binary files.

· the creation of points in a uniform grid structure that fill the holes and areas of low point
density. Three different classes can be used to separate the points according the coverage
level. The elevation of the artificial points is set to be equal to the number of points found
in the sampling area. The points are saved in TerraScan binary files which get the same name
as the original block binary files. A project file with the name DENSITY.PRJ is created that
references the binary files with the artificial point.

· the output of the density calculation results in a report window. You can save a text file from
the report window.

To check the laser point coverage in a project area:

1. (Optional) Draw and select one or more polygons around areas for which you want to check
the coverage.

2. Select Check coverage command from the Tools pulldown menu.
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3. If no polygons are selected, the application informs you that it uses all block boundaries for
the check. Click OK.

This opens the Check Coverage dialog:

4. Define settings and click OK.

This starts the calculation of the point densities and the coverage. The software creates the
files according to the settings in the given directories. An information window shows the
progress of the process.

SETTING EFFECT

Create points for holes If on, points are created that fill holes,
almost hole and almost covered areas.

Directory Directory for storing the TerraScan binary
files and the project file for the artificial
points. This is only active if Create points
for holes is switched on.
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SETTING EFFECT

Almost covered Class for artificial points in almost covered
areas. This is only active if Create points for
holes is switched on.

Almost hole Class for artificial points in almost hole
areas. This is only active if Create points for
holes is switched on.

Hole Class for artificial points in holes. This is
only active if Create points for holes is
switched on.

Create density raster If on, density raster images in TIFF format
are created.

Directory Directory for storing the density raster
images. This is only active if Create density
raster is switched on.

Outside area Color in density raster images for areas
outside the covered area. This is only
active if Create density raster is switched
on.

Covered Color in density raster images for covered
areas. This is only active if Create density
raster is switched on.

Almost covered Color in density raster images for almost
covered areas. This is only active if Create
density raster is switched on.

Almost hole Color in density raster images for almost
hole areas. This is only active if Create
density raster is switched on.

Hole Color in density raster images for holes.
This is only active if Create density raster is
switched on.

Output average density report If on, a report window is displayed
showing the amount of points per
measurement area and the point density.

Source classes Point class(es) that are included in the
coverage calculation.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Source classes field.
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SETTING EFFECT

Step size Defines the steps at which the point
density is analyzed. Determines also the
pixel size of the density raster images and
the distance between the artificial points
that are created to fill holes and areas of
low density.

Sample radius Radius of the sample area from which to
calculate the local point density.

Covered > Point density required for an area being
considered as covered.

Hole < Point density for an area that will be
considered as hole.

Since the file names of the files created by the process are fixed, existing files are
overwritten without warning if the command is performed a second time on a project with
the same directory settings.

Convert storage format
Not UAV

Convert storage format command converts project block binary files into another binary format.
At the same time, it modifies and saves the project definition according to the new binary file
format.

Before you convert block binary files into a new format, make sure that you do not loose any
important attributes stored in the original binary files. For instance, if converting from
FastBinary format to LAS, specific attributes, such as normal vector, group number, or even the
color (LAS 1.0 or 1.1), are no longer available.

The converted binary files can be written into another folder. This keeps the original files
unchanged. The modified project file is stored in the same folder as the converted binary files.

To convert the storage format of project binary  files:

1. Select Convert storage format command from the Tools pulldown menu.

This opens the Convert Storage Format dialog:
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2. Select a new format from the Store as list. The list contains all supported binary formats for
project blocks. See Supported file formats for more information.

3. Click OK.

This starts the conversion process.

SETTING EFFECT

Store as New storage format of the binary files. The
list contains all supported binary formats for
project blocks. See Supported file formats for
more information.

Attributes Opens the Attributes dialog which contains
the list of possible point attributes to be
stored in the selected format. You may
change the pre-selection by switching on/off
additional attributes.

Write to Storage location of the converted binary files
and modified project file. Use the Browse
button in order to select or create a new
folder.

Copy from reference
Not UAV

Copy from reference command copies attributes of laser points from a reference project to the
laser points of the active project. The command requires the definition of a reference project in
the project information settings of the active project. See Edit project information for more
information about defining a reference project.

There has to be a possibility to uniquely identify a point by its attributes in the active and
reference project binary files in order to ensure that the correct attributes are copied for a
point.

For LAS files, the combination of time stamp + echo information is unique for each laser point if
all the data was captured in one GPS week or if GPS standard time stamps are used. Otherwise,
the combination of line + time stamp + echo information defines a laser point unambiguously.

For TerraScan Binary and FastBinary files, the combination of time stamp + echo information is
not unique for each laser point because of the resolution with which time stamps are stored in
this format. Therefore, additional attributes that are the same in the active and reference
project binary files have to be selected to identify laser points unambiguously.

An example case for using this command could be:

· Laser data has been imported into a project in folder \laser1.
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· Heading, Roll, Pitch (HRP) misalignment has been solved and applied to the laser points that
are now stored in folder \laser2.

· Automatic and manual classification steps have been performed.

· After the classification it has been realized that the HRP correction was wrong but the
classification is good and took a lot effort.

· As a solution, the project in folder \laser1 is defined as reference project in the information
dialog of the project in folder \laser2.

· The attributes xy and z are copied from laser data in \laser1 to the data in \laser2 using the
Copy from reference command.

This restores the coordinate values from the status before the HRP correction but preserves the
classification that was done after the HRP correction.

To copy attributes from a reference project:

1. Select Copy from reference command from the Tools pulldown menu.

This opens the Copy from Reference dialog:

2. Define settings and click OK.

This copies the selected attributes to the points of the active project. An information
window shows the progress of the process.

After the process finished, a report is displayed that shows the number of points that have
been changed in each block binary file. The report can be saved as a text file or printed
directly using commands from the File pulldown menu in the Copy parameters window.
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SETTING EFFECT

Copy from Point class(es) from which the attributes are
copied.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Copy from field.

Apply to Point class(es) to which the attributes are
copied.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Apply to field.

Search in Method how corresponding blocks are
searched in the reference project:

· Block with matching name - the block
names in the reference project are
supposed to be the same as in the active
project.

· Blocks close in xy - the block boundaries
of the reference project are supposed to
be at the approximately same location as
the block boundaries of the active
project. The software finds matching
points in the active and reference project
blocks also if they are not exactly at the
same XY location.

Match by If on, the attribute is used to find matching
points in the reference and active projects.

Copy data If on, the attribute is copied from the laser
points in the reference project to the
corresponding laser points in the active
project.

Draw cloud boundaries
Not UAV

Draw cloud boundaries command draws shape element(s) for area(s) that are covered by the
point cloud or by single lines. Single lines are identified by the line number attribute stored for
laser points. In addition, the class attribute can be used to further limit the area enclosed by the
shape.
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The shape elements may be useful to ensure that there are no gaps in the data set or to test if
data from specific lines can be removed without causing a gap. The process can draw the shapes
on different CAD file levels for each line. This supports the check of line removal without the
need to delete the elements.

To draw cloud boundaries:

1. Select Draw cloud boundaries command from the Tools pulldown menu.

This opens the Draw Cloud Boundaries dialog:

2. Define settings and click OK.

The software checks all blocks of the project and draws the boundary shape(s) into the CAD
file. The color of the shape element(s) is determined by the line number (for individual
lines) or the active color (for the whole point cloud), line style and weight by the active
symbology settings of the CAD platform. After drawing individual line shapes on separate
levels, a MicroStation design file is compressed automatically.

SETTING EFFECT

Boundary for Defines the boundary type:

· Whole point cloud - one boundary for the
whole project point cloud is drawn.

· Individual lines - boundaries for separate
lines are drawn.

Class Point class(es) that are included in the
shape computation.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Gap A new shape element is drawn if there is a
gap larger than the given size between
points of the same line.



TerraScan User Guide  © 2023 Terrasolid Ltd

645Working with Projects > Tools pulldown menu > Draw cloud boundaries

SETTING EFFECT

Level CAD file level(s) on which the shape
elements are drawn:

· Active level - shapes for all lines are
drawn on the active level.

· Separate levels - shapes for each line are
drawn on a separate level. The levels for
the shapes are created automatically with
the name <LineX> where X is the line
number.

Draw internal holes If on, areas within lines without points
larger than the given Gap size are enclosed
by boundaries. They are defined as holes
within the shape element for the line.

Export 3D ortho
Not UAV

Export 3D ortho command generates a point cloud from orthophotos. The process combines
orthophoto pixel location and color, and laser point coordinates in order to create a high-
density colored point cloud. The resulting point cloud contains one point for each orthophoto
pixel with the following attributes:

· XY coordinates - computed from the center of orthophoto pixels or used from the original
laser points.

· Z coordinate - computed from a TIN generated from laser data or used from the original laser
points.

· Class - defined by the source class in the laser data.

· RGB color values - determined by the pixel color, the laser point color, or a fixed color.

The command requires TerraScan and TerraPhoto running on the same computer. The
orthophotos must be attached as TerraPhoto raster references in order to create the 3D point
cloud. In addition, the laser data in the block binary files should be classified in order to
distinguish point elevations on the ground, vegetation, building roofs, etc. This allows you to
define different rules for the point cloud generation depending on the object types.

The process can also include vector elements in the point cloud computation, such as 3D
building models or other 3D shapes.

The process creates a new TerraScan project file and block binary files for each orthophoto
inside the area covered by blocks of the original laser project. The names of the blocks and
binary files are determined by the names of the orthophotos. The point density and the
amount of points per block binary file of the generated point cloud is determined by the pixel
resolution of the orthophotos but also by the rules for the point cloud creation.



TerraScan User Guide  © 2023 Terrasolid Ltd

646Working with Projects > Tools pulldown menu > Export 3D ortho

To export a 3D ortho point cloud:

1. Attach orthophotos by using the Manage Raster References tool of TerraPhoto.

2. Open the TerraScan project that references the classified laser binary files.

3. Select Export 3D ortho command from the Tools pulldown menu.

This opens the Export 3D Ortho dialog:

4. Define a storage directory and name for the Output project. The block binary files are stored
in the same folder as the project file. Click on the Browse button in order to define the
output project in a standard dialog.

5. Select a file format for the block binary files: FastBinary or LAS 1.2.

6. Click on the Add button in order to define rules for the export of different layers, such as
ground, vegetation, or buildings.

This opens the 3D Ortho Layer dialog:

https://terrasolid.com/guides/tphoto/toolmanagerasterreferences.html
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7. Define settings and click OK.

You can Edit and Delete layers by using the corresponding buttons in the Export 3D ortho
dialog.

8. Click OK in the Export 3D Ortho dialog.

This starts the point cloud generation process. A progress window displays the progress of
the process.

SETTING EFFECT

Name Descriptive name of the layer.

Type Defines how points are extracted for the
export:

· Grid from TIN - a grid is extracted from a TIN
created from the laser points. The XY
location of a grid point is determined by the
pixel center, the elevation by the TIN.

· Points directly - the original laser points are
exported.

Max triangle Maximum length of a triangle edge in the TIN.
Determines how big gaps are filled with
points generated by aerial triangulation. This
is only active if Type is set to Grid from TIN.
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SETTING EFFECT

Color source Defines the source for extracting RGB values
for the points:

· Ortho - each point gets the color of the
closest pixel in the orthophotos.

· Point color - each point gets the color
assigned to laser points.

· Fixed color - each point gets a fixed color
value.

Gaps at class changes If on, a gap is enforced at boundaries between
different classes in the source laser data. This
avoids that point are generated by aerial
triangulation between different point classes.

R G B RGB color values of a fixed color assigned to
points. This is only active if Color source is set
to Fixed color.

List of classes Select the source class(es) for this layer. The
list contains the active classes in TerraScan.

User surface objects If on, shape elements on the given Levels are
used for determining the elevation of
exported points inside a shape area.

The TerraScan project file for the exported point cloud is created with the Color attribute
inactive. Therefore, you have to switch the attribute on and save the project before you can
see the points displayed by color correctly. See Edit project information for instructions how
to edit a project.

Export lattice models
Not UAV

Export lattice models command creates grid files with uniform distances between points from
one or more selected laser point classes. For each grid point, the lattice model file stores XY
coordinates and one of the following value types:

· elevation values

· point count/density values

· distance values computed for points with the Compute distance command or corresponding
macro action

· analytical values, such as average intensity, horizontal or vertical distance, surface
roughness

There are several formats supported to store lattice models as raster or text files. The command
requires the selection of at least one polygon that defines the lattice model boundary. If
several polygons are selected, the software creates a separate lattice model file for each
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polygon. Text elements placed inside the polygon(s) can be used as file names for the lattice
model files. A polygonal area is always expanded to a rectangular area of a lattice model. The
cells outside the polygon are filled with a defined “outside” value or can be skipped from
output in XYZ text files.

To export a lattice model:

1. Draw rectangle(s) around area(s) from which you want to create lattice model(s). (Optional)
Place text elements inside the rectangles. Select rectangle(s) and (optional) text(s).

2. Select Export lattice model command from the Tools pulldown menu.

This opens the Export Lattice Model dialog:

3. Define settings and click OK.

This starts the lattice model file creation.

If File naming is set to Enter name for each, the Export lattice model dialog opens, a standard
dialog for saving files.

4. Define a location and name for the lattice file and click Save.

Repeat step 4 for each lattice model.
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SETTING EFFECT

Class Source class(es) for lattice model creation.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Value Value stored for each grid point of a lattice
model:

· Triangulated model z - elevation value
calculated from a TIN model of the points
in the source class(es).

· Highest hit z - elevation value determined
by the highest point in the source
class(es).

· Average hit z - elevation value calculated
as average of points in the source
class(es) falling inside the grid cell.

· Lowest hit z - elevation value determined
by the lowest point in the source
class(es).

· Closest hit z - elevation value determined
by the point closest to the grid cell center
in the source class(es).

· Point count - amount of points falling
inside the cell.

· Point density - amount of points per
squared master unit.

· Average intensity - average intensity
value of points in the source class(es)
falling inside the grid cell.

· Distance to point - average horizontal
distance between a grid point and the
two closest points in the source class(es).

· Dz from ground - vertical distance
between a grid point and a surface model
created from the Ground class(es).

· Surface roughness - difference of a grid
point from a plane fitted to the closest
points in the source class(es). Represents
the local elevation variation of points in
the source class(es).

· Biggest distance - biggest distance value
inside the grid cell. Requires that a
distance value is computed for each point
using the command for loaded points or
corresponding macro action.
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· Average distance - average distance value
of points inside the grid cell. Requires
that a distance value is computed for each
point using the command for loaded
points or corresponding macro action.

· Smallest distance - smallest distance
value inside the grid cell. Requires that a
distance value is computed for each point
using the command for loaded points or
corresponding macro action.

Ground Source class(es) for creating a surface
model. This is only active if Value is set to
Dz from ground.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground field.

Export Area to be exported into lattice model
file(s):

· Whole area - not available.

· Selected rectangle(s) - the area inside
selected polygon(s) is exported into
separate files.

Expand by Distance by which a selected polygon is
expanded for the model export. The area
covered by the expanded polygon is
included in a lattice model file.

Grid spacing Defines the distance between grid points
and thus, the resolution of the lattice
model.

Max triangle Maximum length of a triangle edge for TIN
creation. Effects how big gaps are filled in
the lattice model by interpolating grid point
values from the TIN. This is only active if
Value is set to Triangulated model z or
Distance to point.

Model buffer Width of a buffer area around the actual
model area that is considered for calculating
grid point values. This is only active if Value
is set to Triangulated model z, Distance to
point, Dz from ground, or Surface
roughness.

Fill gaps up to Defines the size of gaps that are filled in the
lattice model by deriving grid point values
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from closest points in the source class(es).
This is only active if Value is set to Highest|
Average| Lowest hit z, Average intensity, or
Surface roughness.

Conserve memory If on, the software first determines how
many points will be loaded and thus, how
much memory needs to be allocated for the
exact number of points. This slows down
the process but it is less likely to run out of
memory.

File format Format of the lattice model file: ArcInfo,
GeoTIFF, Intergraph GRD, Raw, Surfer ASCII
or binary, Xyz text.

Z unit Unit of grid point values. Relevant for
formats storing elevations as integers. This
is only active if File format is set to GeoTIFF,
Intergraph GRD, or Raw.

Outside points Defines how the software handles grid cells
that are not covered by points in the source
class(es): Skip or Output. This is only active
if File format is set to Xyz text.

Outside Z Defines the value for grid cells that are
inside the rectangular lattice model area
but not covered by points in the source
class(es). This is only active if File format is
set to ArcInfo, GeoTIFF, Surfer ASCII and
binary, Xyz text.

Z decimals Determines the number of decimals stored
for the grid point value. This is only active if
File format is set to ArcInfo, Surfer ASCII, or
Xyz text.

Create TFW files If on, the software creates external
georeference files for GeoTIFFs. This is only
active if File format is set to GeoTIFF.

File naming Defines how lattice model files are named:

· Enter name for each - a name for each
lattice model file has to be defined
manually.

· Selected text elements - selected text
elements inside the lattice model area
are used as file names.

Directory Directory for storing lattice model files.
Click on the Browse button in order to
select a folder in the Browse For Folder
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dialog. This is only active if File naming is
set to Selected text elements.

Extension Extension of lattice model files. There may
be a specific extension required for a
certain file format, such as .GRD for ArcInfo
or .TIF for GeoTIFF. This is only active if File
naming is set to Selected text elements.

Lattice models can be produced by using

· Export lattice models command for loaded points.

· Export lattice macro action.

· Produce lattice models command in TerraModeler

Export raster images
Not UAV

Export raster image command generates raster images where pixel values are derived from
laser point attributes. The source data is points referenced by a TerraScan project.

The raster image can be created as Windows bitmap (.BMP) or GeoTIFF (.TIF). The color of a
pixel is determined using laser points whose coordinate values fall inside the pixel. The
coloring attribute can be chosen as:

· Distance - distance value based on the distance computation.

· Elevation - laser point elevation.

· Elevation difference - elevation difference between laser points of two different classes.

· Intensity hits - laser point intensity.

· Intensity footprint - average intensity of laser points within a footprint area overlapping the
pixel.

· Normal - direction of the normal vector relative to horizontal plane.

· Point color - color values stored for laser points.

· Point class - laser point class.

· Road intensity - intensity of laser points computed by directional sampling along road
alignment vectors.

· Slope - slope gradient based on normal vector computation.

The boundary of each raster file must be defined as a rectangle drawn into the CAD file. The
rectangle(s) must be selected. Text strings placed inside the rectangles can be used as file
names for the output files.

To create colored raster images:

1. Select rectangles as raster file boundaries and (optional) text strings inside the boundaries.

https://terrasolid.com/guides/tmodel/sw_producelatticemodels.html
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2. Select Export raster images command from the Tools pulldown menu.

This opens the Export Raster Images dialog:

3. Define settings. You may define your own coloring scheme by using the Define button.

4. Click OK.

This starts the raster file generation.

If File naming is set to Enter name for each, the Export raster image dialog opens, a standard
dialog for saving files.

5. Define a location and name for the raster file and click Save.

Repeat step 5 for each lattice model.

The software creates a raster file for each selected rectangle.

SETTING EFFECT

Color by Coloring attribute. See description above.

Class Point class(es) to use for creating the raster
file. If Color by is set to Elevation
difference, two classes have to be selected.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Bounding polygons Defines the area filled with values in the
output raster files. Pixels outside the
polygons get black as a background value.

Scheme file Color scheme file for Distance values. This
file can be stored from the Distance
Coloring Scheme dialog.

Alignments Level on which the road alignment vectors
are located. This is only active if Color by is
set to Road intensity.

Value Determines the value for each pixel:

· Lowest - smallest value of points inside
the pixel area.

· Average - average value of points inside
the pixel area.

· Highest - highest value of points inside
the pixel area.

This is only active if Color by is set to
Elevation, Elevation difference, or Intensity
hits.

Sampling Computation of raster values based on
directional sampling:

· Road intensity - distance along the road
alignment element(s).

· Slope - radius around a point.

Format Format of the output file: Windows BMP,
GeoTIFF or GeoTIFF + TFW.

Colors Color depth of the output file for elevation
or intensity coloring:

· 24 Bit Color - true color image.

· 256 Colors - 256 color image.

· Grey Scale - 8 bit gray scale image.

Background RGB values for pixels that do not have an
attribute value.

Pixel size Size of each pixel in the output file.

Fill gaps If on, gaps up to the given number of pixels
are filled in places where there are no laser
points inside a pixel area.
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SETTING EFFECT

Attach as reference If on, the output image is attached as a
raster reference. This requires TerraPhoto
to run.

Range Defines the value range that is covered by
the color scheme for Elevation and Intensity
coloring. Should be set to the general
elevation or intensity range covered in the
laser data to ensure that all values are
represented by the complete color scheme.

Unit Defines the unit for Slope coloring: Degree
or Percentage.

Scheme Type of coloring scheme for elevation or
intensity coloring:

· Cold to hot - varies from blue for low
pixel values via cyan, green, and yellow to
red for high pixel values. This is a
common coloring scheme for elevation
coloring.

· Hot to cold - varies from red for low pixel
values via cyan, green, and yellow to blue
for high pixel values.

· Selected colors - a user-defined coloring
scheme can be created by clicking on the
Define button. The dialog for color
scheme definition depends on the
selection of the color depth in the Colors
field, 24-Bit Color or 256 Colors.

· Black to white - varies from black for low
pixel values to white for high pixel
values. This is only active if Colors is set to
Grey scale. This is the common coloring
scheme for intensity coloring.

· White to black - varies from white for low
pixel values to black for high pixel values.
This is only active if Colors is set to Grey
scale.

Degree Determines how the color changes in color
schemes are computed. Warm and Hot
move a coloring scheme towards the red-
yellow color range, Cool and Cold towards
the blue-cyan color range. For gray scale
images, Light moves the gray scale towards
white and light gray, Dark towards black and
dark gray. Linear defines a linear
distribution of colors.
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SETTING EFFECT

File naming Defines how raster files are named:

· Enter name for each - a name for each file
has to be defined manually.

· Selected text elements - selected text
elements inside the raster image
boundary are used as file names.

Directory Directory for storing raster image files. Click
on the Browse button in order to select a
folder in the Browse For Folder dialog. This
is only active if File naming is set to
Selected text elements.

Raster images can be produced based on points loaded in TerraScan by using the Export
raster image command.

Export to Google Maps
Not UAV

Export to Google Maps command creates a KML file that includes the block boundaries and links
to block binary files of the project. With the help of this file, a point cloud project can be
published in Google Maps. The following steps are required:

1. (Recommended) The storage format of the block binary files should be LAZ. Use the Convert
storage format command in order to convert files to LAZ.

2. Upload the block binary files to any data exchange platform that is publicly available.

3. Export the project into a KML file as described below.

4. In you Google Maps account, create a new map by defining a title and description.

5. Import the KML file created in step 3.

The block boundaries are added as new layer to the map. Each block polygon acts as a link to
the LAZ file on the data exchange platform. By clicking inside a block polygon, the download
of the corresponding block binary file starts. Alternatively, the user can download all block
binary files.

The download of the files can be password protected by options of the data exchange
platform.

To export a project into a KML file:

1. Select Export to Google Maps command from the Tools pulldown menu.

This opens the Export to Google Maps dialog:
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3. Define settings and click OK.

The KML output file dialog opens, a standard dialog for saving files.

5. Define a location and name for the KML file and click Save.

The software creates the KML file.

SETTING EFFECT

Projection Projection system of the project data.  The
software shows the system information if it
is stored in the project definition. To change
the projection system, click on the >> button.
This opens the Browse for Projection System
dialog. The dialog provides a search option
for projection systems as well as a list of all
implemented systems. In addition, any user-
defined projection systems are included in
the list.

Folder Folder for storing the block binary files on a
data exchange platform. The folder must be
publicly available but file download may be
password protected.

Polygon Line/filling color of the block polygons in
Google Maps. Click on the color button in
order to open the Windows dialog for
selecting a color.

Transparency Transparency percentage for displaying the
block polygons in Google maps. The higher
the value, the more the background map is
visible.

Edge width Line width of the block boundary in Google
Maps. The list contains the standard line
widths of the CAD platform.
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Extract color from images
Not UAV

Extract color from images command extracts RGB color values from raster images and assigns
the color values to laser points in block binary files. The color sources can be orthophotos
attached as TerraPhoto raster references or raw images in an active TerraPhoto image list. In
addition, a color point file can be used to balance colors of the raw images before the color
values are assigned to the laser points. The command requires TerraPhoto or TerraPhoto Lite
running on the same computer.

TerraScan can extract up to 10 color channels for each point. The maximum amount of color
channels can only be stored in the TerraScan FastBinary format. LAS 1.4 format and later can
store up to 4 color channels, LAS 1.2 format and later and TerraScan Binary files up to 3.

The color for a laser point is derived by resampling the color values of all the pixels inside a
circular area around the point. There are different methods of color value extraction from raw
images which are either suitable for airborne or mobile data sets.

The process can involve the computation and storage of image numbers. The number of the
image used for extracting the color can be stored for each laser point. This requires the storage
of points in TerraScan FastBinary format. The image number stored as laser point attribute is
required for advanced coloring methods for mobile point clouds.

The command performs the same action on block binary files as the Extract color from images
command on loaded points.

To extract color from attached orthophotos or raw images:

1. Attach reference images in TerraPhoto’s Manage Raster References tool.

OR

1. Load an image list into TerraPhoto.

2. Select Extract color from images command from the Tools pulldown menu.

This opens the Extract Color from Images dialog:

https://terrasolid.com/guides/tphoto/toolmanagerasterreferences.html
https://terrasolid.com/guides/tphoto/mwloadlist.html
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3. Define settings and click OK.

This derives color values for the laser points from the defined source images.

SETTING EFFECT

Process Blocks to process: All blocks or Selected
blocks.

For class Laser point class(es) for which colors are
extracted.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the For class field.

Color source Source files for color extraction:

· Ortho images - colors are extracted from
attached TerraPhoto raster references.

· Raw images - colors are extracted from
raw images in an active image list in
TerraPhoto.

· Raw images & color points - colors are
extracted from raw images and from a
color point file.

Source channels Amount of color channels to be extracted.
Click on the Mapping button in order to set
the channel numbers for color extraction in
the Extract Color Channel Mapping dialog.
This makes it possible extract RGB channels
from one set of images and NIR channel
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SETTING EFFECT

from another set of images (other channels
can be skipped).

Cpt file Location and name of a color point file. This
is only active if Color source is set to Raw
images & color points.

Image numbers Method how the software handles the
computation and storage of image numbers
from raw images:

· Compute -- do not store - image numbers
are computed but not stored for laser
points.

· Compute and store - image numbers are
computed and each laser point stores the
number of the image from which it gets
the color.

· Use stored - stored image numbers of
laser points are used for color extraction.

Use image Method how the software determines the
raw image for extracting a color for a laser
point:

· Closest in 3d - closest camera XYZ
position. Optimized for airborne data
sets.

· Closest in xy - closest camera XY position.
Optimized for airborne data sets.

· Closest in time - closest time stamp.
Optimized for airborne data sets.

· Mobile -- closest in time - closest time
stamp. Optimized for mobile data sets.

· Mobile -- ground surface - best ground
surface visibility. Optimized for mobile
data sets.

· Mobile -- closest in 3d - closest camera
XYZ position. Optimized for mobile data
sets.

Footprint Radius of a circular area around each laser
point within which pixel color values are
resampled. Given in meters for a method
optimized for airborne data sets and in
pixels for mobile data sets. This is the only
active if Color source is set to Ortho images.

Max distance Maximum distance between a raw image
and a laser point. Images outside that
distance are not considered for color
extraction. This is only active if Use image is
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SETTING EFFECT

set to any method optimized for mobile
data sets.

Max time diff Maximum time difference between a raw
image and a laser point. Images outside that
difference are not considered for color
extraction. This is only active if Use image is
set to Mobile -- closest in time.

Use depth maps If on, depth maps files are included in the
color extraction process. See TerraPhoto
User Guide for more information about
depth maps.

Radius Radius checked in image depth maps to find
out if the point is visible in the image or
occluded.

Tolerance Allowed depth difference between a point
and depth map before the point is
considered occluded. If the depth of a point
is bigger than depth map value and
tolerance together, point in that image is
considered occluded and some other image
is used in color extraction.

Favor better quality images If on, the quality attribute stored for raw
images in an image list is considered in the
color extraction process. See TerraPhoto
User Guide for more information about the
quality attribute.

Favor cameras by class If on, the settings in the TerraPhoto mission
file related to favoring cameras for coloring
points are considered in the color extraction
process. See TerraPhoto User Guide for
more information about the mission
definition.

Extract echo properties
Not UAV

Extract echo properties command extracts information from waveform data and assigns it as
attributes to the laser points. The command requires that waveform data and a scanner
waveform profile are available. The processing steps for preparing the extraction of waveform-
related information are described in detail in Chapter Waveform Processing.

The command can extract the following attributes:
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· Echo length - relative length (millimeter) of a return signal compared to a typical return from
a hard surface.

· Echo normality - difference in shape of a return signal compared to a typical return from a
hard surface.

· Echo position - difference in position of a peak of a return signal compared to a typical return
from a hard surface.

The echo length can be used for the visualization of points and for classifying points. For
instance, a classification By echo length prior to ground classification can improve the result of
the Ground routine especially in areas of low vegetation.

The echo properties can be stored in TerraScan FastBinary files. The command can be used to
extract echo properties for all blocks or a selection of blocks defined in a project.

The command performs the same action on block binary files as the Extract echo properties
command on loaded points.

To extract echo properties:

1. Select Extract echo properties command from the Tools pulldown menu.

This opens the Extract Echo Properties dialog:

2. Select which blocks to process: All blocks or Selected blocks.

3. Select what properties you want to extract by switching the corresponding options on.

4. Click OK.

This starts the extraction process. It assigns the extracted attributes to all laser points of the
processed block binary files for which waveform information is available. Depending on the
amount of points, the process may take some time.

Merge small blocks
Not UAV

Merge blocks command merges small project blocks with neighbour blocks. It combines the
block definitions and the binary files into one definition/file. This may be useful, for example,
if automatically created grid block boundaries have been used for importing points. At the
boundaries of the project areas, there may be blocks with low amounts of points which can be
merged automatically into bigger blocks.
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The process works only if there are block binary files available.

To merge blocks automatically :

1. Select Merge small blocks command from the Tools pulldown menu.

This opens the Merge Small Blocks dialog:

2. Define setting and click OK.

This creates new block definitions and binary files. The original binary files are not kept. An
information dialog shows the number of merged blocks after the process is finished.

3. Use Save project or Save project as commands in order to save the modification in a project
file.

SETTING EFFECT

Method Criteria that determines the block size:

· Point count - amount of points per block.

· Area - size of the area covered by a block.

Minimum Minimum value for accepting a block. Smaller
blocks will be merged with neighboring
blocks, if possible.

Maximum Maximum value for accepting a block. The
process stops if no block can be merged with a
neighboring block without exceeding the
maximum limit.

Blocks can be merged interactively by using the Merge blocks from the Block pulldown
menu. This may be useful if the automatic merging process does not lead to a satisfying
result.

Output collections
Not UAV

Collection shapes can be used to produce output files where logical groups of points are put
together. You can perform the grouping by placing collections shapes around the objects using



TerraScan User Guide  © 2023 Terrasolid Ltd

665Working with Projects > Tools pulldown menu > Output collections

the Place Collection Shape tool. The output process starts from the Project window and
automatically gathers all necessary points from the block binary files.

The output files can be created in two ways:

· The points inside each collection shapes are written into a separate output file. The name of
the output files are determined by an optional prefix and either the number of the
collection shape or an automatically increasing number.

· All points inside collection shapes are written into one output file.

The output file format should be a user-defined text file format which includes a Collection
field so that points belonging to different collections can be distinguished from each other. See
File formats / User point formats category of TerraScan Settings for more information. However,
any text file format or TerraScan binary format is a valid output format for point collections.

To output collection shapes:

1. Select Output collections command from the Tools pulldown menu.

This opens the Output Collections dialog:

2. Define settings and click OK.

3. If Create is set to Single file, the software opens the Collection output file dialog, a standard
dialog for saving files. Define a location, name, and extension for the output file and click
Save.

This starts the output process.

SETTING EFFECT

Type Collection shape type to output. The list
contains all collection shape types that are
defined in Collection shapes category of
TerraScan Settings.

Class Point class(es) to output.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Format Output file format.

Xyz decimals Number of decimals used for coordinate
values in the output files. This is only active
if a text file format is chosen as output
format.

Numbering Defines the number of a point collection
and the numbering method for naming
separate output files:

· Automatic - automatically increasing
numbers starting from 1.

· From texts - text elements drawn inside
collection shapes.

Create Defines the output: Single file or One for
each shape.

Directory Directory for storing output files. This is
only active if Create is set to One for each
shape.

Prefix Defines the first part of the output file
names which is followed by a number. This
is only active if Create is set to One for each
shape.

Extension File name extension. Allowed extensions
are .TXT or .ASC for text files and .BIN for
TerraScan Binary files. This is only active if
Create is set to One for each shape.

Output control report
Not UAV

Output control report command creates a report of elevation differences between laser points
and ground control points or a surface model. This can be used, for example, to check the
elevation accuracy of a laser data set and to calculate a correction value for improving the
elevation accuracy of the laser points.

The ground control points have to be stored in a space-delimited text file in which each row has
three or four fields: (optionally) identifier, easting, northing and elevation. The identifier field
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is usually a number but it may include non-numeric characters as well. The surface model has to
be an active model in TerraModeler.

The output report shows statistical information about the elevation difference between points
and surface model, such as points used for computing the values, average difference and
magnitude, standard deviation, and RMS value. It does not show elevation difference values for
single point locations.

The command performs the same action on block binary files as the Output control report
command on loaded points. Only the elevation accuracy can be checked for a project.

To create a control report:

1. (Optional) Select block definitions in the Project window to be adjusted.

2. Select Output control report command from the Tools pulldown menu.

This opens the Output Control Report dialog:

3. Define settings and click OK.

This calculates the elevation differences and opens the Control report window. The content
of the report depends on the source file used for the comparison, ground control points in a
text file or a surface model. The results and the further usage of a comparison with ground
control points is described in detail in Section Systematic elevation correction.

SETTING EFFECT

Process Blocks to include in the process: All blocks
or Selected blocks.

Compare against Source file for elevation value comparison:

· Known points - text file that contains
coordinates of ground control points.

· <surface model> - name of a specific
surface model active in TerraModeler.

https://terrasolid.com/guides/tmodel/sw_managingsurfaces.html
https://terrasolid.com/guides/tmodel/sw_managingsurfaces.html
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SETTING EFFECT

Known points Location and name of the file that stores the
coordinates of the ground control points.
This is only active if Compare against is set
to Known points.

Class Point class(es) used for the elevation value
comparison.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Max triangle Maximum length of a triangle edge. The
software creates a triangle from the closest
3 laser points around a ground control point
location. If the triangle edge length exceeds
the given value, the control point is not
used for the report.

Max slope Maximum terrain slope for which an
elevation difference is computed.

Z tolerance Normal elevation variation (noise level) of
laser points. This value is used only when
computing the terrain slope so that small
triangles do not exceed the Max slope
value.

Run macro
Not UAV

The main benefit of defining a project is the ability to perform batch processing on blocks. Run
macro command lets you run a TerraScan macro on project level. This requires that you first
define a macro which includes all the processing steps to perform. Then, you can run the macro
on all or selected project blocks.

A macro can run on project level either by using TerraScan or by using TerraSlave. Using
TerraSlave has the advantage that TerraScan and the CAD platform are not blocked when a
macro is processed.

For detailed information about macros, see Chapter Macros.
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Show statistics
Not UAV

Show statistics command calculates simple statistics for the block binary files. The output dialog
includes information about classes, point count as well as minimum, maximum, and median
elevation values. Besides for the whole project, these values are also calculated for each block
and line. The statistics can be saved into a text file.

To calculate statistics for a project:

1. Select Show statistics command from Tools pulldown menu.

The calculation process starts and an information window is displayed that shows the progress
of the process. After finishing the calculation, the Project statistics dialog opens:

Check the statistics for the project, different blocks, or lines by selecting the corresponding
settings in the Display and Block or Line lists.

The statistical values for all classes occurring in the block binary files are listed in the lower
part of the dialog.

You can save the statistics into a text file using Save as command from the File menu in the
Project statistics dialog.

The text file stores the point count for each class and the elevation values if Display is set to
Project total, and the point count for each class per block or line if Display is set to By block or
By line.

SETTING EFFECT

Display Content of statistics display:
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SETTING EFFECT

· Project total - values for the whole project
are displayed.

· By block - values are shown for the selected
block.

· By line - values are shown for the selected
line.

Block Name of the block for which statistical values
are shown. This is only active if Display is set
to By block.

Line Number of the line for which statistical values
are shown. This is only active if Display is set
to By line.

Transform coordinates
Not UAV

Transform coordinates command applies a coordinate transformation to the block binary files
and/or block boundaries.

The command can use the following transformation types:

· Dz - fixed elevation difference value in order to apply a systematic elevation shift.

· Dxyz - text file storing difference values for easting, northing and elevation. The format of
the text file is X Y dX dY dZ.

· Projection change - from one implemented projection system to another.

· A specific transformation defined in Coordinate transformations / Transformations category
of TerraScan Settings.

To transform block boundaries:

1. Select Transform coordinates command from the Tools pulldown menu.

This opens the Transform Project Coordinates dialog:



TerraScan User Guide  © 2023 Terrasolid Ltd

671Working with Projects > Tools pulldown menu > Transform coordinates

2. Define settings and click OK.

This opens the Target Coordinate Setup dialog. 

3. Define a coordinate setup for the new project and click OK.

This transforms the coordinates of block boundaries and/or the point cloud. The process
writes a new project file and new block binary files in the given output folder. After the
process is finished, a report shows the number of transformed points for each block binary
file.

SETTING EFFECT

Transform point cloud If on, the block binary files are transformed
and stored in (new) files.

Transform block boundaries If on, block boundaries are transformed and
stored in a (new) project file.

Write to Output folder for the transformed project and
block binary files. If the folder contains
already files with the same name, they are
overwritten.

Transform Type of transformation to be applied:

· Dz - fixed elevation difference value in
order to apply a systematic elevation shift.

· Dxyz - text file storing difference values for
easting, northing and elevation. The format
of the text file is X Y dX dY dZ.

· Projection change - from one implemented
projection system to another.

· <name> - name of a transformation defined
in Coordinate transformations /
Transformations category of TerraScan
Settings.

Dz Value added to the elevation coordinate of
each point. This is only active if Transform is
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SETTING EFFECT

set to Dz.

Dxyz Text file that stores the XYZ correction values.
This is only active if Transform is set to Dxyz.

From system Source projection system. The software shows
the system information if it is stored in the
project definition. To change the projection
system, click on the Browse button. This
opens the Browse for Projection System
dialog. The dialog provides a search option for
projection systems as well as a list of all
implemented systems. In addition, any user-
defined projection systems are included in
the list. This is only active if Transform is set to
Projection change.

To system Target projection system. Click on the Browse
button to open the Browse for Projection
System dialog. The dialog provides a search
option for projection systems as well as a list
of all implemented systems. In addition, any
user-defined projection systems are included
in the list. This is only active if Transform is set
to Projection change.

You may use Draw boundaries command to draw the transformed boundaries into the CAD
file.

Validate blocks
Not UAV

Validate blocks command checks block definitions of a project regarding duplicated block
names, small area blocks, and overlap between block boundaries. This helps to analyze
automatically created block boundaries and names before the block binary files are created.

To validate blocks:

1. Select Validate blocks command from the Tools pulldown menu.

This opens the Block validity check window that displays the results of the validation in a
report.

The report can be saved into a text file or sent to a printer using Save as text or Print commands
from the File pulldown menu.
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Write by line
Not UAV

Write by line command writes data from block binary files of a project into files per line sorted
into time order. The process creates first temporary files for lines from each block. Then, for
each line the temporary files are combined into one final output file.

To write project data by  line:

1. Select Write by line command from the Tools pulldown menu.

This opens the Write by Line dialog:

2. Define settings and click OK.

This starts the output process.

SETTING EFFECT

Class Point class(es) that are included in the
output process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Line Line number(s) that are included in the
output process. 0-65535 refers to all lines.

Format New storage format of the binary files per
line. The list contains all supported binary
formats for project blocks. See Supported
file formats for more information.

Attributes Opens the Attributes to write dialog which
contains the list of possible point
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SETTING EFFECT

attributes to be stored in the selected
format. You may change the pre-selection
by switching on/off additional attributes.

Write each scanner to its own files If on, the data is further split into files per
scanner.

Output folder Location for storing the final output files.
Use the Browse button in order to select or
create a new folder.

Temp folder Location for storing the temporary files
that are produced during the process. Use
the Browse button in order to select or
create a new folder. The temporary files
are removed when the final output files
are created.

Name prefix Prefix for naming the output files. The line
number is added automatically to the file
name.
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View pulldown menu

Commands of the View pulldown menu are used to sort project block definitions in the list and
to select attribute fields for being displayed in the window.

TO USE COMMAND

Select fields to be displayed in the window Fields Not UAV

Sort trajectories according to specific criteria Sort Not UAV

Fields
Not UAV

Fields command lets you select which attributes are displayed for each block definition in the
Projects window.

To select visib le fields:

1. Select Fields command from the View pulldown menu.

This opens the View Project Fields dialog:

2. Select fields and click OK.

FIELD DESCRIPTION

Name Block name.

Number Block number.

Point count Amount of points per block.

Area Size of the area covered by a block.

Locked by Name of the computer that locks a block file.
The information is only displayed if Require
file locking option is active in the project
definition.



TerraScan User Guide  © 2023 Terrasolid Ltd

676Working with Projects > View pulldown menu > Fields

FIELD DESCRIPTION

Lock date Date when a block was locked by a computer.
 The information is only displayed if Require
file locking option is active in the project
definition.

Lock time Time when a block was locked by a computer.
 The information is only displayed if Require
file locking option is active in the project
definition.

Sort
Not UAV

Commands from Sort submenu are used to display the list of blocks in a specific order. The
order can be stored in the project file.

· By name - Sort alphabetically ascending by block name.

· By number - Sort ascending by last number in the block name.

· By point count - Sort ascending by amount of points in the block binary files.

· North to south - Sort by geographical location, north to south and secondarily west to east.

· South to north - Sort by geographical location, south to north and secondarily west to east.

· West to east - Sort by geographical location, west to east and secondarily south to north.

· East to west - Sort by geographical location, east to west and secondarily south to north.
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Manage Trajectories

Trajectories are required for many processing steps in TerraScan and TerraMatch. They provide
positional and, usually for moving systems, attitude information of the scanner system for each
point of time during the data collection.

Normally, the raw trajectory is produced by so-called post-processing software that combines
the input of GPS and INS sensors. The raw trajectory may be provided in a binary or ASCII file
format. TerraScan is able to import common binary formats of post-processing software as well
as a number of ASCII formats. Additional text file input formats for trajectories can be defined
in File formats / User trajectory formats category of TerraScan Settings. All imported trajectories
are converted into the TerraScan trajectory binary format (*.TRJ). See Trajectory file formats for
more information.

All commands related to trajectories is combined in the TerraScan Trajectories window which is
opened by the Manage Trajectories tool.

TerraScan Trajectories window

The Trajectories window contains pulldown menu commands for importing, modifying, and
managing trajectory information.

The list in the window shows all TerraScan trajectory files that are stored in the active trajectory
folder. The active directory is shown in the title bar of the window.

To select a trajectory, click on the line in the list. Press  <Ctrl> to select several trajectories.

To show the location of one or more trajectories, select the corresponding line(s) in the list.
Click on the Show location button and move the mouse pointer into a view. This displays any
selected trajectories. With a data click inside the view you can center the selected trajectories
in the view. In the Show trajectory location dialog, you can define the Hilite color, line Weight
and Style for the temporary display of the trajectory. If the Show travel direction option in the
dialog is switched on, the travel direction of a trajectory is displayed by small arrows along the
temporary line element.
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To identify a trajectory, click on the Identify button and place a data click close to a trajectory in
a view. This selects the corresponding line in the Trajectories window. You may identify several
trajectories by pressing the <Ctrl>-key while placing data clicks close to trajectories in a view.
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File pulldown menu

Commands from the File pulldown menu in the Trajectories window are used to import
trajectory information into TerraScan and to export trajectory information into text files.

TO USE COMMAND

Set the active trajectory folder Set directory

Import trajectory files Import files

Import trajectory files from a folder and its
sub-folders

Import directory

Import positions of tripod-mounted scanners Import scanner positions

Deduce trajectories from point clouds of
tripod-mounted scanners

Deduce scanner positions

Import separate text files from GPS and INS
sensors

Merge from GPS and INS

Import accuracy files for trajectories Import accuracy files

Export trajectory information into text files Output positions

Deduce scanner positions

Deduce scanner positions command creates trajectory information for tripod mounted scanner
data where:

· each scan has its own line number in the point cloud. The line information is used to
separate one scanner position from another.

· scanner appears as a circular void area without points. The software assumes that the
scanner is located in the center of the void area.

The routine computes the average XY position of points in one line and then searches for the
void area. It creates a trajectory file with one position. The process may fail if a scanner position
is close to a wall or if the void area is not circular.

You can use this method, if no text file for scanner positions is available for import. 

The deduced trajectory allows processes for the point clouds that rely on trajectory
information, such as cut overlap, classify by range, compute normal vectors towards the
direction of scanner, etc..

To deduce scanner positions:

1. Set a directory for storing trajectories.

2. Load the point cloud produced by the scanner. You may load point clouds from several
scanner positions.
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3. Select Deduce scanner positions from the File pulldown menu.

The Deduce Scanner Positions dialog opens:

4. Define settings and click OK.

This writes the scanner positions as TerraScan trajectory binary file(s) into the active
trajectory directory. The name of a file is determined by the line number.

SETTING EFFECT

Scanner height Height of the scanner above the ground.

Hole diameter Diameter of the circular void area around the
scanner position.

Deduce trajectories

Deduce trajectories command creates approximate trajectories based on the point cloud. This
requires that points are loaded into TerraScan and time stamps must be available. The deduced
trajectory files store the a time, XYZ positions as well as a heading value.

You can use this method, if no trajectory information is available for import. The deduced
trajectory allows processes for the point clouds that rely on trajectory information, such as cut
overlap, classify by range, compute normal vectors towards the direction of the trajectory, etc..

To deduce trajectories from points:

1. Set a directory for storing trajectories.

2. Load the point cloud into TerraScan.

3. Select Deduce trajectories from the File pulldown menu.

The Deduce Trajectories From Points dialog opens:
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4. Define settings and click OK.

This sorts the points by time stamps and deduces the trajectory information. The command
writes TerraScan trajectory binary file(s) into the active trajectory directory. The name of a
file is determined by the start and end time of the deduced trajectory. When the process has
finished, a message is displayed that informs about the amount of created trajectories.

SETTING EFFECT

First number Number of the first deduced trajectory.
Additional trajectories are numbered
increasingly.

Quality Quality attribute assigned to the trajectories.

System Scanner system assigned to the trajectories.
This may add lever arm corrections to
trajectory positions and thus, effect the
computation of the scanner location at the
moment of measuring a laser point.

Time step Time interval from which the average XYZ of
points is computed and thus, a trajectory
position is derived.

Elevation Altitude of the trajectory:

· Constant - absolute height of the trajectory.

· Dz from points - relative height difference
from the point cloud.

Z Absolute height value of the trajectory. This is
only active if Elevation is set to Constant.

Dz Height difference value of the trajectory from
the point cloud. The value is added to the
average Z value computed from the points in
one Time step. This is only active if Elevation
is set to Dz from points.
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The command sorts the loaded points by time stamp and thus, modifies the points in
memory. If you want to save the modification permanently, save the points into a file.

Import accuracy files

Import accuracy files command imports an output file from post-processing software that
contains accuracy estimates for each trajectory position. The file includes the RMS values for
XYZ positions as well as for heading, roll, and pitch angles. It is connected to the trajectory file
by the time stamps.

TerraScan can import the following accuracy file formats:

· Applanix SMRMSG_*.OUT

· Leica IPAS .SOL

· Riegl .POQ

The RMS values are stored in the binary trajectory files. TerraScan stores only four RMS values
for each trajectory position: x/y, z, heading, roll/pitch.

The information from the accuracy files is used for strip matching computations in TerraMatch
and for drawing trajectories into the CAD file.

To import an accuracy file:

1. Import the trajectory file(s) as described in Import files or Import directory.

2. Select Import accuracy files command from the File pulldown menu.

This opens the Import accuracy files dialog, a standard dialog for opening files.

3. Open the accuracy file delivered by the post-processing software.

This reads the file and connects the RMS values to the trajectory positions. The values are
saved automatically to the binary trajectory files in the active trajectory directory. A dialog
informs about the number of positions for which RMS values are available.

Import directory

Import directory command imports trajectory files into TerraScan. All files of the same format in
a directory are imported. The import process itself works in the same way as described for the
Import files command.

To import all trajectory  files in  a directory:

1. Select Import directory command from the File pulldown menu.

This opens the Import Directory dialog:
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2. Define settings and click OK.

This opens the Import trajectories dialog. Follow the steps of Import files procedure in order
to import the files.

SETTING EFFECT

Directory Folder from which to import files. Click on
the Browse button in order to select a folder
in the Browse for Folder dialog.

Files Defines the extension of files that are
imported. You can use the * character as
placeholder for any file extension or type a
specific extension.

Import files

Import files command is used to import raw trajectories into TerraScan. During the import,
trajectory information is converted into TerraScan trajectory binary files (*.TRJ).

The input files must contain at least time-stamped position and, for most processing tasks,
attitude information. The input files can be:

· text files in one of the implemented ASCII formats, see Supported file formats

· binary files from Applanix or Riegl software, see Supported file formats

· text files in a user-defined file format, see File formats / User trajectory formats

During the import, the software assigns some attributes to the trajectories and can apply
coordinate transformations and/or a time stamp format conversion. Most of the settings
defined in the import process can be changed later for the converted trajectory files by using
the Edit information command or commands from the Tools pulldown menu.

If external accuracy files are available for Riegl POF (*.POQ) and Applanix SBET.OUT
(SMRMSG_*.OUT) trajectory formats, the command reads the information automatically from
the files matching the trajectory files. In this case, Import accuracy files is no longer necessary
in a separate step.

To import a raw trajectory:

1. Select Import trajectories command from the File pulldown menu.
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This opens the Import trajectories dialog, a standard dialog for opening files.

2. Select the raw trajectory file(s) and click Open.

The Import Trajectories dialog opens:

3. Define settings and click OK.

This imports the trajectory file(s) and stores them as TerraScan trajectory binary file(s) into
the active trajectory directory. The name of a file is determined by the start time (and end
time if GPS seconds-of-week) of a trajectory using 0.01 second resolution. The parts in the
file name are separated by underline characters.

SETTING EFFECT

File format File format of the input file(s). This is usually
recognized automatically for implemented
input formats.

Attitude format Format of the INS file. This is only active if
Merge from GPS and INS command is used to
import trajectory information.
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SETTING EFFECT

First number Number assigned to the first trajectory file. If
more than one file is imported, the files are
numbered incrementally.

Group Group number assigned to trajectory file(s).
Groups may indicate, for example, different
flight sessions and can be used by TerraMatch
processes.

Increase by file If on, the group number is automatically
increased for each imported trajectory file.

Quality Quality attribute assigned to trajectory file(s).
Quality may indicate, for example, the
accuracy of trajectories and can be used for
TerraMatch and TerraScan processes.

System Scanner system used for data collection. This
may add lever arm corrections to trajectory
positions and thus, effect the computation of
the scanner location at the moment of
measuring a laser point.

Input projection Projection system of the input data. Click on
the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

Active projection Projection system of the data for processing.
Click on the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

Transform Additional transformation applied to points
during the reading process.

The list contains transformations that are
defined in Coordinate transformations /
Transformations category of TerraScan
Settings.

Coordinates Easting and Northing coordinate values of the
first point found in the point cloud. The first
values are coordinates in the Input projection
system, the second values in the Active
projection system or after an additional



TerraScan User Guide  © 2023 Terrasolid Ltd

686Manage Trajectories > File pulldown menu > Import files

SETTING EFFECT

transformation has been applied. If the
values are the same, no transformation is
applied. 

Input time Format of time stamps in the raw trajectory
file(s): GPS seconds-of-week, GPS standard
time, Unix time, or GPS time.

Store time as Format of time stamps in the converted files:
GPS seconds-of-week, GPS standard time, or
GPS time. If the format is different from the
Input time format, time stamps are
converted.

Survey date Date when the trajectory data was captured.
The format is day/month/year (dd/mm/yyyy).
This is required for the conversion of time
stamps from GPS seconds-of-week to GPS
standard time and is only active if Input time
and Store time as are set accordingly.

Input angles Format of angle values in the raw trajectory
file(s): Degrees, Radians, or TopEye radians.
This is usually set automatically for
implemented input formats.

Adjust heading If on, the software applies a meridian
convergence correction to heading values.
The correction is applied if there is a
projection system change from WGS 84
longitude/latitude coordinates to another
system.

Thin positions If on, intermediate positions are skipped as
long as the trajectory accuracy stays within
the given tolerances.

Xyz tolerance Maximum allowed locational change of the
trajectory caused by thinning. This is only
active if Thin positions is switched on.

Angle tolerance Maximum allowed angular change of the
trajectory caused by thinning. This is only
active if Thin positions is switched on.

Break at long gaps If on, the software splits the trajectory if
there is a gap between consecutive trajectory
positions that is longer than the given Gap
value. The gap value is given in seconds.
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TerraScan and TerraMatch do not need highly accurate trajectory information. It is beneficial
to remove unnecessary positions with Thin positions setting when importing a raw
trajectory. This reduces the amount of memory consumed by trajectory information and
speeds up processes.

Import scanner positions

Import scanner positions command is used to import positions of tripod-mounted scanners into
TerraScan. The scanner positions must be stored in space-delimited text files of the format:

· number easting northing elevation

The number of a scanner position must be a numerical value, no alphanumerical or other
characters are allowed. During the import, the software assigns some attributes to the scanner
positions and can apply coordinate transformations. Most of the settings defined in the import
process can be changed later for the converted trajectory files by using the Edit information
command or commands from the Tools pulldown menu.

To import scanner positions from a text file:

1. Select Import scanner positions command from the File pulldown menu.

This opens the Import scanner positions dialog, a standard dialog for selecting files.

2. Select the text file and click Done.

The Import Scanner Positions dialog opens:

3. Define settings and click OK.

This imports the text file and stores the scanner positions as TerraScan trajectory binary
file(s) into the active trajectory directory. The name of a file is determined by the position
number.
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SETTING EFFECT

File format File format of the input file. This is usually
recognized automatically for implemented
input formats.

Quality Quality attribute assigned to trajectory
file(s). Quality may indicate, for example, the
accuracy of trajectories and can be used for
TerraMatch and TerraScan processes.

System Scanner system used for data collection. This
may add lever arm corrections to trajectory
positions and thus, effect the computation of
the scanner location at the moment of
measuring a laser point. Scanner systems are
defined in the corresponding category of
TerraScan settings.

Input projection Projection system of the input data. Click on
the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

Active projection Projection system of the data for processing.
Click on the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

Transform Additional transformation applied during the
import. The list contains transformations
defined in Coordinate transformations /
Transformations category of TerraScan
Settings.

Merge from GPS and INS

Merge from GPS and INS command creates a trajectory binary file for TerraScan from separate
GPS and INS files. The GPS file contains time stamps and coordinates for the trajectory
positions, while the INS file includes time stamps and attitude angle values for the same
trajectory positions. The software combines the two input files using the time stamps.

The GPS and INS files are usually text files. The format of the files can be defined in File formats
/ User trajectory formats of TerraScan Settings.
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To create a trajectory  from GPS and INS files:

1. Select Merge from GPS and INS command from the File pulldown menu.

This opens the GPS positions files dialog, a standard dialog for opening files.

2. Open the file that contains the positional information.

This opens the INS attitude files dialog, a standard dialog for opening files.

3. Open the file that contains the attitude information.

The Import Trajectories dialog opens.

4. Check the File format and Attitude format. The software tries to determine the format of the
GPS and INS files automatically.

If necessary, select the correct format from the selection lists.

For all other settings of the dialog, see Import files for a description.

5. Define settings and click OK.

The software combines the two input files and creates the binary trajectory file in the active
trajectory directory.

Output positions

Output positions command saves trajectory positions into text files. It creates a separate text
file for each trajectory file. The format of the output files can be defined in File formats / User
trajectory formats of TerraScan Settings. There are also two implemented output formats. The
software writes one line for each trajectory position into an output file.

To create text files for trajectory  positions:

1. (Optional) Select the trajectories in the list of the Trajectories window for which you want to
save positions into text files.

2. Select Output positions command from the File pulldown menu.

This opens the Output Trajectory Positions dialog:
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3. Define settings and click OK.

This writes the trajectory positions into text files.

SETTING EFFECT

Output Trajectories for which text files are created:
All trajectories or Selected only.

Format Text file format, defines which attributes are
stored in the columns of the text file. The list
contains two implemented formats:

· TYXZRPH - time northing easting elevation
roll pitch heading

· TXYZ - time easting northing elevation
and any formats defined for output in File
formats / User trajectory formats.

Time decimals Amount of decimals written for the time
stamps.

Z decimals Amount of decimals written for elevation
values.

HRP decimals Amount of decimals written for attitude
values.

File names Method of naming the output files:

· Prefix and line number - name contains a
prefix and the trajectory number.

· Same as trj file - name of the trajectory
binary file is used.

Directory Folder into which the output files are written.
Click on the Browse button in order to select a
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SETTING EFFECT

folder in the Browse for Folder dialog.

Prefix Text string added in the beginning of an
output file name. This is only active if File
names is set to Prefix and line number.

Extension File name extension.

Set directory

Set directory command is used to define the active trajectory directory. The software writes
trajectory files into this folder during the import process. It loads TerraScan trajectory files from
a folder if it is set as active directory and files do already exist. Usually, this is the first command
you use when you start working with trajectories.

It is good practice to reserve a folder in your project directory structure for storing trajectories
imported into TerraScan. In some cases, it might be advisable to save a new copy of TerraScan
trajectories. Then, you would have multiple trajectory directories in a project and change the
active directory whenever needed in order to access the correct set of trajectory files.

To set the active trajectory  directory:

1. Select Set directory command from the File pulldown menu.

This opens the standard dialog for selecting a folder.

2. Select a folder and click OK.

This sets the active directory to the given folder. TerraScan scans the directory. If there are
TerraScan trajectory files in the folder, it reads the header information from each file into
memory and displays them in the list.
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Tools pulldown menu

Commands in the Tools pulldown menu are used to manipulate trajectories and to create
macros automatically based on trajectory information.

TO USE

Split a trajectory manually Split

Split trajectories automatically at
turnarounds

Cut turnarounds

Split trajectories and keep only parts inside a
polygon

Delete outside polygons

Split trajectories at gaps in laser data Split at laser gaps

Link trajectories to waveform files Link to waveform files

Apply new numbers to trajectories Renumber trajectories

Remove unnecessary trajectory positions Thin positions

Transform trajectory coordinates Transform

Add lever arms to trajectory positions Add lever arm

Adjust trajectory elevations to a geoid model Adjust to geoid

Convert trajectory angle values Convert angles

Convert trajectory time stamps Convert time stamps

Create macros automatically based on
trajectory information

Create macro / For stops and turns

Create macro / For poor accuracy

Create macro / For repeated passes

Correct trajectory drift during a stop Smoothen stops

Draw trajectories into the CAD file Draw into design

Add lever arm

Add lever arm command applies a lever arm to trajectories. A lever arm is expressed by the X,Y,
and Z components of a vector between the original trajectory position and the lever arm-
corrected position.

The direction of the three vector components relative to the trajectory or system movement
direction is as follows:

· X - positive values to the right, negative to the left.

· Y - positive values forward, negative backward.

· Z - positive values up, negative down.
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A lever arm should be applied, if the trajectory has been computed for the IMU and the point
cloud has been generated without considering the lever arm values. Then, the lever arm vector
describes the distance between the IMU and the scanner. However, this is commonly done by
post-processing software for one scanner systems. For multiple scanner systems, the Scanner
systems definition in TerraScan Settings defines the lever arms of the different scanners which
can be applied in the import process of trajectories. See Import files command for more
information.

An application example for applying lever arms to active trajectories is to project the trajectory
of a MMS survey to the center of a rail track. In this case, the lever arm vector describes the
distance between the IMU (trajectory location) and the center between the wheels of the
vehicle carrying the system along the tracks.

To add a lever arm to trajectories:

1. (Optional) Select the trajectory file(s) you want to modify in the Trajectories window.

2. Select Add lever arm command from the Tools pulldown menu.

This opens the Add Lever Arm to Trajectories dialog:

3. Define settings and click OK.

This modifies the trajectory positions and updates the trajectory files in the active trajectory
directory. An information dialog shows the number of the trajectories effected by the
process.

SETTING EFFECT

Apply to Trajectories effected by the process: All
trajectories or Selected only.

Lever X X component of the lever arm vector.

Lever Y Y component of the lever arm vector.

Lever Z Z component of the lever arm vector.
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Adjust to geoid

Adjust to geoid command applies an elevation correction to trajectory files. The command is
used, for example, to transform the WGS84-based ellipsoidal elevation values of a raw
trajectory file to a local height model. TerraScan implements a number of national, continental
or global geoid models. The corresponding files are provided with the installation of a bundle
package (Terrasolid installation bundle for Spatix or Microstation) and stored in the \GEOID
folder of the Terra installation directory.

Alternatively, the input model for geoid adjustment must be provided in one of the following
formats:

· Points from file - text file containing space-delimited X Y dZ- points.

· TerraModeler surface - triangulated surface model created from X Y dZ - points. The surface
model in TerraModeler has the advantage that you can visualize the shape of the adjustment
model.

· Selected linear chain - linear element of which the vertices represent the X Y dZ - points.

XY are the easting and northing coordinates of the geoid model points, dZ is the elevation
difference between ellipsoidal and local heights at the location of each geoid model point.
Intermediate adjustment values of the model are derived by aerial (text file or surface model
as input) or linear (linear element as input) interpolation between the known geoid model
points.

You can find more detailed information about elevation adjustment in Section Geoid
adjustment.

To adjust trajectories to a geoid model:

1. (Optional) Load a geoid model into TerraModeler.

2. (Optional) Select trajectory file(s) to adjust.

3. Select Adjust to geoid command from the Tools pulldown menu.

This opens the Adjust Trajectories to Geoid dialog:

4. Define settings and click OK.
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This applies the elevation adjustment to all or selected trajectories. The modification is
saved to the trajectory binary files in the active trajectory directory. An information dialog
shows the minimum and maximum values of the adjustment.

SETTING EFFECT

Adjustment Direction of the elevation adjustment:

· Ellipsoidal to orthometric - adjustment from
ellipsoidal to orthometric height values.
This is the normal way of an geoid
adjustment.

· Orthometric to ellipsoidal - adjustment
from orthometric to ellipsoidal height
values. This is the reverse way of an geoid
adjustment.

Process Trajectories to adjust:

· All trajectories - all trajectories in the list.

· Selected only - selected trajectories only.

Dz model Source file that provides the geoid correction
model:

· Points from file - text file.

· Selected linear chain - linear element
selected in the CAD file.

· <name> - name of a geoid model loaded as
surface in TerraModeler.

· <implemented model> - name of an
implemented geoid model.

File name Name of the geoid text file. This is only active
if Dz model is set to Points from file.

Extend Distance from a selected linear element by
which the linear chain is extended for
elevation value corrections. This is only active
if Dz model is set to Selected linear chain.

Projection Projection system of the geoid model. This is
only active if Dz model is set to any
implemented geoid model.

Convert angles

Convert angles command lets you apply a mathematical equation to the attitude angles
heading, pitch, and roll of each trajectory position. The current angle value can be accessed by
using constants H (heading), R (roll) and P (pitch). Thus, the command can also be used to
exchange angle values.
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To convert angles of trajectory  positions:

1. (Optional) Select trajectory file(s) for which to manipulate angles.

2. Select Convert angles command from the Tools pulldown menu.

This opens the Convert Trajectory Angles dialog:

3. Define equations and click OK.

This computes the new values for the orientation angles. The modification is saved to the
trajectory binary files in the active trajectory directory. An information dialog shows the
number of effected trajectories.

SETTING EFFECT

Apply to Trajectories for which the computation of new
angles is applied:

· All trajectories - all trajectories in the list.

· Selected only - selected trajectories only.

Heading Equation for modifying the heading angle.

Roll Equation for modifying the roll angle.

Pitch Equation for modifying the pitch angle.

Convert time stamps

Convert time stamps command can be used to convert the format of time stamps. Supported
conversions are:

INPUT FORMAT CONVERTED FORMAT

GPS seconds-of-week GPS standard time

GPS time

GPS standard time GPS seconds-of-week

GPS time
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INPUT FORMAT CONVERTED FORMAT

GPS time GPS seconds-of-week

GPS standard time

GPS seconds-of-day GPS seconds-of-week

GPS standard time

GPS time

Unix time GPS seconds-of-week

GPS standard time

GPS time

UTC seconds-of-day GPS seconds-of-week

GPS standard time

GPS time

UTC seconds-of-week GPS seconds-of-week

GPS standard time

GPS time

The conversion is necessary, for example, if data collected in several weeks is processed
together in one project. Then, GPS seconds-of-week time stamps result in repeated values and
GPS standard time must be used in order to provide unique time stamps for each trajectory
position. This is a requirement for many processes that rely on trajectory information. Some
post-processing software generates data with Unix or UTC seconds-of-day time stamps. They
must be converted into another GPS time format as well.

It is essential that time stamps of trajectories and point cloud data are stored in the same GPS
time format.

To convert time stamps:

1. (Optional) Select trajectory file(s) for which to manipulate time stamps.

2. Select Convert time stamps command from the Tools pulldown menu.

This opens the Convert Trajectory Time dialog:
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3. Define settings and click OK.

This converts the trajectory time stamps to the new format. The modification is saved to the
trajectory binary files in the active trajectory directory. An information dialog shows the
number of effected trajectories.

SETTING EFFECT

Apply to Trajectories for which the conversion of time
stamps is applied:

· All trajectories - all trajectories in the list.

· Selected only - selected trajectories only.

Method Defines the computation method of
modifying time stamps:

· Source and target system - conversion from
one time format to another.

· Multiply and add constant - constant value
by which time stamps are multiplied or that
is added to current time stamps.

Current values Original time stamp format of the trajectory
positions. This is only active if Method is set
to Source and target system.

Convert to Target time stamp format. This is only active if
Method is set to Source and target system.

Survey date Date when the trajectory data was captured.
The format is day/month/year (dd/mm/yyyy).
This is only active for the conversion from GPS
seconds-of-week or UTC seconds-of-
day/week to GPS standard time or GPS time.

Multiply by Factor by which current time stamps are
multiplied. This is only active if Method is set
to Multiply and add constant.
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SETTING EFFECT

Add Value to add to GPS time stamps when
converted from UTC seconds-of-day time
stamps. Refers to the leap-seconds that by
which GPS time is ahead of UTC time. This is
only active for the conversion from UTC
seconds-of-day/week to any GPS time format.
Value to add to current time stamps if Method
is set to Multiply and add constant.

Create macro / For poor accuracy

Create macro / For poor accuracy command creates a TerraScan macro automatically. The macro
is used to classify points that were collected from locations of bad trajectory accuracy.

Especially in MLS data sets, there might be places of poor trajectory accuracy caused, for
example, by the lack of GPS signals. The command can be used to identify such locations based
on trajectory position attributes. The process uses accuracy values that are assigned to
trajectory positions. See Import accuracy files for more information. If the search finds poor
accuracy locations, the resulting macro contains steps that classify points based on time
intervals.

To create a macro for poor accuracy:

1. Select Create macro / For poor accuracy command from the Tools pulldown menu.

This opens the Macro for Poor Accuracy dialog:

2. Define settings and click OK.

The software computes poor accuracy time ranges from the trajectory positions and creates a
TerraScan macro. An information dialog shows the number of added time intervals.
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The macro can be saved and applied to the laser points. See Chapter Macros for more
information about macros in TerraScan.

SETTING EFFECT

From class Point class(es) from which to classify points.
The list contains the active point classes in
TerraScan.

To class Target class for points collected during poor
trajectory accuracy. The list contains the
active point classes in TerraScan.

Xy accuracy If the xy accuracy value is bigger than the
given value, the trajectory position is added
to the macro.

Z accuracy If the z accuracy value is bigger than the given
value, the trajectory position is added to the
macro.

Heading accuracy If the heading accuracy value is bigger than
the given value, the trajectory position is
added to the poor accuracy macro.

Roll/pitch accuracy If the roll/pitch accuracy value is bigger than
the given value, the trajectory position is
added to the macro.

Roll or pitch If the value of roll or pitch angle is bigger
than the given value, the trajectory position
is added to the macro.

Buffer Number of seconds that is added to each
poor accuracy time interval. The seconds are
added at the beginning and in the end of a
time interval.

Create macro / For repeated passes

Create macro / For repeated passes command creates a TerraScan macro automatically. The
macro is used to classify points collected from the same location in several strips.

Especially in MLS data sets of roads inside urban areas, there might be places where data was
collected several times during a survey. The command can be used to identify such locations
based on trajectory position attributes. The process can make use of accuracy values that are
assigned to trajectory positions. See Import accuracy files for more information. If the search
finds repeated pass locations, the resulting macro contains steps that classify points based on
time intervals.
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To create a macro for repeated passes:

1. Select Create macro / For repeated passes command from the Tools pulldown menu.

This opens the Macro for Repeated Passes dialog:

2. Define settings and click OK.

The software computes time ranges of repeated passes from the trajectory positions and
creates a TerraScan macro. An information dialog shows the number of added time intervals.

The macro can be saved and applied to the laser points. See Chapter Macros for more
information about macros in TerraScan.

SETTING EFFECT

From class Point class(es) from which to classify points.
The list contains the active point classes in
TerraScan.

To class Target class for points collected in repeated
passes. The list contains the active point
classes in TerraScan.

Keep pass Defines which data is kept in the original class:

· First - data of the first pass.

· Last - data of the last pass.

· Best xyz - data of any pass with the best
positional accuracy.

· Best hrp - data of any pass with the best
attitude accuracy.

Minimum interval Minimum time interval within which the
software searches for repeated pass points.

Buffer Number of seconds that is added to each
repeated pass time interval. The seconds are
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SETTING EFFECT

added at the beginning and in the end of a
time interval.

Xyz within Defines the maximum distance between
repeated passes. If passes are less than the
given distance apart from each other, they are
considered repeated passes.

Heading within Defines the maximum angular difference
between repeated passes. If the heading
angle between passes is smaller than the
given value, they are considered as repeated
passes.

Create macro / For stops and turns

Create macro / For stops and turns command creates a TerraScan macro automatically. The
macro is used to classify points of an MLS data set that were collected during stops or in sharp
turns.

Since stops and turns cause a slowing-down of the vehicles speed, the scanner collects
significantly more data than at normal operating speed. The command can be used to identify
locations of stops and turns based on trajectory position attributes. If the search for stop and
turns finds such locations, the resulting macro contains steps that classify points based on time
intervals.

To create a macro for stops and turns:

1. Select Create macro / For stops and turns command from the Tools pulldown menu.

This opens the Macro for Stops and Turns dialog:
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2. Define settings and click OK.

The software computes stops and turns from the trajectory positions and creates a TerraScan
macro. An information dialog shows the number of added time intervals.

The macro can be saved and applied to the laser points. See Chapter Macros for more
information about macros in TerraScan.

SETTING EFFECT

Classify stops If on, the software searches for stops.

From class Point class(es) from which to classify points.
The list contains the active point classes in
TerraScan.

To class Target class for points collected during stops.
The list contains the active point classes in
TerraScan.

Buffer Number of seconds that is added to each stop
time interval. The seconds are added at the
beginning and in the end of a stop.

Classify turns If on, the software searches for turns.

Left turn from Point class(es) from which to classify points
collected during turns to the left. The list
contains the active point classes in TerraScan.

Left turn to Target class for points collected during a
turns to the left. The list contains the active
point classes in TerraScan.
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SETTING EFFECT

Right turn from Point class(es) from which to classify points
collected during turns to the right. The list
contains the active point classes in TerraScan.

Left turn to Target class for points collected during a
turns to the right. The list contains the active
point classes in TerraScan.

Heading change Minimum change in heading angle that
defines a turn. As long as the heading angle
between consecutive trajectory positions
changes more than the given degree value
per second, the change is considered a turn
and the respective time stamps are added to
the macro step.

Buffer Number of seconds that is added to each turn
time interval. The seconds are added at the
beginning and in the end of a turn.

Cut turnarounds

Cut turnarounds command splits a trajectory into several trajectories that do not overlap
themselves anymore. It does not remove any parts of the original trajectory. The following
figure illustrates the method:

Original trajectory Resulting trajectories

Split condition

The method does not require point cloud information since the logic uses the line shape and
turn angles of trajectories. A trajectory is cut if the minimum length of a trajectory part is at
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least 5 times longer than the shortest distance between two neighboring trajectory lines. This
split condition is illustrated in the third figure above.

To cut trajectories at turnarounds:

1. (Optional) Select the trajectory file(s) you want to cut in the Trajectories window.

2. Select Cut turnarounds command from the Tools pulldown menu.

This opens the Cut Turnarounds dialog:

3. Define settings and click OK.

This splits trajectories whenever there is a close to 180 degree turn. The application deletes
the old trajectory file(s) and creates new files in the active trajectory directory.

SETTING EFFECT

Apply to Trajectories effected by the process: All
trajectories or Selected only.

First number Number of the first additional trajectory that
is created by the process.

Delete by polygons

Delete by polygons command cuts trajectories at the boundary of a shape element. It keeps
only trajectory lines inside or outside the shape and deletes all other parts.

This is often the easiest way to split trajectories of aerial projects. The figure below illustrates
the method:
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Original trajectory Resulting trajectories using Delete =
outside polygons.

To delete trajectories by  polygons:

1. Use CAD tools to draw polygon(s) around areas where you want to keep or delete trajectory
information. Select the polygon(s).

2. (Optional) Select the trajectory file(s) you want to cut in the Trajectories window.

3. Select Delete by polygons command from the Tools pulldown menu.

This opens the Delete by Polygons dialog:

4. Define settings and click OK.

This deletes all trajectory parts inside or outside the selected polygon(s). The application
deletes the old trajectory file(s) and creates new files in the active trajectory directory. An
information dialog shows the result of the process.

SETTING EFFECT

Delete Determines which part of a trajectory is
deleted: Inside polygons or Outside
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SETTING EFFECT

polygons.

Apply to Trajectories effected by the process: All
trajectories or Selected only.

First number Number of the first additional trajectory that
is created by the process.

Draw into design

Draw into design command draws the trajectories as line elements into the CAD file. The line
elements are drawn on the active level using the active line width and line style settings of the
CAD file. The color(s) of the line elements are defined by the command’s settings.

The command can use accuracy values that are assigned to trajectory positions. See Import
accuracy files for more information.

The line elements are drawn by placing a vertex for each trajectory position. The lines can by
simplified by removing positions within a given tolerance.

You can apply lever arms to trajectories when drawing them into the CAD file. This is useful, for
example, if a centerline or other line elements along rails are derived from the trajectories of
an MLS survey. The lever arm values are only applied to the line elements drawn into the CAD
file but do not effect the original trajectory files.

To draw trajectory  lines into the CAD file:

1. (Optional) Select trajectory file(s) to draw.

2. Select Draw into design command from the Tools pulldown menu.

This opens the Draw trajectories dialog:
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3. Define settings.

SETTING EFFECT

Draw Trajectories that are drawn:

· All trajectories - all trajectories in the list.

· Selected only - selected trajectories only.

Color by Determines how the color is chosen for
drawing a trajectory line:

· Active color - the active color of the CAD file
is used.

· Trajectory number - the color whose
number in the active color table of the CAD
file corresponds to the trajectory number is
used.

· Xy accuracy - x/y accuracy values are applied
to a color scheme.

· Z accuracy - z accuracy values are applied to
a color scheme.

· H accuracy - heading accuracy values are
applied to a color scheme.

· Rp accuracy - roll/pitch accuracy values are
applied to a color scheme.

· Travel speed - speed of the system.

Colors Button to open the coloring scheme for
accuracy-based coloring methods.

Thin positions If on, intermediate trajectory positions are
skipped when the line is drawn as long as the
line accuracy stays within the given positional
Accuracy tolerance.
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SETTING EFFECT

Add lever arm If on, a lever arm correction is applied to the
lines that are drawn in the CAD file. This does
not effect the trajectory file itself.

Lever X X component of the lever arm vector. This is
only active, if Add lever arm is switched on.

Lever Y Y component of the lever arm vector. This is
only active, if Add lever arm is switched on.

Lever Z Z component of the lever arm vector. This is
only active, if Add lever arm is switched on.

4. If the trajectory is drawn with an accuracy-based coloring option, click on the Colors button.

This opens the Coloring Scheme dialog, the TerraScan dialog for 256 Colors:

5. (Optional) Define your own coloring scheme for drawing trajectories.

6. Click on the Auto fit button in order to fit the colors to RMS value ranges.

7. Click OK to the Coloring scheme dialog.

8. Click OK to the Draw trajectories dialog.

This draws the line element(s) into the CAD file.

You can undo the drawing of trajectories by using the Undo command of the CAD platform.
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Link to waveform files
Not UAV

Link to waveform files command links waveform files to trajectories. This is required for any
processing tasks based on waveform data. See Chapter Waveform Processing for more
information. You can check if a waveform file is linked to a trajectory in the Trajectory
information dialog that is opened by the Edit information command.

In order to link a waveform file to a trajectory, select the LAS file even if the waveform data is
stored in WDP files. If waveform files are linked with the Link to waveform files command, the
software creates index files for waveform files. Index files can speed up further processing
steps that require waveform information. However, they are not necessarily required.

TerraScan Lite and TerraScan UAV do not provide any waveform processing capabilities.

To link trajectories to waveform files:

1. (Optional) Select the trajectory file(s) you want to link in the Trajectories window.

2. Select Link to waveform files command from the Tools pulldown menu.

This opens the Link to Waveform Files dialog:

3. Click on the Add files button.

This opens the Waveform files dialog, a standard dialog for opening files.

4. Select the waveform file(s) and click Open.

This adds the file(s) to the list of waveform files in the Link to waveform files dialog.

5. Click OK.
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This links trajectories to the waveform files and updates the trajectory files in the active
trajectory directory. An information dialog shows the amount of trajectories that are
effected by the process.

SETTING EFFECT

Apply to Trajectories linked to waveform files: All
trajectories or Selected only.

Add files Opens a dialog for selecting waveform files.

Remove Removes a selected waveform file from the
list.

Renumber trajectories

Renumber trajectories command applies a new numbering to trajectories. It assigns increasing
numbers to the trajectories according to their order in the Trajectories window.

Renumbering can be useful, for example after a new sorting has been applied to the active
trajectories using the Sort command.

To renumber trajectories:

1. (Optional) Select the trajectory file(s) you want to sort in the Trajectories window.

2. Select Renumber trajectories command from the Tools pulldown menu.

This opens the Renumber Trajectories dialog:

3. Define settings and click OK.

This assigns new numbers to the trajectories and updates the trajectory files in the active
trajectory directory. An information dialog shows the number of the trajectories effected by
the process.

SETTING EFFECT

Apply to Trajectories effected by the process: All
trajectories or Selected only.

First number Number of the first trajectory in the list.
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Smoothen stops

Smoothen stops command detects stops that occurred during a survey drive and creates a
correction for trajectory drift at stop locations. The process looks into trajectory information
and finds stop intervals. Then, it computes a smooth curve through each stop interval. The
correction is the difference between the smooth curve and the actual trajectory positions.

The corrections are stored in a .TMS file and can be applied by using the Apply correction macro
action or the Apply corrections tool of TerraMatch.

At the moment, the software stores only the elevation correction in the correction file. The
correction of a horizontal drift is difficult to compute and may not provide a valid improvement
for the data.

To create a corrections file for trajectory  drift at stop locations:

1. Select Smoothen stops command from the Tools pulldown menu.

This opens the Smoothen Stops dialog:

2. Define settings and click OK.

SETTING EFFECT

Before stop Number of seconds before a stop that is
included in the time interval for computing
the corrections.

After stop Number of seconds after a stop that is
included in the time interval for computing
the corrections.

The process starts. If the software does not find any stops in the active trajectories, an
information dialog is displayed.

If stops are found, the corrections are computed and another Smoothen Stops dialog opens:

https://terrasolid.com/guides/tmatch/apply-correction.html
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The dialog shows for each stop the trajectory line number, the start time, duration in
seconds, XY and Z drift values, and the number of seconds before and after the stop time that
are included in the correction computation.

You can switch on/off the correction for stop locations by toggling the cross on or off in the
field before the line number. If the cross is off, the correction is not stored in the correction
file.

To show the location of a stop interval, select a line in the Smoothen Stops dialog. Click on
the Show location button and move the mouse pointer into a view. This highlights the
selected interval location with a cross. Place a data click inside the view in order to center
the location in the view.

3. (Optional) Click on the Edit button to open the Edit Stop dialog:

You can define new values for the time interval that is used to compute correction values.

4. Click on the Save correction button.

This opens the Correction file window, a standard dialog for saving files.

5. Define a storage location and name for the correction file and click Save.

Split

Split command can be used to split a trajectory manually into smaller parts. The command lets
you define the location for splitting the trajectory with a data click. This can be used if the
automatic methods for splitting trajectories do not apply or lead to the requested result.
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To split a  trajectory:

1. Select Split command from the Tools pulldown menu.

If the mouse pointer is moved inside a CAD file view, the closest trajectory is highlighted.

2. Identify the trajectory to split with a data click.

A red cross shows dynamically the split location.

3. Define the position at which to split the trajectory with a data click.

This splits the trajectory at the given position. The application deletes the old trajectory file
and creates two new files in the active trajectory directory.

There are also automatic ways to split a trajectory. See Cut turnarounds, Delete by polygons,
and Split at laser gaps commands for more information.

Split at laser gaps

Split at laser gaps command cuts trajectories if there is a gap in laser data. It removes part of
trajectories where there is no laser data available.

The command requires points or a project loaded into TerraScan. It is best suited, if the scanner
was turned off during the survey or if only a part of captured data is processed in a TerraScan
project.

To split trajectories at laser gaps:

1. (Optional) Select the trajectory file(s) you want to cut in the Trajectories window.

2. Select Split at laser gaps command from the Tools pulldown menu.

This opens the Split at Laser Gaps dialog:

3. Define settings and click OK.

This deletes all trajectory parts outside the area covered by laser data. The application
deletes the old trajectory file(s) and creates new files in the active trajectory directory. An
information dialog shows the result of the process.
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SETTING EFFECT

Use Source data used for detecting gaps in a point
cloud:

· Loaded points - points loaded into
TerraScan.

· Active project - points referenced by the
active TerraScan project. Not UAV

Apply to Trajectories effected by the process: All
trajectories or Selected only.

Gap Minimum time interval that defines a gap in
the laser data. If there is data missing for a
longer time, the trajectory is split.

Sort and renumber If on, the trajectories are sorted by time and
renumbered after splitting.

Thin positions

Thin positions command removes positions from trajectories. The process removes positions as
long as the trajectory line stays within given accuracy tolerance values.

To thin positions of trajectories:

1. (Optional) Select the trajectory file(s) you want to thin in the Trajectories window.

2. Select Thin positions command from the Tools pulldown menu.

This opens the Thin Trajectory Positions dialog:

3. Define settings and click OK.

This removes unnecessary trajectory positions and updates the trajectory files in the active
trajectory directory. An information dialog shows the number of the trajectories effected by
the process.
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SETTING EFFECT

Apply to Trajectories effected by the process: All
trajectories or Selected only.

Keep position every Time interval between two trajectory
positions to keep.

Xyz tolerance Maximum allowed locational change of the
trajectory caused by thinning.

Angle tolerance Maximum allowed angular change of the
trajectory caused by thinning.

Thinning can also be applied to a trajectory in the import process. See Import files command
for more information.

Transform

Transform command applies a transformation to the coordinates of a trajectory. The
transformation can be, for example, a change of the projections system or any other
transformation defined in Coordinate transformations / Transformations category of TerraScan
Settings.

You can find more detailed information about transformations in Chapter Coordinate
Transformations.

To transform a trajectory:

1. (Optional) Select trajectory file(s) to transform.

2. Select Transform command from the Tools pulldown menu.

This opens the Transform Trajectories dialog:

3. Define settings and click OK.
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The coordinates of the trajectory are changed. The modification is saved to the trajectory
binary files in the active trajectory directory. An information dialog shows the number of
effected trajectories.

SETTING EFFECT

Apply to Trajectories to transform:

· All trajectories - all trajectories in the list.

· Selected only - selected trajectories only.

Transform Type of transformation to apply:

· Projection change - from one implemented
projection system to another.

· <name> - name of a transformation defined
in Coordinate transformations /
Transformations category of TerraScan
Settings.

Adjust heading If on, the software applies a meridian
convergence correction to heading values. The
correction is applied if there is a projection
system change from WGS 84
longitude/latitude coordinates to another
system.

From system Source projection system. Click on the >>
button to open the Browse for Projection
System dialog. The dialog provides a search
option for projection systems as well as a list
of all implemented systems. In addition, any
user-defined projection systems are included
in the list. This is only active if Transform is set
to Projection change.

To system Target projection system. Click on the >>
button to open the Browse for Projection
System dialog. The dialog provides a search
option for projection systems as well as a list
of all implemented systems. In addition, any
user-defined projection systems are included
in the list. This is only active if Transform is set
to Projection change.
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Trajectory pulldown menu

Commands from the Trajectory pulldown menu are used to modify information of a trajectory,
to assign a new trajectory number, to delete trajectory files, and to view the positions of a
trajectory.

TO USE COMMAND

Modify trajectory information Edit information

Assign a number by identifying a laser point Assign number

Set accuracy estimate values for trajectory
positions

Set accuracy

Delete selected trajectories Delete

View positions of a selected trajectory View positions

The commands of the pulldown menu are only available if at least one trajectory is selected in
the Trajectories window.

Assign number

Assign number command lets you modify the trajectory number based on laser points loaded in
TerraScan. It assigns the line number of the laser point closest to a data click as trajectory
number to the selected trajectory.

The command applies the number only to one trajectory at a time. If several trajectories are
selected, only the first one is effected by the number assignment.

To assign a trajectory  number from laser points:

1. Load laser data into TerraScan.

2. Select a trajectory in the list of the Trajectories window.

3. Select Assign number command from the Trajectory pulldown menu.

4. Place a data click inside a view.

This assigns the line number of the point closest to the data click location as number to the
trajectory.

Delete

Delete command deletes one or more selected trajectory files. The entries for the files are
removed from the list and the binary files are deleted from the hard disc.
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To delete trajectories:

1. Select the trajectory file(s) in the list of the Trajectories window.

2. Select Delete command from the Trajectory pulldown menu.

A dialog asks to confirm the removal of the file(s).

3. Click Yes in order to delete the selected file(s).

A dialog informs about the deletion process.

Edit information

Edit information command opens a dialog that contains basic information and attributes stored
for a selected trajectory. The attributes can be modified. Modifications are immediately stored
in the binary trajectory file.

In addition, up to two video files and a waveform file can be linked to a trajectory. The video
file settings are not actively used by TerraScan but required for the compatibility of trajectories
with TerraPhoto.

The Waveform field may contain a link to a single waveform file, for example, if one LAS or
WDP file contains data of one line (trajectory). Alternatively, a file name with wild-cards can be
used to establish a link between one trajectory and several waveform files. Example:
"Laser_20160308_*.las" or "Laser_20160308_FL??_???.las" can be used to link waveform files
with names "Laser_20160308_FL20_123.las" and "Laser_20160308_FL21_124.las" to one
trajectory.

In order to link a waveform file to a trajectory, select the LAS file even if the waveform data is
stored in WDP files. Only one file name in the field is allowed. If several waveform files need
to be linked, select one file and then, replace the varying part(s) of the file name with wild-
cards. If waveform files are linked in the Trajectory information dialog, no index files for
waveform files are created.

TerraScan Lite and TerraScan UAV do not provide any waveform processing capabilities.

To modify  trajectory  information:

1. Select a trajectory in the list of the Trajectories window.

2. Select Edit information command from the Trajectory pulldown menu.

This opens the Trajectory information dialog:
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3. Define settings and click OK.

This modifies the information in the header of the corresponding .TRJ file.

SETTING EFFECT

Number Number of the trajectory.

Group Group number of the trajectory. Group
numbers may indicate, for example,
different flight sessions and are used for
TerraMatch processes.

Quality Quality attribute of the trajectory. Quality
may indicate, for example, the accuracy of
trajectories and can be used for TerraMatch
and TerraScan processes.

System Scanner system used for data collection. This
determines lever arm corrections that are
added to trajectory positions and thus,
effects the computation of the scanner
location at the moment of measuring a laser
point.

Description Text that describes the trajectory. By default,
the name of the raw trajectory file is used as
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SETTING EFFECT

descriptive text.

Video 1 Primary video file linked to the trajectory.
This is not actively used by TerraScan but
required for the compatibility of trajectories
with TerraPhoto.

Start time GPS time stamp of the start position of Video
1.

End time GPS time stamp of the end position of Video
1.

Video 2 Secondary video file linked to the trajectory.
This is not actively used by TerraScan but
required for the compatibility of trajectories
with TerraPhoto.

Start time GPS time stamp of the start position of Video
2.

End time GPS time stamp of the end position of Video
2.

Waveform Waveform data file linked to the trajectory.
See Link to waveform files command and
Chapter Waveform Processing for more
information.

If you select several trajectories in the Trajectories window, the Edit information command
opens the Edit several trajectories dialog. This dialog allows you to modify only settings
which may apply for several trajectories, such as Group, Quality, and System settings.

Set accuracy

Set accuracy command lets you define accuracy estimates for trajectory positions. The selected
estimate value is applied to all positions of one or more selected trajectories. The command
can be used to set reasonable accuracy estimates for trajectories, if no system-based accuracy
files are available. Alternatively, a minimum accuracy estimate value can be enforced. The
accuracy estimates are treated like RMS values. A list of values is provided in the command’s
dialog from which you can select the best estimate.

If accuracy estimates are available from the post-processing software, the files can be imported
by using the Import accuracy files command.

The accuracy estimate values are stored in the binary trajectory files. TerraScan stores only four
values for each trajectory position: x/y, z, heading, roll/pitch.
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The information from the accuracy files is used for strip matching computations in TerraMatch
and for drawing trajectories into the CAD file.

To set accuracy values for trajectory  positions:

1. Select one or more trajectories in the list of the Trajectories window.

2. Select Set accuracy command from the Trajectory pulldown menu.

This opens the Set Trajectory Accuracy dialog:

3. Switch on accuracy estimates that you want to define and select a value from the list.

4. Click OK.

This assigns the values to the trajectory positions and saves the .TRJ file(s). An information
dialog shows the number of effected trajectories.

SETTING EFFECT

Mode Determines whether a fixed accuracy estimate
is set or a minimum value is enforced:

· Assign accuracy - sets a fixed accuracy
estimate value for all trajectory positions.

· Enforce minimum - sets an accuracy
estimate value for a trajectory position if
the original value is smaller than the new
given value.

Accuracy xy If on, accuracy estimates for xy positions are
set.

Accuracy z If on, accuracy estimates for z positions are
set.

Accuracy h If on, accuracy estimates for heading attitude
are set.

Accuracy rp If on, accuracy estimates for roll and pitch
attitude are set.
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View positions

View positions command can be used to display the single positions of a trajectory file. The
command opens a window that shows the list of positions and for each position the attributes
stored in the trajectory file. This may include the time stamp, coordinate values, heading, roll,
and pitch values, travel speed as well as RMS values.

To view trajectory  positions:

1. Select a trajectory file in the list of the Trajectories window.

2. Select View positions command from the Trajectory pulldown menu.

This opens the View Trajectory Positions dialog which contains the list of trajectory
positions:

To show the location of a trajectory position, select a line in the list of positions. Click on the
Show location button and move the mouse pointer into a view. This highlights the selected
position with a cross. Place a data click inside a view in order to center the display at the
selected position.

To identify a position, click on the Identify button and place a data click close to a trajectory
in a view. This selects the line of the position closest to the data click in the View trajectory
positions dialog.

You can set the accuracy estimates (RMS values) for one or more selected trajectory positions
by using the Set accuracy button. The options for defining an accuracy estimate are the same
as for the Set accuracy command.
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View pulldown menu

Commands of the View pulldown menu are used to sort trajectory files in the list and to select
attribute fields for being displayed in the window.

TO USE COMMAND

Sort trajectories according to specific criteria Sort

Select fields to be displayed in the window Fields

Fields

Fields command lets you select which attributes are displayed for each trajectory in the
Trajectories window.

To select visib le fields:

1. Select Fields command from the View pulldown menu.

This opens the View Trajectory Fields dialog:

2. Select fields and click OK.

FIELD DESCRIPTION

Number Trajectory number.

Group Group number of the trajectory.

Quality Attribute that indicates the quality of the
trajectory.

Scanner system Scanner system assigned to the trajectory.

File Name of the trajectory binary file on the hard
disk.

Description Description of the trajectory given in the
Trajectory information dialog.
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FIELD DESCRIPTION

Vertical video Name of the video file defined as Video 1 in
the Trajectory information dialog. See Edit
information command.

Forward video Name of the video file defined as Video 2 in
the Trajectory information dialog. See Edit
information command.

Waveform file Path and name of a waveform file linked to
the trajectory.

Start time Time stamp at the start of the trajectory.

End time Time stamp at the end of the trajectory.

Duration Length of the trajectory in seconds.

Sort

Sort command defines the display order of trajectory files in the list. The trajectories can be
sorted by up to two attributes.

To sort trajectory  files:

1. Select Sort command from the View pulldown menu.

This opens the Sort trajectories dialog:

2. Select a Primary key and Secondary key for sorting.

3. Click OK.

The display order of the trajectory files in the list is changed according to the settings.

SETTING EFFECT

Primary key Attribute used first for sorting the trajectories:

· Number - increasing trajectory numbers.

· Group - increasing group numbers.

· Time ascending - increasing time stamps.

· Time descending - increasing time stamps.
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SETTING EFFECT

· Duration - increasing trajectory duration.

Secondary key Attribute used second for sorting the images:

· See Primary key attributes.

· None - no secondary key is used for sorting.



TerraScan User Guide  © 2023 Terrasolid Ltd

727Fit Geometry Components >   >  

Fit Geometry Components
Preliminary draft

Note Lite, Not UAV, Not Spatix

This is an introduction to the Fit Geometry Components tool in TerraScan. The tool can be use to
find a road geometry by fitting its components to the points found in a MicroStation line string.
The application can generate horizontal and vertical road geometries. Normally, the horizontal
geometry is solved first. The work on the vertical geometry only starts after the horizontal
geometry has been finalized. A normal overall workflow in this case is:

1. Create a filtered survey vector.

2. Find preliminary horizontal geometry.

3. Modify the horizontal geometry.

4. Find preliminary vertical geometry.

5. Modify the vertical geometry.

6. Export your work.

However, if the horizontal geometry is not required, it is possible to start working on the
vertical geometry once the filtered survey vector has been created. In this case the workflow is:

1. Create a filtered survey vector.

2. Find preliminary vertical geometry.

3. Modify the vertical geometry.

4. Export your work.

The modifications to the geometry components are stored in the CAD file. The saved
components can be used to continue working on the geometry at a later point of time. The
application also supports saving the geometry components into a text file in a proprietary file
format. The vertical and horizontal geometries are saved into separate files. The application can
then import geometries from files that are in its proprietary file format. Finally, the geometry
components can be exported into selected exchange formats, such as simplified LandXML
among others.

Content of this Chapter

This Chapter describes the recommended steps for producing the horizontal and vertical
geometries. The first step in the generation of a road geometry is the filtering of the input
survey vector which is described in Section Survey / Filter survey vector.
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The generation of a horizontal geometry and the options for working with its components are
discussed in Sections Horizontal / Create geometry and Modifying the horizontal geometry.

The generation of a vertical geometry and commands for working with its components are
introduced in Sections Vertical / Create geometry / From horizontal components, Create
geometry / From line string, and Modifying the vertical geometry. The commands for modifying
vertical geometry components appear identical to the ones used for horizontal geometry. The
main difference is:

· the horizontal geometry is compared to the filtered survey vector.

· the vertical geometry is generated using the elevation values of the filtered survey vector
and the station values calculated using the horizontal geometry.

Section Activate an existing geometry shows how to continue with previously created
geometries.

Section Tools for component modification provides detailed description of the commands for
modifying the geometry components. Finally, all other commands included in the component
fitting application are introduced in Section Other commands.
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User settings

You can modify the colors and levels which are used by Fit Geometry Components in
Component fitting / Colors category and Component fitting / Levels category of TerraScan
Settings.

The initial values for the levels are:

FEATURE LEVEL

Horizontal geometry 23

Vertical geometry 24

3D representation of the geometry 25

Vertical geometry frame 20

Filtered survey data 21

Internal vertical line string 22

The levels will be automatically created if they do not exist in the CAD file.

You can adjust settings for line weights and styles in Component fitting / Weights and styles
category. The layout of the profile used to present the vertical geometry component fitting
results is defined in Component fitting / Profile category.

If you want the application to save the results of component fitting automatically, you can
enable this option in Component fitting / Operation category of TerraScan Settings.
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Starting the Fit Geometry Components application

The application can be started from TerraScan Fit Geometry Components tool which is part of
the Road toolbox.

This opens the Component fitting main window:

The main window contains pulldown menus with commands, buttons, and the list of geometry
components. The list is displayed as soon as a geometry has been created. The menu
commands are activated when their use becomes possible during the geometry generation
progress. All commands can also be activated by key-in commands and most of them are
specified in section Tools for component modification.

The following list provides an overview of the functionality included in the pulldown menus:

1. File

Remove non-essential but helpful elements created during the work with geometry
components from the CAD file.

Export the geometry into a text file.

2. Survey

Create a filtered version of the survey vector.

View some basic properties of a CAD file line string.

Calculate and display curvature information for the filtered line string.

3. Horizontal

Create a preliminary horizontal geometry.

Activate a horizontal geometry from the elements in the CAD file.

Read horizontal geometry from a text file. Only the application's own file format is
supported.

Save the horizontal geometry into a text file.
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4. Vertical

Create a preliminary vertical geometry.

Activate a vertical geometry from the elements of the CAD file.

Read vertical geometry from a text file. Only the application's own file format is supported.

Save the vertical geometry as a text file.

5. Regression

Automatic modification of single or all components so that they follows the filtered line
string more closely.

Refitting the lengths of the segments.

6. Component

Tools for modifying the circular arc radius of curvature, joining of components, and changing
the type of a component. Note, that these tools make a modification considering only the
continuity of the model, the continuity of its tangent and curvature, if applicable.

Finding components using different criteria, for example the shortest component.

7. Tools

Modifying some set of components of the current geometry automatically.

Visualizing the residual or error of the fit.

Modifying the weight of different points of the survey vector.

8. View

Making the vertical or the horizontal geometry active.

See Component fitting main window for more information about the content of the main
window after a geometry has been created.
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Survey / Filter survey vector

This is the first step in both of the workflows presented in the Chapter’s introduction. Filter
survey vector command starts from the selected MicroStation line string element. The filtering
process modifies the line string in order to make it better suited for the task of creating
geometry components. The goal is to get a line string that does not have vertices too close to
each other or too far apart. In ideal case, this step would not be needed. However, since the
application does not make any assumption on the source of the survey vector, this command is
used to make sure that the input line string is reasonable.

To create a filtered survey vector

1. Select a line string element using MicroStation Selection tool.

2. Select Filter survey vector command from the Survey pulldown menu.

This opens the Filter survey vector dialog:

3. Define settings and click OK.

SETTING EFFECT

Data noise level Controls, in part, how many points the
application automatically adds to the line
string using linear interpolation.

· Typically, this parameter is Normal.

· However, if there are gaps in the line string
or the data is noisy, use High.

· Value Low can be used if the component
length is large compared to the average
point distance and data is smooth.

Min. component length Determines, together with Data noise level,
how many points are added to the survey line
string in the filtering process. The goal is to
have approximately six points for each
minimum component length.
Typically, the value should be at maximum 0.5
* the known minimum component length.
Larger values can cause the application to miss
components which results in a poor-quality
geometry.
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SETTING EFFECT

Point filtering step Defines the approximate minimum distance
between the vertices in the filtered line
string. For a line string with a large vertex
density, the parameter can be used to filter
out vertices and speed up the calculations.
Typically, the value should be much smaller
than the minimum component length, for
example one sixth of the minimum
component length.

The filtered line string should not be modified since any changes to its position or shape is
directly translated to the geometry components.

Horizontal / Create geometry

Create geometry command generates a preliminary horizontal geometry.

The preliminary geometry is a combination of the geometry components arcs and lines. You can
include transition curves using the Tools / Change curved set mode command. Almost all
commands for modifying a geometry work on curved component sets with and without
transition curves. The transition curve type that is currently implemented is clothoid.

To generate a preliminary  horizontal geometry:

1. Select the filtered survey vector element using MicroStation Selection tool.

2. Select Create geometry command from the Horizontal pulldown menu.

This opens the Create horizontal geometry components dialog:

3. Define settings and click OK.

This starts the automatic process for generating a preliminary geometry.

SETTING EFFECT

Min. component length The application attempts to generate a
geometry that has components longer than
this value. Usually, the components are much
longer and this value only comes into effect
in extreme cases.
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SETTING EFFECT

Typically, the value should be at maximum
0.5 * the known minimum component length.
Larger values can cause the application to
miss components and producing poor-quality
geometry.

Maximum residual Determines the goal for the level of
agreement between the generated geometry
and the vertices of the line string. In other
words, the application adds components or
continues to try to converge the components
until this level of agreement is reached.
Typically, the value is comparable to the
noise level of the data. In test cases, average
residuals were less than 0.1 m, maximum
residuals about 0.2 m. A value that is too
small can cause the preliminary geometry
generation to be slow or fail.

Road fit: results

The Road fit: results dialog is opened after the preliminary horizontal geometry components
have been created:

The dialog shows a general overview of the geometry. It lists the total number of the
components in the geometry as well as the number of different types of components ( line,
circular arc, clothoid ). The dialog also reports the differences between the geometry and the
filtered line string by giving

· the largest distance from the geometry to a point in the line string (Worst point)

· the largest average residual that a single component has (Worst comp.)

· the average residual (Average residual).

The two Show buttons can be used to pan the view to the component with the worst point-wise
residual or the worst average residual. The values of the dialog are automatically updated as
the geometry is modified. Checking these values is a fast way to detect problems in the
geometry.
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Current geometry

The horizontal geometry is stored in the CAD file (on level 23 as the default). The different
components of the geometry are color-coded, the default colors for lines is light blue, for
circular arcs red and for clothoids purple. The colors for components and the level for the
geometry can be defined in TerraScan Settings, see also User settings.

An example of a segment of a road with different types of components can be seen in the
illustration below.

The elements written in the CAD file are standard MicroStation elements grouped together into
a cell. For the component fitting application, they are mostly the visual representation of the
geometry but include information about the components. This means that the components can
be regenerated from the elements of the CAD file.

The geometry components in the CAD file are automatically updated if they are modified with
the commands of the component fitting application. Modifications of the elements drawn for
components in the CAD file are not recommended but they do not effect the components that
are stored internally by the component fitting application. If components are redrawn by the
component fitting application, they are always redrawn at their position that is stored
internally.

Component fitting main window

After the preliminary geometry generation, the geometry components are listed in the
Component fitting main window. The only way to select a component for modification is by
selecting it in the list of this window.
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To show the location of a geometry component, select a line in the Component fitting window.
Click on the Show location button and move the mouse pointer into a view. This highlights the
selected component. Place a data click inside the view in order to center the component in the
view. If horizontal and vertical geometries are present, you can select in the Show location
dialog which one to use for panning a view.

To identify a geometry component, click on the Identify button and place a data click close to a
component in a view. This selects the corresponding line in the Component fitting window.
Only components of the currently active geometry (vertical or horizontal) can be selected.

To display the station and the signed residual between the geometry and the line string for the
currently active (horizontal or vertical) geometry, click on the Show station button and move
the mouse pointer into a view. Positive residuals of a horizontal geometry mean that the
geometry component is on the left of the line string. Positive residuals of a vertical geometry
mean that the geometry component is below the line string.

Use the Undo button in order to undo a modification. You can undo up to 20 modifications.

VALUE DESCRIPTION

Index Index of the component. Numeration starts
at 0.

Station Starting station of the road component. The
value indicates the distance from the first
vertex of the filtered line string to the first
vertex of the component measured along the
filtered line string.

Type Type of the component: Line, Arc, or
Clothoid. Arc means a circular arc.

Radius Starting radius of curvature of the
component. The sign of the radius indicates
the direction of the turn (counter-clockwise
or clockwise ). In the case of circular arcs, the
starting radius is always finite. However, 0.00
is displayed for circular arcs if the value for
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VALUE DESCRIPTION

the radius is larger than the number of digits
available in the field.

Cloth. A Value of the clothoid parameter.

Length Length of the component. It is possible to
end up with 0.0 length components when
components are modified. You should try to
join the zero-length components with other
components.

AvgResid Average distance between the component
and vertices of the line string that are closer
to this component than any other. Value 0.00
means that none of the vertices are closer to
this component than any other component.
You should try join such components with
other components.

MxResid Maximum distance from the component to a
vertex of the line string that is closer to this
component than any other. Value 0.00 means
that none of the points are closer to this
component than any other component.

Modifying the horizontal geometry

There are two alternative goals for modifying the horizontal geometry:

· obtaining a continuous curvature geometry. This means that the geometry includes
transition curves between a line and a circular arc as well as between circular arcs with
different radii. At the moment, the only supported transition curve type is a clothoid.

· obtaining continuous tangent geometry. This means that the geometry contains lines and
arcs but no transition curves.

The application fully supports geometry where a set of curved components with continuous
curvature is connected with a line to another set of components with only continuous tangent.

The changes in the geometry can be followed by viewing the changes in the Component fitting
main window, the Road fit: results dialog, and in the graphical display of the geometry
components in MicroStation views. Additionally, you can display exaggerated residual vectors
by using the Tools / Residual display command.

The workflow for producing a horizontal geometry given below aims at obtaining a continuous
curvature geometry that represents the line string. The modification steps for going from a
preliminary geometry to the final geometry may include in some order the following steps:
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Basic workflow

1. Change circular arcs to lines.

Tools / Remove arcs with large radius

Component / Change selected

2. Break-up curved sets with a change in the sign of curvature.

Tools / Break S-curve set

3. Join circular arcs with similar radii.

Tools / Join arcs with similar radii

Component / Join selected

4. Add transition curves, change the mode of the curved set from continuous tangent to
continuous curvature (or back).

Tools / Change curved set mode

Done repeatedly during the basic workflow

1. Refit the line components.

Regression / Refit selected lines

Regression / Refit all lines

2. Refit individual circular arcs or join several components into an arc.

Regression / Refit selected components as arc

3. Refit the lengths of all components.

Regression / Refit component lengths

4. Find an alternative set of components for a segment of the geometry

Tools / Fit alternative components

Finalizing

In the very last part of the geometry modification process, the radii of the circular arcs can be
changed to desired values.

· Tools / Fix to even radius

· Component / Modify selected

· Tools / Radius table
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Vertical / Create geometry / From horizontal components

Create geometry / From horizontal components command generates a preliminary vertical
geometry. It uses the filtered survey vector element and horizontal geometry components as
basis for computing the vertical geometry components.

To generate vertical geometry  from horizontal components:

1. Select the filtered survey vector element using MicroStation Selection tool.

2. Select Create geometry / From horizontal components command from the Vertical pulldown
menu.

This opens the Create vertical geometry components dialog:

3. Define settings and click OK.

4. Move the mouse pointer into a MicroStation view. The horizontal geometry components
closest to the mouse pointer are highlighted.

5. Place a data click inside the view in order to select the highlighted components for which to
create vertical geometry.

This starts the automatic process for generating a preliminary vertical geometry.

6. Place the frame for displaying the profile of the vertical geometry components by a data click
inside a MicroStation view.

The elements drawn in the profile frame have station and elevation values scaled as
specified in the Component fitting / Profile category of TerraScan Settings. The frame is
drawn on the level defined in the Component fitting / Profile category of TerraScan Settings.

SETTING EFFECT

Min. component length The application attempts to generate a
geometry that has components longer than
this value. Usually, the components are much
longer and this value seldom comes into
effect.

Maximum residual Determines the goal for the level of
agreement between the generated geometry
and the vertices of the line string. In other
words, the application adds components or
continues to try to converge the components
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SETTING EFFECT

until this level of agreement is reached.
Typically, the maximum residual that can be
achieved for the vertical geometry is smaller
than for the horizontal geometry.

Create geometry / From line string

Create geometry / From line string command generates a preliminary vertical geometry. It uses
only the filtered survey vector element as basis for computing the vertical geometry
components.

To generate vertical geometry  directly  from the filtered survey line string:

1. Select the filtered survey vector element using MicroStation Selection tool.

2. Select Create geometry / From line string command from the Vertical pulldown menu.

This opens the Create vertical geometry components dialog:

3. Define settings and click OK.

This starts the automatic process for generating the preliminary geometry.

4. Place the frame for displaying the profile of the vertical geometry components by a data click
inside a MicroStation view.

The elements drawn in the profile frame have station and elevation values scaled as
specified in the Component fitting / Profile category of TerraScan Settings. The frame is
drawn on the level defined in the Component fitting / Levels category of TerraScan Settings.

SETTING EFFECT

Min. component length The application attempts to generate a
geometry that has components longer than
this value. Usually, the components are much
longer and this value only comes into effect
in extreme cases.

Maximum residual Determines the goal for the level of
agreement between the generated geometry
and the vertices of the line string. In other
words, the application adds components or
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SETTING EFFECT

continues to try to converge the components
until this level of agreement is reached.
Typically, the maximum residual that can be
achieved for the vertical geometry is smaller
than for the horizontal geometry.

Modifying the vertical geometry

The vertical geometry can be modified with the same tools as the horizontal geometry.
However, the assumption is that the final result does not include transition curves, such as
clothoids.

The modification steps for going from a preliminary vertical geometry to the final geometry
may include in some order the steps listed in the next three Sections.

Basic workflow

1. Change circular arcs to lines.

Tools / Remove arcs with large radius

Component / Change selected

2. Break-up curved sets with a change in the sign of curvature.

Tools / Break S-curve set

3. Join circular arcs with similar radii.

Tools / Join arcs with similar radii

Component / Join selected

Done repeatedly during the basic workflow

1. Refit the line components.

Regression / Refit selected lines

Regression / Refit all lines

2. Refit individual circular arcs.

Regression / Refit selected components as arc

3. Refit the lengths of all components.

Regression / Refit component lengths

4. Find an alternative set of components for a segment of the geometry
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Tools / Fit alternative components

Finalizing

In the very last part of the geometry modification process, the radii of the circular arcs can be
changed to desired values.

· Tools / Fix to even radius

· Component / Modify selected

· Tools / Radius table

Activate an existing geometry

You can activate previously generated geometries, for example if your work with the
Component fitting application has been interrupted. After activating a geometry, the geometry
components are displayed again in the Component fitting main window and can be modified.

Only one geometry, horizontal or vertical, can be active at a time. Use the View / Horizontal
components or View / Vertical components commands in order to activate the other geometry
for modification.

To continue the work on previously  generated geometries:

1. Select the filtered survey vector in the CAD file by using the MicroStation Selection tool.

2. Select Activate geometry command from the Horizontal pulldown menu in order to activate a
horizontal geometry.

OR

3. Select Activate geometry command from the Vertical pulldown menu in order to activate a
vertical geometry.

4. Identify the geometry components drawn in the CAD file with a data click inside a view.

This lists the geometry components in the Component fitting main window. You can
continue with modifications of the components as described in Sections Modifying the
horizontal geometry and Modifying the vertical geometry. If the vertical geometry is
associated with a horizontal geometry, the horizontal geometry should still be present in the
CAD file and is automatically available for activation.
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Tools for component modification

This Section describes commands of the Component fitting main window that can be used to
modify horizontal and vertical geometry components. Many commands require the selection of
one or more components in the main window’s list of components. These commands may be
inactive if there is no selection of components made beforehand.

Component / Change selected

The operation of Change selected command depends on the type of the selected components.

Key-in: road change components

Change into a line

The application tries to change the components into a line if

· the selection is a circular arc or a set of circular arcs that belong to a set of curved
components with continuous tangent.

· the selection includes a line.

In this case, the change is attempted automatically and you have only the option of accepting or
rejecting it.

Change into a circular arc

The application tries to change the components into a circular arc if

· the selection is part of a set of curved components with continuous curvature

In this case, the command opens the Road change component dialog:

The Radius value shown in the dialog is an estimate made by the application. The sign of the
radius is also determined automatically. You may set the new radius of the circular arc to a
specific value by typing the value into the Radius field. Changing curved components into a line
can be attempted by setting the radius to 0.00 in the Road change component dialog.

The change is attempted and if a solution is found, a preview of the modified component(s) is
shown in the MicroStation view. If you accept the modification by a data click, the component
list is updated.

Small radius values are more likely to produce an acceptable solution.
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Component / Insert line between arcs

Insert line between arcs command can be used to insert a line, if possible, between two circular
arcs. It only considers the geometry components and disregards the original line string. This
means, that the command may create components that do not fit well to the line string.
However, it can be used to force the insertion of a line component in cases where other
commands fail.

The insertion of a line is only possible between two connected arcs. This means that the
command does not work if the arcs are connected by a clothoid.

Component / Join selected

The operation of Join selected command depends on the type of selected components.

Key-in: road join segments

Join circular arcs

If the selected components include circular arcs, the elements are joined into a single circular
arc. In this case, the command opens the Road join components dialog:

The Radius value shown in the dialog is an estimate made by the application. The sign of the
radius is determined automatically. You may set the new radius of the circular arc to a specific
value by typing the value into the Radius field.

The change is attempted and if a solution is found, a preview of the modified component(s) is
shown in the MicroStation view. If you accept the modification by a data click, the component
list is updated.

Small radius values are more likely to produce an acceptable solution.

Join clothoids

If the selection only includes clothoids, there is no option to set the radius and the dialog does
not appear. You have only the option of accepting or rejecting the result.
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Component / Modify selected

Modify selected command is used to modify the radius of a single selected circular arc
component. It opens the Road modify component dialog:

The Radius value shown in the dialog is an estimate made by the application. The sign of the
radius is also determined automatically. You may set the new radius of the circular arc to a
specific value by typing the value into the Radius field.

If a continuous solution is found, a preview of the modified component is shown in the
MicroStation view. If you accept the modification by a data click, the arc radius is changed and
the component list is updated.

Key-in: road modify component

Regression / Refit all lines

Refit all lines command refits all line components to the vertices of the line string. Often, this is
a quick way to make a significant improvements in the accuracy.

The command is most effective for lines connecting two curved sets with only continuous
tangent. It modifies the radius of the neighbouring circular arcs. This means that this command
should not be used after radius values have been set to specific values manually.

In the case the residuals in the components are large, the command may reduce the neighbours
of the line to zero length components. These components should then be removed by using the
Component / Join selected command.

The command does not have a dialog.

Key-in: road fit all lines

Regression / Refit component lengths

Refit component lengths command improves the fit between the geometry components and
the vertices of the line string by adjusting the lengths of the components.

The local convergence of the process stops if

· the length of one of the components approaches zero.

· one of the components does not have any vertices associated with it.



TerraScan User Guide  © 2023 Terrasolid Ltd

746Fit Geometry Components > Tools for component modification > Regression / Refit component lengths

In these cases you should try to remove the components by joining them to other components.

Occasionally, an improvement in the accuracy for one part of the geometry can result in a worse
accuracy for other parts. You should always check the overall changes after using this command.

The command does not have a dialog.

Key-in: road refit lengths

Regression / Refit selected components as arc

Refit selected components as arc command can be used to refit the radius of a single circular arc
or to join selected components into a circular arc with optimal radius. The process automatically
searches for a circular arc radius that locally improves the fitting between a geometry
component and the vertices of the line string.

The automatic process does not always find the solution that minimizes the residuals. In these
cases, you may use Component / Modify selected or Component / Change selected commands
in order to set the radius of the circular arc manually.

The command does not have a dialog.

Key-in: road refit as arc

Regression / Refit selected lines

Refit selected lines command can be used to refit selected line components to the vertices of
the line string.

The command is most effective for lines connecting two curved segments with only continuous
tangent. It modifies the radius of the neighbouring circular arcs. This means that the command
should not be used after radius values have been set to specific values.

In the case the residuals of the components are large, the command often reduces the
neighbours of the line to zero length components. These components should then be removed
by using the Component / Join selected command.

The command does not have a dialog.

Key-in: road fit selected lines
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Tools / Break S-curve set

Break S-curve set command is used for breaking-up curved sets with a change of curvature
( circular arcs with opposite signs for radius values). The process may change one or two of the
circular arcs into a line or add a line between two arcs.

To break-up S-curve sets automatically :

1. (Optional) Select circular arc components in the main window of the application.

2. Select the Break S-curve set command from the Tools pulldown menu.

This opens the Break S-curve set dialog:

3. Define settings and click OK.

This starts the process.

SETTING EFFECT

Apply to Defines to which components the process is
applied: All components or Selected
components.

Allow increase Determines the maximum allowed increase
in residual values caused by breaking-up S-
curved sets.

Key-in: road break s-curve

Tools / Change curved set mode

Change curved set mode command lets you change the mode of a curved set from continuous
tangent to continuous curvature or vice versa. The application checks curved sets in the
selected components and tries to find a best fit by

· using clothoid - circular arc - clothoid combinations if the goal is a continuous curvature set.

· using a set of circular arcs if the goal is a continuous tangent set.

The command can cause relatively large increases in the residuals for the components created
for the selected curved set.
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The command does not have a dialog.

Key-in: road change local mode

Tools / Fit alternative components

Fit alternative components command can be used to create an alternative set of components
for a curved set or a line.

The operation of the command depends on the type of the selected components in the main
window. The selection must only include either curved components or a line but not both,
curved components and lines or several lines.

A curved set

If the selection includes components of a curved set (circular arcs, clothoids), the command
opens the Fit alternative to curve dialog:

The Max average residual value determines the maximum allowed average residual of the
alternative components.

The application tries to find an alternative set of components for the curve set that includes the
selected component(s). The analysis of the maximum average residual is done for the curved
set and the line components before and after it. If a solution is found that fulfills the accuracy
requirement, the list of components in the main window is updated.

The lines before and after the curved set can dominate in the accuracy check. This means that
it is unrealistic to try to find alternative components for a curved set that are more accurate
than the lines before and after it.

A line

If the selection includes a line component, the command opens the Fit alternative to line
dialog:
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The Max average residual value determines the maximum allowed average residual of the
alternative components.

The application tries to find an alternative set of components for the selected line. The result
normally includes both, lines and arcs. The analysis of the maximum average residual is done
for the line and the arc components before and after it. If a solution is found that fulfills the
accuracy requirement, the list of components in the main window is updated.

The command works only for lines that are connected to arcs. Lines connected to clothoids
are not yet supported.

Tools / Fix to even radius

Fix to even radius command is used in the last stage of the geometry production workflow. It
quickly changes the radii of all or the selected circular arcs to the closest even meter, five
meter, or any other radius value.

To fix radii to  even values automatically :

1. (Optional) Select circular arc components in the main window of the application.

2. Select the Fix to even radius command from the Tools pulldown menu.

This opens the Fix to even radius dialog:

3. Define settings and click OK.

This starts the process.

SETTING EFFECT

Apply to Defines to which components the process is
applied: All components or Selected
components.

Divisible by Defines the common factor for all radii.

Allow increase Determines the maximum allowed increase
in residual values caused by fixing radius
values of arcs.

Key-in: road arcs even
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Tools / Join arcs with similar radii

Join arcs with similar radii command joins pairwise neighbouring circular arcs with similar radii
into a single circular arc. It is applied to all circular arc components.

To jo in arcs with similar radii automatically :

1. Select the Join arcs with similar radii command from the Tools pulldown menu.

This opens the Join arcs with similar radii dialog:

2. Define settings and click OK.

This starts the process.

SETTING EFFECT

R closer than Defines the maximum relative difference in
radius values that is allowed between of two
arcs to be joined.

Allow increase Determines the maximum allowed increase
in residual values caused by joining two arcs.

Automatic iteration Usually, the command needs to run more
than once in order to join all components
with similar radii. If this option is on, the
iteration is continued automatically until no
more arcs can be changed.

Key-in: road arcs join

Tools / Radius table

Sub-commands of the Radius table command can be used to apply radius values specified in a
text file to circular arc components of the active geometry. The text file must contain only the
radius values separated by space or line break.

To apply  radius values from a text file:

1. Select Radius table / Read radius table... command from the Tools pulldown menu.
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2. (Optional) Select circular arc components in the main window of the application.

3. Select Radius table / Apply radius table command from the Tools pulldown menu.

This opens the Apply radius table dialog:

4. Define settings and click OK.

This starts the process.

SETTING EFFECT

Apply to Defines to which components the process is
applied: All components or Selected
components.

Allow increase Determines the maximum allowed increase
in residual values caused by applying radius
values of arcs.

Show table Opens a preview of the radius values read
from the text file.

Tools / Remove arcs with large radius

Remove arcs with large radius command offers a fast way to change circular arcs with large radii
to lines.

To remove arcs with large radii automatically :

1. (Optional) Select circular arc components in the main window of the application.

2. Select the Remove arcs with large radius command from the Tools pulldown menu.

This opens the Remove arcs with large radius dialog:
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3. Define settings and click OK.

This starts the process.

SETTING EFFECT

Apply to Defines to which components the process is
applied: All components or Selected
components.

Maximum radius Maximum allowed radius of arcs. If the radius
of an arc is larger, the application tries to
convert the arc into a line.

Allow increase Determines the maximum allowed increase
in residual values caused by converting arcs
into lines.

Automatic iteration Usually, the command needs to run more
than once in order to get rid of large radius
components. If this option is on, the iteration
is continued automatically until no more arcs
can be changed. However, this can cause the
residuals to accumulate.

Key-in: road arcs max
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Component / Find component

Find component command can be used to find the component that

· is shortest.

· is longest.

· has the largest radius of curvature.

· has the smallest radius of curvature.

· does not have any vertices of the lines string associated with.

The command automatically selects the first component that matches the selected criteria in
the main window.

File / Close all

Close all command can be used to remove all unnecessary results generated by the component
fitting application from the CAD file.

I/O-commands

Input/Output commands are used to import geometry components from text files, save or
export geometry components into text files, or to read in a line string that can serve as starting
element for the component fitting process.

TOOL DESCRIPTION

Horizontal/Open geometry Imports a horizontal geometry from a text file
in the application's proprietary file format.

Key-in: road read horizontal components

Vertical/Open geometry Imports a vertical geometry from a text file in
the application's proprietary file format.

Key-in: road read vertical components

Horizontal/Save geometry as Exports a horizontal geometry into a text file
in the application's proprietary file format.

Key-in: road save horizontal components
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TOOL DESCRIPTION

Vertical/Save geometry as Exports a vertical geometry into a text file in
the application's proprietary file format.

Key-in: road save vertical components

File/Export to LandXML Exports geometries into a LandXML file.

Key-in: road write landxml

File/Export to Tekla 11/12 Exports geometries to Tekla 11/12 format

Key-in: road write tekla1112

Survey / Draw curvature graph

Draw curvature graph command can be used to display the curvature information of a filtered
line string and the geometry components in a graph.

To draw a curvature graph:

1. Select a line string element using the MicroStation Selection tool.

2. Select Draw curvature graph command from the Survey pulldown menu.

This opens the Draw curvature graph dialog:

3. Define settings and click OK.

4. Define the location of the graph drawing with a data click in a MicroStation view.

This draws the graph as MicroStation cell element into the CAD file. The graph is drawn on
the active level.
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SETTING EFFECT

Select mode Defines for which geometry the graph is
drawn: Horizontal or Vertical.

Estimation length Specifies the length of a line string segment
used for estimating the curvature. Higher
values reduce the oscillations in curvature
values.

Type of smoothing Determines the smoothing mode: None,
Moving average, Moving median, or Lowpass
filter.

Number of points Number of points used for smoothing.

Station step Determines the horizontal scale markings in
the graph.

Curvature step Determines the vertical scale markings in the
graph.

Show segments If on, components of an existing geometry
are drawn in the graph using the selected
color.

The application uses the same graph drawing if the command is performed for a second time
during the same work session. The connection gets lost if the Component fitting main
window is closed.

Survey / Show curvature

Show curvature command can be used to display the curvature along the line string. The
command requires that the Survey / Draw curvature graph command has been performed
before and that the graph is drawn in the CAD file.

The curvature is displayed dynamically for the station closest to the mouse pointer and
calculated using the parameters specified in the dialog of the Survey / Draw curvature graph
command. The station value can be selected either from the line string or from the curvature
graph.
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Survey / Show line string info

Show line string info command opens a dialog that shows general information about vertices of
a selected line string. This includes the longest, shortest, and average distances between
consecutive vertices, and the length of the line string.

Tools / Residual display

Residual display command shows an exaggerated residual vector for the active geometry. The
settings for drawing residual vector into the CAD file are defined in the Residual display dialog:

SETTING EFFECT

Display as vector If on, the residual vector is displayed in the
CAD file.
Switch this off if you want to remove the
display of the residual vector.

Amplify by Scaling factor of the residual vector.

Level Level on which the residual vector is drawn.
Refers to a MicroStation level number.

Color Color of the residual vector. Uses the active
color table of MicroStation.

You can also remove the display of a residual vector by using File / Close all command.
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Tools / Set point weights

Set point weights command can be used to specify weights for the vertices of the line string.
The weights are used in the component fitting process. You can define separate weights for the
horizontal and vertical geometries.

The default weight or a vertex is 1.0. If the components should follow some vertices more
closely, set the weight of these vertices to a value larger than 1.0. To decrease the weight of the
vertices for the fitting process, set the weight to a value smaller than 1.0. Weight values must
be larger than 0.0.

The weights are drawn as text elements into the CAD file. Only manually set weight values are
drawn, the default weight of 1.0 is not drawn.

To set the weight of a vertex:

1. Select the filtered survey string using MicroStation Selection tool.

2. Select Set point weights command from the Tools pulldown menu.

3. Move the mouse pointer close to the line string. The vertex closest to the mouse pointer is
highlighted by a small circle.

4. Select a vertex with a data click. You can select several vertices by pressing the <Ctrl> key
while selecting a vertex.

This opens the Set point weights dialog:

5. Define the weight value for the selected vertex (vertices) in the Weight field.

6. Click OK.

The weight values are written into the CAD file next to the filtered survey vector. They are
drawn as MicroStation text elements on the level defined in Component fitting / Levels
category of TerraScan Settings. Weights of vertices for a vertical geometry are also displayed
in the profile window.

View / Horizontal components

Horizontal command activates the horizontal geometry for modification. It also changes the
content of the main window to display the horizontal geometry components.
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View / Vertical components

Vertical command activates the vertical geometry for modification. It also changes the content
of the main window to display the vertical geometry components.
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Key-in commands/Spaccels

Key-in commands (MicroStation) or Spaccels (Spatix accelerates) are a way to speed up the call
of tools and menu commands. The CAD platforms offer command lines where you can type and
execute the commands. In addition, commands can be assigned to keys (function keys in
MicroStation). This speeds up some manual tasks significantly as you can call tools by pressing a
key instead of mouse clicks. Especially tools with optional parameters in their call commands
are well suited for speeding up manual work with keys.

SPATIX MICROSTATION

Tools in TerraScan can be started by entering
a spaccel in the Spatix Spaccels window. The
window contains a command line and two
lists that help to find the correct syntax of a
command.

Most of the tools in TerraScan can be started
by entering a key-in command in the
MicroStation Key-in line. The Browse Key-in
option of the Key-in line can be used to find
out the syntax of a key-in command.

The upper list in the Spaccels window lists all
available spaccels. This includes commands
for calling tools of Spatix and any loaded
IxApp, such as Terra applications.
If you know approximately the beginning of
the command syntax, start typing the first
word. The list of spaccels is reduced to those
that start with the typed letters. This helps to
find the correct command syntax.
You can select a spaccel from the list with a
double-click. This writes the spaccel in the
command line on the top of the window.
Press <Enter> in order to execute the
command. This starts the corresponding tool.
The lower list in the Spaccels window lists
spaccels that have been executed. To repeat a
command, you may select it from this list with
a double-click and press <Enter>.

If you select TSCAN in the list at the lower
right corner of the Browse Key-in dialog, the
selection of commands is limited to TerraScan
commands only. There are four list fields that
show available commands. Select the first
word of a command in the left list. This adds
the word to the command line and displays
matching second words in the second-left list
field. Select the second word of a command.
This adds the word to the command line and
displays any matching third words in the next
list field. Continue until a command is
complete.
If you know approximately, how a command
looks like, you may start typing the command
in the Key-in line. The software automatically
completes words of the command, so you just
type the first letter(s) and then, confirm the
suggested word with <Space>.
Press <Enter> in order to execute a key-in
command. This starts the corresponding tool
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SPATIX MICROSTATION

or performs another action called by the
command.

In Spatix, you can assign commands to any key
or combination of keys. Key assignments are
defined in the Shortcuts window. The
window lists all tools/function calls of the
software and lets you define a key
(combination) for selected ones. In addition,
Spaccels for commands with optional
parameters can be defined and assigned to a
key (combination) as well.

In MicroStation, you can assign commands to
function keys. This is done in the Function
keys category of User Settings. You first need
to select the function key and then, type the
correct command in the command line. Set
the command with <Enter>.

This Chapter lists a selection of commands and their optional parameters. Some of them you
may consider assigning to keys. For each command, a link to the corresponding tool or menu
command is given. Use this link to jump to a more detailed description of the tool/command.

The syntax of commands/spaccels is the same in all CAD platforms. Also optional parameters
for function calls are defined in the same way.

KEY-IN COMMAND

Add point to ground

Assign point class

Classify above line

Classify below line

Classify close to line

Classify fence

Classify inside shape

Classify using brush

Classify view

Fix elevation

Mouse point adjustment

KEY-IN COMMAND

Move backward

Move forward

Open block

Open scan project

Scan app main

Scan app mainwin

Scan create surface

Scan display

Scan display close

Scan display dialog

Scan delete inside fence

KEY-IN COMMAND

Scan delete outside fence

Scan fit view

Scan move sun

Scan run macro

Scan undo display

Travel step backward

Travel step forward

View tower next

View tower previous



TerraScan User Guide  © 2023 Terrasolid Ltd

761Key-in commands/Spaccels > Key-in commands - A >  

Add Point To Ground

Add Point To Ground key-in command adds a point to the ground class and re-iterates its
closest environment. You identify the laser point to add after starting the command with a data
click.

Syntax:

add point to ground

Corresponding menu command: Add point to ground

Assign Point Class

Assign Point Class key-in command assigns a point class to a single laser point or to all points
belonging to the same group. You identify the laser point with a data click after starting the
command.

Syntax:

assign point class from=2/to=6/classify=single/select=highest/within=2.0

Parameters:

PARAMETER EFFECT

from=n Source class. Use from=999 or from=any to
use any visible points.

to=n Target class.

classify=x Points to classify: single or group.

select=x Point to classify within the search radius:
closest to mouse pointer, highest, or lowest.

within=n Search radius for selecting the highest or
lowest point.

Corresponding tool: Assign Point Class
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Classify Above Line

Classify Above Line key-in command classifies points above a given line in a section view. You
specify the line with two data clicks after starting the command.

Syntax:

classify above line [From] To

Parameters:

PARAMETER EFFECT

from Source class(es). Use 999 or no value at all to
classify any visible points. Separate several
source classes by a comma or minus, for
example class=1,3-5.

to Target class.

Corresponding tool: Classify Above Line

Classify Below Line

Classify Below Line key-in command classifies points below a given line in a section view. You
specify the line with two data clicks after starting the command.

Syntax:

classify below line [from] to

Parameters:

PARAMETER EFFECT

from Source class(es). Use 999 or no value at all to
classify any visible points. Separate several
source classes by a comma or minus, for
example class=1,3-5.

to Target class.

Corresponding tool: Classify Below Line

Classify Close To Line

Classify Close To Line key-in command classifies points above, below or close to a given line in
a section view. You define the line with two data clicks inside a section view.
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Syntax:

classify close to line abovefrom=any/aboveto=3/abovetol=0.1

Parameters:

PARAMETER EFFECT

abovefrom=n Source class above line. Use 999 or any to
classify any visible points.

aboveto=n Target class above line.

abovetol=x Tolerance above line.

closefrom=n Source class close to line. Use 999 or any to
classify any visible points.

closeto=n Target class close to line.

belowfrom=n Source class below line. Use 999 or any to
classify any visible points.

belowto=n Target class below line.

belowtol=x Tolerance below line.

Corresponding tool: Classify Close To Line

Classify Fence

Classify Fence key-in command classifies points inside an existing fence. It also starts the Place
Fence tool so that you can immediately place a new or the next fence.

Syntax:

classify fence [from] to

Parameters:

PARAMETER EFFECT

from Source class(es). Use 999 or no value at all to
classify any visible points. Separate several
source classes by a comma or minus, for
example class=1,3-5.

to Target class.

Corresponding tool: Classify Fence
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Classify Inside Shapes

Classify Inside Shapes key-in command classifies points inside selected shapes. Source class,
destination class and expand distance may be set as parameters if the key-in command.

The command requires that at least one shape element is selected in the CAD file. It classifies
the points inside selected shapes immediately, no manual action is required.

Syntax:

classify inside shapes from=5/to=6/expand=1.0

Parameters:

PARAMETER EFFECT

from=n Source class(es). Use from=999 or from=any
to classify from any class.

to=n Target class.

expand=n Distance by which to expand the shapes.
Positive values expand and negative values
shrink the shapes.

Corresponding macro action: By polygons

Classify Using Brush

Classify Using Brush key-in command classifies points inside a circular or rectangular brush. You
define the points to classify placing a data click and moving the brush over the points in a top or
section view. Stop the tool by placing another data click.

Syntax:

classify using brush from=2/to=6/size=15/shape=circle

Parameters:

PARAMETER EFFECT

from=n Source class(es). Use from=999 or from=any
to classify any visible points. Separate
several source classes by a comma or minus,
for example class=1,3-5.

to=n Target class.

size=n Brush size. Given in pixels on screen.
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PARAMETER EFFECT

shape=n Shape of the brush: circle or rectangle.

Corresponding tool: Classify Using Brush

Classify View

Classify View key-in command classifies points which are visible inside a view. You select the
view with a data click after starting the command.

Syntax:

classify view [from] to

Parameters:

PARAMETER EFFECT

from Source class(es). Use 999 or no value at all to
classify any visible points.

to Target class.

There is no corresponding tool, menu command, or macro action.
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Development Replace Angle Scan 

Development Replace Angle Scan key-in command estimates scan angle values for each point
and writes them in the Scan angle attribute.

Syntax:

development replace angle scan

Draw Horizontal Section

Draw horizontal section key-in command activates the Draw Horizontal Section tool. It does not
take any parameters to adjust tool settings.

Syntax:

draw horizontal section

Corresponding tool: Draw Horizontal Section

Draw Vertical Section

Draw vertical section key-in command activates the Draw Vertical Section tool.

Syntax:

draw vertical section depth=0.5/view=3

Possible parameters:

PARAMETER EFFECT

depth=n Display depth of a section on both sides of
the center line. For example depth=0.5.

view=n View number in which to display the defined
section. View numbers can range from 1-8,
for example view=3.

Corresponding tool: Draw Vertical Section



TerraScan User Guide  © 2023 Terrasolid Ltd

767Key-in commands/Spaccels > Key-in commands - F >  

Fix Elevation

Fix Elevation key-in command changes the elevations of laser points inside given polygons.
Each laser point inside one polygon is fixed to the same elevation value. The polygons used for
this action can be defined by a MicroStation fence, selection or a specific CAD file level.

The command manipulates the points inside polygons immediately, no manual action is
required.

Syntax:

fix elevation class=2,8/percentile=5/level=10/color=7

Possible parameters:

PARAMETER EFFECT

class=n Classes to modify. Use class=999 or class=all
to modify all points. Separate several classes
by a comma or minus, for example class=1,3-
5.

polygon=n Type of polygons: fence, selected, or level.

percentile=n If given, elevation values are computed from
the points inside the polygon and n specifies
the percentile (0=minimum, 50=median,
100=maximum) of points.

elevation=n If given, elevation values of all points are set
to the fixed value, for example elevation=
0.0.

level=n CAD file level to search for polygons. If given,
it forces polygon=level.

color=n If given, filters polygons by color in addition
to level. Uses CAD file color numbers.

weight=n If given, filters polygons by line weight in
addition to level. Uses CAD file line weight
numbers.

style=n If given, filters polygons by line style in
addition to level. Uses CAD file line style
numbers.

Corresponding tool: Fix elevation
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Mouse Point Adjustment

Mouse Point Adjustment key-in command activates the Mouse Point Adjustment tool. As long
as the tool is active, all data clicks are adjusted to the elevation and/or horizontal location of
points loaded into TerraScan.

Syntax:

mouse point adjustment AdjZ=1/AdjXy=0/Point=Closest/Class=2/Within=0.5

Possible parameters:

PARAMETER EFFECT

AdjZ=n If given, the elevation of data clicks (vertices
of elements) is adjusted. n defines a constant
value that is added to the point cloud
elevation when vertices are placed. If n=0,
the parameter is deactivated.

AdjXy=n If n=1, the parameter is activated and the xy
location of data clicks (vertices) is adjusted. If
n=0, the parameter is deactivated.

Point Points or surface model from which element
vertex coordinates are derived: Closest,
Highest, Average, Percentile, Lowest, TIN
model.

class=n Point class to adjust to. n defines the class
number.

Within=n n defines the radius of the search area
around the mouse pointer location.

Corresponding tool: Mouse Point Adjustment

Move Backward

Move Backward key-in command activates the Move Section tool and moves a section view
backward. The key-in command must include a view number (1-8). The section is moved
backward by the full depth or half of the depth of the section view, depending on the active
setting in the Move Section tool dialog.

Syntax:

move backward [stayactive] ViewNumber

Parameters:
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PARAMETER EFFECT

stayactive If given, the Move Section tool stays active
until a reset click is placed. The section
extend is displayed in a top view. A reset
click deactivates the Move Section tool and
re-activates the tool used before starting the
key-in command.
If not given, the Move Section tool does not
stay active and the section extend is not
displayed. The tool used before starting the
key-in command stays active.

ViewNumber View in which the action is applied. View
numbers can range from 1-8.

Corresponding tool: Move Section

Move Forward

Move Forward key-in command activates the Move Section tool and moves a section view
forward. The key-in command must include a view number (1-8). The section is moved forward
by the full depth or half of the depth of the section view, depending on the active setting in the
Move Section tool dialog.

Syntax:

move forward [stayactive] ViewNumber

Parameters:

PARAMETER EFFECT

stayactive If given, the Move Section tool stays active
until a reset click is placed. The section
extend is displayed in a top view. A reset
click deactivates the Move Section tool and
activates the tool used before starting the
key-in command.
If not given, the Move Section tool does not
stay active and the section extend is not
displayed. The tool used before starting the
key-in command stays active.

ViewNumber View in which the action is applied. View
numbers can range from 1-8.

Corresponding tool: Move Section
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Open Block

Open Block key-in command opens a project block for viewing or modification.

Syntax:

open block [BlockFile [options]]

Parameters:

PARAMETER EFFECT

BlockFile Block binary file to open. Can be specified by
the file name or the unique block number.

OPTIONS  

neighbours=n Distance to load points from neighbouring
blocks.

fit=n View(s) to fit where n is between -1 and 8 (-
1=all, 0=none, 1-8=view).

lock=n If n is 0, opens block for viewing only.
If n is not zero, opens block for modification.

Corresponding menu command: Open block

Open Scan Project

Open Scan Project key-in command opens a project in TerraScan.

Syntax:

open scan project ProjectFile

Parameters:

PARAMETER EFFECT

ProjectFile Path and name of the TerraScan project.

Corresponding command: Open project in the TerraScan Project window
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Scan App Main

Scan App Main opens the TerraScan toolbox. By default, the toolbox is opened when TerraScan
is loaded. The command can be used to re-open the toolbox after it was accidentally closed.

Syntax:

scan app main

Scan App Mainwin

Scan App Mainwin opens the TerraScan window. By default, the window is opened when
TerraScan is loaded. The command can be used to re-open the window after it was accidentally
closed.

Syntax:

scan app mainwin

Scan Close Dialog

Scan Close Dialog key-in command closes a modeless dialog.

Syntax:

scan close dialog name

PARAMETER EFFECT

name Name of the dialog. Use the Scan Log Dialogs
command in order to record dialog actions.
The log file includes the name of dialogs that
have been called during the recording.

Scan Create Surface

Scan Create Surface key-in command creates a TerraModeler surface model. The command
starts TerraModeler if it is not yet running. It creates the surface model, keeps the model in the
memory and stores the model file on the hard disk. The storage location and name of the
model file on the hard disk are the same as of the CAD file.

Syntax:

scan create surface class name

Parameters:
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PARAMETER EFFECT

class Point class from which the surface model is
created.

name Name of the surface model.

Corresponding menu command: Create surface model

Scan Display

Scan Display key-in command changes the view display mode for laser points.

Syntax:

scan display off=all/on=2/color=class

Parameters:

PARAMETER EFFECT

view=n View to which the display settings are
applied. View numbers can range from 1-8,
for example view=3. If this parameter is
given, it must be the first one and causes an
immediate display change to the specified
view. If not given, you select the view(s) with
a data click.

on=n Class(es) to switch on. Examples: on=2 or
on=1,5-8 or on=all.

off=n Class(es) to switch off. Examples: off=7 or
off=3-11 or off=all.

color=n Coloring mode, n can be class, echo,
elevation, line, intensity, distance, color,
lineint, echolen, scanner, dimension, group,
shading, or u. Example: color=class.

weight=n Weight (point size) where n is line weight
value. Parameter n can be set 0-7 for constant
weight, -1 for class-based weight, relative,
smooth, or +/- to increase/decrease constant
weight by one step. Examples: weight=1 or
weight=-1 or weight=relative or weight=+.

lineon=n Lines to switch on. Examples: lineon=1-3 or
lineon=all.

lineoff=n Lines to switch off. Examples: lineoff=1-3 or
lineoff=all.
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PARAMETER EFFECT

sparse=n Sparse display mode. Examples: sparse=on or
sparse=off.

depth= Depth display mode. Examples: depth=on or
depth=off.

Corresponding settings can be done in the Display mode dialog.

Scan Display Close

Scan Display Close key-in command closes the Display mode dialog.

Syntax:

scan display close

Scan Display Dialog

Scan Display Dialog key-in command opens the Display mode dialog.

Syntax:

scan display dialog

Corresponding menu command: Display mode

Scan Delete Inside Fence

Scan Delete Inside Fence key-in command deletes points inside a fence or selected polygon.
You accept the action with a data click inside the view where the fence is drawn or the polygon
is selected.

The command requires that a fence is drawn or a polygon is selected before it is started.

Syntax:

scan delete inside fence

Corresponding menu command: Delete / Inside fence

Scan Delete Outside Fence

Scan Delete Outside Fence key-in command deletes points outside fence or selected polygon.
You accept the action with a data click inside the view where the fence is drawn or the polygon
is selected.
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The command requires that a fence is drawn or a polygon is selected before it is started.

Syntax:

scan delete outside fence

Corresponding menu command: Delete / Outside fence

Scan Fit View

Scan Fit View key-in command fits a view to display the area covered by loaded points. You can
specify the view to fit as an optional parameter or by selecting it with a data click.

Syntax:

scan fit view [view]

PARAMETER EFFECT

view View to which the action is applied. View
numbers can range from 1-8.

Corresponding menu command: Fit view

Scan Log Dialogs

Scan Log Dialogs key-in command starts a log file in which dialog calls and changed to dialog
settings are recorded. After the command is called, do the steps that you want to record. This
may include starting a tool or command, define settings in the tool's dialog and close the dialog
with Cancel. When the dialog is closed, the variable names and values of the settings are
written to the log file.

Syntax:

scan log dialogs logfile.txt

PARAMETER EFFECT

logfile.txt Storing directory and name of the log file,
e.g. D:\dialog_log.txt. If the command is used
without the parameter, the action recording
is stopped.

Scan Move Sun

Scan Move Sun key-in command moves the sun direction (azimuth) in shaded views.

Syntax:
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scan move sun degree

PARAMETER EFFECT

Degree Value to add to the current sun direction,
angle by which the sun direction is moved.

Corresponding dialog setting: Display mode dialog, Azimuth setting for Color by Shading.

Scan Run Macro

Scan Run Macro key-in command executes a macro.

Syntax is:

scan run macro macrofile

PARAMETER EFFECT

macrofile File name of the macro to execute. If the file
name does not include a directory path, the
value of TSCAN_MACRODIR environment
variable is used as the directory to search
from. See Configuration Variables for
MicroStation for more information.

Corresponding menu command: Run macro

Scan Undo Display

Scan Undo Display key-in command makes an undo for the last display mode change.

Syntax:

scan undo display

There is a corresponding Undo display button in the Display mode dialog.
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Travel Step Backward

Travel Step Backward key-in command moves Travel Path windows by one section backward.
This works only, if the Travel Path tool has been used to set up the Travel Player of TerraScan.

Syntax:

travel step backward [Count]

PARAMETER EFFECT

Count Number of steps to move.

There is a corresponding button in the TerraScan Travel Player which is opened by the Travel
Path tool.

Travel Step Forward

Travel Step Forward key-in command moves Travel Path windows by one section forward. This
works only, if the Travel Path tool has been used to set up the Travel Player of TerraScan.

Syntax:

travel step forward [Count]

PARAMETER EFFECT

Count Number of steps to move.

There is a corresponding button in the TerraScan Travel Player which is opened by the Travel
Path tool.
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View Tower Next

View Tower Next key-in command moves to the next tower location in the  Tower Spans list.
This works only, if the View Tower Spans tool has been used to set up the the display of tower
locations in TerraScan.

Syntax:

view tower next

The same action is performed by selecting a new line in the Tower Spans dialog.

View Tower Previous

View Tower Previous key-in command moves to the previous tower location in the  Tower
Spans list. This works only, if the View Tower Spans tool has been used to set up the the display
of tower locations in TerraScan.

Syntax:

view tower previous

The same action is performed by selecting a new line in the Tower Spans dialog.
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Coordinate Transformations

TerraScan can apply a coordinate transformation to point clouds at different steps of the
processing workflow, for example, when loading or importing points, working with the points
in RAM, processing points in batch mode in a TerraScan project or with a macro step, or writing
points to output files. Coordinate transformations may also be applied to trajectories.

TerraScan divides coordinate transformations into several categories:

· Projection system transformations - used to transform coordinates from one coordinate
system to another.

· User-defined transformations - coordinate transformations which can be defined by a
number of parameters or equations.

· Geoid adjustment - used to transform elevation values from one height model to another.

· Systematic elevation or XY(Z) correction - applies a shift or rubbersheet correction to
elevation values or an XY(Z) shift..

Projection system transformations

The transformation of coordinates from one coordinate system to another is a common task.
Usually, the coordinates of raw laser data or trajectories are given in WGS84 or some UTM
projections system values. For data processing and/or delivery, it is often necessary to
transform these coordinates into another (national) projection system.

Coordinates in WGS84 system can be provided as longitude, latitude, ellipsoidal elevation
values or geocentric XYZ values. TerraScan automatically recognizes the coordinate value
format when it reads the points or trajectories.

The transformation into the destination coordinate system is usually done when point cloud
data or trajectories are imported into TerraScan, for example, at the beginning of the
processing workflow, or when data is prepared for delivery.

Projection systems are referenced by their EPSG code (EPSG = European Petroleum Survey
Group Geodesy, worldwide unique 4- to 5-digits code numbers for coordinate systems).
TerraScan implements a number of projection systems. A list of all available projection systems
is provided in the Browse for Projection System dialog. If a projection system is not available in
the EPSG code list, it can be defined in Coordinate transformations / User projection systems.
All systems activated there are also available for a Projection change transformation.

User-defined transformations

There are different types of transformations that can be used to manipulate the coordinate
values of point cloud data and trajectories in TerraScan. The implemented transformation types
are:

· Linear transformation

· Known points transformation
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· Xy multiply transformation

· 3D translate & rotate transformation

· 3D Affine transformation

You can define the values for the transformation parameters in Coordinate transformations /
Transformations category of TerraScan Settings.

Geoid adjustment

The elevation values of raw laser data and trajectories are often provided as ellipsoidal height
values. Usually, these values need to be transformed into orthometric values of a local height
system.

For larger areas, the adjustment from ellipsoidal to orthometric height values can not be
defined as one mathematical formula. Therefore, the elevation adjustment model needs to be
defined by using local points for which the elevation difference between the height systems is
known.

In TerraScan, the elevation adjustment can be performed for loaded points or for project blocks
in batch mode. See Adjust to geoid command for loaded points, Adjust to geoid command for
project blocks and Adjust to geoid command for trajectories for more information.

Elevation adjustment model

TerraScan implements a number of national, continental or global geoid models. The
corresponding files are provided with the installation of a bundle package (Terrasolid
installation bundle for Spatix or Microstation) and stored in the \GEOID folder of the Terra
installation directory.

Alternatively, the input model for geoid adjustment may be provided in one of the following
formats:

· Points from file - text file containing space-delimited X Y dZ- points.

· TerraModeler surface - triangulated surface model created from X Y dZ - points. The surface
model in TerraModeler has the advantage that you can visualize the shape of the adjustment
model.

· Selected linear chain - linear element of which the vertices represent the X Y dZ - points.

XY are the easting and northing coordinates of the geoid model points, dZ is the elevation
difference between ellipsoidal and local heights at the location of each geoid model point.
Intermediate adjustment values of the model are derived by aerial (text file or surface model
as input) or linear (linear element as input) interpolation between the known geoid model
points.

The figure below illustrates the aerial interpolation method. The yellow shape represents a
project area covered by data, the red points symbolize known X Y dZ - points and the green
points interpolated X Y dZ - points. The red (dotted) lines show the triangulated model.
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The six known points in the illustration above do not create a model that completely encloses
the project area. If the model does not provide any additional information, TerraScan
automatically adds four corner points (green points in the illustration) to expand the elevation
adjustment model. Each added corner point has the same dz value as the closest known point.

It is recommended to use an adjustment model that exceeds the project area and thus,
provides more accurate elevation information for project boundaries.

Systematic elevation or XY(Z) correction

A systematic correction needs to be applied if the point cloud data are systematically shifted in
elevation and/or in XY. The systematic shift can be detected by comparing the point cloud with
ground control points (GCPs).

TerraScan can do the comparison automatically. The GCPs must be provided in a text file which
stores an identifier (optionally), X, Y and Z coordinates in space-delimited fields, one line for
each control point. The identifier is normally a number but it may include non-numeric
characters as well.

In the point cloud, at least the points on the ground around the GCP locations should be
classified into a separate class. In practice, the check of a systematic elevation shift is often
done after the ground points have been classified in the point cloud. The check of a systematic
elevation shift can be performed for loaded points or for project blocks in batch mode.

An XY(Z) correction can only be applied to loaded points. The check of an XY shift requires the
definition of signal markers for GCP locations. The signal markers must be visible in the
intensity display of the point cloud. Thus, signal markers must be drawn on the ground,
preferable as white signal on a dark background, before the data is collected. Signal marker
shapes can be defined in the Signal markers category of TerraScan Settings and then used in the
Output control report command for loaded points. The proper use of signal markers requires a
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relatively high point density and is best suited for point clouds collected with a UAV-carried
system.

To apply  a systematic correction to a loaded point cloud,  proceed as follows:

1. Create a control report using Output control report command for loaded points.

2. Check the correction values. If necessary, improve a signal marker position manually.

3. Apply the correction by using commands from the Apply pulldown menu of the Control
report window.

You can type the dz value directly into the Transform loaded points dialog if you want to
apply the elevation adjustment to loaded points only. In this case, you do not need to define
a transformation in TerraScan Settings.

To apply  a systematic elevation correction to project blocks,  proceed as follows:

1. Create a control report using Output control report command for project blocks.

2. Define a Linear transformation in TerraScan Settings. Use the given Average dz value from the
report with the inverse sign as Add constant Z value in the transformation definition.

3. Apply the transformation using the Transform points macro action for project blocks or
multiple files.

Control point report

The control point report is shown in the Control report or Xyz Control report window:
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The window contains the list of all GCPs in the input text file. For each point, the following
information is shown:

· Use - determines whether a GCP is used in the comparison or not. Switch control points on
or off by clicking on the square.

· Number - identifier of the GCP.

· Signal - name of the signal marker used for a GCP. This is only shown if XYZ is checked.

· Easting - easting coordinate of the GCP.

· Northing - northing coordinate of the GCP.

· Known Z - elevation coordinate of the GCP.
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· Laser Z - elevation value derived from the point cloud at the GCP’s XY location. This is only
shown if elevation is checked.

· Dx - difference between the  GCP’s easting value and the easting value derived from the
signal marker. This is only shown if XYZ is checked.

· Dy - difference between the  GCP’s northing value and the northing value derived from the
signal marker. This is only shown if XYZ is checked.

· Dz - difference between Known Z and Laser Z. (Elevation check only) If the value exceeds a
limit defined in the Control report settings, the value is displayed in red. If a control point is
outside the area covered with point cloud data, the Dz value is shown as "outside".

· Intensity - weighted intensity value of the three closest laser points at the GCP’s XY location.
A closer laser point influences the value more than a more distant laser point. This is
displayed if the option in the Control report settings is switched on.

· Line - line number assigned to the laser points at the GCP’s XY location. This is displayed if
the option in the Control report settings is switched on.

Below the GCP list, some statistical information computed from the difference values is
provided. This includes average magnitude, standard deviation of a single value (X, Y or Z) and
root mean square. Additionally, the average of single values, minimum and maximum value of
differences is displayed. For XYZ check, you may select a value in the Value list for which you
want to see the statistics.

The report can be saved into a text file or sent to a printer using Save as text or Print commands
from the File pulldown menu.

The GCPs in the list can be sorted in different ways using the commands from the Sort pulldown
menu.

For loaded points, you can apply the correction shown in the report window by using
commands from the Apply pulldown menu.

If a line in the list is selected, the CAD file views defined in the Control report settings are
centered at the location of the corresponding GCP.

To show the location of a GCP, select a line in the list. Click on the Show location button and
move the mouse pointer into a view. This highlights the selected GCP with a square (elevation
check) or with the shape of the signal marker (XYZ check).

To identify a GCP, click on the Identify button and place a data click close to a GCP in a view. This
selects the corresponding line in the list.

If the software did not detect the XY location of a signal marker accurate enough, you can place
the control point location manually by using the Enter position button or try the detection again
by using the Detect button. A click on the button opens the Enter signal position or the Detect
signal location dialog:
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Define settings and place a data click at the location of the control point. In case of manual
placement, the data click determines the XY location of the signal measurement. The automatic
detection tries to identify the signal marker in the point cloud and derives the XY position.

SETTING EFFECT

Signal marker Name of the signal marker as defined in the
Signal markers category of TerraScan
Settings.

Angle Horizontal rotation angle of the signal
marker. For manual placement, the (rotated)
signal marker shape is displayed at mouse
pointer location.

Search radius Radial distance around the data click within
which the software tries to detect the signal
marker shape in the intensity values. For
automatic detection, the circle representing
the search area is displayed at mouse pointer
location.

Apply correction

Commands from the Apply pulldown menu can be used to apply a correction to the loaded
point cloud. This includes either a shift correction in XYZ, XY or Z (elevation), or a rubbersheet
correction. A rubbersheet correction is based on a correction model where each GCP defines a
correction vector. Between the GCPs, correction values are interpolated. A rubbersheet
correction forces all difference values between GCPs and point cloud to 0.0. The following
figure illustrates the method:
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Numbers indicate, for example, elevation correction values.

To apply  a systematic elevation shift or rubbersheet correction to loaded points:

1. Select Elevation shift command or Rubbersheet correction from the Apply pulldown menu.

A dialog is displayed which shows the shift value and asks for confirmation.

2. Confirm the correction by clicking Yes. Alternatively, you can can cancel the process by
clicking No.

This applies the correction to the loaded point cloud. In the Control report window, the
difference values and statistics are recomputed.

To apply  a systematic XY(Z) shift correction to loaded points:

1. Select Shift command from the Apply pulldown menu.

 This opens the Apply Shift dialog:

2. Select the dimension of the shift you want to apply and click OK.

This applies the systematic shift to the loaded point cloud. An information dialog shows the
applied values. In the Xyz Control report window, the difference values and statistics are
recomputed.

SETTING EFFECT

Shift Dimension of the shift:

· Xyz - systematic 3D correction in X, Y and Z.
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SETTING EFFECT

· Xy - systematic horizontal shift.

· Z - systematic vertical shift.

Control report settings

The display settings for the control point report can be changed using Settings command from
the File pulldown menu. This opens the Control Report Settings dialog:

SETTING EFFECT

Top view Top view that is updated if a GCP is selected.

Section view 1 First section view that is updated if a GCP is
selected. The section is drawn in east-west
direction.

Section view 2 Second section view that is updated if a GCP
is selected. The section is drawn in north-
east direction.

Depth Depth of a section in the section views. The
actual depth shown in a section view is the
given value * 2.

Hilite limit Determines the limit for displaying elevation
difference values in red in the report. This is
only available for elevation check.

Display intensity If on, the average intensity value of the laser
points at the GCP location is displayed in the
report. This is only available for elevation
check.
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SETTING EFFECT

Display line If on, the line number of the laser points at
the GCP location is displayed in the report.
This is only available for elevation check.
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Classification Routines

The Routine sub-menu in the Classify pulldown menu of the TerraScan window offers a number
of classification routines that effect or rely on points.

The Classify sub-menu in the Group pulldown menu of the TerraScan window contains
classification routines that effect or rely on groups of points.

In addition, there are some classification routines which can be used in macros only. This
Chapter describes the basic logic used in the classification routines.

In TerraScan Lite, only a small selection of classification routines is available.
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Air points
Not Lite

Air points routine classifies points which are clearly higher than the median elevation of
surrounding points. It can be used to classify noise up in the air.

For each point, the routine finds all neighbouring points within a given search radius. It
computes the median elevation of the points and the standard deviation of the elevation
values. A point is classified as air point if it is more than the standard deviation multiplied by a
given factor above the median elevation. The comparison using the standard deviation results
in the routine being less likely to classify points in places where there is more elevation
variation.

SETTING EFFECT

From classes Source class(es). Select several classes by
pressing the Ctrl-key while selecting a class
from the list.

To class Target class.

Search radius 2D search radius around a point. For points
within this radius the median elevation and
standard deviation are computed. Normally a
value between 2.0 - 10.0 m.

Require Minimum amount of points required within
the Search radius. A point is not classified if
there are not enough points within the
search radius.

Limit Factor for multiplication with the standard
deviation of elevation values within the
search radius. A point is classified, if it is
more than Limit * std deviation above the
median surface of the points in the search
radius.
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SETTING EFFECT

Inside fence only If on, only points inside a fence or selected
polygon(s) are classified.

Below surface
Not Lite

Below surface routine classifies points which are lower than neighbouring points in the source
class. This routine can be run, for example, after ground classification to locate points which are
a bit below the true ground surface.

For each point, the routine finds up to 25 closest neighbour points in the source class. It fits a
planar or curved plane to the neighbouring points and computes the average magnitude of the
elevation differences between the points and the plane. If the point is more than the average
magnitude multiplied by a given factor below the plane, it is classified. If the point is above the
plane or less than a given tolerance value below the plane, it is not classified.

Below point classification

SETTING EFFECT

From class Source class(es) from which points are
classified.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in
the From class field.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Surface Shape of the surface that is used as
reference for classifying points: Planar or
Curved.

Limit Factor for multiplication with the average
magnitude of the elevation differences of
neighbouring points. A point is classified, if
it is more than Limit * avg magnitude
below the plane fitted through the
neighbour points.

Z tolerance Maximum allowed elevation variation of a
point below the fitted plane. A point
within this tolerance distance is not
classified.

Buildings
Not Lite

Buildings routine classifies points on building roofs which form a planar surface. The routine
requires that ground points have been before. It is also advisable to classify points above the
ground into a separate class, so that this class contains points in an elevation range above
ground where building roofs are included.

The routine starts from empty areas in the ground class and tries to find points on planar
surfaces above these areas.
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SETTING EFFECT

Ground class Point class that contains points on the
ground.

From class Source class(es).

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Accept using Defines how easily a group of points is
accepted as building roof points. The more
strict the rules, the closer the points must
follow a plane surface.

Minimum size Smallest size of a building footprint. Points
are only classified if the footprint area of the
whole building is larger than the given value.

Z tolerance Minimum elevation difference of a point
from the plane fitted through the points on a
roof. The value is related to the noise level of
the points on roof planes.

Use echo information If on, the echo type attribute of laser points
is considered in the classification process.
This can support the classification because
points on roofs mostly belong to the echo
type ‘only echo’ whereas vegetation usually
contains lot of ‘first of many’ and
‘intermediate’ echoes.
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Building Surfaces
Not Lite

Building Surfaces routine classifies floor, roof and wall hits in indoor point clouds.

The routine relies on normal vector information in source class(es). Use Compute normal
vectors command for loaded points or Compute normal vectors macro action in order to
compute normal vectors before running the tool.

SETTING EFFECT

From class Source class(es).

Floor/Roof/Wall to Target class for floor/roof/wall points.

Floor/Roof normal Angle limit between floor/roof planes and
horizontal plane. More inclined surfaces are
not accepted.

Wall normal Angle limit between wall planes and
horizontal axis. More leaning surfaces are not
accepted.

Wall height Minimum required elevation difference
between the low and high edge of a wall.
Larger value helps to reduce detections from
objects.

Expansion radius The maximum distance allowed between
two surface parts to consider surfaces
connected.
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SETTING EFFECT

Plane tolerance Defines how thick layer of points is
considered as a surface. The more strict the
rule, the closer the points must follow to the
surface.

Minimum area Minimum continuous plane on which points
will be classified. Larger value helps to
reduce detections from furniture and other
small objects captured in the point cloud.
Minimum area is compared against the sum
of areas connected with Expansion radius.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

By absolute elevation
Not Lite

By absolute elevation routine classifies points within a given elevation range. It uses the
elevation values stored for laser points in order to decide which points are classified. This can
be used to classify error points high up in the air or clearly below the ground level.

SETTING EFFECT

From class Source class(es).

To class Target class.

Elevation Elevation range within which points are
classified. Given in absolute elevation
values.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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By angle
Not Lite

By angle routine classifies points according to the scan angle, the angle from vertical, or the
angle from the line edge.

The Scan angle can be stored as attributes for laser points in TerraScan FastBinary and LAS files.
If points from other file formats are used, or if the attribute is not stored, a scan angle is
computed based on the trajectories and their values can range from -128 and +127 degree.

Angles from vertical are computed based on trajectories and can range from 0 to 90 degree.

Angles from edge uses the angle attribute stored for laser points and thus, requires that points
are stored in TerraScan FastBinary or LAS files. The option can be used to classify points along
scan line edges at a high angular accuracy.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Use Type of angle used for classification: Scan
angle, Angle from vertical, or Angle from
edge.

Angle Range of angle values. A point is classified
if its angle value falls within the given
range.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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By centerline
Not Lite

By centerline routine classifies points based on their distance to a linear element.

The linear elements that are used by this routine can be lines, polylines (Spatix) or line strings
(MicroStation), arcs, polygons (Spatix) or shapes (MicroStation), big elements (Spatix) or
complex elements (MicroStation) consisting valid simple element types. The classification is
performed by using either selected elements or elements on a specified CAD file level.

If multiple elements are used, each laser point is classified according to the offset distance to
either the closest linear element or to any of the linear elements. In addition to the 2D
distance, the elevation distance can be included in the classification process. Further, the
classification can be limited to a certain longitudinal distance from vertices, which is useful, for
example, to classify points along a line string but only in a certain area around vertices.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in
the From class field.

To class Target class.

Use Defines what elements are used:

· Selected linear elements - any selected
elements in the CAD file. This requires
the selection of elements before starting
the routine.

· Elements by level - any elements that are
located on a given CAD file level.

Level Number of the CAD file level where
elements are located that are used for the
classification. This is only active if Use is set
to Elements by level.

By color If on, elements on the given Level are
further filtered by the selected color. Click
on the color field in order to select the
color. Uses the active color table of
MicroStation. This is only active if Use is set
to Elements by level.

By weight If on, elements on the given Level are
further filtered by the selected weight.
Click on the list of line weights in order to
select the weight. Uses the line weights of
MicroStation. This is only active if Use is set
to Elements by level.

By style If on, elements on the given Level are
further filtered by the selected style. Click
on the list of line styles in order to select
the style. Uses the line styles of
MicroStation. This is only active if Use is set
to Elements by level.

Compare with Method of comparing points to linear
elements:

· Any line - points are classified if they are
within the distance of any linear element.

· Closest line - points are classified if they
are within the distance of the closest
linear element.

Side Side on which to classify points: On left
side, On either side, or On right side. The
side is relative to the digitization direction
of the linear element.
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SETTING EFFECT

Offset Minimum and maximum 2D distance. Points
within the offset range are classified.

By elevation difference If on, only points within the given elevation
distance range from the linear element are
classified. Define the elevation offset in the
Dz fields.

By longitudinal distance from vertex If on, only points within the given
longitudinal distance range from the closest
element vertex are classified. The
longitudinal distance is measured in both
directions from a vertex along the linear
element. Define the distance in the
Distance fields.

By class

By class routine simply classifies all points from one or several given class(es) to another class.

SETTING EFFECT

From class Source class from which to classify points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class to classify points into.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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By color
Not Lite

By color routine classifies points based on color values. RGB color values can be stored as
attributes for laser points in TerraScan FastBinary files, Binary 8-bit/16-bit files, LAS 1.2+ files,
and user-defined text file formats that include the color channels as attributes. The color values
have to be assigned to the laser points before using this classification routine. You may, for
example, extract colors from images using Extract color from images command.

The routine classifies points whose color attribute falls into a specified HSV color range. The
HSV color model consists of three components:

· Hue - pure color value on a 360-degree color circle ranging from Red (0 deg) via Yellow (60
deg), Green (120 deg), Cyan (180 deg), Blue (240 deg), Magenta (300 deg) back to Red.

· Saturation - intensity or purity of the color. A smaller saturation sets the color closer to a
gray shade.

· Value - lightness or darkness of the color. A smaller value sets the color closer to black.

In the routine’s dialog, you define a range of values for each component. A point is classified, if
its color value falls within the given ranges. The dialog contains a color circle which illustrates
the selected Hue range. The circle can also be used to select another Hue value with a data
click. Further, the dialog contains a color field that illustrates the selected Saturation (x-axis)
and Value (y-axis) ranges.

Color values for laser points are stored as RGB values but the corresponding HSV values can be
displayed in the TerraScan window by using the Fields command and switching on the Point
color HSV attribute.
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SETTING EFFECT

From class Source class(es).

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Hue Hue value and tolerance.

Saturation Minimum and maximum value for saturation
component.

Value Minimum and maximum value for value
component.

You can effectively classify by gray scale if you set Hue tolerance to +- 180. Then, all hue
values fall within the range.

By deviation
Not Lite

By deviation routine classifies points based on the Deviation attribute. The deviation is usually
derived from the Riegl Extra Byte attribute Pulse shape deviation. A small deviation value
indicates a normal shape return pulse. A big deviation value indicates an abnormal shape return
pulse which may be caused by noise. Thus, the routine is useful for eliminating potential noisy
points from more reliable points.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in
the From class field.

To class Target class to classify points into.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Minimum Smallest deviation value of a point to be
classified. The minimum value is 0.

Maximum Biggest deviation value of a point to be
classified. The maximum value is 65535

By distance
Not Lite

By distance routine classifies points which are within a given distance range. The routine
requires distance values that have been computed by using the Compute distance command or
macro action.

If distance from ground values have been computed, the By distance routine results in the
same classification as the By height from ground routine.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.
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SETTING EFFECT

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Min distance Minimum distance value.

Max distance Maximum distance value.

By echo
Not Lite

By echo routine classifies points based on echo type or echo number. Echo type and echo
number can be stored as attributes for each laser point. Echo number is stored only in TerraScan
FastBinary files, LAS files, or user-defined text file formats that include the echo number
attribute.

SETTING EFFECT

From class Source class(es).

From echo Echo type from which to classify points:

· Only echo - only echo from a return signal.

· First of many - first echo from a return signal
which produced at least two echoes.

· Intermediate - intermediate echo(es) from
a return signal which produced at least
three echoes.

· Last of many - last echo from a return signal
which produced at least two echoes.

· Any first - combination of Only echo and
First of many.

· Any last - combination of Only echo and Last
of many.

· First... Seventh - points with a specific echo
number. This requires a file format that
stores the echo number as attribute for each
point.
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SETTING EFFECT

· Zero number - points with zero as echo
number.

· Zero count - points with zero as echo count.

To class Target class to classify points into.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

By echo difference
Not Lite

By echo difference routine classifies points based on elevation difference between first and
last echoes. The echo type can be stored as attribute for each laser point. The classification
effects only points with the echo types first of many or last of many.

SETTING EFFECT

Classify Echo type from which to classify points: First
echoes or Last echoes.

From class Source class(es).

To class Target class.

If first | last > Elevation difference between first and last
echos. A point is classified, if the difference
is larger than the given value.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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By echo length
Not Lite

By echo length routine classifies points based on the length of a return signal that resulted in a
point. The echo length can be stored as attribute for each laser point in TerraScan FastBinary
format. It describes the relative length of a return signal compared to a typical return from a
hard surface, for example:

· -50 - the echo is 50 mm shorter than a typical hard surface return.

· +845 - the echo is 845 mm longer than a typical hard surface return.

The routine requires that the echo length has been extracted for the points from waveform
information. Alternatively, the Riegl Extra Byte attribute Pulse width is used in TerraScan as Echo
length attribute if available.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Echo length Range of echo length values. A point is
classified, if its echo length value falls
within the given range.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

https://terrasolid.com/guides/tscan/introwaveformprocessing.html
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By height from ground
Not Lite

By height from ground routine classifies points which are within a given height range compared
to a reference surface. The surface can be temporarily created from points in one or several
classes or a surface active in TerraModeler can be used. Most often, the previously classified
ground class is used as the surface for classifying points above the ground level.

You might use this routine for to classify points into different vegetation classes for preparing,
for example, building classification, powerline processing, or tree detection. As a result, the
highest vegetation class should include all hits on the target objects of interest (building roofs,
wires and towers, or trees).

SETTING EFFECT

Ground class Point class(es) used for creating the
reference surface or the name of a surface
model that is active in TerraModeler.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground class field.

Max triangle Maximum length of a triangle edge in a
temporary surface model.

From class Source class(es).

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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SETTING EFFECT

Min height Minimum height above the reference
surface. If a negative value is given, points
below the reference surface are classified.

Max height Maximum height above the reference
surface. The value must be bigger than the
value of Min height. If a negative value is
given, points below the reference surface
are classified.

By intensity
Not Lite

By intensity routine classifies points within a given range of amplitude, intensity or reflectance
values. These value can be stored as attribute for each laser point.

The routine can be used to quickly classify points that are possible hits on rails or on paint
markings because the metal surface or the white paintings produce high intensity values while
the surrounding area, such as dark gravel or asphalt often result in low intensity values.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Use Point attribute used for the classification:

· Amplitude - Riegl Extra Byte attribute.
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SETTING EFFECT

· Intensity - common intensity attribute,
representation of the pulse return
magnitude.

· Reflectance - Riegl Extra Byte attribute.

Classify Determines which points are classified:

· Point itself - points with an intensity
value in the given range are classified.

· Later echoes - points with last and
intermediate echo types are classified if
the intensity value of the point with first
echo type of the same return signal is
within the given range. Points with first
and only echo types are not effected with
this setting.

· Earlier echoes - points with first and
intermediate echo types are classified if
the intensity value of the point with last
echo type of the same return signal is
within the given range. Points with last
and only echo types are not effected with
this setting.

Amplitude Range of amplitude values within which a
point is classified. The routine classifies
points with MinAmp <= Amplitude <=
MaxAmp. MinAmp and MaxAmp are given
in absolute amplitude values and may range
from 0 to 65535.

Intensity Range of intensity values within which a
point is classified. The routine classifies
points with MinInt <= Intensity <= MaxInt.
MinInt and MaxInt are given in absolute
intensity values and may range from 0 to
65535.

Reflectance Range of reflectance values within which a
point is classified. The routine classifies
points with MinRef <= Reflectance <=
MaxRef. MinRef and MaxRef are given in
absolute Reflectance values and may range
from -32768 to 32767.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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By normal vector
Not Lite

By normal vector routine classifies points based on normal vector values and/or dimension
types.

Normal vector and dimension can be stored as attributes for points in TerraScan FastBinary
files. They must be computed by using the Compute normal vectors command before starting
the classification routine.

The normal vector is computed for points with planar dimension. It contains three components,
X, Y, and Z. Points can be classified by using the dimension attribute only, or by specifying
certain normal vector components and their values. The values can range from -1.0 to +1.0 for
each component. For instance, the value +1.0 for the Z component means that the normal
vector points upward from a completely horizontal surface.

The routine is useful, for example, to classify points on very flat parts of a road surface in a
mobile data set or to classify points on roof planes facing to a certain direction in an airborne
data set.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Dimension Dimension of points to be classified: Not
known, Linear, Planar, or Complex. See
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SETTING EFFECT

Compute normal vectors command for a
more detailed description of dimensions.

X If on, points are classified, if the X
component of their normal vector falls
within the given range of values.

Y If on, points are classified, if the Y
component of their normal vector falls
within the given range of values.

Z If on, points are classified, if the Z
component of their normal vector falls
within the given range of values.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

By polygons
Not Lite

By polygons routine classifies points that are located inside or outside 2D shapes, or close to 3D
shapes. The shapes must be drawn in the CAD file. They must be located on a specified level in
the active CAD file or in a reference CAD file (MicroStation only) in order to be used in the
classification routine. Optionally, the shapes can be filtered by color, weight, or style settings.

The routine is only available in macros. See Chapter Macros for more information about macro
creation and macro actions.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Classify Defines the type of reference polygons:

· Inside 2D polygons - points inside a
polygon are classified. The elevation of
the polygon is ignored.

· Outside 2D polygons - points outside a
polygon are classified. The elevation of
the polygon is ignored.

· Close to 3D polygons - points within the
given Offset from a 3D polygon are
classified.

Polygons from Source where shapes are drawn:
· Active or reference files - in the active

CAD file or in an attached reference file.
(MicroStation only)

· Active CAD file - in the active CAD file.
· Reference file - in an attached CAD file.

(MicroStation only)

Expand by Distance that is added to the boundary
location of shapes. A positive value expands
shapes, a negative value shrinks shapes.

Offset Distance from a 3D polygon within which
points are classified. A negative value refers
to the inside, a positive value to the outside
of a polygon, such as a building wall. This is
only active if Classify is set to Close to 3D
polygons.

Level Number of the CAD file level where shapes
are located that are used for the
classification.

By color If on, shapes on the given Level are further
filtered by the selected color. Click on the
color field in order to select the color. Uses
the active color table of the CAD file.

By weight If on, shapes on the given Level are further
filtered by the selected weight. Click on the
list of line weights in order to select the
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weight. Uses the line weights of the CAD
file.

By style If on, shapes on the given Level are further
filtered by the selected style. Click on the
list of line styles in order to select the style.
Uses the line styles of the CAD file.

By range
Not Lite

By range routine classifies points based on the range. The range is defined as the distance of a
point from the scanner. The distance can be measured as 3D, horizontal, or vertical distance.

This classification routine is primarily used with laser data from mobile scanners and can be
used, for example, to classify points at long ranges or points that are clearly below the ground
level.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Use Defines how the range between a point and
the scanner is measured:

· 3D distance - 3D distance.

· Xy distance - horizontal distance.

· Offset distance - left/right distance.

· Forward distance - forward/backward
distance.
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SETTING EFFECT

· Dz - vertical distance.

Range Distance range. A point is classified, if it is
within the given distance range from the
scanner.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

By reliability
Not Lite

By reliability routine classifies points based on the Reliability attribute. The reliability is usually
derived from the Agisoft attribute Confidence.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class to classify points into.

Reliability Points with a reliability value within the
given range are classified.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.
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By scan direction
Not Lite

By scan direction routine classifies points in negative or positive scan direction, or edge points.
This requires that laser points are stored in LAS files. The classification is based on the scan
direction and edge of flight line bit fields present in LAS files.

SETTING EFFECT

From class Source class(es).

To class Target class.

Direction Scan direction from which to classify points:
Negative, Positive, or Edge point.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

By scanner
Not Lite

By scanner routine classifies points according to the scanner number. The number of the
scanner that recorded a point can be stored as attribute for laser points in TerraScan FastBinary
and LAS files. This is primarily used for laser data from multiple-scanner systems.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Scanner Number(s) of the scanner(s) from which to
classify points. Separate several scanner
numbers by a comma or minus, for
example 1-3,5. Use 0-255 for all scanners.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

By section template
Not Lite

By section template routine classifies points based on the shape of a section. The points to
classify are defined by a three dimensional alignment element and a section template.

This classification routine is useful for classifying points along roads, rails, in tunnels, or along
other corridors in order to analyze clearance areas.

The section template must be defined in Section templates category of TerraScan Settings
before using the classification routine. Then, it can be used to classify points which are inside
the section, outside the section, or on and close to the section outline. Further, the routine
requires a 3D alignment element which is used to move the section template along. A selected
linear element can act as alignment element or alternatively, trajectories that are active in
TerraScan.
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SETTING EFFECT

Alignment Elements that are used as alignment
elements:

· Selected vectors - any selected linear
elements in the CAD file. The element(s)
must be selected before starting the
routine.

· Trajectories - trajectories that are active
in TerraScan.

Traj numbers Number(s) of trajectories used as alignment
elements. Separate several trajectory
numbers by a comma or minus, for example
1,3-5. This is only active if Alignment is set
to Trajectories.

Classify Points to classify relative to trajectories:

· All points - all points are compared to any
trajectory line.

· Points from same line - points are
compared only with their associated
trajectory line. This is only active if
Alignment is set to Trajectories.

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.
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SETTING EFFECT

Section Name of the section template. The list
includes all section templates that are
defined in Section templates category of
TerraScan Settings.

Location Points to classify relative to the section
template:

· Inside section - points inside the section.

· Outside section - points outside the
section.

· On section - points on and close to the
section.

Tolerance Defines the maximum distance of a point
from the section outline in order to be
classified. This is only active if Location is
set to On section.

By time stamp
Not Lite

By time stamp routine classifies points within a specified time range. This requires time stamps
stored for each laser point.

SETTING EFFECT

From class Source class(es).

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Time range Range of time stamps. A point is classified, if
its time stamp value falls within the given
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SETTING EFFECT

range.
The numbers below the input fields show the
minimum and maximum time stamps of
loaded points.

By vegetation index
Not Lite

By vegetation index routine classifies points based on a vegetation index computation. The
routine requires that color values have been extracted for the points. Color values for laser
points can be extracted from raw images or raster attachments loaded into TerraPhoto, or
assigned per class by setting values for red, green, and blue channels. See Extract color from
images and Assign color to points for corresponding commands in TerraScan.

TerraScan can assign up to 10 color channels for each point. The maximum amount of color
channels can only be stored in the TerraScan FastBinary format. LAS 1.4 format and later can
store up to 4 color channels, LAS 1.2 format and later up to 3.

There are two implemented methods for computing the vegetation index.

Normalized difference

The method assumes that channel 0 stores red (R) and channel 3 near-infrared (NIR) color
values. The normalized difference value is computed with the following equation:

ND = (NIR - R) / (NIR + R) -1 <= ND <= +1

Visual band difference

The method assumes that channel 0 stores red (R), channel 1 green (G), and channel 2 blue (B)
color values. The visual band difference value is computed with the following equation:

VBD = (2*G - R - B) / (2*G + R + B) -1 <= VBD <= +1

The routine is well suited for separating points on vegetation from non-vegetation points. You
can check how well the vegetation index computation separates vegetation from non-
vegetation points by displaying points by vegetation index. The larger the difference value, the
more likely a point is representing vegetation.

In addition to the implemented methods, there may be User vegetation indexes defined in the
corresponding category of TerraScan Settings.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Index type Method of vegetation index computation:
Normalized difference, Visual band
difference, or any User vegetation index
defined in TerraScan Settings.

Min value Minimum difference value to be classified.

Max value Maximum difference value to be classified.

Copy dominant result from neighbours If on, the software checks neighbouring
points before classifying a point. If the
percentage of neighbouring points given in
the Limit field are classified, the point is
classified as well. This avoids that single
isolated points are classified as vegetation
or non-vegetation.
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Closeby points
Not Lite

Closeby points routine classifies points close to points from another class, another line, or
another scanner. For each point, the software finds points within a given 2D or 3D search radius.
It checks whether the points within the radius fulfill the given conditions, such as being in a
specific class, from another line or scanner. If all defined conditions are true, the point is
classified.

Example of a high-density point cloud:

· thin the point cloud, keep a central point and classify other points into a temporary point
class

· apply classification routines to the thinned point cloud, classify points into any object-
specific point classes

· apply the Closeby points routine in order to densify the object classes with points from the
temporary point class

In the above example, the processing speed is increased by thinning a dense point cloud before
running processing-intensive classification routines. The Closeby points routine is fast to apply
for a large number of points.

Example for a multiple-scanner system data set:

· scanner 1 is better quality than scanner 2

· classify ground from each scanner into separate classes

· use ground points of scanner 2 only in places where there are no ground points of scanner 1.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

From line Only points in the given line(s) are effected.
Use a comma or minus to separate several
line numbers, for example 2-5,10. 0-65535
refers to all lines.

From scanner Only points captured by the given
scanner(s) are effected. Use a comma or
minus to separate several scanner numbers,
for example 1-3,5. 0-255 refers to all
scanners.

To class Target class. Chose Closest point class if you
want to deduce the class of a point in the
source class(es) from the closest point in
the Specific class selection.

Search type Type of the search radius:

· 2D - a 2D search radius (horizontal
dimension) is applied for finding closeby
points.

· 2D above - points are only classified if the
reference points are above and within a
2D search radius.

· 2D below - points are only classified if the
reference points are below and within a
2D search radius.

· 3D - a 3D search radius is applied for
finding closeby points.

· 3D above - points are only classified if the
reference points are above and within a
3D search radius.

· 3D below - points are only classified if the
reference points are below and within a
3D search radius.

Radius Size of the search radius around each point.

Inside fence only If on, only points inside a fence or selected
polygon(s) are classified.

Another line If on, a point is classified if another point
from any other line is within the given
search radius.
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Another scanner If on, a point is classified if another points
from any other scanner is within the given
search radius.

Specific class If on, a point is classified if another point
from the given class(es) is within the given
search radius.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Specific class field.

Specific line If on, a point is classified if another point
from the given line(s) is within the search
radius. Use a comma or minus to separate
several line numbers, for example 2-5,10.

Specific scanner If on, a point is classified if another point
from the given scanner(s) is within the
search radius. Use a comma or minus to
separate several scanner numbers, for
example 1-3,5.

Contour keypoints

Contour keypoints routine classifies points for the production of contours. It works similar to
the Model keypoints routine but produces a keypoint model which is suited for creating
smooth, cartographic contour lines for map production.

If contours are derived from the original ground points, they are very accurate, detailed, and
mathematically correct but less suited for being used for representation purposes. Small details
in contour lines are caused by ground points close to contour line locations. Therefore, contour
keypoints do not include points that are close to these locations.

The volumetric difference between a contour keypoint model and the model created from the
original ground points is controlled by the Limit value for contour keypoints classification. The
value determines how much the contours derived from the keypoints are smoothed. So higher
the limit value, the smoother, nicer-looking the contours are but the less accurate the keypoint
model is compared with the original ground model.

In addition to contour lines, the classification routine can also consider peaks and pits in the
ground model. The values for Peak area and Pit area are used to define the minimum area that
is enclosed by a contour line on top of hills or in depressions.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Contour interval Minimum interval planned for producing
contours.

Use points every Minimum point density of contour
keypoints. In areas of completely flat
ground, there is a keypoint at
approximately the given distance.

Limit Determines the accuracy of the contour
keypoint model and thus, the smoothness
of the resulting contours.

Keep relevant peaks and pits If on, areas on top of hills and in
depressions are considered in the model.

Peak area Minimum size of a peak area enclosed by a
contour line.

Pit area Minimum size of a pit area enclosed by a
contour line.
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Ground
Not Lite

Ground routine classifies ground points by creating a triangulated surface model iteratively.
The routine is best suited for classifying ground in airborne laser data sets and in data sets
where there is mainly natural terrain. For classifying ground in mobile data sets where the
majority of ground is on hard surfaces, such as roads, use the Hard surface routine instead of
the ground routine.

The routine is sensitive to low error points in the point cloud. Therefore, you should run one or
more classification steps using the Low points routine before classifying ground. A more
complex classification strategy is required for classifying ground in photogrammetric point
clouds.

The ground routine starts by selecting local low points that are confident hits on the ground.
The initial point selection is controlled with the Max building size parameter. If the maximum
building size is, for example, set to 60.0 m, the routine assumes that any 60 by 60 m area has at
least one point on the ground level and that the lowest point is on the ground level.

Then, the routine builds a surface model (TIN) from the initial ground points. The triangles in
this initial model are mostly below the ground level and only the vertices are touching the
ground. In the following iterations, the routine molds the model upwards by adding more and
more points. Each added point makes the model following the true ground surface more
closely.

The iteration parameters of the routine determine how close a point must be to a triangle
plane for being accepted as ground point and added to the model. Iteration angle is the
maximum angle between a point, its projection on the triangle plane and the closest triangle
vertex. This is the main parameter controlling how many points are classified into the ground
class. The smaller the Iteration angle, the less eager the routine is to follow variation in the
ground level, such as small undulations in terrain or points on low vegetation. Use a smaller
angle value (close to 4.0) in flat terrain and a bigger value (close to 10.0) in mountainous terrain.

Iteration distance makes sure that the iteration does not make big jumps upward if triangles are
large. This avoids ground points that are too high, for example within low vegetation or on low
buildings.

Illustration of Iteration angle and Iteration distance parameters in the ground routine.
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A smaller Iteration distance value avoids classification of ground points on low objects.

The iteration angle can be reduced automatically, if the triangles become small. This reduces
the eagerness to classify more ground points inside small triangles and thus, avoids
unnecessary point density of the ground model. The iteration angle inside small triangles
approaches zero if the longest triangle edge is shorter than a given Edge length value.
Furthermore, the iteration can be stopped completely if triangle edges are shorter than a given
limit.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in
the From class field.

To class Target class.

Current ground Class(es) with already classified ground
points. These points influence the
classification of additional ground points
but they are not effected themselves.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Current ground field.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Select Selection of initial ground points. If
starting a new ground classification, use
Aerial low + Ground points. Use Current
ground points when you want to continue
the ground classification in a previously
classified area.

Max building size Defines the search area for initial ground
points. The value should be close to the
edge length of largest building in the
project area.

Terrain angle Steepest allowed slope in the ground
surface. Use 88-90 degree if there are man-
made objects in the project area. Use the
estimated maximum terrain slope plus 10-
15 degree if there is only natural terrain.

Iteration angle Maximum angle between a point, its
projection on the triangle plane and the
closest triangle vertex.

Iteration distance Maximum distance from a point to the
triangle plane. Normally values between
0.5 and 1.5 m.

Reduce iteration angle when If on, reduces the eagerness to add new
points to ground inside a triangle if every
edge of the triangle is shorter than Edge
length. Avoids the addition of unnecessary
point density to the ground model and
reduces memory requirement.
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Stop triangulation when If on, stops processing points inside a
triangle if every edge of the triangle is
shorter than Edge length. Avoids the
addition of unnecessary point density to
the ground model and reduces memory
requirement.

Use distance as rating If on, the vegetation index stored as
distance is used to determine how likely a
point is to be ground. This can improve the
ground classification result for
photogrammetric point clouds. If used, the
routine is less eager to classify points with
a positive distance value (= more likely a
vegetation point) and rising above other
points in the local environment as ground.
Points with a negative distance value (=
more likely a non-vegetation point) and
points in planar terrain are more easily
accepted as ground points.
In a similar way, the echo length or
deviation stored as distance is used to
determine how likely a point is to be
ground in a LiDAR point cloud. Distance
values are considered to be ground,
while values >0 are less likely accepted as
ground points. The closer a value to +1, the
more unlikely a point is accepted to
ground.
 A smaller Weight value translates to a
smaller effect of the setting for the ground
classification, a larger value to a bigger
effect.
The positive effect of the setting for
classifying ground can be improved by
smoothing the distance values that
represent the vegetation index, echo
length or deviation.

After running the automatic ground routine, there might be the need to improve the result
of ground classification manually. You may use half-automatic ways in order to do this task.
One possibility is to run the ground routine on loaded points and inside a fence using the
Inside fence only option of the routine. Alternatively, the Add point to ground command can
be used to classify more points into the ground class within a limited area.
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Ground classification in photogrammetric point clouds

The ground routine often fails to detect the real ground in photogrammetric point clouds
because the geometric conditions within the point cloud are different from those in LiDAR
point clouds. Here it helps to use the color information in addition to point-to-point
relationships. The following steps illustrate an example workflow for ground classification in
photogrammetric point clouds. All steps may be also performed as macro actions.

1. Sort points by Xy location.

2. Classify major surfaces.

3. Smooth XYZ for the surface points found in step 2.

4. Thin the surface points found in step 2 by density, keep the central point within reasonable
XY and Z distances (depending on the noise level in the data). The remaining points in the
surface class now represent cleaner surfaces.

5. If color information is noisy, classify points that are perfectly white.

6. Classify hard surface from points that remain in the surface class after step 4. Use a planarity
tolerance that allows some point variation on surfaces.

7. Compute distance for hard surface points found in step 6 by using the Visual band difference
(RGB available) or the Normalized vegetation index (RGB + Infra-red available). You may
check a good limit value by displaying the point cloud by vegetation index and playing with
the limit setting.

8. Smooth the distance in order to reduce the noise in vegetation index values derived from
color information.

9. Classify ground and make use of the Use distance as rating setting as described above.

Hard surface
Not Lite

Hard surface routine classifies ground points by creating a triangulated surface model
iteratively. The routine classifies dominant median surface points. It is best suited for
classifying ground in mobile laser data sets and in data sets where there is mainly hard ground
surface, such as paved roads or other areas. For classifying ground in airborne data sets where
the majority of ground is in natural terrain, use the Ground routine instead of the hard surface
routine. If you need to classify both, natural terrain and paved areas, you may need to draw
polygons around natural/paved areas in order to apply on of the routines inside the polygons
and the other routine for the rest of the data.

In contrast to the ground routine, the hard surface routine is not sensitive to low error points in
the point cloud. Therefore, you do not need to run any low point classification before
classifying ground with this routine. However, you may run other routines in order to limit the
amount of points in the source class for the hard surface routine.
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The hard surface routine is eager to classify points that form a local plane. The Plane tolerance
given in the routine’s settings determines how well the points must fit the plane. This is the
main parameter controlling how many points are classified into the ground class.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Plane tolerance Determines how well the points on a hard
surface must fit a plane.

Max terrain slope Maximum slope of the hard surface. 

Iteration angle Maximum angle between a point, its
projection on the triangle plane and the
closest triangle vertex.

Minimum detail Minimum size of a continuous hard surface
area.

Minimum triangle Minimum edge length of a triangle.

After running the automatic hard surface routine, there might be the need to improve the
result of the classification manually. You may use half-automatic ways in order to do this
task. One possibility is to run the hard surface routine on loaded points and inside a fence
using the Inside fence only option of the routine.
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Isolated points
Not Lite

Isolated points routine classifies points which have less neighbour points within a 3D search
radius than defined in the routine’s settings. This routine is useful for finding isolated points up
in the air or below the ground.

In addition, it can be used to find points that do not have neighbour points in another class(es)
within the given search radius. The same example provided for the Closeby points routine
applies.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

If fewer than A point is classified if there are less than
the given number of neighbouring points
within a 3D search radius. Normally a value
between 1-5m.

In class A point is classified if there are not enough
neighbour points in the given class(es)
within the search radius.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the In class field.
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SETTING EFFECT

Within Size of the 3D search radius.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Low points
Not Lite

Low points routine classifies single points or groups of points which are lower than other points
in the surrounding. It is often used to search for possible error points which are clearly below
the ground.

The routine compares the elevation of each point or point group with any other point within a
given 2D radius. If the point or point group is clearly lower than any other point, it is classified.

Single low point classification Group of low points classification

The routine finds the lowest point or point group in a data set when it runs once. If there are
low points on several elevation levels below the ground, it should be executed several times
with different settings. Typically, the routine is included in a macro for ground classification in
an airborne laser data set and depending on the amount of error points below the ground,
there are two or even more steps for low point classification.

SETTING EFFECT

From class Source class(es).
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Search Defines the target points: Single points or
Groups of points.

Max count Maximum amount of points in a group of
low points. This is only active if Search is
set to Groups of points.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

More than Minimum height difference between a
single point or a group of points and a
point in the surrounding. Normally a value
between 0.3 - 1.0 m.

Within Size of the 2D search radius. Normally
values between 2.0 - 8.0 m.

Model keypoints

Model keypoints routine classifies points which are needed to create a triangulated surface
model of a given accuracy. This routine is normally used to create a thinned data set from
previously classified as ground points. For LAS 1.4 files, you can set the keypoint bit instead of
classifying the points.

The routine tries to find a relatively small set of points (= keypoints) which create a triangulated
model of the given accuracy. It starts by classifying all points from the source class, which is
usually the ground class, into the target class. Then, it iteratively removes all points from the
target class that are not required in a surface model of the given accuracy.

Model keypoints (red points) as subset of ground points (black points).

You control the accuracy of the keypoint model with elevation tolerance settings Above and
Below model. These settings determine the maximum allowed elevation difference
between the keypoint model and a surface model created from the original ground points.
The Use points every setting ensures a minimum point density in the final model. For
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example, if the distance between a point and its closest neighbour must not be less than 10
meter, you should set the Use points every setting to 10.0 m.

SETTING EFFECT

From class Source class(es). Contains usually ground
points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class. For LAS 1.4 files, you can
choose Set keypoint bit as alternative.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Use points every Minimum point density of model
keypoints. In areas of completely flat
ground, there is a keypoint at
approximately the given distance.

Tolerance above Maximum allowed elevation difference
upward between the triangulated keypoint
model and a model of the original source
points.

Tolerance below Maximum allowed elevation difference
downward between the triangulated
keypoint model and a model of the original
source points.
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Railroad
Not Lite

Railroad routine classifies points which match the elevation pattern of a railroad track.

The conditions for a point that matches the required pattern are:

· A point must have some points in the vicinity which are 0.05 - 0.35 m lower.

· A point can not have any points in the vicinity which would be 0.15 - 2.50 m higher.

· A point can not have any points in the vicinity which would be more than 0.35 m lower.

The routine tries to find points that match the elevation pattern and a given Rail width ±
Tolerance setting. Further, it may be supported by an alignment element that can be created
using the Place Railroad String tool in TerraScan or any other line string placement tool of the
CAD platform.

The alignment element can be used in three different ways:

· None - No alignment is available. The routine tries to find points that match the elevation
pattern and have another matching point at Rail width ± Tolerance distance in any direction.

· Track centerline - The alignment follows the centerline between two rails. The routine tries
to find points that match the elevation pattern and are at (0.5 * Rail width) ± Tolerance
distance from the alignment.

· General direction - The alignment defines the general direction of the railroad. The routine
tries to find all points which match the elevation pattern and have another matching point at
Rail width ± Tolerance distance. The line between the two points must be close to
perpendicular to the alignment direction.

The alignment element(s) must be selected before starting the classification routine.

The routine is suited for ALS data sets with a comparatively low point density. For dense MLS
data sets, there are better-suited tools for processing data of railroads in the Railroad toolbox,
such as Find Rails tool.
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SETTING EFFECT

From class Source class(es).

Or class Second source class.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Alignment Usage of an alignment: None, Track
centerline, or General direction.

Tolerance Horizontal offset by which the alignment can
differ from the true centerline locations. This
is only active if Alignment is set to Track
centerline.

Rail width Track width, distance from rail center to rail
center.
The field is followed by another input field
that is only active if Alignment is set to None
or General direction. The field defines the
horizontal offset by which the track width can
differ.

Surface points
Not Lite

Surface points routine classifies points that fit to locally smooth surfaces. It classifies points on
planar surfaces of any direction and also on rounded surface. The routine can be used as pre-
classification for ground, building roof or wall classification in noisy point clouds, such as
photogrammetric point clouds.

After classifying surface points, it might be useful to smooth the points using the Xyz method
before running additional classification routines. 

SETTING EFFECT

From class Source class(es).
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Tolerance Offset from the main surface up to which
points are included in the classification.
Given in CAD file units.

Use reliability as weight factor If on, the reliability value stored for points
is considered in the surface classification.
The software is more eager to classify
points of higher reliability as surface.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Top surface

Top surface routine classifies points that form a common surface model in the point cloud.
From up to three source class types, the highest points at each location are classified. The result
is suitable, for example, to create true orthophotos without additional vector models.

SETTING EFFECT

Ground Class(es) that contain points on the
ground.

Roof Class(es) that contain points on high planar
objects, such as buildings or bridges.
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SETTING EFFECT

Vegetation Class(es) that contain points on high
complex objects, such as vegetation.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Ground, Roof or Vegetation fields.

Spacing Determines the point density in the target
class for the different source class types.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Tunnel surfaces
Not UAV

Tunnel surface routine classifies points collect inside tunnels. The routine classifies points on
the tunnel roof, floor and walls. It requires the computation of normal vectors which can be
done with the Compute normal vectors command or macro action. The normal vector direction
should be turned towards the inside of the tunnel determined by either a trajectory or a vector
element.

SETTING EFFECT

From class Source class(es).
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Floor to Target class for points on the tunnel floor.

Roof to Target class for points on the tunnel  roof.

Wall to Target class for points on the tunnel walls.

Floor normal Maximum angle off from vertical of the
normal vector for points on the tunnel
roof.

Roof normals Maximum angle off from vertical of the
normal vector for points on the tunnel
floor.

Min count Minimum amount of points per surface
patch belonging to one target class. If a
patch contains less points, it is added to
the larger neighbouring class.

Smoothen roof/wall transitions If on, the transition between roof and wall
surface patches is smoothed.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Walls
Not Lite

Wall routine classifies points on wall-like surfaces in mobile data sets. The routine requires
that normal vectors for the points in the source class(es) are available. Normal vectors can be
stored as attributes for points in TerraScan FastBinary files. They must be computed by using
the Compute normal vectors command.

The routine classifies points on planar surfaces that are nearly vertical (within 10 degree) and
larger than a given minimum area. It classifies the points on the surface and also smaller details
up to a given distance from the main surface.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Minimum area Minimum size of a wall surface. Given in
squared CAD file units.

Tolerance Offset from the main planar wall surface
up to which points are included in the
classification. Given in CAD file units.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Wire danger points
Not Lite

Wire danger points routine classifies points which are within a certain distance from reference
elements. The reference elements can be wire elements produced by tools of the Vectorize
Wires toolbox or any linear element drawn in the CAD file.

The routine can be used to classify points on potential danger objects along powerlines, rail
tracks, roads or other corridor objects. There are three methods how potential danger points
are defined:

· Vertical distance to wire - points within a vertical distance from a reference element are
classified.

· 3D distance to wire - points within a 3D radius around a reference element are classified.

· Falling tree logic - each point is considered as the tip of a tree with its trunk at the xy
location of the point and the elevation of the base point on the ground. If the point “falls
like a tree” and falls into a 3D buffer area around a reference element, it is classified.
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The routine is only available in macros. See Chapter Macros for more information about macro
creation and macro actions. However, the routine works similar as the classification part of the
Find Danger Objects tool in the View Powerline toolbox.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Compare against Defines the reference elements: TerraScan
wires or Any linear elements.

Wire levels CAD file level(s) on which the reference
elements are placed. Separate several
level numbers by a comma or minus, for
example 1-10,13.

Find using Method of danger point definition: Vertical
distance to wire, 3D distance to wire, or
Falling tree logic.

Within distance Radius that defines a 3D buffer around a
reference element. The buffer is added to
the reference element for computing
distances to points.

Within offset Horizontal distance from a reference
element that defines a corridor. Points
within the given corridor are analyzed
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SETTING EFFECT

whether they are potential danger points
or not.

Ground class Point class with ground points. This is only
active if Find using is set to Falling tree
logic.
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By best match
Not Lite

By best match routine classifies groups of points into several classes according to object types.
For each group, the routine tests the probability that the group represents an object, such as a
building roof, a wall, a tree, a pole, and so on. The group is classified as the object that gets the
highest probability.

The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.

SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class from which to classify points.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Plane tolerance Distance how well points of a group must
match a plane equation. This effects the
classification of groups as roofs and walls. If
a group is large enough and fulfills the
planarity condition, it's classified as roof or
wall. The smaller the tolerance value, the
less likely a group is classified as roof or
wall.

To classes If an option is switched on, the routine
checks the probability of groups fitting to
the object type. If a group fits to an object
type, the points of the group are classified
into the given target class.

By centerline

By centerline routine for groups classifies points into another class if all points, the majority of
points, or just a single point of a group is within a given distance from a linear element.

The linear elements that are used by this routine can be lines, polylines (Spatix) or line strings
(MicroStation), arcs, polygons (Spatix) or shapes (MicroStation), big elements (Spatix) or
complex elements (MicroStation) consisting valid simple element types.. The classification is
performed by using either selected elements or elements on a specified CAD file level.

If multiple elements are used, each laser point is classified according to the offset distance to
either the closest linear element or to any of the linear elements. In addition to the horizontal
distance, the elevation distance can be included in the classification process.
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The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.

SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Use Defines what elements are used:

· Selected linear elements - any selected
elements in the CAD file. This requires
the selection of elements before starting
the routine.

· Elements by level - any elements that are
located on a given CAD file level.
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SETTING EFFECT

Level Name of the CAD file level where elements
are located that are used for the
classification. This is only active if Use is set
to Elements by level.

Centerline rule Determines the reference point(s) within a
group:

· One or more points - groups are classified
if one or more points are within the given
distance.

· Average xy - groups are classified if the
average xy point is within the distance.

· Majority of points - groups are classified if
the majority of points is within the
distance.

· All points - groups are classified if all
points are within the distance.

Compare with Determines which linear element effects
the classification of a group:

· Any line - groups are classified if they are
within the distance of any linear element.

· Closest line - groups are classified if they
are within the distance of the closest
linear element.

Side Side on which to classify groups: On left
side, On either side, or On right side. The
side is relative to the digitization direction
of the linear element.

Offset Minimum and maximum horizontal
distance. Groups within the offset range are
classified.

By elevation difference If on, only groups within the given elevation
distance range from the linear element are
classified. Define the elevation offset in the
Dz fields.

By class

By class routine for groups classifies points into another class if all points, the majority of
points, or just a single point of a group belongs to the source class.

The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.
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SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class from which to classify points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class to classify points into.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

By distance
Not Lite

By distance routine classifies groups of points which are within a given distance range.
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The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.

SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class from which to classify points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class to classify points into.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.
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SETTING EFFECT

Use value Value that determines the distance of a
group:

· Biggest - groups is classified if the biggest
distance value is within the given
distance range.

· Median - groups is classified if the
median distance value is within the given
distance range. 

· Average - groups is classified if the
average distance value is within the given
distance range.

· Smallest - groups is classified if the
smallest distance value is within the
given distance range.

Min distance Minimum distance value.

Max distance Maximum distance value.

By parameters
Not Lite

By parameters routine classifies groups of points according to parameters stored in a parameter
file. The parameter file can be created by using the Test parameters command.

SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class from which to classify points.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Parameter file Text file that stores the parameters for
classification. Use the Browse button in
order to open a standard dialog for opening
a file.

By vegetation index
Not Lite

By vegetation index routine classifies groups of points based on a vegetation index
computation. The routine requires that color values have been extracted for the points. Color
values for laser points can be extracted from raw images or raster attachments loaded into
TerraPhoto, or assigned per class by setting values for red, green, and blue channels. See
Extract color from images and Assign color to points for corresponding commands in TerraScan.

TerraScan can assign up to 10 color channels for each point. The maximum amount of color
channels can only be stored in the TerraScan FastBinary format. LAS 1.4 format and later can
store up to 4 color channels, LAS 1.2 format and later up to 3.

There are two methods for computing the vegetation index.

Normalized difference

The method assumes that channel 0 stores red (R) and channel 3 near-infrared (NIR) color
values. The normalized difference value is computed with the following equation:

ND = (NIR - R) / (NIR + R) -1 <= ND <= +1

Visual band difference
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The method assumes that channel 0 stores red (R), channel 1 green (G), and channel 2 blue (B)
color values. The visual band difference value is computed with the following equation:

VBD = (2*G - R - B) / (2*G + R + B) -1 <= VBD <= +1

The routine is well suited for separating points on vegetation from non-vegetation points. You
can check how well the vegetation index computation separates vegetation from non-
vegetation points by displaying points by vegetation index. The larger the difference value, the
more likely a point is representing vegetation.

The routine further requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.

SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.
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SETTING EFFECT

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Index type Method of vegetation index computation:
Normalized difference or Visual band
difference.

Min value Minimum difference value to be classified.

Max value Maximum difference value to be classified.

Moving objects
Not Lite

Moving objects routine classifies groups of points that are captured from moving objects. It can
be used for mobile laser data sets. The routine requires that data from multiple lines or
scanners is available. It should be applied after data has been matched but before data from
overlapping lines is cut off.

The following preparation steps should be performed before moving object detection (all
available also as macro actions):

1. Classify hard surface on the road.

2. Compute distance from hard surface.

3. Classify 2-3 elevation steps above the road surface using the by distance routine (e.g. road
low <0.5m, road medium 0.5-3.0m, road high >3.0)

4. Compute normal vectors for the 3 above-road classes. Use Turn normals = Towards trajectory
and do not separate lines/scanners.

5. Assign groups for the road medium and road high classes. Use method Group by density, Gap
= Automatic and a reasonable value for required points per group (depending on point
density).

The routine classifies groups of points that are captured at one moment of time. At another
moment of time, when the area was captured by another scanner or in another line, there are
no points at the moving object's location but point from behind the moving object.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Time difference Minimum time difference between points
on the moving object and points from
behind the moving object.

Search radius 3D radius around each point within which
only points of the same group can be
located. Points on a moving object are
considered to belong to the same group. A
group is classified if there are no points
from another group or without a group
number falling within the given search
radius.

Limit Controls how often the moving object was
seen by scanner(s) and in different lines. In
best case, the moving object is seen only
once (i.e. in one line or by one scanner).
The recommended value is 20%, a value of
0% would mean that all of the moving
object was seen only once.

Require Controls the rate of laser beams that did
not hit the moving object but went
through. The recommended value is 0%
which means that no points are accepted
from other than the moving object.
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SETTING EFFECT

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

One point in group

One point in group routine for groups classifies one point for each group that fullfills the
classification condition. This may be the point with the highest or lowest value of point
attributes, or the point closest to the 3D center of the group.

The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.

SETTING EFFECT

Groups with Determines which groups are classified:

· One or more points - groups with one or
more points in the source class.

· Majority of points - groups with the
majority of points in the source class.

· All points - groups with all points in the
source class.

From class Source class from which to classify points.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Classify point Classification condition:

· Highest Z - highest elevation value.

· Lowest Z - lowest elevation value.

· Closest to 3D center - closest to the 3D
center of the group.
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SETTING EFFECT

· Highest intensity - highest intensity
value.

· Lowest intensity - lowest intensity value.

· Biggest distance - biggest distance value.
This requires that a distance value has
been computed for the points in the
source class.

· Smallest distance - smallest distance
value. This requires that a distance value
has been computed for the points in the
source class.

To class Target class to classify points into.

Inside fence Determines how a fence or selected
polygon(s) effect the classification:

· Not used - fence or selected polygons are
ignored.

· One or more points - groups are classified
if one or more points are inside.

· Average xy - groups are classified if the
average xy point is inside.

· Majority of points - groups are classified if
the majority of points is inside.

· All points - groups are classified if all
points are inside.

Non-grouped points
Not Lite

Non-grouped points routine classifies points that are not assigned to any group.

The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.
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SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

To class Target class.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Trees
Not Lite

Trees routine classifies groups of points that are captured from tree crowns. It can be used for
mobile laser data sets. The routine requires that normal vectors have been computed using the
Compute normal vectors command or corresponding macro action. The normal vector attributes
can be stored for points in TerraScan FastBinary files. The routine classifies irregular groups of
points.

Further, it is recommended to classify points above the ground into a separate class, so that this
class contains points in an elevation range above ground where tree crowns are included.

The routine requires that points have been assigned to groups using the Assign groups
command or corresponding macro action.

SETTING EFFECT

From class Source class(es).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
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SETTING EFFECT

classes from the list that are then used in
the From class field.

To class Target class.

Min height Minimum height of a point group above
ground considered for classification.

Min width Minimum width of a point group
considered for classification.

Inside fence only If on, points inside a fence or selected
polygon(s) are classified.

Another way to classify trees is provided by the By best match routine for point groups.
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Macros

Macros provide a method to automate processing steps. The best level of automation is
reached when using macros together with a project definition. See Chapter Working with
Projects for information about projects in TerraScan. In the UAV version of TerraScan, projects
are not available and macro execution is limited to points loaded in TerraScan.

Macros consist of a number of processing steps which are executed one after the other.
Processing steps can classify points, modify points, delete points, transform points, output
points, update views, execute commands, or call functions from other Terra applications.
Macros may also contain comments.

Macros are stored as text files with the default extension .MAC.

TerraScan Lite does not include any macro functionality.
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Create a macro
Not Lite

A macro can be created in TerraScan using the Macro command from the Tools pulldown menu
in the TerraScan window. The Macro dialog lets you add, modify, delete, and arrange
processing steps and comments. It also provides pulldown menu commands to open, save, and
run macros. Each line in the macro dialog represents one comment line or one processing step
that is performed on the point cloud when running a macro.

To create a macro:

1. Choose Macro command from the Tools pulldown menu in the TerraScan window.

This opens the Macro dialog:

2. (Optional) Type a description of the macro in the Description field.

3. (Optional) Type your name in the Author field.

4. Click Add to add a new processing step to the macro.

This opens the Macro step dialog, a dialog for defining Macro actions and related settings.

5. Define settings for the macro step and click OK.

You can continue to steps 4 and 5 until all the steps are complete.

6. Select Save as from the File pulldown menu to save the macro into a file.

SETTING / BUTTON / COMMAND EFFECT

Description Description of the macro.

Author Name of the author.
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SETTING / BUTTON / COMMAND EFFECT

Process lines separately If on, the macro steps are performed for each
line separately. Line refers to data of a single
line in an ALS data set or a single drive path in
an MLS data set. Lines are identified in the
point cloud by the line attribute, a unique
number for each point.

Process scanners separately If on, the macro steps are performed for each
scanner separately. Scanner refers to data of
a single scanner in a multiple scanner system
(usually MLS systems). Scanners are
identified in the point cloud by the scanner
attribute, a unique number for each point.

Step By clicking this button, the selected macro
step is executed on loaded points. With this
button, you may check settings of macro
actions step-by-step.

Slave can (not) run The note indicates whether a macro can be
processed in TerraSlave or not. See
TerraSlave User Guide for more information.

Add Add a new macro step.

Insert Insert a new macro step before the selected
macro step.

Edit Modify settings for the selected macro step.

Delete Delete the selected macro step.

Move up Moves a selected macro step one line up in
the macro.

Move down Moves a selected macro step one line down
in the macro.

File / New Create a new macro. This removes any active
macro from the macro dialog and starts a new
macro definition. If another macro is still
active, a dialog asks you to confirm whether
you want to start a new macro or not.

File / Open Open an existing macro file. This opens a
standard Windows dialog for opening files.

File / Save Save changes to an existing macro file.

File / Save As Save a macro into a new file. This opens a
standard Windows dialog for saving files.

Run / On loaded points Run the active macro on loaded points.

https://terrasolid.com/guides/tslave/index.html
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SETTING / BUTTON / COMMAND EFFECT

Run / On selected files Run the active macro on selected files.
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Run macros in TerraSlave
Not Lite, Not UAV

TerraSlave is a program for executing TerraScan macros. It is included in a full TerraScan version
but it can also run with an own license on a computer without TerraScan and a CAD platform
installed. It can be launched from TerraScan Run macro on blocks dialog.

The main benefits of using TerraSlave are:

· The CAD platform and TerraScan are immediately free for interactive work while the macro
is running.

· It can use more memory and processor power than an application running on top of a CAD
platform.

· It can queue several tasks for being executed one after the other without further
interaction.

· It can utilize several computers in the network.

· Powerful servers can be used for batch processes.

Besides executing the macro steps, TerraSlave provides a simple task management system
called TerraDispatcher. This includes the display of processed working segments and computers
involved in the processing task, the ability to abort tasks, the ability to restart processing for a
working segment and other options to interact with the process. The TerraSlave User Guide
describes the application in detail.

There are some macro actions and processing options that do not work with TerraSlave. This
includes:

· Start a task on computer 1 and start another task on computer 2 modifying the same data set.

· Run on another computer, if local paths are used. Network directories used in macros must
be shared in order to enable TerraSlave to read and write data into a folder over the
network.

· Run on multiple computers, if an output step writes into the same output file for all blocks
(Output points or Output by line macro steps).

· Use Inside fence only setting in a macro step.

· Use Keyin command step.

· Use a step that requires functionality of other Terra applications, such as Apply correction
and Create model.

· Use Write to design step.

The Macro dialog shows whether a macro can run in TerraSlave or not. See Create a macro for
more information. The options for TerraSlave processing are stored in the macro file header:

· SlaveCanRun=1 - Macro can be executed by TerraSlave.

· AnotherComputerCanRun=1 - Macro can be executed by TerraSlave on another computer.

· CanBeDistributed=1 - Macro can be executed by TerraSlave on multiple computers.

https://terrasolid.com/guides/tslave/terradispatcher.html
https://terrasolid.com/guides/tslave/index.html
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If one of these options is set to 0, the option is not available due to the above listed restrictions
for running macros in TerraSlave. Macros are stored as text files, so you can check the file
header in any text editor.

To run a macro in TerraSlave:

1. (Optional) Select blocks in the TerraScan Project window if you want to execute the macro on
selected blocks only.

2. Select Run macro command from the Tools pulldown menu in the TerraScan Project window.

This opens the Run Macro on Blocks dialog:

3. Define settings as described in Run a macro on a project.

4. Switch on Run using TerraSlave.

5. Click on Settings button.

This opens the TerraSlave Task Settings dialog:
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6. Select from the Run using list, whether to execute the macro on your computer only or on
network computers.

Depending on the selection, the dialog provides different options.

For this computer, you can set the number of Instances for TerraSlave processing in the
corresponding dialog field.

For network computers, the list shows the computers set for TerraSlave processing in the
Slave computers category of TerraScan Settings. By default, all computers are switched on.
Switch off a computer that you want to exclude from processing the macro. You can also
change the number of instances used for TerraSlave processing on a computer. Click on the
number behind the computer name and type a new number in the text field. Press <Enter>
to set the new number.

By default, TerraDispatcher will take care of dispatching the task to computers and instances
automatically. Select Manually in the Dispatch list if you want to control this manually.

The Interval value determines the time interval at which the TerraDispatcher checks for
pending tasks and updates the progress display.

7. Click OK.

https://terrasolid.com/guides/tslave/terradispatcher.html
https://terrasolid.com/guides/tslave/terradispatcher.html
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8. Click OK to the Run macro on blocks dialog.

This launches TerraDispatcher if it is not already running and starts processing the task in
TerraSlave. If another process is already running, the task file is added to the queue and
processed as soon as the other tasks are finished. See TerraSlave background processing
workflow for a more detailed description of TerraSlave task management.

https://terrasolid.com/guides/tslave/terradispatcher.html
https://terrasolid.com/guides/tslave/processing-workflow.html
https://terrasolid.com/guides/tslave/processing-workflow.html
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Run a macro on a project
Not Lite, Not UAV

Most often, macros are executed on a TerraScan project. See Working with Projects for detailed
information about projects in TerraScan.

You can run a macro on all or selected blocks of a project. A macro can be performed by either
using TerraScan or TerraSlave.

After a macro has been executed on a project in TerraScan, the Macro execution window
appears. It shows a report that lists for each block binary file the amount of loaded points, the
executed macro steps and a return value, as well as the amount of saved points, if applicable.
The return value can be the amount of points that has been effected by the macro step or
another value specifying the result of the macro step. If a processing step failed, the line in the
report appears in red color. A definition of the return values for many processing functions is
given in Section Function Prototypes. The macro report can be saved as text file using the Save
as command from the File pulldown menu or printed using the Print command from the File
pulldown menu in the Macro execution dialog.

If a macro is executed in TerraSlave, the report of the macro execution is saved as text file in
the TerraSlave installation folder, such as C:\TERRA64\TSLAVE\REPORTS. One report file is
created for each block included in the macro process. The TerraSlave User Guide describes in
detail the processing workflow of TerraSlave.

To execute a macro(s) on blocks:

1. (Optional) Select blocks in the TerraScan Project window if you want to execute the macro on
selected blocks only.

2. Select Run macro command from the Tools pulldown menu in the TerraScan Project window.

This opens the Run Macro on Blocks dialog:

https://terrasolid.com/guides/tslave/index.html
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3. Define settings and click OK.

This executes the macro on all or selected blocks. The application loops through the blocks,
loads the corresponding block binary file, performs the macro step(s) and, if applicable,
saves the modified points back to the block binary file or into another output file.

SETTING EFFECT

Process Blocks to process: All blocks or Selected
blocks.

Macros Macro files to execute. Macros are executed in
top-down order.

Neighbours Distance from the boundary of the active
block for which the application loads points
from neighbouring blocks. See Section
Neighbour points for more information.

Save points Method of saving the points after processing:

· Do not save - points are not saved to the
original block binary files. Use this, if the
macro includes an output step which writes
the results into new files.

· Write over original - original block binary
files are overwritten.

· Temporary copy & replace original - a copy
is created for each processed block binary
file. TerraScan moves the copies at the end
of the macro process to replace the original
block binary files.
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SETTING EFFECT

· Create new copy - a new file is created for
each processed block binary file.
Additionally, the project file is copied to the
directory where the new binary files are
stored. The original block binary files are
not changed.

Temporary Directory for storing the temporary copies of
the block binary files. This is only active if
Save points is set to Temporary copy & replace
original.

Write to Directory for storing the new block binary
files. This is only active if Save points is set to
Create new copy.

Run using TerraSlave If on, the macro is performed by TerraSlave.
See Section Run macros in TerraSlave for more
information.

Fit view Views to fit after loading a block binary file:
None, All, or any CAD file view specified by its
number.

Update all views after loading If on, all views are updated after loading a
block binary file.

Neighbour points

Neighbour points should be loaded in addition to the points of the active block, if the macro
includes certain processing steps. For these steps, the application needs information from
neighbouring areas in order to process the points along block boundaries correctly and to
ensure smooth transitions between blocks. The steps include:

· all classification steps that include a search radius parameter or rely on points within a local
environment around a point, such as Air points, Closeby points, Isolated points, Low points,
Below surface

· Ground, Hard surface and Surface classification

· Model keypoints and Contour keypoints classification

· Buildings and Walls classification

· Assign groups, Fix border groups, Classification routines for groups, Split groups by class

· Compute distance, Compute normal vectors, Compute section parameters, Compute slope
arrows

· Cut overlap

· Export lattice

· Find paint lines, Find poles, Find wires

· Fix elevation

· Scale intensity
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· Search tie lines

· Smoothen points, Thin points

· Vectorize buildings

The distance for loading neighbour points measured from the block boundary outwards
depends on the processing step. If only a local environment around a point is required, a small
area of neighbour points may be enough. For ground, keypoints, or building classifications, the
maximum edge length of buildings in the project area can be used as estimation for the
neighbour points area. For other processing steps, the parameters of the step may also provide
some good estimation, such as lengths, distances, radius values, etc..

If the distance for loading neighbour points is too small, the result of a macro step may not be
satisfying because of lacking information from the surrounding of a block. If the distance is too
big, there is a risk that too many points need to be loaded for processing a block. This may lead
to memory issues and long processing duration, in worst case to the failure of the macro (step)
execution.

Points from neighbour blocks do not belong to the active block and are not saved with the
active block points.
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Run a macro on loaded points
Not Lite

You can execute the active macro on the points that are loaded in TerraScan. To run the
complete macro, select On loaded points command from the Run pulldown menu in the Macro
dialog.

You can also execute a macro by entering a key-in commandMicroStation or SpaccelSpatix, such as:

scan run macro modelkey.mac

which would read and execute the file MODELKEY.MAC. If no directory is specified in the key-in
command, the application searches the macro file in the directory specified in the
TSCAN_MACRODIR environment variable in the Configuration Variables for MicroStation
definition.

A macro can be executed step-by-step on loaded points using the Step button in the Macro
dialog. This is useful to test the result of the separate processing steps when creating a macro.

After a macro has been executed on loaded points, the Macro execution window appears. It
shows a report that lists all macro steps and a return value. The return value can be the amount
of points that has been effected by the macro step or another value specifying the result of the
macro step. If a processing step failed, the line in the report appears in red color. A definition of
the return values for many processing functions is given in Section Function Prototypes.

The macro report can be saved as text file using the Save as command from the File pulldown
menu or printed using the Print command from the File pulldown menu in the Macro execution
dialog.
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Run a macro on selected files
Not Lite, Not UAV

A macro can be executed on selected files. You select a number of input files and optionally,
additional transformation and/or file storage settings. When the macro is executed, the
application loads one input file at a time, executes the macro steps on the points extracted
from the input file and, if applicable, writes the results into an output file.

The input files can be in any format that TerraScan supports. Thus, the command provides a
possibility to apply processing steps in batch mode to files that are not supported in TerraScan
projects, such as text files.

After a macro has been executed on loaded points, the Macro execution window appears. It
shows a report that lists for each input file the amount of loaded points, the executed macro
steps and a return value, as well as the amount of saved points, if applicable. The return value
can be the amount of points that has been effected by the macro step or another value
specifying the result of the macro step. If a processing step failed, the line in the report appears
in red color. A definition of the return values for many processing functions is given in Section
Function Prototypes.

The macro report can be saved as text file using the Save as command from the File pulldown
menu or printed using the Print command from the File pulldown menu in the Macro execution
dialog.

To run a macro on selected files:

1. Select On selected files command from the Run pulldown menu in the Macro dialog.

This opens the Run Macro on Files dialog:
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2. Click Add to add files to the list of files to process.

This opens the Select files to run macros on dialog, a standard dialog for opening multiple
input files.

3. Select files and click Open.

You may continue with step 2 to add additional files.

4. Define additional settings in the Run Macro on Files dialog, if applicable.

5. Click OK to start the process.

SETTING EFFECT

Add Add files for processing.

Remove Remove selected files from the list of files to
process.

Fit view View to fit after loading an input file: None,
All, or any CAD file view specified by its
number.

Update all views after loading If on, all views are updated after loading an
input file.



TerraScan User Guide  © 2023 Terrasolid Ltd

871Macros > Run a macro on selected files >  

SETTING EFFECT

Input format Definition of the input file format. The list
contains all binary and text formats that are
implemented in TerraScan as well as formats
defined in File formats / User point formats
category of TerraScan Settings. Implemented
file formats are usually recognized
automatically.

Input projection Projection system of the input data. Click on
the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

Active projection Projection system of the processed data.
Click on the >> Button to open the Browse for
Projection System dialog. The dialog provides
a search option for projection systems as well
as a list of all implemented systems. In
addition, any user-defined projection
systems are included in the list.

Transform Additional transformation applied to the
output files. The list contains transformations
defined in Coordinate transformations /
Transformations category of TerraScan
Settings.

Save As Format of the output file(s). The list contains
most of the binary and text formats that are
implemented in TerraScan as well as formats
defined in File formats / User point formats
category of TerraScan Settings. Select Do not
save all points option if there is a more
selective output step included in the macro.

Directory If on, you can specify the directory into which
output files are written.

File name If on, you can specify a name for the output
file(s). You may include the #name Variable
as part of the file name. This uses the name
of the input file as name (or part of the
name) for the corresponding output file. See
File Name Variables for more information.

Extension If on, you can specify the extension of output
file(s).
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Macro actions
Not Lite

When you click on the Add button in the Macro dialog, the Macro Step dialog opens:

The Action field includes a list of all available macro actions. Depending to the selected action,
another dialog may open when OK is clicked or the dialog may be expanded when the action is
selected. The settings for the selected macro action are then defined in the next or expanded
dialog.

An overview of macro actions is given in the table below. There is a corresponding tool or menu
command for many of the macro actions. The following Sections explain only the settings and
parameters that are specific for the macro actions. Otherwise, there is a link to the description
of the corresponding tool or command.

TO USE ACTION

Apply a classification routine for single
points

Classify points

Apply a classification routine for groups Classify groups

Assign groups to laser points Modify groups > Assign groups

Fix groups along block boundaries Modify groups > Fix border groups

Clear group numbers of selected classes Modify groups > Clear by class

Copy the group attribute from the closest
neighbor point

Modify groups > Copy from closest

Split groups by class Modify groups > Split groups by class

Draw polygons around point groups Vectorize > Draw polygons

Detect paint markings from point cloud data Vectorize > Find paint lines

Detect poles from point cloud data Vectorize > Find poles

Detect overhead wires from point cloud data Vectorize > Find wires

Create 3D models of buildings Vectorize > Vectorize buildings

Call an Addon function Addon command

Adjust misalignment angles Adjust angles
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TO USE ACTION

Apply a TerraMatch corrections file to laser
data

Apply correction

Assign a color to laser points Assign color

Create a surface model in TerraModeler Create model

Add a comment line to a macro Comment

Compute normal vectors for laser points Compute normal vectors

Compute parameters of road cross sections Compute section parameters

Compute slopes on road surfaces Compute slope arrows

Convert time stamps of laser data Convert time stamps

Cut off points from long range
measurements

Cut long

Cut off points from overlapping lines Cut overlap

Assign line number from trajectories to laser
points

Deduce line numbers

Delete points of certain class(es) Delete by class

Delete points of certain line(s) Delete by line

Execute a Windows command Execute command

Export a lattice model Export lattice

Extract additional points from waveform
information

Extract echoes

Fix the elevation of points Fix elevation

Execute a key-in command Keyin command

Adjust color values of points Modify color

Modify line numbers of points Modify line numbering

Save points into new files Output points

Save points into new files separated by line Output by line

Save points into the original file Save points

Manipulate intensity values Scale intensity

Run a tie line search in TerraMatch Search tie lines

Smooth the elevation of points Smoothen points

Sort points by time stamps or coordinate
values

Sort points
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TO USE ACTION

Thin points to a lower density Thin points

Apply a transformation to the points Transform points

Update the display of a CAD file view Update views

Create a section points data set Write section points

Write points into CAD file Write to design

Each macro action returns a value that indicates whether a process was successful or failed. The
return value can be the amount of points that has been effected by the macro action or another
value specifying the result of the macro action. The return value is displayed in the Macro
execution window if a macro was executed in TerraScan or it is written in the report text file if
the macro was executed in TerraSlave. If a processing step failed, the line in the Macro
execution window appears in red color and the return value is usually -1.

Classify points
Not Lite

Classify points action requires the selection of a classification routine in the Routine list of the
Macro step dialog. The routines available in the list are basically the same as in the Routine
sub-menu of the TerraScan window. However, a few classification routines can be executed in
macros only.

The classification routines are described in detail in Section Points of Chapter Classification
Routines.

Return value: Number of points that were effected by the process or a value < 0 if the process
failed. The return values for failed processes can be found in Section Function Prototypes.

Classify groups
Not Lite

Classify groups action requires the selection of a classification routine in the Routine list of the
Macro step dialog. The routines available in the list are basically the same as in the Group /
Classify sub-menu of the TerraScan window.

The classification routines are described in detail in Section Groups of Chapter Classification
Routines.

Return value: Number of points and groups that were effected by the process or a value < 0 if
the process failed. The return values for failed processes can be found in Section Function
Prototypes.
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Assign groups
Not Lite

Assign groups action performs the same process as the Assign groups command.

If the macro step is performed on project level, the step creates a text file for each block. The
text file stores the group number and center coordinates of each group that is cut by the block
boundary. The enables the harmonization of group numbers along block boundaries with the
Fix border groups macro step.

Return value: Number of points that were effected by the process or -1 if the process failed.

Fix border groups
Not Lite

Fix border groups action harmonizes group numbers along block boundaries. It requires that
group numbers have been assigned to the points for all blocks of a project. The group
assignment must be done with the Assign groups macro step on project level because Fix
border groups relies on the text files that are created by the macro step.

SETTING EFFECT

Delete group file If on, the text files created by the Assign
groups macro action are deleted after groups
along block boundaries have been fixed.

Return value: Number of groups that were effected by the process or -1 if the process failed.

Clear by class
Not Lite

Clear by class action performs the same process as the Clear by class command.

Return value: Number of points that were effected by the process or -1 if the process failed.
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Copy from closest
Not Lite

Copy from closest action performs the same process as the Copy from closest command.

Return value: Number of points that were effected by the process or -1 if the process failed.

Split by class
Not Lite

Split by class action performs the same process as the Split by class command.

Return value: Number of groups that were effected by the process or -1 if the process failed.

Draw polygons
Not Lite

Draw polygons action performs about the same process as the Draw Polygons command.
However, instead of drawing polygons immediately into the CAD file, the process writes the
coordinates of the polygon vertices into text files.

The text files can be read into the CAD file by using the Read / Polygons command in order to
draw the polygons. The storage location and name of the output file(s) are defined in the action
settings. If the macro runs on a project with several blocks, the file name should include a
variable, such as the block name or number.

Return value: Number of polygons written in the text file, -1 if the process failed, or -2 if the
output files could not be written.
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Find paint lines
Not Lite

Find paint lines action finds linear chains of a given width from points. The linear chains may
represent paint lines in the center or along the edges of roads.

A macro should first classify points with high intensity values using By intensity routine from
the road surface into a separate class. If color values are stored for the points, By color routine
could be used as an alternative to classify bright points. The result of the classification by
intensity or color values should include points on paint markings but it will also include some
noise points in the surrounding. Therefore, polygons for asphalt areas may be useful to exclude
points outside the area of interest. In addition, the noise in intensity values can be reduced by
using the Smoothen points routine.

The extraction of linear chains can be supported by an alignment element. Then, only chains
within a given angular tolerance from the alignment are extracted.

The action writes the extracted paint line information into text files. The information includes
the center point coordinates of a paint line, reliability value, normal direction in XY, and
extension of the line.

The text files can be read into the CAD file by using the Read / Paint lines command in order to
visualize the lines. The storage location and name of the output file(s) are defined in the action
settings. If the macro runs on a project with several blocks, the file name should include a
variable, such as the block name.

SETTING EFFECT

Approx width Approximate width of the linear chains in
the point cloud. Refers to the width of the
paint markings to extract.

Bright class Point class(es) that are included in the
linear chain extraction. The class(es) should
include mostly points on paint markings.
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SETTING EFFECT

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Bright class field.

Find Specifies how the software extracts linear
chains:

· All lines - all linear chains.

· Along selected vectors - only linear chains
Within the given angular tolerance.

Output file Storage location and name of the output
text file. If the macro runs on a project with
several blocks, the file name should include
a variable, such as the block name.

Browse Can be used to open a standard dialog for
selecting a storage location for a file.

Variable Can be used to define a variable as part of
the output file name. See Variables for a list
of available variables.

Return value: Number of line elements written in the text file.

Find poles
Not Lite

Find poles action performs about the same process as the Find Poles tool. However, instead of
drawing cell elements for the poles immediately into the CAD file, the process writes the cell
name and location into text files.

The text files can be read into the CAD file by using the Read / Poles command in order to
visualize the objects. The storage location and name of the output file(s) are defined in the
action settings. If the macro runs on a project with several blocks, the file name should include
a variable, such as the block name.
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Return value: Number of groups that are effected by the process and classified into the target
class.

Find wires
Not Lite

Find wires action performs about the same process as the Find Wires tool. However, instead of
drawing lines for the wires immediately into the CAD file, the process writes the coordinates of
vertices of each wire into text files.

The text files can be read into the CAD file by using the Read / Wires command in order to
visualize the wires. The storage location and name of the output file(s) are defined in the
action settings. If the macro runs on a project with several blocks, the file name should include
a variable, such as the block name.
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Return value: Number of points that are effected by the process and classified into the target
class.

Vectorize buildings
Not Lite

Vectorize buildings action performs about the same process as the Vectorize Buildings tool. The
main difference is that the building models are not drawn into the CAD file directly. Instead,
text files are created that stores drawing parameters for each building model and the corner
coordinates for all building model shapes.

The text files can be read into the CAD file by using the Read / Building models command in
order to visualize the building models. The storage location and name of the output file(s) are
defined in the action settings. If the macro runs on a project with several blocks, the file name
should include a variable, such as the block name.

Return value: Number of building models written in the text file.
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Addon command
Not Lite

Addon command action can be used to call a command of an addon function. Addons are the
interface between TerraScan and user-developed DLL functions. Chapter DLL Interface provides
more information about addons.

The Macro step dialog contains two input lines, one for the command syntax and another one
for parameter values.

Adjust angles
Not Lite

Adjust angles action performs the same process as the Adjust laser angles command.

The only difference in the input dialog is that Flight line and Scanner are text fields in the
Macro step dialog instead of selection lists in the command’s dialog. This means that you need
to type the number of a line and scanner for which you want to adjust angles. The following
values are accepted:

· Flight line - a number between 0 and 65535 or 99999 for any line.

· Scanner - a number between 0 and 255 or 9999 for any scanner.
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Trajectories must be loaded in TerraScan before starting a macro with the Adjust angles
action.

Return value: Number of points that were effected by the process or -1 if the process failed due
to missing trajectory information.

Adjust to geoid
Not Lite

Adjust to geoid action performs the same process as the Adjust to geoid command.

The only difference is in supported adjustment methods. The macro action supports
adjustment using built-in geoid models and model stored in a text file. It does not support
adjustment with a loaded TerraModeler surface or selected linear chain.

Return value: Number of points that were effected by the process or -1 if the process failed.
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Apply correction
Not Lite

Apply correction action applies corrections to points that were computed and stored by
TerraMatch. It requires a TerraMatch Solution file as parameter. The action performs the same
process as the Apply corrections tool of TerraMatch. The TerraMatch User Guide provides
extensive information about TerraMatch functionality and data processing.

Apply correction action can not run in TerraSlave.

Apply correction is a processing step that can not be easily undone. Therefore, it is
recommended to create a copy of the original block binary files if this action is included in a
macro.

Assign color
Not Lite

Assign color action performs the same process as the Assign color to points command.

Return value: Number of points that were effected by the process or -1 if the process failed.

Create model
Not Lite

Create model action creates a TerraModeler surface model. Basically, it performs the same
process as the Create surface model command. The action requires two additional parameters:

· Model name - name of the surface model in TerraModeler.

· Model file - name and extension (normally .TIN) of the surface model file that is stored on a
hard disk. The file is stored in the same directory as the CAD file.

 If the macro runs on a project with several blocks, the model name and model file name should
include a variable, such as the block name. This allows the clear identification of a model
loaded in TerraModeler and the storage of several model files in the same directory.

https://terrasolid.com/guides/tmatch/apply-correction.html
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Before the action is executed, TerraModeler is launched automatically if it is not yet running.
After execution, the surface model is active in TerraModeler and stored in the file on the hard
disk. The TerraModeler User Guide provides extensive information about TerraModeler
functionality and surface models.

Create model action can not run in TerraSlave.

Return value: Internal number of the surface model (starting from 1 for the first model) or -1 if
the process failed.

Comment
Not Lite

Comment action adds a comment line to the macro. Comment lines are introduced by a hash
character (#) that is added automatically before the text of the comment. The length of the
Comment text field is limited to 258 characters including spaces.

Compute distance
Not Lite

Compute distance action performs the same process as the Compute distance command.
Elements drawn in the CAD file can not be used as reference for distance computation in the
macro action.

Return value: Number of points that were effected by the process or -1 if the process failed.
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Compute normal vectors
Not Lite

Compute normal vectors action performs the same process as the Compute normal vectors
command.

Return value: Number of points that were effected by the process or -1 if the process failed.

Compute road parameters
Not Lite

Compute road parameters action extracts information from cross sections at regular spacing
along a road. The extraction requires a high density of points on the road surface. Therefore,
the action is only suited for MLS data sets. It requires the classification of points on the road
surface using the Hard surface routine. Additionally, points close to the surface points should
be classified using the By distance routine, for example points within an elevation range of ±1
cm.

The section parameter extraction relies on an alignment element, such as a line string
representing the centerline of a road. An Offset parameter in the action settings defines on
which side of the alignment (left or right) the cross sections are extracted. The left or right side
is defined relatively to the digitization direction of the alignment element. To get cross section
parameters for both sides, you need to add the Compute section parameters action two times
to a macro.

The following list contains the cross section parameters that can be extracted:

· Edge to edge slope - slope from the middle of the two leftmost points to the middle of the
two rightmost points.

· Cross section roughness - average distance of points to a line connecting the left- and
rightmost points.

· Maximum deviation - maximum distance from a point to a line connecting the left- and
rightmost points. The value is positive if the point is above the line and negative if the point
is below the line.

· Maximum rut depth - maximum elevation distance from a point to a line connecting two
other points in the section. The elevation distance is always measured downward from the
line to the point.

· Left rut depth - the left rut is searched in an interval from the left edge to the first point on
the right side of the cross section center. The left rut depth is the Maximum rut depth within
this interval (see illustration below).

· Right rut depth - the right rut is searched in an interval from the right edge to the first point
on the left side of the cross section center. The right rut depth is the Maximum rut depth
within this interval (see illustration below).
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· Left rut water depth - searched in the same interval as the Left rut depth. The rut water
depth is the maximum elevation difference from a point to a water surface in the left rut
(see illustration below).

· Right rut water depth - searched in the same interval as the Right rut depth. The rut water
depth is the maximum elevation difference from a point to a water surface in the right rut
(see illustration below).

· Section elevations - elevation distances between points to the fitted section line. The line is
fitted to all points of a cross section within a given tolerance. The elevation distance is
measured at given regular steps along the cross section, for example every 5 cm.

The process writes the section parameters into text files, one for each block binary file of a
TerraScan project. Depending on the selection of parameters for extraction, the text files
contain more or less columns with the section parameter values.

The text files can be read into the CAD file by using the Read / Section parameters command in
order to visualize the cross section parameters.
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You must select the alignment element before starting a macro with the Compute road
parameters action.

SETTING EFFECT

Class Source class(es) that are included in the
section parameter extraction.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the From class field.

Process Area to process and include in the output
file:

· All locations - area covered by the active
block binary file and possibly
neighbouring areas, if neighbour points
are loaded for the macro execution.

· Inside active block - area covered by the
active block binary file.

Step Distance between consecutive cross
sections. Measured along the alignment
element.
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SETTING EFFECT

Offset Defines the area for extracting the cross
section parameters relative to the
alignment element. If the offset values are
positive, the cross section are extracted on
the right side of the alignment. If the offset
values are negative, the cross section are
extracted on the left side of the alignment.

Depth Depth of a cross section. The points within
the cross section depth are included in the
parameter extraction.

Point spacing Distance between points along the cross
section that define the locations where the
cross section is analyzed for the parameter
computation.

Fit tolerance Defines how well a fitted cross section line
follows the points.

Output file Storage location and name of the output
text file. If the macro runs on a project with
several blocks, the file name should include
a Variable, such as the block name.

Variable Opens the Macro variable dialog which
contains the list of variables. Select the
variable that you want to use as part of the
output file name.

Parameters to write Switch on all parameters that you want to
include in the output file.

Return value: 0 if the process was successful, -1 if the process failed, or -2 if the output files
could not be written.

Compute slope arrows
Not Lite

Compute slope arrows action performs about the same process as the Draw Slope Arrows tool.
However, instead of drawing slope arrows immediately into the CAD file, the process writes
the slope arrow parameters into text files.

The text files can be read into the CAD file by using the Read / Slope arrows command in order
to visualize the slope arrows. The storage location and name of the output file(s) are defined in
the action settings. If the macro runs on a project with several blocks, the file name should
include a variable, such as the block name.
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You must select the alignment element before starting a macro with the Compute slope
arrows action.

Return value: Number of arrows written in the text file, -1 if the process failed, or -2 if the
output files could not be written.

Convert time stamps
Not Lite

Convert time stamps action converts the format of time stamps. Supported conversions are:

INPUT FORMAT CONVERTED FORMAT

GPS seconds-of-week GPS standard time

GPS time

GPS standard time GPS seconds-of-week

GPS time

GPS time GPS seconds-of-week

GPS standard time

Unix time GPS seconds-of-week

GPS standard time

GPS time

The conversion is necessary, for example, if data collected in several weeks is processed
together in one project. Then, GPS seconds-of-week time stamps result in repeated values and
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GPS standard time must be used in order to provide unique time stamps for each laser point.
This is a requirement for many processes that rely on the link between laser points and
trajectory information. Therefore, it is essential that time stamps of trajectories and laser data
are stored in the same GPS time format.

The conversion of time stamps can also be done when laser points are imported into a project.
See Import points into project command and Section Attributes to store of New project
command for more information.

Further, time stamps can be manipulated by using the Fix time macro action.

SETTING EFFECT

From Original time stamp format of the laser
points.

To Target time stamp format.

Lines Only points in the given line(s) are effected.
Use a comma or minus to separate several
line numbers, for example 2-5,10. 0-65535
stands for all lines.

Survey date Date when the laser data was captured. The
format is day/month/year (dd/mm/yyyy).
This is only active for the conversion from
GPS seconds-of-week to GPS standard time
or GPS time.

Return value: Number of points that were effected by the process or -1 if the process failed.

Cut long
Not Lite

Cut long action performs the same process as the Cut long range command.
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Return value: Number of points that were effected by the process, -2 if the process failed due
to invalid parameters.

Cut low reliability
Not Lite

Cut low reliability action performs the same process as the Cut low reliability command.

Return value: Number of points that were effected by the process.

Cut overlap
Not Lite

Cut overlap action performs the same process as the Cut overlap command.

Return value: Number of points that were effected by the process, -2 if the process failed due
to invalid parameters, or -4 if the process failed due to missing trajectory information.

Deduce line numbers
Not Lite

Deduce line numbers action performs the same process as the Deduce using time command.

Return value: Number of points that were effected by the process. An error message appears if
the process fails, for example due to missing trajectory information.

Delete by class
Not Lite

Delete by class action performs about the same process as options of the Delete command. The
action deletes points from the block binary files. You can select a certain class and specify the
area from which to delete points.

For LAS 1.4 files, you can specify that the withheld bit is set instead of removing points from the
file.
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SETTING EFFECT

Method Defines what method is applied to points:

· Delete points - deletes the point. This is the
normal method to remove points from a
file.

· Set withheld bit - sets the withheld bit for
points in LAS 1.4 files. The point itself is
kept in the file.

Class Point class(es) to delete. Use Any class to
delete all points.

Points Specifies the area for which to delete points:

· All points - all points are deleted.

· Inside fence only - all points inside a
MicroStation fence or selected polygons are
deleted.

· Outside fence only - all points outside a
MicroStation fence or selected polygons are
deleted.

· Outside block only - all points outside the
active block area are deleted.

Return value: Number of points that were effected by the process or -1 if the process failed due
to missing fence information.

Delete by line
Not Lite

Delete by line action performs about the same process as the By line option of the Delete
command. The action deletes points from the block binary files. You can define a certain line
number and specify the area from which to delete points.

For LAS 1.4 files, you can specify that the withheld bit is set instead of deleting points.
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SETTING EFFECT

Method Defines what method is applied to points:

· Delete points - deletes the point. This is the
normal method to remove points from a
file.

· Set withheld bit - sets the withheld bit for
points in LAS 1.4 files. The point itself is
kept in the file.

Line Line number of points to be deleted. A
number between 0 and 65535.

Points Specifies the area for which to delete points:

· All points - all points are deleted.

· Inside fence only - all points inside a
MicroStation fence or selected polygons are
deleted.

· Outside fence only - all points outside a
MicroStation fence or selected polygons are
deleted.

Return value: Number of points that were effected by the process or -1 if the process failed due
to missing fence information.

Execute command
Not Lite

Execute command action calls a Windows batch command. It starts the cmd.exe application of
Windows and executes the given command.

You can include variables in the batch command that refer to block binary files, such as the
block file name or project directory.

If the Wait for completion option is switched on, the software waits until the Windows batch
process is completed before starting any next macro step.
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The Command given in the image above copies all files with the extension .FBI from the D:
\DATA directory to the D:\DATA\LASER01 folder. Only when the copy process finished, the
other steps in the macro are started.

Export lattice
Not Lite

Export lattice action performs about the same process as the Export lattice model command for
loaded points and the Export lattice models command for projects. The major differences are:

· There are no selected shapes required that define the area for each lattice model. The area
is defined by the extend of loaded data or by the boundaries of the block binary files.

· Instead of defining a model buffer area, set a good distance for loading neighbour points
when the macro is executed.

· The storage location and name of the output file(s) are defined in the macro action settings.
If the macro runs on a project with several blocks, the file name should include a variable,
such as the block name.

· Text elements drawn in the CAD file can not be used in the macro action.
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Return value: 1 if the process was successful, 0 if the process failed due to the lack of points in
the source class, or -2 if the output files could not be written into the given directory.

Extract echoes
Not Lite

Extract echoes action performs the same process as the Extract Echoes tool. The action requires
that one or more polygons are selected before starting the macro.

Return value: Number of points that were effected by the process or -1 if the process failed.

Fix elevation
Not Lite

Fix elevation action performs the same process as the Fix elevation tool.

Return value: Number of points that were effected by the process.

https://terrasolid.com/guides/tscan/toolextractechoes.html
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Fix time
Not Lite

Fix time action manipulates the time stamps of laser points. You can multiply time stamps by a
factor and/or add a value to the time stamps.

SETTING EFFECT

Class Point class(es) for which the time
modification is computed.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Lines Points of the given line(s) are effected by
the time modification. Use a comma or
minus to separate several line numbers,
for example 2-5,10. 0-65535 refers to all
lines.

Multiply by Factor by which time stamps are
multiplied. Example: convert millisecond
time stamps to seconds.

Add Value that is added to time stamps.
Example: convert Unix seconds-of-day
time stamps to GPS seconds-of-day time
stamps.
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Keyin command
Not Lite

Keyin command action calls a key-in command of TerraScan. Key-in commands are described in
Chapter Key-in commands.

The Command given in the image above opens the TerraScan project from file PROJECT.PRJ
stored in folder D:\DATA\LASER01.

Match passes
Not Lite

Match passes action performs the same process as the Match passes command.

Return value: 1 if the process was successful or 0 if the process failed.

Modify color
Not Lite

Modify color action adjusts the color values of points. The components to adjust are brightness,
saturation and gray balance. The action requires that color values are stored for the points. It is
normally used after extracting color values from images, for example with Extract color from
images command for projects or Extract color from images command for loaded points.

The action performs the approximately same process as the Modify color command for loaded
points.
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SETTING EFFECT

Class Point class(es) that are effected by the
process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Brightness Value to add to the brightness of color
values. Accepts values between -100 and
500.

Saturation Value to add to the saturation of color
values. Accepts values between -100 and
200.

Red Value to add to the current red value of a
point. Accepts values between -65535 and
65535.

Green Value to add to the current green value of
a point. Accepts values between -65535
and 65535.

Blue Value to add to the current blue value of a
point. Accepts values between -65535 and
65535.

Return value: Number of points that were effected by the process.
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Modify line numbering
Not Lite

Modify numbering action performs the same process as the Modify numbering command.

Return value: Number of points that were effected by the process.

Output points
Not Lite

Output points action can be used to write points into a new file. A typical example is a macro
that:

1. classifies model keypoints.

2. writes only model keypoints into one output file for all block binary files.

3. does not effect the original block binary files in any way.

The action can also be used to write points block-wise into new files that may have a different
format than the original block binary files, for example for delivery purposes.

The output file format can be any of the Supported file formats implemented in TerraScan or a
user-defined point file format.

SETTING EFFECT

Points Points for output: All points which would
include neighbour points or Active block.
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SETTING EFFECT

Class Point class(es) that are included in the
output file(s).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Transform Transformation applied to the points
before an output file is written. The list
contains all transformation defined in the
Coordinate transformations /
Transformations category of TerraScan
Settings.

Inside fence only If on, only points inside a fence or selected
polygon(s) are included in the output
file(s).

To file Storage location and name of the output
file. If it does not include a directory, the
project directory is used. If there should be
one output file for each block binary file,
the file name must include a variable, such
as the block name. Add the extension of
the output file manually at the end of the
file name according to the selected output
Format.

Variable Opens the Macro variable dialog which
contains the list of variables. Select the
variable that you want to use as part of the
output file name.

Format Format of the output file(s).

Delimiter Character that separates different fields in
an implemented text file format: Space,
Tabulator, or Comma. This is only active if
Format is set to a text file format that does
not explicitly define the delimiter itself.

Xyz decimals Number of decimals stored for coordinate
values. This is only active if Format is set to
any text file format.

Append if file exists If on, input files are written into one
output file if the file name is the same. If
the output file name does not contain a
variable, all input files are written into a
single output file.
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SETTING EFFECT

If off, input files are written into individual
output file(s), if the file name contains a
variable. If no variable is used that makes
an output file name unique, the process
might overwrite existing files of the same
name.

Return value: Number of points that were written into the output file, -1 if the process failed
due to a missing fence, -2 if the output file(s) could not be written into the given directory, -3 if
the process failed due to invalid parameters, -4 if the process failed due to a missing
transformation.

Output by line
Not Lite

Output by line action can be used to write points into output files per line number. You would
typically use this to produce final output files for delivering each line in a separate file.

The output file format can be any of the Supported file formats implemented in TerraScan or a
user-defined point file format.

SETTING EFFECT

Lines Points of the given line(s) are included in
the output file(s). Use a comma or minus to
separate several line numbers, for
example 2-5,10. 1-65535 refers to all lines
and creates one output file for each line.
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SETTING EFFECT

Class Point class(es) that are included in the
output file(s).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Transform Transformation applied to the points
before an output file is written. The list
contains all transformation defined in the
Coordinate transformations /
Transformations category of TerraScan
Settings.

To file Storage location and name of the output
file. If it does not include a directory, the
project directory is used. If there should be
individual output files for several lines, the
file name must include the #line variable.
Add the extension of the output file
manually at the end of the file name
according to the selected output Format.

Variable Opens the Macro variable dialog which
contains the list of variables. Select the
variable that you want to use as part of the
output file name.

Format Format of the output file(s).

Delimiter Character that separates different fields in
an implemented text file format: Space,
Tabulator, or Comma. This is only active if
Format is set to a text file format that does
not explicitly define the delimiter itself.

Xyz decimals Number of decimals stored for coordinate
values. This is only active if Format is set to
any text file format.

Append if file exists If on, input files are written into one
output file if the file name is the same. If
the output file name does not contain a
variable, all input files are written into a
single output file.
If off, input files are written into individual
output file(s), if the file name contains a
variable. If no variable is used that makes
an output file name unique, the process
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SETTING EFFECT

might overwrite existing files of the same
name.

Return value: Number of points that were written into the output file, -3 if the process failed
due to invalid parameters, -4 if the process failed due to a missing transformation.

Save points
Not Lite

Save points action performs the same process as the Save points command. It saves the points
into their original binary file. There is no restriction for executing the action as for the menu
command.

Return value: Number of points that were effected by the process.

Scale intensity
Not Lite

Scale intensity action manipulates the intensity values of points. It computes new intensity
values according to a selected method:

· Direct scale - the new intensity value is the result of adding and/or multiplying the old value
with given values.

· Angle of incidence - the new intensity value is computed based on the angle of incidence of
a point and a given factor. The higher the factor, the stronger the effect of the intensity
correction. The method requires that normal vectors are available, they have to be
computed for each line separately, for example by the Compute normal vectors routine,
before applying the method. The computation effects only points of planar dimension. The
method is suited for MLS data sets for which the intensity values vary systematically
depending on the angle of incidence of the laser beam.

· Stretch spread - the new intensity value is computed based on the median and spread
values of the old values.

The Direct scale and Stretch spread methods are useful for adjusting intensity values of
different scanners, lines, or data collection days to each other. You can check the average,
median, and spread values of loaded points by using the Addon / View histogram command.
The values shown in the Laser intensity histogram window can be used as basis for the input
values of the Scale intensity action.
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SETTING EFFECT

Lines Only points in the given line(s) are
effected. Use a comma or minus to
separate several line numbers, for
example 2-5,10. 0-65535 refers to all lines.

Scanners Only points captured by the given
scanner(s) are effected. Use a comma or
minus to separate several scanner
numbers, for example 1-3,5. 0-255 refers to
all scanners.

Class Point class(es) that are effected by the
process.

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Method Method of computing new intensity
values: Direct scale, Angle of incidence, or
Stretch spread.

New value Values for computing the new intensity
value of a point. This is only active if
Method is set to Direct scale.

Factor Determines how strong the effect of
intensity value computation based on
angle of incidence is. This is only active if
Method is set to Angle of incidence.

Current median Current median of intensity values. This is
only active if Method is set to Stretch
spread.
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SETTING EFFECT

Current spread Current spread of intensity values. This is
only active if Method is set to Stretch
spread.

New median Target median of intensity values. This is
only active if Method is set to Stretch
spread.

New spread Target spread of intensity values. This is
only active if Method is set to Stretch
spread.

Max value Maximum allowed intensity value.

Return value: Number of points that were effected by the process.

Search tie lines
Not Lite

Search tie lines action performs a tie lines search in TerraMatch. It requires a TerraMatch tie line
search Settings file as parameter. The settings file can be created in the Search tie lines dialog
of TerraMatch. The action performs the same process as the Search tie lines command  of
TerraMatch. The TerraMatch User Guide provides extensive information about TerraMatch
functionality and data processing.

Running the macro action requires that TerraMatch is available on the same computer.

The macro action writes the tie lines into an output file. The storage location and name of the
output file(s) are defined in the action settings. If the macro runs on a project with several
blocks, the file name should include a variable, such as the block name.

SETTING EFFECT

Output file Storage location and name of the output tie
line file. Use the Browse button above the

https://terrasolid.com/guides/tmatch/search-tie-lines.html
https://terrasolid.com/guides/tmatch/search-tie-lines.html
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SETTING EFFECT

text field in order to open the Output file
dialog, a standard Windows dialog for
defining a file location and name. Use the
Variable button in order to select a variable
for the tie line file name.

Settings file Location and name of the tie line search
settings file.

Smoothen points
Not Lite

Smoothen points action performs the same process as the Smoothen points command.

Return value: 1 if the process was successful, 0 if the process failed, or -2 if the process ran out
of memory.

Sort points
Not Lite

Sort points action performs the same process as the Sort command.

Return value: 1 if the process was successful or 0 if the process failed.

Split trajectories
Not Lite

Split trajectories action performs the same process as the Split trajectories command.

Return value: always 1.

Thin points
Not Lite

Thin points action performs the same process as the Thin points command. The only difference
is that you can define the area for thinning points in the macro action. The process either
effects all points, points inside or points outside a fence or selected polygon(s).
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If points inside or outside a fence or selected polygon(s) are thinned, the macro step can not be
performed in TerraSlave.

Return value: Number of points that were effected by the process, -1 if the process failed due
to a missing fence, or -3 if the process failed due to invalid parameters.

Transform points
Not Lite

Transform points action performs the same process as the Transform loaded points command.

If the transformation manipulates the Z values of the points in a way that they do not represent
elevation values anymore but rather elevation differences, the macro must create a new copy
of the data instead of overwriting the original files. This applies if you run the macro on a
project or on selected files. These transformations include the types:

· Height from ground - elevation of each point is replaced by its height above ground. Ground
is defined by points in one or more point classes.

· Height from TIN - elevation of each point is replaced by its height above a TIN model. The
TIN model is defined by an active surface model in TerraModeler.

· Add TIN - elevation values of a TIN are added to the original elevation values of loaded
points. The corresponds to an Adjust to geoid action which uses a TIN as geoid model. The
TIN is defined by an active surface model in TerraModeler.

· Scale dZ from TIN - scaled elevation difference values between the loaded points and a TIN
are added to the original elevation values of loaded points. The TIN is defined by an active
surface model in TerraModeler.

Return value: Number of points that were effected by the process, -1 if the process failed due
to a missing fence, -2 if the process was aborted, -3 if the process failed due to invalid
parameters, -4 if the process failed due to a missing transformation.
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Update views
Not Lite

Update views action redraws all CAD file views that display points.

Return value: 1.

Write section points
Not Lite

Write section points action produces new files that contain only points of cross sections at
regular steps along an alignment element. The resulting files are suitable for visualizing data of
a corridor object, such as a road or railroad.

The action relies on a linear element that is used as alignment element. The parameters of the
action determine, how many points are written in the new files by settings like the width of the
sections left and right of the alignment element, the step size along the alignment element,
and the depth of the sections.

The output files can be written with either the original coordinates of the points or in an
artificial coordinate system Station-Offset-Z. The artificial coordinate system is defined by:

· X = scaled station along the alignment element.

· Y = offset to the left and right sides of the alignment element.

· Z = scaled elevation values.

The artificial coordinate system should be used, for example, to produce a data set suited for
digitization tasks along a corridor data set. The advantages are:

· faster viewing as the corridor is shortened.

· exaggerated elevation values make small elevation changes better visible.

· easier panning as the whole corridor runs along the view’s X axis without curves.

· better shaded surface display as the direction of the corridor relative to the light source
does not change.
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You must select the alignment element before starting a macro with the Write section
points action.

SETTING EFFECT

Format File format of the output files: FastBinary,
LAS, Scan binary 8 bit or 16 bit.

To file Storage location and name of the output
file(s). If there should be individual output
files for several block binary files, the file
name must include a Variable. Add the
extension of the output file manually at
the end of the file name according to the
selected output Format.

Variable Opens the Macro variable dialog which
contains the list of variables. Select the
variable that you want to use as part of the
output file name.

Class Point class(es) that are included in the
output file(s).

Opens the Select classes dialog which
contains the list of active classes in
TerraScan. You can select multiple source
classes from the list that are then used in
the Class field.

Left width Width of the cross sections to the left side
of the alignment element. The side is
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SETTING EFFECT

relative to the digitization direction of the
alignment.

Right width Width of the cross sections to the right side
of the alignment element. The side is
relative to the digitization direction of the
alignment.

Step Distance between consecutive cross
sections along the alignment element.

Depth Depth of a cross section.

Coordinates Defines the coordinate system of the
output files: Original or Station-Offset-Z.

Stations Scale factor for stations along the
alignment element. Determines the
compression of the original corridor
length. This is only active if Coordinates is
set to Station-Offset-Z.

Elevations Scale factor for elevation values.
Determines the elevation exaggeration.
This is only active if Coordinates is set to
Station-Offset-Z.

Return value: Number of points written into the output file or -1 if the process failed.

Write to design
Not Lite

Write to design action performs about the same process as the Write to design file command.
The action includes only Active symbology, Class, Line and Point color as coloring options for
drawing the points.
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Return value: Number of points that were effected by the process.
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File Formats

TerraScan stores point clouds in its own proprietary point file formats. It also supports the
standard format for point cloud data, LAS, and a number of text formats. See Supported file
formats for an overview. In addition, user-tailored text formats for point clouds can be defined
in the TerraScan Settings.

TerraScan can import trajectory information from several binary and ASCII formats. In addition,
user-tailored text formats for trajectories can be defined in TerraScan Settings. TerraScan
converts the files into its own trajectory format.
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Supported point file formats

TerraScan has built-in support for the following point file formats:

T = text file format R = read files
B = binary file format W = write files

NAME TYPE CONTENT

FASTBINARY B R/W TerraScan FastBinary (FBI).

SCAN8 B R/W TerraScan binary with 8 bit line numbers (BIN).

SCAN16 B R/W TerraScan binary with 16 bit line numbers (BIN).

TOPEYE B R TopEye binary (DTE) with geocentric coordinates.

EARTHDATA B R/W EarthData binary (EBN or EEBN).

LEICA B R Leica-Helava binary (LDI).

LAS B R/W Industry standard format, versions 1.0, 1.1, 1.2, 1.4. 
See more details below.

LAS B R Industry standard format, version 1.3. See more details
below.

LAZ B R/W Compressed LAS format, versions 1.0, 1.1, 1.2, 1.3, 1.4

PTS T R Leica PTS format.

XYZ T R/W Easting Northing Elevation

CXYZ T R/W Class Easting Northing Elevation

XYZI T R/W Easting Northing Elevation Intensity

CXYZI T R/W Class Easting Northing Elevation Intensity

PXYZI T R Pulse number Easting Northing Elevation Intensity

XYZXYZII T R East1 North1 Elev1 East2 North2 Elev2 Intensity1
Intensity2

TXYZXYZII T R Time East1 North1 Elev1 East2 North2 Elev2 Intensity1
Intensity2

TXYZI T R Time Easting Northing Elevation Intensity

XYZIXYZI T R East1 North1 Elev1 Intensity1 East2 North2 Elev2
Intensity2

TXYZIXYZI T R Time East1 North1 Elev1 Intensity1 East2 North2 Elev2
Intensity2

Grass Sites T W



TerraScan User Guide  © 2023 Terrasolid Ltd

914File Formats > Point file formats > Supported point file formats

NAME TYPE CONTENT

XYZdZ T W Easting Northing Elevation Elevation difference to a
surface

IdXYZ T W Index Easting Northing Elevation

IdXYZP T W Index Easting Northing Elevation Pulse number

In some dialogs, E is used instead of X and N is used instead of Y in order to refer to the
easting and northing coordinates, respectively.

More information: formats and their capabilities of storing attributes for points

LAS file format

The table below lists the Point Data Record Formats (PDRF) of LAS format versions as they are
handled by TerraScan.

LAS FORMAT VERSION READING CAPABILITIES BY
PDRF

WRITING CAPABILITIES BY
PDRF

LAS 1.0 - 1.2 0-5 0 - by default
1 - if there is time attribute
2 - if there is RGB attribute
but no time attribute
3 - if there are time and RGB
attributes
4 - no writing capability
5 - no writing capability

LAS 1.3 0-5 no writing capability

LAS 1.4 6-10 6 - by default
7 - if there is RGB attribute
8 - if there is RGBN attribute
9 - no writing capability
10 - no writing capability

TerraScan binary files

The recommended format for processing point clouds in TerraScan is FastBinary. This format
is not documented openly but information may be provided upon request.
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The information below refers to file formats which were last revised on 12.07.2001 and on
15.07.2002. These version dates are stored in the file header. Future versions of TerraScan may
store laser points into another format but will always recognize and read in the old files.

TerraScan reads and writes two versions of the old binary file format:

· Scan binary 8 bit line - a more compact version which can accommodate line numbers 0-
255. Files with this format have HdrVersion field set to 20010712.

· Scan binary 16 bit line - a slightly bigger version which can accommodate line numbers
0-65535. Files with this format have HdrVersion field set to 20020715.

See \TERRA64\ADDON\ROUTINES.C for example source code for reading in TerraScan binary
files.

File organization

TerraScan binary file consists of a file header of 48 bytes and a number of point records. The
size of the point record is 16 bytes for file version 20010712 and 20 bytes for file version
20020715. Each point record may be followed by an optional four byte unsigned integer time
stamp and an optional four byte RGB color value.

For example, a file containing four laser points and their time stamps using format 20020715
would consist of:

· 48 byte header (ScanHdr)

· 20 byte record for first point (ScanPnt)

· 4 byte time stamp for first point

· 20 byte record for second point (ScanPnt)

· 4 byte time stamp for second point

· 20 byte record for first three (ScanPnt)

· 4 byte time stamp for three point

Structure definitions

The structure of the file header is:

typedef struct {
 int     HdrSize ;     // sizeof(ScanHdr)
 int     HdrVersion ;  // Version 20020715, 20010712, 20010129 or

970404
 int     RecogVal ;    // Always 970401
 char    RecogStr[4];  // CXYZ
 long    PntCnt ;      // Number of points stored
 int     Units ;       // Units per meter = subpermast * uorpersub
 double  OrgX ;        // Coordinate system origin
 double  OrgY ;
 double  OrgZ ;
 int     Time ;        // 32 bit integer time stamps appended to points
 int     Color ;       // Color values appended to points
} ScanHdr ;

The structure of a point record for file version 20010712 is:
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typedef struct {
 BYTE    Code ;        // Classification code 0-255
 BYTE    Line ;        // Line number 0-255
 USHORT  EchoInt ;     // Intensity bits 0-13, echo bits 14-15
 long    X ;           // Easting
 long    Y ;           // Northing
 long    Z ;           // Elevation
} ScanRow ;

The structure of a point record for file version 20020715 is:

typedef struct {
 Point3d Pnt ;         // Coordinates
 BYTE    Code ;        // Classification code
 BYTE    Echo ;        // Echo information
 BYTE    Flag ;        // Runtime flag (view visibility)
 BYTE  Mark ;          // Runtime flag
 USHORT  Line ;        // Line number
 USHORT  Intensity ;   // Intensity value
} ScanPnt ;

Coordinate system

Laser point coordinates are stored as integer values which are relative to an origin point stored
in the header. To compute user coordinate values X, Y and Z (normally meters), use:

X = (Pnt.X - Hdr.OrgX) / (double) Hdr.Units ;
Y = (Pnt.Y - Hdr.OrgY) / (double) Hdr.Units ;
Z = (Pnt.Z - Hdr.OrgZ) / (double) Hdr.Units ;

Time stamps

Time stamps are assumed to be GPS week seconds. The storage format is a 32 bit unsigned
integer where each integer step is 0.0002 seconds.

Echo information

TerraScan uses two bits for storing echo information. The possible values are:

0 Only echo
1 First of many echo
2 Intermediate echo
3 Last of many echo
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Supported trajectory file formats

TerraScan has built-in support for the following trajectory file formats:

NAME TYPE CONTENT

TYXZRPH Text Time Northing Easting Elevation Roll Pitch Heading

TYXZSSSQSS Text Time Northing Easting Elevation Skip Skip Skip Quality
Skip Skip

TYXZQSSSS Text Time Northing Easting Elevation Quality Skip Skip Skip
Skip

TTXYZHPR Text Time Time Easting Northing Elevation Heading Roll
Pitch

TXYZ Text Time Easting Northing Elevation

SBET.OUT Binary Proprietary file format of Applanix

SBTC / SBIC Binary Proprietary file format of NovAtel Inertial Explorer
8.6+

POF 1.1 Binary Proprietary file format of Riegl.

TerraScan trajectory binary files

Imported trajectories are stored as binary files with TRJ extension. These files contain a header
followed by a number of trajectory position records.

The structure of the file header is:

typedef struct {
 char    Recog[8] ;       // TSCANTRJ
 int     Version ;        // File version 20010715
 int     HdrSize ;        // sizeof(TrajHdr)
 int     PosCnt ;         // Number of position records
 int     PosSize ;        // Size of position records
 char    Desc[78] ;       // Description
 BYTE    SysIdv ;         // System identifier (for lever arms)
 BYTE    Quality ;        // Quality for whole trajectory (1-5)
 double  BegTime ;        // First time stamp
 double  EndTime ;        // Last time stamp
 int     OrigNbr ;        // Original number (before any splitting)
 int     Number ;         // Line number (in laser points)
 char    VrtVideo[400] ;  // Vertical facing video
 double  VrtBeg ;         // Start time of VrtVideo[]
 double  VrtEnd ;         // End time of VrtVideo[]
 char    FwdVideo[400] ;  // Forward facing video
 double  FwdBeg ;         // Start time of FwdVideo[]
 double  FwdEnd ;         // End time of FwdVideo[]
 char    WaveFile[400] ;  // Waveform data file
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 char    Group[16] ;      // Group (session description)
} TrajHdr ;

The structure of the trajectory position records is:

typedef struct {
 double  Time ;           // Time stamp
 Dp3d    Xyz ;            // Position
 double  Head ;           // Heading (degrees)
 double  Roll ;           // Roll (degrees)
 double  Pitch ;          // Pitch (degrees)
 BYTE    QtyXy ;          // Quality for xy, 0=not set
 BYTE    QtyZ ;           // Quality for z, 0=not set
 BYTE    QtyH ;           // Quality for headingy, 0=not set
 BYTE    QtyRp ;          // Quality for roll/pitch, 0=not set
 short   Mark ;           // Run time flag
 short   Flag ;           // Run time flag
} TrajPos ;

where Dp3d structure is:

typedef struct {
 double  x ;
 double  y ;
 double  z ;
} Dp3d ;

and where xy and z quality values translate to meters as:

QualityInMeters = pow(QtyXy,1.5) * 0.001 m

(1=0.0010m, 2=0.0028m, 3=0.0052m, 4=0.0080m,... 255=4.072m)

and where heading, and roll/pitch quality values translate to degrees as:

QualityInDegrees = pow(QtyH,1.5) * 0.0001 deg

(1=0.00010, 2=0.00028, 3=0.00052, 4=0.00080,... 255=0.4072 deg
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Configuration Variables for MicroStation

MicroStation is able to locate TerraScan with the help of configuration variables. When you
install TerraScan, the installation program will create a configuration file TERRA.CFG which
defines the required environment variables. This file is placed in MicroStation's CONFIG\APPL
sub-directory.

For example, C:\USTATION\CONFIG\APPL\TERRA.CFG may contain:

#--------------------------------------------------

#  TERRA.CFG - Configuration for Terra Applications

#--------------------------------------------------

TERRADIR=c:/terra/

TERRACFG=$(TERRADIR)config/

TERRADOCS=$(TERRADIR)docs/

MS_MDLAPPS < $(TERRADIR)ma/

%if exists ($(TERRACFG)*.cfg)

%   include $(TERRACFG)*.cfg

%endif

This configuration file will include all the configuration files in C:\TERRA\CONFIG directory.
TerraScan's configuration file TSCAN.CFG contains:

#------------------------------------------

#  TSCAN.CFG - TerraScan Configuration File

#------------------------------------------

TSCAN_DATA=$(TERRADIR)data/

TSCAN_LICENSE=$(TERRADIR)license/

TSCAN_MACRODIR=$(TERRADIR)macro/

# Directory for user preferences (user has write access)

TSCAN_PREF=$(TERRADIR)tscan/

# Directory for settings (may point to read-only directory)

TSCAN_SET=$(TERRADIR)tscan/

# Files for settings (may be shared by organization)

TSCAN_ALIGNREP  = $(TSCAN_SET)alrepfmt.inf

TSCAN_OUTFMT    = $(TSCAN_SET)outfmt.inf

TSCAN_TRANSFORM = $(TSCAN_SET)trans.inf

TSCAN_TARGETS   = $(TSCAN_SET)targets.inf
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TSCAN_CODES     = $(TSCAN_SET)codes.inf

In a default configuration, MicroStation automatically includes these settings as configuration
variables. You can check the values for these variables in the Configuration Variables dialog of
MicroStation. In case these variables have not been defined correctly, you should define them
manually.

· MS_MDLAPPS should include the directory where TSCAN.MA is located.

· TSCAN_DATA defines a default directory for incoming laser points.

· TSCAN_LICENSE should point to the directory where user license TSCAN.LIC is located.

· TSCAN_MACRODIR defines a directory where macros are searched from.

· TSCAN_SET should point to a directory where settings can be stored. This directory may be
shared by an organization and the user may lack write access to it.

· TSCAN_PREF should point to a directory where user preferences can be stored. The user
must have write access to this directory.

· TSCAN_ALIGNREP defines the file in which alignment report formats are stored.

· TSCAN_OUTFMT defines the file in which output file formats are stored.

· TSCAN_TRANSFORM defines the file in which coordinate transformations are stored.

· TSCAN_TARGETS defines the file in which target object types are stored.

· TSCAN_CODES defines the file in which EarthData code translation table is stored.
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DLL Interface

TerraScan installation includes an example dynamic link library together with source code
illustrating how tools can be added into TerraScan.

These addon tools may perform such tasks as classifying points, writing points to output files or
displaying statistical information. The names of the tools will appear in the Addon menu in the
TerraScan window. The tools are responsible for providing modal or mode-less dialogs for the
input of required user settings.

The example link library \TERRA64\MA\TSCANADD.DLL has been built using Visual C++ 6.0 from
source codes included in \TERRA64\ADDON directory. It provides one tool: the display of an
intensity histogram.

You may modify the source code and build a dynamic link library to replace the one supplied
during installation. The addon library must provide four predefined functions which TerraScan
will call at different stages of application execution. These functions are:

· AddonFillCommands() is called at start-up so that the DLL will inform TerraScan about
available tools.

· AddonLinkVariables() is called after start-up to provide the DLL with information about
some of TerraScan’s internal tables and variables.

· AddonRunCommand() is called whenever user starts an addon command.

· AddonEnd() function is called before the application is unloaded so that the DLL may
release any resources it has allocated.

See \TERRA64\ADDON directory for example source code files.

The example source code uses C syntax and accesses WIN64 API to create the user interface
items.
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File Name Variables

TerraScan includes a number of commands that write output files, for example, for point clouds
or for vector data derived from point clouds. In order to write separate files with specific
names, there are different variables that can be used in the output file name definition. The
variables are always introduced with a # followed by the variable name.

Possible variables are:

· #bnumber - block number.

· #block - block name or block binary file name without extension.

· #bpath - path of the block binary file. This includes the binary file name and its extension.

· #bemin - minimum easting value of block boundary vertices.

· #bnmin - minimum northing value of block boundary vertices.

· #bemax - maximum easting value of block boundary vertices.

· #bnmax - maximum northing value of block boundary vertices.

· #pdir - path of the storage directory of the block binary file. This does not include the name
of the binary file.

· #name - active file name. Use this to replace the file name component when running a
macro on selected files.

· #line - line number stored for a point. Use this variable with the Output by line action in
order to store one file for each line.
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Installation Directories

TerraScan shares the same directory structure with all Terra Applications. It is recommended
that you install all Terra Applications in the same directory.

The list below shows a typical directory structure when TerraScan has been installed in path C:
\TERRA64.
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C:\TERRA64 installation directory for Terra applications

0 addon example addon source files

 app application files for Spatix

 tscan.ix application

 tscanadd.dll library

 cell MicroStation cell libraries

 karttali.cel sample cell library with topographic objects,
such as trees

 config application configuration files

 tscan.cfg defines environment variables for
MicroStation

 tscan.ini defines environment variables for Spatix

 coordsys coordinate system definitions

 docs documentation, such as user guides in PDF
format

 example sample files

 dangerpoint_report.html HTML template for creating danger object
reports

 geoid geoid model files

 include C/C++ header files with prototypes of public
functions in TerraScan

 public_classification.h prototypes of classification public functions

 public_functions.h prototypes of general public functions

 public_types.h data types used

 license user license files

 tscan.lic user license

 ma application files for MicroStation

 seed seed files, templates

 seed3dcm.dgn seed file for creating MicroStation 3D design
files with centimeter resolution

 seed3dcm.spx template for creating Spatix files with
centimeter resolution

 seed3dmm.dgn seed file for creating MicroStation 3D design
files with millimeter resolution

 seed3dmm.spx template for creating Spatix files with
millimeter resolution

 tscan user settings and configuration files

 asprs.ptc list of point classes according to the ASPRS
standard

 tscan.ptc default list of point classes

 tslave TerraSlave application files and sub-folders



TerraScan User Guide  © 2023 Terrasolid Ltd

925Scripting interface >   >  

Scripting interface

TerraScan implements a scripting interface which you can use to send key-in commands to the
CAD system. Any programming method provided by the CAD system is applicable, such as MDL,
Microstation Visual Basic or simply function key definition. In your own code, you may launch
any action available in TerraScan as toolbox icon, pulldown menu command or dialog push
button, and set values of any dialog variable. Actions and dialog variables are only available
when the corresponding dialog is created. This ensures that the application state is ready for
the action or for setting a variable.

Scripting key-in commands

TerraScan, TerraPhoto, TerraMatch and TerraModeler implement the same scripting interface
and thus, work with the same key-in command logic. The key-in commands below show the
syntax for TerraScan commands while examples are given from TerraScan. The syntax for the
other applications follow logical rules:

APPLICATIO
N

SET
LOGGING

LAUNCH
ACTION

SET
VARIABLE

TerraScan scan log scan action scan set

TerraPhoto photo log photo
action

photo set

TerraMatch match log match
action

match set

TerraModel
er

model log model
action

model set

Scan Log Dialogs logfile

Scan Log Dialogs logfile starts to write actions and dialog variables to a text file at a given
location on the hard disc. E.g., "scan log dialogs d:\logs\dialogs.txt" writes the logfile
"dialogs.txt" in directory d:\logs\ on the hard disc. If the file does not exist, it is created when
the first action to log is performed.

The command is most useful to find out action, dialog and variable names. Start the logfile
creation by using the key-in command in the Key-in lineMicrostation or Spaccels windowSpatix. Call
the tool or command in the software and define settings in the dialog. Close the dialog with OK
or Cancel. The application writes the dialog name, variable names and setting values into the
logfile.

Use the key-in command without the logfile variable in order to stop writing actions to the
logfile.
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Scan Action action

Scan action action starts the given action. E.g. "scan action trajectviewfields" launches the
command View fields in the Trajectory window which means it opens the View Trajectory
Fields dialog. Actions are linked to dialog push buttons or dialog pulldown menus in the
software. An action can be started only when the dialog is open.

Scan Action HideDialog

Scan action hidedialog instructs the software to keep the next modal dialog hidden and close it
with OK.

Scan Set variable = value

Scan set variable = value assigns the given value to the given variable. E.g. "scan set
VtfNumber=1" sets the Number attribute to be visible in the View Trajectory Fields dialog. If
there is no matching variable in an open dialog, the application stores the variable-value-
assignment in a buffer. When the next dialog is created, it will apply the assignment and clear
the buffer.

Scan Close Dialog dialog

Scan close dialog dialog closes a modeless dialog with the given name. E.g. "scan close dialog
ManageTrajectories" closes the Trajectories window.

Scripting examples (Microstation VBA)

TerraScan setup provides an example script that includes Microstation VBA modules. The script
is stored in the \EXAMPLE folder of the Terra installation directory, e.g.
C:/TERRA64/EXAMPLE/SCRIPTING_EXAMPLE.MVBA. The example script can be loaded in the
VBA Manager of Microstation and used, for example, as starting point for own scripts.



TerraScan User Guide  © 2023 Terrasolid Ltd

927

Index

- A -
Activate Powerline     258

Add Attachment     279

Add by boundaries     605

Add Cross Arm     280

Add lever arm     692

Add point to ground     416

Add Synthetic Point     242

Adjust laser angles     455, 881

Adjust to geoid     510, 635, 694, 882

Adjust xyz     636

Align Edge Segment     164

Apply Intersection Line     165

Apply Straight Line     166

Assign color to points     512, 883

Assign groups     424, 875

Assign number     718

Assign Point Class     243

Assign Wire Attributes     259

- B -
Build Step Corner     167

Building models     132, 134, 155, 163, 173

Roof contruction     143, 144, 157, 158, 162

Roof edges     164, 165, 166, 167, 168, 169, 170,
171, 172

Roof patches     160, 162, 163

Vectorization     32, 33, 34, 134, 143, 144, 148, 150,
187, 880

Walls     174, 175, 176, 177, 178, 179, 181, 182

Buildings     32, 33, 34, 132, 134, 155, 167, 791, 793,
880

- C -
Check Building Models     134

Check Catenary Attachments     261

Check coverage     637

Check Footprint Polygons     187

Check Wire Ends     355

Class + image     565

Classify Above Line     245

Classify Below Line     246

Classify Close To line     247

Classify Fence     249

Classify groups     424, 788

Automatically     427, 860, 864, 868, 869, 874

Manually     243

Classify points     415, 788

Automatically     422, 860, 864, 868, 869, 874

Manually     243, 245, 246, 247, 249, 250, 255, 415,
416, 421

Classify Using Brush     250

Clear groups     428

Close points     441

Collection shapes     664

Compare with reference     515

Compute distance     517, 884

Compute normal vectors     524, 885

Construct Roof Polygons     143

Convert angles     695

Convert geoid model     526

Convert storage format     640

Convert time stamps     696, 889

Copy from reference     641

Create along centerline     610

Create along tower string     611

Create Attachments     282

Create Buildings from Polygons     144

Create Editable Model     252

Create Point Group     238

Create Span Tiles     292

Create surface model     485

Create Tree Cells     374

Cut Edge Corner     167

Cut Edge Segment     168

Cut Linear Element     200

Cut overlap     460, 891

Cut Section     386

- D -
Deduce from order     466

Deduce using time     467, 891

Define Classes     225

Define Coordinate Setup     228

Define Project     229

Delete     168, 283, 500, 613, 718, 891, 892

Design Block Boundaries     230

Detect plane     418

Detect trees     419

Detect Wires     268

Display mode     565

Distance     514

Drape Linear Element     201

Draw as l ine strings     486

Draw boundaries     614

Draw bounding box     528

Draw Building Section     157

Draw from points     467

Draw Horizontal Section     386
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Draw into design     707

Draw into profile     528

Draw into sections     529

Draw polygons     530

Draw Sight Distances     318

Draw Sign Visibil ity     322

Draw Slope Arrows     325

Draw Vertical Section     389

- E -
Edit definition     615

Edit information     719

Edit project information     619

Edit Tower Information     283

Export 3D ortho     645

Export lattice model     487, 648, 894

Export Powerline     293

Export raster image     491, 653

Extend Cross Arm     285

Extract color from images     532, 659

Extract echo properties     536, 662

Extract Echoes     408

Extrude Building     158

- F -
Fields     580, 724

File Formats     912, 913, 914, 917

Find Automatic Breaklines     328

Find Breakline Along Element     204

Find Danger Objects     295

Find Powerline Wires     271

Find rails     364

Find Road Breaklines     331

Find wires     368

Fit Geometry Components     336

Fit Linear Element     210

Fit Railroad String     370

Fit to reference     537

Fit view     582

Fix Elevation     253

- G -
Groups     875

Assign     424, 875

Classify     427, 874

Clear     428

Create     238

Merge     240

Tool box     236

- I -
Import accuracy fi les     682

Import directory     619, 682

Import fi les     683

Import points into project     621

Import Road Breaklines     336

Insert Edge Vertex     169

Inspect Elements     211

- L -
Label Alignment Curvature     338

Label Catenary Height     305

Label Towers     307

Link to waveform files     710

Lock selected     617

- M -
Macros     540, 856, 857

Macro actions     872

Run macros     668

Manage Trajectories     233

Measure Point Density     391

Merge blocks     617, 663

Merge Footprint Polygons     148

Merge from GPS and INS     688

Merge Patches     160

Merge Point Groups     240

Modify Cross Arm     286

Modify Edge     170

Modify l ine numbering     473, 899

Modify Tree Cells     379

Mouse Point Adjustment     216

Move Edge Vertex     171

Move Section     394

Move Tower     286

- N -
New project     627

- O -
Open block     442

Open inside fence     443

Open project     632
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Output alignment report     495

Output Catenary     308

Output control report     542, 666

Output positions     689

Output Tree Cells     382

- P -
Place Catenary String     276

Place Collection Shape     218

Place Railroad String     372

Place Tower     287

Place Tower String     273

Place Tree Cell      382

Powerlines     257

Danger objects     295, 838

Export     293, 308

Towers     92, 93, 94, 278, 279, 280, 282, 283, 285,
286, 287, 290, 291

View     89, 258, 291, 305, 307, 310

Wires     258, 259, 261, 268, 271

Projects     602, 605, 619, 634, 676

Blocks     605, 610, 611, 613, 614, 615, 617, 618,
663, 670, 672

Manage     619, 621, 627, 632, 633, 640, 669

- R -
Railroads     315, 354

Analyze     318, 322, 338, 814, 838

Rails     98, 364, 370, 833

Wires     355, 368, 879

Read     446, 452, 544, 546, 547, 548, 549, 551

Read points     233, 446

Read reference points     452

Rebuild Model     254

Release lock     618

Remove Details     160

Remove Patch     162

Remove Vegetation     255

Roads     112, 315, 317, 343, 345, 348, 350, 351, 546,
548, 549

Analyze     106, 318, 322, 325, 336, 338, 353, 814,
827, 877, 885, 888

Breaklines     328, 331, 336, 908

Rotate Cross Arm     290

Rotate Section     395

Rotate Tower     291

- S -
Save points     452, 903

Save project     633

Set accuracy     721

Set all  edges     172
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